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3D Basemaps 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. The capabilities have been replaced with 3D Buildings and Tree Data 

Management. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to 3D Basemaps 
3D Basemaps can be used to author and maintain a 3D basemap for your organization. 

It provides a series of workflows that streamline the creation and maintenance of a 3D 

basemap that supports diverse information needs. This optimized approach allows 

organizations to use existing data (for example, lidar, building footprints, and utilities) and 

generate 3D visualizations that increase understanding and community engagement. 3D 

Basemaps is typically implemented by planning departments, emergency management 

agencies, GIS departments, and utilities that want to use 3D basemaps to visualize the built 

environment. 

The 3D Basemaps solution delivers a set of capabilities that help you use existing data, 

develop a standard set of 3D layers, and visualize your community in an immersive way. 

 

Requirements 
The 3D Basemaps solution requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later (Advanced) 

• ArcGIS 3D Analyst extension 

• ArcGIS Spatial Analyst extension 

 

Information products 
3D Basemaps includes the following information products: 

Item Description 

Minimum user 

type 

3D 

Basemaps 

An ArcGIS Pro project used by GIS analysts and 

mapping technicians to create and maintain a 3D 

basemap for their organization 

GIS Professional 

Advanced 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-3d-buildings.htm
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-tree-management.htm
https://doc.arcgis.com/en/arcgis-solutions/latest/reference/introduction-to-tree-management.htm


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 6 

Release notes 
The following are the release notes: 

Version Description 

1.5 • A new 3D Basemaps ArcGIS Pro project to support ArcGIS Pro 3.0. 

• Added a workflow to create 3D water features such as lakes, rivers and 
coastal waters from 2D polygon features. 

• New offset option in the Modify Ground Surface tool. 

• Added the ability to buffer floor plates inwards as well as outwards. 

• 3D Tree symbols can now be set through the symbology pane. 

1.4 • Added deep learning for power line classification in lidar. 

• Added the ability to extract power line features from lidar. 

• Any web map with feature layers can now be quickly added to your 3D 
basemap. 

1.3 • Resolved an issue when a meter-based coordinate system is used with 
the Windows language set to other than English. 

• Resolved an issue with roof form extraction when running multiple times 
on large datasets. 

 

1.2 

• Added an integrated mesh editing and maintenance workflow 

• Added the ability to color trees in lidar point clouds 

• Lidar class codes can now be preserved when classifying trees using 
deep learning 

• Improved stability of footprint segmentation 

• Fixed an issue with extracting tree points using cluster analysis 

1.1 • Added deep learning for tree classification in lidar 

• Added tree extraction using cluster analysis 

• Significantly improved the performance and quality of building footprint 
extraction 

• Added links to 3D analysis solutions that can use 3D basemaps layers 

• Fixed an issue with building footprint extraction in ArcGIS Pro 2.6 

1.0 • First release of 3D Basemaps 
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Use 3D Basemaps 
The 3D Basemaps solution delivers a set of capabilities that help you leverage existing data 

(for example, lidar, building footprints, utilities), develop a standard set of 3D layers, and 

visualize your community in an immersive way. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Get to know 3D Basemaps 
You will assume the role of a mapping technician responsible for creating a 3D basemap for 

your community. The 3D Basemaps ArcGIS Pro project includes a series of tasks to help 

guide you through these workflows. The first set of tasks will help you get to know 3D 

Basemaps. 

1. Start the ArcGIS Pro application and open the 3D Basemaps project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Getting to know 3D 
Basemaps task and go through the various subtasks. 

 

Understand the 3D Basemaps solution 
The 3D Basemaps solution uses existing data within the organization such as lidar, building 

footprints, power lines, and underground pipe features. Your 3D basemap can be created at 

different levels of detail (LOD) depending on the quality of the input lidar data. This first task 

will guide you through the data requirements and help you learn how you can utilize your 3D 

basemap in other workflows and applications. 

 

Download sample data 
Sample data is provided to help you learn how to use the 3D Basemaps solution. Click to 

expand the Getting to know 3D Basemaps task group and double-click the Download 

sample data task. Click the sample data hyperlink to download sample data for Naperville 

and Philadelphia. Using the sample data the first time will help you learn how to use the tasks 

and how to organize your data. 

 

Start using 3D Basemaps 
The 3D Basemaps project includes a task workflow that provides a structured sequence using 

tasks and steps. Follow the steps in this task to learn how to use the 3D Basemaps solution. 
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Publish data for your 3D Basemaps 
After you have reviewed the Get to know 3D Basemaps section, you can begin using the 

solution with your data. The following set of tasks will help you learn how to use 3D 

Basemaps. 

1. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

2. In the Catalog pane, expand the Tasks folder, and double-click the How to use 3D 
Basemaps task and go through the various subtasks. 

 

Publish ground elevation surface 
Detailed elevation layers can be automatically generated from the input lidar data. These 

layers are used to create buildings and vegetation layers. The ground elevation layer can be 

used to enhance the existing elevation in your 3D scene. 

To publish your ground elevation surface, click the Publish ground elevation surface task 

and follow the steps provided. 

 

Extract elevation surfaces from LAS dataset 
This task extracts three elevation surfaces from the LAS dataset: a ground elevation (dtm), a 

surface elevation (dsm), and a normalized surface elevation (ndsm). These surfaces are used 

to create buildings and vegetation layers. The ground elevation layer can also be used to 

improve the ground in your scene. 

 

Publish ground elevation 
This task publishes the ground elevation layer to your organization. Reprojection to Web 

Mercator with height in meters is only required if you want to use the published layers in a 

global web scene. 

 

Publish buildings 
Buildings with simple roof structures can be generated automatically from the lidar. Attributes 

such as building height, eave height, and the roof form are extracted from the lidar and added 

to the building footprints. Procedural rules are then used to create the 3D roof structures. 

High-density lidar (point spacing less than 3 feet) and building footprint segmentation are 

needed to model complex roof structures. 

Note: 

The quality of the roof structures is dependent on the quality of the input lidar and building 
footprint data. A lidar point spacing of 3 feet or less is required, 1 foot or less is 
recommended. Building footprints with one roof type within their boundary (for example, 
suburban areas) will produce higher-quality roof structures than footprints with multiple 

https://www.esri.com/en-us/privacy/overview
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roof types (for example, city centers). These footprints require splitting, segmentation, and 
updating of the roof form attributes. 

To publish your buildings, expand the Publish buildings group task and follow the steps 

provided. 

 

Extract building footprints (optional) 
Run the Extract building footprints task to optionally extract building footprints from lidar. It 

is not required if you have an accurate footprint feature class. 

 

Preprocess building footprints (optional) 
Run the Preprocess building footprints task to prepare the building footprints for a realistic 

3D visualization. Some building footprints may contain several roof types and roof parts. To 

accurately represent these buildings, they need be split into their separate parts. Building 

footprints can be split with another feature class or by differences in elevation. 

 

This image shows the result of building extraction before preprocessing of building footprints. 

https://www.esri.com/en-us/privacy/overview
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This image shows the result of building extraction after preprocessing of building footprints. 

Tip: 

Separate features of similar size into separate feature classes before running 
segmentation to improve segmentation quality. Use different spectral and spatial detail for 
each of these feature classes to tweak the roof segmentation for your data. Merge the 
feature classes when finished. 

 

Create buildings 
Run the Create buildings task to create a 3D building layer. This task uses the elevation 

surfaces and building footprints to find both flat and sloped planar areas within a roof area of a 

building. It estimates a standard architectural form for the roof based on the attributes 

collected from these planar surfaces. These attributes are then used to inform a procedural 

rule that generates these features in 3D. 

https://www.esri.com/en-us/privacy/overview
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This image shows the roof types that will be automatically classified. 

 

Review buildings 
Run the Review buildings task to inspect your building roof forms. The Confidence 

Measurement tool reports the following measurement (attribute added to the building 

footprints): 

Note: 

The RMSE field shows the root mean square error of the generated building multipatch to 
the underlying surface model. The higher this number, the more likely that the building 
creation encountered an error in classification. In general, a value of 1 meter (3 feet) or 
less is desirable, though this depends on the required application of the output features, 
and the resolution of the input data. 

 

Modify buildings 
Use the Modify buildings task to further improve the quality of the building roof forms. The 

building roof form is driven by the attributes that are generated by the Create buildings task 

and by the underlying the building footprint. To refine the building roof form, modify the 

attributes or the building footprint. 

Tip: 

The attributes that control the roof form are building height, eave height, roof direction, 
and the type of roof are BLDGHEIGHT,EAVEHEIGHT, ROOFFORM, RoofDirAdjust. By 
editing these attributes, you can adjust your building models to better match the lidar 
data. 

https://www.esri.com/en-us/privacy/overview
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Building footprint attributes that control the roof form. 

 

Building height 

If the ridge of the building is not at the correct height, identify the elevation of a LAS point on 

the true ridge by clicking the LAS point while having the Explore tool active. You will need to 

subtract the BASEELEV value from the LAS elevation to get the correct BLDGHEIGHT value. 

 

Results of manual updating of the BLDGHEIGHT attribute are shown. 

 

Eave height 

Similar to building height, reference the lidar to obtain the correct eave height. You will need to 

subtract the BASEELEV from the lidar elevation to get the correct the EAVEHEIGHT value. 

https://www.esri.com/en-us/privacy/overview
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Results of manual updating of the EAVEHEIGHT attribute are shown. 

 

Roof form 

If your roof type does not match the lidar data, change the roof type by choosing the correct 

roof form from the drop-down list. 

 

Results of manual updating of the ROOFFORM attribute are shown. 

 

Roof direction 

Adjust the direction of the roof by modifying the RoofDirAdjust field. The default value is 0. A 

value of 1 will rotate the roof counterclockwise 90 degrees, or a value of 2 will rotate it 180 

degrees. 

https://www.esri.com/en-us/privacy/overview
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Results of manual updating of the RoofDirAdjust attribute are shown. 

 

Split roof segments 

Some building footprints may contain several roof types and roof parts. To accurately 

represent these buildings, you can split the footprints into separate features manually and 

update the attributes for each feature accordingly. 

To edit the building footprints, complete the following steps: 

1. Select the feature you want to segment. 

2. Use the Split tool in the Roof Segmentation task, or in the Modify Features pane to 
segment the selected feature. 

3. Edit the attributes as needed with the new sections of the building footprint. 

https://www.esri.com/en-us/privacy/overview
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Results of manual splitting of buildings are shown. 

 

Modify building vertices 

Sometimes building footprints may have been created incorrectly and do not represent the 

building adequately, resulting in lower-quality roof forms. 

To edit the building footprints, complete the following steps: 

https://www.esri.com/en-us/privacy/overview
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1. Select the feature you want to modify. 

2. Use the Vertices tool in the Modify Building Vertices task, or on the Edit tab to modify the 
selected feature. 

3. Edit the attributes as needed with the modified building footprint. 

 
Results of manual updating of building vertices are shown. 

 

Create cross gable roof forms 

You can also use vertex editing to make cross gable roof forms. To do so, complete the 

following steps: 

1. Select the feature you want to modify. 

2. Use the Split tool in the Roof Segmentation task, or on the Edit tab to segment the 
building footprint according to the roof forms present within the footprint. 

3. Use the Vertices tool in the Modify Building Vertices task, or in the Modify 
Features pane to extend one gable roof into the other one. 

4. Edit the attributes as needed with the modified building footprint. 
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Results of manual updating of cross gable roof forms are shown. 

 

Fuse buildings 
If you have segmented some building footprints into separate features, you can use the Fuse 

buildings task to fuse the building features that represent building parts back together in the 

resulting 3D building features. 

Note: 

Review and modification of buildings is done on the building footprint layer with 
procedural symbology. Fusing saves the modification to multipatch format for texture 
adding and publishing. 

 

Add textures to buildings (optional) 
Use this task to add realistic textures to the previously extracted buildings. 

Note: 

Textures depict generic usage of buildings and are applied based on footprint size. Using 
high-resolution textures will result in large output, potentially leading to decreased 
visualization performance. 

https://www.esri.com/en-us/privacy/overview
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Publish buildings layer 
This task publishes the building layer to your organization. Reprojection to Web Mercator with 

height in meters is only required if you want to use the published layers in a global web scene. 

 

Update buildings (optional) 
Use this task if new lidar is available. It compares an existing 3D multipatch building layer with 

a new lidar dataset to verify whether there are any updates required due to new construction 

or demolition. If changes have been detected, these can then be merged back into the original 

3D building layer. 

To update your existing buildings, you will need the following data: 

• Multipatch buildings 

• Lidar with ground and buildings classified 

The Update Buildings process accomplishes the following purposes: 

• Detects changes between input 3D multipatch buildings and new lidar. The output is 
building update polygons where changes have been detected depending on the input 
parameters. 

• Creates LOD2 update buildings using the building update polygons and the lidar. 

• Merges the LOD2 update buildings with the existing 3D buildings. 

 

Publish floors 
Building Floors can be created using the Publish floors task. The input is multipatch buildings, 

which can come from the Publish buildings task or from other sources such as CityEngine or 

third-party providers. The output is building floor plates and floor volumes. Floors can be 

created using a Building Space Use table where the building will be split into tiers or groups of 

floors, each with their own number of floors, floor height, space use, and color. Alternatively, 

building attributes such as number of floors, ground floor height, upper floor height, and roof 

height can be used to create the floors. 

Note: 

Splitting buildings into floors can take a long time to run, especially when the initial split 
failed, and a more time-intensive splitting algorithm must be used. Ensure you only split 
the buildings that are required. Also, factors such as building size and complexity will 
affect the processing time. 

In the Task Pane, click the Publish floors task and follow the steps provided. 
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Create building floors 
This tool splits existing 3D buildings into floors based on building attributes. You can use the 

buildings created in the Publish buildings task or bring in your own buildings. 

One option to create building floors is to use the building space use table to split the building 

into tiers or groups of individual floors with defined space use. The building space use table 

has several attributes that describe the different tiers within the building. Each tier has an 

attribute defining space use, number of floors, floor color, and floor height. The 

BuildingTypeName attribute is the identifier that links the Building Space Use table to the 

building features. An example building space use table can be found in the tables folder of the 

3D basemaps ArcGIS Pro project. 

 

Create floor volumes 
If you require floor volumes, use the Create floor volumes task to create floor volumes out of 

the 3D floor plates. The Extrude By Attribute geoprocessing tool requires a building feature 

class with space usage information that includes floor height. 

 

Publish trees 
Tree location, size, and width can be extracted from ground classified lidar as point features. 

Tree point features are then symbolized using procedural rules and can be schematic or 

realistic. If trees are classified in the lidar, the quality of the tree extraction will improve. 

In the Task pane, expand the Publish trees group task and follow the steps provided. 

 

Classify trees in lidar using deep learning 
Run this tool to optionally classify trees in the lidar using a deep learning model. Classified 

trees will improve the vegetation extraction but keep in mind that deep learning is 

computationally very intensive, and a powerful GPU is needed to process large datasets 

faster. Depending on data size and available hardware, it can take hours to finish. Start with 

one LAS file to see processing time on your system. 

To work with the deep learning tools in ArcGIS Pro, you need to install supported deep 

learning frameworks packages. See deep learning frameworks for ArcGIS. 

A tree classification model trained by Esri can be downloaded from ArcGIS Living Atlas of the 

World or you can create your own model using the Training a Deep Learning model for Point 

Cloud Classification notebook that can be found in the notebooks folder of the 3D 

basemaps ArcGIS Pro project. 
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Extract tree points using surface analysis 
Use this tool to extract tree points from the lidar using surface analysis. This type of extraction 

is faster for large lidar datasets, but the results are less accurate than using cluster analysis 

for dense lidar (point spacing less than 1.5 feet/0.5 meters). 

 

Extract tree points using cluster analysis 
Use this tool to extract tree points from the lidar using cluster analysis. This type of extraction 

is slower for large lidar datasets, but the results are more accurate than using surface 

analysis. 

Note: 

When creating the 3D trees, make sure to verify the Vegetation class code. The correct 
class codes for vegetation is typically 5. The tool will verify whether your lidar has this 
code, but trees might be represented by other codes as well. Visually review your lidar 
and verify what class code tree points have by clicking a tree lidar point. If the vegetation 
has not been classified, enter the class code that represents the vegetation, for example, 
0 or 1. 

Tip: 

Use the Extract tree points using surface analysis tool to create an initial vegetation layer. 
Run the Extract tree points using cluster analysis tool for lidar files for which you need 
detailed trees and replace the trees from the initial layer with the more detailed trees 
where needed. 

 

Create colorized lidar trees 
Classified lidar can also be used directly to visualize trees. This step extracts just the tree 

points from the input lidar and uses aerial imagery to colorize them. 

 

Publish bridges 
If bridge surfaces are classified in the lidar and the lidar is dense enough, it is possible to 

extract the bridge surfaces as 3D polygons. 3D bridges can then be created by applying 

procedural rules. 

In the Task pane, expand the Publish bridges group task and follow the steps provided. 

 

Create bridges 
In the Extract bridge surfaces from lidar step, enter the following: 

• Class Code—The class code that represents the bridge surfaces. 
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• Sampling Value—Experiment with this value to improve processing speed and output 
quality. 

• Bridge Area—This is the minimum area that defines a bridge surface. 

 

Note: 

The bridge surface should be a separate class code. If bridge surfaces are not classified 
in the lidar, you can interactively classify the bridge surfaces in ArcGIS Pro. 

Note: 

Only rectangular bridge surfaces and models are supported. 

 

Publish power lines 
Power line features such as wires and support structure locations with height can be extracted 

from classified lidar as line and point features. Simple symbology or procedural rules can be 

used to visualize the power lines in 3D. A wide variety of conductor and tower configurations 

are supported when using procedural rules. It is also possible to use your existing GIS data 

instead of the features extracted from lidar. 

In the Task pane, expand the Publish power lines group task and follow the steps provided. 

 

Classify power line features in lidar using deep learning 
Run this tool to optionally classify wires and support structures in the lidar using a deep 

learning model. Classified power lines will improve the wire and support structure locations 

extraction, but keep in mind that deep learning is computationally very intensive, and a 

powerful GPU is needed to process large datasets faster. Depending on data size and 

available hardware, it can take hours to finish. Start with one .las file to see processing time 

on your system. 

To work with the deep learning tools in ArcGIS Pro, you need to install supported deep 

learning frameworks packages. See Install deep learning frameworks for ArcGIS. 

A power line classification model trained by Esri can be downloaded from ArcGIS Living Atlas, 

or you can create your own model using the Training a Deep Learning model for Point Cloud 

Classification notebook that can be found in the notebooks folder of the 3D basemaps ArcGIS 

Pro project. 

After classification using deep learning, you can manually improve the classification further in 

the next step. 
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Extract wires from lidar 
This step extracts the wires as features from the classified lidar. It models each segment of a 

power line between two suspension points as individual line features. Use this step if you 

need to extract all wires as PolylineZ features. 

Note: 

For best extraction results, ensure the average lidar point spacing is less than 1 foot or 30 
centimeters. 

 

Extract support structure locations from lidar 
Use this step to extract the support structure locations from lidar as PointZ (x,y,z) features 

with height as the attribute. 

Note: 

For best extraction results, ensure the average lidar point spacing is less than 1 foot or 30 
centimeters. 

 

Symbolize wires 
Use this step to visualize the wire features that were extracted from lidar as 3D tubes. 

 

Symbolize support structure locations 
Use this step to symbolize the support structures as complete transmission or distribution 

lines including wires and towers or poles. This can be useful if you need a realistic visual 

representation of the transmission or distribution lines with wires connected to the support 

structures. 

Note: 

In this step, wires are modeled as catenary curves with a default sag to span ratio of 
0.035, which may differ from the classified wire points in the lidar. 

Run the Create transmission lines task to create 3D transmission lines. Enter the following: 

• Voltage—Select the voltage for the transmission line. The values for the voltage list are 
read from the TowerLUTable table located in the project tables directory. Change these 
values to modify conductor and tower features. 

• Tower configuration—Experiment with these parameters to create the desired towers. 

Run the Create distribution lines task to create 3D distribution lines. Enter the following: 

Pole configuration—Experiment with these parameters to create the desired poles. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 23 

Note: 

Both tools support point features as input. You can use existing features or features that 
have been extracted from lidar, or you can manually create features. A line and tower 
attribute must be present. The line attribute should describe which line the points belong 
to and the tower attribute should describe the tower order per line. Connected lines are 
not supported. 

Note: 

This tool requires that the Microsoft Access Database Engine driver be installed. 

 

Publish underground pipes 
You can turn your existing 2D underground utility features into 3D features using elevation 

attributes. 

In the Task pane, expand the Publish underground pipes group task and follow the steps 

provided. 

 

Create gravity mains 
Run the Create gravity mains task to create 3D gravity-driven mains. The first time you run 

this step, you evaluate the current state of the gravity mains and highlight errors. After 

reviewing the errors and updating fields that are incorrect, run Interpolate gravity mains to 

calculate any remaining missing values. 

 

Create manholes 
Run the Create manholes task to create 3D manhole features. 

 

Create laterals 
Run the Create laterals task to create 3D lateral features. 

 

Create a surface trench 
Run the Create a surface trench task to better visualize underground pipe features. 

 

Publish integrated mesh 
An integrated mesh is a textured continuous meshed surface capturing a current state of an 

area or city. They are often derived from drone, aerial, or satellite imagery via 

photogrammetric processing. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://pro.arcgis.com/en/pro-app/3.0/help/data/excel/work-with-excel-in-arcgis-pro.htm#GUID-F832BD5C-0000-47A3-85E2-0D11B948353C


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 24 

In the Tasks pane, expand the Publish integrated mesh group task and follow the steps 

provided. 

 

Add integrated mesh 
This step adds an integrated mesh to your scene. A mesh (.slpk) is typically created from 

photogrammetric sources, like imagery captured by drones and processed with Drone2Map or 

SiteScan. There are also several Esri partners that specialize in producing city-scale 

integrated mesh for purchase. 

 

Modify integrated mesh 
Use this step to make a modification to an integrated mesh layer. You can create a new 

modification or import from an existing polygon feature layer. Mesh modifications are useful to 

be able to show other 3D layers such as buildings, trees or bridges together with the 

integrated mesh. 

 

Publish integrated mesh layer 
This step publishes the integrated mesh layer to your organization. Reprojection to Web 

Mercator with height in meters is only required if you wish to use the published layer in a 

global web scene. 

Run Share as new web scene to publish the entire scene as web scene to your organization. 

Remove all the layers that you don't want to publish from the scene before publishing. 

Run Share as scene layer if you need to add an integrated mesh to an existing web scene. 

 

Modify integrated mesh in web scene 
This tool modifies an integrated mesh in a published web scene without having to republish 

the entire mesh as a new web scene. 

 

Publish water features 
This task allows you to create and publish 3D water features as multipatch features and 

polygon features. Water features can represent flat water bodies such as lakes and coastal 

waters as well as rivers with a certain gradient. This task works well with flat water features 

and river features at city scale. Larger features with a lot of gradient will results many 

polygons which may lead to performance degradation. 

 

Create water features 
This step creates water features as 2D polygons. You can skip this step if you already have a 

polygon feature class that defines the water features. 
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Modify water features 
The water features need to have a depth attribute that describes the average depth for each 

water feature. These values are used to modify the ground elevation for the area of the water 

features so that the water surface features display properly. 

In this step you can calculate the depth values for all water features. If you want specific depth 

values for each water features, open the feature attribute table and set the values manually. 

 

Create 3D water features 
This step allows you to create 3D water features from the 2D water features and a ground 

elevation (dtm) surface as input. 

This tool outputs a multipatch layer and a polygon layer representing the 3D water level. Use 

the multipatch layer to visualize large areas of flooding as this format is suited for fast 

rendering of many features. Use the polygon layer if you want to leverage water animation in 

ArcGIS Pro and the Scene viewer. 

 

Symbolize water features 
Use this step to symbolize the water features with a water renderer. 

 

Publish 3D Basemaps 
The 3D basemap is a web scene that can be used across the ArcGIS platform. 

In the Task pane, expand the Publish 3D basemap web scene group task and follow the 

steps provided. 

 

Publish 3D basemap web scene 
Use this step to create a web scene containing the 3D basemap layers. 

Tip: 

For more information on creating a web scene, see Get started with scenes. 

 

Add web map to web scene 
Use this step to add the layers of a web map to a web scene; for example, you can add a web 

map to the 3D basemaps web scene. 
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Address Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar 2026 

 

Introduction to Address Data Management 
Address Data Management can be used to maintain an authoritative address repository and 

continuously improve the quality of address data. 

Addresses describe a physical place. Typically, an address includes the number assigned to a 

structure, the name of the street and town, or municipality. Assigning addresses is an 

essential act of government, often local government, and is critical to the provision of efficient 

services and cost-effective commerce in a community (for example, 911, permitting, billing, 

assessment and taxation). While many address authorities have a central database of 

address information, the physical location of those addresses eludes them.Address Data 

Management is typically implemented by address authorities, planning departments, dispatch 

centers, GIS departments, and other local government organizations that want to develop an 

address repository that supports diverse information needs and continuously improve the 

quality of this information. 

The Address Data Management solution delivers a set of capabilities that help you maintain 

an authoritative address repository, continuously improve the quality of address data, and 

share address information with internal and external stakeholders. 

 

Requirements 
Address Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.8 or later (Standard or Advanced) 

• ArcGIS Data Reviewer (optional) 

• ArcGIS Workforce 

• ArcGIS Field Maps 

• ArcGIS Survey123 Connect 
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Information products 
Address Data Management includes the following information products: 

Item Description 

Minimum user 

type 

Address Data 

Management 

An ArcGIS Pro project used to maintain an inventory 

of road centerlines, valid road names, site addresses, 

and related mailing addresses 

GIS Professional 

Standard 

Addressing An ArcGIS Hub site used by the general public to 

learn more about addressing and how they are 

assigned 

Not required 

Master Address 

Locator 

A Media Map app used by the general public to 

validate an address used to deliver public safety and 

other government services 

Not required 

Address Request 

Form 

An ArcGIS Survey123 form used by the general 

public to request a new address or report a potential 

error in the master address repository 

Not required 

Address 

Assignments 

An ArcGIS Workforce project used by addressing 

staff to manage address field operations. Field users 

access the Address Assignments project using 

the ArcGIS Workforce mobile app. 

Mobile Worker 

Address Field 

Inventory 

An ArcGIS Field Maps map used by addressing staff 

to collect address information while in the field 

Mobile Worker 
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Release notes 
The following are the release notes: 

Version Description 

2.0 • A new feature template in the Address Data Management Pro project 
helps users create one, or more, site addresses at a defined location (for 
example, new subdivision). 

• A series of new tasks in the Address Data Management Pro project help 
users split a road at a defined location (for example, municipal boundary) 
and calculate USNG coordinates for a site address. 

• A series of new rules in the Address Data Management Pro project help 
users calculate the municipality on a new road or site address, create a 
new postal address for each site address, and find common errors in 
address ranges and site addresses (for example, overlapping address 
ranges, site addresses that do not fall within an address range). 

• A new Address hub site that can be used to learn more about addressing 
and how they are assigned. 

• A new app that can be used to validate an address used to deliver public 
safety and other government services. 

• A new survey form that can be used to request a new address or report a 
potential error in the master address repository. 

• A new ArcGIS Workforce project that can be used to manage address 
field operations. 

• A new map that can be used to collect address information while in the 
field. 

1.0 • First release of Address Data Management 
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Configure Address Data Management 
Learn how to configure the Address Data Management solution to meet specific needs in your 
organization. 

 

Configure address data management project 
The Address Data Management solution includes an ArcGIS Pro project and sample data you 
can use to explore data management workflows. When you are ready to configure the project, 
a series of tasks are included to help you review the schema, make modifications to the maps 
and layers, load your data, and optionally migrate into ArcGIS Enterprise. 

1. Sign in to your ArcGIS organization and browse to the Address Data 
Management Desktop Application Template. 

2. Open the item page and click Download. 

3. Unzip and open the Address Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Address Data 
Management task. 

6. In the Tasks pane, expand the Configure Address Data Management task group. 

 

Review schema 
Included in the solution is a data dictionary that describes the feature classes, relationship 
classes, and domains included in the Address Data Management geodatabase. 

To review the data dictionary, browse to the Data Dictionary.htm file included with the Address 
Data Management project and open in your default web browser. 

 

Define spatial reference 
The Address Data Management project comes with two file geodatabases. Address Data 
Management Sample.gdb contains data designed to help test workflows supported in the 
solution. 

Address Data Management.gdb is an empty geodatabase with the same schema and a 
spatial reference set to Web Mercator. You can use this geodatabase to define your spatial 
reference and load your data. 

To define the spatial reference, follow the steps in the Define spatial reference task. 
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Configure maps, layers, and rules 
The Address Data Management solution leverages preconfigured attribute rules to automate 
many of the editing workflows. For example, when you create an address point, a unique ID is 
automatically generated for the point. 

In some cases, you may need to modify the default schema included with the solution to meet 
your organization’s needs. If you need to remove or rename fields that are used in any of the 
attribute rules, you must first update the rule to remove the reference to the field. Adding new 
fields does not impact the rules. You may also want to add additional rules or configure the 
feature templates to set the default attributes applied when a feature is created. 

To modify the schema, attribute rules, and feature templates of the layers, follow the steps in 
the Configure maps, layers, and rules task. 

 

Load your data 
When you have completed any schema modifications, you can load your existing data into 
the Address Data Management layers by following the steps in the Load your data task. 

 

Load into ArcGIS Enterprise 
While everything included with the Address Data Management solution is supported in a file 
geodatabase, some organizations may choose to manage this data in ArcGIS Enterprise. In 
Enterprise, the Address Data Management requires branch version to evaluate the validation 
rules and branch versioned datasets need to be published as a feature service to edit 
in ArcGIS Pro. 

To copy the Address Data Management schema into ArcGIS Enterprise and publish as a 
branch versioned feature service, follow the steps in the Load into ArcGIS Enterprise task. 

 

Modify address request survey 
The Address Data Management solution includes an Address Request Form survey that can 
be used by the general public to request a new address or report a potential error in the 
master address inventory. Review the preconfigured questions and align the survey with your 
organizational policies and desired outcomes. 

1. Install ArcGIS Survey123 Connect. 

2. Click Address Request Form to download the survey. 

3. In the Download window, click Download and click OK. 

4. Click Address Request Form to open the survey. 

5. On the left, from the side toolbar, click the XLSForm button. 

6. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 
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This tab comprises all the selectable options for survey questions. 

7. Click the survey tab. 

This tab comprises all the questions in the survey. 

8. Click the settings tab. 

This tab contains options for controlling the presentation and behavior in the survey. 

9. Revise the survey to reflect your needs. 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

11. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

12. Click Publish survey to publish your changes, and then click OK. 

 

Configure Addressing site 
The Address Data Management solution includes the Addressing ArcGIS Hub site that your 
organization can configure with your branding and use to share addressing information. 

Update with organizational information 
1. Verify that you are signed in to your ArcGIS organization and browse to 

the Addressing site. 

2. From the item page, click Configure. 

3. If necessary, click the Edit button  to open the site editor. 

4. Scroll to the Verify Your Address section, hover over the card, and click the edit 

pencil . 

5. Enter your email address. 

6. Scroll to the Address Assignment section, hover over the card, and click the edit 

pencil . 

7. Enter the URL to your address regulations. 

8. Scroll to the Frequently Asked Questions section, hover over the card, click the edit 
pencil, and update the questions and answers. 

9. To modify your site’s footer, on the left, click the Customize Toggle button . 

10. Click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

11. Click the HTML box. 

 The HTML window appears. 

12. Make the necessary changes and click Apply. 

13. Click Save. 
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14. In the upper-left corner of the page, click the Exit edit mode button. 

Share items with public 
Several layers, maps, and apps included in the Address Data Management solution must be 
shared with everyone so they can be accessed by the public on the Addressing site. To share 
your items with everyone, use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Address Data 
Management folder. 

2. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) SiteAddresses_public 

Feature Layer (hosted, view) ProposedSiteAddresses_submit 

Web Map Master Address Locator 

Web Mapping Application Master Address Locator 

Form Address Request Form 

Site Application Addressing 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

6. Click OK and click Save. 

 

Publish address locators 
You can author the address locators described below in ArcGIS Pro from the layers managed 
in the Address Data Management solution: 

• Composite 

• Dual Range 

• Site address 

• Road name 

Once you have authored the locators, you can use them in ArcGIS Pro to locate places using 
addresses along the left or right side of a road, rooftop address locations, and road names. 
You can also share the locators with your organization and use them in many ArcGIS 
Solutions. 

Learn how to create an address locator and more about the components of an address locator 
in the ArcGIS Pro help. 
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Share address data 
On a routine schedule, you can publish address data managed in Address Data 
Management in other formats and share this reformatted data with other organizations. Two 
common publication formats are Esri Community Maps and National Emergency Number 
Association (NENA) NG911. 

The Community Maps Program for Addresses provides the best available data to support the 
ArcGIS World Geocoding Service. You can contribute point address data to enhance the 
geocoding experience of your ArcGIS users. The Community Maps Program provides a 
toolbox to assist data Contributors with preparing their address layers prior to sending them 
into the Esri Community Maps Program. Learn how to become a Community Maps 
Contributor and what address elements can be shared with the ArcGIS user community. 

The NENA Guidelines were designed to meet public safety address needs. But they do not 
address other uses (permitting, billing, land records, etc.) of address data. The address layers 
in the Address Data Management solution have been optimized for data management in 
ArcGIS and support diverse address data needs (ie. service delivery, mailing, etc.). NENA's 
mandatory fields, and most of the recommended fields, have been incorporated in the address 
layers and NENA compliant layers can easily be produced from the address layers included in 
the Address Data Management solution. 

 

Join road name elements 
The Address Data Management solution stores the unique elements of a road name (for 
example, direction, name, and type) in the Master Road Names table and uses an attribute 
rule to create a full road name. Rather than repeating the unique road name elements on 
every road centerline and site address feature, a full road name is stored on each feature. 
Community Maps, NENA NG911 and many other publication formats expect unique road 
elements to be stored on each feature. Road name elements contained in the Master Road 
Names records can be joined to road centerlines and site addresses using the Make Query 
Table tool. This query table can then be consumed in the Community Maps toolset or 
exported to a desired format, such as NENA NG911. 

To join road name elements to your road centerlines, complete the following steps: 

1. Open the Address Data Management ArcGIS Pro project. 

2. Click Tools in the Geoprocessing group on the Analysis tab of the ribbon. 

3. In the Geoprocessing pane, search for Make Query Table. 

4. Open the Make Query Table tool. 

5. In the Input Tables parameter select the Master Road Name table and the Local Streets 
layer. 

You can select any of the road layers, the join will run against all the roads in the 
RoadCenterline feature class. 

6. In the Fields parameter from drop down arrow, click the Toggle All Checkboxes. 
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7. Uncheck the OBJECTID fields for the MasterRoadName and RoadCenterline feature 
classes. 

8. Click Add. 

9. In the Expression parameter, click New Expression. 

10. Click the SQL toggle button. 

11. Paste the following code: 

RoadCenterline.fullname = MasterRoadName.fullname And 
RoadCenterline.munileft = MasterRoadName.municipality 

Note: 

If you are working in enterprise you will need to provide the full qualified name of the 
feature class or table. 

12. In the Table Name parameter, type Roads. 

13. In the Key Field Options, select Generate a key field. 

14. Click Run. 

Note: 

The output layer will contain the roads with the joined Master Road Name attributes. If 
a road is missing from the Query Table there was no matching road name in the Master 
Road Name table. 

To join road name elements to your site addresses, complete the following steps: 

1. Open the Make Query Table tool. 

2. In the Input Tables parameter select the Master Road Name table and the Site 
Addresses layer. 

3. In the Fields parameter from drop down arrow, click the Toggle All Checkboxes. 

4. Uncheck the OBJECTID fields for the MasterRoadName and SiteAddressPoint feature 
classes. 

5. Click Add. 

6. In the Expression parameter, click New Expression. 

7. Click the SQL toggle button. 

8. Paste the following code: 

SiteAddressPoint.fullname = MasterRoadName.fullname And 
SiteAddressPoint.municipality = MasterRoadName.municipality 
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Note: 

If you are working in enterprise you will need to provide the full qualified name of the 
feature class or table. 

9. In the Table Name parameter, type Site Addresses. 

10. In the Key Field Options, select Generate a key field. 

11. Click Run. 

Note: 

The output layer will contain the roads with the joined Master Road Name attributes. If 
a road is missing from the Query Table there was no matching road name in the Master 
Road Name table. 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 36 

Use Address Data Management 
The Address Data Management solution delivers a set of capabilities that help you maintain 

an authoritative address repository, continuously improve the quality of address data, and 

share address information with internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Maintain address inventory 
You will assume the role of a mapping technician responsible for maintaining an inventory of 

road centerlines, valid road names, site addresses, and related mailing addresses. 

The Address Data Management ArcGIS Pro project includes a series of tasks to help guide 

you through these workflows. 

1. Sign in to your ArcGIS organization and browse to the Address Data 
Management Desktop Application Template. 

2. Open the item page and click Download. 

3. Unzip and open the Address Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Address Data 
Management task. 

6. In the Tasks pane, click the How to Use Address Data Management task group to 
expand the collection of tasks. 

 

Add new roads 
Roads are line segments representing centerlines of all roadways or carriageways that 

support address geocoding and mapping. They are also a resource for the agencies 

responsible for the active management of the road network. Typically, this information is 

compiled from orthorectified aerial imagery and record drawings. 

The road features leverage a valid list of road names that can be assigned to a road and 

subsequent site address. The Master Road Names table includes the unique elements of a 

road name (for example, direction, name, and type) and uses an attribute rule to create a full 

road name. To ensure data integrity, the Master Road Names table constrains the road 

names that can be populated in the road centerlines and site addresses. 

The feature classification and type schema for the roads is based on a functional classification 

of roads provided by the Federal Highway Administration (FHWA). Specific attributes and 

default values vary for each feature type. 

To manage the Master Road Name table and add new roads, follow the steps in the Add new 

roads task. 
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Add site addresses 
Site addresses represent the location of a site or service delivery address assigned by a local 

government. Typically, site addresses are placed on top of the associated structure. 

Alternatively, they may be placed at the center of a parcel or in close proximity to the curb cut. 

Site addresses are related to two other address layers: 

• Address points that represent the location along the road network where the specific site 
or service delivery address has been assigned. 

• Entrance points that represent the location where the public, or a service provider, gains 
access to the specific site address. In urban settings, an entrance point can represent a 
driveway for a home that is on a corner lot and the address is assigned off an adjacent 
road. In rural areas, an entrance point can represent a shared driveway that provides 
access to many homes. Entrance points are optional and can be added on a case-by-
case basis. 

Each site address may have one or more postal addresses associated with it. Postal 

addresses provide contact information for the owner or occupant of the building or buildings 

associated with a site address. The Owner / Occupant field indicates whether the postal 

address is for the owner, occupant, or both. 

The feature classification and type schema for the site addresses is based on a status field. 

This status field allows local governments to identify pending, temporary, and current 

addresses. 

To add a new site address and one, or more, related postal addresses and building entrances, 

follow the steps in the Add site addresses task. 

 

Update road names 
Road names may change during the plan review process and as a result, pending road 

names must be updated. When road name changes are made, the changes are pushed to the 

site address features to ensure data integrity is maintained 

To modify a pending road name and update related features, follow the steps in the Update 

road names task. 

 

Split existing roads 
When constructing new roads, existing roads will split at the intersection of the new road and 

the address ranges will be prorated based on the length of each segment. In some cases, 

existing roads may not be split at an intersection or where a boundary (for example, municipal 

boundary) crosses a road. 

To split existing roads at an intersection or where a boundary crosses a road, follow the steps 

in the Split existing roads task. 
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Modify road and address parity 
In some cases, roads were not drawn in the direction of ascending address ranges and the 

direction of the line must be flipped to improve address geocoding. This may also mean the 

address range parity is incorrect and must be flipped as well. 

To modify the road direction or address parity, follow the steps in the Flip roads and swap 

parity task. 

 

Create road intersections 
When creating new roads, existing roads are split at intersections along the new road. An 

inventory of road intersections with the names of relevant crossroads is often required by 911 

systems and to manage right-of-way assets. 

To create road intersections, follow the steps in the Create road intersections task. 

 

Add USNG coordinates 
The United States National Grid (USNG) standard provides a nationally consistent grid 

reference system and creates a more interoperable environment for developing location-

based services within the United States. Some business systems require site address points 

have an associated USNG coordinate. 

To add USNG coordinates to site addresses, follow the steps in the Add USNG 

coordinates task. 

 

Validate address data 
You can use the Address Data Management solution to validate, maintain, and improve the 

integrity of your address data. The solution includes validation and topology rules configured 

on the address layers can help you identify and resolve common errors in your address data. 

To validate address integrity, follow the steps in the Validate address data task. 

 

Request address correction 
You will first assume the role of a resident or member of the public. When attempting to file a 

permit application, you search for an address, but the result is incorrect. You will use 

the Addressing site and Address Request Form to report an erroneous address. 

1. In a browser, go to the Addressing site. 

2. Scroll to the Verify Your Address section and review the story. 

3. In the Master Address Locator search box, enter an address. 

You see suggestions as you type and are able to choose the address from the search 

results. 
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The results show several site addresses in the area. 

4. Click a site address and review the additional details. 

If you do not see an address, or see an error, return to the Addressing site and complete 

the Address Request Form. 

5. Scroll to the Request New Address section and review the story. 

6. Click Request Address. 

7. Complete the survey and click Submit. 

 

Resolve address correction 
You will now assume the role of a supervisor at an addressing authority. As a supervisor, you 

are responsible for assigning field crews to verify missing or incorrect address reports from 

stakeholders. Using the Address Assignments ArcGIS Workforce project, you will create a 

new assignment using the missing address report and assign it to one of your mobile workers. 

1. In a browser, sign in to your ArcGIS organization and click the Apps button  in the 
header of the site. 

2. From the app launcher, click ArcGIS Workforce to open the app. 

3. Click Address Assignments to open the project. 

Tip: 

Workforce projects 

When implementing the Address Data Management solution in your organization, you 
must add anyone responsible for verifying addresses in the field to the Address 
Assignments ArcGIS Workforce project with a Mobile Worker role. You can add users 
and assign roles in the configuration settings of the project. To access configuration 
settings, hover over Address Assignments project and click Configure. Click 
the Users tab. For the purposes of this exercise, ensure your named user account is 
assigned as a dispatcher and as a mobile worker. Click My Projects tab to return to 
your projects. 

4. On the map, select the address you created in the previous section and click the + 
Create Assignment at the bottom of the pop-up window. 

5. From the Create Assignment panel, fill in the following details: 

• For Assignment Type, choose Verify Address. 

• For Assigned to, choose a worker. 

• For Priority, choose Medium. 

• For Due Date, choose tomorrow. 

6. Click Create Assignment. 
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Verify address correction 
You will now assume the role of a mobile worker at an addressing authority. As a mobile 

worker, you are responsible for verifying missing or incorrect address reports. Using 

the Address Assignments ArcGIS Workforce project, you will review and update the status of 

your assignments and open the Address Field Inventory map in ArcGIS Field Maps to verify 

missing addresses. 

1. Download Workforce for ArcGIS and ArcGIS Field Maps apps onto your mobile device. 

2. Open the Workforce for ArcGIS app and sign in to your ArcGIS organization. 

3. Tap the Address Assignments project. 

4. Tap Verify Address from the To Do list. 

5. Tap Start. 

6. Tap Open Field Maps. 

This opens the Address Field Inventory map in ArcGIS Field Maps and defaults to the 

location of the assignment. 

7. Tap the missing address point at the same location. 

8. Tap Edit to modify the details of the address. 

At this point, verify the details of the address and make any necessary changes to the 

attributes and location of the address. 

9. Tap Verified and tap Yes. 

10. Tap Submit (iOS) or the check mark (Android). 

The address point changes from red to green and now reflects any edits you made 

during verification. 

11. Return to the Workforce for ArcGIS app and tap Finish to complete the assignment. 

 

Collect new addresses in field 
You will continue your role as a mobile worker at an addressing authority. You are responsible 

for collecting addresses for a new commercial development in the community. You will use 

the Address Field Inventory map in ArcGIS Field Maps to collect new addresses in the field. 

1. From your mobile device, open the ArcGIS Field Maps app. 

Tap the back arrow, if necessary, to go back to the Maps list. 

2. Tap the Address Field Inventory map. 

3. Tap Add and tap Proposed Site Addresses. 

4. Swipe up and enter the details of the address. 

When adding multiple addresses, they may have common attributes such as the road name 

and municipality. You can create a copy of an existing address point by selecting it and 

tapping Copy. 
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5. Tap Submit (iOS) or the check mark (Android). 

 

Incorporate proposed site addresses 
You will assume the role of a mapping technician responsible for incorporating verified 

proposed site addresses submitted through the Address Request Form or collected in the field 

using Address Field Inventory into your authoritative site address. The Address Data 

Management ArcGIS Pro project can be used to copy and paste these points into your site 

address layer and mark the proposed site address as incorporated. 

1. Open the Address Data Management ArcGIS Pro project. 

2. Click Add Data in the Layer group on the Map tab of the ribbon. 

3. Under Portal browse into My Content and select the ProposedSiteAddresses feature 
layer deployed with the solution. 

4. Click Ok. 

5. Select a verified proposed site address point. 

6. Click the Copy button in the Clipboard group on the Edit tab of the ribbon. 

7. Click the Paste dropdown in the Clipboard group. 

8. Select Paste Special. 

9. From the Paste Special window select Layer and select Site Addresses from the 
dropdown. 

10. Check Keep source attribute values and click Ok. 

11. Select the proposed site address you copied. 

12. From the Attributes pane update the Incorporated field to Yes. 

13. Click Apply. 

The verified proposed site address has been incorporated into your authoritative site 

address layer and marked incorporated. 
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Adopt-A-Stop 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Adopt-A-Stop 
Adopt-A-Stop can be used to operate stop adoption programs that allow volunteers to adopt 

transit stops and clean them for the community. 

A transit ride begins and ends at a stop, and a rider’s overall experience includes not only the 

ride, but their time spent at transit stops. Adopt-A-Stop programs seek to improve this 

experience and reduce maintenance costs by leveraging individual volunteers and 

organizations to clean transit stops. Program volunteers are typically asked to inspect their 

stops, remove trash, and report graffiti or serious damage at regular intervals. This simple 

action has a big impact on rider satisfaction, safety around the stop and the quality of life in a 

neighborhood. Adopt-A-Stop is typically implemented by transit agencies that want to engage 

the community and maximize the capacity of operations staff. 

The Adopt-A-Stop solution delivers a set of capabilities that help you engage volunteers to 

keep transit stops clean, manage participants, and monitor the performance of the adoption 

program. 

 

Requirements 
Adopt-A-Stop requires the following: 

• ArcGIS Enterprise 

• ArcGIS Web AppBuilder (Developer Edition) 2.11 or later 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

• SMTP Server 
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Information products 
Adopt-A-Stop includes the following information products: 

Item Description Minimum user type 

Adopt-A-Stop An ArcGIS Hub site used by the general public 
to learn how to get involved in the Adopt-A-
Stop program 

Not required 

Adopt-A-Stop An ArcGIS Pro project package used by transit 
personnel to configure the Adopt-A-Stop app 
and publish supporting web tools to ArcGIS 
Enterprise 

GIS Professional 
Standard with Web tool 
publisher permission 

Adopt-A-Stop 
Manager 

A Crowdsource Manager app used by transit 
personnel to manage Adopt-A-Stop 
participants 

Editor 

Adopt-A-Stop 
Dashboard 

An ArcGIS Dashboards app used by transit 
personnel to monitor the Adopt-A-Stop 
program 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Adopt-A-Stop 
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Configure Adopt-A-Stop 
Learn how to configure the Adopt-A-Stop solution to meet specific needs in your organization. 

 

Publish the Adopt-A-Stop app 
The Adopt-A-Stop solution includes an ArcGIS Pro project used to publish the Adopt-A-

Stop app. When you are ready to publish the app, a series of tasks are included to help you 

get started. 

 

Get started 
Use the ArcGIS Pro project to familiarize yourself with Adopt-A-Stop. 

1. Sign in to your ArcGIS organization and browse to the Adopt-A-Stop Project Package. 

2. Open the item page and click Download. 

3. Browse to and open the Adopt-A-Stop project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Adopt-A-Stop task. 

6. In the Tasks pane, expand the Getting to Know Adopt-A-Stop task group. 

7. Double-click Understanding Adopt-A-Stop task to review it. 

 

Configure Adopt-A-Stop 
Use the ArcGIS Pro project to set up Adopt-A-Stop. 

1. In the Tasks pane, expand the Configure Adopt-A-Stop task group. 

2. Use the Configure Adopt-A-Stop task group to access several tasks that guide you 
through: 

• Load your transit stops into the AdoptAStops feature layer deployed with the 
solution. 

• Set up a user table in ArcGIS Enterprise to store program participants. 

• Publish the authentication geoprocessing webtool. 

• Configure the Adopt-A-Stop app. 

 

Contact participants 
Use the ArcGIS Pro project to configure tools necessary for contacting participants in 

the Adopt-A-Stop program. 

1. In the Tasks pane, expand the Contact participants task group. 
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The Contact participants task group contains tasks to help you contact program 

participants by sending bulk emails or contacting a selection of participants by local or 

attribute. 

2. Follow the task instructions to configure the bulk email model with your SMTP server and 
contact participants. 

 

Configure the Adopt-A-Stop site 
The Adopt-A-Stop solution includes the Adopt-A-Stop ArcGIS Hub site. This site can be 

configured with your organization's branding and used to share information about the Adopt-A-

Stop program with the public. 

 

Update with organizational information 
After deploying the Adopt-A-Stop solution, the Adopt-A-Stop Hub site layout only requires a 

few updates to fit your local context. 

To update the site with your organizational information, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-
Stop site. 

2. From the item page, click Configure. 

3. Scroll to the statistics section under the Hub site title. 

The Stops Adopted and Cleaned This Month summary statistic cards are already 
linked to the Adopt-A-Stop solution’s AdoptAStops_public feature layer. These statistics 
automatically update as participants adopt stops and report cleanings using the Adopt-A-
Stop app. 

The Volunteers statistic is provided in a text card styled to resemble the summary 
statistic cards, but you can manually enter a statistic of your choice, independent of the 
solution data. You can update the Volunteers text card with the number of program 
participants, a metric of your choice, or you can replace the text card with a summary 
statistics card and connect it to the AdoptAStops_public feature layer in a similar fashion 
to the other dynamic statistics cards. 

4. To update the Volunteers card, hover over the card, click the edit pencil , and update 
the text. 

Note: 
To add a summary statistics card to the existing row, see Display key metrics. Then, 
after the card has been added to the row, hover over the existing Volunteers card and 

click the delete button . 

5. Scroll to the Adopt a Stop section, hover over the card, and click the edit pencil. 

6. Click the Adopt Stop button and click the Edit button. 
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7. Type the Adopt-A-Stop app URL published using the Adopt-A-Stop ArcGIS Pro project 
into the Link Destination text box and click Add Link. 

Tip: 
Browse to the Adopt-A-Stop app. Open the item page, click View Application, and 
copy the app URL. 

8. Scroll to any additional sections that you want to update, hover over the card, and click 

the edit pencil  that appears in the horizontal toolbar, and then edit the content with 
information specific to your organization. 

9. In the side panel, click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

10. Click the HTML text box. 

The HTML window appears. 

11. Make the necessary changes and click Apply. 

12. Click Save. 

13. Click the Save drop-down arrow and click Publish Draft. 

 

Share items with the public 
Several layer views, maps and apps included in the Adopt-A-Stop solution must be shared 

with everyone so they can be accessed by the public on the Adopt-A-Stop site. 

To share items with the public, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-
Stop folder. 

2. Next to each of the following items, check the check box: 

Name Item type 

AdoptAStops_public Feature layer (hosted, view) 

Adopt-A-Stop Web Map 

Adopt-A-Stop Web Mapping Application 

Adopt-A-Stop Site Application 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 
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Deploy a related solution 
This site references content from the Transit Outreach solution. To deploy the Transit 

Outreach solution, follow the steps in the Deploy an ArcGIS Solution section. 

 

Update solution references 
After you have deployed the Transit Outreach solution, you can access Transit 

Outreach items from the Adopt-A-Stop site. 

To update your site with an item from Transit Outreach, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-
Stop site. 

2. From the item page, click Configure. 

3. Scroll to the Report a Problem section, hover over the Submit a Report card, and click 

the edit pencil . 

4. Click Submit Report and click the Edit button. 

5. In a separate browser tab or window opened to your ArcGIS organization, browse to 
the Transit Outreach folder and open the Transit Rider Reporter form item page. 

6. Click Open in Survey123 and choose Open in browser, and then copy the URL. 

7. In the Adopt-A-Stop site, paste the Transit Rider Reporter form URL into the Link 
Destination text box and click Add Link. 

8. Hover over the Contact Call Center text card and click the edit pencil. 

9. Edit the text with information applicable to your organization. 

10. Click Save. 

11. Click the Save drop-down arrow and click Publish Draft. 

 

Share other solution items with the public 
Several layer views, maps and apps included in the Transit Outreach solution must be shared 

with everyone so they can be accessed by the public on the Adopt-A-Stop site. 

To share items with the public, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transit 
Outreach folder. 

2. Next to each of the following items, check the check box: 

Name Item 

TransitRiderReports_public Feature layer (hosted, view) 

Transit Rider Reporter Form 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 
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The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

 

Adopta widget settings 
The Adopt-A-Stop app uses the Adopta widget with preconfigured settings and actions. 

Optionally, you can modify and expand the Adopta widget’s settings to meet your 

organization's needs. Use the tables below to understand the Adopta widget's configuration 

settings and capabilities. 

 

Layer and Authentication settings 
The Layer and Authentication settings allow you to configure behaviors as well as the look 

and feel of the user interface. 

Setting Description 

Asset 
nickname field 

Field that stores the stop's nickname. 

Login screen 
message 

Message that appears when signing in to the application. 

Additional 
signup field 

Fields in the UserTable to be displayed in the sign up form in addition to 
email—for example, add first and last name, address, and phone number. 

Show asset 
address 

Display the reverse geocoded address of a stop in the details view. 

Asset highlight 
color 

Color of selection symbol displayed around the stop symbol when it is 
selected on the map. 

Tolerance 
setting 

New stops are created if no asset is found within the tolerance. 

My asset 
symbol 

Choose a symbol and set the size of user-adopted stops. 

 

Actions 
The primary actions used for the Adopt-A-Stop app are assign (Adopt) and unassign (Opt 

out). You can configure additional actions as needed. 

Setting Description 

Assign status 
settings 

Allows you to label the button (Adopt) in the asset detail view and 
specify additional actions that occur after clicking the assign status 
button. 

Unassigned 
status settings 

Allows you to configure the unassigned label (Abandoned) in the asset 
detail view and specify additional actions that occur after clicking the 
unassigned label. 

Additional status 
settings 

Allows you add additional actions you want adopters to report on—for 
example, damaged stops. 

Primary Status Displays text and status buttons in the Adopta application—for 
example, Is the stop cleaned? 
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Before action 
image 

Image that is displayed before performing an action. 

After action 
image 

Image that is displayed after performing an action. 

 

Messages 
The Adopt-A-Stop app displays messages based on user interaction—for example, Thank you 

for adopting stop name. You can modify the messages or create additional messages 

according to your organization’s needs. 

Setting Description 

Assign Message displayed when an asset is successfully assigned. Use 
'${assetTitle}', for example, to display the title of asset in message. 

Unassign Message displayed when an asset is successfully unassigned. 

Action Message displayed when action is successfully completed. Use 
'${actionName}', for example, to display the name of action in 
message. 

Asset not found Message displayed when asset is not found. 

Asset already 
assigned 

Message displayed when asset is already assigned. Use 
'${assetTitle}', for example, to display the title of asset in message. 

Unable to perform 
action 

Message displayed when action is not successful. Use 
${actionName}, for example, to display the name of the action 
message. 

Asset creation Message displayed when creating an asset. Use ${layerName}, for 
example, to display the name of the layer in message. 

Create asset failed Message displayed when asset creating fails. 

User token expired Message displayed when user token is expired and generated. 

Signup/Login 
success 

Message displayed after successful sign up or log in. 

Home screen (when 
logged in) 

Message displayed in widgets home screen after user logs into the 
application. 

Cursor tooltip before 
login 

Message displayed when the user hovers over the map with their 
pointer before logging in to the application. 

Cursor tooltip after 
login 

Message displayed when the user hovers over the map with their 
pointer after logging in to the application. 

Nickname hint The text displayed in the nickname hint text box. 

 

 

 

Use Adopt-A-Stop 
The Adopt-A-Stop solution delivers a set of capabilities that help you engage volunteers to 

keep transit stops clean, manage participants, and monitor the performance of the adoption 

program. 
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In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 
Use your organization's data or configured apps to follow these workflows. 

 

Adopt a stop 
First, you’ll assume the role of a transit rider who wants to participate in your local transit 

agency’s adopt-a-stop program. You’ll use the Adopt-A-Stop app to submit an adoption 

request and report the stop is clean. 

1. In a browser, from the Adopt-A-Stop solution, view the Adopt-A-Stop site. 

2. Scroll to the Adopt-A-Stop section, and then click Adopt Stop to open the Adopt-A-
Stop app. 

3. In the panel on the right, type your email address, and then click Login/Sign Up to sign 
up and begin the adoption process. 

4. In the form, type your contact details, and then click Sign Up. 

The Adopt-A-Stop app sends an email with program details and a link that you will use to 
log in to the app. 

5. In the email, click Login. 

Returning users also receive an email with a link used to sign in to the app. 

The Adopt-A-Stop app opens in a browser with your newly created user authenticated. 
Notice the instructions to select a stop on map to adopt. 

6. Select an available stop to adopt (the gray symbols on the map). Optionally, add a 
nickname to your stop in the text box. Click Adopt. 

Adopt-A-Stop displays a thank you message. The Adopt-A-Stop pane displays your stop 
as Adoption Pending and allows you to report if the stop is clean or to opt out of adopting 
the stop. You can use the Adopt-A-Stop app to regularly report cleanings. 

 

Manage adoptions and participants 
You are now a transit agency employee managing the stop adoption program. You will use 

the Adopt-A-Stop Manager app to approve adoption requests and contact program 

participants. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-
Stop solution. 

2. View the Adopt-A-Stop Manager app. 

Pending and adopted stop requests are listed in the table at the top. The table can be sorted 
and filtered in various ways. 

3. In the table, click the Adoption Status column filter, and then for Status is, 
choose Pending. 
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4. Click the Date Adopted column header and choose Sort in descending order. 

The pending adoption requests are now listed with the most recent request at the top. 

5. Select a pending adoption request from the table. 

The map selects the stop and zooms to the appropriate location, and the request details 
open at the bottom left. 

6. Review the details. 

7. In the details, click the participant’s email address to share information about your Adopt-
A-Stop program with the participant. 

Adopt-A-Stop Manager opens your email client and presents a preformatted subject. 

After contacting the participant, you are ready to approve the adoption request. 

8. In the Adopt-A-Stop Manager app, in the request details, click the Edit record button 
. 

9. For Adoption Status, choose Adopted. 

10. Optionally, modify the nickname to ensure it is appropriate to be displayed in Adopt-A-
Stop app. 

11. Click Save. 

12. Optionally, click a record in the table, and then in its details, click Manage Adopter’s 
Stops to launch the Adopt-A-Stop app and manage the stops adopted by the selected 
user. 

You can use this workflow to remove an adopter from a stop, making it available for 
adoption. 

 

Monitor the program 
You will continue your role as a transit agency employee, this time looking to monitor 

the Adopt-A-Stop program. You will use the Adopt-A-Stop Dashboard to review key metrics 

and trends. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-
Stop solution. 

2. View the Adopt-A-Stop Dashboard app. 

The Adopt-A-Stop Dashboard displays new adoptions and cleaning charts by month and 
provides management a quick view of program activity over time. 

3. On the left, adjust filters to explore transit stop status, type, date adopted and last 
cleaned. 

Note: 
Dashboard charts are linked. If you click a month in either New Adoptions by 
Month or Cleanings by Month charts, related details are filtered and updated in other 
elements in the dashboard. 

4. On the right, select a stop from the list to view key details. Alternatively, click a stop on 
the map. 
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5. Optionally, in a pop-up, click Manage Stop in the pop-up to launch the Adopt-A-Stop 
Manager app. 
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Configure Adopt-A-Stop 
Learn how to configure the Adopt-A-Stop solution to meet specific needs in your organization. 

 

Publish the Adopt-A-Stop app 
The Adopt-A-Stop solution includes an ArcGIS Pro project used to publish the Adopt-A-

Stop app. When you are ready to publish the app, a series of tasks are included to help you 

get started. 

 

Get started 
Use the ArcGIS Pro project to familiarize yourself with Adopt-A-Stop. 

1. Sign in to your ArcGIS organization and browse to the Adopt-A-Stop Project Package. 

2. Open the item page and click Download. 

3. Browse to and open the Adopt-A-Stop project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Adopt-A-Stop task. 

6. In the Tasks pane, expand the Getting to Know Adopt-A-Stop task group. 

7. Double-click Understanding Adopt-A-Stop task to review it. 

 

Configure Adopt-A-Stop 
Use the ArcGIS Pro project to set up Adopt-A-Stop. 

1. In the Tasks pane, expand the Configure Adopt-A-Stop task group. 

2. Use the Configure Adopt-A-Stop task group to access several tasks that guide you 
through: 

• Load your transit stops into the AdoptAStops feature layer deployed with the 
solution. 

• Set up a user table in ArcGIS Enterprise to store program participants. 

• Publish the authentication geoprocessing webtool. 

• Configure the Adopt-A-Stop app. 

 

Contact participants 
Use the ArcGIS Pro project to configure tools necessary for contacting participants in 

the Adopt-A-Stop program. 

1. In the Tasks pane, expand the Contact participants task group. 
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The Contact participants task group contains tasks to help you contact program 

participants by sending bulk emails or contacting a selection of participants by local or 

attribute. 

2. Follow the task instructions to configure the bulk email model with your SMTP server and 
contact participants. 

 

Configure the Adopt-A-Stop site 
The Adopt-A-Stop solution includes the Adopt-A-Stop ArcGIS Hub site. This site can be 

configured with your organization's branding and used to share information about the Adopt-A-

Stop program with the public. 

 

Update with organizational information 
After deploying the Adopt-A-Stop solution, the Adopt-A-Stop Hub site layout only requires a 

few updates to fit your local context. 

To update the site with your organizational information, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-
Stop site. 

2. From the item page, click Configure. 

3. Scroll to the statistics section under the Hub site title. 

The Stops Adopted and Cleaned This Month summary statistic cards are already 
linked to the Adopt-A-Stop solution’s AdoptAStops_public feature layer. These statistics 
automatically update as participants adopt stops and report cleanings using the Adopt-A-
Stop app. 

The Volunteers statistic is provided in a text card styled to resemble the summary 
statistic cards, but you can manually enter a statistic of your choice, independent of the 
solution data. You can update the Volunteers text card with the number of program 
participants, a metric of your choice, or you can replace the text card with a summary 
statistics card and connect it to the AdoptAStops_public feature layer in a similar fashion 
to the other dynamic statistics cards. 

4. To update the Volunteers card, hover over the card, click the edit pencil , and update 
the text. 

Note: 
To add a summary statistics card to the existing row, see Display key metrics. Then, 
after the card has been added to the row, hover over the existing Volunteers card and 

click the delete button . 

5. Scroll to the Adopt a Stop section, hover over the card, and click the edit pencil. 

6. Click the Adopt Stop button and click the Edit button. 
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7. Type the Adopt-A-Stop app URL published using the Adopt-A-Stop ArcGIS Pro project into 
the Link Destination text box and click Add Link. 

Tip: 
Browse to the Adopt-A-Stop app. Open the item page, click View Application, and 
copy the app URL. 

8. Scroll to any additional sections that you want to update, hover over the card, and click the 

edit pencil  that appears in the horizontal toolbar, and then edit the content with 
information specific to your organization. 

9. In the side panel, click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

10. Click the HTML text box. 

The HTML window appears. 

11. Make the necessary changes and click Apply. 

12. Click Save. 

13. Click the Save drop-down arrow and click Publish Draft. 

 

Share items with the public 
Several layer views, maps and apps included in the Adopt-A-Stop solution must be shared 

with everyone so they can be accessed by the public on the Adopt-A-Stop site. 

To share items with the public, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-
Stop folder. 

2. Next to each of the following items, check the check box: 

Name Item type 

AdoptAStops_public Feature layer (hosted, view) 

Adopt-A-Stop Web Map 

Adopt-A-Stop Web Mapping Application 

Adopt-A-Stop Site Application 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 
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Deploy a related solution 
This site references content from the Transit Outreach solution. To deploy the Transit 

Outreach solution, follow the steps in the Deploy an ArcGIS Solution section. 

 

Update solution references 
After you have deployed the Transit Outreach solution, you can access Transit 

Outreach items from the Adopt-A-Stop site. 

To update your site with an item from Transit Outreach, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-
Stop site. 

2. From the item page, click Configure. 

3. Scroll to the Report a Problem section, hover over the Submit a Report card, and click 

the edit pencil . 

4. Click Submit Report and click the Edit button. 

5. In a separate browser tab or window opened to your ArcGIS organization, browse to 
the Transit Outreach folder and open the Transit Rider Reporter form item page. 

6. Click Open in Survey123 and choose Open in browser, and then copy the URL. 

7. In the Adopt-A-Stop site, paste the Transit Rider Reporter form URL into the Link 
Destination text box and click Add Link. 

8. Hover over the Contact Call Center text card and click the edit pencil. 

9. Edit the text with information applicable to your organization. 

10. Click Save. 

11. Click the Save drop-down arrow and click Publish Draft. 

 

Share other solution items with the public 
Several layer views, maps and apps included in the Transit Outreach solution must be shared 

with everyone so they can be accessed by the public on the Adopt-A-Stop site. 

To share items with the public, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transit 
Outreach folder. 

2. Next to each of the following items, check the check box: 

Name Item 

TransitRiderReports_public Feature layer (hosted, view) 

Transit Rider Reporter Form 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 
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The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

 

Adopta widget settings 
The Adopt-A-Stop app uses the Adopta widget with preconfigured settings and actions. 

Optionally, you can modify and expand the Adopta widget’s settings to meet your 

organization's needs. Use the tables below to understand the Adopta widget's configuration 

settings and capabilities. 

 

Layer and Authentication settings 
The Layer and Authentication settings allow you to configure behaviors as well as the look 

and feel of the user interface. 

Setting Description 

Asset 
nickname field 

Field that stores the stop's nickname. 

Login screen 
message 

Message that appears when signing in to the application. 

Additional 
signup field 

Fields in the UserTable to be displayed in the sign up form in addition to 
email—for example, add first and last name, address, and phone number. 

Show asset 
address 

Display the reverse geocoded address of a stop in the details view. 

Asset highlight 
color 

Color of selection symbol displayed around the stop symbol when it is 
selected on the map. 

Tolerance 
setting 

New stops are created if no asset is found within the tolerance. 

My asset 
symbol 

Choose a symbol and set the size of user-adopted stops. 

 

Actions 
The primary actions used for the Adopt-A-Stop app are assign (Adopt) and unassign (Opt 

out). You can configure additional actions as needed. 

Setting Description 

Assign status 
settings 

Allows you to label the button (Adopt) in the asset detail view and 
specify additional actions that occur after clicking the assign status 
button. 

Unassigned 
status settings 

Allows you to configure the unassigned label (Abandoned) in the asset 
detail view and specify additional actions that occur after clicking the 
unassigned label. 

Additional status 
settings 

Allows you add additional actions you want adopters to report on—for 
example, damaged stops. 

Primary Status Displays text and status buttons in the Adopta application—for 
example, Is the stop cleaned? 
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Before action 
image 

Image that is displayed before performing an action. 

After action 
image 

Image that is displayed after performing an action. 

 

Messages 
The Adopt-A-Stop app displays messages based on user interaction—for example, Thank you 

for adopting stop name. You can modify the messages or create additional messages 

according to your organization’s needs. 

Setting Description 

Assign Message displayed when an asset is successfully assigned. Use 
'${assetTitle}', for example, to display the title of asset in message. 

Unassign Message displayed when an asset is successfully unassigned. 

Action Message displayed when action is successfully completed. Use 
'${actionName}', for example, to display the name of action in 
message. 

Asset not found Message displayed when asset is not found. 

Asset already 
assigned 

Message displayed when asset is already assigned. Use 
'${assetTitle}', for example, to display the title of asset in message. 

Unable to perform 
action 

Message displayed when action is not successful. Use 
${actionName}, for example, to display the name of the action 
message. 

Asset creation Message displayed when creating an asset. Use ${layerName}, for 
example, to display the name of the layer in message. 

Create asset failed Message displayed when asset creating fails. 

User token expired Message displayed when user token is expired and generated. 

Signup/Login 
success 

Message displayed after successful sign up or log in. 

Home screen (when 
logged in) 

Message displayed in widgets home screen after user logs into the 
application. 

Cursor tooltip before 
login 

Message displayed when the user hovers over the map with their 
pointer before logging in to the application. 

Cursor tooltip after 
login 

Message displayed when the user hovers over the map with their 
pointer after logging in to the application. 

Nickname hint The text displayed in the nickname hint text box. 
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Use Adopt-A-Stop 
The Adopt-A-Stop solution delivers a set of capabilities that help you engage volunteers to 

keep transit stops clean, manage participants, and monitor the performance of the adoption 

program. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 
Use your organization's data or configured apps to follow these workflows. 

 

Adopt a stop 
First, you’ll assume the role of a transit rider who wants to participate in your local transit 

agency’s adopt-a-stop program. You’ll use the Adopt-A-Stop app to submit an adoption 

request and report the stop is clean. 

1. In a browser, from the Adopt-A-Stop solution, view the Adopt-A-Stop site. 

2. Scroll to the Adopt-A-Stop section, and then click Adopt Stop to open the Adopt-A-
Stop app. 

3. In the panel on the right, type your email address, and then click Login/Sign Up to sign up 
and begin the adoption process. 

4. In the form, type your contact details, and then click Sign Up. 

The Adopt-A-Stop app sends an email with program details and a link that you will use to 
log in to the app. 

5. In the email, click Login. 

Returning users also receive an email with a link used to sign in to the app. 

The Adopt-A-Stop app opens in a browser with your newly created user authenticated. 
Notice the instructions to select a stop on map to adopt. 

6. Select an available stop to adopt (the gray symbols on the map). Optionally, add a 
nickname to your stop in the text box. Click Adopt. 

Adopt-A-Stop displays a thank you message. The Adopt-A-Stop pane displays your stop 
as Adoption Pending and allows you to report if the stop is clean or to opt out of adopting 
the stop. You can use the Adopt-A-Stop app to regularly report cleanings. 

 

Manage adoptions and participants 
You are now a transit agency employee managing the stop adoption program. You will use 

the Adopt-A-Stop Manager app to approve adoption requests and contact program 

participants. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-
Stop solution. 
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2. View the Adopt-A-Stop Manager app. 

Pending and adopted stop requests are listed in the table at the top. The table can be sorted 
and filtered in various ways. 

3. In the table, click the Adoption Status column filter, and then for Status is, 
choose Pending. 

4. Click the Date Adopted column header and choose Sort in descending order. 

The pending adoption requests are now listed with the most recent request at the top. 

5. Select a pending adoption request from the table. 

The map selects the stop and zooms to the appropriate location, and the request details 
open at the bottom left. 

6. Review the details. 

7. In the details, click the participant’s email address to share information about your Adopt-
A-Stop program with the participant. 

Adopt-A-Stop Manager opens your email client and presents a preformatted subject. 

After contacting the participant, you are ready to approve the adoption request. 

8. In the Adopt-A-Stop Manager app, in the request details, click the Edit record button . 

9. For Adoption Status, choose Adopted. 

10. Optionally, modify the nickname to ensure it is appropriate to be displayed in Adopt-A-
Stop app. 

11. Click Save. 

12. Optionally, click a record in the table, and then in its details, click Manage Adopter’s 
Stops to launch the Adopt-A-Stop app and manage the stops adopted by the selected 
user. 

You can use this workflow to remove an adopter from a stop, making it available for 
adoption. 

 

Monitor the program 
You will continue your role as a transit agency employee, this time looking to monitor 

the Adopt-A-Stop program. You will use the Adopt-A-Stop Dashboard to review key metrics 

and trends. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-
Stop solution. 

2. View the Adopt-A-Stop Dashboard app. 

The Adopt-A-Stop Dashboard displays new adoptions and cleaning charts by month and 
provides management a quick view of program activity over time. 

3. On the left, adjust filters to explore transit stop status, type, date adopted and last cleaned. 

Note: 
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Dashboard charts are linked. If you click a month in either New Adoptions by 
Month or Cleanings by Month charts, related details are filtered and updated in other 
elements in the dashboard. 

4. On the right, select a stop from the list to view key details. Alternatively, click a stop on the 
map. 

5. Optionally, in a pop-up, click Manage Stop in the pop-up to launch the Adopt-A-Stop 
Manager app. 
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AED Inventory 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to AED Inventory 
AED Inventory can be used to maintain an inventory of automated external defibrillators 

(AEDs) and share the location of AEDs with internal stakeholders and the public. 

An AED is a portable electronic device that automatically diagnoses the life-threatening 

cardiac arrhythmias and is able to treat them through defibrillation. Defibrillators are typically 

found in office buildings, airports, educational facilities, and other locations where people 

congregate. Proactively managing and communicating AED information helps dispatchers 

inform first responders when a cardiac emergency occurs. AED Inventory is typically 

implemented by public safety agencies that want to have a single catalog of AEDs and share 

this information with internal stakeholders and the public. 

The AED Inventory solution delivers a set of capabilities that help you inventory AEDs, share 

authoritative AEDs with computer aided dispatch systems or consumer applications, and 

inform the public. 

 

Requirements 
AED Inventory requires the following: 

• ArcGIS Enterprise 

 

Information products 
AED Inventory includes the following information products: 

Item Description Minimum user 
type 

AED 
Inventory 

An ArcGIS Survey123 form used by fire personnel to 
inventory automated external defibrillators (AEDs) 

Editor 

AED 
Inventory 

A map used by internal stakeholders to locate AEDs near a 
given location 

Viewer 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of AED Inventory 
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Configure AED Inventory 
AED Inventory can be used to inventory automated external defibrillators (AEDs) and share 

the location of AEDs with internal stakeholders and the public. 

In this topic, you'll learn how to configure the AED Inventory solution to meet specific needs in 

your organization. 

 

Modify AED Inventory survey 
The AED Inventory solution includes a survey that can be used to inventory defibrillators. 

Review the preconfigured questions and align the survey with your organizational policies and 

desired outcomes. 

To modify the AED Inventory survey, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the AED Inventory form. 

2. Open the item page and click Open in Survey 123 > Manage in Survey123 website. 

3. Click the Design tab. 

4. Make your edits to the survey and save the changes. 

5. Click Publish twice. 
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Use AED Inventory 
The AED Inventory solution delivers a set of capabilities that help you inventory AEDs, share 

authoritative AEDs with computer aided dispatch systems or consumer applications, and 

inform the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect defibrillators in the field 
In many cases, a field assessment of existing automated external defibrillators (AEDs) may be 

the most efficient way to develop an AED inventory. The information collected in the field can 

then be shared with internal stakeholders and the public. 

You will assume the role of a mobile worker in a public safety agency. In this workflow, you 

have been asked to use ArcGIS Survey123 to access your AED Inventory form and inventory 

defibrillators in your community. 

1. On your mobile device, in ArcGIS Survey123, open the AED Inventory form. 

Tip: 

The form can also be accessed from a browser by signing in to your ArcGIS 
organization, browsing to the AED Inventory form, and choosing to open the form in a 
browser. 

2. Tap Collect. 

3. Complete the form with as much information as possible. 

Note: 

Required information is marked with a red asterisk. 

Tip: 

Automated external defibrillators (AEDs) can be inventoried in the office on a desktop 
computer or in the field from your mobile device. If you allow your browser to access 
your location while in the field, your current location can also be used to inventory an 
automated external defibrillator. 

4. Tap the check mark to submit the form, and then tap Send now. 

5. Repeat these steps for each AED. 

Tip: 
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You can share the URL to the AED Inventory form with your mobile workers so they 
can access the survey form directly on their device. When they click on the URL, they 
will be asked to sign in to your ArcGIS organization before completing the survey. 

 

Locate a defibrillator 
Communicating automated external defibrillator information helps public safety staff locate the 

closest defibrillator. The AED Inventory map can be used to communicate automated external 

defibrillator alternatives and locate one nearby. 

 

Find a defibrillator 
You will assume the role of a public safety staff member. In this workflow, you are interested 

in locating a defibrillator near a given location in a downtown or neighborhood. 

1. Sign in to your ArcGIS organization, and then browse to the AED Inventory solution. 

2. Open the AED Inventory map in Map Viewer. 

Tip: 

You can share the URL to the AED Inventory map with your public safety staff so they 
can access the map directly on their device. When they click on the URL, they will be 
asked to sign in to your ArcGIS organization before accessing the map. 

3. On the right, in the Settings (light) toolbar, click Search. 

Tip: 

If you do not see Search in the toolbar, click Map tools and choose Search. 

4. In the search box, type the location. 

The results show any automated external defibrillators in the area. 

5. On the map, click a defibrillator and review the additional details. 

If you do not see a defibrillator, zoom out to a larger area. 
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Agricultural Best Management Practices 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Agricultural Best Management 

Practices 
Agricultural Best Management Practices can be used to enroll agricultural producers in best 

management practice programs and monitor the success of those programs. 

It simplifies the enrollment and verification process in best management practice programs 

and helps agriculture agencies promote efficient water resource practices. Monitoring 

enrollment and verification data in near real time allows program managers to target outreach 

efforts where they are needed to ensure water quality for everyone. Agricultural Best 

Management Practices is typically implemented by agriculture agencies and other government 

agencies that want to increase participation in best management practice programs. 

The Agricultural Best Management Practices solution delivers a set of capabilities that help 

you enroll participants in best management practices (BMP) programs, verify those 

participants, and analyze trends in BMP programs. 

 

Requirements 
Agricultural Best Management Practices requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

• Survey123 Connect 
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Information products 
Agricultural Best Management Practices includes the following information products: 

Item Description Minimum 
user type 

Best Management 
Practice Dashboard 

An ArcGIS Dashboards app used by program 
managers to evaluate BMP program status with 
policy makers, stakeholders, and the public 

Viewer 

BMP Enrollment 
Status 

An ArcGIS Dashboards app used by agriculture staff 
to monitor BMP enrollment and verification status 

Viewer 

BMP Enrollment 
Survey 

An ArcGIS Survey123 form used by mobile workers 
to enroll agriculture producers in BMP programs 

Mobile 
Worker 

BMP Verification 
Survey 

An ArcGIS Survey123 form used by mobile workers 
to validate BMP programs in the field 

Mobile 
Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Agricultural Best Management Practices 
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Configure Agricultural Best Management 

Practices 
In this topic, you will learn how to configure the Agricultural Best Management 

Practices solution to meet specific needs in your organization. 

 

Load data 
Agricultural Best Management Practices can be used to enroll and verify agricultural 

producers in best management practice programs and monitor the success of those 

programs. In some cases, you may already have this information in ArcGIS or another 

business system. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the ArcGIS Solution before 

sharing the maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 

workflow below. 

 

Load data from a shapefile 
Load data for the BMPEnrollments and BPMProgramSummary feature layers from a shapefile 

by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Navigate to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you wish to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Agricultural Best Management Practices 
The Agricultural Best Management Practices solution delivers a set of capabilities that help 

you enroll participants in best management practices (BMP) programs, verify those 

participants, and analyze trends in BMP programs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage BMP programs 
The BMP Enrollment Survey can be used by program managers to enroll agricultural 

producers in BMP programs. The BMP Verification Survey verifies that best management 

practices are being followed, while the BMP Enrollment Status dashboard can be used to 

track participation and understand participation trends. 

Enroll participants 
You will assume the role of a mobile worker enrolling agricultural producers in BMP programs. 

1. Download ArcGIS Survey123 to a mobile device, if necessary. 

2. On the mobile device, open the app, and then open the BMP Enrollment Survey form. 

3. Tap Collect. 

4. Complete the survey with as much information as possible. 

5. Tap the check mark, and then tap Send Now to submit the form. 

 

Verify participants 
You will assume the role of a mobile worker verifying agricultural producers enrolled in BMP 

programs are adhering to best management practices. 

1. On a mobile device, in ArcGIS Survey123, open the BMP Verification Survey. 

2. Tap Inbox and, if no surveys appear, tap Refresh. 

3. Find your site in the list or tap Map to find sites near you. 

4. After you find your site, tap it to open the survey. 

5. Scroll to the Verification of Implementation section and update the information. 

6. Tap the check mark, and then tap Send Now. 
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Monitor participation 
You will assume the role of a BMP manager monitoring enrollment and verification trends in 

your BMP program. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Agricultural 
Best Management Practices solution. 

2. View the BMP Enrollment Status app. 

3. Use the dashboard to visualize your data. 

 

Use best management practices metrics 
The Best Management Practice Dashboard can be used by policy makers and constituents to 

understand overall program metrics for watersheds, counties, or legislative boundaries. It is 

typically used to understand how BMP programs are improving water quality, the total number 

of producers, and acres enrolled in BMP programs. 

 

Monitor best management practices metrics 
You will assume the role of a BMP manager monitoring the impact programs are having. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Agricultural 
Best Management Practices solution. 

2. View the Best Management Practice Dashboard. 

3. Use the dashboard to visualize your data. 
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Broadband Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Broadband Outreach 
Broadband Outreach can be used to understand broadband coverage and promote actions 

being taken to address the digital divide. 

In a connected world, access to reliable broadband internet service is essential. Today, the 

FCC estimates that approximately 35% of Americans do not have reliable access to service 

(25MB download / 3MB upload). In some areas, internet access is either limited, unavailable, 

or unaffordable for those in need. Understanding where gaps in broadband coverage exist 

helps governments make smart broadband infrastructure investments and promote equitable 

access. Broadband Outreach is typically implemented by state and local governments that 

want to understand where broadband gaps exist in their community and how actions they are 

taking impact access or needs. 

The Broadband Outreach solution delivers a set of capabilities that help you inventory 

broadband investments and resources, understand broadband coverage in your community, 

and promote actions being taken to address the digital divide. 

 

Requirements 
Broadband Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 Connect 
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Information products 
Broadband Outreach includes the following information products: 

Item Description Minimum 
user type 

Broadband 
Outreach 

An ArcGIS Hub site used by the general public to learn 
more about broadband investments being made and 
how they can help improve coverage maps in order to 
advance digital equity. 

Not 
required 

Broadband Speed 
Test 

An ArcGIS Survey123 form used by the general public 
and businesses to record broadband speed test results 
and feedback. 

Not 
required 

Broadband Survey 
Results 

A Media app used by the general public to view 
Broadband Speed Test survey results. 

Not 
required 

Public WiFi 
Locator 

A Nearby app used by the general public to find public 
WiFi locations. 

Not 
required 

Broadband 
Investments 

An ArcGIS Experience Builder app used by the general 
public and other interested parties to review broadband 
investment projects. 

Not 
required 

Broadband 
Infrastructure 
Inventory 

An ArcGIS Experience Builder app used by program 
analysts to create and edit Public WiFi and broadband 
project locations. 

Editor 

Broadband 
Coverage 
Dashboard 

An ArcGIS Dashboards app used by the director to 
monitor broadband survey metrics. 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Broadband Outreach 
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Configure Broadband Outreach 
Broadband Outreach can be used to understand broadband coverage and promote actions 

being taken to address the digital divide. 

In this topic, you’ll learn how to configure the Broadband Outreach solution to meet specific 

needs in your organization. 

 

Load data 
Broadband projects and WiFi locations can be loaded from a shapefile by completing the 

following steps: 

1. Create a .zip file of a shapefile of the broadband projects. 

2. Sign in to your ArcGIS organization and browse to the BroadbandProjects feature layer. 

3. From the item page, click Update Data > Append Data to Layer. 

4. Click Choose File, browse to the .zip file containing the shapefile with the broadband 

projects, and click Open. 

5. Click Upload and Continue. 

6. Click the Choose the layer to update drop-down arrow and choose Broadband 
Projects. 

7. Uncheck Update existing features. 

8. Click Show field matching to map the fields from the file to the fields in the layer. 

9. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

10. Repeat steps 1-9 to load Wifi locations into the WiFiLocations feature layer. 

 

Modify Broadband Speed Test survey 
To modify the Broadband Speed Test survey reporting area choice list, complete the following 

steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Broadband Speed Test to download the survey. 

4. In the Download window, click Download and click OK. 

5. Click Broadband Speed Test to open the survey. 

6. On the left, from the side toolbar, click the XLSForm button. 
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7. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 

This tab comprises all the selectable options for survey questions. 

8. Update the providerlist choice list to reflect the internet service providers (ISP) available 
in your area. 

9. Revise the survey to reflect your needs. 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

11. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

12. Click Publish survey to publish your changes, and then click OK. 

 

Configure Public WiFi Locator app 
Configurable apps have common configuration options that you may want to extend. The 

Public WiFi Locator app can be extended to allow directions from your current location. 

To configure the Public WiFi Locator app to provide directions to the nearest location, 

complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Public WiFi 
Locator app. 

2. From the item page, click Configure App. 

Close the Welcome to the App Setup Page splash page, if necessary. 

3. In the left side panel, make sure you are in Full Setup mode and click Nearby. 

4. Click Options then click the Show directions toggle button. 

5. Check the check box next to layers you want to include a directions link for. 

6. Click Publish. 

7. Click Confirm. 

The Authorize premium content window appears indicating the number of credits 

consumed. 

8. Click Authorize. 

9. Click Confirm. 

10. Click Launch. 

 

Configure Broadband Outreach site 
The Broadband Outreach solution includes the Broadband Outreach ArcGIS Hub site that 

your organization can configure with your branding and use to share broadband information 

with the public. 
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Update with organizational information 
After deploying the Broadband Outreach solution, the Broadband Outreach site layout only 

requires a few updates to fit your local context. Consider what information you already have 

and what you can most easily find. To update your site, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Broadband 
Outreach site. 

2. From the item page, click Configure. 

3. If necessary, click the Edit button  to open the site editor. 

4. Hover over each image card in the site, click the edit pencil , and update the 
placeholder images with images from your organization. 

5. Scroll to the Additional Resources section, hover over each text card, and click the edit 
pencil. 

6. Update the resources in the text box and repeat for each resource you would like to add. 

7. Scroll to the Frequently Asked Questions section, hover over the card, click the edit 
pencil, and update the questions and answers. 

8. To modify your site’s footer, on the left, click the Customize Toggle button . 

9. In the side panel, click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 

organization's branding, contact information, and social media references. 

10. Click the HTML box. 

The HTML window appears. 

11. Make the necessary changes and click Apply. 

12. Click Save. 

13. In the upper-left corner of the page, click the Exit edit mode button. 

 

Share Broadband Outreach items 
When you deploy the Broadband Outreach solution, it will create a Broadband Outreach site, 

and two Groups (Core Team and Followers) in your ArcGIS organization. Several maps and 

apps included in the Broadband Outreach solution must be shared with the general public so 

they can submit surveys and view broadband information. 

To share the Broadband Outreach maps and apps, follow the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Broadband 
Outreach folder. 

2. Check the check box next to each of the items below: 
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Item Name 

Feature Layer (hosted) BroadbandSpeedTest 

Feature Layer (hosted, view) BroadbandSpeedTest_public 

Feature Layer (hosted, view) BroadbandProjects_public 

Feature Layer (hosted, view) WiFiLocations_public 

Web Map Broadband Investments 

Web Map Broadband Survey Results 

Web Map Public WiFi Locator 

Web Mapping Application Broadband Investments 

Web Mapping Application Broadband Survey Results 

Web Mapping Application Public WiFi Locator 

Form Broadband Speed Test 

Dashboard Broadband Investments Dashboard 

Dashboard Broadband Investments Dashboard Mobile 

Site Application Broadband Outreach 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 

you are sharing editable layers publicly. 

5. Click Update. 

 

Add equity and inclusion app 
Optionally, an equity analysis index can be created by program analysts. Once published it 

can be shared with the general public via a web mapping application. This app can be used to 

see how need is distributed across the community. 

To add an app link to the equity and inclusion section, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Broadband 
Outreach site. 

2. From the item page, click Configure. 

3. If necessary, click the Edit button  to open the site editor. 

4. Scroll to the Equity and Inclusion section, click the edit pencil , and update the button 
hyperlink. 

5. Make the necessary changes and click Apply. 

6. Click Save. 
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7. In the upper-left corner of the page, click the Exit edit mode button. 
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Use Broadband Outreach 
The Broadband Outreach solution delivers a set of capabilities that help you inventory 

broadband investments and resources, understand broadband coverage in your community, 

and promote actions being taken to address the digital divide. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Promote broadband and digital equity programs 
The Broadband Outreach ArcGIS Hub site can be used to promote broadband investments 

and digital equity programs in your community. 

In this section, you'll assume the role of a member of the public and explore broadband and 

digital equity programs in your community. 

 

Submit a broadband access and speed survey 
The Broadband Speed Test survey can be used to help broadband staff to find gaps in high-

speed internet service and identify areas of need. 

1. Sign in to your ArcGIS organization and browse to the Broadband Outreach ArcGIS 
Hub site. 

2. Open the item page and click View. 

3. Navigate to the Current Broadband Coverage section and click the Launch 
Survey button. 

4. Ensure you are connected to your home WiFi network and turn off cellular service if you 
are using a mobile device. 

5. Enter your address in the search box and select the corresponding location from the 
drop-down. 

6. Answer corresponding survey questions and click Submit. 

 

Examine broadband speed test survey results 
The Broadband Survey Results app can be used to examine broadband speed test results. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Broadband 
Outreach ArcGIS Hub site. 

2. Open the item page and click View. 

3. Scroll to the Broadband Survey Results section. 

4. Explore the embedded app to view broadband speed test results. 
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Locate a public WiFi hotspot 
The Public WiFi Locator can be used to find WiFi hotspots that are available for use. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Broadband 
Outreach ArcGIS Hub site. 

2. Open the item page and click View. 

3. Navigate to the WiFi Hotspots section and click the Launch App button. 

4. Enter your address in the search box or click Search this area in the map window. 

5. Explore public WiFi locations and details. 

 

Review broadband investments 
The Broadband Investments app can be used to find information about broadband projects in 

their community. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Broadband 
Outreach ArcGIS Hub site. 

2. Open the item page and click View. 

3. Navigate to the Active Broadband Investments section and click the Launch 
App button. 

4. In the left panel, choose Planned Start Date filters to further explore and refine 
broadband project results. 

5. Click a project from the Projects list to see where the project is located, and to show the 
project detail. 

6. Pan and zoom around the map to refine the list of projects and project details. 

 

Inventory investments and WiFi hotspots 
The Broadband Infrastructure Inventory app can be used by program analysts to create, edit, 

and review investments and WiFi hotspots. New broadband features can be added as new 

WiFi locations or broadband projects go online. 

You'll now assume the role of a program analyst. In this workflow, you are asked to review 

and add new broadband investments and WiFi hotspots. 

 

Edit broadband infrastructure 

1. Sign in to your ArcGIS organization and browse to the Broadband Infrastructure 
Inventory app. 

2. Open the item page and click View. 

3. Select a broadband project on the map. 
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4. Review the attribute information and enter the remaining details for the broadband 
project. 

5. When you're finished, click Update. 

 

Add a new WiFi location 

1. Verify that you are signed in to your ArcGIS organization and browse to the Broadband 
Infrastructure Inventory app. 

2. Open the item page and click View. 

3. In the Editor widget, click New Feature under WiFi Locations. 

4. Add a new WiFi location to the map. 

5. Enter details for the WiFi location, scroll to the bottom of the form, and click Create. 

6. Repeat steps 1-3 for each WiFi location. 

 

Monitor broadband coverage 
The Broadband Coverage Dashboard can be used by the director to understand broadband 

speed test survey results and identify coverage gaps in the community. 

You'll now assume the role of director. In this workflow, you will explore how broadband 

coverage is distributed across the community and analyze survey results to understand 

patterns in access or speed. 

1. Sign in to your ArcGIS organization and browse to the Broadband Coverage 
Dashboard app. 

2. Open the item page and click View Dashboard. 

3. Click the graphs to explore the surveys submitted. 

4. Review indicators to see the range and average download speed, upload speed and ping 
results. 

5. Click the Average Download Speed by ISP graph to see how results vary by provider. 

6. Examine trends in survey responses by survey date, location type, ethnicity and race 
using filters in the left panel. 

7. Click a survey in the map to see additional details. 

 

Analyze broadband equity 
The Social Equity Analysis solution delivers a set of capabilities that can help you understand 

broadband coverage, analyze community characteristics, and generate a broadband equity 

index that can be used to educate internal and external stakeholders. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 82 

In this section, you'll assume the role of a broadband program analyst and use the Social 

Equity Analysis solution to analyze broadband equity. 

 

Deploy the Social Equity Analysis solution 
To perform a broadband equity analysis, complete the following steps: 

1. Sign in to your ArcGIS organization in the ArcGIS Solutions app. 

2. Navigate to the Social Equity Analysis solution and click Deploy Now. 

3. Review licensing requirements and download the Social Equity Analysis Desktop 
Application Template. 

4. Unzip and open the Social Equity Analysis ArcGIS Pro project. 

 

Evaluate conditions and actions 
Use the tasks in the Social Equity Analysis ArcGIS Pro project to summarize and load data 

into your broadband reporting areas. 

1. On the View tab, in the Windows group, click Catalog Pane 

2. In the Catalog pane, expand the Tasks folder, and double-click the Social Equity 
Analysis task. 

3. In the Tasks pane, click the Evaluate Conditions and Actions task group to expand the 
collection of tasks. 

4. In the Tasks pane, double-click the Prepare community asset, condition and 
outcome data task and follow the steps provided. 

5. Review and share results. 

Note: 

In step 3 of the Prepare community asset, condition and outcome data task, when adding 
demographic data to reporting areas, keep the Total Population variable but adjust the 
other variables you’d like to enrich. Some common indicators you may want to use when 
looking at broadband coverage are: 

• HHs w/No Internet Access 

• Population Age 65+ 

• Child Population 

• Median Household Income 

Relevant community characteristics are unique to each geography, you will want to focus 
on the characteristics that matter to your community - use the Broadband Coverage 
Dashboard to help inform your analysis. 
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If you’d like to summarize download and upload speeds by reporting area. In step 5 of 
the Prepare community asset, condition and outcome data task, select the 
BroadbandSpeedTest layer as the Input Summary Features. Under Summary Fields, 
specify the download and upload speed fields and select “Mean” as the corresponding 
statistic. By checking the box next to “Add shape summary attributes” a field will be added 
to the output calculating the number of speed test survey results corresponding to each 
reporting area. 

In step 6 of the Prepare community asset, condition and outcome data task, you can 
normalize broadband coverage by a chosen demographic variable. Using the example 
analysis above an average download/upload speed is already normalized, so you can 
skip this step. 

 

Identify community characteristics 
Use the community indicators data, or enriched variables, from the previous steps and the 

tasks in the Social Equity Analysis ArcGIS Pro project to identify focus variables and find 

areas with a higher preponderance of these factors. 

1. On the View tab, in the Windows group, click Catalog Pane. 

2. In the Catalog pane, expand the Tasks folder, and double-click the Social Equity 
Analysis task. 

3. In the Tasks pane, expand the Tasks folder, click the Identify Community 
Characteristics task group to expand the collection of tasks. 

4. In the Tasks pane, double click the Prepare community characteristic data task, and 
follow the steps provided. 

5. In step 1, set the Enriched Boundaries parameter as the enriched layer with your 
summarized broadband coverage speeds. 

6. In the Focus Factors (High to Low focus variables), click the drop-down and choose 
all variables where high values equate to a higher focus. Following the example, choose: 
HHs w/No Internet Access, Population Age 65+, Child Population. 

7. In the Focus Factors (Low to High focus variables), click the drop-down and choose 
all variables where low values equate to a high focus. Following the example, choose: 
Median Household Income. 

8. Type CommunityCharacteristicsIndex for the Output Layer, click Run. 

9. Review and share results. 

 

Create equity analysis index 
Use the previously generated broadband coverage and community characteristics data from 

the previous steps and the tasks in the Social Equity Analysis ArcGIS Pro project to identify 

and rank need across your reporting areas. 

1. Open the Social Equity Analysis ArcGIS Pro Project. 
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2. On the View tab, in the Windows group, click Catalog Pane 

3. In the Catalog pane, expand the Tasks folder, and double-click the Social Equity 
Analysis task. 

4. In the Tasks pane, click the Create Equity Analysis Index task group to expand the 
collection of tasks. 

5. In the Tasks pane, double-click the Create equity analysis index map task and follow 
the steps provided. 

6. In step 1, set the Input Features parameter as the CommunityCharacteristicsIndex 
created in previous steps. 

7. In the Focus Factors (High to Low focus variables), click the drop-down and choose 
all variables where high values equate to a higher focus. Following the example, there 
are no variables. 

8. In the Focus Factors (Low to High focus variables), click the drop-down and choose 
all variables where low values equate to a high focus. Following the example, choose: 
Average Download Speeds and Rank. 

9. Type EquityAnalysisIndex for the Output Layer, click Run. 

10. Review the created index, and in step 3 share the resulting Equity Analysis Index as a 
web layer. 

 

Publish broadband equity analysis index 
Once the Equity Analysis Index map is shared as a web layer using the Social Equity 

Analysis ArcGIS Pro project, the resulting map can be shared with the general public. To add 

one, or more, layers to a web map, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Equity Analysis Index web map. 

2. Open the item details and click Open in Map Viewer. 

3. In the left pane, click Add, select Browse Layers. 

4. Search for the Equity Analysis Index layer or alternative layer that was shared using the 
Social Equity Analysis tasks. 

5. Click the Add button. 

6. Open the Layer pane, click the Options ellipses on the Equity Analysis Index layer, 
click Zoom to. 

7. Save the map. 

8. Browse to the Equity Analysis Index application, open the item details page and 
click View Application. 

9. The Equity Analysis Index map is now available in the application to be shared. 

 

Explore community need 
Once the Equity Analysis Index is created and shared with the public, it can be used by the 

general public to understand how broadband need is distributed across the community. 
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You'll now assume the role of a member of the general public. You are asked to use the 

Equity Analysis Index app to explore broadband need in the community. 

1. Sign in to your ArcGIS organization and browse to the Equity Analysis Index app. 

2. Open the item page and click View Application. 

3. Search for an address or click a reporting area on the map. 

A popup will display showing the Equity Rank Score and details for the given area. 

4. Review other communities and examine how need is distributed across the region. 

5. The Information tab displays details regarding the map. 

6. Click the Share icon to copy a link or share the app on social media. 
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Business Resilience 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Business Resilience 
Business Resilience can be used to better understand the current status of asset locations. 

Organizations focus on allowing key leaders to have constant awareness of threats to the 

organization. Security and risk teams must be able to have one location that visually 

communicates information to allow decision makers to take action when a threat occurs or a 

status changes at a location. Analysts must create assessment reports based on threats or 

changes to the facility and be able to share these assessments with key leadership at the 

facility level and up to the C-suite level for actionable decision making. Business Resilience is 

typically implemented by organizations that want to take a proactive, data-driven approach to 

plan, manage, and enhance current business operations. 

The Business Resilience solution delivers key leadership the ability to share the status of retail 

stores, manufacturing plants, and other facilities. The solution provides the ability to 

understand and update the current status and review and share operational assessments to 

key leaders. 

 

Requirements 
Business Resilience requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 Connect 
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Information products 
Business Resilience includes the following information products: 

Item Description Minimum 
user type 

Business Resilience 
Web App 

An ArcGIS Web AppBuilder app used by analysts to 
understand, manage, and maintain the operational 
status of an organization 

Editor 

Operational 
Assessment Survey 

An ArcGIS Survey123 form app used by facility 
managers to report the facility status 

Editor 

Facility Manager An ArcGIS Web AppBuilder app used by analysts to 
maintain an organization's facility information 

Editor 

FacilitySource An Excel document used to load and validate an 
authoritative list of facilities into ArcGIS 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • An update to the Operational Assessment Survey to support multiple images 
and automates contact data entry. 

• An update to the facility layer symbology. 

• An update to the facility and operational assessment layer schemas. 

1.0 • First release of Business Resilience 
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Configure Business Resilience 
In this topic, you will learn how to configure the Business Resilience solution to meet specific 

needs in your organization. 

 

Prevent duplicate records 
To support the updating of data using the Append Data to Layer and to ensure accurate 

statistics within the information products of the solution. You'll need to add an attribute index 

which applies a unique constraint to facility_id field in the facilities layer. 

To add an unique constraint, complete the steps below: 

1. Sign in to your ArcGIS Enterprise portal. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Facilities in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. On the right side of the page, click Facilities to view it details. 

6. Under the Layers section, click Facilities. 

7. In the URL section, click View. 

A new tab opens into the ArcGIS REST Service Directory for this item. 

8. In the URL bar of the browser, edit the URL with the following changes: 

a. Add the word admin between /rest/ and /services/. (For example: 
ArcGIS/rest/admin/services/facilities.) 

b. Scroll to the bottom of the page and click on Add to Definition. 

c. A window appears where you will be entering JSON to add an index to the layer. 

d. In the text box, copy the following: 

{ 

"indexes" : [{ 

"name" : "facility_id_Index", 

"fields" : "facility_id", 

"isAscending" : false, 

"isUnique" : true, 

"description" : "" 

}] 

} 

e. Click Add To Layer Definition to commit update. 

The following message will appear if add was successful. {"success": true} 

9. In the browser, return to the Facilities layer tab and click on the Data tab. 
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10. Click the Fields and click on Facility ID. 
This page reveals the properties for the facility_id field. Under Settings, the Unique field 
is set to Yes. 

 

Load data 
Organizations can use Business Resilience as a source of information to understand risk to 

their company’s critical infrastructure. 

Facility information must be loaded before using the app. Use the FacilitySource file to 

organize facility information before loading it into ArcGIS. Ensure that you populate the Facility 

ID column with unique values in the FacilitySource file. 

Note: 

Each row in the FacilitySource Excel document must have a unique facility ID; otherwise, 
your data will not load correctly. 

In some cases, you may already have an inventory of facilities in ArcGIS. If you do, review the 

layers provided with the solution and determine what, if any, source data you would like to 

load. Then, load your existing data into the layers provided with the ArcGIS Solution before 

sharing the maps or applications. 

Note: 

If you need to load data into the solution, you may want to develop a source-target matrix 
to track how your source data will be loaded into the target layer or layers used in the 
solution. 

To load your facilities from a spreadsheet, complete the steps below: 

1. If necessary, sign in to your ArcGIS organization and browse to the FacilitySource item. 

2. Open the item details page. 

3. Click Download. 

4. Edit the Excel file and populate your facility information in the document. When complete, 
save the spreadsheet tab containing your data as a CSV file. 

Note: 

At a minimum, you need to provide a unique facility ID and the latitude and longitude 
for each facility in the FacilitySource file. If you don't have a unique ID, you can edit 
the Excel file and copy this formula into the first row of the facilityid column: 
=CONCATENATE("Facility-", TEXT(ROW(A1),"00000")). You can then drag the right 
corner of the cell downward to fill the formula for all facilities, giving each a unique ID. 

5. In your ArcGIS organization, at the top of the site, click Content. 

6. On the My Content tab, type facilities in the search box. 
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7. On the left under Folders, click the folder Business Resilience was deployed to. 

8. Click the item title for Facilities to view its details. 

9. Click Update Data and click Append Data to Layer. 

10. Under Filename, choose your CSV. 

11. Click Upload and Continue. 

12. Uncheck Update existing features 

Note: 

If features exist in the layer that you would like to update, do not uncheck. 

13. Click Show field matching to map the fields. 

Note: 

While field matching is auto mapped ensure that the fields are properly mapped. 

14. Click Apply Updates. 

 

Configure the survey form 
To show your facility information in the survey form, you will use ArcGIS Survey123 

Connect to make necessary updates. Adding your facility information to the form enables an 

extra level of data validation to ensure that facility information is correct and the respondent’s 

questions are associated with the correct facility. 

 

Open the form using ArcGIS Survey123 Connect 
If Survey123 Connect is not already downloaded, you can find the download link on 

the ArcGIS Survey123 Resources page. 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Operational Assessment Survey in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Operational Assessment Survey to view its details. 

6. Click Open in Survey123 and click Edit in Survey123 Connect. 

ArcGIS Survey123 Connect opens. 

Note: 

If this is your first time opening ArcGIS Survey123 Connect, you may need to add your 
organization’s portal and sign in. To add the URL, click Settings. Then, in 
the Settings window, click Add Connection and paste the URL. Click OK. After 
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adding the connection, click Sign in to sign in to your organization. Verify that the 
active connection is set to the correct URL. 

7. Click the Operational Assessment Survey form to download the survey. 

8. Click the Operational Assessment Survey form again to open the survey. 

 

Update survey form with Facilities service URL 
The survey form is configured to pass values from the Facilities layer and populate questions 

based on a custom URL scheme using the facility ID. To get the URL for the facility layer, 

open your browser and complete the following steps. 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Facilities in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Facilities to view its details. 

6. Under the Layers section, click Facilities. 

7. In the lower right section name URL, click the Copy button to copy to your clipboard. 

Note: 

The service URL should include the layer reference index /0. For example: 

https://services9.arcgis.com/9S3xKDKM8mHbxXx/arcgis/rest/services/Faci
lities/FeatureServer/0 

8. Paste the URL into a plain text document to keep it available and go back to ArcGIS 
Survey123 Connect. 

9. In the left pane, click Open XLSForm Spreadsheet. 

An Excel window appears where you are presented with survey property settings. 

10. In the Survey tab, scroll to the right until you see the default column. 

11. In the row labeled facility_url, copy the URL of the survey from your text document and 
paste it into the cell for the default column. 

12. Save the Microsoft Excel spreadsheet and close it. 

13. In ArcGIS Survey123 Connect, click Publish in the left pane to publish the changes. 

 

Update the survey URL fields 
The Facilities feature layer is used in the Business Resilience Web App to map your facilities, 

display their data contained in the attribute table, and connect to the Operational Assessment 

Survey. Complete the steps below to add the survey URLs as attributes in the Facilities layer. 
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Acquire the URL of the survey 
To get the URL of the survey, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Operational Assessment Survey in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Operational Assessment Survey to view its details. 

6. Click Open in Survey123 > Open in Survey123 app. 

Note: 

A new tab opens, prompting you to open into Survey123 app. Click Cancel and 
remove "&open=native" from the URL to open survey directly into the browser. 

7. In the address bar of the browser, copy the survey URL, including the question mark and 
portalURL= statement. 

Note: 

For example, if the URL is as follows: 

https://survey123.arcgis.com/share/aee97bcef4d24c9187da9590ec86b67c?po
rtalUrl=https://LearnGIS.maps.arcgis.com 

This URL will be used to populate the survey URL attributes for the Facilities layer. 

8. Paste the URL into a plain text document to keep it available. 

 

Populate the Base Survey URL field 
To populate the Base Survey URL field, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Facilities in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Facilities to view its details. 

6. Click the Data tab. 

A table view of the layer appears. 

7. Scroll to the right until you see the Base Survey URL field. Click Base Survey URL and 
click Calculate. 
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8. In the Calculate Field pane, click Arcade. 

9. In the Arcade calculator, type the following: 

 var BaseURL = ”” 

10. Copy the URL of the survey from your text document and paste it between the quotation 
marks. 

11. Add a new line and type the following: 

 return BaseURL 

12. Click OK. 

The string is added to each record in the Facilities layer’s Base Survey URL field. 

Note: 

This calculation must be manually run when new features added to the Facilities layer. 

 

Populate the Assessment Survey URL field 
To populate the Assessment Survey URL field, complete the following steps: 

1. Scroll to the right until you see Assessment Survey URL. Click Assessment Survey 
URL and click Calculate. 

2. In the Calculate Field pane, click Arcade. 

3. Copy and paste the Arcade expression into the expression box: 

var BaseURL = $feature["base_survey_url"] 

var JoinedURL = BaseURL + "&field:survey_facility_id=" + UrlEncode($feature["facility_id"]) 

return JoinedURL 

4. Click OK. 

The Assessment Survey URL field is populated with URLs that also have the field 

parameter set to the corresponding facility’s ID value. 

Note: 

This calculation must be manually run when new features added to the Facilities layer. 
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Use Business Resilience 
In this topic, you will learn how to use the Business Resilience solution and the set of 

capabilities and features that it provides. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Visualize hazards 
There are a variety of hazards, such as severe weather, fires, earthquakes, and hurricanes, 

that have the potential to affect your facilities. Many organizations have large geographic 

footprints and may be impacted by a diverse array of natural hazards and threats. 

The Business Resilience solution allows an analyst in an operation center to monitor hazards 

that may threaten your facilities. 

To use the Business Resilience solution to visualize hazards, complete the following steps: 

1. In a browser, open the Business Resilience Web App. 

On the right side of the app, the layers pane is divided into the following sections: 

• Organizational Assets 

• Weather Layers 

• Drought and Wildfires 

• Natural Disasters 

In the Organizational Assets section of the Layers pane, the Operational Assessment 
Survey and Facilities layers are turned on by default. 

Facilities are represented by point features that appear on the map and are symbolized 
to indicate their status. 

The Operational Assessment Survey layer shows results of surveys that have been 
submitted by facility managers. 

2. In the upper right of the Weather Layers section, click the options menu and click Turn 
all layers on. 

These layers contain real-time weather feeds, many of which are published by the 
National Weather Service. Use these layers to track potential severe weather threats to 
your facilities. 

To see the symbology for these layers, you can expand them individually by clicking the 
arrows to the left of the layer visibility check boxes. 

3. To optionally view more details on each layer, click the options button and click Show 
item details. Otherwise, in the upper right of the Weather Layers section, click the 
options menu and click Turn all layers off. 
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Tip: 

You can also use keyboard shortcuts to turn groups of layers on or off and expand or 
collapse them. Press the Ctrl key and check the layer check box to turn layers on or off 
in the same level. Press the Ctrl key and click the arrow to expand or collapse a layer in 
the same level. 

4. In the upper right of the Wildfires and Active Fires section, click the options menu and 
click Turn all layers on. 

These layers contain the latest up-to-date information on current and ongoing fire-related 
incidents. Areas suffering drought conditions may be at greater risk of wildfire, so these 
areas may pose an elevated risk to your facilities. Use these layers to track potential fire-
related threats to your facilities. 

To see the symbology for these layers, you can expand them individually by clicking the 
arrows to the left of the layer visibility check boxes. 

5. To optionally view more details on each layer, click the options button and click Show 
item details. Otherwise, in the upper right of the Droughts and Wildfires section, click 
the options menu and click Turn all layers off. 

6. In the upper right of the Natural Disasters section, click the context menu to expand and 
click Turn all layers on. 

These layers contain real-time feeds of the latest natural hazards, such as hurricanes 
and earthquakes. 

To see the symbology for these layers, you can expand them individually by clicking the 
arrows to the left of the layer visibility check boxes. 

7. To optionally view more details on each layer, click the options button and click Show 
item details. Otherwise, in the upper right of the Natural Disasters section, click the 
options menu and click Turn all layers off. 

Tip: 

When you configure the Business Resilience Web App, you can include your own 
sections, groups, and layers. For example, if you are tracking threats to coastal 
facilities, you can create another section named Coastal Threats and include layers 
from the National Weather Service, such as High Surf Advisory, Areal Flood 
Warning, and Coastal Flood Watch. 

 

Send an assessment survey 
The role of an analyst in the operations center is to watch over the multitude of threats that 

may impact one or more assets within your organization. When a threat has been detected to 

potentially impact one or more facilities, it is imperative to alert the facility administrators of the 

possible impact and understand the potential effects of the even on the facility to minimize 
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disruption. The Business Resilience Web App is configured to allow you to quickly send out an 

assessment to the facility manager. 

 

Send an assessment to a single facility 
In this workflow, you will take on the role of an analyst who has be alerted to an event that is 

threatening a facility. You will be sending an assessment form to gather relevant information 

from the facility manager at the threatened facility. 

1. In a browser, open the Business Resilience Web App app if you do not have it open 
already. 

2. Select a facility of interest from the list on the left side of the application or zoom to the 
location of the facility and click the facility. 

In the pop-up window, general details about the facility are provided. 

3. On the pop-up, in the Notes section, click the Click here to send Operational 
Assessment to Facility Administrator link. 

An email opens in your email client. It is populated with the email address of the facility 

manager, the name of the manager, text requesting information about the event, and a 

hyperlink to a survey that the manager can use to reply with status information. 

4. Select the [INSERT EVENT DESCRIPTION AND DETAILS HERE] text in the email and 
add any other information that may be useful to the facility manager in evaluating the 
threat. 

5. Send the email to the manager. 

 

Send an assessment to multiple facilities 
In this workflow, you will take on the role of an analyst who has identified a hurricane event 

that is threatening multiple facilities. You will be sending assessments form to gather relevant 

information from the facility manager at the threatened facilities. 

1. In a browser, open the Business Resilience Web App if you do not have it open already. 

2. Select the Create Assessment Report widget in the upper right of the application, 
above the layers pane. 

3. With the Create Assessment Report widget open, define an area of interest by searching 
for a location in the Place Name tool or using the Draw tool. Click the Draw tool and click 
the Select by Rectangle button. 

4. Click Choose selectable layers to expand the layer list and select Hurricane Irma 
Example – Forecast Cone. Uncheck all other layers. 

You can use the Choose selectable layer list to define the layers that are selectable on 
the map. 

5. On the map, drag a small box on the Hurricane Irma forecast cone feature. This selects 
the feature from the service, just as it would select a feature in a live Hurricane Forecast 
feed. 
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6. Optionally, set a Buffer distance value to select facilities that are also within a distance 
from the selected feature, and click Report. 

The report of facilities within the buffer around the forecast cone is generated. 

7. In the Create Assessment Report pane, click the Expand button next to Facilities to 
expand the list. 

The report contains information about each facility, including the facility ID, a survey link, 
the number of employees at the location, and the manager's name and email address. 

8. If you would like a CSV file of selected facilities, click the Download button. 

9. If you want a PDF report, click the Print button, choose a report layout size, and click 
the Print button to generate the report. 

10. In the header section of the report web page, click Print to save. 

Tip: 

You can get a list of all the email addresses from the downloaded CSV file of selected 
facilities. Find the email column and copy the facility manager email address to your 
clipboard, and paste it into your email client to send a report. 

 

Submit an assessment survey 
For an organization to assess impacts, facility managers can share relevant information about 

the operational status of their facility and the impact of a likely event. The Operational 

Assessment Survey allows facility managers to submit this information back to the operations 

center. The survey contains assessment questions about the exterior, interior, and employee 

vulnerability. This information allows decision makers to understand the threat, prioritize aid, 

and allocate supporting resources throughout the organization. 

In this workflow, you will take on the role of a facility manager at a threatened facility and use 

the survey link to send status information to the operations center. 

1. In a browser, open the Operational Assessment Survey. 

This is a link to the survey for Facility #104. 

Note: 

The URL for the survey includes the facility ID. This ties the survey to a specific facility 
location and allows the survey to be populated with information about the facility, 
saving the manager time. 

The survey opens in a browser tab. The Potential Impact Assessment section is open 
with a number of questions that you can answer to communicate your facility's status 
back to the operations center. 

2. Click the header for the top section, Facility Location Details. 

The details for your facility are prepopulated in the survey. 

3. Complete the Potential Impact Assessment section. 
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Parameter Value 

External Vulnerablity Select Low. 

Interior Vulnerablity Select Negligible. 

Employee Vulnerablity Select Moderate. 

Employee Vulnerablity Extent Select 25% to 50%. 

Do you foresee the need to possibly temporarily close this 
location due to this event? 

Select Maybe/Not 
Sure. 

Is there a potential need for local evacuation? Select No. 

Describe any relevant information, thoughts, strategies, or 
issues 

Type relevant 
information. 

4. Optionally, upload pictures of the facility and of any vulnerability concerns in 
the Media group to provide further context. 

5. Once the survey is completed, click the Submit button. 

 

Review assessments 
Upon submission of assessment reports, they appear as points on the map. The feedback in 

the survey is key to assessing the potential impact to the health and safety of customers, 

employees, and assets while also understanding how to facilitate resources and minimize 

interruptions. 

In this workflow, you will take on the role of the analyst in the command center reviewing an 

open submission by a facility manager. 

1. In a browser, open the Business Resilience Web App app. 

2. In the Facilities pane on the left side of the Business Resilience web app, expand 
the Assessment Status section if it is not already expanded. 

This group contains a list of assessments by status with the latest submission at the 

bottom. 

3. Click the latest submission in the list. 

The assessment is selected, and the pop-up appears on the map. 

4. On the pop-up, in the lower right corner, click the Options button and click Smart Editor. 

The Review Assessments pane appears. You can see the responses the facility 

manager sent, describing the probable impact of the event on the facility. 

5. Review the information provided by the facility manager. 

6. Optionally, change the status from Open to Under Review. 

7. Click Save and close the Review Assessments pane. 

The assessment status changes to Under Review on the map and in the Assessment 

Status group. Once the review status is set to Closed, the assessment is removed from 

the list and the map. 
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Modify operational status 
Upon review of an assessment, an analyst can modify the status of one or more facilities in 

the organization to reflect its current state for visual awareness. This is important when 

working with a team that needs to keep track of the overall operational impact to an 

organization and share the latest information with an executive audience. 

In this workflow, you will take on the role of the analyst in the command center updating the 

operational status of facilities to reflect their current state. 

1. In a browser, open the Business Resilience Web App if you do not have it open already. 

2. Zoom in on the map to the facility you want to update. 

3. Select the Modify Facility Status widget from the upper right of the application, above 
the layers pane. 

4. In the Modify Facility Status pane, click the Select by Rectangle button. 

5. Drag a box around the facility you want to modify. 

The Modify Facility Status window appears with multiple drop-down buttons. 

Note: 

You can also select and update multiple facilities at the same time. 

6. Enter the following values for the parameters: 

Parameter Value 

Notes Manager reports local flooding with the power and gas service 
out. 

Operating Status Select Impacted. 

Electric Service 
Status 

Select Impacted. 

Fire System Status Select Operating. 

HVAC Status Select Operating. 

Gas Service Status Select Impacted. 

Water Service Status Select Operating. 

7. Click Save. 

The change in status updates the symbology of update facilities on the map as well as 

the Facilities list on the left side to reflect the current count of facilities by status. 
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Capital Project Planning 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Capital Project Planning 
Capital Project Planning can be used to define a project portfolio, organize the portfolio into an 

official capital improvement plan, and share the plan with internal and external stakeholders. 

High-quality infrastructure is essential to a community's economic vitality and quality of life. A 

good capital project planning process helps communities make smart infrastructure 

improvements and investments in their future. Governments may have hundreds of projects in 

their capital improvement plan (CIP) that range in cost from thousands to billions of dollars. 

Managing this CIP comes with inherent challenges that can impact the schedule, quality, and 

cost of infrastructure improvements. Capital Project Planning is typically implemented by 

government agencies and utilities that want an efficient way to manage and share a capital 

improvement plan. 

The Capital Project Planning solution delivers a set of capabilities that help you define capital 

project plans, coordinate project schedules with internal and external agencies, manage 

pavement moratoriums, organize a project portfolio into an official capital improvement plan, 

and share capital improvement plans with the public and other key stakeholders. 

 

Requirements 
Capital Project Planning requires the following: 

• ArcGIS Enterprise 
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Information products 
Capital Project Planning includes the following information products: 

Item Description Minimum user type 

Capital Project 
Plans 

A Category Gallery app that includes a collection 
of ArcGIS Web AppBuilder apps used by project 
leads to organize new capital project plans and 
revise project information during the planning 
process 

Editor 

Capital Project 
Review 

A Crowdsource Manager app used by plan 
review staff to organize a project portfolio into an 
official capital improvement plan 

Editor 

Capital Project 
Review 
Dashboard 

An ArcGIS Dashboards app used by plan review 
staff to examine proposed projects before 
inclusion in an official capital improvement plan 

Viewer 

External Agency 
Projects 

An ArcGIS Web AppBuilder app used by private 
utilities and external agencies to share capital 
projects planned for their respective 
infrastructure 

Editor 

Pavement 
Moratoriums 

An ArcGIS Web AppBuilder app used by 
engineering and operations staff to inventory 
moratoriums that preclude, or restrict, right-of-
way activity on newly paved streets 

Editor 

Capital 
Improvement 
Plan 

An ArcGIS Experience Builder app used by the 
public and other interested parties to review 
projects included in the capital improvement plan 

Viewer (required if 
application is used 
for internal purposes 
only) 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Capital Project Plans app. 

1.0 • First release of Capital Project Planning 
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Use Capital Project Planning 
The Capital Project Planning solution delivers a set of capabilities that help you define capital 

project plans, coordinate project schedules with internal and external agencies, manage 

pavement moratoriums, organize a project portfolio into an official capital improvement plan, 

and share capital improvement plans with the public and other key stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage pavement moratoriums 
Engineering and operations staff of a local municipality are typically responsible for 

inventorying moratoriums that preclude or restrict right-of-way activity on newly paved streets. 

Moratoriums identified by staff are shared with municipal departments, private utilities, and 

other external agencies so that they can understand the impact of any work planned in the 

same right-of-way. 

You will assume the role of a municipality staff member and will use the Pavement 

Moratoriums app to create new and update existing pavement moratoriums. 

 

Add a pavement moratorium 
In this workflow, you will use the Pavement Moratoriums app to create a pavement 

moratorium. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital Project 
Planning solution. 

2. View the Pavement Moratoriums app. 

The app opens with the Create Moratorium widget opened by default. 

3. On the map, use the search field to zoom to your area. 

4. In the Create Moratorium widget, click the Pavement Moratoriums template, and then 
uncheck the Save new features automatically check box. 

Note: 

When Save new features automatically is checked, edits are automatically saved 
without opening the Pavement Moratoriums form. This option is useful when you want 
to digitize new features quickly. 

5. On the map, draw a new pavement moratorium. 

A Pavement Moratoriums form opens on the right. 
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6. Complete the form with your moratorium information. 

7. Click Save to complete the pavement moratorium creation workflow. 

 

Edit a pavement moratorium 
In this workflow, you will edit the details for an existing moratorium. 

1. In the Create Moratorium widget, unselect the Pavement Moratoriums template, if 
necessary. 

2. On the map, select the moratorium that you just created. 

The Pavement Moratoriums form opens on the right. 

3. Revise the form information, and then click Save. 

 

Delete a pavement moratorium 
In this workflow, you will delete an existing moratorium from the app. 

1. In the Create Moratorium widget, unselect the Pavement Moratoriums template, if 
necessary. 

2. On the map, select the moratorium that you just created. 

The Pavement Moratoriums form opens on the right. 

3. Click Delete, and then confirm the deletion. 

Note: 

If you plan to complete subsequent workflows, ensure that you leave at least one 
moratorium in the app. 

 

Create and share project plans 
Capital projects, typically defined for water, sewer, stormwater, parks, facility, and 

transportation assets in a community, can be visualized together with external agencies' 

projects when the agencies plan and schedule work for their respective infrastructure. Sharing 

this information helps identify potential project conflicts and can become the foundation for 

public-private partnership opportunities. 

Infrastructure project planning and coordination between municipalities and external agencies 

can be achieved by using the Capital Project Planning and External Agency Projects apps. 

 

Create and share external agency projects 
In this workflow, you will assume the role of a project lead from a private utility who is 

responsible for coordinating infrastructure development and improvement activities with the 
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local municipality. You will use the External Agency Projects app to gain insight into existing 

external projects and pavement moratoriums and to enter new project information. 

The updates that you provide in the External Agency Projects app will be immediately 

available to the municipality plan review team and will aid in their coordination of schedules of 

planned projects. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital Project 
Planning solution. 

2. View the External Agency Projects app. 

The app opens with the Sort Projects widget opened by default. This widget allows you 
to search for and filter existing external agency projects by company name. 

3. To create a new external agency project, at the top right, click the Create Project button. 

The Create Project widget opens. 

4. On the map, use the search field to zoom to your area. 

5. In the Create Project widget, click the External Agency Projects template, and then 
uncheck the Save new features automatically check box. 

Note: 

When Save new features automatically is checked, edits are automatically saved 
without opening the Pavement Moratoriums form. This option is useful when you want 
to digitize new features quickly. 

6. On the map, draw a new external project boundary. 

An External Agency Projects form opens on the right. 

7. Complete the form with your project information. 

8. Click Save to complete the external agency project creation workflow. 

 

Define capital project plans 
In this workflow, you will assume the role of a public works organization project lead who is 

responsible for organizing new capital project plans and revising project information during the 

planning process. You will use the Capital Project Plans app to gain insight into existing 

project plans, external agency projects, and pavement moratoriums and to create a project 

plan. 

After all relevant information has been added to the project plan and is ready for internal 

review, you will be able to share your plan with members of the coordinating body. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital Project 
Planning solution. 

2. View the Capital Project Plans app. 

The Capital Project Plans app is a gallery that contains individual Capital Project 
Planning apps for water, sewer, stormwater, facilities, and transportation projects. 

3. Click the Sewer Project Plans app. 
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The app opens with the Create Plan widget opened by default. This widget allows you to 
create, edit, and delete sewer plans. 

4. On the map, use the search field to zoom to your area. 

5. To create a sewer project plan, in the Create Plan widget, click the Sewer 
Collection template. 

6. On the map, draw a new sewer project. 

A Sewer Project Plans form opens on the right. 

7. Complete the form with your project information. 

The Project Status parameter allows you to share your project in the Capital Project 
Review app with members of the coordinating body. 

8. To share your plan with members of review board, for Project Status, choose Analysis 
and Review. 

9. Click Save to complete the capital project plan creation workflow. 

Tip: 

Existing sewer project plans can also be edited or deleted. To edit or complete a plan, 
click the Sewer Collection template to unselect it, and then on the map, select an 
existing sewer project plan to enable the Sewer Project Plans form. In the form, you 
can edit plan information, update the feature's geometry, or delete the plan. 

 

Organize and review the project portfolio 
Many agencies have a coordinating body that is responsible for examining project proposals 

and preparing a consolidated list of projects that align with community goals and strategic 

priorities. 

Project-planning organization and review can be achieved using the Capital Project Review 

Dashboard and the Capital Project Review app. 

 

Review the portfolio of capital project plans 
In this workflow, you will assume the role of a member of the coordinating body that is 

responsible for reviewing proposed projects. You will use the Capital Project Review 

Dashboard to examine proposed projects, visualize project schedules, and summarize 

estimated costs. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital Project 
Planning solution. 

2. View the Capital Project Review Dashboard app. 

On the right, any capital projects submitted for analysis and review are listed. 
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Tip: 

If you do not have any projects listed, return to and complete the Define capital 
project plans workflow. 

3. On the left, adjust the filters to refine the capital project list by type, fiscal year, funding 
source, status, and planned start date. 

Note: 

Filter options will vary based on the types of projects submitted. 

4. On the right, in the Capital Projects list, click the name of a capital project to zoom to it 
on the map. 

5. On the map, click a project to see a pop-up with more information about the project. 

6. If a proposed plan is ready for further review, click the Review Now button to launch the 
selected capital project plan within the Capital Project Review app. 

 

Organize the project portfolio into an official capital improvement plan 
In this workflow, you will assume the role of a member of the coordinating body that is 

responsible for reviewing proposed projects. You will use the Capital Project Review app to 

sort various key characteristics of a project and update project information, such as status, 

fiscal year, and funding sources, where appropriate. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital Project 
Planning solution. 

2. View the Capital Project Review app. 

The same portfolio of projects from the Capital Project Review Dashboard are visible in 
this app. 

3. At the top, in the table, click a column head to sort and filter the project list by that key 
field. 

4. In the table, click a project to view its details. 

The project details appear in the bottom left pane. If any items were attached when the 
project was created, you will see Details and Attachments tabs. 

5. Click the Details tab, and then click the Edit record button , if necessary. 

As a decision maker, you can refine plan information such as funding source, fiscal year, 
project status and phase, and whether a project is funded. 

6. In the project details, click the Project Status drop-down arrow and choose Board 
Authorized, and then click the Funded Project drop-down arrow and choose Yes. 

These settings ensure that the project will be included in the capital improvement plan 
(CIP). 

7. Click Save. 

Because you have authorized the project and marked it as funded, it is no longer listed in 
the Capital Project Review app. 
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Explore the capital improvement plan 
In this workflow, you will assume the role of a community member who is interested in 

learning more about projects being planned in your community and where they are located. 

You will use the Capital Improvement Plan app to review projects included in the capital 

improvement plan (CIP). 

1. In a browser, from the Capital Project Tracking solution, view the Capital Improvement 
Plan web experience app. 

Any projects that you authorized and marked as funded in the previous step appear in 
the Projects pane. 

2. In the left panel, under Type, check an option or options, and then set Planned Start 
Date filters to further explore and refine capital improvement plan results. 

Note: 

Filter options will vary based on the types of projects listed. 

3. In the Projects pane, click a project to zoom to it on the map and view project details. 

4. On the map, click the Home button to zoom to the full extent of the project map. 

You can also use the map extent to filter results. 

5. Pan and zoom the map to refine the list of projects and project details. 
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Capital Project Tracking 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Capital Project Tracking 
Capital Project Tracking can be used to manage an active project portfolio, communicate 

project status, and share project updates with internal and external stakeholders. 

Managing a large project portfolio and quickly communicating progress is a challenge for 

government agencies and utilities. Many times, the lack of information leads to expensive 

project changes, budget overruns, frustrated executives and a disenfranchised public. 

Maintaining effective communication with internal and external stakeholders throughout the 

life cycle of a capital project increases transparency and strengthens public trust. It also 

assures stakeholders that public dollars are being spent effectively and improvements are 

being made in a timely manner. Capital Project Tracking is typically implemented by 

government agencies and utilities that want to proactively share the status of active capital 

projects with the communities they serve. 

The Capital Project Tracking solution delivers a set of capabilities that help you manage the 

status of active capital projects, track project performance, share project progress with internal 

stakeholders, and communicate investments being made with the public. 

 

Requirements 
Capital Project Tracking requires the following: 

• ArcGIS Enterprise 
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Information products 
Capital Project Tracking includes the following information products: 

Item Description Minimum user type 

Maximizing 
Capital 
Expenditures 

An ArcGIS Hub site used by the public to learn 
more about public investments being made and 
how they can participate in the capital project 
planning process 

Not required 

Capital Project 
Dashboard 

An ArcGIS Experience Builder app used by 
internal and external stakeholders to monitor 
active capital projects 

Viewer (required 
for internal 
stakeholders) 

Capital Project 
Reports 

A Crowdsource Manager app used by project 
leads to manage the status of active capital 
projects and communicate the schedule, quality, 
and cost to internal and external stakeholders 

Editor 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Capital Project Tracking 
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Configure Capital Project Tracking 
In this topic, you will learn how to configure the Capital Project Tracking solution to meet 

specific needs in your organization. 

 

Load capital projects 
The Capital Project Tracking solution is built on the same foundational feature layer, 

InfrastructureProjects, used in the Capital Project Planning solution. If you have also deployed 

the Capital Project Planning solution, you can use that solution to define project plans and 

organize your project portfolio into a capital improvement plan. Once projects have been 

approved and funded, they will display in the Capital Project Tracking solution. 

If you are using another system for project planning and want to use the Capital Project 

Tracking solution to report and share active projects with key stakeholders and the public, you 

will need to load these projects into the InfrastructureProjects feature layer. You will also need 

to update the Project Status, Funded Project, and Project Phase fields to make the projects 

visible in the Capital Project Reports and Capital Project Dashboard apps. 

 

Load data from a shapefile 
Capital projects can be loaded from a shapefile by completing the following steps: 

1. Create a .zip file of a shapefile of your capital projects. 

2. Sign in to your ArcGIS organization and browse to the InfrastructureProjects feature 
layer. 

3. Open the item page and click Update Data > Append Data to Layer. 

4. Click Choose File and browse to a .zip file containing the shapefile with your capital 

projects, and click Open. 

5. Click Upload and Continue. 

6. Click the Choose the layer that you wish to append data into drop-down arrow and 
choose the Infrastructure Projects. 

7. Uncheck Update existing features. 

8. Click Show field matching to map the fields. 

Note: 

The only required field is the projtype (Project Type) field. This is a text field that 
defines the type of project and supports the following values: Facilities, Parks, Sewer 
Collection, Stormwater Drainage, Transportation, Water Distribution, and Other. 

9. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Update project attributes 
The Capital Project Reports and Capital Project Dashboard apps both use feature layer views 

to ensure only approved and funded projects are visible. Projects will only display in these 

apps if the Project Status is set to Board Authorized, Funded Project is set to Yes. 

And Project Phase is set to PreDesign, Design, Construction, or Closeout. 

To update the project attributes, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
InfrastructureProjects feature layer. 

2. Open the item page and click the Data tab. 

3. Click within a cell in the table and edit the attributes of the project. 

To update all projects with the same attribute, complete the remaining steps: 

4. Click the column containing the values you want to update. 

5. Click Calculate. 

6. Click SQL. 

7. Enter the value you want to apply. For text fields, you need to surround the value with 
single quotes, for example, 'Board Authorized'. 

Tip: 

For more information, see Calculate field values. 

 

Configure the Maximizing Capital Expenditures site 
The Capital Project Tracking solution includes the Maximizing Capital Expenditures ArcGIS 

Hub site. This site can be configured with your organization's branding and used to share 

important capital investment and planning information with the public. 

 

Update with organizational information 
After deploying the Capital Project Tracking solution, the Maximizing Capital 

Expenditures Hub site layout only requires a few updates to fit your local context. 

To update the site with your organizational information, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Maximizing 
Capital Expenditures site. 

2. From the item page, click Configure. 

3. Scroll to the statistics section under the Hub site title. 

The Capital Projects and Public Investment (dollars) summary statistics cards are 
already linked to the Capital Project Tracking solution’s 
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InfrastructureProjects_allfundedprojects feature layer. These statistics will automatically 
update as you load data into the feature layer. 

The Public Workshops statistic is provided in a text card styled to resemble the 
summary statistics cards, but you can manually enter a statistic of your choice, 
independent of feature layer data. You can update the Public Workshops text card 
using a metric of your choice, or you can replace the text card with a summary statistics 
card and connect it to the InfrastructureProjects_allfundedprojects feature layer in a 
similar fashion to the other dynamic statistics cards. 

4. Scroll to any additional sections that you want to update, hover over the card, and click 

the edit pencil  that appears in the horizontal toolbar, and then edit the content with 
information specific to your organization. 

5. In the side panel, click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

6. Click the HTML text box. 

The HTML window appears. 

7. Make the necessary changes and click Apply. 

8. Click Save. 

9. Click the Save drop-down arrow and click Publish Draft. 

 

Share items with the public 
Several layer views, maps and apps included in the Capital Project Tracking solution must be 

shared with everyone so they can be accessed by the public on the Maximizing Capital 

Expenditures site. 

To share items with the public, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Capital 
Project Tracking folder. 

2. Next to each of the following items, check the check box: 

Name Item type 

InfrastructureProjects_allfundedprojects Feature layer (hosted, view) 

Capital Project Dashboard Web Map 

Capital Project Dashboard Dashboard 

Capital Project Mobile Dashboard Dashboard 

Capital Project Dashboard Web Experience 

Maximizing Capital Expenditures Site Application 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 
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The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 
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Use Capital Project Tracking 
The Capital Project Tracking solution delivers a set of capabilities that help you manage the 

status of active capital projects, track project performance, share project progress with internal 

stakeholders, and communicate investments being made with the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Update capital project status 
You will first assume the role of a public works project lead responsible for communicating 

schedule, quality, and cost updates on active capital projects. 

The updates you provide in the Capital Project Reports app will be immediately viewable to 

the public and key stakeholders through the Maximizing Capital Expenditures site and the 

Capital Projects Dashboard. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Capital Project 
Tracking solution. 

2. View the Capital Project Reports app. 

The Capital Project Reports app shows all categories of capital projects by default. 

3. On the left, click a report type to view active capital projects. 

4. At the top of the page, in the table, click a project report to view project details. 

At the bottom left, you see the project's current information, including any attachments 
and comments associated with the project. 

5. To edit the project's information, on the Details tab, click Edit . 

6. Update the parameters with new values. 

7. Click Save. 

 

Monitor active capital projects 
As a member of the community, you are interested in learning more about the active capital 

projects in the community and whether they are on schedule and budget. You will use 

the Maximizing Capital Expenditures site to learn about the active public investments being 

made in the community and how you can participate in the capital project planning process. 

1. In a browser, from the Capital Project Tracking solution, view the Maximizing Capital 
Expenditures site. 
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2. Scroll to the Active Capital Projects section and click the Review Active 
Projects button. 

On the left, under Active Projects, any active projects are listed. 

3. On the left, adjust the filters to refine the list by type, phase, or fiscal year. 

The map's current extent can also further refine the results shown in the Active 
Projects list. 

4. Pan and zoom around the map to dynamically update the refined results in the 
dashboard. 

Note: 

Using the map extent to refine dashboard results will also honor dashboard filters 
for Type, Phase, or Fiscal Year, if enabled. 

5. To view the location and project details for a project, click a project in the Active 
Project list. 

Selecting a project from the Active Projects list automatically pans and zooms the map 
to the selected project and updates and filters the project summary and detail 
information. 
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Citizen Problem Reporter 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Citizen Problem Reporter 
Citizen Problem Reporter can be used to solicit non-emergency requests (for example, blight, 

graffiti, trash, potholes, clogged drains, and flooding) from the general public. 

It provides 24/7 access to an organization and the location-enabled requests helps efficiently 

triage requests to the correct person or department responsible for its resolution. This 

accelerated approach improves the quality of life in a community and reduces long-term asset 

maintenance costs. Citizen Problem Reporter is typically implemented by planning 

departments, public works agencies, utilities, and other local government organizations that 

want to take a data-driven approach to asset maintenance or code enforcement. 

The Citizen Problem Reporter solution delivers a set of capabilities that help you solicit 

requests from the public, manage the response to each request, solicit feedback from the 

public after addressing a request, and monitor the resolution of non-emergency requests in a 

community. 

 

Requirements 
Citizen Problem Reporter requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 Connect 
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Information products 
Citizen Problem Reporter includes the following information products: 

Item Description Minimum user 
type 

Citizen Request 
Center 

An ArcGIS Hub site used by the general public to 
learn how they can submit a non-emergency 
request to help improve the community 

Community 
Identity 
(optional) 

Citizen Problem 
Reporter 

A Crowdsource Reporter app used by the general 
public to submit non-emergency requests in their 
community 

Community 
Identity 
(optional) 

Citizen Problem 
Satisfaction 
Survey 

An ArcGIS Survey123 form used by the general 
public to report their satisfaction regarding the 
service requested 

Not required 

Citizen Problem 
Manager 

A Crowdsource Manager app used by local 
government personnel to triage non-emergency 
requests and update the status of each 

Editor 

Citizen Problem 
Dashboard 

An ArcGIS Dashboards app used by local 
government personnel to monitor non-emergency 
requests and satisfaction survey responses 

Editor 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • A new Citizen Problem Reporter app with a simplified process for modifying 
and adding request categories and types. 

• A new Citizen Problem Manager app with the ability to add public comments 
that display in the Citizen Problem Reporter app. 

• A new Citizen Request Center site promoting the use of community identities 
to submit and track the status of submitted requests. 

• A new Citizen Problem Dashboard with additional filtering capabilities and an 
average resolution time indicator. 

1.0 • First release of Citizen Problem Reporter 
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Configure Citizen Problem Reporter 
Learn how to configure the Citizen Problem Reporter solution to meet specific needs in your 

organization. 

 

Modify request categories and types 
The Citizen Problem Reporter app allows the public to submit nonemergency requests. 

Requests types are grouped into categories that make it easier to submit a request. The 

request categories and types are defined in the Request Types .csv file deployed with the 

solution. 

Complete the following steps to modify the request categories and types available in 

the Citizen Problem Reporter app. 

1. Sign in to your ArcGIS organization and browse to the Request Types .csv file. 

2. Open the item page and click Download. 

3. Open the Request Types .csv file; add, remove, or modify the request categories and 

types; and save your changes. 

Tip: 

The source field column defines whether the values apply to the request category 
(reqcategory) or request type (reqtype) field. The name field defines the value that is 
written to the feature. The label field defines the value shown in the app drop-down 
menu. The source value field defines which category the type will display under. 

4. On the Request Types item page, click Upload, browse to your modified .csv file, and 

click Update Item. 

 

Configure Citizen Request Center site 
The Citizen Problem Reporter solution includes the Citizen Request Center ArcGIS Hub site 

that your organization can configure with your branding and can use to share information 

about nonemergency problem reporting with the public. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Citizen 
Request Center site. 

2. From the item page, click Configure. 

3. If necessary, click the Edit button  to open the site editor. 

4. Scroll to the Frequently Asked Questions section, hover over the card, click the edit 
pencil, and update the questions and answers. 

5. In the side panel, click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 

organization's branding, contact information, and social media references. 
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6. Click the HTML box. 

The HTML window appears. 

7. Make the necessary changes and click Apply. 

8. Click Save. 

9. When you're finished, click the Save drop-down menu and click Publish Draft. 

 

Share items with the public 
Several layer views, maps, and apps included in the Citizen Problem Reporter solution must 

be shared with everyone so they can be accessed by the public on the Citizen Request 

Center site. To share your Citizen Problem Reporter items with everyone, use the guide below 

and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Citizen 
Problem Reporter folder. 

2. Check the box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) Requests_public 

Feature Layer (hosted, view) Requests_reporter 

Feature Layer (hosted, view) SatisfactionSurveys_public 

Feature Layer (hosted, view) SatisfactionSurveys_submit 

CSV Request Types 

Web Map Citizen Problem Reporter 

Web Mapping Application Citizen Problem Reporter 

Form Citizen Problem Satisfaction Survey 

Site Application Citizen Request Center 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 

you are sharing editable layers publicly. 

5. Click Update. 

6. Click Groups at the top of the site. 

7. Open the Citizen Problem Reporter group page and click Settings. 

8. Under Who can view this group, click Everyone (public), and click Save. 
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Revise satisfaction survey questions 
The Citizen Problem Satisfaction Survey allows you to solicit feedback from the public that 

helps you improve your community’s customer service. The survey includes six questions. In 

some cases, you may want to add or remove questions from the survey. 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Citizen Problem Satisfaction Survey to download the survey. 

4. In the Download window, click Download and click OK. 

5. Click Citizen Problem Satisfaction Survey again to open the survey. 

6. On the side toolbar, click the Open XLSForm Spreadsheet button. 

7. In the Microsoft Excel spreadsheet, click the choices tab. 

This tab comprises all the selectable options for survey questions. 

8. Click the survey tab. 

This tab comprises all the questions in the survey. 

9. Revise the survey to reflect your needs. 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

11. In ArcGIS Survey123 Connect, click Publish on the side toolbar to publish your changes. 

12. Click Publish survey to publish your changes and click OK. 

 

Extend Citizen Problem Reporter 
You can extend the Citizen Problem Reporter solution with a set of Python tools that can be 

used to generate report IDs, moderate reports, send email notifications, and enrich reports. 

These tools can be executed automatically via Task Scheduler, and as new problem reports 

are submitted or updated, the corresponding action occurs. 

 

Add the ServiceFunctions toolbox 
The ServiceFunctions toolbox contains tools for generating report IDs, moderating reports, 

sending email notifications, and enriching reports. Download and add the ServiceFunctions 

toolbox to your ArcGIS Pro project before configuring the appropriate tools. 

1. Download the ServiceFunctions toolbox. 

2. Browse to the ServiceSupport.zip file and unzip the file to the location from which you 

want to the tools to execute. 

3. Open ArcGIS Pro and create a new project. 

4. Sign in to the ArcGIS organization to which you deployed the Citizen Problem 
Reporter solution, if necessary. 
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5. On the View tab, in the Windows group, click the Catalog pane, if necessary. 

6. In the Catalog pane, right-click Toolboxes and choose Add Toolbox. 

The Add Toolbox dialog box appears. 

7. Browse to the ServiceSupport folder. 

8. Click the ServiceSupport.pyt Python toolbox, and click OK. 

9. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

If you've never used the ServiceSupport toolbox before, run the Define Connection 

Settings tool to establish a connection between the toolbox and the Requests feature 

layer. 

10. In the Catalog pane, in the ServiceSupport.pyt Python toolbox, double-click the Define 
Connection Settings tool. 

11. In the ArcGIS Online organization or ArcGIS Enterprise portal URL parameter, click 
the drop-down arrow and choose a URL. 

12. In the Username parameter, type your user name for the organization you chose in step 
11. 

13. In the Password parameter, type your password for the user name provided in 
the Username. 

14. Click Run. 

 

Generate report IDs 
Many workflows require you to generate a unique identifier when a feature or record is created 

so it can be referenced and tracked in other workflows. You can use the Generate IDs tool to 

configure custom unique identifiers that will be applied to features at a regularly scheduled 

interval of your choosing. The tool only generates the configuration; you must run an 

additional script (provided) to update the features with incrementing identifier values. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt, if necessary. 

2. Double-click the Generate IDs tool. 

3. In the Layer parameter, click Browse. 

The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Citizen Problem Reporter folder. 

6. Double-click the Requests feature layer. 

7. Click Requests, and click OK. 

Expand General Identifier Settings. If the tool has not been run previously, start by 
specifying at least one identifier sequence. 

8. In the Sequence Name parameter, type a name for the sequence. 

This value appears in the drop-down menu for selecting the sequence to assign to each 
layer. 
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9. In the Pattern parameter, type a pattern to use for the sequence. 

This can be a combination of letters, numbers, and symbols. Mark the location for the 
incrementing value with a pair of curly braces {}. Python formatting is applied to the 
pattern text, so string formatting syntax such as {0:03d} pads the incrementing number 
section with zeros to a length of 3. For example, the expression seq-{0:05d} creates the 
following pattern of values: seq-00001, seq-00002, seq-00003, and so on. 

10. In the Next Value parameter, type a value. 

When initially creating the sequence, this must be the first value in the identifiers. After 
this point, this value shows the value to be used for the next identifier generated. 

11. In the Interval parameter, type a value. 

The interval by which the identifier values increase between features. For example, an 
initial Next Value of 1 and an Interval of 10 creates identifiers with the incrementing 
values of 1, 11, 21, and so on. 

Deleting or changing these sequences impacts all the layers that are configured to use 
the edited sequences. 

12. Optionally, edit the identifier configuration and run the tool to overwrite the existing 
identifier configuration for the selected layer. 

Note: 

If an identifier configuration already exists, a check box appears that, when checked, 
deletes the existing identifier configuration for the selected layer. 

13. Choose the moderation list to use to process the features in the selected layer. 

14. Choose the sequence to use to generate the identifiers for each feature in the layer. 

15. Choose a text field to store the generated identifier. 

16. Click Run to write out the identifier configuration for the layer and any changes to the 
identifier sequences. 

17. To configure identifiers for another layer, rerun the tool with the settings for the next 
layer. 

General Identifier Settings are not specific to any one layer—they apply to all layers 
configured using this tool. 

 

Moderate reports 
Public comment apps can occasionally generate feedback that should not be made publicly 

visible. Data entered into specific fields, such as personal information, can be hidden and 

protected using the pop-up configuration and layer security, but sometimes entire comments 

need to be hidden to avoid displaying sensitive or explicit content to other users. 

You can hide features by updating the value of a field so that it no longer meets the 

requirements of a filter applied to that layer in the map. You can use the Moderate 

Reports tool to configure which layers and fields to scan for explicit or sensitive words and 

phrases and how to update the feature so that it can be filtered from the map. You can choose 
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how often to scan features and records. The tool only generates the configuration; an 

additional script (provided) must be run to scan the features. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Moderate Reports tool. 

3. In the Layer parameter, click Browse. 

The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Citizen Problem Reporter folder. 

6. Double-click the Requests feature layer. 

7. Click Requests, and click OK. 

Expand General Moderation Settings. If the tool has not been run previously, start by 

specifying at least one moderation list. 

8. In the List Name parameter, type a name. 

This value appears in the drop-down menu for selecting the moderation list use when 

scanning each layer. 

9. In the Filter Type parameter, click the drop-down arrow and choose to scan feature for 
words and phrases that exactly match the provided list of words and phrases. 

For example, when the filter type is EXACT, if the list contains the word duck, the script 

updates the specified field when the feature contains the word duck, but not when it 

contains the word duckling. When the filter type is FUZZY, the script updates the feature 

when either duck or duckling are found. 

10. In the Words and Phrases parameter, type a word or phrase. Provide a comma-
separated list of words or phrases to scan for. 

Keep in mind that deleting or changing these lists will impacts all the layers that are 

configured to use the edited sequences. 

11. If a moderation configuration already exists for the selected layer, choose to edit an 
existing configuration by selecting the name of the moderation list used in the 
configuration, or choose the option to add a new moderation configuration. 

If you choose to edit an existing configuration, a check box appears that, when checked, 

deletes the existing moderation configuration for the selected layer. Alternatively, edit the 

moderation configuration and run the tool to overwrite the existing moderation 

configuration for the selected layer and moderation list. 

To add a new moderation configuration, click the Add New button and continue with the 

following steps. 

12. Choose the moderation list to use to process the features in the selected layer. 

13. Choose the fields that will be scanned for content that matches the words and phrases in 
the selected moderation list. 

14. Optionally, provide an SQL query to only apply moderation to some features. 
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If no query is provided, all features are processed. 

15. Use the Field to Update parameter when a match is found between the value of a field 
and the content of a moderation list. Use the Found Value parameter to specify the 
value that should be written to this field indicating a match. 

16. Click Run. 

 

Send email notifications 
Many workflows require that an email be sent when a feature or record is created and 

updated. You can use the Send Emails tool to configure emails that can be sent based on 

attribute values and a schedule of your choosing. The tool only generates the configuration; 

you must run an additional script (provided) to actually generate and send the emails. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Send Emails tool. 

3. In the Layer parameter, click Browse. 

The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Citizen Problem Reporter folder. 

6. Double-click the Requests feature layer. 

7. Click Requests, and click OK. 

All existing email settings for the layer load and can be edited by updating the parameter 

values for each configuration. To delete a single email configuration, click 

the Remove button  next to the configuration. To delete all the email configurations for 

the layer, check the Delete all existing email configurations for this layer check box. 

Run the tool to save your changes. 

8. In the Email Template parameter, click Browse to access the ServiceSupport folder. 

9. Click one of the HTML templates for the body of the email, and click OK. 

To add attributes from the triggering feature to the email, use unique string keys in the 

places where the values should appear in the HTML and reference these strings in 

the Find parameter of the Email Substitutions section of the General Email 

Settings along with the name of the field that contains the value to be substituted for the 

string key in the Replace parameter. 

10. Optionally, in the SQL Query parameter, provide an SQL query to only trigger an email 
from specific features. 

If no query is provided, all features trigger emails every time the script is run, so you most 

likely want to use this query along with the Field to Update and Sent Value parameters 

to ensure that the same email isn't sent repeatedly for the same feature. 

11. In the Recipient Email Address parameter, type an email address of the recipient or the 
name of a field in the layer that contains the address of the recipient. 
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12. In the Email Subject parameter, type the subject for the email. 

Similar to the email body provided in the HTML document, this text can contain string 

keys that will be swapped out for attribute values based on the Find and Replace values 

defined in the Email Substitutions list in the General Email Settings section. 

13. In the Field to Update parameter, type Email. When the email has been sent for each 

feature, use the Sent Value parameter to specify the value that should be written to this 
field indicating that the email has been sent. 

This field and value can be used in the previously described SQL query to prevent 

duplicate emails from being sent. 

14. Configure additional emails to be sent for the currently selected layer by clicking the Add 
New button. 

Emails will be sent in the order they are configured. Expand General Email Settings. If 

the tool has not been run previously, start by specifying the connection information for 

your SMTP server in the tool. 

15. In the SMTP Server parameter, type the URL of the SMTP server used for sending 
emails. 

16. In the SMTP Username parameter, type the user name required to authenticate to the 
SMTP server. This is not required if authenticating through a port. 

17. In the SMTP Password parameter, type the password required to authenticate to the 
SMTP server. This is not required if authenticating through a port. 

18. In the From Address parameter, type the address from which the emails should be sent. 

19. In the Reply Address parameter, type the address that should be used for any replies to 
the email message. 

20. Check or uncheck the Use TLS check box to turn on or off TLS. 

21. In the Email Substitutions section, type Find and Replace values. Swap out one piece 
of text for another in the outgoing email subject or body. 

Anywhere a value in the Find parameter is found in the email subject or body, it will be 

replaced with the corresponding value from the Replace parameter. If the value in 

the Replace parameter is a field in the layer, the Find value will be replaced with the 

value in that field in the triggering feature. For example, to add the ID of a feature from 

the REQUESTID field to the email subject, include a piece of text such as {ID} in the 

configured Email Subject, and add {ID} to the Find parameter and REQUESTID to 

the Replace parameter. All specified substitutions are applied to all emails configured for 

all layers so, while the Find values can be any piece of text, it's suggested that you use 

something that is clearly variable-like and unlikely to appear elsewhere in the messages 

in a literal form. 

Deleting or changing these settings impacts all the emails for all the layers configured 

with this tool. 

22. Click Run. 
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Enrich reports 
Reports made in public comment apps can be enriched with information about the report 

location. You can then use this information to efficiently direct the report to the correct person 

or agency responsible for its resolution. 

You can then use the Enrich Reports tool to configure which attribute values to calculate from 

a coincident or intersecting set of features at a regularly scheduled interval of your choosing. 

Note that the tool only generates the configuration; you must run an additional script 

(provided) to update the features based on intersecting features. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Enrich Reports tool. 

3. In the Layer parameter, click the browse button. 

The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Citizen Problem Reporter folder. 

6. Double-click the Requests feature layer. 

7. Click Requests, and click OK. 

8. In the Enrichment parameter, if an enrichment configuration already exists for the 
selected layer, choose to either edit an existing configuration by selecting the 
configuration from the drop-down list, or choose the option to add a new enrichment 
configuration. 

If you choose to edit an existing configuration, a check box appears that, when checked, 

deletes the existing enrichment configuration for the selected layer. Alternatively, edit the 

configuration and run the tool to save the changes. To add a new enrichment 

configuration, click the Add New button and continue with the following steps. 

9. Choose the polygon feature layer that will provide the enriching attribute values by either 
choosing a layer from the active map or by browsing to your hosted content and choosing 
a polygon feature layer. 

10. In the Source Field parameter, click the drop-down arrow and choose a field from the 
enrichment layer. 

11. In the Target Field parameter, click the drop-down arrow and choose a field from the 
Requests feature layer. 

The script does not process features that already have a value in the target field. 

12. In the Priority parameter, type a value. Specify the priority for this enrichment 
configuration relative to the other configurations for the Requests feature layer. 

Enrichment configurations for a layer that have a lower priority value will override 

enrichment configurations with a higher value. For example, a layer has two enrichment 

configurations that use the same target field, but one has a priority value of 1 and the 

other has a priority of 2. If the configuration with priority 1 does not produce a valid value 

for the field, the field is populated with the value produced from the configuration with 

priority 2. 
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13. Click Run. 

 

Set up Task Scheduler 
Use Windows Task Scheduler to schedule the script to generate report IDs when a feature or 

record is created, moderate reports when feedback contains inappropriate language, send 

email notifications when a feature or record is created or updated, or enrich reports. All the 

tools in this toolbox share a common configuration file and execution script, so only one 

scheduled task is required to automate running all the associated processes. 

1. Open the Task Scheduler on the computer that is hosting the scripts. 

2. Click Action > Create Task and name your task. 

3. Click the Action tab and click New. 

4. Set Action to Start a Program. 

5. Browse to the location of your Python 3 installation (for example, <default 
directory>\C:\Program Files\ArcGIS\Pro\bin\Python\envs\arcgispro-
py3\python.exe). 

6. In the Add arguments text box, type the name of the script (servicefunctions.py). 

7. In the Start in text box, type the path to the folder where your script is and click OK. 

8. Click the Trigger tab, click New, and set a schedule for your task. 

9. Click OK. 

When the trigger occurs, the scripts begin scanning the configured layers and, for each one, 

processing (in order) configurations for generating identifiers, enriching reports, moderating 

reports, and sending emails. 
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Use Citizen Problem Reporter 
The Citizen Problem Reporter solution delivers a set of capabilities that help you solicit reports 

from the public, manage the response to each report, solicit feedback from the public after 

addressing a report, and monitor the resolution of nonemergency reports in a community. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Submit nonemergency problem reports 
You will first assume the role of a concerned resident in the community who is notifying the 

city of a burned-out light in the park. 

1. In a browser, go to the Citizen Request Center site. 

2. Scroll to the Join Our Community section. 

This section only applies when an organization is licensed for ArcGIS Hub Premium. 
When community residents do not have a community account or are not signed in to 
the Citizen Request Center site, the site displays buttons to Create an account or Sign 
In with an existing account. Creating an account allows users to view their submissions 
to more easily track the status of their requests. In the following steps, a community 
resident has created an account and is signed in to the Citizen Request Center site. 

3. Scroll to the Request Service section and click the Submit a Request button to open 
the Citizen Problem Reporter app. 

4. On the Citizen Problem Reporter page, click  Sign in with ArcGIS. 

Tip: 

Share the maps, app, and group with everyone (public) to allow users to proceed as a 
guest. For more information, see Share items with the public. 

5. Click Submit a Request. 

6. For Category, choose Park. 

7. For Request Type, choose Light Out. 

8. In the form, provide additional details and contact information. 

When signed in, user's first name, last name, and email address will automatically be 
populated. 

9. Click the Add a Location text box and click the location of your broken park light on the 
map. 

10. To submit a request, click Report It. 

11. Click your name near the top of the Citizen Problem Reporter app and click My 
Submissions. 

12. At the top of the list of requests, click the Park - Light Out request to select it. 

The park light out request you reported appears. As the request moves through its life 
cycle (Submitted, Received, In Progress, and Completed), the status bar updates. 
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13. Optionally, click Leave a reply to display the comment form and add a new comment. 

You and others can add comments to update or highlight information related to the initial 
request to authorities. The department or agency who is responding to the request can 
also add comments to provide updates on the progress. 

 

Respond to problem reports 
You are now an employee for the city who is responsible for responding to submitted problem 

reports, assigning them to the appropriate department for resolution. 

1. In a browser, go to the Citizen Request Center site. 

2. At the top of the site, click Manage Requests. 

This is an internal page that can be shared with users inside the organization responsible 
for responding to requests. 

3. Scroll to the Manage Requests section. 

4. In the Citizen Problem Manager app, click the Request Category column filter. 

5. Click Unique, click the Request Category is drop-down arrow and choose Tree. 

6. Click the Request Type column filter. 

7. Type Light Out in the Request Type is text box. 

8. In the Request table, identify and click the request you reported. 

Review the details of the problem in the lower left corner of the app. 

9. On the Details tab, click the Edit button . 

10. Click the Status drop-down arrow and choose Received. 

11. Click Save. 

Public Works staff are ready to address the problem. 

12. On the Details tab, click the Edit button. 

13. Click the Status drop-down arrow and choose In Progress. 

14. In the Assigned To text box, type Public Works. 

15. Click Save. 

16. On the Comments tab, click the Add Record button. 

17. In the Comments text box, type Public Works is working on this issue. 

Tip: 

When Visible to Public is set to Yes, the comment will display in the Citizen Problem 
Reporter app. 

18. Click Save. 

Public Works staff inform you that the park light bulb has been replaced. 

19. On the Details tab, click the Edit button. 
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20. Click the Status drop-down arrow and choose Completed. 

21. For Resolved On, choose the current date. 

22. In the Resolution text box, type Park light bulb has been replaced. 

23. Click Save. 

Once the issue is complete, the status indicator changes and the details now provide 
information about when and how the issue was resolved. 

24. On the Details tab, click the Send Satisfaction Survey button. 

25. Review the formatted email and click send. 

 

Provide feedback on work performed 
In the previous section, you sent an email containing a link to a satisfaction survey. You will 

now respond to the survey as the resident who originally submitted the request with your 

feedback on how the issue was handled. 

1. Open the email. 

2. Click the URL in the email to open the Citizen Problem Satisfaction Survey. 

3. In the app, complete the first four survey questions. 

4. Optionally, for Do you have any other comments or concerns, add any other 
comments. 

5. For Would you like to be contacted for more information, click Yes. 

6. Provide information for the Full Name, Phone, and Email parameters. 

7. Click Submit. 

 

Monitor reports and measure performance 
As a program manager for the city, you want to know how well the citizen problem program is 

functioning, monitor the reports coming in, and see how satisfied the residents are with the 

program. 

1. In a browser, go to the Citizen Request Center site. 

2. At the top of the site, click Manage Requests. 

3. Scroll to the Monitor Performance section. 

4. In the Citizen Problem Dashboard app, review the high-level metrics on 
the Overview tab. 

The Overview tab displays infographics of categories of reported problems. This 

information gives management a quick overview of the number of open requests 

submitted by the public. 

5. Click the Requests tab at the bottom of the dashboard. 
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The Requests tab allows a department manager to monitor how their department is 

doing when it comes to resolving requests. The page displays the top request categories 

and types, summarizes requests by month, and provides metrics on the average time to 

resolution. 

6. Use the graphs to filter and explore active and resolved requests. 

Dashboard charts are linked. As you click and select a category in one chart, related 

details are filtered and updated in other charts on the dashboard to allow a manager to 

identify issues and areas that need attention. The filtering is also linked to indicators and 

charts on the Survey Results tab. 

7. Click the Survey Results tab at the bottom of the dashboard and explore the survey 
responses. 

The Survey Results tab displays the results from the Citizen Satisfaction Survey. The 

indicators on the tab include Resolution Quality, Resolution Time, and Customer 

Service indicators that identify whether a community is below or above its target. 

The Recommended Problem Reporter to Friend or Colleague chart is used to display 

whether the user who submitted the survey would recommend Citizen Problem 

Reporter to a friend or colleague. The right side of the dashboard displays the number of 

surveys submitted and their details. 

8. Locate your response in the Surveys list and click it to see the details. 
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Code Enforcement Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

  

Introduction to Code Enforcement Operations 
Code Enforcement Operations can be used to collect and monitor code violations and related 

inspection information. 

It provides access to code violation and inspection information in the field, which helps 

streamline field operations and improve communication between field and office staff. This 

improved process can decrease the overall time it takes to cite and resolve potential code 

violations. Code Enforcement Operations is typically implemented by code enforcement, 

zoning administrators, and other local government agencies that want to improve their 

response time resolving code violations. 

The Code Enforcement Operations solution delivers a set of capabilities that help you review 

potential code violations, inspect code violations in the field, and monitor the resolution of 

code violations in a community. 

 

Requirements 
Code Enforcement Operations requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 
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Information products 
Code Enforcement Operations includes the following information products: 

Item Description Minimum 
user type 

Code Violation A map used by code enforcement officers, building 
officials, and zoning administrators to collect code violation 
and related inspection information 

Mobile 
Worker 

Code Violation 
Dashboard 

An ArcGIS Dashboards app used by planning and zoning 
administrators to monitor code violations 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Code Enforcement Operations 
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Use Code Enforcement Operations 
The Code Enforcement Operations solution delivers a set of capabilities that help you review 

potential code violations, inspect code violations in the field, and monitor the resolution of 

code violations in a community. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect code violations 
You will start by assuming the role of a code enforcement officer responsible for verifying a 

potential code violation. You are asked to use Code Violation to visit a potential code violation 

in the field and verify the details. 

1. Download ArcGIS Field Maps to a mobile device, if necessary. 

2. On the mobile device, open the app, and then sign in to your ArcGIS organization. 

3. Tap the Code Violation map to open it. 

4. Tap the plus sign to open the ArcGIS Field Maps form. 

5. Complete the form, using the following table as a guide: 

Parameter Value 

Violation ID Type a unique ID. 

Full Address Type the property address, if applicable. 

Location Type a description of the location (for example, front yard), if 

applicable. 

Violation Type Choose a category. 

Description Type a description. 

Municipal Code Type the violation code number. 

Visible Choose Yes or No. 

Date Submitted Choose the appropriate date. 

Name Type the contact's name. 

Phone Type the contact's phone number. 

Email Type the contact's email. 

Violation Status Choose Open or Closed. 

6. Tap Submit or the check mark to submit the form. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 135 

 

Monitor code violation status 
Now, you will assume the role of a planning or zoning administrator responsible for reviewing 

current open and closed violations. You are asked to use Code Violation Dashboard to 

monitor code violations. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Code 
Enforcement Operations solution. 

2. View the Code Violation Dashboard app. 

The Code Violation Dashboard opens, showing all submitted code violations. 

3. Review the high-level metrics about code violations, such as blight, illegal signs, and 
overgrown yards. 

4. On the left, use filters to refine the results by violation type, status, or date. 

5. On the right, click a specific code violation to review the violation ID, location on the 
premises, and property address. 

Note: 

Alternatively, click a point on the map. 
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Communications Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Communications Data 

Management 
Communications Data Management can be used to map coax, copper, fiber, and wireless 

system assets, edit data, view system maps in the field and office, view asset reports, and 

collaborate with map notes. 

It turns ArcGIS into a system for communications organizations to easily inventory their assets 

and keep information up to date. It provides simple to use interactive system maps and 

dashboards for office and field staff, and increases collaboration. 

After deploying, organizations with no digital communication data can immediately begin 

mapping their systems using GPS or digitizing data with web or desktop software. 

Organizations with existing spatial data can load it and begin using the apps. 

 

Requirements 
Communications Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later (Basic, Standard, or Advanced) 

• ArcGIS Field Maps 
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Information products 
Communications Data Management includes the following information products: 

Item Description Minimum user type 

Communications Data 
Manager 

An ArcGIS Pro package used to manage 
communication system data and map 
notes 

GIS Professional 
(Basic, Standard, or 
Advanced) 

Communications 
Editor 

An ArcGIS Web AppBuilder application 
used to edit communication data and 
map notes 

Editor 

Communications 
Viewer 

An ArcGIS Web AppBuilder application 
used to view and manage map notes 

Editor 

Communications 
Dashboard 

An ArcGIS Dashboards application used 
to view communication asset information 

Viewer 

Communications Map 
Notes Manager 

An ArcGIS Web AppBuilder application 
used to review and manage map notes 

Editor 

Communications 
Mobile Viewer 

A map used in ArcGIS Field Maps to 
view communication system assets and 
create map notes in the field 

Mobile Worker 

Communications 
Asset Collector  

A map used in ArcGIS Field Maps to 
capture communication assets and 
create map notes from the field 

Mobile Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 • The Minimal Gallery app has been removed from the solution item. 

1.1 • Name changed from Communications Data Management for ArcGIS Online 
to Communications Data Management. 

1.0 • The first release of Communications Data Management for ArcGIS Online 
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Configure Communications Data Management 
The Communications Data Management solution can be configured to meet specific needs in 

your organization. The sections below outline some administrative tasks to update and 

manage the solution to fit your organization's needs. 

 

Load data 
In some cases, you may need to load existing data into the solution before sharing the maps 

or applications. Review the maps or applications provided with the solution and determine 

what, if any, source data you want to load. Communications Data Management also includes 

a data model to store information about typical communications system assets. To explore the 

schema, view the data dictionary. 

Tip: 

If you do have to load data into the solution, you may want to develop a source-target 
matrix to track how your source data will be loaded into the target layer or layers used in 
the solution. 

Depending on the format of your source data, you may choose to append your source data to 

the new layers. Once you have determined what source data must be loaded, complete one of 

the data loading workflows below: 

 

Use the Append tool 
In ArcGIS Pro, the Append tool can be used to append multiple input datasets to an existing 

target dataset. Input datasets can be point, line, or polygon feature classes. 

To append features to the target layer or layers using the Append tool, complete the steps 

below: 

1. In ArcGIS Pro, sign in to your ArcGIS organization. 

2. To open the Communications Data Manager project, click Open another project, 
click My Content under Portal, double-click the Communications Data 
Management folder, and click Communications Data Manager. 

3. Add your existing source layers to a new map. To add the target feature layers from the 
CommunicationsSystem feature service, click My Content under Portal, double-click 
the Communications Data Management folder, and add the CommunicationsSystem 
feature service to the map. 

4. On the Analysis tab, in the Geoprocessing group, click Tools to open 
the Geoprocessing pane. 

5. In the search bar, type Append and click to open the Append tool. 

6. Add your existing communications data from the map to the Input Datasets parameter. 

7. For Target Datasets, use the CommunicationsSystem features in the map. 
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8. In the Schema Type parameter, use the drop-down menu to choose Use the Field Map 
to reconcile schema differences to perform field mapping. 

9. Update your field mapping and click Run. 

10. Repeat this process as needed to load all your existing data into the target 
communications schema. 

 

Use the Data Loading Tools 
The Data Loading toolbox can be used in ArcGIS Pro to streamline loading data from a source 

to a target dataset and provide the ability to perform in-process data transformation. Setup 

the Data Loading toolbox before getting started with the steps below. 

1. Open the Communications Data Manager project. 

2. On the Project tab, click Python to access the Python Package Manager. 

3. Under Project Environment, click Manage Environments. 

4. Click Clone Default  to clone your default environment. 

5. Click the Active button for the new environment, and click OK. 

6. Restart ArcGIS Pro to allow your environment changes to take effect. 

7. In the Python Package Manager, click Add Packages to see the Python packages 
available for installation. 

8. Click Refresh  to update the list of available packages. 

9. In the Search box, type dltsolutions to find the Data Loading Tools toolbox. 

10. Select the dltsolutions package and click the drop-down arrow to update the version. 

11. Click Install. 

The Install Package dialog box appears. 

12. Review the terms and conditions and check the box to agree. 

13. Click Install to install the package. 

14. Once the installation is complete, close ArcGIS Pro. 

The Data Loading Tools toolbox is now installed. The next time you start ArcGIS Pro, 

you can access it from the geoprocessing toolboxes. 

15. Review An overview of the Data Loading toolbox to learn more about the tools and how 
to use them to load data into the CommunicationsSystem layers. 

 

Configure the Communications Data Manager ArcGIS 

Pro project 
The Communications Data Manager project includes a Communications Data Manager map 

with broken links. 
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1. In ArcGIS Pro, sign in to your ArcGIS organization. 

2. To open the Communications Data Manager project, click Open another project, 
click My Content under Portal, double-click the Communications Data 
Management folder, and click Communications Data Manager. 

3. In the Catalog pane, expand Maps and double-click Communications Data Manager to 
open the map. 

4. In the Contents pane, click the red exclamation point  next to the Map Notes layer. 

The Change Data Source dialog box appears. 

5. Click My Content under Portal, double-click the Communications Data 
Management folder, double-click the CommunicationsMapNotes_managing feature 
service, and double-click the Map Notes layer. 

6. In the Contents pane, click the red exclamation point  next to the Regional Cable 
Components layer. 

The Change Data Source dialog box appears. 

7. Click My Content under Portal, double-click the Communications Data 
Management folder, double-click the CommunicationsSystem_editing feature service, 
and double-click the Regional Cable Components layer. 

The data source is repaired for the remaining layers. 

8. In the Contents pane, right click the Communications Data Manager map and 
click Properties. 

9. Click the Coordinate Systems tab. In the XY Coordinate Systems Available section 
select the coordinate system that matches the layers in the map. 

Note: 

Ensure the coordinate system of the map matches that of the feature layers deployed 
in the solution. If these do not match there may be discrepancies in what units are 
displayed in the map. 

10. Click Save to save the project. 

 

Add members to groups in your organization 
Included with Communications Data Management are four groups designed to help managers 

organize their members based on their privileges and their work. The solution includes the 

following groups: Communications Editors, Communications Field Users, Communications 

Map Notes Managers, and Communications Office Users. 

To add members to the groups, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization. 

Verify that you have privileges to manage member groups before continuing. 

2. Click Groups at the top of the site. 

3. Click the name of the group to open the group details pages. 
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4. On the Settings tab, edit and update the properties of the group, including access, 
sharing properties, and group ownership. 

5. Click the Overview tab and click Invite users. 

6. Select the members you want to add and click Add to group. 

7. Repeat steps 3 through 6 for each group you need to add members to. 

The provided groups are intended to be utilized by members with a minimum of the 
following user types in order to fully use the provided maps and apps: 

Group name User type 

Communications Editors • Editor 

• GIS Professional Basic with ArcGIS Pro 
(minimum of one license recommended) 

Communications Field Users • Mobile Worker 

Communications Map Notes 
Managers 

• Editor 

Communications Office Users • Editor 

 

Set the default map extent to your service territory 
When the Communications Data Management solution is deployed into your organization, it 

uses the map default set in your organization. If this property has not been set, you may want 

to quickly update a few maps and apps to your service territory manually to avoid having to 

pan and zoom to your area each time you open a map. Follow the steps below to update the 

initial extent of the maps and apps provided with this solution. 

1. In a browser, sign in to your ArcGIS organization. 

2. To set the default map extent for the Communications Viewer application, browse to 
the Communications Viewer item page and click Edit Application. 

3. On the Map tab, zoom the map to the desired extent and click Use current map 
view under Set initial extent. Click Save. 

4. Repeat steps 2 and 3 to set the default map extent for the Communications 
Editor and Communications Map Notes Manager applications. 

5. To set the default map extent for the Communications Asset Collector map, open 
the Communications Asset Collector map. 

6. Zoom the map to the desired extent and save it. 

7. Repeat steps 5 and 6 for the Communications Mobile Viewer map. 

 

Configure the dashboard 
When you deploy the Communications Data Management solution to your organization you 

have the option to change spatial reference. If you selected a spatial reference with a linear 
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unit other than meters, you will need to revise the dashboard by completing the following 

steps. 

1. In a browser, sign in to your ArcGIS organization. 

2. To set the default map extent for the Communications Dashboard application, browse 
to the Communications Dashboard item page and click Edit Dashboard. 

3. Navigate to the Civil & Engineering Assets tab and click the configure button  on 
first indicator. 

4. On the Data tab, change the Factor setting to the correct conversion. 

The dashboard Factor setting is configured to convert meters to miles. Learn more about 
how to Convert Values. 

5. Repeat steps 3 through 4 until all indicators on the Civil & Engineering Assets tab have 
been updated. 

6. Click the save button  . 
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Use Communications Data Management 
The Communications Data Management solution can be used by staff to collect and manage 

system information. This solution allows an organization to manage communications data to 

obtain information about the current state of their system. These workflows are intended for 

editors, mobile workers, and managers who want to use the maps and apps to manage their 

data. You will learn how to use the Communications Data Management solution to add new 

assets from the field, manage communications data in the web and desktop, and view and 

interact with a dashboard to find key statistics about your system. 

 

Add data in the field 
In these workflows, you will be taking the role of a mobile worker collecting data in the field. If 

you have a mobile-centric workforce, this may be the best option to collect new data or 

validate existing data. 

 

Collect existing poles 
As a mobile worker, collect existing poles in the field. 

1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Communications Asset Collector map. 

3. Browse to the collection location. 

4. Tap Add . 

5. From the list of features, search for Pole by swiping up or typing Pole in the filter search 

bar. 

If the pole is added to an inaccurate location, or you want to move the point manually, 
move the crosshairs to the correct location by panning the map and tapping Update 
Point. This moves the added pole to the specified location. 

6. Fill in any attributes and tap Submit. 

Note: 

Move to a safe location to fill in the attributes. The added pole remains in its original 
location. 

7. Ensure the last collected pole is selected and browse to the next pole location. Tap 
the Copy button at the bottom of the screen to create a copy of the previously added 
pole at the location of the new pole. 

8. Adjust any attributes as needed and tap Submit. 

 

Collect existing handholes 
As a mobile worker, collect existing handholes in the field. 
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1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Communications Asset Collector map. 

3. Browse to the collection location. 

4. Tap Add . 

5. From the list of features, search for Handhole by swiping up or typing Handhole in the 

filter search bar. 

If the handhole is added to an inaccurate location, or you want to move the point 
manually, move the crosshairs to the correct location by panning the map and 
tapping Update Point. This moves the added handhole to the specified location. 

6. Fill in any attributes and tap Submit. 

Note: 

Move to a safe location to fill in the attributes. The added handhole remains in its 
original location. 

7. Ensure the last collected handhole is selected and browse to the next handhole location. 
Tap the Copy button at the bottom of the screen to create a copy of the previously added 
handhole at the location of the new handhole. 

8. Adjust any attributes as needed and tap Submit. 

 

Add map notes 
As a mobile worker, you can add a map note to the system. 

1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Communications Asset Collector map. 

3. Browse to the map note location. 

4. Tap Add. 

5. From the list of features, search for the Map Notes type by swiping up or typing a 
description in the filter search bar, select the Map Notes type, and add the note to the 
map by sketching a polygon in the map note location. 

6. Fill in the attributes and click Submit. 

The map note is added to the map and is available to be viewed and reviewed by others in the 

organization. 

 

Add data in the web 
In the workflows below, you will be taking the role of an editor adding data in ArcGIS Online. 

The workflows explain how to add data in the web, use the provided dashboard, and add and 

manage map notes. 
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Add wire aerial supports to connect poles 
As an editor, you can add an aerial span to connect poles in the web. 

1. In a browser, sign in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Communications Editors group and locate the Communications 
Editor app. Click View Application to launch the app. 

In the Communications Editor app, the Asset Editor widget is open by default on the left 
side of the window when the app opens. 

4. In the Asset Editor pane, click the template drop-down menu and select Wire Aerial 
Support, and select Aerial Span from the list of options. 

Note: 

Zoom to the visible range for the Wire Aerial Support layer if no templates are visible in 
the Asset Editor. 

5. Scroll down and fill in the preset values. 
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6. With Aerial Span selected, press Ctrl to snap to the pole by hovering over the point, and 
click to start the line.

 

7. Draw the aerial span to the next pole, press Ctrl, and double-click to finish the sketch. 

You are prompted to update attributes and save. 

8. Click Save. 

9. Repeat steps 4 through 8 to add the remaining aerial spans. 

 

Add trenches to connect handholes 
As an editor, you can add an trench to connect handholes in the web. 

1. In a browser, sign in to your ArcGIS organization. 
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2. At the top of the site, click Groups. 

3. Browse to the Communications Editors group and locate the Communications 
Editor app. Click View Application to launch the app. 

In the Communications Editor app, the Asset Editor widget is open by default on the left 

side of the window when the app opens. 

4. In the Asset Editor pane, click the template drop-down menu and select Wire Trench, 
and select Trench from the list of options. 

5. Scroll down and fill in the preset values. 

6. With Trench selected, press Ctrl to snap to the handhole by hovering over the point, and 
click to start the line.

 

7. Draw the trench to the next handhole, press Ctrl, and double-click to finish the sketch. 

You are prompted to update attributes and save. 
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8. Click Save. 

9. Repeat steps 4 through 8 to add the remaining trenches. 

 

Add map notes 
As a user, you can add a map note to the system. 

1. In a browser, sign in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Communications Office Users group and locate the Communications 
Viewer app. Click View Application to launch the app. 

a. In the Communications Viewer, click the Map Notes Editor widget to open it. 

b. Choose a map note issue type and sketch a polygon in the desired map note 
location. 

c. Enter attributes and click Save. 

 

Manage map notes 
As a GIS manager, you can review and resolve map notes about your system to ensure 

issues are addressed. 

1. In a browser, sign in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Communications Map Notes Managers group and locate 
the Communications Map Notes Manager app. Click View Application to launch the 
app. 

In the upper right of the app, there are a number of widgets that have been configured to filter, 

edit, update, and manage map notes. 

4. Review the list of included widgets to learn how to use them to manage map notes: 

• Legend—View a list of included layers in the map. The legend displays what is 
visible on the map, so zooming in or out can expand or reduce the list if scale 
suppression is set on the layers. 

• Filter—Use the Creation Date, Issue, and Severity filters to view only map notes 
that fit the entered criteria. Select a date range or an option from the drop-down 
menu and turn on a filter to view the selection on the map. 

• Batch Edit Map Notes—Select a group of map notes using one of the selection 
tools and update values for all the selected features at once. 

• Map Notes Editor—Add a new map note or edit an existing map note. 

• Map Notes Summary—View all the map notes by status and expand each section 
to view the individual notes. Click a note to zoom to it on the map and view its 
attributes in a pop-up. 
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These changes are reflected in other apps and maps across the system so others in your 

organization can view the latest information. 

 

Use the communications dashboard 
As a member of the utility, you want to have a comprehensive view of your communications 

system assets. 

1. In a browser, sign in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Communications Office Users group and locate the Communications 
Dashboard app. Click View Dashboard to launch the dashboard. 

4. View system statistics on the Civil & Engineering Assets tab, Point of Presence (PoP) 
Assets tab, and on the Structural Assets tab to view the asset information. 

 

Add data in ArcGIS Pro 
In the workflows below, you will be taking the role of an editor adding data in ArcGIS Pro. If 

you have known locations of assets or as-built drawings to work from, the following workflows 

can demonstrate using ArcGIS Pro to add data to your communications system. 

Note: 

The first time you open the Communications Data Manager map in ArcGIS Pro, the layers 
will show as broken. Follow the steps to Configure the Communications Data Manager 
ArcGIS Pro project to fix your layers. 

 

Add a commercial service 
As an editor, you can add a commercial service to the map in ArcGIS Pro. 

1. After receiving the Communications Data Manager editing ArcGIS Pro project, sign in 
to your ArcGIS organization. 

2. In the Catalog pane, expand Maps and double-click Communications Data Manager to 
open the map. 

3. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

4. On the Edit tab, in the Features group, click Create. 

The Create Features pane appears. 

5. Select the Trench with Handhole group template from the Favorites list and click 
through the included templates to fill in the attributes. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://doc.arcgis.com/en/arcgis-solutions/11.0/reference/configure-communications-data-management.htm#ESRI_SECTION1_AE707905F3AB42F0BD96CF9BD2528FB6
https://doc.arcgis.com/en/arcgis-solutions/11.0/reference/configure-communications-data-management.htm#ESRI_SECTION1_AE707905F3AB42F0BD96CF9BD2528FB6


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 150 

6. Add the template to the map by following the steps below:

 

a. Click the location on the map to start the trench. 

b. Double-click at the location of the handhole. 

This adds the trench and handhole. 

7. Repeat steps 5 through 6 to add the remaining structural assets for your commercial 
service. 

8. Select the Drop Network Interface Unit template from the Favorites list and fill in the 
attributes. 

9. Add the drop network interface unit to the map at the commercial customers' location. 

10. Select the Fiber Drop Cable template from the Favorites list and fill in the attributes. 

11. Add the fiber template to the map by following the steps below: 

a. Click the hub terminator on the map to start the fiber cable. 

b. Snap to and click on each handhole. 

c. Finish the sketch by double-clicking at the drop network interface unit. 
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Extend a residential service 
As an editor, you can extend a residential service to the map in ArcGIS Pro. 

1. After receiving the Communications Data Manager editing ArcGIS Pro project, sign in 
to your ArcGIS organization. 

2. In the Catalog pane, expand Maps and double-click Communications Data Manager to 
open the map. 

3. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

4. On the Edit tab, in the Features group, click Create. 

The Create Features pane appears. 

5. Select the Aerial Span with Pole group template from the Favorites list and click 
through the included templates to fill in the attributes. 

6. Add the template to the map by following the steps below: 

a. Click the location on the map to start the aerial span. 
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b. Double-click at the location of the pole 

This adds the aerial span and pole. 

7. Repeat steps 5 through 6 to add the remaining structural assets for extending your 
residential service. 

8. Select the Drop Network Interface Unit template from the Favorites list and fill in the 
attributes. 

9. Add a drop network interface unit to the map for each customer. 

10. Select the Fiber Drop Cable template from the Favorites list and fill in the attributes. 

11. Add the fiber template to the map by following the steps below: 

a. Click the hub terminator on the map to start the fiber cable. 

b. Snap and click on each pole along the way to the drop network interface unit. 

c. Finish the sketch by double-clicking at the drop network interface. 
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12. Repeat steps 10 through 11 for each customer service. 

 

Add map notes 
As an editor, you can add a map note to the system. 

1. After receiving the Communications Data Manager editing ArcGIS Pro project, sign in 
to your ArcGIS organization. 

2. In the Catalog pane, expand Maps and double-click Communications Data Manager to 
open the map. 

3. On the Edit tab, in the Features group, click Create. 

The Create Features pane appears. 
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4. In the Favorites list, expand the Map Notes folder and choose a Map Note option. Add 
the map note by digitizing a polygon on the map at the desired location. 

5. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

The map note is added to the map and is available to be viewed and reviewed by others 
in the organization. 
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Community Data Aggregation 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Community Data Aggregation 
Community Data Aggregation can be used to aggregate authoritative data (for example, 

addresses and parcels) and deliver focused maps and locators to key stakeholders. 

It provides a series of tools and standard layers that streamline the maintenance of regional 

address and parcel information. Traditionally, address and parcel data is managed by local 

governments. Aggregating this data into larger geographies (county, region, watershed, or 

state) helps organizations address common needs or issues that affect residents in many 

local governments. Community Data Aggregation is typically implemented by state and 

regional organizations that want to access authoritative data and address emergency 

response, permitting, as well as address land use and regulatory issues at a more regional 

level. 

The Community Data Aggregation solution delivers a set of capabilities that help you 

transform and load data source data (for example, addresses and parcels) in to target dataset 

with a standard information model. 

 

Requirements 
Community Data Aggregation requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 - 2.9 (Basic, Standard or Advanced) 
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Information products 
Community Data Aggregation includes the following information products: 

Item Description Minimum user 
type 

CommunityAddresses A feature layer to help organizations aggregate 
address information from authoritative sources 

Not Required 

CommunityParcels A feature layer to help organizations aggregate 
parcel information from authoritative sources 

Not Required 

DataAssistant An ArcGIS Pro Add-in that includes the Data 
Assistant ribbon and a series of tools that have 
been optimized for migrating data from a source 
dataset to a target dataset 

GIS 
Professional 
Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Community Data Aggregation 
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Configure Community Data Aggregation 
Learn how to configure the Community Data Aggregation solution to meet specific needs in 

your organization.  

 

Set up data aggregation project 
Before you begin aggregating data, create an ArcGIS Pro project, install the Data 

Assistant add-in, and add the Data Assistant ribbon to the project so you can access the tools 

and features of the add-in. 

 

Data Assistant add-in 
The Data Assistant add-in includes a series of tools that have been optimized for migrating 

data from a source dataset to a target dataset that may have a different data structure. It 

includes a series of predefined methods to automatically populate attributes when migrating 

data to the target dataset. For example, one method concatenates multiple source fields into a 

single target field. Other methods help you extract the left or right characters from a field or 

split a single source field into multiple target fields. 

To use the Data Assistant add-in, you must install the Data Assistant add-in on each ArcGIS 

Pro machine that will be used to migrate data from a source dataset to one or more target 

datasets. 

To install the Data Assistant add-in, complete the following steps: 

1. Deploy the Community Data Aggregation solution. 

2. Browse to the Content section of your ArcGIS organization. 

3. Click the DataAssistant item to open the item details page and click 
the Download button to download the add-in. 

4. Extract the DataAssistant .zip file. 

5. Close any open or running ArcGIS applications. 

6. Using Windows Explorer, browse to the DataAssistant folder. 

7. Double-click DataAssistant.esriAddInX to run the installer. 

8. Click the Install add-In button. 

 

Data aggregation project 
You can use an ArcGIS Pro project and the Data Assistant add-in to migrate community 

datasets from one or more source datasets to a target dataset. 

To create a data aggregation project, complete the following steps: 
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1. In ArcGIS Pro, click Add Data and browse to the My Content folder in the active portal. 
Select the CommunityAddresses or CommunityParcels layer that deployed with the 
solution. 

2. Click Add Data and browse to your source data. Add your source data to the map. 

3. Click the Data Assistant ribbon. Ensure that the Data Assistant add-in loaded and is 
accessible in ArcGIS Pro. 

4. Save the data aggregation project. 

 

Data mapping 
The Configure Data Mapping dialog box allows you to configure settings in a selected 

source-target configuration file. 

 

File panel 
The Data Assistant file properties define the active source-target configuration file and allow 

you to further configure the source dataset, target dataset, and replace settings. 

Property Description 

Source-Target 
Configuration File 

The active source-target configuration file for Data Mapping. 

Source Layer The path to the source layer for the active configuration file. 

Replace By Field 
Value 

When enabled, defines the selection query for the target layer 
that will be used when the Replace Data tool is executed. 

Target Layer The path to the target layer for the active configuration file. 

 

Fields panel 
The Data Assistant field methods define the actions to occur when migrating data from a 

source dataset to a target dataset. You can use them to populate new values in the target 

dataset or perform more advanced field mapping that may be necessary when the target 

dataset has a different data structure. 

You can configure the following Data Assistant methods in your data migration project: 

Method Description 

Copy Copy source field values to target fields. 

Default Value Sets a default value for a field. 

Value Map Set target values based on source value. 

Change Case Change the case of the source text string. 

Concatenate Concatenate source values into a string. 

Left Extract a number of characters from the left. 

Right Extract a number of characters from the right. 

Substring Extract a set of characters from a string. 

Split Split a string into parts and use one part. 

Conditional 
Value 

Construct an if/else statement. 
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Domain Map Load and map domains values. 

 

Data Assistant settings 

You configure the following settings for Data Assistant. 

 

Match library 
When updated, the Data Assistant Match Library will assist with automatically creating field 

mappings based on configuration files you create. 

Setting Description 

Update Match 
Library 

The Match Library will be updated to include the settings in the currently 
selected source-target configuration file. 

Clear Match 
Library 

All saved settings in the Match Library will be erased. 
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Use Community Data Aggregation 
The Community Data Aggregation solution delivers a set of capabilities that help you 

transform and load data source data (for example, addresses and parcels) in to target dataset 

with a standard information model. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

This solution supports two parcel data aggregation models, both of which are supported by 

the same set of tools: 

• The Contributor Model allows authoritative data producers to update the community 
layers directly on a regular schedule. 

• The Aggregator Model allows authoritative data producers to send their data to a 
community aggregator so the community layer can be updated. 

Choose a parcel data aggregation model (Contributor or Aggregator) and configure the Data 

Assistant to load your source data. 

 

A quick tour of Data Assistant 
The Data Assistant add-In includes a set of focused tools that are organized on a Data 

Assistant toolbar. These tools enable you to create data mapping files and load or replace 

data in your target datasets. 

Tool Tool name Description 

 

New File Creates a new source-target configuration file for the selected source 
and target datasets. 

 

Data 
Mapper 

Enables users to define the field mapping and settings for the 
selected source-target configure file. 

 

Preview Creates a preview of the output from the source-target configuration 
file in a local database with a sub-set of records. 

 

Stage Stage Results in a local database using a subset of the records, skip 
final processing. 

 

Append 
Data 

Appends data into the target dataset from the source dataset 
according to the settings in the source-target configuration file. 

 

Replace 
Data 

When the Replace By Field Value option has been enabled and 
configured, replaces data in the target dataset from the source 
dataset according to the settings in the source-target configuration 
file. 

 

Settings Optional settings for the data mapping tool. 
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Load data using Data Assistant add-in 
The Data Assistant add-in can be used by organization staff in order to migrate data from a 

source to target dataset, as well as schedule automated updates of the community layers. 

 

Update community layer 
The Data Assistant Add-In includes a series of tools that have been optimized for migrating 

data to the CommunityParcels and CommunityAddresses hosted feature layers, as well as 

updating this data on a regular interval. 

To migrate your source data to one of the hosted feature layers provided and configure 

updates, complete the following steps: 

1. Open your data aggregation project in ArcGIS Pro. 

2. Sign in to your ArcGIS organization and make it the active portal. 

3. Click the Data Assistant ribbon. 

4. In the Source Dataset parameter, browse to the source dataset, and then click OK. 

5. In the Target Dataset parameter, browse to 
the CommunityParcels or CommunityAddresses dataset, and then click OK. 

6. In the Source-Target Configuration File parameter, browse to an output location and 
provide a name, and then click OK. 

7. Click Run. 

8. Click Data Mapper and select the Configuration File you created previously. Click Fields. 

9. Select the source fields and review the initial field mapping. Configure any additional 
fields and required data assistant methods. Once complete, click Apply. 

Tip: 

For hosted feature layers in ArcGIS Online, navigate to the Data tab and click Fields to 
find more information about each field in the data model. 

10. Optionally, click Preview and select a configuration file. Specify the Number of Features 
you'd like to generate in the preview. Click Run. 

11. Click Append Data or Replace Data and select the Configuration File you created 
previously. 

• If you are contributing or aggregating data for the first time, choose Append Data. 
This tool will add all features in the source dataset to the target dataset. 

• If you are updating data that already exists in the target dataset, choose Replace 
Data. This tool will use a defined query to replace specific features in the target 
dataset. 

12. Click Run. 
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Note: 

In the Settings tool, the Update Match Library option can be used to use the updated 
field mapping to use fuzzy logic in order to speed up data loading in the future. 

 

Schedule updates 
The Data Assistant tools can be used with Windows Task Scheduler to update layers on a 

regular interval. Scheduled updates will ensure users have access to current information to 

support more dynamic decision-making. 

To update community data on a schedule, complete the following steps: 

1. Using ArcGIS Pro, open the Python window 

2. Import ArcPy by typing the following command: 

import arcpy 

3. Import a python toolbox from the Data Assistant tools by typing the following command: 

arcpy.ImportToolbox(r"C:\Users\user\AppData\Local\Esri\ArcGISPro\Assemb
lyCache\{28142961-b645-420f-ba2a-
72bcf8212558}\GPTools\DataLoadingAssistant.tbx") 

4. Specify your XML configuration file by typing the following command: 

arcpy.dla.ReplaceData(r"C:\Users\youruserprofile\Documents\ArcGIS\Proje
cts\MyProject\ReplaceData.xml") 

Note: 

Using the Append Data and the Replace data tools, you can specify multiple XML files, 
separate each XML file with “;” 

5. Right-click in python window and choose to Save Transcript, this will save a new python 
file. 

6. Open Windows Task Scheduler. 

Note: 

Use Windows Start menu search box to find Windows Task Scheduler. 

7. Select Action > Create Task and name your task. 

8. Select the Actions tab and click New. 

9. Set Action to Start a Program. 

10. Browse to the location of your ArcGIS Pro python installation. 

C:\Program Files\ArcGIS\Pro\bin\Python\Scripts\propy.bat 

11. In the Add Arguments text box, enter the full path of the script saved in step 5. 
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Community Health Assessment 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Community Health Assessment 
Community Health Assessment can be used to collect community health information, at the 

household-level, required for disaster response or health action plans. 

Health and human services professionals need information to make informed decisions as 

they allocate health resources. Timely access to community health information helps leaders 

maintain situational awareness, confirm assumptions, and understand community need. The 

Community Assessment for Public Health Emergency Response (CASPER) framework 

(developed by the World Health Organization and adopted by the United States Centers for 

Disease Control and Prevention) to plan randomized clusters, conduct health assessments, 

and monitor progress accordingly was used. This framework has become a common 

methodology used to understand community need. Community Health Assessment is typically 

implemented by health and human services agencies or health care organizations that want to 

use CASPER principles as they conduct health assessments to understand community need. 

The Community Health Assessment solution delivers a set of capabilities that help you plan 

community health survey areas, collect survey responses from random households, and 

monitor key indicators as the assessment occurs. 

 

Requirements 
Community Health Assessment requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later 

Note: 

To use this ArcGIS Solution an ArcGIS Online organizational account is required to 
configure the GeoEnrichment Service to work with ArcGIS Enterprise. 
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Information products 
Community Health Assessment includes the following information products: 

Item Description Required user 
type 

Community Health 
Assessment Planner 

An ArcGIS Pro project used by public health 
agencies to plan community health survey 
clusters used to conduct assessment surveys. 

GIS 
Professional 
Basic 

Community Health 
Assessment Manager 

A configuration of the Crowdsource Manager 
app used by assessment managers to assign 
survey teams. 

Editor 

Community Health 
Assessment Survey 

An ArcGIS Survey123 form used by assessment 
managers to conduct health assessments. 

Mobile Worker 

Community Health 
Assessment Progress 
Dashboard 

An ArcGIS Dashboards app used by health and 
human services managers to monitor survey 
teams and the progress of a health assessment. 

Viewer 

Community Health 
Assessment 
Dashboard 

An ArcGIS Dashboards app used by 
epidemiologists and executives to monitor key 
indicators as the assessment occurs. 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.3 • A new Community Health Assessment Planner ArcGIS Pro project. 

• A new Community Health Assessment Survey map. 

1.2 • A new Community Health Assessment Progress Dashboard app. 

• A new Community Health Assessment Dashboard app. 

• A new Community Health Assessment Planner. 

1.1 • A new Community Health Assessment Planner ArcGIS Pro project that 
resolves an issue where a layer reference was missing. 

1.0 • First release of Community Health Assessment 
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Configure Community Health Assessment 
Configure the Community Health Assessment solution to meet specific needs in your 

organization. 

 

Modify the survey 
The Community Health Assessment Survey is a survey with a comprehensive collection of 

questions, all based on the Community Assessment for Public Health Emergency Response 

(CASPER) Toolkit. In addition to the questions provided in the toolkit, questions for 

coronavirus disease 2019 (COVID-19) assessments are included. You have the option to add 

your own specific questions or hide some of the questions you do not need. 

All of the steps below use ArcGIS Survey123 Connect to modify the survey. See Install 

ArcGIS Survey123 for more information. 

Note: 

The following changes may impact theCommunity Health Assessment Progress 
Dashboard or the Community Health Assessment Dashboard. See dashboards 
documentation to learn more about configuring dashboards. 

 

Hide questions 
There are over 200 questions in the survey, and many may not be relevant to the issues that 

you want to assess. The survey has logical groupings of questions. Individual questions can 

be hidden, or entire groups of questions can be hidden if necessary. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Community Health Assessment Survey to download the survey. 

3. Click Community Health Assessment Survey again to open the survey. 

4. In the left pane, click Open XLSForm Spreadsheet. 

5. In the Microsoft Excel spreadsheet, verify the survey tab if highlighted. 

6. Find a green highlighted row of the type: begin group. For example, find the group 
named damage repair. 

7. Scroll over to the relevant column. 

8. Change the value of the relevant column to false. 

This process will hide all questions within that group. You can also do this for specific 

questions within a group. 

9. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect to verify the group no longer appears. 

10. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 
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Change a survey event 
Health assessments are often designed in the context of an emergency or event. Therefore, 

several questions may pertain to the status of that event. By default, the Community Health 

Assessment Survey specifies the event to be COVID-19. You can change one variable name 

in the survey to a different event, such as the name of a flood or hurricane. Then all questions 

will update to that name. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Community Health Assessment Survey to download the survey. 

3. Click Community Health Assessment Survey again to open the survey. 

4. In the left pane, click Open XLSForm Spreadsheet. 

5. In the Microsoft Excel spreadsheet, verify the survey tab if highlighted. 

6. Select the first row for the surveyevent variable. 

7. Scroll over to the default column. The value should read COVID-19 Pandemic. 

8. Change the value from COVID-19 Pandemic to the name of another event or disaster. 

There are several questions in the survey that use the surveyevent variable. Each 
question will be updated with the name of the new event or disaster. 

9. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

10. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

 

Change the team names list 
By default, the survey has a drop-down list of team names as simple number values for Team 

1 through Team 15. Follow the steps below to change the list to a smaller number of teams or 

to change the names of your teams. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Community Health Assessment Survey to download the survey. 

3. Click Community Health Assessment Survey again to open the survey. 

4. In the left pane, click Open XLSForm Spreadsheet. 

5. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all the 
selectable options for survey questions. 

6. Near the top of the spreadsheet, revise the survey to reflect your team names. 

7. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

8. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 
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Add questions 
Your community may have special circumstances you want to assess. Follow the steps below 

to add questions to the survey. 

1. Sign in to your ArcGIS organization and browse to the Community Health Assessment 
Survey hosted feature layer. 

2. Add a new field to a layer in the Community Health Assessment Survey hosted feature 
layer. 

3. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

4. Click Community Health Assessment Survey to download the survey. 

5. Click Community Health Assessment Survey again to open the survey. 

6. In the left pane, click Open XLSForm Spreadsheet. 

7. In the Microsoft Excel spreadsheet, verify the survey tab if highlighted. 

8. Insert new records that represent your new fields. Refer to the Survey123 Connect 
documentation for more details on modifying surveys. 

9. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

10. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

11. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

12. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 
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Use Community Health Assessment 
The Community Health Assessment solution delivers a set of capabilities that help you plan 

community health survey areas, collect survey responses from random households, and 

monitor key indicators as the assessment occurs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Plan survey areas 
The Community Health Assessment is based on guidelines from the Centers for Disease 

Control and Prevention (CDC) Community Assessment for Public Health Emergency 

Response (CASPER) framework. The CASPER framework uses a randomized sampling 

methodology to determine in which areas community surveys should be conducted to produce 

a result that is representative of the entire study area. 

Typically, in this specific CASPER methodology, a Community Health Assessment is 

conducted using 30 survey areas or clusters within the survey area. These clusters are 

commonly defined by census blocks as the geographic unit. The clusters are randomly 

selected, with the number of households given a higher weight, which increases the chance of 

a census block being selected. Once the clusters are defined, interview teams will select 

seven households in each survey area to conduct survey assessments. This workflow will 

guide you through the process of defining the survey areas (clusters). 

 

Plan and create survey areas 
You will start by assuming the role of an epidemiologist or GIS analyst who will create the 

survey areas within the area of interest to define where the assessments will be conducted. 

1. Download and open the Community Health Assessment Planner ArcGIS Pro project and 
sign in using your ArcGIS organizational account. 

2. On the View tab, in the Windows group, click Catalog and click Catalog Pane. 

3. In the Catalog pane, expand Tasks and double-click the Getting Started Task. 

4. Complete all steps in the Add Survey Area step. 

This task provides an overview of the process to add a Survey Areas layer that is 
deployed with the solution. The layer will have a broken reference, which you will point to 
the deployed hosted feature layer. 

5. In the Catalog pane, expand Tasks and double-click Plan Survey Areas. 

6. Complete all steps in the Plan Survey Areas task. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://links.esri.com/localgovernment/help/casper


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 169 

This task guides you through the process of identifying a geography, creating the random 
30 areas based on census blocks included in the project, and sharing the results to be 
used in other apps. 

 

Assign teams 
Once the survey areas are defined, you can assign teams to conduct the surveys within the 

selected survey areas. The Community Health Assessment Manager allows you to assign 

teams to the survey areas from the previous task. 

 

Assign teams and notify team members 
You will now assume the role of a community assessment manager or team lead who needs 

to assign teams and notify team members in their survey areas. 

1. Sign in to your ArcGIS organization and browse to the Community Health Assessment 
Manager app. 

2. Select a record in the table that you want to assign a team. 

3. Review the details of the survey area and click the Edit button in the upper right corner of 
the pane. 

4. Change the Team value to a team in the drop-down list. Optionally, add more comments 
on this survey area. 

5. Click Save. 

Once a team is assigned, you can notify individual teams of their duties and monitor 
progress. 

6. Click the Send Survey Info button. 

This button opens an email that can be sent to team members who will conduct the 
assessments in the field. 

 

Conduct health assessment surveys 
Team members conduct assessments in the field at defined intervals (using the CASPER 

methodology) based on the number of housing units in each survey area. 

 

Conduct surveys in your survey area 
You will now assume the role of an interview team member who will conduct surveys in the 

field using your mobile device. The team manager has previously assigned you to a team. 

Note: 

The default survey has many questions that may not be related to your assessment. See 
the Configure Community Health Assessment topic to learn how to modify the survey. 
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1. Open the email sent by the team manager, as described in the previous step. 

The instructions indicate the number of surveys and how surveys must be conducted. 

2. Click the first hyperlink to open a map of the assigned survey area. 

This hyperlink is used to help you ensure you are conducting assessments in the 
assigned survey area. You can use the GPS on the map to verify your location and 
determine whether you are currently within the assigned survey area. 

3. Click the second hyperlink to access the survey. 

4. If this is the first time conducting the survey, click the Download button to download 
the Survey123 field app. 

5. Sign in to ArcGIS Survey123. 

6. Expand the Identification and physical location information. 

7. Fill in all information in this group. 

8. Expand the Demographic and functional needs section. 

9. Fill in all information in this group. 

10. Scroll down to the end of the survey. 

11. Make sure to choose a value for Survey Status End. 

12. Click the green check mark in the lower right to submit the survey. 

Tip: 

The Survey123 app allows you to complete the surveys offline. The email from the 
team manager automatically fills in the team, housing units, and survey area ID when 
using the app with the steps described above. However, a browser version of 
the Community Health Assessment Survey can also be used if the app is not installed. 

 

Complete an incomplete survey 
In some cases, the person you are interviewing may be unwilling or unable to complete the 

survey in one visit and may agree to finish the survey at a later time or date. In this case, you 

can complete a survey you submitted that is incomplete. 

1. Open the Survey123 app. 

2. Select the incomplete Community Health Assessment Survey. 

3. At the bottom of the screen, click Sent. 

Note: 

This option will only appear if you have submitted surveys with the value of Incomplete. 

4. Fill in the remaining information in the survey and submit. 
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Monitor assessment progress 
Now, you will assume the role of the assessment manager or team leader who wants to 

monitor progress of the assessments being captured in the field. The CASPER toolkit has 

specific criteria defined for cooperation rates, contact rates, and completion goals. The 

traditional goal is to complete 80 percent of the surveys expected. This dashboard will help 

you determine whether you are reaching those metrics and whether the teams are completing 

their work. 

1. Sign in to your ArcGIS organization and browse to the Community Health Assessment 
Progress Dashboard. 

2. Open the Community Health Assessment Progress Dashboard app. 

The app opens with an overview of the current status. 

3. Review the list of teams and click a team in the chart to see the dashboard update. 

4. Select the other charts to monitor the progress of the health assessment. 

 

Visualize key metrics from the assessment 
The demographic and functional needs section of the survey is particularly useful to 

executives who want a quick glance of their community. Visualizing the demographic 

information will help determine whether the demographic you have surveyed aligns with the 

overall makeup of the community. In addition, key metrics such as monitoring rent and 

mortgage payments or access to healthy foods are vital health indicators. 

1. Sign in to your ArcGIS organization and browse to the Community Health Assessment 
Dashboard app. 

2. Open Community Health Assessment Dashboard. 

The app opens with an overview of the key indicators captured in the field. 

3. Review the Age Distribution chart and click a specific age category to see the 
dashboard update. 

4. Select the other charts to monitor the progress of the health assessment. 

 

View detailed survey results 
The demographic dashboard shows only a portion of what could be captured during 

assessments. Epidemiologists may prefer to highlight different information from the survey. 

You can create a dashboard or modify the demographic dashboard to see these results. In 

addition, you can export these results to share in other software applications. 

1. In a browser, go to My Surveys and sign in. 

2. Click Community Health Assessment Survey. 

3. Click the Analyze tab. 

4. Scroll down to examine the various questions that were asked during the survey. 
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5. In the upper left, search for a key term of another question collection such as COVID. 

6. Click the Data tab. 

7. Click the Export drop-down menu and export to an Excel file. 
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Community Health Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Community Health Outreach 
Community Health Outreach can be used to communicate health initiatives, increase 

participation in key initiatives, and ensure the public knows where they can locate health 

services. 

Health and Human Services agencies have learned that a community's health goes beyond 

just access to healthcare services. Understanding the interplay of behavior, physical and 

social environments, biological and genetic factors, and access to health systems helps health 

and human services agencies devise initiatives that ultimately increase the well-being of all 

residents. Increasing public health requires a robust and transparent public education 

campaign that provides accurate healthcare information, progress on key healthy community 

initiatives, and guidance needed to access assistance. A key aspect of any healthy community 

program is a web destination that helps the public locate healthcare providers, review key 

initiatives, request assistance and volunteer to help. Community Health Outreach is typically 

implemented by public or private health and human services agencies that want to increase 

the quality of life for all residents and ensure the public understands where health services 

can be found in the community. 

The Community Health Outreach solution delivers a set of capabilities that help you launch a 

healthy communities web destination, provide an authoritative inventory of healthcare 

services, and engage the public in key health initiatives that increase the quality of life for all. 

 

Requirements 
Community Health Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 Connect 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 174 

Information products 
Community Health Outreach includes the following information products: 

Item Description Required 
User Type 

Health Resource 
Inventory 

An ArcGIS Web AppBuilder app used by health and 
human service agencies to inventory all health 
resources in their community 

Editor 

Healthy 
Communities 

An ArcGIS Hub site used by health and human service 
agencies to communicate key health initiatives, 
upcoming events, and ensure the public knows 
resources available for their health needs 

Not 
required 

Health Resource 
Locator 

An ArcGIS Web AppBuilder app used by the public to 
locate health resources 

Not 
required 

Health Resource 
Feedback 

An ArcGIS Survey123 form used by providers or the 
general public add their location or provide updated 
information to the Health Resource Inventory 

Not 
required 

Healthy Community 
Outreach 
Volunteers 

An ArcGIS Survey123 form used by the public to 
volunteer to help with various public health outreach 
activities 

Not 
required 

Healthy 
Communities 
Pledge 

An ArcGIS Survey123 form used by the public to 
pledge to lead healthy lives 

Not 
required 

Community Health 
Volunteer Manager 

A Crowdsource Manager app used by health and 
human services staff to manage volunteers 

Editor 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Community Health Outreach 
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Configure Community Health Outreach 
In this topic, you will learn how to configure the Community Health Outreach solution to meet 

specific needs in your organization. 

 

Load data 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or apps. 

Once you have determined what source data must be loaded, complete one or more of the 

data loading workflows below. 

Load data from a shapefile or file geodatabase 
Load data into a health resource layer from a shapefile or file geodatabase by completing the 

following steps: 

1. Create a .zip file of your shapefile or file geodatabase. 

2. Sign in to your ArcGIS organization and browse to the feature layer you want to populate. 

3. Open the item page and click Update Data > Append Data to Layer . 

4. Click Choose File and browse to your .zip file, and click Open. 

5. Click the Contents drop-down arrow and choose Shapefile or File Geodatabase. 

6. Click Upload and Continue. 

7. Click Choose the layer that you want to load data into drop-down arrow and choose 
the layer that contains the updated data. 

8. Uncheck Update existing features. 

9. Click Show field matching and map the fields between the two layers. 

10. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Populate operational hours 
This solution leverages the Opening Hours Specification to display operating hours for a place 

or service. When you populate the data fully, Arcade expressions interpret the data and 

display the operating hours in a human-readable format in the map pop-up. Understanding the 

data specification and options in the Arcade expressions will help you populate your data and 

display it in the maps and apps provided with the ArcGIS Solution. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://enterprise.arcgis.com/en/portal/11.0/use/manage-hosted-feature-layers.htm#APPEND
https://links.esri.com/openingHours


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 176 

 

Operating Hours Specification 
The Operating Hours Specification allows you to store a combination of operating hours in a 

single field but relies on a series of data standards to render the information correctly. To 

ensure operating hours are displayed correctly, follow the standards below: 

• Enter all times using a 24-hour clock without a leading 0—for example, Tu (7:00-19:00). 

• Use a two-letter abbreviation for each day, with the first letter capitalized—for example, 
Mo, Tu, We, Th, Fr, Sa, Su. 

• When a location is open 24 hours a day, use 24 Hours—for example, Mo (24 Hours). 

• When a location is closed on a specific day, use Closed—for example, Sa-Sun (Closed). 

• Enclose all times and closed statuses in parentheses—for example, Tu (7:00-19:00); We-
Mo (Closed). 

• Separate days and ranges with a semicolon to denote the two (or more) groups—for 
example, Th-Fr (7:00-19:00); Sa (24 Hours). 

Using the standards above, a diverse set of operating hours can be populated for your places 

and services. Some common examples include the following: 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. seven days a week, populate the 
operating hours field with the following: Mo-Su (9:00-17:00). 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. during the week and closed on 
weekends, populate the operating hours field with the following: Mo-Fr (9:00-17:00); Sa-
Su (Closed). 

• To specify the place is open one day (Tuesday) a week, populate the operating hours 
field with the following: Tu (7:00-19:00); We-Mo (Closed). 

• To specify the place has operating hours that vary by day, populate the operating hours 
field with the following: Mo-Tu (9:00-17:00); We (Closed); Th-Fr (7:00-19:00); Sa (24 
Hours); Su (Closed). 

Operating hours data can be populated all at once for many places and services 

using Calculate field values or uniquely entered for each place or service using an application 

provided with the solution. 

 

Arcade expressions 
The Arcade expressions include several settings that allow you configure the look and feel of 

the operating hours when they are displayed in the web map pop-up. The expressions work 

with the operating hours data and web map pop-up configurations to display current operating 

hours in your map and app. 

This solution uses three Arcade expressions: Hours, Days, and Open/Closed. To modify one 

of these expressions, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Health 
Resource Locator map. 
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2. Open the item page and click Open in Map Viewer Classic. 

3. Click More Options and click Configure Pop-up on a health resource layer. 

4. Under Attribute Expressions, double-click the Arcade expression you want to modify. 

Each Arcade expression has a set of variables that can be configured according to your 

organization’s needs. Review the expression notes and modify the variables as needed. Do 

not change anything else in the expressions. 

5. Click OK. 

6. Repeat the above steps for each health resource layer in the map. 

 

Configure Health Resource Locator 
The Health Resource Locator can be used by the public to locate health resources. It has 

some common configuration options you may want to explore and directions from your current 

location to a health resource can be enabled. 

 

Configure directions 
Health Resource Locator can be configured to provide directions to the nearest health 

resources. Follow the steps below to enable directions: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Health 
Resource Locator app. 

2. Click Edit Application. 

3. Browse to the Locate Health services widget and click the Edit button. 

4. Click the Direction Settings tab, check Enable Directions and click OK. 

5. Save the app and share it with everyone. 

6. Open the app. 

 

Modify surveys 
The Healthy Community Outreach Volunteers form can be used by the public to volunteer to 

help with various public health outreach activities. After reviewing the survey, you may decide 

you want to collect additional information from volunteers when they apply. 

To modify the volunteer survey, complete the following steps: 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click a survey and if prompted, download the Healthy Community Outreach 
Volunteers survey. 
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Note: 

If you have not downloaded the chosen survey, you will be prompted to click Download 
in the Download window, then click OK. You will also need to click the survey again to 
open it. 

3. On the side toolbar, click the Open XLSForm spreadsheet button. 

4. Edit the survey to reflect your needs. 

5. Save and close the Microsoft Excel spreadsheet. 

6. In ArcGIS Survey123 Connect, click Publish on the side toolbar to publish your changes. 

 

Configure Healthy Communities site 
The Community Health Outreach solution includes the Healthy Communities ArcGIS Hub site 

that your organization can configure with your branding and use to share community health 

information with the public. 

 

Update with organizational information 
After deploying the Community Health Outreach solution, the Healthy Communities site layout 

only requires a few updates to fit your local context. Consider what information you already 

have and what you can most easily find. To update your site, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Healthy 
Communities site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Our Focus section, hover over each text card and click edit pencil . 

5. Update the focus area into the text box and repeat for each focus area. 

6. Scroll to the Frequently Asked Questions section, hover over the card and click the edit 
pencil, and update the questions and answers. 

7. Scroll to the Partners section, hover over the card and click the edit pencil, and update 
the image. 

8. To modify your site’s footer, click Customize Toggle  on the side panel. 

9. Click Footer. 

A custom footer is already provided, and in most cases, it needs to be updated with your 

organization's branding, contact information, and social media references. 

10. Click the HTML text box. 

The HTML window appears. 

11. Make the necessary changes and click Apply. 
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12. Click Save. 

 

Add health initiatives 
The Healthy Communities hub site includes a section that can be used to share information on 

key health initiatives. You can share links to other hub sites, web destinations, or even health 

related apps. There are several other ArcGIS Solutions you could deploy to assist with the key 

health initiatives (for example, homelessness, COVID-19, and addiction). Any one of those 

solutions could be cataloged in the key initiatives section. 

To add key health initiatives, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Healthy 
Communities site. 

2. Click Configure App. 

3. Click the Edit tool on the left of the screen. 

4. Scroll to the Programs and Initiatives section. 

5. Hover over the gallery and click Edit. 

6. For Select Groups, choose the group used to catalog the hub sites, web destinations, or 
health related apps are shared. 

Tip: 

Each hub site, external web destination or health related app much be organized in a 
group before it can be shared in the Healthy Communities site. 

7. Click Save. 

8. Click the drop-down arrow next to Save, and chose Publish Draft. 

 

Share health metrics 
The Healthy Communities hub site includes a section that can be used to share health 

metrics. You can share a link to an existing dashboard you might have. If you do not have an 

existing dashboard, you can deploy the Performance Management solution and use this 

solution to communicate health metrics and progress made. 

To share health metrics, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Healthy 
Communities site. 

2. Open the item page and click View Application. 

3. Click the Edit button to open the site editor. 

4. Scroll to the How Are We Doing? section, hover over the card and click the settings 
button. 

5. Click the Select Application button. 
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6. Browse to your dashboard or deployment of the Performance Management solution and 
click Select. 

7. Click Save and click Publish Draft. 

 

Share items with public 
Several maps and apps included in the Community Health Outreach solution must be shared 

with everyone to display on the public-facing hub site. The solution includes several feature 

layer views to avoid sensitive or incorrect data from being shared accidentally. Use the 

information below to help determine which items need to be shared with everyone. 

To share the Community Health Outreach maps and apps, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Health 
Resource Locator app. 

2. Open the item page and click Share. 

3. In the Share window, click Everyone (public). 

4. Click Save. 

5. Repeat steps 2 through 5 to share the following items with everyone: 

Item Type Item Name 

Web Map Health Resource Locator 

Feature Layer (hosted, view) AddictionFacilities_public 

Feature Layer (hosted, view) HomelessServices_public 

Feature Layer (hosted, view) MentalHealthFacilities_public 

Feature Layer (hosted, view) PublicHealthFacilities_public 

Feature Layer (hosted, view) HealthcareFacilities_public 

Feature Layer (hosted, view) MedicalFacilties_public 

Form Healthy Communities Outreach Volunteers 

Feature Layer (hosted, view) HealthyCommunityOutreachVolunteers_public 

Web Map Healthy Community Outreach Volunteers 

Form Healthy Communities Pledge 

Feature Layer (hosted, view) HealthyCommunitiesPledge_public 

Site Application Healthy Communities 

Form Health Resource Feedback 

Feature Layer (hosted, view) HealthResourceFeedback_public 
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Use Community Health Outreach 
The Community Health Outreach solution delivers a set of capabilities that help you launch a 

healthy communities web destination, provide an authoritative inventory of healthcare 

services, and engage the public in key health initiatives that increase the quality of life for all. 

In this topic, you’ll learn how to use the applications in the solution by assuming various roles 

of individuals performing these duties. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Inventory health resources 
Health resources in a community can often change. New providers become available, 

operating hours and contact information at certain facilities change over time. This can make it 

challenging for citizens in your community to know where to find accurate information. A 

variety of health resources can be added to your inventory and shared with the public. 

The Health Resource Inventory app can be used by health and human service agencies to 

inventory health resources that will be shared with the public. 

In this workflow, you will assume the role of a staff member in a health and human services 

agency. You have been asked to inventory known health resources in your community. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Community 
Health Outreach solution. 

2. View the Health Resource Inventory app. 

3. On the right, click the Resource Editor to ope the widget, if necessary. Scroll through 
the list of available health resource types and place the location of a resource of your 
choice on the map. 

The widget includes templates for various health resource types. 

4. In the widget, click the drop-down arrow or use the search field to locate the resource 
type. 

5. Click the resource symbol, and then click the resource's location on the map to place the 
point. 

Tip: 

If you already have a list of health resources in a spreadsheet, you can use the Load 
Health Resources tool to load the entire list of testing sites. 

Note: 

The Load Health Resources widget will consume credits if you use an address in your 
spreadsheet to create the new health resource location. 
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6. In the Resource Editor, complete the form with details about the health resource 
location that you placed on the map; be as complete as possible. 

Tip: 

This solution leverages the Operating Hours Specification and relies on a series of data 
standards—for example, Mo-Fr (7:00-19:00)—to render the operating hours correctly. 
For more information, see Populate operating hours. 

7. Click Save to place the point on the map. 

8. Repeat these steps for each health resource that you want to add to your inventory. 

 

Review healthy community destination 
Improving public health outcomes requires a robust and transparent public education 

campaign that provides accurate healthcare information, progress on key healthy community 

initiatives, and guidance needed to access assistance. A key aspect of any healthy community 

program is a web destination that helps the public locate healthcare providers, review key 

initiatives, request assistance and volunteer to help. 

In this workflow, you will assume the role of a resident or member of the public. You are 

interested in the healthy community program, key initiatives, health resources available in the 

community. 

1. In a browser, from the Community Health Outreach solution, view the Healthy 
Communities hub site. 

2. Review the information on the site, including the Healthy Communities program focus, 
frequently asked questions, upcoming events, and other information provided. 

3. Scroll to the Programs and Initiatives section and review the healthy community 
initiatives in your community. 

Note: 

Each initiative may link to a separate ArcGIS Hub site, depending on how you 
configured your site. 

 

Take healthy community pledge 
A healthy community is built on active participation and recognition of important factors that 

influence a persons health. Raising awareness and encouraging members of the public to live 

healthy lifestyles is an important aspect of a public education campaign. The Healthy 

Communities Pledge survey can be used to create awareness of key health issues and collect 

public pledges to lead healthy lives. To take the pledge, complete the following steps: 

1. Return to the Healthy Communities hub site, if necessary, and then scroll to the Healthy 
Communities Pledge section. 

2. Click the Take the Pledge button. 

3. Complete the survey, and then press Submit. 
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Locate health resources 
Access to comprehensive health care services is important for promoting and maintaining 

health, preventing and managing disease, reducing unnecessary disability and premature 

death, and achieving health equity for all. The Health Resource Locator app can be used by 

the public to locate health resources. To locate health resources in the community, complete 

the following steps: 

1. Return to the Healthy Communities hub site, if necessary, and then scroll to the Find 
Health Services section. 

2. Click the Find Health Services button. 

The Health Resource Locator app opens and shows all health resources from your 
inventory. 

3. Use the Locate Health Services widget to search for an address or place, or click the 
location on the map. 

4. Optionally, drag the slider to increase or decrease your search radius. 

The results shown in the Locate Health Services widget highlight the various health 
resources near the location that you entered and within your search radius. 

5. In the widget, click one of the results. 

Tip: 

If you do not see any results, search for a new location or drag the slider to increase 
the search radius. 

 

Contribute missing health resources 
Developing a comprehensive inventory of health care providers is challenging. New providers 

will open, existing providers may close, and information you have about existing providers will 

continuously evolve. Engaging health care providers and the public is one way you can curate 

a health resource inventory and respond to changes in the community. The Health Resource 

Feedback survey can be used by providers to add a missing health resource location. It can 

also be used by the public to correct inaccurate information presented in the Health Resource 

Locator. 

In this workflow, you will assume the role of a staff member at a local health care provider. 

You have noticed that your health care facility is not visible in the Health Resource 

Locator and have been asked to add the facility and services provided. 

1. Return to the Healthy Communities hub site, if necessary, and then scroll to the Find 
Health Services section. 

2. Click the let us know hyperlink. 

3. Complete the Health Resource Feedback survey, and then click Submit. 
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Tip: 

The feedback will not appear in the Health Resource Locator until is has been reviewed 
and approved by the health and human services agency in the Health Resource 
Inventory app. To be notified automatically when these submissions are entered, you 
can set up Survey123 webhooks. 

 

Volunteer to help 
Health and Human Services agencies are always looking for volunteers that can help with 

activities that advance the overall health of the community. The Healthy Community Outreach 

Volunteers survey can be used by the public to volunteer to help with various public health 

outreach activities. 

In this workflow, you will assume the role of an engaged resident in the community. You have 

noticed several healthy community issues that are of interest to you and you want to volunteer 

your time, experiences, and skills. 

1. Return to the Healthy Communities hub site, if necessary, and then scroll to 
the Volunteer to Help section. 

2. Click the Volunteer Now button. 

3. Complete the Healthy Community Outreach Volunteers form, and then click Submit. 

 

Manage volunteers 
As volunteers offer to help with a variety of health outreach activities, health and human 

services staff must contact the volunteers to ensure that each volunteer has the required skills 

and experiences and then align their skills and experiences with appropriate volunteer 

opportunities. The Community Health Volunteer Manager can be used by health and human 

services staff to manage volunteers. 

In this workflow, you will assume the role of a staff member in a health and human services 

agency. You have been asked to review volunteer applications and contact each volunteer 

after you have completed your review. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Community 
Health Outreach solution. 

2. View the Community Health Volunteer Manager app. 

3. Expand the left panel, if necessary and click the Healthy Community Outreach 
Volunteers map. 

4. From either the table or the map, select a volunteer. 

The volunteer's application opens at the bottom left. 

5. Review the volunteer's application form. 

6. Click Edit button to begin editing. 
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7. Click the Status drop-down arrow and choose a status. 

8. Optionally, in the comments text box, add comments to the volunteer application form. 

9. Click Save. 

10. Click Send Volunteer Email. 

Your email client opens, which allows you to format the email message and attach any 
additional information that you want to share with the volunteer. 

 

Review health resource contributions 
Engaging health care providers and the public is one way you can curate a health resource 

inventory and respond to changes in the community but it is critical to review contributions 

made through theHealth Resource Feedback form before making them visible in the Health 

Resource Locator app. 

In this workflow, you’ll assume the role of a staff member in a health and human services 

agency. You have been asked to review health resource contributions and make the 

necessary updates to your inventory. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Community 
Health Outreach solution. 

2. View the Health Resource Inventory app. 

On the map, red diamonds indicate the locations marked in feedback contributions. 

3. On the right, click the Resource Editor button to open the widget, if necessary. 

4. On the map, click a red diamond. 

Tip: 

Current health care resources will be symbolized with a circle. 

5. Review the health resource contribution. 

6. If applicable, use the information in the contribution to create a health resource or update 
an existing one. 

7. After you finish updating your inventory, click the red diamond again to open the 
feedback form, and then and change the status to Reviewed. 

Changing the status removes the contribution from the Health Resource Inventory. 
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Community Science 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

 

Introduction to Community Science 
Community Science can be used to solicit plant and animal observations from community 

scientists, manage each observation, and monitor community science programs. 

It encourages engagement with community scientists, and the location-enabled observations 

help community science program managers evaluate the effectiveness of community science 

initiatives. Contributing plant and animal observations to a larger initiative gives community 

scientists a sense of ownership and investment in the protection of these areas, and exploring 

observations submitted by others encourages further engagement. Community Science is 

typically implemented by conservation organizations, natural resource departments, and other 

government agencies that want to take a data-driven approach to conserving plant and animal 

populations. 

The Community Science solution delivers a set of capabilities that help you engage 

community scientists, manage incoming observations, and monitor community science 

programs. 

 

Requirements 
Community Science requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

• Survey123 Connect 
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Information products 
Community Science includes the following information products: 

Item Description Minimum 
user type 

Community 
Science Dashboard 

An ArcGIS Dashboards app used by conservation 
staff to explore reports 

Viewer 

Community 
Science Manager 

A Crowdsource Manager app used by conservation 
staff to monitor and verify reports 

Editor 

Community 
Science Survey 

An ArcGIS Survey123 form used by community 
scientists to report plant and animal observations in 
wildlife areas 

Mobile 
Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Community Science 
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Configure Community Science 
In this topic, you will learn how to configure the Community Science solution to meet specific 

needs in your organization. 

 

Edit survey categories 
Community Science Survey presents community scientists with a set of categories for their 

report. Each category is stored as a separate path in an SVG file. You can add and remove 

categories to reflect the types of reports that may be collected in your area by editing the SVG 

file in a vector graphics editor. 

Tip: 

Learn more about using SVG files in ArcGIS Survey123. 

 

Remove a category 
Removing a category from the Community Science Survey does not affect any observations 

that were previously collected. To remove a category in Community Science Survey, complete 

the following steps: 

1. Download and install Survey123 Connect. 

2. Sign in to Survey123 Connect using the account that owns your Community Science 
Survey application. 

3. Use Survey123 Connect to download and open your Community Science Survey. 

4. From the menu on the left side of the app, click Files. 

Windows Explorer opens to the directory containing the downloaded files for 
the Community Science Survey. 

5. Open the media directory. 

This folder contains the SVG files with the options for each of the categories. 

6. Open the file that contains the option you want to remove. You can use a text editor, but 
an editor such as Inkscape allows you to visualize the changes as you make them. 

7. Select and delete the option you want to remove. Each option consists of three paths: a 
colored square, one or several text elements, and a line drawing of an organism that 
belongs to the category. Delete all three belonging to the option you are removing. 

8. If necessary, rearrange the other categories to fill in the hole. 

9. Save the changes to the SVG file. 

10. In Survey123 Connect, click the Update button to preview your changes. If you are 
satisfied, click the Publish button to push your changes to your published survey. 
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Note: 

No changes are necessary in the XLSX form to remove a category from the Community 
Science Survey. 

11. Open the Item Details page for the survey hosted feature layer and click Data and then 
click the Fields button. 

12. If you want to remove a top-level category, click the I saw a field name. Remove the 
category from the list of values. 

13. Click the observation field. Remove the relevant category of categories from the list of 
values. 

14. Confirm that the category has been removed from the Dashboard view by repeating step 
11 on the Dashboard layer. 

15. Open the Survey123 field app and refresh the survey by clicking the Refresh button on 
the Download Surveys screen. Open the survey to view the changes. 

 

Add a category 
Adding a category from the Community Science Survey app does not affect any observations 

that were previously collected. To add a top-level category from Community Science Survey, 

complete the following steps: 

1. Open the Item Details page for the survey hosted feature layer and click Data and then 
click the Fields button. 

2. Click the I saw a field name. Add the new category to the list of values. 

3. Confirm that the category has been added to the Dashboard view by repeating step 1 on 
the Dashboard layer. 

4. Download and install Survey123 Connect. 

5. Sign in to Survey123 Connect using the account that owns the Community Science 
Survey. 

6. Use Survey123 Connect to download and open the Community Science Survey. 

7. Click the XLSForm button to open the survey spreadsheet. 

8. On the Choices tab, add the new option to the category list. Save the XLS form. 

9. From the menu on the left side of the app, click Files. 

Windows Explorer opens to the directory containing the downloaded files for 
the Community Science Survey. 

10. Open the media directory. 

This folder contains the SVG files with the options for each of the categories. 

11. Open the category.svg file. You can use a text editor, but an editor such as Inkscape 
allows you to visualize the changes as you make them. 

12. Copy and paste an existing option. Each option consists of three paths: a colored square, 
one or several text elements, and a line drawing of an organism that belongs to the 
category. Make sure you copy and paste all components. 
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13. Update the id property of the colored square to match the name (not the label) of the new 
option. 

14. Update the contents of the text to reflect your new category. 

15. If necessary, rearrange the categories, update the color, and provide a new graphic. 

16. Save the changes to the SVG file. 

17. In Survey123 Connect, click the Update button to preview your changes. If you are 
satisfied, click the Publish button to push your changes to your published survey. 

18. Open the Survey123 field app and refresh the survey by clicking the Refresh button on 
the Download Surveys screen. Open the survey to view the changes. 

 

Add a subcategory 
Adding a subcategory to the Community Science Survey app does not affect any observations 

that were previously collected. To add a second-level category to the Community Science 

Survey, complete the following steps: 

1. Open the Details page for the survey feature layer and click Data > Fields. 

2. Click the category field name. Add the new option to the list of values. 

3. Repeat the previous step for the dashboard view. 

4. Download and install Survey123 Connect. 

5. Sign in to Survey123 Connect using the account that owns the Community Science 
Survey. 

6. Use Survey123 Connect to download and open your Community Science Survey. 

7. Click the XLSForm button to open the survey spreadsheet. 

8. On the Choices tab, add the new option to the appropriate list. If you are creating a new 
list of options for a new category, create a new list. Save the XLS form. 

9. Optionally, add choices to the condition and observationtype lists for the new 
subcategory. 

10. If you are creating a new list of options for a new category, you will also need to add a 
question to the survey. Follow the pattern of the other subcategory selection questions to 
create a question that will display the appropriate subcategories when the new category 
is selected. Save the XLS form. If you are only adding a new option to an existing 
category, no new question is required. 

11. From the menu on the left side of Survey123 Connect, click Files. 

Windows Explorer opens to the directory containing the downloaded files for 
the Community Science Survey. 

12. Open the media directory. 

This folder contains the SVG files with the options for each of the categories. 

13. Open the SVG file that corresponds to the category where you want to add a new option. 
If you are adding options for a new category, copy, paste, rename, and edit an existing 
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file. You can use a text editor, but an editor such as Inkscape allows you to visualize the 
changes as you make them. 

14. Copy and paste an existing option within the SVG file. Each option consists of three 
paths: a colored square, one or several text elements, and a line drawing of an organism 
that belongs to the category. Make sure you copy and paste all components. 

15. Update the id property of the colored square to match the name (not the label) of the new 
option. 

16. Update the contents of the text to reflect your new option. 

17. If necessary, rearrange the options, update the color, and provide a new graphic. 

18. Save the changes to the SVG file. 

19. In Survey123 Connect, click the Update button to preview your changes. If you are 
satisfied, click the Publish button to push your changes to your published survey. 

20. Open the Survey123 field app and refresh the survey by clicking the Refresh button on 
the Download Surveys screen. Open the survey to view the changes. 
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Use Community Science 
The Community Science solution delivers a set of capabilities that help you engage 

community scientists, manage incoming observations, and monitor community science 

programs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Submit a community science report 
You will assume the role of a member of the general public setting out on a day hike in a local 

park. You will use the Community Science Survey app to submit observations along the way. 

1. In ArcGIS Survey123, open the Community Science Survey form. 

2. At the bottom of the app, tap Collect to begin collecting data. 

3. Tap the tile that best represents the type of organism you have observed, and then tap to 
report how you observed it. 

4. At the bottom of the app, tap the arrow to continue to the next question. 

5. On the next page, fill in as many details as you can, and then tap the arrow to continue to 
the next question. 

A photo or audio recording is used to help verify a report. Therefore, you are required to 
upload one. 

6. Take or upload a photo or audio recording (for audio observations) of the organism, and 
then tap the arrow to continue to the next question. 

7. Tap the map to provide the observation location and tap the date to provide information 
about when you made the observation, and then tap the arrow to continue to the next 
question. 

8. Provide any additional information about the observation that could be helpful in verifying 
the reported organism, and then tap the arrow to continue to the next question. 

9. Optionally, provide your name and email address. 

When you provide this information, the report is counted toward the top contributor 
ratings in the Community Science Dashboard. 

10. At the bottom of the app, tap the check mark. 

If you are working in a disconnected environment, you can save your report in your 
outbox and then submit it when you have connectivity. 

11. Choose whether to submit the survey now or save it for later. 
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Manage community science reports 
You will assume the role of a conservation staff member who verifies incoming reports based 

on the presented evidence. You will use the Community Science Manager app to verify a 

community science report. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Community 
Science solution. 

2. View the Community Science Manager app. 

3. In the Status column, click the filter button, and then for Status, choose Unverified. 

4. In the Observation Time column, click the arrows and choose Sort in ascending order. 

The oldest reports are now at the top of the table. 

5. Click a report to select it. 

The report opens in the information panel at the bottom right. 

6. Review the details and attached media. 

7. Click the Edit Record button , and then, if necessary, edit the categorization and 
identification of the organism based on the evidence provided. 

8. Update the status to Verified. 

9. Click Save to update the report. 

 

Explore community science reports 
You will assume the role of either a conservation staff member or a member of the general 

public who wants to explore the submitted community science reports. You will use 

the Community Science Dashboard to filter and explore the dataset to see what types of 

observations have been submitted. 

1. In a browser, from the Community Science solution, view the Community Science 
Dashboard. 

2. On the left, adjust the filters to refine the results by category, type of organism observed, 
status, or observation date. 

The map, charts, count, and observation list update to show a subset of the data based 
on your filters. 

3. On the serial charts, click the bars to further filter the results. 

4. On the right, click a report in the list to review its details. 

5. Continue exploring and applying filters to reveal more details about the community 
science program. 

6. After you finish, close the Community Science Dashboard app. 
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Conservation Easement Monitoring 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Conservation Easement 

Monitoring 
Conservation Easement Monitoring can be used to routinely inspect conservation easements 

and monitor conservation easement programs. 

It streamlines the inspection of conservation easements established to protect natural 

resources such as forests, riparian areas, and wildlife. The generation of property reports 

strengthens communication with conservation easement stakeholders and promotes 

compliance with the terms of each easement. Conservation Easement Monitoring is typically 

implemented by forestry departments, natural resource departments, and other conservation 

organizations that want to take a data-driven approach to managing conservation easements. 

The Conservation Easement Monitoring solution delivers a set of capabilities that help you 

understand current property conditions, inspect conservation easements, monitor 

conservation easement programs, and engage conservation easement stakeholders. 

 

Requirements 
Conservation Easement Monitoring requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 

• ArcGIS Survey123 

• Survey123 Connect 
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Information products 
Conservation Easement Monitoring includes the following information products: 

Item Description Minimum 
user type 

Conservation 
Easement 
Dashboard 

An ArcGIS Dashboards app used by conservation 
staff to monitor the results and progress of 
conservation easement inspections 

Viewer 

Conservation 
Easement Survey 

An ArcGIS Survey123 form used by mobile workers 
to inspect conservation easements 

Mobile 
Worker 

Conservation 
Easement 
Monitoring 

A map used by mobile workers to review existing 
conservation easements and start a routine 
inspection of a given easement 

Mobile 
Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Conservation Easement Monitoring 
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Configure Conservation Easement Monitoring 
In this topic, you will learn how to configure the Conservation Easement Monitoring solution to 

meet specific needs in your organization. 

 

Load data   
Conservation Easement Monitoring can be used to routinely inspect conservation easements 

and monitor conservation easement programs. In some cases, you may have this information 

in ArcGIS or another business system already. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the ArcGIS Solution before 

sharing the maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 

workflow below. 

Load data from a shapefile   
Load data for ConservationEasements from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Navigate to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you wish to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Conservation Easement Monitoring 
The Conservation Easement Monitoring solution delivers a set of capabilities that help you 

understand current property conditions, inspect conservation easements, monitor 

conservation easement programs, and engage conservation easement stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Conduct conservation easements inspections 
You will start by assuming the role of a mobile worker in a state forestry department capturing 

an inspection of a conservation easement. You are asked to use the Conservation Easement 

Survey to capture inspection details. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Conservation 
Easement Monitoring solution. 

2. View the Conservation Easement Monitoring map. 

3. On the map, click the conservation easement that you want to inspect. 

A pop-up with information about the conservation easement property appears. 

4. In the pop-up, review the conservation easement property details, and then click Start 
Inspection to launch the Conservation Easement Survey. 

The form opens. Property information has been automatically completed with details from 
the Conservation Easement Monitoring map. 

5. Complete the remaining survey parameters with as much additional information as 
possible. 

6. Click Submit, and then if necessary, click Send now. 

 

Monitor conservation easement programs 
Next, you will assume the role of a program manager in a state forestry department. You are 

responsible for monitoring the status of a conservation easement program. You will view the 

overall status of your conservation easement program and then look more closely at specific 

locations. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Conservation 
Easement Monitoring solution. 

2. View the Conservation Easement Dashboard. 

The Conservation Easement Dashboard opens with an overview of the current program 
status. The overview displays key metrics. This information gives management a quick 
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overview of the total number of conservation easements, conservation easements that 
require follow up after inspection, and completed conservation easement inspections. 

3. In the filter panel, for Follow Up Required, choose Yes. 

4. In the right panel, at the bottom, click the List tab, and then select an inspection from the 
list. 

The map zooms to the inspection location, and the inspection report opens in a pop-up. 

5. Review the information in the pop-up. 

 

Share inspection results 
Finally, you will assume the role of a conservation staff member in a state forestry department. 

You are responsible for generating an inspection report to send to the conservation easement 

owner or property manager. 

In a browser, go to the ArcGIS Survey123 website and sign in with your ArcGIS organization 

credentials. 

Open the Conservation Easement Survey, and then click the Data tab. 

1. From the table, select a conservation easement inspection. 

2. At the top of the page, click Report. 

3. In the Report panel, provide a report name, and then for Format, choose Portable 
Document Format (.pdf). 

4. Click Generate to create the inspection report. 

Note: 

You can generate conservation easement inspection reports for multiple inspections at 
the same time. There are two options: Select multiple inspections from the Conservation 
Easement Survey table or select the All records in the table option in the Report pane. 

Note: 

To learn more about printing reports in ArcGIS Survey123, see Print survey results 
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Conservation Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Conservation Outreach 
Conservation Outreach can be used to track wildlife conflicts and engage stakeholders in and 

around protected areas. 

It provides 24/7 access to conservation outreach information and the location-enabled wildlife 

conflict reports help conservation staff mitigate future wildlife conflicts. Conservation 

Outreach is typically implemented by conservation organizations that want to take a data-

driven approach to managing conflicts between humans and wildlife. 

The Conservation Outreach solution delivers a set of capabilities that help you capture 

conflicts between humans and wildlife, manage the resolution of each conflict, and monitor 

outreach activities in and around protected areas. 

 

Requirements 
Conservation Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 
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Information products 
Conservation Outreach includes the following information products: 

Item Description 
Minimum user 
type 

Wildlife Conflict 
Dashboard 

An ArcGIS Dashboards app used by conservation 
staff to monitor the status of wildlife conflict incidents 
within and around protected areas 

Viewer 

Wildlife Conflict 
Manager 

A Crowdsource Manager app used by conservation 
staff to manage and update wildlife conflict incident 
reports 

Editor 

Wildlife Conflict 
Reporter 

An ArcGIS Survey123 form used by conservation 
staff to collect wildlife conflict incident reports 

Mobile Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Conservation Outreach 
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Configure Conservation Outreach 
In this topic, you will learn how to configure the Conservation Outreach solution to meet 

specific needs in your organization. 

 

Load data   
Conservation Outreach can be used to track wildlife conflicts and engage stakeholders in and 

around protected areas. In some cases, you may have this information in ArcGIS or another 

business system already. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the ArcGIS Solution before 

sharing the maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 

workflow below. 

 

Load data from a shapefile   
Load data for WildlifeConflicts from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Navigate to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you wish to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Conservation Outreach 
The Conservation Outreach solution delivers a set of capabilities that help you capture and 

manage wildlife conflicts and engage local communities. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect wildlife conflict incidents 
You will start by assuming the role of a mobile worker in a protected area collecting wildlife 

conflict incidents. You have been asked to use the Wildlife Conflict Reporter survey to collect 

wildlife conflict incidents. 

1. On a mobile device, in ArcGIS Survey123, open the Wildlife Conflict Reporter form. 

2. Tap Collect. 

3. Complete the survey with as much information as possible. 

Note: 

Required information is marked with a red asterisk. 

4. Tap Submit, and then tap Send now. 

 

Manage wildlife conflicts 
Next, you will assume the role of a community outreach staff member. You will review wildlife 

conflict incidents by completing the following steps: 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Conservation 
Outreach solution. 

2. View the Wildlife Conflict Manager app. 

Wildlife incident reports are listed in the table at the top. The table can be sorted and 
filtered in various ways. 

3. In the table column headers, use the filters and arrows to filter results. 

4. Select a wildlife conflict incident from the table. 

The report details open at the bottom left. 

5. In the report details, click the Edit Record button . 

6. Make any necessary updates to the report, and then click Save. 
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Monitor wildlife conflict programs 
Now, you will assume the role of a protected area manager. You will monitor the status of 

wildlife conflict incidents within and around a protected area. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Conservation 
Outreach solution. 

2. View the Wildlife Conflict Dashboard app. 

3. On the left, adjust the filters to refine the results. 

4. On the right, select a wildlife conflict incident from the list. 

The map zooms to the incident, and a pop-up with incident details appears. 

5. Review the incident details. 
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Crime Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Crime Analysis 
Crime Analysis can be used to enhance public safety, identify emerging trends, organize law 

enforcement operations and plan crime-prevention strategies. 

It improves productivity of crime analysts with specialized tools and a tailored desktop GIS 

interface for mapping data and performing spatial analysis, making it easier to quickly 

generate high-quality crime analysis map products. Improved crime analyst productivity helps 

law enforcement decision makers optimize resource allocation, solve cases, and implement 

more effective crime-reduction strategies. Crime Analysis is typically implemented by law 

enforcement agencies that want to use data-driven strategies to reduce crime and improve 

police operations. 

The Crime Analysis solution delivers a set of capabilities to help you manage incident data, 

conduct tactical and strategic analysis, perform investigative analysis, and share web-based 

or hard-copy information products with decision makers. 

 

Requirements 
Crime Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 3.0 (Basic, Standard, or Advanced) 

• ArcGIS Spatial Analyst (optional) 
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Information products 
Crime Analysis includes the following information products: 

Item Description Minimum User Type 

CrimeAnalysis.esriAddInX An ArcGIS Pro add-in used to map, 
identify, and communicate geospatial 
patterns in law enforcement data. 

ArcGIS Desktop 
Basic or GIS 
Professional Basic 

CrimeAnalysisSolution An ArcGIS Pro project that leverages 
the capabilities included in the Crime 
Analysis add-in to generate a standard 
set of crime maps. 

ArcGIS Desktop 
Basic or GIS 
Professional Basic 

 

Release notes 
The following are the release notes: 

Version Description 

3.0 • A new Crime Analysis Add-In (2022.7.21) that includes support for ArcGIS 
Pro 3.0 and all languages supported in ArcGIS Pro 3.0. 

• A series of enhancements to the Crime Analysis ArcGIS Pro project. 

2.1 • A new Crime Analysis Add-In (2021.6.29) that resolves an issue that could 
cause the Crime Analysis ribbon to become unresponsive. 

• A series of enhancements to the Crime Analysis ArcGIS Pro project. 

2.0 • A new Crime Analysis Add-In (2020.12.17) that includes a new ribbon design 
and analysis gallery. 

• A series of new capabilities have been added: Add Graphics Layer, 
Colocation Analysis tool, Density-based Clustering tool, Link Charts, and 
Reports. 

• Existing tools have been updated to simplify parameters, streamline licensing 
and increase performance. In some cases, tool names have also been 
changed. 

1.0 • Crime Analysis is now available in the ArcGIS Solutions app. 

• The Crime Analysis Add-In (2019.10.16). 
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Configure Crime Analysis 
The Crime Analysis solution can be deployed in your ArcGIS Enterprise account. After 

deploying the solution to your ArcGIS Enterprise account, download, install and configure it to 

meet the needs in your organization. 

 

Download and install Crime Analysis solution 
The Crime Analysis solution includes the Crime Analysis Add-In, ArcGIS Pro project, sample 

data, and maps you can use to explore common crime analysis workflows. Before you begin, 

you will need to download the CrimeAnalysis.zip file containing the ArcGIS Pro project and 

Crime Analysis add-in. After this file is downloaded to your computer and extracted, you can 

install the add-in and open the ArcGIS Pro project. 

Tip: 

If you are upgrading from a previous version of the Crime Analysis Add-In, you are 
required to remove the previous version of the add-in before completing the following 
steps. 

Follow the steps below to download and install the Crime Analysis solution: 

1. Sign in to your ArcGIS organization and click Content at the top of the website. 

2. Click the My Content tab, and then click CrimeAnalysis.zip to open the item page. 

3. Click the Download button and browse to a folder on your computer. 

4. Extract CrimeAnalysis.zip. 

5. Browse to the CrimeAnalysis folder where you extracted the CrimeAnalysis.zip file. 

6. Double-click CrimeAnalysis.esriAddInX to run the installer. 

7. Click the Install Add-In button. 

 

Automate Geoprocessing Tools 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

All geoprocessing tools can be scheduled to run automatically on your computer using the 

scheduling capabilities in ArcGIS Pro or Windows Task Scheduler. Scheduling frequently run 

tools can improve productivity by reducing manual steps that you do routinely. For example, 

by scheduling the Update Features With Incident Records tool to run nightly, datasets can get 

geocoded and updated into a web layer overnight, so you have updated data ready to use 

when you arrive to work. Likewise, if you are preparing a monthly Compstat report, Kernel 
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Density or other analysis tools can be automated to run on a monthly schedule to simplify the 

process. 

 

Disable the Crime Analysis ribbon 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

The Crime Analysis ribbon is automatically added to your projects when you install the Crime 

Analysis add-in. To disable the Crime Analysis ribbon, follow these steps: 

1. From an open project, click the Project tab on the ribbon. Alternatively, on the ArcGIS 
Pro home page, click Settings. 

2. Click Options, and then click Crime Analysis. 

3. Disable Show Crime Analysis tab, click OK, and then at the top left, click the back 
arrow. 

When the Crime Analysis ribbon is disabled, it will no longer appear in ArcGIS Pro, but the 

tools will appear contextually in various locations throughout the ArcGIS Pro user interface. 

For example, on the Analysis ribbon, users will see a Crime Analysis button that lists all the 

solution tools. 

Note: 

Learn more about how to remove an add-in. 
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Use Crime Analysis 
The Crime Analysis solution delivers a set of capabilities to help you manage incident data, 

conduct tactical and strategic analysis, perform investigative analysis, and share web-based 

or hard-copy information products with decision makers. 

In this topic, you’ll learn how to use the Crime Analysis solution by exploring the Crime 

Analysis ArcGIS Pro project and key crime analysis workflows it supports. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Review the Crime Analysis project 
Crime Analysis includes an ArcGIS Pro project with the Crime Analysis add-In. The project 

includes the Crime Analysis tab and ribbon, which can be used to conduct a series of key 

analytical functions to support crime analysis. Before using the Crime Analysis tools with your 

data, familiarize yourself with the contents of the Crime Analysis project. 

1. Browse to the CrimeAnalysis folder and open the CrimeAnalysisSolution.aprx ArcGIS Pro 
project. 

2. On the ribbon, click the Crime Analysis tab.  

3. The ribbon includes four groups of tools: Data Management, Selection, Analysis Tools, 
and Information Products. 

4. In the Catalog pane, expand Maps and review the sample maps and notes provided. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog, and then click Catalog Pane. 

 

Manage incident data 
To perform analysis, crime analysts must first import data from disparate record systems and 

prepare it for use in GIS. Data import and management activities such as geocoding, date 

field transformations, and appending of spatial data must be performed daily. These time-

consuming but necessary activities leave little time for actual analysis, which limits analyst 

productivity. Crime Analysis provides tools to help analysts automate data import and simplify 

common data management activities. 

To learn more about managing data using Crime Analysis, go to the CrimeAnalysisSolution 

ArcGIS Pro project and open the following maps: 

 

• Enhance Attributes map 
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• Import Incidents (Update Features With Incident Records) 

 

Focus on specific incidents 
Crime analysts ask a wide variety of analytical questions on behalf of the organizations they 

support, which requires the analysts to query their data from a variety of date-based, spatial, 

and field attribute perspectives that can be challenging to perform without the use of GIS. 

Crime Analysis provides selection tools that can be used individually or in tandem to 

interrogate incident data and focus on specific problem subsets. 

To learn more about performing selections using Crime Analysis, go to the 

CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

 

• Summarize Percent Change and Select Layer by Date and Time 

• Kernel Density and Minus 

 

Conduct tactical and strategic analysis 
Crime analysts support the data-driven crime reduction efforts of law enforcement agencies by 

using tactical analysis methods to identify short-term crime patterns and strategic analysis 

methods to support the identification and evaluation of long-term crime problems and trends. 

Central to these methods are spatial analysis—specifically hotspot identification—but analysts 

can be challenged with understanding which techniques are available and are appropriate to 

the type of analysis they are trying to perform. Crime Analysis curates new and traditional 

spatial analysis tools appropriate for tactical and strategic crime analysis, which makes it easy 

for analysts to discover the right tool for the job. 

To learn more about conducting tactical and strategic analysis using Crime Analysis, go to the 

CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

 

• 80-20 Analysis (Hot Streets) 

• 80-20 Analysis (Repeat Locations) 

• Colocation Analysis 

• Density-based Clustering 

• Kernel Density and Minus 

• Emerging Hot Spot Analysis and Space Time Cube 

• Optimized Hot Spot Analysis and Calendar Heat Chart 

• Summarize Incident Count 

• Summarize Percent Change and Select Layer by Date and Time 

• RNR-Calculate Prediction Zones 
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• RNR-Export Near Repeat Calculator Table 

• RNR-Repeat and Near Repeat Classification 2D 

• RNR-Repeat and Near Repeat Classification 3D 

 

Perform investigative analysis 
Crime analysts support investigations by using data to explore the relationships between 

people, events, and locations. Investigative analysis helps investigators uncover criminal 

networks and understand suspect activity patterns through analysis of cell phone records, 

financial transactions, and other investigative data sources. These forms of analysis have 

previously required specialized, expensive, single-purpose software programs. Crime Analysis 

provides a set of analytical tools to support common investigative workflows such as cell 

phone analysis, financial analysis, temporal sequencing of GPS or incident data, and 

visualizing spatial relationships, such as the relationship between the locations of motor 

vehicle thefts with where those vehicles are recovered. 

To learn more about performing investigative analysis using Crime Analysis, go to the 

CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

 

• CPA-2D Cell Phone Points to Track Segments 

• CPA-3D Cell Phone Points to Track Segments 

• CPA-Cell Site Records to Feature Class 

• CPA-Cell Phone Records to Feature Class 

• CPA-Pairwise Dissolve 

• CPA-Find Space Time Matches 

• CPA-Generate Call Links 

• CPA-Generate Sector Lines 

• Origin Destination Links (MV Theft to Recovery) 

• Origin Destination Links (Financial Crime) 

• Origin Destination Links and Link Chart (Gang Turf to Member Homes) 

• Points to Track Segments 

 

Share maps and reports 
To share their work with stakeholders and decision makers, crime analysts prepare 

information products to summarize their results. Analysts get requests to deliver these 

products in both hard-copy and interactive forms. To support the needs of their customers, 

analysts need flexible options to deliver analysis results. Crime Analysis provides a set of 

information product options, including hard-copy map layouts, a rich charting library, tabular 
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reports, link analysis charts, and the ability to publish layers and maps into web mapping 

applications in ArcGIS Enterprise or ArcGIS Online. 

To learn more about sharing maps and reports using Crime Analysis, go to the 

CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

 

• Optimized Hot Spot Analysis and Calendar Heat Chart 

• Origin Destination Links and Link Chart (Gang Turf to Member Homes) 
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Crime Analysis Tool Reference 
The Crime Analysis solution delivers a set of capabilities to help you manage and query 

incident data, conduct tactical, strategic, and investigative analysis, and share web-based and 

hard-copy information products with decision makers. 

In this topic, you’ll learn how to use the Crime Analysis solution by exploring Crime Analysis 

tools, navigating the Crime Analysis Add-In, and reviewing the Repeat and Near Repeat tools. 

 

Crime Analysis tools 
The Crime Analysis solution contains many tools to support key analytical functions to 

manage data, select crime incidents, conduct tactical and strategic analysis, investigate crime 

patterns, and share information with other law enforcement personnel. These tools are 

accessed through the Crime Analysis tab and ribbon which is automatically added to your 

projects when you install the Crime Analysis add-in. The following sections contain a list of the 

tool groups on the ribbon, with details for each tool in chronological order according to a 

typical crime analysis process. 

Note: 

You will need to ensure the Crime Analysis add-in is installed before you can review the 
Crime Analysis tools. See Configure Crime Analysis for more information. 

 

Data Management tools 
Crime analysts can import data from disparate record systems to perform spatial analysis 

using ArcGIS Pro. In many cases, the data must also be geocoded and prepared for analysis. 

For example, you many want to append information about police operational boundaries, 

transform date values, or perform other transformation functions. The Data Management 

group includes a series of tools that can be used for manual or automatic data import, 

geocoding, and enhancing of data for use in crime mapping and spatial analysis. 

The following tools and commands are included in the Data Management group of the Crime 

Analysis ribbon: 

Name Description 

Add Data An ArcGIS Pro menu command that references data management tools 
that add data to the map. 

Add Graphics 
Layer 

An ArcGIS Pro menu command that provides a way to include simple 
notations on a map or layout that highlight particular areas or label 
places. 

Import Records An ArcGIS Pro Crime Analysis and Safety toolbox that converts a 
nonspatial table to point features based on x,y coordinates or street 
addresses and updates an existing dataset with new or updated record 
information from the table. 
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Convert Time 
Field 

An ArcGIS Pro Data Management tool that converts time values stored in 
a string or numeric field to a date field. 

Feature To 3D 
By Time 

An ArcGIS Pro Crime Analysis and Safety toolbox that creates a 3D 
feature class using date values from input features. 

Convert 
Coordinate 
Notation 

An ArcGIS Pro Data Management tool that converts coordinate notations 
contained in one or two fields from one notation format to another. 

Add Date 
Attributes 

An ArcGIS Pro Crime Analysis and Safety toolbox that adds fields 
containing date or time properties from an input date field, such as day, 
month, and year. 

Join Attributes 
From Polygon 

An ArcGIS Pro Crime Analysis and Safety toolbox that joins attributes 
from input polygon features to input point features. 

Enrich An ArcGIS Pro Analysis tool that enriches data by adding demographic 
and landscape facts about the people and places that surround or are 
inside data locations. 

 

Selection tools 
Before applying spatial analysis methods, crime analysts use queries to select subsets of data 

related to their topic of analysis. The Selection group on the ribbon includes a series of tools 

to perform spatial, temporal, or location-based queries of your data. 

The following tools and commands are included in the Selection group of the Crime Analysis 

ribbon: 

Name Description 

Explore An ArcGIS Pro command that allows you to explore maps and scenes by 
zooming in and out and moving around, or, in the case of scenes, moving 
up or down and looking around. 

Select An ArcGIS Pro command that provides an interactive feature selection by 
clicking a single feature in the view or digitizing a shape to select a set of 
features. 

Select By 
Attributes 

An ArcGIS Pro Data Management tool that adds, updates, or removes a 
layer or table-view selection based on an attribute query. 

Select By 
Location 

An ArcGIS Pro Data Management tool that selects features in a layer 
based on a spatial relationship to features in another dataset. 

Select Layer By 
Date and Time 

An ArcGIS Pro Crime Analysis and Safety toolbox used to select records 
based on date and time ranges or date properties, such as a single date, 
a time range, a time period, days of the week, a month, or a year. 

Attributes An ArcGIS Pro command that displays the Attribute pane. 

Clear An ArcGIS Pro command that clears the current selection in the active 
map. 

Layer From 
Selection 

An ArcGIS Pro command that creates a layer based on a selected set of 
features in an existing layer. 

 

Analysis tools 
Crime analysts perform many types of analyses to support the needs of law enforcement 

decision makers in their organization. The Analysis Tools group includes a gallery of tools that 
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can be used to perform a variety of hotspot detection techniques and other spatial methods 

that can be applied as part of tactical or strategic crime analysis projects. The gallery also 

includes tools to apply spatial methods in support of investigations, such as cell phone 

analysis, crime series sequencing, or motor vehicle theft to recovery linking. 

The following tools and commands are included in the Analysis Tools group of the Crime 

Analysis ribbon: 

Name Description 

Summary Statistics An ArcGIS Pro Analysis tool that calculates summary statistics for 
field(s) in a table. 

Buffer An ArcGIS Pro Analysis tool that creates buffer polygons around input 
features to a specified distance. 

80-20 Analysis An ArcGIS Pro Crime Analysis and Safety toolbox used to conduct an 
80/20 analysis of features and determines cluster locations by 
creating a graduated symbol layer based on the number of incidents 
occurring at each location. 

Summarize 
Incident Count 

An ArcGIS Pro Crime Analysis and Safety toolbox used to create a 
feature class with coincident point counts. Coincident point counts for 
line and point features are determined by a specified maximum 
distance. Point counts for polygon features are determined by 
whether point features or portions of features overlap with the polygon 
feature. 

Summarize 
Percent Change 

An ArcGIS Pro Crime Analysis and Safety toolbox used to calculate 
the percent change for features that correspond with point features 
that represent two equal comparison time periods. 

Optimized Hot Spot 
Analysis 

An ArcGIS Pro Spatial Statistics tool that creates a map of statistically 
significant hot and cold spots using the Getis-Ord Gi* statistic. 

Kernel Density An ArcGIS Pro Spatial Analyst tool that calculates a magnitude-per-
unit area from point or polyline features using a kernel function to fit a 
smoothly tapered surface to each point or polyline. This tool requires 
a Spatial Analyst license. 

Minus An ArcGIS Pro Spatial Analyst tool that subtracts the value of the 
second input raster from the value of the first input raster on a cell-by-
cell basis. 

Create Space Time 
Cube By 
Aggregating Points 

An ArcGIS Pro Space Time Pattern Mining tool that summarizes a set 
of points into a netCDF data structure by aggregating them into 
space-time bins. 

Emerging Hot Spot 
Analysis 

An ArcGIS Pro Space Time Pattern Mining tool that identifies trends 
in the clustering of point densities. 

Colocation Analysis An ArcGIS Pro Intelligence tool that measures local patterns of spatial 
association, or colocation, between two categories of point features 
using the colocation quotient statistic. 

Density-based 
Clustering 

An ArcGIS Pro Spatial Statistics tool that finds clusters of point 
features within surrounding noise based on their spatial distribution. 

Points To Tracks 
Segments 

An ArcGIS Pro Intelligence tool that converts a series of output paths 
from time-enabled sequences of input point data, such as GPS 
points. 
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Generate Origin-
Destination Links 

An ArcGIS Pro Analysis tool that generates connecting lines from 
origin features to destination features. The result is often referred to 
as a spider diagram. 

Cell Site Records 
to Feature Class 

An ArcGIS Pro Crime Analysis and Safety toolbox tool used to create 
cell site points and sector polygons based on input latitude, longitude, 
azimuth, beamwidth, and radius information from a cell site table. 

Cell Phone 
Records to Feature 
Class 

An ArcGIS Pro Crime Analysis and Safety toolbox tool used to import 
cell phone records from wireless network providers and associates 
those records with a cell site and sector feature classes as generated 
by the Cell Site Records To Feature Class tool based on identifier 
fields. 

Generate Call 
Links 

An ArcGIS Pro Crime Analysis and Safety toolbox tool used to create 
line features that represent the call links between phones, using cell 
site points or cell site antenna sectors based on the start date and 
time of the call. 

Find Space Time 
Matches 

An ArcGIS Pro Crime Analysis and Safety toolbox tool that identifies 
matches between two feature classes based on proximity, time 
extent, or both. 

Generate Sector 
Lines 

An ArcGIS Pro Crime Analysis and Safety toolbox tool used to create 
line features that represent the extent of cell site antenna sectors. 

Pairwise Dissolve An ArcGIS Pro Data Management tool that aggregates features 
based on specified attributes. 

Export Near 
Repeat Calculator 
Table 

A Repeat and Near Repeat tool that creates a CSV file in the format 
required by the Near Repeat Calculator from an input feature class. 
The Near Repeat Calculator is a tool published by Temple University 
for examining the statistical significance of repeat and near-repeat 
patterns in a dataset. 

Repeat and Near 
Repeat 
Classification 

A Repeat and Near Repeat tool that uses a series of distance and 
time values to classify incidents as originators, repeats, or near 
repeats, and to identify potential spatial and temporal relationships 
between incidents. 

Calculate 
Prediction Zones 

A Repeat and Near Repeat tool that identifies areas at risk of repeat 
and near-repeat incidents by specifying the spatial and temporal 
range of influence of past incidents. 

 

Information products 
After an analysis is complete, crime analysts often prepare hard-copy maps and web-based 

information products to help their organizations make data-driven decisions. The Information 

Products group includes a series of tools to create information products for analysis 

consumers, including link charts, hard-copy maps, charts, and reports, and to publish maps 

and layers to organizational web GIS portals. 

The following tools and commands are included in the Information Products group of the 

Crime Analysis ribbon: 

Name Description 

Create 
Chart 

An ArcGIS Pro command that creates a chart to visualize categories, 
distribution, change and relationships in your data. 
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New Link 
Chart 

An ArcGIS Pro command used to generate a link chart to visualize relationships 
between entities in your data and is a complementary view to the map. 

New 
Report 

An ArcGIS Pro command used to generate a report to share a well-formatted, 
multipage representation of your data. A report can contain a tabular list of 
attributes, summary information, or both. 

New 
Layout 

An ArcGIS Pro command that creates a layout and adds it to the project. 

Web Map An ArcGIS Pro command used to share the active map as a web map to your 
organization. 

Web 
Layer 

An ArcGIS Pro command used to share all data layers in the active map as a 
new web layer to your organization. 

 

Repeat and Near Repeat Analysis tools 
Repeat Victimization is an empirically observed phenomenon where when a location becomes 

the victim of a specific type of crime, that location has an elevated risk of subsequent 

victimization, a risk which drops precipitously over time. A corollary phenomenon is known as 

Near-Repeat Victimization, whereby locations immediately around a location that has been 

victimized are at elevated risk, a level that drops both as time passes and as the distance from 

the originating victim increases. Repeat and Near Repeat patterns have been observed 

across a wide variety of crime types, are believed to be spatial artifacts of serial offending 

behaviors, and thus have important implications for crime prevention and investigations. 

The Crime Analysis solution includes three custom geoprocessing tools to support analyses 

relative to Repeat and Near Repeat Victimization patterns. The Export Near Repeat Calculator 

Table tool can be used with Temple University’s Near Repeat Calculator to identify statistically 

significant patterns of Repeat and Near Repeat Victimization. The Near Repeat Classification 

tool can be used to identify historical patterns of repeat and near-repeat victimization, which 

can support investigative efforts to connect and clear cases that were not otherwise known to 

be part of a pattern. The Calculate Prediction Zones tool can be used to generate daily tactical 

crime risk predictions based on Repeat Victimization and Near-Repeat Victimization risk for 

recent crime locations. These risk predictions can be used to inform police operational 

strategies for crime reduction. 

The tools in the Crime Analysis solution related to Repeat and Near Repeat Victimization 

(Export Near Repeat Calculator Table, Repeat and Near Repeat Classification, and Calculate 

Prediction Zones) were developed in cooperation with Spencer Chainey, Ph.D., Associate 

Professor in Security and Crime Science at the Jill Dando Institute of Security and Crime 

Science, University College London. 

 

Export Near Repeat Calculator Table Tool 
The Near Repeat Calculator is a tool published by Temple University for examining the 

statistical significance of repeat and near-repeat patterns in a dataset. When a statistically 

significant repeat or near-repeat pattern is found, the spatial and temporal bandwidths of the 

pattern can then be used as parameters for analyses involving the Repeat and Near Repeat 

Classification Tool and the Calculate Prediction Zones tool. This tool creates a comma-
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separated values (CSV) file from an input feature class in the format required by the Near 

Repeat Calculator. 

 

Usage 

 

• Input features must have a date field. 

• The output comma-separated values (CSV) file does not contain any field headers 
because they are not supported by the Near Repeat Calculator. In order, the output 
fields are X, Y, Date. 

 

Syntax 

ExportNearRepeatCalculatorTable_crime (Input_Feature_Class, Output_Table, Date_Field) 

Parameter Explanation Data 
Type 

Output 
Table 

Specify the path and file name of output comma-separated values 
(CSV) file. 

File 

Date Field The field in the input feature class that contains the date on which 
each incident occurred. If the date of the incident spans a range (for 
example, date information is recorded in two fields that represent the 
from and to dates), choose the date field you consider to be most 
appropriate. It will usually be the date at the beginning of the date 
range. 

Field 

 

Licensing information: 

• ArcGIS Desktop Basic: Yes 

• ArcGIS Desktop Standard: Yes 

• ArcGIS Advanced: Yes 

 

Repeat and Near Repeat Classification tool 
Use a series of distance and time values to classify incidents as originators, repeats, or near 

repeats, and to identify potential spatial and temporal relationships between incidents. 

 

Usage 

• The Input Features must be a point feature class or shape file with a date field, 
representing the locations of incidents. 

• The tool will use all points with date values. Incidents without valid dates will be 
excluded and a warning message will print to the screen listing the skipped incidents. 

• This tool will honor a selected set of features. When the Input Features contain a 
selection, only the selected features will be considered when classifying features and 
building connections. 
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• Incidents are classified as O (Originator), NR (near repeat), or R (repeat) according to 
their proximity to each other in space and time using each combination of the specified 
spatial and temporal band values and the specified repeat distance. 

• Incidents are classified as originators if they are the originator of at least one other 
incident and have no preceding incidents within the current spatial and temporal 
ranges. 

• Incidents are classified as near-repeat incidents when they follow a previous repeat, 
near-repeat, or originating incident within the current spatial and temporal ranges, and 
do not meet the criteria to be classified as a repeat incident. 

• Incidents are classified as repeat incidents when they occur within the specified repeat 
distance and the current temporal range. An incident that meets the requirements for 
both a repeat and a near-repeat incident is classified as a repeat. 

• Incidents that do not meet the criteria for any of the above are left unclassified. 

• This tool creates the following three outputs: 

• A copy of the input incident features with classification fields added. These fields 
are populated with the classification values for each incident within each set to 
spatial and temporal ranges. For example, if a repeat distance of 1 map unit 
(Feet), spatial bands of 100 and 200 map units (Feet), and temporal bands of 7 
and 14 days are specified, the tool will append six fields with the following field 
names and aliases: 

• sb0tb1 (1 ft / 7 Days): Classification of incidents that are originators of 
repeat incidents occurring no more than 7 days later and incidents that 
occurred within the repeat distance and 7 days of a previous incident. 

• sb0tb1 (1 ft / 14 Days): Classification of incidents that are originators of 
repeat incidents occurring no more than 14 days later, and incidents that 
occurred within the repeat distance and 14 days of a previous incident. 

• sb1tb1 (100 ft / 7 Days): Classification of incidents that are originators of 
repeat and near-repeat incidents occurring no more than 7 days later and 
incidents that occurred within 100 map units and 7 days of a previous 
incident. 

• sb1tb2 (100 ft / 14 Days): Classification of incidents that are originators of 
repeat and near-repeat incidents occurring no more than 14 days later and 
incidents that occurred within 100 map units and 14 days of a previous 
incident. 

• sb2tb1 (200 ft / 7 Days): Classification of incidents that are originators of 
repeat and near-repeat incidents occurring no more than 7 days later and 
incidents that occurred within 200 map units and 7 days of a previous 
incident. 

• sb2tb2 (200 ft / 14 Days): Classification of incidents that are originators of 
repeat and near-repeat incidents occurring no more than 14 days later and 
incidents that occurred within 200 map units and 14 days of a previous 
incident. 

• The tool also appends a field called ZVALUE with values that represent the 
number of days between each incident and the smallest date value in the 
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dataset. These values can be used to visualize the time sequence of 
incidents in ArcGIS Pro so that oldest incidents appear near the ground and 
more recent incidents appear farther from the ground. 

• A line feature class that is populated with z-enabled line features representing the 
potential relationships between repeat and near-repeat incidents and their 
originators. The z values for each vertex correspond to the ZVALUE field value for 
the incident that occurs at that vertex. 

• A comma-separated values (CSV) file summary report with the number of 
incidents processed, the counts and proportions of incidents that fall within each 
spatial and temporal band combination, and the estimated half-life and half-
distance values which can be used as inputs for the Calculate Prediction Zones 
tool. 

• All distances are calculated using geodesic measurements. 

 

Syntax 

RepeatNearRepeatClassification_crime (Input_Feature_Class, Output_Incident_Points, 

Output_Incident_Connection_Lines, Output_Summary_Report_Location, Date_Field, 

Repeat_Incident_Distance, Spatial_Bands, Temporal_Bands) 

Parameter Explanation Data Type 

Input Feature 
Class 

Feature class containing points that represent the location of 
incidents to classify. The data contained in the features class 
will typically cover a long time period (for example, one year). 
The feature class must have a date field (in date format) and 
all features must have date values. 

Feature 
Layer 

Output 
Incident 
Points 

Output feature class containing calculated classification 
values. 

Feature 
Layer or 
Feature 
Class 

Output 
Summary 
Report 
Location 

The results from the analysis of repeats and near repeats 
written into a summary report (CSV file format) for review. 
The report can be found in this folder after the tool has 
completed successfully. The results are also written to the 
Messages section of the Results window. 

Folder 

Date Field The field in the input feature class containing the date on 
which each incident occurred. If the date of the incident spans 
a range (for example, date information is recorded in two 
fields that represent the from and to dates), choose the date 
field you consider to be most appropriate. It will usually be the 
date at the beginning of the date range. Values in the date 
field are used to calculate the number of days between each 
incident. 

Field 

Repeat 
Incident 
Distance 

Maximum distance in the units of the input feature class 
where adjacent incidents are considered repeats rather than 
near repeats. A value of 0 is exact to the accuracy of the 
coordinate system. If the geocoding of the input feature class 
is likely to vary very slightly, it is recommended this value be 
set to 1 (in other words, incidents will be classified as repeats 

Double 
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if the distance between them is less than or equal to 1 map 
unit). 

Spatial Bands Distance in the units of the input feature class to classify near 
incidents. Multiple bands can be entered. For example, bands 
of 200m and 400m will classify features that are located up to 
and including 200m from a previous incident and up to and 
including 400m of a previous incident. 

Multiple 
Value 

Temporal 
Bands 

Number of days to classify near incidents. Multiple bands can 
be entered. For example, bands of 7, 14 and 21 days will 
classify features that took place up to and including 7 days, 
14 days, and 21 days of a previous incident. 

Multiple 
Value 

 

Licensing information: 

• ArcGIS Desktop Basic: No 

• ArcGIS Desktop Standard: No 

• ArcGIS Advanced: Yes 

 

Calculate Prediction Zones tool 
Identify areas at risk of repeat and near-repeat incidents by specifying the spatial and 

temporal range of influence of past incidents. 

 

Usage 

• The Input Features must be a point feature class or shape file with a date field, 
representing the locations of incidents. 

• The tool will use all points with date values in the Temporal Range of Influence 
preceding the Initial Processing Date. Features with date values outside this range and 
features with null or invalid date values will not be processed. 

• This tool will honor a selected set of features. When the Input Features contain a 
selection, only the selected features will be considered when building the prediction 
zones. 

• Incidents that occur closer in time to the Initial Processing Date will have more influence 
over the prediction zones than older incidents. Areas nearer to incidents will be 
considered to have a greater risk of future incidents, up to the Spatial Range of 
Influence. Use the Spatial Half Distance and Temporal Half Life parameters to modify 
the rate of decay of influence. 

• The following fields are populated in the output feature class: 

• CREATEDATE: Text field populated with the date and time the features are 
created. 

• STARTDATE: The Initial Processing Date, or the calculated date if TODAY or 
YESTERDAY is the input value. 

• TIMEBAND: The Temporal Range of Influence used to generate the features. 
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• SPACEBAND: The Spatial Range of Influence used to generate the features. 

• RISKRANGE: The classification of risk for the area defined by that polygon. 
Higher values have a higher level of risk and lower values have a lower value of 
risk based on the location and dates of nearby incidents. 

• This tool creates up to two outputs: 

• A raster representation of the levels of risk over the area covered by the incidents. 

• Polygons generated by binning the raster values into a number of Risk Ranges 
are appended to the Output Prediction Zones Feature Class, as previously 
described. 

• Although storing the output raster in a geodatabase is supported, it is recommended to 
store the raster in a folder rather than a geodatabase, especially if this tool will be run 
as a scheduled task. 

• All distances are calculated using geodesic measurements. 

• This tool requires the Spatial Analyst extension. 

 

Syntax 

CalculatePredictionZones_crime (Input_Features, Output_Prediction_Zones_Raster, 

Output_Prediction_Zones_Feature_Class, Date_Field, Initial_Processing_Date, 

Spatial_Range_of_Influence, Spatial_Half_Distance, Temporal_Range_of_Influence, 

Temporal_Half_Life, Risk_Calculation_Method, Number_of_Risk_Ranges) 

Parameter Explanation Data Type 

Input Features Feature class containing points that represent the location of 
incidents and from which prediction zones will be calculated. 
The feature class must have a date field (in date format) and 
all features must have date values. 

Feature 
Layer 

Point Join 
Features 

Point features coincident with the input polygon or line 
features. 

Feature 
Layer 

Output 
Prediction 
Zones Raster 

Output prediction zone raster. Raster 
Layer 

Output 
Prediction 
Zones Feature 
Class 

Output feature class with polygons that represent the 
prediction zones. 

Feature 
Class or 
Feature 
Layer 

Date Field The field in the input feature class containing the date on 
which each incident occurred. If the date of the incident 
spans a range (for example, date information is recorded in 
two fields that represent the from and to dates), choose the 
date field you consider to be most appropriate. It will usually 
be the date at the beginning of the date range. Values in the 
date field are used to calculate the level of future risk based 
on a combination of when the incident occurred, the Initial 
Processing Date and the temporal decay in risk (determined 

Field 
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from the Temporal Range of Influence and the Temporal 
Half Life). 

Initial 
Processing 
Date 

The date to use from the Input Feature Class for creating the 
prediction zones. 

Date 

Spatial Range 
of Influence 

This value determines the size of the prediction zones 
around each incident (in the units of the coordinate system 
of the Input Feature Class). The value refers to the 
maximum distance from an incident that the incident is 
estimated to have on influencing the risk of future incidents 
taking place. Additionally, this value can be based on the 
area around an incident that is considered to be practical for 
resource targeting and deployment (for example, the area to 
which additional patrols are targeted). 

Double 

Spatial Half 
Distance 

The distance from an incident at which the risk is estimated 
to be half that of another incident taking place (a near-
repeat). This value is used to calculate the exponential rate 
of decay in the spatial risk of a near-repeat incident and 
must be lower than the value for the Spatial Range of 
Influence. Distance units are the units of the coordinate 
system of the input feature class. A useful initial value to 
apply is half the value of the Spatial Range of Influence. 

Double 

Temporal 
Range of 
Influence 

This value refers to the number of days before the Initial 
Processing Date that incidents are estimated to have an 
influence on the risk of future incidents taking place. More 
recent incidents have the greatest level of influence on future 
risk. Incidents that took place between the Initial Processing 
Date and the value for the Temporal Range of Influence are 
used for creating prediction zones. For example, if this value 
is set to 3, only incidents for the Initial Processing Date and 
the two days prior would be used for creating prediction 
zones. Incidents that took place three days ago would have 
less of an influence on the risk of future incidents than those 
that took place on the Initial Processing Date. 

Double 

Temporal Half 
Life 

The number of days before the Initial Processing Date on 
which the risk is estimated to be half that of further incidents 
taking place immediately after the Initial Processing Date. 
(For example, incidents that take place on the Initial 
Processing Date are considered to have the greatest 
influence on the risk of future incidents taking place. 
Incidents before the Initial Processing Date have less 
influence on future risk.) This value is used to calculate the 
exponential rate of decay in the temporal risk of a repeat and 
near-repeat incident and must be lower than the value for 
the Temporal Range of Influence. A useful initial value to 
apply is half the value of the Temporal Range of Influence. 

Double 

Risk 
Calculation 
Method 

Choose the method for calculating the predictive risk. 
'CUMULATIVE' (default) creates prediction zones where the 
value of each cell is the sum of any prediction zone cells that 
overlap. 

String 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 223 

'MAXIMUM' creates prediction zones where the value of 
each cell is the maximum value of any prediction zone cells 
that overlap. 

Number of 
Risk Ranges 

Integer value that represents the number of ranges that will 
be used in the polygon version of the output for representing 
the variation in predicted risk (for example, if this value is set 
to 2, two Risk Ranges would determine areas of primary risk 
from areas of secondary risk). 

Long 

 

Licensing information: 

• ArcGIS Desktop Basic: Requires Spatial Analyst 

• ArcGIS Desktop Standard: Requires Spatial Analyst 

• ArcGIS Advanced: Requires Spatial Analyst 
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Dam Safety 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Dam Safety 
Dam Safety can be used to routinely inspect dams to ensure the dams they regulate are in 

good condition and provide the service for which they were intended. 

It provides dam safety programs the necessary resources to adequately inspect and monitor 

their inventories. This standardized approach minimizes failure risk and improves safety of this 

critical infrastructure used for flood protection, water supply, hydropower, irrigation, and 

recreation. Dam Safety is typically implemented by natural resource departments and other 

government agencies that want to modernize their dam inspection programs. 

The Dam Safety solution delivers a set of capabilities that help you routinely inspect dams, 

manage work assignments, and monitor inspection programs. 

 

Requirements 
Dam Safety requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Basic, Standard, or Advanced) 

• ArcGIS Survey123 

• ArcGIS Workforce 

• Survey123 Connect 
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Information products 
Dam Safety includes the following information products: 

Item Description Minimum user 
type 

Dam Inspection 
Dashboard 

An ArcGIS Dashboards app used by dam safety staff to 
review fieldwork activity and monitor the progress of dam 
inspection programs 

Viewer 

Dam Inspection 
Survey 

An ArcGIS Survey123 form used by mobile workers to 
inspect upstream reservoirs, downstream hazards, and 
other relevant information at dam sites 

Mobile 
Worker 

Dam Inspection 
Assignments 

An ArcGIS Workforce Classic project used by dam safety 
staff to manage dam inspection assignments and track 
the status of each inspection. Mobile workers access the 
Dam Inspection Assignments project using the 
Workforce for ArcGIS mobile app 

Mobile 
Worker 

Dam Safety An ArcGIS Pro project used by mapping technicians to 
inventory dam information (for example, location and 
specifications) and assign dam sites to mobile workers 

GIS 
Professional 
Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Dam Safety 
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Use Dam Safety 
The Dam Safety solution delivers a set of capabilities that help you routinely inspect dams, 

manage fieldwork assignments, and monitor inspection programs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Prepare dam inspections 
You will start by assuming the role of a dam safety staff member responsible for coordinating 

dam safety field operations. You are asked to use the Dam Safety ArcGIS Pro project to setup 

your organization’s dam safety field operations. Follow the defined tasks to add inspectors, 

inventory dam information, and assign dam sites to mobile workers. 

To open the ArcGIS Pro project tasks, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Dam Safety 
solution. 

2. Download the Dam Safety desktop application template and unzip the folder. 

3. From the unzipped folder, open Dam Safety.aprx in ArcGIS Pro. 

4. In ArcGIS Pro, in the Catalog pane, expand Tasks, and then double-click the Dam 
Safety task. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to Use Dam Safety task group to see the collection 
of tasks. 

6. Follow the steps in each task. 

 

Complete a dam inspection 
Next, you will assume the role of a dam safety inspector responsible for conducting safety 

inspections of dams. You are asked to use the Dam Inspection Survey to conduct a dam 

safety inspection. 

1. Install the Survey123 field app on your mobile device, if necessary. 

2. Open the Survey123 field app, and then download and open the Dam Inspection Survey. 

3. Tap Inbox. 
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4. Select a survey from the inbox, and then complete it. 

5. After the survey is complete, tap the check mark, and then tap Send Now to submit the 
survey. 

 

Create dam inspection reports 
In the previous section, you completed a dam safety inspection. You will now create an 

inspection report of the dam safety inspection to provide to the dam owner. 

1. In a browser, go to the Survey123 website and sign in, if necessary. 

2. Open the Dam Inspection Survey, and then click the Data tab. 

3. From the Dam Inspection Survey table, select a survey. 

4. Click the Report button. 

5. In the Report panel, type a report name, and then for Format, choose PDF. 

6. Note: 

7. Generating reports consumes credits. To see how many credits your report will consume, 
click Show credits. 

8. Click the Generate button to create the inspection report. 

Note: 

To learn more about printing reports in ArcGIS Survey123, see Print survey results. 

 

Monitor dam inspections 
Finally, you will assume the role of a dam safety program manager responsible for managing 

a dam safety program. You are asked to review key metrics to better understand your dam 

safety program. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Dam Safety 
solution. 

2. View the Dam Inspection Dashboard app. 

3. On the left, adjust the filters to refine the inspection list results by the hazard 
classification, specific watershed, inspector name, inspection type, or inspection date. 

4. In the Dam Condition chart, click any bar to filter by dam condition. 

5. In the Inspections Completed panel, select any inspection to see important inspection 
details. 
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Damage Assessment 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Damage Assessment 
Damage Assessment can be used to conduct initial damage assessments after a natural 

disaster or catastrophic incident. 

Initial damage assessments are used by local officials to understand the severity and 

magnitude of damage to public and private property after an incident. In some cases, they 

may also contribute to a Joint Preliminary Damage Assessment conducted by Federal, State 

and Local officials after a disaster declaration. Information collected during these assessments 

is analyzed to determine if the incident-related costs and damages qualify for any State and/or 

Federal assistance. Any delays in the assessments could make an organization ineligible for 

State or Federal assistance. Damage Assessment is typically implemented by emergency 

management agencies that want to quickly understand the impact of a natural disaster, or 

catastrophic incident, and immediately assign resources to appropriate response and recovery 

activities. 

The Damage Assessment solution delivers a set of capabilities that help you collect damage 

reports, assign initial damage assessments, monitor the impact of a disaster on the 

community, brief internal stakeholders, and share information with the public. 

 

Requirements 
The Damage Assessment solution requires the following: 

• ArcGIS Enterprise 

• ArcGIS Notebook Server 

• ArcGIS Survey123 

• ArcGIS Survey123 Connect 

• ArcGIS QuickCapture 
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Information products 
Damage Assessment includes the following information products: 

Item Description Minimum 
User Type 

Damage 
Assessment 

An ArcGIS Hub Basic site used by emergency 
management agencies to share damage assessment 
information with internal stakeholders and the public 

Not 
required 

Damage 
Assessment 
Photo Viewer 

An Attachment Viewer app use by emergency 
management staff and the public to view photos from 
windshield reports of damaged property 

Not 
required 

Public Damage 
Report 

An ArcGIS Survey123 form used by the public to report 
damages to residence or businesses. 

Not 
required 

Damage 
Assessment 
Operations 

An ArcGIS Experience Builder app used by emergency 
management staff to manage, monitor and administer 
damage assessments 

Editor 

Windshield 
Damage Report 

An ArcGIS QuickCapture project used by public safety or 
trained volunteers to rapidly capture damage reports 

Mobile 
Worker 

Individual 
Assistance 
Survey 

An ArcGIS Survey123 form used by field inspectors with 
the Survey123 app to conduct initial damage assessments 
for private properties 

Mobile 
Worker 

Public 
Assistance 
Survey 

An ArcGIS Survey123 form used by field inspectors with 
the Survey123 app to conduct initial damage assessments 
for public-owned facilities 

Mobile 
Worker 

Individual 
Assistance 
Express Survey 

An ArcGIS Survey123 form used by field inspectors with 
the Survey123 app to assess damage that has impacted 
many structures, with varying damage levels, in one 
location (i.e. neighborhood, apartment building, mobile 
home park, etc.) 

Mobile 
Worker 

Archive Damage 
Assessment 

An ArcGIS Notebook used by GIS professionals to archive 
damage assessment reports after an incident 

Creator 

Damage 
Assessment 
Photo Extraction 

An ArcGIS Notebook used by GIS professionals to extract 
every photo collected during the initial damage 
assessment 

Creator 
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Release notes 
The following are the release notes: 

Version Description 

3.1 • A new Windshield Damage Report ArcGIS QuickCapture project. 

3.0 • A resolution to an issue where dependant questions in the Individual 
Assistance Express Survey weren't being displayed. This issue required 
updates to all related info products. 

• A new ArcGIS QuickCapture project. 

• A new Damage Assessment Photo Extraction and Archive Damage 
Assessment notebook. 

2.0 • A new Damage Assessment hub site that can be used to share damage 
assessment information with internal stakeholders and the public. 

• A new app that can be used by the public to view photos of property 
damage. 

• A new app that can be used by internal stakeholders to manage, monitor and 
administer damage assessments. 

• A new survey form that can be used to collect public damage reports. 

• A series of new survey forms that can be used to conduct Individual 
Assistance and Public Assistance assessments. 

• A new ArcGIS QuickCapture project that can be used to collect Windshield 
Damage Reports. 

• A series of new tools that can be used to collaborate with other agencies, 
share reports, export photos and archive data. 

• A series of new damage assessment layers and related feature layer views. 

1.0 • First release of Damage Assessment. 
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Configure Damage Assessment 
Learn how to configure Damage Assessment to meet specific needs in your organization. 

 

Manage active incidents 
Over time you may experience several emergency incidents. Therefore, it will be important to 

name each incident so you will be able to track the damage assessments associated to each 

incident. The Damage Assessment Operations application can be used to create incident 

names. 

Create an incident name so that all damage reports and assessments can be collected for 

each individual incident, complete the following steps: 

1. Deploy the Damage Assessment solution and open the Damage Assessment Operations 
application. 

Note: 

The Damage Assessment Operations app can be used by emergency management 
staff to manage, monitor and administer damage assessments. 

2. Click Administer. 

The Administration Tools page will open with several administration tools. 

3. In the Administer page, review the instructions in the Manage Active Incidents option and 
click the Incident Names csv link. 

The IncidentNames item page will open in your ArcGIS organization. This item contains a 
CSV file that can be used to update as each new incident occurs. 

4. Click Download and open the IncidentNames CSV file on your computer. 

5. Add a new incident name in the first field and save the file with the changes. 

6. Click Update on the IncidentNames item page and choose the updated IncidentNames 
file on your computer then click Update Item. 

  The new incident name has been added to the list of incidents and will appear on each 
survey when damage reports are collected. 

 

Modify surveys 
The Damage Assessment solution includes four surveys: Public Damage Report, Individual 

Assistance Survey, Individual Assistance Express Survey, and Public Assistance Survey. 

These surveys are all based largely upon FEMA PDA Guidebook. You can modify these 

surveys by adding your own questions or include logic to populate other values such as a 

Parcel Identification Number (PIN). 
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Tip: 

The Damage Assessment Operations, Individual Assistance Survey,Public Assistance 
Survey and Individual Assistance Express Survey forms are configured to provide 
address information and will consume credits using the ArcGIS World Geocoding Service. 
Learn more about credit usage when using the geocoding service. 

 

Modify incident list 
You may choose to limit the content of the Public Damage Report. For example, you may 

want the public to see only the current incident and not all incidents in the past. 

Follow the steps below to change the content of the Public Damage Report survey. 

1. Sign in to your ArcGIS Online organization and search for the Public Damage Report 
form. 

2. Install ArcGIS Survey123 Connect if you have not already installed it. 

3. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

4. Click Public Damage Report survey to download the survey. 

5. Click Public Damage Report survey again to open the survey. 

6. On the left pane, click Open XLSForm to open Microsoft Excel spreadsheet. 

7. Click the choices tab. 

8. Revise the list of name values to reflect the incidents you want to see the public report to 
use. 

9. Save the Microsoft Excel spreadsheet. 

10. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

 

Populate parcel information (optional) 
Parcel information can be used to link damage assessments to home ownership. The parcel 

information can then be included in each damage report. You can also use other boundary or 

jurisdiction data to populate your survey as long as you have the boundary data published as 

web layer. 

Optionally, follow the steps below to incorporate your parcels in the surveys. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Individual Assistance Survey to download the survey. 

3. Click Individual Assistance Survey again to open the survey. 

4. On the bottom pane, click Scripts. 

5. In the myJSFunctions.js file find the following line: 
https://services.arcgis.com/15kuuRedeiUAOfF5pwAerered/arcgis/rest/servi
ces/YourParcelLayer/FeatureServer/0 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://geocode.arcgis.com/arcgis/
https://doc.arcgis.com/en/arcgis-online/administer/credits.htm#ESRI_SECTION1_709121D2C7694DCAB9B8592F36F7A5BA


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 233 

6. Replace the URL in step 5 with a URL that represents your parcel layer. 

7. On the right pane, click Save to save the script. 

8. On the left pane, click Open XLSForm to open the Excel spreadsheet. 

9. Find the hidden parcelid row. 

10. Scroll over to the calculation column. 

11. Add the following logic in the cell: 
pulldata("@json",${json},"attributes.PARCEL_NO") 

12. Update the Parcel_NO value in step 11 to the name of the field that represents your 

parcel identifier from the feature layer. 

13. Save the spreadsheet 

14. Preview your changes in ArcGIS Survey123 Connect. 

15. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

Tip: 

Mobile workers face the challenge of collecting accurate information in the field. After a 
disaster, reference data such as parcel boundaries can help ensure accurate data 
collection. It can also help mobile workers navigate to assigned location so the correct 
information can be captured. To add authoritative data such as parcel boundaries, or 
address points to the survey in your map. Add the reference layers to the web map for 
Individual Assistance Survey or Public Assistance Survey and save the map. You'll then 
see this layer in the survey map. 

 

Configure Damage Assessment Operations 
The Damage Assessment Operations app allows the damage assessment coordinator to 

manage, monitor and administer damage assessments. This app can be configured to make 

the management and administration process easier by adding and updating mobile workers 

and creating in app level help to help fit organizational needs. 

 

Add mobile workers 
The Damage Assessment Operations app allows the damage assessment coordinator to 

assign reports to field personnel to conduct the damage assessments. The damage 

assessment coordinator can type in the username to assign the assessment. However, a 

more efficient way to manage the process is to maintain a list of mobile workers so that you 

can follow up with them if necessary. This can also be used as a predefined list of users to 

make it easier to select the name instead of typing. 

To add or update the list of mobile workers, complete the following steps: 

1. Sign into your ArcGIS organization. 

2. Search for the IndividualAssistance feature layer and open the item details. 
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3. Click Data. 

4. Click Fields. 

5. Scroll near the bottom and click the Assigned To field. 

6. Click Create List. 

7. For Label and Code enter values that represent the ArcGIS username. 

Note: 

The Code field value needs to match the ArcGIS username. The Label field value can 

be a user-friendly name or also be the username. 

8. Repeat and add all the usernames that are supporting operations for your active incident. 

9. Click Save. 

Now when assigning users in the Damage Assessment Operations app, you will be able 
to select mobile workers from a drop-down list. This will help ensure consistency. 

10. Repeat all the above steps for the PublicAssistance feature layer and save. 

Note: 

In the Damage Assessment Manager app within the Damage Assessment Operations 
app, the Update Multiple Reports widget includes a drop-down list that can be used to 
easily assign users. This widget requires the list for both the IndividualAssistance and 
PublicAssistance mobile workers be identical. 

 

Update help 
Additionally, you may choose to update the Damage Assessment Operations help page to 

include step-by-step instructions appropriate for your organization. To get started, copy the 

help documentation into the page and then modify it to fit your organizational needs. 

Configure the Damage Assessment Operations app help page to fit your organization by 

completing the following steps: 

1. Navigate to the item page for the Damage Assessment Center app and click the Edit 
button.  

2. Click the Page button to open the page panel and select the Help page. 

3. Use the Body node of the page panel to navigate between each section. 

4. To update the text or images select the element in the layout and make the necessary 
changes. 

5. Click Save then click publish in ArcGIS Experience Builder. 
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Configure the Damage Assessment site 
The Damage Assessment solution includes the Damage Assessment ArcGIS Hub. This site 

can be configured with your organization's branding and used to share information with the 

public. 

To update the site with your organizational information, complete the following steps: 

 

Prepare images for the Damage Assessment site 
To locate QR codes for the Damage Assessment site internal destination page, complete the 

following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Click the Apps button  in the header of the site and click QuickCapture. 

3. Open the Windshield Damage Report project and click Share. 

4. In the Sharing dialog box, under Sharing options, click QR Code, and then right-click 
the QR code and save the image locally. 

5. Close the ArcGIS QuickCapture designer. 

6. Open ArcGIS Survey123 and sign in, if necessary. 

7. Open the Individual Assistance Survey. 

8. Click Collaborate. 

9.  Next to Share this survey, click the Show the QR Code button and then click Click to 
download. 

10. Repeat the previous steps for the Individual Assistance Express Survey and Public 
Assistance Survey. 

11. Close the ArcGIS Survey123 website. 

 

Update with organizational information 
After deploying the Damage Assessment solution, the Damage Assessment Hub layout 

requires a few updates to fit your local context. 

To update the site with your organizational information, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Damage 
Assessment site. 

2. From the item page, click Configure. 

3. At the top of the site, hover over the animated message and click the click the edit pencil 

, and then click Edit in HTML. 

4. Update the existing text to the message that you want promote with the community. 
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The existing code is <span>Advisory issued on Sept 19, 2021 at 8:00AM EST. 
Watch for severe flooding.<strong> Adhere to local evacuation 
notices</strong>.</span> 

Note: 

You can remove an animated banner when a warning period has expired or there is 
nothing to report. In edit mode, point to the animated banner. On the right, in the 
vertical toolbar, click the edit pencil. In the side panel, scroll to Row CSS Class and 
delete the word warning. When you are ready to enable the animated banner, type 
warning in the Row CSS Class text box, and then, if necessary, repeat the previous 

step to modify the message. 

5. Click Save. 

6. Scroll to any sections that you want to update, hover over the card, and click the edit 

pencil  that appears in the horizontal toolbar, and then edit the content with 
information specific to your organization.  

7. In the side panel, click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

8. Click the HTML text box. 

The HTML window appears. 

9. Make the necessary changes and click Apply. 

10. Click Save. 

11. Click the Save drop-down arrow and click Publish Draft. 

Next, you will edit content on the associated Internal Destination Hub page. 

12. In the side panel, next to Customize, click the number of associated pages button. 

13. Under Home, click Internal Destination. 

14. Scroll to the Windshield Damage Report section, hover over the Place QR Code Here 
image card, and click the edit pencil. 

15. In the side panel, click the Clear Image button to delete the placeholder image, and then 
upload the QR code that you previously saved locally. 

16. Repeat these steps to replace the QR code placeholder images for the Individual 
Assistance Survey, Individual Assistance Express Survey and Public Assistance Survey 
sections. 

17. Scroll down to Damage Categories and find the placeholder for damage categories, 
Affected, Minor, Major, Destroyed and Inaccessible. Replace the placeholder images with 
your own damage guidance photos. 

18. Scroll to the Frequently Asked Questions section, hover over the card and click the edit 
pencil, and update the questions and answers. 

19. On the Internal Destination hub page click Save. Under the Save menu click Publish 
Draft. 
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You may now share your HUB page with others in your organization with unique QR 
codes for your mobile applications to provide quick access to mobile personnel. 

20. Click Save. 

21. Click the Save drop-down arrow and click Publish Draft. 

You can now share your internal Hub page with others in your organization. The unique QR 

codes provide field personnel with quick access to your organization's mobile applications. 

 

Share items with the public 
Several layer views, maps and apps included in the Damage Assessment solution must be 

shared with everyone so they can be accessed by the public on the Damage Assessment site. 

To share items with the public, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Damage 
Assessment folder. 

2. Next to each of the following items, check the check box: 

Name Item type 

Public Damage Report Form 

IndividualAssistance_report Feature layer (hosted, view) 

Public Damage Report Web Map 

Damage Assessment Photo Viewer Web Mapping Application 

Damage Assessment Photo Viewer Web Map 

IndividualAssistance_public Feature layer (hosted, view) 

Damage Assessment Site Application 

Caution: 

The Internal Destination page should not be shared with the public. 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 
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Use Damage Assessment 
The Damage Assessment solution delivers a set of capabilities that help you collect damage 

reports, assign initial damage assessments, monitor the impact of a disaster on the 

community, brief internal stakeholders, and share information with the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Initial damage assessment process 
The Federal Emergency Management Agency (FEMA) has two programs that provide 

assistance when a natural disaster or catastrophic event occurs. These programs are referred 

to as Individual Assistance and Public Assistance. The Damage Assessment solution 

supports both programs. 

Information collected during the initial damage assessment is provided to state and federal 

authorities to conduct the Joint Preliminary Damage Assessments. This information can be 

collected early in the process and shared with partner agencies, saving time and helping to 

prioritize recovery activities. 

Many incidents don’t result in a state or federal declaration but still require some degree of 

assistance. The Damage Assessment solution can be used for either declared or nondeclared 

emergencies. This process includes collecting damage reports, managing damage reports, 

and monitoring and sharing damage reports with other authorized agencies. 

As damage reports are collected, some of the information can be shared with the public to 

keep them informed of the recovery activities. 

 

Understand community impact 
During an emergency, it’s important for residents in the community to learn how the 

community has been impacted and how the recovery activities may affect them. The Damage 

Assessment can be used by emergency management agencies to share damage assessment 

information with those who have been impacted. 

In this workflow, you will assume the role of a resident in the community who wants to learn 

more about the impact of the incident on the community and submit a damage report. 

1. Sign in to your ArcGIS organization and browse to the Damage Assessment to learn how 
the community has been impacted by the disaster. 

2. Review the scrolling text at the top of the site to get critical information on the current 
situation. 
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3. Review the number of damage assessments completed, number of properties destroyed, 
and number that have major damage. 

4. Scroll to the Damage Reports section. 

5. Click Review conditions to open the Damage Assessment Photo Viewer app. 

  The Damage Assessment Photo Viewer app opens with information about damage 
assessment photos in the community. 

6. Click Explore Damage Photos. 

7. Click one of the photos in the photo panel on the left. 

8. Click the Zoom To button in the photo panel. 

9. Click the View in full screen button in the upper left of the photo panel. 

10. When you are finished reviewing the full extent of the photo, click the Exit full screen 
button in the upper right corner of the photo. 

11. Click the Back arrow to review more damage report photos. 

12. Use the Zoom in and Zoom out buttons to navigate the map. 

Note: 

You can also share the Damage Assessment Photo Viewer using the Facebook, 
Twitter, or Send a link buttons in the upper right corner of the application window. 

13. Close the Damage Assessment Photo Viewer application when you are done reviewing. 

14. Scroll down the page of the Damage Assessment to view additional information about the 
incident. 

15. Review the Report Damage, Frequently Asked Questions, and Cleanup Events sections 
to learn more about how the community is responding to the disaster. 

 

Submit public damage report 
Immediately after the emergency response and rescue operations are completed, initial 

damage assessments can be submitted to determine the impact of the incident. The Damage 

Assessment solution allows residents of a community to submit public damage reports using 

an ArcGIS Survey123 form available on an emergency management hub site that is hosted by 

the local jurisdiction. 

In this workflow, you will assume the role of a resident in the community who needs to submit 

a damage report on residential property. 

Tip: 

In some situations, it may not be appropriate to collect damage reports from the public. 
Therefore, you may choose to skip this workflow and move to the Submit Windshield 
Damage Reports section if you have chosen not to use the Public Damage Reports. 
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1. Sign in to your ArcGIS organization and browse to the Damage Assessment and scroll 
down the page. 

2. Click the Report damage button. 

  The Public Damage Report survey form is opened in the browser. 

3. Select the Incident Name from the drop-down list. 

Note: 

Review Configure Damage Assessment for more information populating the incident 
list. If you have not completed this step, the survey will display a default list of choices. 

4. Select the Property Type. 

5. Enter the Property Location information as prompted. 

6. Enter the Structure Type, Home Ownership, and Homeowners Insurance information 
and click Next. 

7. Enter the Contact Information and click Next. 

8. Select the type of disaster and other damage information, and then click Next. 

9. Attach a photo for Damage Extent, Additional Context, Curbside Image, and Close-
Up Image as needed.  

10. Click the Submit button to complete the public damage report.  

 

Manage damage reports 
The Damage Assessment Operations app can be used by emergency management staff to 

manage, monitor, and share damage information. 

In this workflow, you will assume the role of a damage assessment coordinator in the 

emergency management agency who needs to review, update, and assign damage reports to 

be assessed. 

1. Sign in to your ArcGIS organization and browse to the Damage Assessment Operations 
application.  

2. Click Manage to review the number of submitted reports, assigned reports, and 
completed reports. 

3. Click Manage Damage Reports under the Manage tab at the top of the application 
window. 

 

Review damage reports 
As damage reports are submitted, they are added to the Review Damage Reports list. This list 

provides an organized way to review, update, and assign field users to conduct the initial 

damage assessments. This list displays damage reports for Individual Assistance and Public 

Assistance programs. At the top of each list is a number indicating the total number of 

damage reports within the map view for each program. 
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1. In the Review Damage Reports pane, click Individual Assistance to review the 
damage reports listed by address. 

2. Click any damage report in the list to see the date, status, and type of damage report for 
the selected address. 

3. Click the damage report to view a pop-up with additional details. 

4. Click Zoom to in the pop-up. 

Note: 

By default, the application is filtered to only show those reports that are unassigned. 
This allows the coordinator to focus on only those reports that need to be assigned to 
field personnel to conduct the initial damage assessment. 

5. In the Damage report filter, turn off Filter unassigned individual assistance to see all 
damage reports. 

  All damage reports are displayed, including those that have been assigned. 

6. Turn on Filter individual assistance by assigned user to see all damage reports that 
have been assigned. 

Tip: 

After you deploy the Damage Assessment solution to your organization, you can enter 
a username in the Assigned To text box to find all damage reports assigned to a user 
in your organization. 

7. Turn on Filter individual assistance by status and select Completed from the drop-
down list to see all damage assessments for individual assistance that have been 
completed. 

8. Repeat the same steps for the Public Assistance damage report filters. 

9. Turn on Filter unassigned individual assistance to see all submitted damage reports. 

 

Update damage reports 
1. In the Review Damage Reports pane, click Individual Assistance to review the 

damage reports listed by address. 

Note: 

Damage reports that have been submitted for the same address multiple times have a 
number higher than one. This can occur if a resident has submitted a public damage 
report more than once for the same address. Windshield damage reports will not 
contain an address but may appear near the same location. 

2. Scroll down the list and select an address with two or more reports. 

3. Review the date in the list of repeated damage reports for the same address to determine 
which are duplicates of the original record. 
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4. Click one of the repeated damage reports in the list and zoom in to the selected feature. 

5. Decide which damage report is correct and which is a duplicate. 

6. In the pop-up, click the more (…) button and click the Smart Editor option. 

7. In the edit panel, set Report Status to Duplicate, which removes it from the map if the 
Filter unassigned individual assistance option is on. 

8. Click the original damage report and change Report Status to Assigned. 

9. Change Assigned to a username. 

Note: 

The username must be a valid username in the ArcGIS Online organization. 

10. Enter any concerns or instructions in the Coordinator Comments field. 

11. If necessary, move the damage report to the correct location, such as a building. 

Note: 

After you move the damage report point on top of a building, the Street Address field 
will be updated using a reverse geocoder to reflect the correct address. When you 
zoom in to street level, you can use the Switch Basemaps tool to help visualize the 
building on which the damage report should be placed. 

12. Click Save to update the damage report location and attributes. 

Tip: 

The same procedure can be used to review, edit, and assign public assistance damage 
reports. 

 

Assign damage reports 
After large disasters such as a wildfire, earthquake, or hurricane, it may be necessary to use 

additional field personnel from other agencies. In these situations, a reference grid can be 

helpful to assign those resources and to monitor damage reports within each grid. Then use 

Update Multiple Records to assign multiple damage reports to a single user. 

1. Click Create a Reference Grid in the upper right of the application window. 

2. Click Define a Grid from an Area. 

3. Click the arrow next to By Dimension. 

4. Click the Draw GRG Area using extent button and draw a rectangular box around a 
large geographic area. 

5. Click Create GRG. 

  A geographic reference grid will be created with damage reports inside each grid that is 
labeled. 
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Note: 

You can create an assignment grid based on a user-defined dimension or reference 
system such as United States National Grid (USNG). You can also publish it to the 
Damage Assessment Grid layer if you want the assignment grid to persist. 

6. Click Update Multiple Reports in the upper right of the application window. 

7. Click the Extent button and draw a rectangle around a group of damage reports within a 
grid cell. 

8. Select an Incident Name from the drop-down list to assign 

9. Select Assigned from the Report Status drop-down list 

10. Enter a username to assign multiple damage reports to the same user. 

Tip: 

You can change the status of multiple damage reports to Duplicate, Invalid, or 
Inactive if necessary. 

11. Click Save. 

Note: 

The color of the point representing the damage report will change, indicating it is now 
assigned. If Filter Unassigned Individual Assistance reports is on, the damage 
report points will be removed from the map. 

 

Conduct damage assessments 
After the damage reports have been assigned by the damage assessment coordinator, public 

safety officials will need to conduct the damage assessments that have been assigned to 

them. Each mobile worker who has been assigned to conduct an assessment will receive the 

assignment in the inbox of the survey they are using. 

 

Submit windshield damage reports 
Immediately after the disaster, it is important to determine the severity of the impact to the 

community. In some situations, public safety personnel who are already in the field may be 

able to provide an initial assessment of damages. Windshield Damage Report is an ArcGIS 

QuickCapture mobile app that can be used by public safety or volunteers to rapidly capture 

damage reports while traveling down a road. 

In this workflow, you will assume the role of a public safety official who needs to submit 

windshield damage reports. 

1. In a browser, go to the Internal Destination on the Damage Assessment. 

2. Scroll down the page and find the section on the Windshield Damage Reports. 
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3. Use the camera on your mobile device and capture the Quick Response code (QR code) 
to open the Windshield Damage Report. 

4. Scroll down the page to the Damage Categories section and review the images and 
description for each damage level. 

Note: 

More information on the degree of damage descriptions can be found in the appendix 
of the FEMA Preliminary Damage Assessment Guide. 

5. Click one of the damage levels in the Individual Assistance group. 

6. Take a picture and send the report. 

7. Repeat for one of the Public Assistance damage categories. 

  The Windshield Reports are added to the list of damage reports. 

 

Perform Individual Assistance assessment 

Note: 

When using the Windshield Report, the incident name is not populated. You can open the 
QuickCapture project and set the default or manually set the incident names after they 
are collected. 

The Individual Assistance Survey can be used by public safety personnel to gather details of 

private property losses and direct assistance to disaster survivors. 

In this workflow, you will assume the role of a mobile worker in the emergency management 

agency who needs to conduct the damage assessments assigned to you using the Individual 

Assistance Survey. 

1. In a browser, go to the Internal Destination on the Damage Assessment. 

2. Scroll down the page and find the section on the Individual Assistance Surveys. 

3. Use the camera on your mobile device and capture the QR code to open the Individual 
Assistance Survey. 

Note: 

If you don’t have a QR code assigned to your survey, you can open the ArcGIS 
Survey123 app on your mobile device and sign in to your organization. Then download 
the survey to begin the process. 

Note: 

The Individual Assistance Survey must be used on the ArcGIS Survey123 app on your 
mobile device. Using the form in a web browser will not perform needed calculations. 
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4. Click the Inbox to review which damage reports are assigned to you. 

Tip: 

If the survey is open in the collect mode, close the survey and find the inbox at the 
bottom of the survey item page. The number indicates how many damage 
assessments have been assigned to you. If you do not have assignments, you may 
choose Collect and perform brand assessments on the fly. 

5. Click Refresh to update the list of assignments. 

6. Click the nearest assigned damage report. 

Note: 

When you open a public damage report, some of the information will be provided, 
which allows you to accept or change it as needed. When you open a Windshield 
Damage Report, only the damage level will be provided. You will need to complete the 
assessment by providing all the necessary details for each location. 

7. Fill in all relevant information and add photos. 

8. Click Submit. 

9. Move to the next property in your list. 

 

Perform Individual Assistance Express assessment 
The Individual Assistance Express Survey complements the Individual Assistance Survey and 

can be used to simultaneously capture many damage structures—for example, a 

neighborhood, an apartment building, a mobile home park—with varying levels of damage. 

In this workflow, you will assume the role of a mobile worker in the emergency management 

agency who needs to conduct the damage assessments assigned to you for multiple buildings 

using the Individual Assistance Express Survey. 

1. In a browser, go to the Internal Destination on the Damage Assessment. 

2. Scroll down the page and find the section on the Individual Assistance Express 
Survey. 

3. Use the camera on your mobile device and capture the QR code to open the Individual 
Assistance Express survey. 

Note: 

If you don’t have a QR code assigned to your survey, you can open the ArcGIS 
Survey123 app on your mobile device and sign in to your organization. Then download 
the survey to begin the process. 

Note: 
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The Individual Assistance Express Survey must be used on the ArcGIS Survey123 app 
on your mobile device. Using the form in a web browser will not perform needed 
calculations. 

4. Click Collect to collect information for an area of properties.  

Note: 

The structure of this survey is slightly different so that you can assess damages for 
buildings, streets, blocks, or subdivisions and indicate the number of properties 
affected at each damage level. 

5. Fill in all relevant information and add photos. 

6. Click Submit. 

 

Perform Public Assistance assessment 
The Public Assistance Survey can be used by public safety personnel to gather details of 

public-owned properties such as schools, bridges, water treatment plants, and other facilities. 

In this workflow, you will assume the role of a mobile worker in the emergency management 

agency who needs to conduct the damage assessments assigned to you using the Public 

Assistance Survey. 

1. In a browser, go to the Internal Destination on the Damage Assessment. 

2. Scroll down the page and find the section on the Public Assistance Surveys. 

3. Use the camera on your mobile device and capture the QR code to open the Public 
Assistance Survey. 

Note: 

If you don’t have a QR code assigned to your survey, you can open the ArcGIS 
Survey123 app on your mobile device and sign in to your organization. Then download 
the survey to begin the process. 

Note: 

The Public Assistance Survey must be used on the ArcGIS Survey123 app on your 
mobile device. Using the form in a web browser will not perform needed calculations. 

4. Click Collect to collect information for a new Public Assistance assessment. 

Note: 

When you select the type of assessment, additional questions will be displayed that are 
relevant to the type of facility. Additional questions for the cost will be displayed when 
you select cost status. 

5. Fill in all relevant information and add photos. 

6. Click Submit. 
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Monitor damage assessments 
When an incident occurs, local governments need to ensure Individual Assistance priorities 

and Public Assistance needs are effectively captured and communicated to state and federal 

authorities to help the community recover. Emergency managers can monitor the impact to 

the community as the damage assessments are conducted to determine whether a state or 

national declaration threshold has been exceeded. 

The impact on the community can be measured in the Individual Assistance Dashboard and 

Public Assistance Dashboard. 

In this workflow, you will assume the role of an emergency manager who needs to review key 

metrics for both the individual assistance and public assistance damage assessments. 

1. Sign in to your ArcGIS organization and browse to the Damage Assessment Operations 
application. 

2. Click Monitor to review the number of destroyed and major impacted properties. 

3. Click Individual Assistance under the Monitor tab. 

4. Select the Incident Name from the drop-down list on the left side of the dashboard. 

5. Zoom in to a specific area. 

Note: 

The damage level indicators and the damage report list will be updated as you move 
the map extent. 

6. Select a Type of Dwelling. 

7. Select the Owner, Renter, or Occupant category from the list. 

8. Select an option in the Insured category. 

9. Review the total number of damage reports for the selected incident. 

10. Review the number of damaged properties in each damage level. 

Note: 

The percentage indicator in each damage level shows the percent of all damage 
assessments. The Unknown and Unaffected may be properties that have not been 
assessed yet. 

11. Click one of the damage reports in the list on the right side of the dashboard 

12. In the pop-up, scroll down to review the information gathered for that assessment and 
review a photo of the damage if available. 

13. Close the pop-up. 

14. Click Completed under the Report Status heading on the left side of the dashboard. 

15. Click Public Report under the Report Type heading to determine how many damage 
reports were submitted by the public. 

16. Continue reviewing the damage assessments by selecting other categories and 
comparing the results. 
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17. Click Public Assistance under the Monitor tab. 

18. Select the Incident Name from the drop-down list on the left side of the dashboard. 

19. Zoom in to a specific area. 

20. Select the desired Public Assistance Category. 

21. Review the total damage estimate of damage reports for the selected category. 

22. Click one of the damage reports in the list on the right side of the dashboard. 

23. Review the information in the pop-up on the selected facility. 

 

Administer damage assessments 
Local emergency managers need to be able to manage damage assessments for multiple 

disasters over time. This can be challenging when the recovery period of those disasters can 

be a year or more. The Damage Assessment solution provides administrative tools to help 

you prepare damage assessment for impending incidents and close out damage assessments 

from past incidents. 

 

Collaborate with partners 
Information that is collected during the initial damage assessment process can be shared with 

state and federal agencies. This shared damage assessment information can be used as the 

starting point for the Joint Preliminary Damage Assessment (PDA) process. Just as the initial 

damage assessment process is used to identify the damage, the PDA process is used to 

validate the damage in a request for state or national declaration. 

In this workflow, you will assume the role of the damage assessment coordinator who needs 

to share damage assessments with partner agencies. 

1. Sign in to your ArcGIS organization and browse to the Damage Assessment Operations 
app. 

2. Click Administer to open the administration tools page. 

3. Under the Collaborate with partners heading, click Damage Assessment Collaboration 
to open the group page. 

An item page for that group will be opened with a layer view of the completed damage 
assessments for both the Individual Assistance and Public Assistance feature layers. 
These noneditable layer views can be further restricted by limiting the fields you want to 
display. 

4. Click Invite Users to open a list of named users in your organization. 

5. Select the named users from the list that you need to share the layers. 

6. Click Add members to group. 

Note: 

For more information about sharing, see About distributed collaboration. 
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Manage active incidents 
When a disaster happens, it is critical to prepare to conduct the initial damage assessments 

quickly. The first step in that process is to add an incident name to a list so that all damage 

reports and assessments can be assigned to the correct incident. You can add the incident 

name to a CSV file and upload the incident name list at the beginning of each incident. The 

incident names will then appear in the drop-down list for each survey when they are 

downloaded or refreshed. This assures that the incident name in damage reports will be easily 

accessible and consistent for all mobile workers. The incident names list in the dashboards 

will also be populated as damage assessments are submitted for review. 

In this workflow, you will assume the role of the damage assessment coordinator who needs 

to prepare for the next disaster by updating the list of incident names. 

1. Sign in to your ArcGIS organization and browse to the Damage Assessment Operations 
app.  

2. Click Administer to open the Administration Tools page. 

3. Click IncidentNames CSV under the Update Incident List heading. 

An item page will be displayed for IncidentNames.csv. 

4. Click Download and save the CSV file on your computer. 

5. Open the CSV file and update the names of the incidents, and then save your changes. 

6. Click Update on the IncidentNames item page to upload your updated IncidentNames 
list. 

Note: 

Mobile workers may need to update their surveys on their mobile devices to see the 
new incidents. 

 

Provision users 
The Damage Assessment Mobile Users group includes all the applications, web maps and 

layers needed to support mobile workflows and the Damage Assessment Operations 

applications. If you have additional mobile workers or assessment managers that need to 

access these applications, you can quickly add them to the group. 

1. Click Administer to open the Administration Tools page. 

2. Scroll down to Provision users to groups. 

3. Click the Damage Assessment Mobile Users group. 

4. Click Invite users and add the users who need appropriate access. 

 

Generate reports 
You may be asked to generate a report summarizing and listing all damage assessments. A 

simple report can be generated to include all Individual Assistance damage reports. 
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In this workflow, you will assume the role of the damage assessment coordinator who needs 

to produce a hard-copy report for decision makers. 

1. Click Administer to open the Administration Tools page. 

2. Click data view to generate a report. 

3. Type a report name and, optionally, choose the format. 

4. Click Generate. 

5. Click Download and view the report. 

Note: 

The default report is a generalized street sheet style report. These reports are 
extensible and the template document provided can be modified. See the Survey123 
Report templates documentation for guidance on extending the report. 

 

Export photos 
Some partner agencies may want to view the photos captured during the initial damage 

assessment process. This can be important to prove the damage levels from each 

assessment. You can use the Damage Assessment Photo Extraction Notebook to export 

photos into a ZIP file that can be shared. 

In this workflow, you will assume the role of the damage assessment coordinator who needs 

to share damage assessment photos with partner agencies. 

Note: 

You must be assigned a role of Administrator or custom role which includes the privilege 
to Create and edit notebooks in order to run an ArcGIS Notebooks and complete the 
following steps. 

1. Click Administer to open the Administration Tools page. 

2. Click Damage Assessment Photo Extraction Notebook. 

3. Follow the instructions in the notebook to create a ZIP file of photos for the selected 
incident. 

4. Close the notebook. 

 

Archive incidents 
The Damage Assessment solution is designed for centralized management of all damages 

over time. This design allows you to continue to conduct all damage assessments in one layer 

for the Individual Assistance and another layer for the Public Assistance damage reports. You 

do not need to deploy the entire solution for each new incident. 

When a disaster is over, it is important to close out the initial damage assessments that are 

completed. You can archive all completed damage assessments for each incident to a 

separate layer. This separate incident layer can be used for reviewing past incidents and 
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ensures you are ready to start conducting damage assessments for any new incident. The 

archived damage assessments for each incident can also be used as a backup in case of data 

loss. 

In addition, you may want to clean up the IndividualAssistance or PublicAssistance layer to 

only show incidents that are active by deleting damage assessments of past incidents. The 

Archive Damage Assessments Notebook can be used to archive and copy damage reports to 

a separate layer. 

In this workflow, you will assume the role of the damage assessment coordinator who needs 

to close the incident by archiving the damage assessment of a specific incident. 

Note: 

You must be assigned a role of Administrator or custom role which includes the privilege 
to Create and edit notebooks in order to run an ArcGIS Notebooks and complete the 
following steps. 

1. Click Archive Damage Assessment Notebook to open the notebook. 

2. Follow the instructions in the notebook to archive damage assessments for the selected 
incident. 

3. Close the notebook. 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://enterprise.arcgis.com/en/portal/11.0/use/roles.htm


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 252 

Development Impact Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Development Impact Analysis 
Development Impact Analysis can be used to evaluate proposed developments and assess 

their impact on solar radiation, shadows, and viewsheds in a community. 

It provides specialized workflows to produce information products for a comprehensive 

planning review. This optimized approach helps create powerful 3D visuals that can be used 

to inform stakeholders and improve public involvement in the development process. 

Development Impact Analysis is typically implemented by planning departments, design firms, 

and other local government agencies that want to create effective visualizations that highlight 

the impact of proposed developments. 

The Development Impact Analysis solution delivers a set of capabilities that help you create 

solar radiation maps, evaluate how proposed developments will cast shadows on existing 

buildings, and review the impact on viewsheds. 

 

Requirements 
Development Impact Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later (Advanced) 

• ArcGIS 3D Analyst extension 

• ArcGIS Spatial Analyst extension 
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Information products 
Development Impact Analysis includes the following information products: 

Item Description Minimum user 
type 

Solar 
Radiation 
Analysis 

An ArcGIS Pro project used by government planners to 
calculate solar radiation maps for the wider community 

GIS Professional 
Advanced 

Shadow 
Impact 
Analysis 

An ArcGIS Pro project used by government planners to 
evaluate the shadow impact of proposed or existing 
buildings on the surrounding community 

GIS Professional 
Advanced 

Visibility 
Analysis 

An ArcGIS Pro project used by planners to assess the 
visibility from or visibility of a proposed development 
within the community 

GIS Professional 
Advanced 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Solar Radiation Analysis ArcGIS Pro project to support ArcGIS Pro 
3.0. 

• A new Shadow Impact Analysis ArcGIS Pro project to support ArcGIS Pro 
3.0. 

• A new Visibility Analysis ArcGIS Pro project to support ArcGIS Pro 3.0. 

• Added the ability to use integrated meshes as obstruction terrain in Visibility 
Analysis. 

1.0 • First release of Development Impact Analysis 
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Use Development Impact Analysis 
The Development Impact Analysis solution delivers a set of capabilities that help you create 

solar radiation maps, evaluate how proposed developments will cast shadows on existing 

buildings, and review the impact on viewsheds. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Shadow impact analysis 
Planners can use Shadow Impact Analysis to evaluate the shadow impact of proposed or 

existing buildings on the surrounding community. 

Two tasks are available to assess shadow impact: 

• Check Shadows 

• Analyze Shadows 

 

Check shadows 
You will start by assuming the role of a planner responsible for evaluating the shadow impact 

of proposed or existing buildings on the surrounding community. You are asked to use the 

Shadow Impact Analysis ArcGIS Pro project to review potential shadow impacts of proposed 

or existing buildings. Follow the Check Shadows task to do a quick visual shadow check. 

1. Download the ShadowImpactAnalysis Desktop Application Template and unzip. 

2. Open the ShadowImpactAnalysis.aprx in the unzipped folder. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Check Shadows 
task. 

5. Follow the steps in each task. 

Note: 

Only use the created sun point locations for display purposes. All shadow impact 
calculations are based on the attributes of the sun points features, not the display 
location. Use Observer Horizon Distance to set the distance to the observer. 

 

Analyze shadows 
Next, you will continue with the role of a planner responsible for evaluating the shadow impact 

of proposed or existing buildings on the surrounding community. Follow the Analyze Shadows 

task to evaluate shadow impact of features by calculating cumulative shadow duration and 

area for the time period of interest. 
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1. Download the ShadowImpactAnalysis Desktop Application Template and unzip. 

2. Open ShadowImpactAnalysis.aprx in the unzipped folder. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Analyze Shadows 
task. 

5. Follow the steps in each task. 

 

The Create Shadows step creates shadow panels on the observer features that will hold the 

shadow attributes: 

• shadow_h—The number of hours each observer panel is in shadow 

• shadow_hits—The number of time intervals (sun positions) each observer panel is in 
shadow 

• num_suns—The number of suns 

• start_date—The start date and time 

• end_date—The end date and time 

Note: 

Check Shadows task only shows shadows as graphics in the scene, giving you a visual 
indication of where the shadows are going to be. The Analyze Shadows task allows you 
to evaluate shadow impact of features by calculating cumulative shadow duration and 
area for the time period of interest. This analysis takes longer to run than the Check 
Shadow task but calculates cumulative shadow duration and area as features with 
shadow attributes as opposed to only a visual display of the shadows. 

Shadow hits are the number of suns that cannot been seen from the observer panel. 

Depending on the time interval, the shadow hits can be the same as the shadow hours (time 

interval is 1 hour), less than the shadow hours (time interval is more than 1h), or more than 

the shadow hours (time interval is less than 1h). 

If your goal is to compare shadow impacts between different conditions, you must run this task 

multiple times, once per scenario in the comparison, such as existing versus proposed 

conditions. For example, the proposed scenario includes a model for a new development in 

the list of obstruction features along with existing buildings, whereas the existing conditions 

only include existing buildings in the obstruction features. 

To create shadow panels for a specific time during the day (for example, 10 a.m.), open the 

Sun Positions attribute table and click a record that corresponds to the time interval of interest. 

This selection is honored by the Create Shadow step. 

 

Solar radiation analysis 
You will now assume the role of a planner responsible for calculating solar radiation maps for 

the wider community. You are asked to use the Solar Radiation Analysis ArcGIS Pro project to 

visualize solar radiation on the ground as well as on the roofs of buildings in a 3D scene and 
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evaluate total solar radiation per selected roof area. Follow the defined tasks to calculate solar 

radiation rasters, visualize solar radiation on building roofs, summarize solar radiation for 

selected roof areas, and publish the results. 

1. Download the SolarRadiationAnalysis Desktop Application Template and unzip. 

2. Open the SolarRadiationAnalysis.aprx in the unzipped folder. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Solar Radiation 
Analysis task. 

5. Follow the steps in each task. 

Note: 

The atmospheric parameters used in this analysis are calibrated to historic solar radiation 
averages provided by the NASA Surface meteorology and Solar Energy global datasets. 

These averages are provided at a one-degree resolution for the globe. While this 
resolution is adequate for most analyses, there may be some inaccuracy in areas with 
high variability in weather patterns over short distances. The accuracy of the solar 
radiation values is dependent on the quality of the input data. 

 

Visibility analysis 
Government agencies can use Visibility Analysis to assess visibility for the wider community. 

For example, planners, architects, and real estate appraisers can use Visibility Analysis to 

determine visibility of or from a proposed development from or of surrounding locations. Event 

planners can use the solution to calculate event visibility from specific locations or surrounding 

buildings. 

Two tasks are available to assess visibility: 

• Explore Visibility 

• Analyze Visibility 

 

Explore visibility 
You will now assume the role of a planner responsible for conducting visibility assessments. 

You have been asked to use the Visibility Analysis ArcGIS Pro project to determine visibility of 

or from a proposed development from or of surrounding locations. Follow the Explore Visibility 

task to quickly explore visibility in your scene. 

1. Download the VisibilityAnalysis Desktop Application Template and unzip. 

2. Open the VisibilityAnalysis.aprx in the unzipped folder. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Explore Visibility 
task. 
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5. Follow the steps in each task. 

Note: 

Typically, these tools are used to get an idea of visibility in your scene. The analytical 
results displayed by these tools are temporary and are not saved with the project, nor are 
they included in map packages. If you require analytical results as data including a 
measurement of how visible an object is, consider using the Analyze Visibility task. 

 

Analyze visibility 
Next, you will continue with the role of a planner responsible for conducting visibility 

assessments. You have been asked to use the Visibility Analysis ArcGIS Pro project to 

determine visibility of or from a proposed development from or of surrounding locations. 

Follow the Analyze Visibility task to perform a detailed visibility assessment. 

Note: 

This task calculates the perceived and actual visible area of the target as an attribute of 
the observer. Distance and angle are considered when calculating perceived visibility 
because targets that are further away and under an angle from the observer appear 
smaller. 

 

Objects that are further away from the observer appear smaller and are less visible compared 

to the objects that are closer to the observer. 

Also, the angle of the targets in relation to the observer is considered because if a target is 

facing slightly away from the observer, it is less visible. 
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Targets facing away from the observer appear smaller. 

1. Download the VisibilityAnalysis Desktop Application Template and unzip. 

2. Open the VisibilityAnalysis.aprx in the unzipped folder. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Analyze Visibility 
task. 

5. Follow the steps in each task. 

Note: 

Analyze Visibility samples the observer and target features in 3D space and creates the 
following attributes on each observer panel describing the target visibility from the 
observer panel: 

• Deviation—Average angle between the observer and target panels. 

• ActualArea—The actual area of all targets visible from the observer. 

• PerceivedArea—The perceived area of all targets from the observer, adjusted for 
distance and angle. The area of the closest target is used to proportionally calculate the 
target areas that are further away. 

• PerceivedAreaPercentage—Percentage value of PerceivedArea. This attribute is 
typically used for symbolization. 

• NumOfSightLines—Number of sight lines from the observer to all visible target panels. 

The average angle of the observer feature panel in relation to the target lines of sight is saved 

in the Deviation attribute. Currently, the observer deviation is not used in the visibility 

calculations, meaning all observer panels that have a deviation of less than 90 degrees are 

considered to have line of sight on the targets. Use Select By Attributes on the Deviation 

attribute to find the panels than have a smaller angle or window of visibility. 
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Visibility is shown on the observer in the upper left without taking into account deviation (left 

image) and with deviation less than 45 degrees (right image). 
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District Energy Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to District Energy Data 

Management 
District Energy Data Management can be used to map district heating and cooling assets, edit 

data, view system maps in the field and office, view asset reports, and collaborate with map 

notes. 

It turns ArcGIS into a system for district energy organizations to easily inventory their assets 

and keep information up to date. It provides simple to use interactive system maps and 

dashboards for office and field staff, and increases collaboration. 

After deploying, organizations with no district energy data can immediately begin mapping 

their district energy systems using GPS or digitizing data with web or desktop software. 

Organizations with existing spatial heating and cooling data can load it and begin using the 

apps. 

 

Requirements 
District Energy Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 (Standard, or Advanced) 

• ArcGIS Field Maps 
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Information products 
District Energy Data Management includes the following information products: 

Item Description Minimum user type 

District Energy 
Data Manager 

An ArcGIS Pro project package used to 
manage district energy system data and map 
notes 

GIS Professional 
(Basic, Standard, or 
Advanced) 

District Energy 
Editor 

An ArcGIS Web AppBuilder application used to 
edit district energy system data and map notes 

Editor 

District Energy 
Viewer 

An ArcGIS Web AppBuilder application used to 
view district energy map and create map notes 

Editor 

District Energy 
Dashboard 

An ArcGIS Dashboards application used to 
view district energy asset information 

Viewer 

District Energy 
Map Notes 
Manager 

An ArcGIS Web AppBuilder application used to 
review and manage map notes 

Editor 

District Energy 
Mobile Viewer 

A map used in ArcGIS Field Maps to view 
district energy system assets to view district 
energy system assets and view or create map 
notes 

Mobile Worker 

District Energy 
Asset Collector  

A map used in ArcGIS Field Maps to capture 
and modify district energy assets and create 
map notes from the field 

Mobile Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • The Minimal Gallery app has been removed from the solution item. 

1.0 • First release of District Energy Data Management 
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Configure District Energy Data Management 
It turns ArcGIS into a system for district energy organizations to easily inventory their assets 

and keep information up to date. It provides simple to use interactive system maps and 

dashboards for office and field staff, and increases collaboration. 

The District Energy Data Management solution can be configured to meet specific needs in 

your organization. The sections below outline some administrative tasks to update and 

manage the solution to fit your organization's needs. 

 

Load data 
In some cases, you may need to load existing data into the solution before sharing the maps 

or applications. Review the maps or applications provided with the solution and determine 

what, if any, source data you want to load. District Energy Data Management also includes a 

data model to store information about typical district energy system assets. To explore the 

schema, view the data dictionary. 

Tip: 

If you do have to load data into the solution, you may want to develop a source-target 
matrix to track how your source data will be loaded into the target layer or layers used in 
the solution. 

Depending on the format of your source data, you may choose to append your source data to 

the new layers. Once you have determined what source data must be loaded, complete one of 

the data loading workflows below: 

 

Use the Append tool 
In ArcGIS Pro, the Append can be used to append multiple input datasets to an existing target 

dataset. Input datasets can be point, line, or polygon feature classes. 

To append features to the target layer or layers using the Append tool, complete the steps 

below: 

1. In ArcGIS Pro, sign in to your ArcGIS organization. 

2. To open the District Energy Data Manager project, click Open another project, click 
My Content under Portal, double-click the District Energy Data Management folder, 
and click District Energy Data Manager. 

3. Add your existing source layers to a new map. To add the target feature layers from the 
DistrictEnergySystem feature service, click My Content under Portal, double-click the 
District Energy Data Management folder, and add the DistrictEnergySystem feature 
service to the map. 

4. On the Analysis tab, in the Geoprocessing group, click Tools to open the 
Geoprocessing pane. 

5. In the search bar, type Append and click to open the Append tool. 
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6. Add your existing district energy data from the map to the Input Datasets parameter. 

7. For Target Datasets, use the DistrictEnergySystem features in the map. 

8. In the Schema Type parameter, use the drop-down menu to choose Use the Field Map 
to reconcile schema differences to perform field mapping. 

9. Update your field mapping and click Run. 

10. Repeat this process as needed to load all your existing data into the target district energy 
schema. 

 

Use the Data Loading Tools 
The Data Loading toolbox can be used in ArcGIS Pro to streamline loading data from a source 

to a target dataset and provide the ability to perform in-process data transformation. Setup the 

Data Loading toolbox before getting started with the steps below. 

1. Open the District Energy Data Manager project. 

2. On the Project tab, click Python to access the Python Package Manager. 

3. Under Project Environment, click Manage Environments. 

4. Click Clone Default  to clone your default environment.  

5. Click the Active button for the new environment, and click OK.  

6. Restart ArcGIS Pro to allow your environment changes to take effect. 

7. In the Python Package Manager, click Add Packages to see the Python packages 
available for installation. 

8. Click Refresh  to update the list of available packages. 

9. In the Search box, type dltsolutions to find the Data Loading Tools toolbox.  

10. Select the dltsolutions package and click the drop-down arrow to update the version. 

11. Click Install. 

12. The Install Package dialog box appears. 

13. Review the terms and conditions and check the box to agree.  

14. Click Install to install the package. 

15. Once the installation is complete, close ArcGIS Pro.  

16. The Data Loading Tools toolbox is now installed. The next time you start ArcGIS Pro, you 
can access it from the geoprocessing toolboxes. 

17. Review An overview of the Data Loading toolbox to learn more about the tools and how 
to use them to load data into the DistrictEnergySystem layers.  
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Configure the District Energy Data Manager ArcGIS 

Pro project 
The District Energy Data Manager project includes a District Energy Data Manager map with 

broken links. 

1. In ArcGIS Pro, sign in to your ArcGIS organization. 

2. To open the District Energy Data Manager project, click Open another project, click 
My Content under Portal, double-click the District Energy Data Management folder, 
and click District Energy Data Manager. 

3. In the Catalog pane, expand Maps and double-click District Energy Data Manager to 
open the map. 

4. In the Contents pane, click the red exclamation point  next to the Map Notes layer. 

5. The Change Data Source dialog box appears. 

6. Click My Content under Portal, double-click the District Energy Data Management 
folder, double-click the MapNotes_managing feature service, and double-click the Map 
Notes layer.  

7. In the Contents pane, click the red exclamation point  next to the Pump layer. 

8. The Change Data Source dialog box appears. 

9. Click My Content under Portal, double-click the District Energy Data Management 
folder, double-click the DistrictEnergySystem_editing feature service, and double-click 
the Pump layer.  

10. The data source is repaired for the remaining layers. 

11. In the Contents pane, right click the District Energy Data Manager map and click 
Properties. 

12. Click the Coordinate Systems tab. In the XY Coordinate Systems Available section 
select the coordinate system that matches the layers in the map. 

Note: 

Ensure the coordinate system of the map matches that of the feature layers deployed 
in the solution. If these do not match there may be discrepancies in what units are 
displayed in the map. 

13. Click Save to save the project. 

 

Add members to groups in your organization 
Included with District Energy Data Management are four groups designed to help managers 

organize their members based on their privileges and their work. The solution includes the 

following groups: District Energy Editors, District Energy Field Users, District Energy Map 

Notes Managers, and District Energy Office Users. 

To add members to the groups, complete the following steps: 
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1. In a browser, sign in to your ArcGIS organization. 

2. Verify that you have privileges to manage member groups before continuing. 

3. Click Groups at the top of the site. 

4. Click the name of the group to open the group details pages. 

5. On the Settings tab, edit and update the properties of the group, including access, 
sharing properties, and group ownership. 

6. Click the Overview tab and click Invite users.  

7. Select the members you want to add and click Add to group. 

8. Repeat steps 3 through 6 for each group you need to add members to. 

The provided groups are intended to be utilized by members with a minimum of the following 

user types in order to fully use the provided maps and apps: 

Group name User type 

District Energy Editors • Editor 

• GIS Professional Basic with ArcGIS Pro (minimum of one 
license recommended) 

District Energy Field Users • Mobile Worker 

District Energy Map Notes 
Managers 

• Editor 

District Energy Office 
Users 

• Editor 

 

Set the default map extent to your service territory 
When the District Energy Data Management solution is deployed into your organization, it 

uses the map default set in your organization. If this property has not been set, you may want 

to quickly update a few maps and apps to your service territory manually to avoid having to 

pan and zoom to your area each time you open a map. Follow the steps below to update the 

initial extent of the maps and apps provided with this solution. 

1. In a browser, sign in to your ArcGIS organization. 

2. To set the default map extent for the District Energy Viewer application, browse to the 
District Energy Viewer item page and click Edit Application. 

3. On the Map tab, zoom the map to the desired extent and click Use current map view 
under Set initial extent. Click Save. 

4. Repeat steps 2 and 3 to set the default map extent for the District Energy Editor and 
District Energy Map Notes Manager applications. 

5. To set the default map extent for the District Energy Asset Collector map, open the 
District Energy Asset Collector map. 

6. Zoom the map to the desired extent and save it. 

7. Repeat steps 5 and 6 for the District Energy Mobile Viewer map. 
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Configure the dashboard 
When you deploy the District Energy Data Management solution to your organization you 

have the option to change spatial reference. If you selected a spatial reference with a linear 

unit other than meters, you will need to revise the dashboard by completing the following 

steps. 

1. In a browser, sign in to your ArcGIS organization. 

2. To set the default map extent for the District Energy Dashboard application, browse to 
the District Energy Dashboard item page and click Edit Dashboard. 

3. Navigate to the Pipes tab and click the configure button  on the Transmission Main 
indicator. 

4. On the Data tab, toggle-on the value conversion switch to expose the conversion 
settings. Change the Factor setting to the correct conversion. 

The dashboard Factor setting is configured to convert meters to other units. Learn more 
about how to Convert Values. 

5. On the General tab, click edit to modify the description. Update the description to the 
correct unit. 

6. Click Done to save your changes. 

7. Repeat steps 3 and 6 for each of the indicators on the Pipes tab. 

8. Click the save button . 
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Use District Energy Data Management 
After deploying, organizations with no district energy data can immediately begin mapping 

their district energy systems using GPS or digitizing data with web or desktop software. 

Organizations with existing spatial heating and cooling data can load it and begin using the 

apps. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Add data in the field 
In these workflows, you will be taking the role of a mobile worker collecting data in the field. If 

you have a mobile-centric workforce, this may be the best option to collect new data or 

validate existing data. 

 

Collect flow meter features 
As a mobile worker, you can collect flow meters and/or controllable valve service using 

ArcGIS Field Maps in the field. 

1. In ArcGIS Field Maps open the District Energy Asset Collector  map. 

2. Browse to the collection location. 

3. Tap Add .  

4. From the list of features, search for the type of meter. In this example you are collecting a 
flow meter. Search for Flow by swiping up or typing flow in the filter search bar and 

select Flow under Meter. 

A point is added to your location. 

5. Fill in any attributes and tap Submit. 

6. Ensure the last collected meter is selected and browse to the next meter location. Tap 
the Copy button at the bottom of the screen to copy the previously added meter to the 
location of the new meter. 

7. Adjust the attributes and tap Submit. 

8. If the meter has an accompanying controllable valve service, you can add it next. 

9. Tap Add .  

10. From the list of features, search for Service by swiping up or typing service in the filter 

search bar and select Service under Controllable Valve Service. 

A point is added to your location. 

11. Fill in any attributes and tap Submit. 
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Add map notes 
As a mobile worker, you can add a map note to the system. 

1. In ArcGIS Field Maps open the District Energy Asset Collector  map. 

2. Navigate to the map note location. 

3. Tap Add.  

4. From the list of features, search for the Map Notes type by swiping up or typing a 
description in the filter search bar, select the Map Notes type, and add the note to the 
map by sketching a polygon in the map note location. 

5. Fill in the attributes and click Submit. 

6. The map note is added to the map and is available to be viewed and reviewed by others 
in the organization. 

 

Add data in the web 
In the workflows below, you will be taking the role of an editor adding data in ArcGIS Online. 

The workflows explain how to add data in the web, use the provided dashboard, and add and 

manage map notes. 

 

Add service connections 
As an editor, you want to use a web app to add service connections to the map. 

1. In a browser, sign in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the District Energy Editors group and locate the District Energy Editor app. 
Click View Application to launch the app. 

In the District Energy Editor app, the Asset Editor widget is open by default on the left 
side of the window when the app opens. 

4. In the Asset Editor pane, click the template drop-down menu and select Service 
Connection, and select Service Connection from the list of options. 

5. Scroll down and fill in the preset values. 

6. With service connection selected, click to add the service connection to the map.  

7. You are prompted to update attributes and click Save. 

8. Continue adding service connections, changing the service connection type as needed. 

The template and preset attributes remain selected so you can continue adding service 
connections. 

 

Add map notes 
As a user, you can add a map note to the system. 
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1. Browse to the District Energy Office Users group and locate the District Energy 
Viewer app. Click View Application to launch the app. 

a. In the District Energy Viewer, click the Map Notes Editor widget to open it. 

b. Choose a map note issue type and sketch a polygon in the desired map note 
location. 

c. Enter attributes and click Save. 

Map note changes are reflected in other apps and maps across the system so others 
in your organization can view the latest information. 

 

Manage map notes 
As a GIS manager, you can review and resolve map notes about your system to ensure 

issues are addressed. 

1. Browse to the District Energy Map Notes Managers group and locate the District 
Energy Map Notes Manager app. Click View Application to launch the app. 

  In the upper right of the app, there are a number of widgets that have been configured to 
filter, edit, update, and manage map notes. 

2. Review the list of included widgets to learn how to use them to manage map notes:  

• Legend—View a list of included layers in the map. The legend displays what is 
visible on the map, so zooming in or out can expand or reduce the list if scale 
suppression is set on the layers. 

• Filter—Use the Creation Date, Issue, and Severity filters to view only map notes 
that fit the entered criteria. Select a date range or an option from the drop-drown 
menu and turn on a filter to view the selection on the map. 

• Batch Edit Map Notes—Select a group of map notes using one of the selection 
tools and update values for all the selected features at once. 

• Map Notes Editor—Add a new map note or edit an existing map note. 

• Map Notes Summary—View all the map notes by status and expand each 
section to view the individual notes. Click a note to zoom to it on the map and 
view its attributes in a pop-up. 

 

Use the district energy dashboard 
As a member of the utility, you want to have a comprehensive view of your district energy 

system assets. 

1. Browse to the District Energy Office Users group and locate the District Energy 
Dashboard app. Click View Dashboard to launch the dashboard. 

2. View the district energy system statistics on the General tab, click the Asset tab to view 
district energy asset details, click the Pump and Heat Exchanger to view other critical 
statistics. 
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Add data in ArcGIS Pro 
In the workflows below, you will be taking the role of an editor adding data in ArcGIS Pro. If 

you have known locations of assets or as-built drawings, the following workflows demonstrate 

using ArcGIS Pro to add data to your district energy system. 

Note: 

The first time you open the District Energy Data Manager map in ArcGIS Pro, the layers 
will show as broken. Follow the steps to Configure the District Energy Data Manager 
ArcGIS Pro project to fix your layers. 

 

Add service pipes 
As an editor, you can add a service lateral and service connection to the map in ArcGIS Pro. 

1. Open the District Energy Data Manager ArcGIS Pro project, sign in to your ArcGIS 
organization. 

2. In the Catalog pane, expand Maps and double-click District Energy Data Manager to 
open the map. 

3. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

4. On the Edit tab, in the Features group, click Create. 

  The Create Features pane appears. 

5. Select Supply from the Service Pipe template. 

6. Add the template to the map by clicking at each bend of the pipe. Double-click on the 
map to complete the sketch of the service laterals. 

7. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

8. Repeat steps 5 through 7 to add the Return service pipe to the map by selecting the 
Return template in place of the Supply template. 

9. Once both Supply and Return services have been added, you will add the Service 
Connection. 

10. Select Service Connection from the Service Connection template. 

11. Add the template to the map by clicking a location of the Service Connection. 

12. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

 

Add features from an as-built drawing 
As an editor, you can add assets such as supply and return laterals, controllable valves, and 

meters to the system from an as-built drawing. 

1. In the Catalog pane, expand Maps and double-click District Energy Data Manager to 
open the map. 
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2.  On the Map tab, in the Layers group, click Add Data. Browse to the location of the as-
built drawing, select it, and click OK to add it to the map. 

3. With the image selected in the Contents pane, browse to the Raster Layer ribbon. On 
the Appearance tab, in the Effects group, change the Layer Transparency setting to 
50%. 

4. On the Imagery tab, in the Alignment group, select Georeferencing. 

  If you are unfamiliar with georeferencing, see Overview of georeferencing in the ArcGIS 
Pro help. 

5. On the Georeferencing tab, in the Adjust group, click Add Control Points. 

a. Add a minimum of two control points to connect your image to your known map 
positions. 

b. Once you have added all the control points, browse to the Georeferencing tab and 
click Save. 

6. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

7. On the Edit tab, in the Features group, click Create.  

  The Create Features pane appears. 

8. Select an asset from the template list and add the asset to the map where it corresponds 
to the georeferenced as-built drawing. 

9. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

10. Remove the image from the Contents pane once digitizing is complete. 

 

Add map notes 
As an editor, you can add a map note to the system. 

1. In the Catalog pane, expand Maps and double-click District Energy Data Manager to 
open the map. 

2. On the Edit tab, in the Features group, click Create. 

  The Create Features pane appears. 

3. In the Favorites list, expand the Map Notes folder and choose a Map Note option. Add 
the map note by digitizing a polygon on the map at the desired location. 

4. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

  The map note is added to the map and is available to be viewed and reviewed by others 
in the organization. 
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Election Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Election Management 
Election Management can be used to manage election day activities, monitor performance, 

and gauge voter sentiment. 

Election offices, in communities large and small, respond to issues and requests from polling 

places and voting centers. Issues with computer hardware, facilities, or supplies impact wait 

times and confidence in the election process. Furthermore, many communities have increased 

early voting options and the use of official ballot drop boxes. As a result, reliable ballot chain 

of custody processes are imperative. Election Management is typically implemented by clerks, 

election commissions, or secretary of state offices that want to run efficient elections and 

increase confidence in the voting process. 

The Election Management solution delivers a set of capabilities that help election officials 

report wait times and request assistance at voting centers and polling places, dispatch field 

staff to respond to requests, track ballot chain of custody, monitor the performance of voting 

locations, and gauge the satisfaction of voters on Election Day. 

 

Requirements 
Election Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later (Standard or Advanced) 

• ArcGIS Workforce 

• ArcGIS Survey123 Connect 
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Information products 
Election Management includes the following information products: 

Item Description Minimum user 
type 

Election 
Assistant 

A Crowdsource Polling app used by poll workers to 
routinely report wait times and request assistance (for 
example, additional ballots or computer support) at 
their assigned voting center or polling place 

Editor 

Election 
Manager 

An ArcGIS Workforce project used by elections staff to 
manage election day requests for assistance and track 
the resolution of each request. Field users access the 
Election Manager project using the ArcGIS Workforce 
mobile app. 

Mobile 
Workerv 

Collection 
Checklist 

An ArcGIS Survey123 form used by ballot collection 
officers to document ballot chain of custody at the drop 
box location 

Mobile Worker 

Return Checklist An ArcGIS Survey123 form used by ballot collection 
officers to document ballot chain of custody at election 
headquarters 

Mobile Worker 

Drop Box 
Requests 

An ArcGIS Survey123 form used by ballot collection 
officers to submit ballot drop box requests for service 

Mobile Worker 

Voter 
Satisfaction 
Survey 

An ArcGIS Survey123 form used by clerks and election 
officials to gauge voter satisfaction and sentiment 
during an ongoing election 

Not required 

Election 
Requests 
Dashboard 

An ArcGIS Dashboards app used by clerks and 
election officials to monitor requests for assistance 

Viewer 

Election Wait 
Times 
Dashboard 

An ArcGIS Dashboards app used by clerks and 
election officials to monitor wait times during an 
ongoing election 

Viewer 

Ballot Collection 
Dashboard 

An ArcGIS Dashboards app used by clerks and 
election officials to monitor ballot chain of custody 
activities 

Viewer 

Election 
Performance 
Center 

An ArcGIS Experience Builder app used by clerks and 
election officials to view all the performance 
dashboards in a single app 

Viewer 

Voter 
Satisfaction 
Dashboard 

An ArcGIS Dashboards app used by clerks and 
election officials to monitor voter satisfaction during an 
ongoing election 

Viewer 

Become An 
Election Worker 

An ArcGIS Hub site used by the general public to learn 
more about becoming an election worker in their 
community 
ArcGIS Hub Premium is required when Community 
Identities are used for election workers 

Not required 

Election Worker 
Application 

An ArcGIS Survey123 form used by community 
members to express interest in becoming election 
workers 

Community 
Identity 

Election Worker 
Manager 

A Crowdsource Manager app used by election staff to 
manage election worker applications 

Editor 
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Election Worker 
Notebook 

An ArcGIS Notebooks app used to grant election 
workers access to election apps 

Editor 

Election Data 
Management 

An ArcGIS Pro project used by mapping technicians to 
inventory and maintain electoral districts, precincts, 
voting centers, and polling places 

GIS 
Professional 
Standard 

 

Release notes 
The following are the release notes: 

Date Description 

2.0 • Updated the Election Assistant app to include voting location search 
functionality. 

• A new collection of apps to conduct and monitor ballot drop box chain of 
custody activities. 

• A new collection of focused ArcGIS Dashboards to monitor election 
performance. 

• A new collection of apps to solicit and manage election workers and provide 
information to potential and current workers. 

1.1 • Updated the Election Manager project from ArcGIS Workforce Classic to 
ArcGIS Workforce. 

1.0 • First release of Election Management 
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Configure Election Management 
Election Management can be used to manage election day activities, monitor performance, 

and gauge voter sentiment. 

Learn how to configure the Election Management solution to meet specific needs in your 

organization. 

 

Manage election data 
The Election Data Management ArcGIS Pro project includes a series of tasks to help guide 

you through creating, loading, and maintaining an inventory of electoral districts, voting 

locations, and voting precincts. 

 

Get started 
To get started with Election Data Management, complete the following steps. 

1. Sign in to your ArcGIS organization and browse to the Election Data Management 
Desktop Application Template. 

2. Open the item page, and then click Download. 

3. Unzip and open the Election Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and then double-click the Election Data 
Management task item. 

6. In the Tasks pane, click the Getting Started task group to expand the collection of tasks. 

Election Data Management is used to load, create, and edit foundational election data used in 

apps such as My Elected Representative, Election Polling Places, and Election Manager. The 

solution uses three foundational datasets: 

• Voting Locations 

• Voting Precincts 

• Electoral Districts 

Voting Locations contains facilities where voters can cast ballots and is defined by a point 

layer. They can be either polling places, voting centers, or ballot drop boxes, depending on 

your community's needs. Voting centers and ballot drop boxes can be modified to allow early 

voting. 

Voting Precincts contains areas that define your community's precincts and is defined by a 

polygon layer. They are related to voting locations by a unique ID and define the unique 

polling place where voters in a precinct should cast ballots. 

Electoral Districts contains geographies that define an elected office's area of representation 

and is defined by a polygon layer. For example, a mayor's Electoral District is the municipal 

boundary. Key attributes are used in My Elected Representative app. 
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Before proceeding to subsequent tasks, follow the instructions in the Add election 

geography layer task to add the ElectionGeography feature layer deployed with the solution. 

 

Load existing election data 
Your election agency may have existing polling place, voting center, ballot drop box, voting 

precinct, or electoral district data, which can be loaded into the ElectionGeography feature 

layer. 

Voting Locations are designated as either Polling Places, Voting Centers, or Ballot Drop 

Boxes using the Voting Facility Type field. Both Voting Centers and Polling Places use a 

standard for operational days and hours in the Voting Centers and Election Polling Places 

apps included with the Election Outreach solution. To load existing voting location data, 

designate the type and format the operational days and hours, following the instructions in the 

Polling places, Voting centers, and Ballot drop boxes tasks. 

The voting precinct’s relationship with a polling place is defined by populating the Polling 

GlobalID field with the GlobalID from the corresponding polling place. Establishing this 

relationship allows the Election Polling Places app to display the appropriate polling place 

when a user searches by address or defines a location on the map. Follow the instructions in 

the Voting precincts task to load existing data and establish the relationship. 

Follow the instructions in the Electoral districts task to load existing electoral district data. 

 

Create new election data 
You may need to create new election data if existing data is not available. Follow the 

instructions in the Create new election data task group to create new voting locations, voting 

precincts, and electoral districts. 

Note: 

Map layers must be visible to create new data. 

 

Prepare for the next election 
Election data changes over time as new voting locations are established, precincts are 

modified, and election cycles are completed. You must update key fields, such as the next 

election date, to maintain election data accuracy and ensure that public facing apps included 

with the Election Outreach solution display the correct information. Use the Next election 

date, Next voter registration date, and Early voting start and end date tasks to update key 

date fields as election cycles are completed. Use the Modify voting locations, Modify 

precincts, and Modify electoral districts tasks to edit your election data. 
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Modify election and drop box request types 
When voting location workers create requests using the Election Assistant app and the 

Election Requests form, requests are automatically created as assignments in the 

corresponding Election Manager ArcGIS Workforce project. Requests submitted by ballot 

collection officers using the Drop Box Requests form also create assignments in the Election 

Manager project. Using Election Manager, dispatchers can assign requests to field rovers. 

Additionally, a dispatcher may need to create an assignment directly without a request from a 

voting location worker. For example, dispatchers can optionally create ballot collection 

assignments to initiate the ballot collection workflow. Follow the steps below to add additional 

request types to the Election Manager Workforce project and the Election Requests ArcGIS 

Survey123 form. 

1. Verify that you are signed in to your ArcGIS organization and click the Apps button  in 
the header of the site. 

2. From the app launcher, click Workforce to open the app. 

3. Under Projects, hover over the Election Manager project, and click Configure. 

4. Click the Assignment Types tab. 

5. In the text box, enter a new assignment type, and then click + Type.  

6. Repeat until all new assignments types have been added. 

Before populating the new assignment types into the Election Requests form, you will 

first copy the GlobalID for each new assignment type. 

7. In your ArcGIS organization, browse to the Election Manager feature layer. 

8. Open the item page, and then click Open in Map Viewer. 

9. On the Contents (dark) toolbar, click Tables. 

10. Click the Assignment Types layer. 

11. In the table header, click Tools, and then check the GlobalID field to show (unhide) in 
the table. 

12. Click Done to close the pop-up window. 

13. Expand the GlobalID field and copy the first new assignment type's ID.  

14. Paste the copied GlobaIID into Microsoft Notepad or another text editor for reference. 

15. If applicable, copy any additional assignment type’s ID into the same text editor. 

 

Update the Election Requests form 
Update the Election Requests form with each new assignment type. 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Election Requests to download the survey. 

4. In the Download window, click Download and click OK. 
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5. Click Election Requests to open the survey. 

6. On the left, from the side toolbar, click the XLSForm button. 

7. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 

  This tab comprises all the selectable options for survey questions. 

8. In the list_name column, type ASSIGN_TYPE.  

9. From the text editor, copy the GlobalID. 

10. In the name column, paste the GlobalID, and before and after the GlobalID, add curly 
braces (for example, {5b3e80df-aec7-4739-929f-8cb70cdbd62c}).  

11. In the label column, type the assignment type. 

12. For each new assignment type, repeat the previous steps. 

13. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

14. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

15.  Click Publish survey to publish your changes, and then click OK. 

 

Update the Drop Box Requests form 
Update the Drop Box Requests form with each new assignment type. 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Drop Box Requests to download the survey. 

4. In the Download window, click Download and click OK. 

5. Click Election Requests to open the survey. 

6. On the left, from the side toolbar, click the XLSForm button. 

7. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 

  This tab comprises all the selectable options for survey questions. 

8. In the list_name column, type ASSIGN_TYPE.  

9. From the text editor, copy the GlobalID. 

10. In the name column, paste the GlobalID, and before and after the GlobalID, add curly 
braces (for example, {5b3e80df-aec7-4739-929f-8cb70cdbd62c}).  

11. In the label column, type the assignment type. 

12. For each new assignment type, repeat the previous steps. 

13. At the bottom of the Microsoft Excel spreadsheet, click the survey tab. 

  This tab comprises all the questions in the survey. 

14. For the select_one ASSIGN_TYPE question, in the readonly column, remove the yes 
setting. 
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15. For the select_one ASSIGN_TYPE question, in the default column, remove the 
GlobalID. 

Note: 

When adding more than one request type, it may be helpful to select an appearance 
such as minimal on the select_one ASSIGN_TYPE question. 

16. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

17. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

18.  Click Publish survey to publish your changes, and then click OK. 

 

Configure location tracking 
Ballot collection officers use ArcGIS Field Maps to track their locations while collecting ballots 

in the field. Location tracks can then be added and viewed in the Ballot Collection Dashboard 

app. 

 

Enable location tracking 
First, location tracking needs to be enabled for your ArcGIS Organization. Then, members of 

the organization need to be licensed. 

1. To enable location tracking for your ArcGIS Organization, see configure location tracking. 

2. The ArcGIS Tracker license is available as an add-on for all user types. See ArcGIS 
Tracker requirements for more information. 

 

Create a track view 
After enabling location tracking for your ArcGIS Organization, you will create a track view that 

will be used by ballot collection officers in the field. 

You will use Track Viewer to create a track view of ballot collection officers. 

1. In a browser, sign in to your organization and open Track Viewer. 

  By default, if Track Viewer is installed and you have the view location tracks privilege, it is 
in the app launcher. Installation is often done as part of enabling location tracking. 

2. Click Create View. 

3. Type a view name, such as ballotcollectiontracking, and then click Create View. 
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Tip: 

Make a note of the name used for the view. The view is a hosted feature layer view and 
will be referenced in later steps when adding the feature layer to the Ballot Collection 
Dashboard. 

  When you create the view, a group in ArcGIS Online that controls access to the view is 
also created. 

4. On the Mobile Users tab, follow these steps to add ballot collection officers to be tracked 
in the field.  

a. For Select to add mobile users, click the drop-down menu. 

b. Search for each ballot collection officer, and then click Add.  

Tip: 

When using the Ballot Collection Officers group provide access to the apps 
used by ballot collection officers, search for Ballot Collection Officers group 
and click Add. 

When you create the view, a group in ArcGIS Online that controls access to the 
view is also created. 

Note: 

While you can add any user as a mobile user, that user won't have a last known location 
or track until they are tracked with the Field Maps mobile app, tracked with the 
QuickCapture mobile app, or tracked with the Indoors mobile app. 

 

Visualize tracks 
You will now add the track view to the Ballot Collection Dashboard to visualize location tracks 

with ballot collection activities. 

1. In a browser, sign in to your organization and open the Ballot Collection Dashboard Web 
Map. 

2. On the Contents (dark) toolbar, click Add  and click Browse layers. 

3. Search for ballotcollectiontracking or the name of the track view created above. 

4. Click Add  on the layer result to add the layer to the map.  

5. Save the Ballot Collection Dashboard Web Map. 

6. Verify that you are signed in to your ArcGIS organization, and then browse to the Ballot 
Collection Dashboard. 

7. From the item page, click Edit Dashboard. 

8. Hover over the upper right corner of the Time selector, and then click the Configure 
button. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://doc.arcgis.com/en/arcgis-online/share-maps/groups.htm
https://doc.arcgis.com/en/arcgis-online/share-maps/groups.htm
https://doc.arcgis.com/en/field-maps/android/help/track.htm
https://doc.arcgis.com/en/quickcapture/help/editproject.htm#ESRI_SECTION1_E70AFA34F2E24533940F31E40F238890
https://doc.arcgis.com/en/quickcapture/help/editproject.htm#ESRI_SECTION1_E70AFA34F2E24533940F31E40F238890
https://doc.arcgis.com/en/indoors/latest/viewer/introduction-to-device-location-and-tracking.htm


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 281 

9. Select the Actions tab. 

10. Expand the Filter section. 

11. Under Ballot Collection Dashboard, next to Track Lines, Tracks, and Last Known 
Locations click the toggle button. 

12. Use the following table to select the appropriate Target field. 

Layer Target field 

Track lines End Time 

Tracks Location Timestamp 

Last known Locations Location Timestamp 

13. Click Done. 

14. Hover over the upper right corner of the Team Captain selector and click the Configure 
button. 

15. Select the Actions tab. 

16. Expand the Filter section. 

17. Under Ballot Collection Dashboard, next to Track Lines, Tracks, and Last Known 
Locations click the toggle button. 

18. For each location tracking layer’s Target field, select Full Name. 

19. Click Done. 

20. Click the Save button. 

 

Update drop box and team information 
The Collection Checklist and Return Checklist forms use choice lists to help ballot collection 

officers enter correct information. Drop box locations, ballot collection teams and election 

officials are stored in csv files included with the Election Management Solution. 

The csv files allow information to be updated quickly when needed. 

 

Update ballot collection locations 
The Collection Checklist and Return Checklist forms define the name of the ballot drop box's 

location with the DropBoxes csv file, which is linked to the ArcGIS Survey123 forms. Updating 

the DropBoxes csv file helps ballot collection officers enter correct information and ensures 

that the Ballot Collection Dashboard functions properly. 

1. Sign into your ArcGIS organization and locate the DropBoxes csv file. 

2. Click Download and open the DropBoxes csv file on your computer. 

3. In the name and label columns, enter the location name of the ballot drop box. 
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Note: 

The name should be unique and match the location name of the ballot drop box 
populated in the Voting Locations layer of the ElectionGeograpy feature layer. 

4. In the globalid column, enter the globalid of the ballot drop box.  

Note: 

The globalid should match the globalid of the ballot drop box in the Voting Locations 
layer of the ElectionGeograpy feature layer. 

5. In the address column, enter the address of the ballot drop box.  

6. In the id column, enter the id of the ballot drop box.  

  The result should look similar to the following table. 

name label globalid address id 

Drop box location 
name 1 

Drop box location 
name 1 

56f43792-1e83-4bb7-ada5-
725c508011e2 

101 S Main 
St 

DB-
1 

Drop box location 
name 2 

Drop box location 
name 2 

38faa2b7-974c-439b-8b80-
11e725f62679 

202 N Main 
St 

DB-
2 

7. Repeat steps 3 through 6 for each ballot drop box. 

8. Save the DropBoxes file. 

9. On the DropBoxes item page, click Update, browse to the updated DropBoxes file on 
your computer, and click Update Item. 

Note: 

The Collection Checklist and Return Checklist will utilize the updated DropBoxes csv 
file the next time they are used. 

 

Update ballot collection teams 
The Collection Checklist and Return Checklist forms define the name collection team 

members with the Team csv file which is linked to the ArcGIS Survey123 forms. Team 

Captain is populated with the user currently logged into the ArcGIS Survey123 app. Team 

Assistant and Driver are defined using the Team csv file. Updating the Team csv file helps 

ballot collection officers enter correct information quickly and ensures that all teams members 

are accurately entered. 

1. Sign into your ArcGIS organization and locate the Team csv file. 

2. Click Download and open the Team csv file on your computer. 

3. In the name and label columns, enter the team member's name.  

4. In the assistant column, enter the name of the team member who will be working with 
the previous team member.  
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5. Repeat steps 3 and 4 for each team member. 

Note: 

The name and assistant pairings should be comprehensive for each team of two. For 
example, each team member should be entered in both the name and assistant 
column. The result should look similar to the below table. 

name label assistant 

Jane Doe Jane Doe John Doe 

John Doe John Doe Jane Doe 

6. Save the Team file. 

7. On the Team item page, click Update, browse to the updated Team file on your 
computer, and click Update Item. 

Note: 

The Collection Checklist and Return Checklist will utilize the updated Team csv file the 
next time they are used. 

 

Update election officials 
The Return Checklist form defines the name election official receiving ballots from the 

collection team with the ElectionOfficials csv file which is linked to the ArcGIS Survey123 

form. Updating the ElectionOfficials csv file helps ballot collection officers enter correct 

information quickly. 

1. Sign into your ArcGIS organization and locate the Team csv file. 

2. Click Download and open the ElectionOfficials csv file on your computer. 

3. In the name and label columns, enter the election official's name.  

4. Repeat steps 2 and 3 for each election official. 

  Note: 

  The result should look similar to the following table. 

name label 

Jane Doe Jane Doe 

John Doe John Doe 

5. Save the ElectionOfficials file. 

6. On the ElectionOfficials item page, click Update, browse to the updated ElectionOfficials 
file on your computer, and click Update Item. 
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Note: 

The Return Checklist will utilize the updated ElectionOfficials csv file the next time it is 
used. 

 

Update ballot collection forms 
The Collection Checklist and Return Checklist allows you to track ballot chain of custody as 

teams collect ballots from official ballot drop boxes. In some cases, you may want to add or 

remove questions from the survey. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Collection Checklist to download the survey. 

3. In the Download window, click Download, and then click OK. 

4. Click Collection Checklist again to open the survey. 

5. In the XLSForm Modified window, click Yes. 

6. On the side toolbar, click Open XLSForm Spreadsheet. 

7. In the Microsoft Excel spreadsheet, click the choices tab. 

  This tab comprises all the selectable options for survey questions. 

8. Click the survey tab. 

  This tab comprises all the questions in the survey. 

9. Revise the survey to reflect your needs. 

10. Save and close the Microsoft Excel spreadsheet and then preview your changes in 
Survey123 Connect. 

11. In Survey123 Connect, click Publish on the side toolbar. 

12. Click Publish survey to publish your changes, and then click OK. 

13. Repeat steps 2 through 12 for the Return Checklist. 

 

Update the voter satisfaction survey 
The Voter Satisfaction Survey allows you to solicit feedback from voters to help you gauge 

voter sentiment during an ongoing election. In some cases, you may want to add or remove 

questions from the survey. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Voter Satisfaction Survey to download the survey. 

3. In the Download window, click Download and click OK. 

4. Click Voter Satisfaction Survey again to open the survey. 

5. In the XLSForm Modified window, click Yes. 
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6. On the side toolbar, click Open XLSForm Spreadsheet. 

7. In the Microsoft Excel spreadsheet, click the choices tab. 

  This tab comprises all the selectable options for survey questions. 

8. Click the survey tab. 

  This tab comprises all the questions in the survey. 

9. Revise the survey to reflect your needs. 

10. Save and close the Microsoft Excel spreadsheet and then preview your changes in 
Survey123 Connect. 

11. In Survey123 Connect, click Publish on the side toolbar. 

12. Click Publish survey to publish your changes, and then click OK. 

 

Create Election Assistant direct URLs 
Election Assistant is accessed through a URL in a web browser. To report a wait time or 

request assistance, election workers then use either the map or list to select their assigned 

polling place or voting center. Organizations that have many voting locations may want to 

provide poll workers a direct URL to the Election Assistant app. You can use a web browser 

URL parameter to help poll workers by opening the Election Assistant app with the proper 

voting location already selected. 

By adding a facilityid parameter to the app URL, Election Assistant selects the location without 

user interaction. Ensure that each voting location has a unique identifier in the facilityid field in 

the ElectionGeography feature layer. For example, by adding &facilityid=89 to the app URL, 

Election Assistant selects facility ID number 89. The full URL is similar to this one: 

https://myorganization.maps.arcgis.com/apps/CrowdsourcePolling/index.html?a
ppid=449f9c890c584c9395a393ad5a541bc6&facilityid=89 

 

Configure Become An Election Worker site 
The Election Management solution includes the Become An Election Worker ArcGIS Hub site, 

which can be configured with your branding. Your organization can use this site to solicit 

election workers and share access to the apps that election workers need to complete their 

tasks. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Become An 
Election Worker site. 

2. From the item page, click Configure. 

3. If necessary, click the Edit button  to open the site editor. 

4. Scroll to the Frequently Asked Questions section, hover over the card, click the edit 
pencil, and update the questions and answers. 
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5. Scroll to the Additional Resources section, hover over the card, click the edit pencil, 
and update the text and Learn More buttons. 

6.  In the side panel, click Footer. 

  A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

7. Click the HTML box. 

  The HTML window appears. 

8. Make the necessary changes and click Apply. 

9. Click Save. 

10. When you're finished, click the Save drop-down menu and choose Publish Draft. 

 

Share items with the public 
The Become An Election Worker site must be shared with everyone so that it can be 

accessed by the public. To share your Become An Election Worker site with everyone, use 

the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Become An 
Election Worker folder. 

2. Next to each of the following items, check the check box: 

Item Name 

Site Application Become An Election Worker 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

5. Click Update. 

 

Administer election workers 
The Election Management solution can be used to solicit election workers. Mapping 

technicians can configure the Election Worker Notebook to help election staff manage the 

process efficiently. 

 

Share Election Election Worker Application with Hub Community 

Members group 
To apply to become an election worker, a user must have a community user account and be 

signed into the Become An Election Worker site. To grant access to the Election Worker 

Application, you should share the form and the ElectionWorkerApplications_submit feature 

layer to the Hub Community Members group. This group is automatically created during Hub 

Premium activation and contains all members of your community organization. As new 
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community members join, they will be automatically added to this group and will have access 

to the Election Worker Application form. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Election 
Management folder. 

2. Check the box next to the Election Worker Application Form and 
ElectionWorkerApplications_submit Feature Layer (hosted, view). 

3. Click Share. 

4. In the Share window, click Edit group sharing. 

5. Check the box next to the Hub Community Members group. 

6. Click OK. 

7. Click Save. 

 

Schedule the Election Worker Notebook 
When election staff use the Election Worker Manager app to approve election worker 

applications, the Election Worker Notebook grants volunteers access to election apps 

according to election worker's approved roles. 

Follow the steps below to schedule the Election Worker Notebook to run as a scheduled task. 

Note: 

To run and schedule ArcGIS Notebooks and complete the following steps, you must be 
assigned an Administrator role or a custom role that includes the privilege to create, edit, 
and schedule notebooks. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Election 
Worker Notebook item. 

2. Open the item page and click Open Notebook. 

3. Click Tasks.  

4. Click Create Task.  

5. For Title, type Election Worker Task, and then click Next.  

6. The task can be configured to run nightly by selecting Day from the Repeat Type drop-
down then selecting 1 - Every Day from the Repeat Interval drop-down. 

7. Select a Time for the task to run like 3:00 AM. 

8. Click Create Task to finish scheduling the notebook 
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Use Election Management 
The Election Management solution delivers a set of capabilities that help election officials 

report wait times and request assistance at voting centers and polling places, dispatch field 

staff to respond to requests, track ballot chain of custody, monitor the performance of voting 

locations, and gauge the satisfaction of voters on Election Day. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Report wait times 
You will first assume the role of a voting location worker tasked with reporting voter wait times 

at a regular interval throughout the day. 

1. In a browser, go to the Election Assistant app. 

2. Select a voting location using the list or map. 

Note: 

Optionally, use the search box to search by voting location name. 

3. On the information panel, click the Report wait time button. 

4. In the Election Wait Times form, enter and submit a wait time in minutes. 

5. Click Submit. 

Note: 

The Election Wait Times form will reload and can be used to submit additional wait 
times for the selected voting location without returning to the Election Assistant app. 

 

Request assistance 
You will continue the role of a voting location worker who now needs to request assistance. 

1. In a browser, sign in to your ArcGIS Online organization, browse to the Election 
Management folder, and open the Election Assistant app. 

2. Select a voting location using the list or map. 

Note: 

Optionally, use the search box to search by voting location name. 

3. On the information panel, click the Request assistance button. 
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4. In the Election Requests form, fill in the following details: 

Question Answer 

Request type Select the type of request 

How critical is your request? Select a level of criticality 

Provide additional details to help us understand 
your request 

Describe the request or issue being 
reported 

Attach an image if it will help describe your 
request 

Optionally, attach an image 

5. Click Submit. 

Note: 

The Election Requests form will reload and can be used to submit additional requests 
for the selected voting location without returning to the Election Assistant app. 

 

Manage election requests 
As requests for assistance are submitted by voting location workers, election staff review 

requests and assign field staff to resolve the request. Now, you will assume the role of a 

dispatcher who needs to assign open requests to field staff. 

1. In a browser, sign in to your ArcGIS organization and click the Apps button  in the 
header of the site. 

2. From the app launcher, click Workforce to open the app. 

3. Under Projects, click Election Manager to open the project. 

Tip: 

When implementing the Election Management solution in your organization, add 
election staff responsible for resolving election requests in the field to the Election 
Manager ArcGIS Workforce project with a Mobile Worker role. You can add users and 
assign roles in the configuration settings of the project. To access configuration 
settings, hover over Election Manager project and click Configure. Click the Users 
tab. For the purposes of this exercise, ensure that your named user account is 
assigned as a dispatcher and as a mobile worker. Click the My Projects tab to return 
to your projects. 

4. In the assignments list, click an assignment-type header or, on the map, click an election 
request. 

5. Review the request details, click the Assign drop-down arrow and choose a mobile 
worker to resolve the issue. 

6. Click the Assignments back button to return to the assignments list. 
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Resolve election requests in the field 
You will now assume the role of a rover during an ongoing election. As a rover, you are 

responsible for responding to and resolving requests submitted by voting location workers. 

Using the Election Manager Workforce project, you will review and update the status of your 

assignments. 

1. Download the Workforce for ArcGIS app onto your mobile device. 

2. Open the Workforce for ArcGIS app and sign in to your ArcGIS organization. 

3. Tap the Election Manager project. 

4. Select an assignment by tapping on it in the To Do list. 

5. Tap Start. 

6. Add notes or attachments to the assignment as needed. 

7. Tap Finish to complete the assignment. 

 

Collect ballots from official drop boxes 
Many communities provide official ballot drop boxes where voters can cast their ballots early 

by mail. These ballots need to be securely retrieved by election staff and delivered to election 

headquarters. You will now assume the role of a ballot collection officer who is tasked with 

collecting ballots from official drop boxes. 

Track locations from the field 
The ability to quickly identify the location of ballot collection officers is critical to ballot chain of 

custody. Election officials can understand and document the location of their staff as they visit 

official ballot drop boxes to collect ballots. 

You will enable location tracking using ArcGIS Field Maps. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open the app on your mobile device, and sign in to your organization. 

3. In the Maps list, tap the My tracks map card toggle button to turn on tracking and set the 
tracking duration. 

4. After completing ballot collections and returning to election headquarters, in the Maps 
list, tap the My tracks map card toggle button to turn off tracking. 

 

Complete the Collection Checklist 
You will first complete the Collection Checklist, which documents ballot chain of custody 

activities at the ballot drop box. 

1. Download the Survey123 field app onto your mobile device. 

2. At the upper right, tap the Menu button, and then tap Download Surveys. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 291 

Note: 

You will download three ArcGIS Survey123 forms used in the ballot collection workflow. 

3. Search for Collection Checklist and tap the Download button. 

4. Search for Return Checklist and tap the Download button. 

5. Search for Drop Box Requests and tap the Download button. 

6. Tap the back arrow to return to the survey gallery. 

7. Tap Collection Checklist form, and then tap Collect. 

8. Tap the Location name drop-down arrow and choose the ballot drop box location. 

Note: 

The Address question is filled in based on the location name provided. 

9. In the Time arrived question, tap the calendar and enter the time arrived at the ballot 
drop box. 

10. Tap the Team Assistant drop-down arrow and choose the ballot collection team 
assistant. 

  The Team Captain is filled in with the full name of the user currently signed into the 
ArcGIS Survey123 app. 

11. Optionally, tap the Team Driver drop-down arrow and choose the ballot collection team 
driver. 

12. Optionally, use the barcode button or enter the drop box's current seal serial number. 

13. Optionally, use the barcode button or enter the drop box's current lock serial number. 

14. Enter the number of containers used to collect ballots from the drop box. 

15. Tap the camera button to capture a photo of each container used. You must capture at 
least one photo per container used. 

16. Tap the camera button to capture a photo of the drop box after the ballots have been 
removed.  

17. Tap the camera button to capture a photo of the drop box after it has been closed, 
secured, and locked.  

18. Optionally, use the barcode button or enter the drop box's new seal serial number. 

19. Optionally, use the barcode button or enter the drop box's new lock serial number. 

20. If ballots are being collected for the last time during an election, select Yes in the Is this 
the final ballot collection for this election? question. Tap the camera button to capture 
a photo of the drop box after it has been secured and closed for this election.  

21. Answer the Is there evidence of inprporiate electioneering question by selecting Yes 
or No. 
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22. If Yes is selected to the above question, use the text box to enter details, and then tap 
the camera button to capture one or more photos of inappropriate electioneering near the 
ballot drop box. 

23. Optionally, assess the drop box's condition by selecting Excellent, Good, Fair, or Poor. 

Note: 

If Poor is selected, a photo is required and details must be entered into the text box. 

24. Optionally, assess the location's condition by selecting Excellent, Good, Fair, or Poor. 

Note: 

When Poor is selected, a photo is required and details are required to be entered into 
the text box. 

25. For the Time departed question, tap the calendar and enter the time departed from the 
ballot drop box location. 

26. At the lower right, tap the check mark, and then tap Send now. 

Note: 

After submitting the Collection Checklist, the check list is available in the inbox until the 
Return Checklist is completed. 

 

Complete the Return Checklist 
You will now complete the workflow by filling out the Return Checklist, which documents ballot 

chain of custody as the ballots are returned to election headquarters. 

1. If necessary, tap the back arrow to return to the survey gallery. 

2. Tap the Return Checklist form and tap the Inbox. 

Note: 

You downloaded the Return Checklist in a previous step. 

3. Tap the Refresh button. 

Note: 

The inbox displays a message with ballot drop locations that have a Collection 
Checklist completed by the current user are in need of the Return Checklist. 

4. Tap the inbox record to open the Return Checklist. 
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Note: 

The Drop Box Information and Team sections display details previously captured on 
the Collection Checklist. 

5. In the Time returning to headquarters question, tap the calendar and enter the time 
returning to election headquarters. 

6. Enter the number of containers submitted.  

Note: 

The number of containers submitted must match the number of containers used that 
was previously entered on the Collection Checklist. 

7. Enter the number of ballots being submitted for processing after the first count. 

8. Tap the Name of the team member completing the first ballot count drop-down arrow 
and choose the team member's name. 

9. Enter the number of ballots being submitted for processing after the second count. 

Note: 

Two ballot counts are required on the Return Checklist. To submit the Return Checklist, 
the count numbers must match. 

10. Enter the name of the team member completing the second ballot count. 

11. Tap the Name of the Official Receiving Transport Containers drop-down arrow and 
choose the election official's name. 

12. Tap the Election Official signature button, and then capture the election official's 
signature.  

13. Tap the Team Captain signature button, and then capture the team captain's signature.  

14. Tap the Team Assistant signature button, and then capture the team assistant's 
signature.  

15. At the lower right, tap the check mark, and then tap Send now. 

 

Submit drop box requests for service 
While performing their ballot collection responsibilities, ballot collection officers may identify 

problems or other ballot drop box requests for service that need to be reported to election 

headquarters in order to be resolved at a later time. You will use the Drop Box Requests form 

to submit a request for service. 

1. If necessary, tap the back arrow to return to the survey gallery. 

2. Tap the Drop Box Requests form, and then tap Collect. 

3. In the Drop Box Requests form, fill in the following details: 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 294 

Question Answer 

Location name Select the ballot drop box location 

How critical is your request? Select a level of criticality 

Provide additional details to help us 
understand the problem 

Describe the request or issue being 
reported 

Attach an image if it will help describe the 
problem 

Optionally, attach an image 

Location Use the map to identify the location of the 
ballot drop box 

4. At the lower right, tap the check mark, and then tap Send now. 

 

Gauge voter satisfaction 
You will now assume the role of a voter who wants to help improve the voting experience for 

the next election by providing feedback on your voting experience. 

1. In a browser, go to the Voter Satisfaction Survey. 

2. Click Yes to indicate that you did vote in the most recent election. 

3. Click the Where did you vote drop-down arrow and choose a voting location. 

4. Complete the remaining questions in the survey, and then click Submit. 

 

Monitor performance 
You will now assume the role of a clerk or election official. As an election official, you want to 

know how an ongoing election is functioning throughout the community by monitoring ballot 

collections, requests, wait times, and voter satisfaction. 

Note: 

The Election Performance Center provides a unified view of the ArcGIS Dashboards apps 
described below. You can access the dashboards individually or by using the Election 
Performance Center. 

 

Ballot collection activities 
As ballots are being collected from official ballot drop boxes, you will use the Ballot Collection 

Dashboard to monitor ballot chain of custody activities. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Ballot 
Collection Dashboard. 

2. From the Location drop-down menu, select a ballot drop box location. 

  The map, graphs, list, and metrics update to display information for the selected location. 
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3. From the Time drop-down menu, select a Predefined option. 

  The map, graphs, list, and metrics update to display results for the selected location. 

4. Optionally, use the Calendar to select a time range. 

5. From the Team Captain drop-down menu, select a worker. 

  The map, graphs, list, and metrics update to display results for the selected location. 

6. Click the graphs to explore the ballot collections. 

Note: 

Explore both the Ballots and Containers charts using the appropriate tabs. 

7. On the left, select a collection in the collections list. 

8. At the bottom of the dashboard, click the Details tab to view information and photos 
captured on the Collection Checklist and Return Checklist. 

 

Election requests 
As voting location workers submit requests for assistance and report issues, you will use the 

Election Requests Dashboard to monitor ongoing requests and their resolution. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Election 
Requests Dashboard. 

2. From the Location drop-down menu, select a voting location. 

  The map, graphs, list, and metrics update to display information for the selected location. 

3. From the Time drop-down menu, select a Predefined option. 

  The map, graphs, list, and metrics update to display results for the selected location. 

4. Optionally, use the Calendar to select a time range. 

5. From the Worker drop-down menu, select a worker. 

  The map, graphs, list, and metrics update to display results for the selected location. 

6. Click the graphs to explore the election requests. 

Note: 

Dashboard charts are linked. If you click a status in the Status chart or a type in the 
Request Type chart, related details are filtered and updated in other elements in the 
dashboard. 

7. On the right, select a request from the requests list. 

Note: 

The map, graphs, list, and metrics update to display information for the selected 
request. 
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Election wait times 
As wait times are reported by voting location workers, you will use the Election Wait Times 

Dashboard to monitor wait times during an ongoing election. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Election Wait 
Times Dashboard. 

2. From the Location drop-down menu, select a voting location. 

  The Average wait by Hour chart, Average Wait metric, and list update to display 
information for the selected location. 

3. From the Not Reported Within drop-down menu, select an option. 

  The map, metrics, and list update to display voting locations that have not reported a wait 
time within the selected time frame. 

4. From the list on the right, select a location. 

Note: 

The map and graph update to display information for the selected location. 

 

Voter satisfaction 
As voters share their feedback on their voting experience using the Voter Satisfaction Survey, 

you will use the Voter Satisfaction Dashboard to understand voter feedback. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Voter 
Satisfaction Dashboard. 

2. From the Location drop-down menu, select a voting location. 

  The map, metrics, chart and list update to display information for the selected location. 

3. From the Time drop-down menu, select an option. 

  The map, graphs, list, and metrics update to display results for the selected time. 

4. Optionally, use the Calendar to select a time range. 

5. From the list on the right, select a Voter Satisfaction Survey response. 

Note: 

The map, graph, and metrics update to display information for the selected survey 
response. 
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Apply to be an election worker 

Note: 

The following workflows are designed to support election organizations using ArcGIS Hub 
Premium Community Identities for paid volunteers or temporary staff. When using ArcGIS 
Named Users, these workflows do not need to be completed. 

Election offices hire paid volunteers or temporary election workers to increase their staff 

capacity during an election. Election workers are often members of the community that 

perform tasks like assisting voters. 

You will now assume the role of a community resident that is interested in becoming an 

election worker. 

1. In a browser, go to the Become An Election Worker site. 

2. Scroll to the Become an Election Worker section. 

  When visitors to the site are not signed in, the Become An Election Worker site displays 
the buttons to Create an account or Sign In with an existing account. If a user is signed 
into the site, the Become An Election Worker site displays an Apply button, which can be 
used to access the Election Worker Application form. In the following steps, the user has 
created an account and is signed into the Become An Election Worker site. 

3. Click the Apply button. 

4. Complete the Election Worker Application form to express interest in becoming an 
election worker. 

  The application will be reviewed by election staff using the Election Worker Manager app. 
After the application has been approved, the applicant can access election apps on the 
Become An Election Worker site. 

5. Close the Election Worker Application and return to the Become An Election Worker site. 

  Election staff use the Election Worker Manager app to approve applicants for roles as 
Election Rovers, Ballot Collection Officers, or Voting Location Workers. Appropriately 
named section are displayed when an applicant's Election Worker Application has been 
approved by election staff and one or more role is assigned. 

6. Follow the instructions in the Election Rovers section to access the Election Manager 
ArcGIS Workforce project. 

7. Follow the instructions in the Ballot Collection Officers section to access the Collection 
Checklist, Return Checklist and Drop Box Requests ArcGIS Survey123 forms. 

8. In the Voting Location Workers section, click the Launch App button to access the 
Election Assistant app. 

 

Manage election workers 
You will now assume the role of election staff responsible for approving election worker 

applications and allocating staff. 
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In this workflow, you are asked to use the Election Worker Manager app to review and 

approve election worker applications. 

1. In a browser, go to the Election Worker Manager app. 

2. Click the Status column filter. 

3. Click the Status is drop-down arrow and choose Pending to view applications with a 
pending status. 

4. Click one of the applications to view its details and the types of election activities the 
applicant is interested in performing. 

5. On the Details tab, click the Edit button . 

6. Click the Status drop-down arrow and choose Approved. 

7. If the worker is approved as an election rover, click the Rover drop-down arrow and 
choose Yes. 

8. If the worker is approved as a ballot collection officer, click the  Ballot Collection Officer 
drop-down arrow and choose Yes. 

9. If the worker is approved as a voting location worker, click the  Voting Location Worker 
drop-down arrow and choose Yes. 

10. Click Save. 

  The Election Worker Notebook can be used to schedule a process that grants access to 
the appropriate election apps based on the roles that election workers are approved to 
perform. 

Election worker 
role 

Value 

Rover Granted access to the Election ManagerElection Manager ArcGIS 
Workforce project and added as mobile workers 

Ballot Collection 
Officer 

Granted access to the Collection Checklist, Return Checklist and Drop 
Box Requests ArcGIS Survey123 forms 

Voting Location 
Worker 

Granted access to the Election Assistant app to report wait times and 
request assistance 
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Election Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Election Outreach 
Election Outreach can be used to educate the public and help voters find an appropriate 

voting center or Election Day polling place. 

State and local governments strive to improve voter participation through open communication 

and a sense of collaboration. Elections departments look for ways to increase voter turnout 

and engage constituents, but are faced with changing behaviors of citizens who seem 

disconnected from the democratic process. Helping voters locate where they can vote and 

understand voting options removes voter confusion. Communicating wait times to voters 

reduces congestion at polling places or voting centers and increases participation by helping 

voters decide when they want to cast their ballot on Election Day. Election Outreach is 

typically implemented by clerks, election commissions, or secretary of state offices that want 

to inform voters and increase participation in the elections. 

The Election Outreach solution delivers a set of capabilities that help you share information 

about current elected representatives with the public, get voters to an appropriate voting 

center or Election Day polling place, and communicate voting wait times. 

 

Requirements 
Election Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later (Standard or Advanced) 
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Information products 
Election Outreach includes the following information products: 

Item Description Minimum user 
type 

Promoting 
Transparent 
Elections 

An ArcGIS Hub site used by the general public to 
access election information 

Not required 

My Elected 
Representative 

A Zone Lookup app used by the general public to 
determine who represents them in local, state, 
and federal elected offices 

Not required 

Election Polling 
Places 

A Zone Lookup app used by voters to locate a 
polling place where ballots can be cast on 
Election Day 

Not required 

Voting Centers A Nearby app used by voters to locate voting 
centers and official ballot drop boxes 

Not required 

Election Data 
Management 

An ArcGIS Pro project used by mapping 
technicians to inventory and maintain electoral 
districts, precincts, voting centers, and polling 
places 

GIS 
Professional 
Standard 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • Updated Promoting Transparent Elections to embed the My Elected 
Representative app. 

• Updated My Elected Representative, Election Polling Places and Voting 
Centers to use ArcGIS Instant Apps. 

• Updated Voting Centers and Election Data Management to include ballot 
drop boxes. 

• Updated ElectionGeography schema to support additional early voting 
patterns. 

1.0 • First release of Election Outreach 
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Configure Election Outreach 
Election Outreach can be used to educate the public and help voters find an appropriate 

voting center or Election Day polling place. 

In this topic, you will learn how to configure the Election Outreach solution to meet specific 

needs in your organization. 

 

Manage election data 
The Election Data Management ArcGIS Pro project includes a series of tasks to help guide 

you through creating, loading, and maintaining an inventory of electoral districts, voting 

locations, and voting precincts. 

Get started 
To get started with Election Data Management, complete the following steps. 

1. Sign in to your ArcGIS organization and browse to the Election Data Management 
Desktop Application Template. 

2. Open the item page, and then click Download. 

3. Unzip and open the Election Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and then double-click the Election Data 
Management task item. 

6. In the Tasks pane, click the Getting Started task group to expand the collection of tasks. 

Election Data Management is used to load, create, and edit foundational election data used in 

apps such as My Elected Representative, Election Polling Places, and Election Manager. The 

solution uses three foundational datasets: 

• Voting Locations 

• Voting Precincts 

• Electoral Districts 

Voting Locations contains facilities where voters can cast ballots and is defined by a point 

layer. They can be either polling places, voting centers, or ballot drop boxes, depending on 

your community's needs. Voting centers and ballot drop boxes can be modified to allow early 

voting. 

Voting Precincts contains areas that define your community's precincts and is defined by a 

polygon layer. They are related to voting locations by a unique ID and define the unique 

polling place where voters in a precinct should cast ballots. 

Electoral Districts contains geographies that define an elected office's area of representation 

and is defined by a polygon layer. For example, a mayor's Electoral District is the municipal 

boundary. Key attributes are used in My Elected Representative app. 
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Before proceeding to subsequent tasks, follow the instructions in the Add election 

geography layer task to add the ElectionGeography feature layer deployed with the solution. 

 

Load existing election data 
Your election agency may have existing polling place, voting center, ballot drop box, voting 

precinct, or electoral district data, which can be loaded into the ElectionGeography feature 

layer. 

Voting Locations are designated as either Polling Places, Voting Centers, or Ballot Drop 

Boxes using the Voting Facility Type field. Both Voting Centers and Polling Places use a 

standard for operational days and hours in the Voting Centers and Election Polling Places 

apps included with the Election Outreach solution. To load existing voting location data, 

designate the type and format the operational days and hours, following the instructions in the 

Polling places, Voting centers, and Ballot drop boxes tasks. 

The voting precinct’s relationship with a polling place is defined by populating the Polling 

GlobalID field with the GlobalID from the corresponding polling place. Establishing this 

relationship allows the Election Polling Places app to display the appropriate polling place 

when a user searches by address or defines a location on the map. Follow the instructions in 

the Voting precincts task to load existing data and establish the relationship. 

Follow the instructions in the Electoral districts task to load existing electoral district data. 

 

Create new election data 
You may need to create new election data if existing data is not available. Follow the 

instructions in the Create new election data task group to create new voting locations, voting 

precincts, and electoral districts. 

Note: 

Map layers must be visible to create new data. 

 

Prepare for the next election 
Election data changes over time as new voting locations are established, precincts are 

modified, and election cycles are completed. You must update key fields, such as the next 

election date, to maintain election data accuracy and ensure that public facing apps included 

with the Election Outreach solution display the correct information. Use the Next election 

date, Next voter registration date, and Early voting start and end date tasks to update key 

date fields as election cycles are completed. Use the Modify voting locations, Modify 

precincts, and Modify electoral districts tasks to edit your election data. 
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Populating operational hours 
This solution leverages the Opening Hours Specification to display operating hours for a place 

or service. When you populate the data fully, Arcade expressions interpret the data and 

display the operating hours in a human-readable format in the map pop-up. Understanding the 

data specification and options in the Arcade expressions will help you populate your data and 

display it in the maps and apps provided with the ArcGIS Solution. 

 

Operating Hours Specification 
The Operating Hours Specification allows you to store a combination of operating hours in a 

single field but relies on a series of data standards to render the information correctly. To 

ensure operating hours are displayed correctly, follow the standards below: 

• Enter all times using a 24-hour clock without a leading 0—for example, Tu (7:00-19:00). 

• Use a two-letter abbreviation for each day, with the first letter capitalized—for example, 
Mo, Tu, We, Th, Fr, Sa, Su. 

• When a location is open 24 hours a day, use 24 Hours—for example, Mo (24 Hours). 

• When a location is closed on a specific day, use Closed—for example, Sa-Sun (Closed). 

• Enclose all times and closed statuses in parentheses—for example, Tu (7:00-19:00); We-
Mo (Closed). 

• Separate days and ranges with a semicolon to denote the two (or more) groups—for 
example, Th-Fr (7:00-19:00); Sa (24 Hours). 

Using the standards above, a diverse set of operating hours can be populated for your places 

and services. Some common examples include the following: 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. seven days a week, populate the 
operating hours field with the following: Mo-Su (9:00-17:00). 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. during the week and closed on 
weekends, populate the operating hours field with the following: Mo-Fr (9:00-17:00); Sa-
Su (Closed). 

• To specify the place is open one day (Tuesday) a week, populate the operating hours 
field with the following: Tu (7:00-19:00); We-Mo (Closed). 

• To specify the place has operating hours that vary by day, populate the operating hours 
field with the following: Mo-Tu (9:00-17:00); We (Closed); Th-Fr (7:00-19:00); Sa (24 
Hours); Su (Closed). 

Operating hours data can be populated all at once for many places and services using 

Calculate field values or uniquely entered for each place or service using an application 

provided with the solution. 

 

Arcade expressions 
The Arcade expressions include several settings that allow you configure the look and feel of 

the operating hours when they are displayed in the web map pop-up. The expressions work 
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with the operating hours data and web map pop-up configurations to display current operating 

hours in your map and app. 

This solution uses several Arcade expressions. To modify one of these expressions, complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Election 
Polling Places or Voting Centers map. 

2. Open the item page, and then click Open in Map Viewer. 

3. In the Layers pane, click the Polling Places or Voting Centers layer, and then in the 
settings toolbar, click Configure Pop-ups. 

4. In the Configure Pop-ups pane, locate and click the Arcade element that you want to 
modify. 

5. Click Edit Expression to open the Arcade expression editor window. 

6. Each Arcade expression has a set of variables that can be configured according to your 
organization’s needs. 

7. Review the expression notes and modify the variables as needed. 

Tip: 

Copy and save all the Arcade syntax in the editor. This allows you to restore the 
original expression or discard changes. 

8. Click OK. 

9. Click Save. 

 

Modify elected offices 
My Elected Representative allows the general public to find who represents them in local, 

state, and federal elected offices. My Elected Representative includes several elected office 

layers, such as Mayor, County Clerk, Governor, and United States Senate. You can modify 

the elected offices available in the app to fit your needs. For example, you can configure My 

Elected Representative to display only locally elected offices. 

 

Update domain values 
First, you will review the elected offices in the ElectionGeography feature layer and identify an 

elected office your organization may want to add to My Elected Representative. 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
ElectionGeography feature layer. 

2. Open the item page, and then click the Data tab. 

3. Click Fields. 

4. Click the Layer drop-down menu and choose Electoral Districts. 
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5. In the list of fields, click the Elected Office display name. 

6. In the List of Values (Domain) section, review the existing categories and identify ones 
that are not applicable and ones that are missing. 

7. Next to List of Values (Domain), click Edit. 

8. Optionally, click the Delete button to remove a category from the list. 

9. Click Add. 

10. In the Displayed Value and Stored Value text boxes, type the new elected office name. 

11. Repeat steps 9–10 to add the remaining elected offices. 

12. Optionally, drag the elected office to a new location in the list to reorder them. 

13. Click Save. 

 

Update map 
Next you will configure the My Elected Representative map to display the elected offices that 

you want to display in the My Elected Representative app. 

1. Verify that you are signed in to your ArcGIS organization and browse to the My Elected 
Representative map. 

2. Open the item page, and then click Open in Map Viewer. 

The map opens. The Layers pane displays a list of several preconfigured elected office 
map layers ranging from Mayor to President of the United States. Each layer is filtered 
using the Elected Office field on the Electoral Districts feature layer. 

3. To remove an unnecessary elected office layer, click Options, and then click Remove. 

4. To duplicate a layer, click Options and then click Duplicate. 

5. A new layer appears in the Layers pane. 

6. To update the new layer’s name, click Options, click Rename, type the elected office 
name in the Title text box, and click OK. 

7. With the new layer selected, click Filter on the settings toolbar. 

An existing filter expression is displayed. You will modify the expression to display the 
new elected office. The Value drop-down menu displays the values that you configured 
in a previous task. 

8. From the drop-down menu, choose the appropriate elected office domain value, and then 
click Save. 

9. Optionally, drag the layer to a new location in the Layers pane. 

Tip: 

You can also configure existing layers using the above steps. Modify the name and 
filter of an existing layer to match your configuration needs. 

10. Click Save. 
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Update app 
You will now configure the My Elected Representative app to use the elected offices 

configured in the My Elected Representative map. 

1. Verify that you are signed in to your ArcGIS organization and browse to the My Elected 
Representative app. 

2. Open the item page, and then click Configure. 

3. Click the Zone Lookup tab. 

4. Click Options. 

5. In the Layers to include in results section, configure the layers searched in the app. 

Tip: 

Check the check box next to each of the layers available. 

6. Click Publish. 

7. Click Confirm. 

8. Click Launch. 

 

Manage wait times 
When paired with the Election Management solution, Election Polling Places and Voting 

Centers can display election wait times on the map so that voters can make an informed 

decision about when to vote. 

 

Share polling place wait times 
The Election Polling Places map includes a Polling Place Wait Times layer that displays the 

current wait time. To share wait times in the Election Polling Places app, you’ll make use of 

the included Polling Place Wait Times map layer. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Election 
Polling Places map. 

2. Open the item page, and then click Open in Map Viewer. 

3. Hover over the Polling Place Wait Times layer and click the Show layer button. 

The map now displays the most recently reported wait time symbolized by the length of 
the wait reported. When an election is completed and you want to remove the wait times 
symbol, you can hide the Polling Place Wait Times layer. 

4. Click Save. 
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Share voting center wait times 
The Voting Centers map includes a Voting Center Wait Times layer that displays the current 

wait time. To share wait times in the Voting Centers app, you’ll make use of the included 

Voting Center Wait Times map layer. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Voting 
Centers map. 

2. Open the item page, and then click Open in Map Viewer. 

3. Hover over the Voting Centers layer and click the Hide layer button. 

4. Hover over the Voting Center Wait Times layer and click the Show layer button. 

The map now displays the most recently reported wait time symbolized by the length of 
the wait reported. When an election is completed and you want to remove the wait times 
symbols, you can show the Voting Centers layer and hide the Voting Center Wait Times 
layer. 

5. Click Save. 

 

Hide polling place wait times 
On Election Day, the Election Polling Places app automatically displays wait times tracked 

using the Election Management solution. Follow the steps below to remove wait times from 

the Election Polling Places app. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Election 
Polling Places map. 

2. Open the item page, and then click Open in Map Viewer. 

3. In the Layers pane, click the Polling Places layer, and then in the settings toolbar, click 
Configure Pop-ups. 

4. In the Configure Pop-ups pane, locate the Wait Times Arcade element. 

Tip: 

Click the Wait Times Arcade element and click Edit Expression to open the Arcade 
expression editor window. Copy and save all the Arcade syntax in the editor in order to 
restore wait times or discard changes. 

5. Delete the Wait Times Arcade element from the pop-up. 

6. Click Save. 

  On Election Day, the pop-up does not display wait times but continues to display current 
information, such as the Today is Election Day message and operational status. 

 

Hide voting center wait times 
A voting center can be open on Election Day as well as for a period prior to Election Day. 

When a voting center is open and active, the Voting Centers app automatically displays wait 
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times tracked using the Election Management solution. Follow the steps below to remove wait 

times from the Voting Centers app. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Voting 
Centers map. 

2. Open the item page, and then click Open in Map Viewer. 

3. In the Layers pane, click the Voting Centers layer, and then in the settings toolbar, click 
Configure Pop-ups. 

4. In the Configure pop-ups pane, locate the Wait Times Arcade element. 

Tip: 

Click the Wait Times Arcade element and click Edit Expression to open the Arcade 
expression editor window. Copy and save all the Arcade syntax in the editor in order to 
restore wait times or discard changes. 

5. Delete the Wait Times Arcade element from the pop-up. 

6. Click Save. 

  When a voting center is open and active, the pop-up does not display wait times but 
continues to display current information, such as the early voting timeframe and 
operational status. 

 

Configure directions for the Voting Centers app 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

The Voting Centers app can be used by the general public to locate voting centers and ballot 

drop boxes where they can cast their ballots. Directions to the nearest voting center or ballot 

drop box can be enabled so that users can quickly find the location they are looking for. 

Follow the steps below to enable directions. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Voting 
Centers app. 

2. From the item page, click Configure App. 

Close the Welcome to the App Setup Page splash page, if necessary. 

3. On the Contents (dark) toolbar, turn off the Express Setup toggle button, if necessary. 

4. Click Nearby > Options and turn on the Show directions toggle button. 

5. Next to the Ballot Drop Boxes and Voting Centers layers, check the check boxes. 

6. Click Publish. 
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Configure the Promoting Transparent Elections site 
The Election Outreach solution includes the Promoting Transparent Elections ArcGIS Hub site 

that your organization can configure with your branding and use to share election information 

with the public. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Promoting 
Transparent Elections site. 

2. Open the item page, and then click Configure. 

3. Scroll through the site and review the content. 

4. If necessary, click the Edit button  to open the site editor. 

5. Scroll to the Voting Locations section, and then, for each image card, hover over the 
card, click the edit pencil and update the image. 

6. Scroll to the Frequently Asked Questions section, hover over the card, click the edit 
pencil, and update the questions and answers. 

7. In the side panel, click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

8. Click the HTML box. 

The HTML window appears. 

9. Make the necessary changes and click Apply. 

10. Click Save. 

11. Under Save, click the drop-down menu and choose Publish Draft. 

 

Sharing solution items 
Several layer views, maps and apps included in the Election Outreach solution must be 

shared with everyone so that they can be accessed by the public on the Promoting 

Transparent Elections site. To share your election outreach items with everyone, use the 

guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Election 
Outreach folder. 

2. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) VotingLocations_currentwait 

Feature Layer (hosted, view) ElectionGeography_public 

Web Map My Elected Representative 

Web Map Voting Centers 

Web Map Election Polling Places 
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Web Mapping Application My Elected Representative 

Web Mapping Application Voting Centers 

Web Mapping Application Election Polling Places 

Site Application Promoting Transparent Elections 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

 

Configure Election Management solution items 

Note: 

Complete this workflow when using the Election Management Solution's Become An 
Election Worker site and Voter Satisfaction Survey. 

When paired with the Election Management solution, the Promoting Transparent Elections site 

can be configured to include links to the Become An Election Worker site and the Voter 

Satisfaction Survey for recruiting election workers and gauging voter sentiment. 

Note: 

Before continuing with the steps below, verify that the Become An Election Worker and 
Voter Satisfaction Survey apps and their associated maps and layers are shared with the 
public. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Become An 
Election Worker site. 

2. Open the item page and scroll down to the URL section, and then click the Copy button. 

3. Paste the URL into Windows Notepad or another text editor for reference. 

4. Browse to the Voter Satisfaction Survey. 

5. Open the item page, click Open in Survey123 > Open in Survey123 app. 

Note: 

A new tab opens, prompting you to open into Survey123 app. Click Cancel and 
remove "&open=native" from the URL to open survey directly into the browser. 

6. In the address bar of the browser, copy the survey URL, including the question mark and 
portalURL= statement. 
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Note: 

For example, the URL is similar to this one: 

https://survey123.arcgis.com/share/aee97bcef4d24c9187da9590ec86b67c?po
rtalUrl=https://statelocaltryit.maps.arcgis.com 

7. Paste the URL into Windows Notepad or another text editor for reference. 

8. Browse to the Promoting Transparent Elections site. 

9. Open the item page, and then click Configure. 

10. Scroll to the Become an election worker section, and then hover over the text card and 
click the edit pencil. 

11. Click the Learn More link, and then click Edit. 

12. Enter the Become An Election Worker site URL into the Link Destination text box, and 
then click Add Link. 

13. Scroll to the Measuring voter satisfaction section, and then hover over the text card 
and click the edit pencil. 

14. Click the Share Feedback link, and then click Edit. 

15. Enter the Voter Satisfaction Survey URL into the Link Destination text box, and then 
click Add Link. 

16. Click Save. 

17. Under Save, click the drop-down menu and choose Publish Draft. 

 

Configure Election Results solution items 

Note: 

Complete this workflow when using the Election Results Solution. 

When paired with the Election Results solution, the Promoting Transparent Elections site can 

be configured to include a link to the Election Results app to view map-based election results. 

Note: 

Before continuing with the steps below, verify that the Election Results app and its 
associated dashboards, maps and layers are shared with the public. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Election 
Results app. 

2. Open the item page, scroll down to the URL section, and click the Copy button. 

3. Paste the URL into Windows Notepad or another text editor for reference. 

4. Browse to the Promoting Transparent Elections site. 

5. Open the item page, and then click Configure. 
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6. Scroll to the Election Results section, and then hover over the text card and click the 
edit pencil. 

7. Click the Explore Results link, and then click Edit. 

8. Enter the Election Results app URL into the Link Destination text box, and then click 
Add Link. 

9. Click Save. 

10. Under Save, click the drop-down menu and choose Publish Draft. 
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Use Election Outreach 
The Election Outreach solution delivers a set of capabilities that help you share information 

about current elected representatives with the public, get voters to an appropriate voting 

center or Election Day polling place, and communicate voting wait times. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Find elected representatives 
You will assume the role of a resident in the community who wants to find information on 

elected representatives. 

1. In a browser, go to the Promoting Transparent Elections site. 

2. Scroll to the Who’s My Elected Representative section. 

3. In the Search for an address search box, type an address, and then press Enter. 

4. Review the list of elected offices. Click an elected office to expand and view the elected 
representative's information. 

Using the list of elected offices, you can discover your elected representatives and their 
contact information. For example, county commissioners are responsible for the 
management of county funds and have fiscal and regulatory powers. 

 

Locate a polling place 
Many states divide communities into geographic areas called precincts and assign registered 

voters to designated polling places based on their residential address. On Election Day, 

ballots are cast at these designated polling places and then tabulated to determine the winner 

of a political contest or proposal. 

You will assume the role of a voter interested in locating the polling place where your ballot 

can be cast on Election Day. 

1. In a browser, go to the Promoting Transparent Elections site. 

2. Scroll to the Voting Locations section, and then, under the Locate My Polling Place 
header, click the Launch App button to open the Election Polling Places app. 

3. In the Search for an address to find your polling place search box, type an address 
and press Enter. 

The map updates to display the area covered by the voting precinct where the address is 
located. 

The Information panel displays details about the polling place, such as the election date, 
location, operational hours, and contact information. If the app has been configured to 
show wait times, they can be visualized on the map, where polling place symbols are 
color-coded according to reported wait times. Depending on when you access the app, 
you will see an operational status of Open Now or Closed below the hours of operation. 
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4. After you finish, return to the Promoting Transparent Elections site. 

 

Locate voting centers and ballot drop boxes 
Voting centers are an alternative to traditional, neighborhood-based precincts. When a 

jurisdiction opts to use voting centers, voters may cast their ballots on Election Day at any 

voting center in the jurisdiction, regardless of their residential address. Voting centers may 

also communicate early voting options such as ballot drop boxes. 

As a voter in the community, you are interested in locating nearby voting centers and ballot 

drop boxes. 

1. In a browser, go to the Promoting Transparent Elections site. 

2. Scroll to the Voting Locations section, and then, under the Locate a Voting Center 
header, click the Launch App button to open the Voting Centers app. 

3. In the Search for an address or place search box, type an address and press Enter. 

Tip: 

Alternatively, click the Search this area button near the top of the map. 

The Information tab displays results for voting centers and ballot drop boxes that are 
located within the search area. 

4. Expand Voting Centers and click a voting center from the search results. 

The Information tab displays center-specific information such as the election date, 
location details, early voting time frame, operational hours, and contact information. If the 
app has been configured to show wait times, they can be visualized on the map, where 
voting center symbols are color-coded according to reported wait times. Depending on 
when you access the app, you will see an operational status of Open Now or Closed 
below the hours of operation. 

5. Collapse Voting Centers and expand Ballot Drop Boxes. 

6. Click a ballot drop box from the search results. 

The Information tab displays center-specific information, such as the election date, 
location details, and early voting time frame. 
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Election Results 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Election Results 
Election Results can be used to share results tabulated on election night and historical results 

shared after each election. 

Election results for political contests, proposals, and voter turnout for one or more jurisdictions 

are integral to election night or post-election night reporting. Election results are often shared 

through files and tables that are difficult to examine. Sharing election results in a map-based 

application helps voters and other interested stakeholders quickly visualize voting trends in a 

community. Election Results is typically implemented by clerks, election commissions, or 

secretary of state offices that want to make election results accessible and understandable by 

voters, the media, and other interested stakeholders. 

The Election Results solution delivers a set of capabilities that help you organize map-based 

election results, share results for each elected office or proposal, and communicate voter 

turnout for one or more jurisdictions. 

 

Requirements 
Election Results requires the following: 

• ArcGIS Enterprise 

 

Information products 
Election Results includes the following information products: 

Item Description Minimum 
user type 

Election 
Results 

An ArcGIS Experience Builder app used by the general public 
and other interested parties to view map-based election 
results 

Not required 
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Release notes 
The following are the release notes: 

Version Description 

2.0 • A new ArcGIS Dashboards app optimized for display on mobile devices. 

• A new ArcGIS Experience Builder app that displays the correct dashboard, 
desktop or mobile, depending on the device. 

• Party domain now includes 10 nonpartisan categories to support nonpartisan 
and primary contests. 

• Results for all candidates are displayed in the map pop-up to better support 
multiple-winner contests. 

• Mail-in, early, and election day voting method metrics are now included. 

1.0 • First release of Election Results 
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Configure Election Results 
In this topic, you’ll learn how to configure the Election Results solution to meet specific needs 

in your organization. 

 

Load data 
The Election Results solution includes the ElectionResults feature layer used to store your 

tabulated election results data. The ElectionResults feature layer has two sublayers, Voting 

Jurisdictions and the Election Results table. Voting Jurisdictions stores the geographic 

jurisdiction you’re using to visualize election results on a map (for example, County, 

Municipality, or Precinct). The Election Results table stores the results of ballot measures 

where each record represents the results of a ballot measure by contest, candidate, and 

jurisdiction. Each record in the Election Results table is also categorized as an Elected Office 

or Proposal using the Contest Category field. 

In the example below, two candidates ran for mayor in a community with three precincts. 

Tip: 

Consider including the number of winners in the name of the contest and the party 
designation in the name of candidate. This information will provide more context for the 
contest and candidate in the Election Results app. 

Contest Contest 
Category 

Jurisdiction 
Name 

Candidate Party Number of 
Votes 

Mayor (Vote 
for 1) 

Elected Office Precinct 1 John Doe 
(D) 

Democratic 306 

Mayor (Vote 
for 1) 

Elected Office Precinct 2 John Doe 
(D) 

Democratic 147 

Mayor (Vote 
for 1) 

Elected Office Precinct 3 John Doe 
(D) 

Democratic 350 

Mayor (Vote 
for 1) 

Elected Office Precinct 1 Jane Smith 
(R) 

Republican 245 

Mayor (Vote 
for 1) 

Elected Office Precinct 2 Jane Smith 
(R) 

Republican 153 

Mayor (Vote 
for 1) 

Elected Office Precinct 3 Jane Smith 
(R) 

Republican 294 

In the previous example, the candidates are symbolized by their traditional party color. The 

Party field domain also includes 10 nonpartisan options. These options can be used for any 

contest, including nonpartisan and primary contests, in which a candidate needs to have a 

unique color from other candidates in the same contest but the color is not tied to their political 

party. The following example shows a nonpartisan contest: 
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Contest Contest 
Category 

Jurisdiction 
Name 

Candidate Party Number of 
Votes 

School Board 
(Vote for 2) 

Elected 
Office 

Precinct 1 John Doe Nonpartisan 
1 

306 

School Board 
(Vote for 2) 

Elected 
Office 

Precinct 2 John Doe Nonpartisan 
1 

147 

School Board 
(Vote for 2) 

Elected 
Office 

Precinct 3 John Doe Nonpartisan 
1 

350 

School Board 
(Vote for 2) 

Elected 
Office 

Precinct 1 Jane 
Smith 

Nonpartisan 
2 

245 

School Board 
(Vote for 2) 

Elected 
Office 

Precinct 2 Jane 
Smith 

Nonpartisan 
2 

153 

School Board 
(Vote for 2) 

Elected 
Office 

Precinct 3 Jane 
Smith 

Nonpartisan 
2 

294 

You can also use the Election Results table to store the results of ballot measure proposals. 

Yes and No are populated in the Candidate field, the Contest Category is Proposal, and the 

Party field is left blank. In the following example, Proposal 1 was voted on in a community with 

three precincts: 

Contest Contest Category Jurisdiction Name Candidate Party Number of Votes 

Proposal 1 Proposal Precinct 1 Yes  306 

Proposal 1 Proposal Precinct 2 Yes  147 

Proposal 1 Proposal Precinct 3 Yes  350 

Proposal 1 Proposal Precinct 1 No  245 

Proposal 1 Proposal Precinct 2 No  153 

Proposal 1 Proposal Precinct 3 No  294 

Caution: 

You can add new fields to the ElectionResults feature layer, but do not delete any fields 
from the Voting Jurisdictions layer or Election Results table. Deleting fields will break the 
ElectionResults_join view and the Election Results app. 

 

Load election results 
You can load election results data from a spreadsheet sourced from your tabulation system. 

The Election Results solution includes a .csv file that you can use to load data into the 

ElectionResults feature layer. Populate the ElectionResults.csv fields with your election results 

data, and complete the following steps to load your election results data: 

1. Sign in to your ArcGIS organization and browse to the ElectionResults.csv item. 

2. Open the item page and click Download. 

3. Edit the .csv file and provide your election results data. 

4. In your ArcGIS organization, browse to the ElectionResults feature layer. 

5. Open the item page and click Update Data > Append Data to Layer. 

6. Click Choose File, browse to your .csv file, and click OK. 

7. Click Upload and Continue. 
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8. Click the Choose the layer that you wish to append data into drop-down arrow and 
choose Election Results. 

9. Uncheck Update existing features. 

10. Click Show field matching to map the fields. 

11. Click Apply Updates. 

 

Load voting jurisdictions 
Voting jurisdictions define the geographic jurisdiction you’re using to visualize election results 

on a map (for example, County, Municipality, or Precinct) and also store voter turnout and 

method metrics. Voting jurisdictions can be loaded from a shapefile by completing the 

following steps: 

1. Create a .zip file of a shapefile of your voting jurisdictions. 

2. Sign in to your ArcGIS organization and browse to the ElectionResults feature layer. 

3. Open the item page and click Update Data > Append Data to Layer. 

4. Click Choose File and browse to a .zip file containing the shapefile with your voting 

jurisdictions, and click Open. 

5. Click Upload and Continue. 

6. Click the Choose the layer that you wish to append data into drop-down arrow and 
choose Voting Jurisdictions. 

7. Uncheck Update existing features. 

8. Click Show field matching to map the fields. 

Note: 

The only required field is the Jurisdiction Name (jurisdictionname) field. This is a text 
field that defines the unique name of the jurisdiction used in the relationship with the 
election results. 

9. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Modify political parties 
The Elected Office map symbolizes the jurisdiction using the party of the candidate who 

received the most votes for the jurisdiction. Each candidate is also displayed in the chart using 

the color associated with their party. The Party field in the ElectionResults feature layer has 

been configured with a domain containing some of the most common political parties in the 

United States and 10 nonpartisan party options that can be used to uniquely identify 
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candidates in the same contest. You may need to modify the political parties to match the 

candidates in your jurisdiction. 

Complete the steps below to modify the political parties available in the Election Results app: 

 

Update the field domain 
To update the field domain, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the ElectionResults feature layer. 

2. On the item page, click the Data tab. 

3. Select Election Results from the Layer drop-down menu. 

4. Click Fields. 

5. Click the Party field. 

6. Click Edit next to List of Values (Domain). 

7. Optionally, click Add. 

8. Type the party in the Displayed Value and Stored Value text boxes. 

9. Optionally, click Delete to remove a party. 

10. Optionally, drag the party to a new location in the list to reorder the list. 

11. Click Save. 

 

Update the map symbology 
To update the map symbology, complete the following steps: 

1. Confirm that you are signed in to your ArcGIS organization and browse to the Election 
Results - Elected Office web map. 

2. On the item page, click Open in Map Viewer. 

3. Select the Elected Office Results layer. 

4. Click Edit layer style on the right side panel. 

5. Click Style options under Types (unique symbols). 

6. Click the up arrow next to each of your new political parties to add them to the layer 
symbology. 

7. Optionally, drag down any political parties you want to remove. 

8. Click the symbol next to each new party to give it a custom color. 

9. Click Done. 

10. Click Save. 

 

Update the dashboard chart 
To update the dashboard chart, complete the following steps: 
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1. Confirm that you are signed in to your ArcGIS organization and browse to the Election 
Results Desktop Dashboard. 

2. Open the item page and click Edit Dashboard. 

3. Hover over the upper left corner of the Elected Office Results chart and choose 

Configure . 

4. Click the Series tab. 

5. Click the + series button. 

6. Type the name of a new party and click Add. 

7. Click the symbol next to the new party to give it the same color you configured in the 
map. 

8. Repeat steps 5 through 7 for each new party. 

9. Optionally, click Delete  next to each party you want to remove. 

10. Click Done. 

11. Click Save. 

12. Repeat steps 1 through 11 for the Election Results Mobile Dashboard. 

 

Remove the jurisdiction type filter 
You can use Election Results to display results for different jurisdiction types, such as county, 

municipality, or precinct, in the same application. In many cases, you may only need to display 

results for a single jurisdiction type. In this case, the jurisdiction type filter is unnecessary and 

can be removed. 

Complete the steps below to remove the jurisdiction type filter: 

1. Confirm that you are signed in to your ArcGIS organization and browse to the Election 
Results Desktop Dashboard. 

2. Open the item page and click Edit Dashboard. 

3. Hover over the upper right corner of the Jurisdiction Type filter and choose Delete . 

4. Click Save. 

5. Repeat steps 1 through 4 for the Election Results Mobile Dashboard. 

 

Modify voting method metrics 
By default, three voting method metrics are included in the Election Results app, Mail-in, Early 

In Person, and Election Day. Communities may define these methods differently, for example, 

Absentee rather than Mail-in, or may not offer all of these methods. In these cases, you may 

want to update the voting methods that are reported in the Election Results app. 

To modify the voting method metrics available in the Election Results app, complete the 

following steps: 
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Update the map pop-up 
To update the map pop-up, complete the following steps: 

1. Confirm that you are signed in to your ArcGIS organization and browse to the Election 
Results - Voter Turnout web map. 

2. On the item page, click Open in Map Viewer. 

3. Select the Voter Turnout layer. 

4. Click Configure pop-ups on the right side panel. 

5. Click the Arcade - Voting Turnout element and click Edit expression. 

The expression returns a table with a header row and three content rows for Mail-in, 
Early In Person, and Election Day. Each content row is surrounded with some HTML 
comments, for example, <!-- Begin Mail-in Row --> and <!-- End Mail-in Row -->. If you 
want to remove one of these rows because the voting method doesn't apply, delete 
everything between these two comment lines. 

6. Make the changes to the voting method name in the table and click OK. 

7. Click Save. 

 

Update the dashboard indicators 
To update the dashboard indicators, complete the following steps: 

1. Confirm that you are signed in to your ArcGIS organization and browse to the Election 
Results Desktop Dashboard. 

2. Open the item page and click Edit Dashboard. 

3. Click the Voter Turnout tab. 

4. To remove one of the voting method indicators, hover over the upper left corner of the 

indicators and choose Delete . 

5. Optionally, hover over the upper left corner of the voting method indicators and choose 

Configure . 

6. Click the General tab. 

7. Click Edit next to the title and update the text you want to display in the indicator. 

8. Click Done. 

9. Click Save. 

10. Repeat steps 1 through 9 for the Election Results Mobile Dashboard. 

Note: 

The tab in the mobile dashboard is named Voting Method. 
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Share historical results 
You can deploy and configure the Election Results solution multiple times to share results for 

different elections. You can then share each of the Election Results apps with a single 

Portfolio app and embed them on your website. 

To create a historical Election Results app using the Portfolio ArcGIS Instant Apps template, 

complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Click the Apps button  in the header of the site and click Instant Apps. 

3. Click Browse All and search for Portfolio. 

4. Click Choose on the Portfolio template. 

5. Specify a title and tags and click Create App. 

6. Click Step 1. Portfolio. 

7. Click Add new section. 

8. Click Browse for content, search for one of your Election Results apps, and click Select 
section. 

9. Optionally, modify the Section name value to be specific to the election, for example, 
2020 General Election. 

10. Click Done. 

11. Repeat steps 7 through 10 for each Election Results app you want to share. 

12. Optionally, change the App layout setting. 

13. Click Publish and click Confirm. 

14. Click Change sharing settings and share the app with Everyone (public). 

15. Embed the Historical Election Results app on your election website. 
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Use Election Results 
The Election Results solution delivers a set of capabilities that help you organize map-based 

election results, share results for each elected office or proposal, and communicate voter 

turnout for one or more jurisdictions. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Explore Election Results 
You are a member of the general public who wants to explore the results of an election in your 

community. 

1. In a browser, go to the Election Results app. 

2. Under Elected Offices, explore additional contests using the filter in the left panel. 

3. Both the map and the results graph at the bottom update when the contests are selected. 

4. Select Municipality from the Jurisdiction Type drop-down menu. 

Both the map and the Elected Offices filter update to display contests by municipality 
rather than precinct. You can use Election Results to display results by any jurisdiction 
type, such as county, municipality, or precinct. 

5. Select a municipality on the map to view a list of candidates sorted by votes received for 
the selected elected office. 

6. Select a municipality from the Jurisdiction Name drop-down menu. 

The map, results graph, and voter turnout metrics update to display results for the 
selected municipality. 

7. Select the Proposal tab on the bottom of the dashboard. 

8. Explore proposal results using the left panel filters and the map. 

9. Click the Voter Turnout tab on the bottom of the dashboard. 

10. Explore voter turnout and voting method metrics using the left panel filters and the map. 

Note: 

On a mobile device, voter turnout information is displayed on three tabs, Voter 
Turnout, Voting Method, and Turnout Map. 
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Emergency Debris Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Emergency Debris Management 
Emergency Debris Management can be used to expedite initial debris clearance, assess 

volume, and monitor the removal of disaster debris accumulated on roads, right-of-ways, and 

public facilities. 

When disaster-related debris presents a threat to public health and safety, a community may 

act to negate the threat and ensure its economic recovery. In the immediate aftermath of an 

incident, the speed at which debris can be cleared from roads determines how quickly life 

safety resources can be mobilized. Before recovery and rebuilding efforts can begin, debris 

must be efficiently assessed and removed safely. These efforts can be expensive. If debris 

removal activities are not monitored and proper documentation maintained, federal 

reimbursement may be delayed. Emergency Debris Management is typically implemented by 

public works departments, emergency management agencies, and other local government 

organizations that want to improve the efficiency of their debris management operations and 

ensure federal guidelines are met. 

The Emergency Debris Management solution delivers a set of capabilities that help you 

expedite initial debris clearance, assess debris removal needs, and monitor debris removal 

activities. 

 

Requirements 
Emergency Debris Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS QuickCapture 

• ArcGIS Survey123 

• ArcGIS Workforce 
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Information Products 
Emergency Debris Management includes the following information products. 

Item Description Minimum 
User Type 

Emergency Debris 
Management 
Center 

An ArcGIS Experience Builder app used by debris 
managers and operations leads to monitor progress and 
update status during the clearance, assessment, and 
removal phases of the debris management process 

Editor 

Road Debris 
Reporter 

An ArcGIS QuickCapture app used by first responders 
during the first 72 hours of a disaster response to identify 
where debris is obstructing the roadway 

Mobile 
Worker 

Debris Clearance 
Assignments 

An ArcGIS Workforce project used to manage road 
debris obstructions and clearance assignments 

Mobile 
Worker 

Debris 
Assessment Form 

An ArcGIS Survey123 form used by assessors to 
perform debris assessments on public facilities or in the 
right-of-way 

Mobile 
Worker 

Load Ticket An ArcGIS Survey123 form used by debris monitors at a 
load site to initiate a load monitoring ticket 

Mobile 
Worker 

Unload Ticket An ArcGIS Survey123 form used by debris monitors at 
debris management sites to complete load monitoring 
tickets 

Mobile 
Worker 

Truck Certification 
Form 

An ArcGIS Survey123 form used by assessors to 
document the capacity of trucks used for emergency 
debris removal 

Mobile 
Worker 

Debris Records 
Reviewer 

An ArcGIS Experience Builder app used by contractors 
or auditors to view debris records from the field, and to 
review or export logs from the office 

Viewer 

Debris Removal 
Services 

A Nearby app used by the public to understand the 
debris removal requirements, the pickup schedule for 
their property and where debris can be dropped off 

Not 
required 

 

Release Notes 
The following are the release notes: 

Version Description 

1.0 • First release of Emergency Debris Management 
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Configure Emergency Debris Management 
In this topic, you will learn how to configure the Emergency Debris Management solution to 

meet specific needs in your organization. 

 

Load data 
Applications included in the Emergency Debris Management solution can leverage 

authoritative operational layers for debris management already managed by your 

organization. Existing GIS layers for debris work areas or routes, debris management sites, 

debris removal providers, and critical infrastructure can be appended into the corresponding 

layers within the solution. Review the layers provided with the solution and determine what 

source data you want to load. Then, load your existing data into the layers provided with the 

solution before sharing maps or apps. 

Load data into the Debris Areas layer from a shapefile or file geodatabase by completing the 

following steps: 

1. Create a .zip file of a shapefile or file geodatabase. 

2. Sign in to your ArcGIS organization and browse to the feature layer you want to populate. 

3. Open the item page and click Update Data > Append Data to Layer. 

4. Click Choose File and browse to your .zip file, and click Open. 

5. Click the Contents drop-down arrow and choose Shapefile or File Geodatabase. 

6. Click Upload and Continue. 

7. Click Choose the layer to update drop-down arrow and choose the layer that contains 
the updated data. 

8. Uncheck Update existing features. 

9. Click Show field matching to map the fields between the two layers. 

10. Click Apply Updates. 

11. Optionally, repeat steps 1-10 for the Debris Removal Providers and Debris Management 
Sites layers. 

Note: 

In order to use the Truck Certification Form, you must first load records in the 
DebrisRemovalProviders feature layer or create them using the Manage Removal Status 
app in the Emergency Debris Management Center. 

 

Provision users 
The Emergency Debris Management solution enables secure viewing and editing privileges to 

users based on their roles in the clearance, assessment, and removal workflows. To ensure 

privileges are appropriate to the needs of each user role, the Emergency Debris Management 
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solution includes several role-specific sharing groups for managers, first responders and 

clearance field crew supervisors, assessors, monitors, and record reviewers such as 

contractor administrative staff or FEMA personnel. These groups are pre-configured with the 

layers, maps, and apps each role needs to perform their functions within the solution. 

Add named user accounts to the corresponding groups, by completing the following steps: 

1. Sign into your ArcGIS Organization. 

2. Click Groups. 

3. Search My Groups for Emergency Debris. 

4. You will see five groups: Emergency Debris Management, Emergency Debris Monitors, 
Emergency Debris Record Reviewers, and Emergency Debris Clearance Crews. 

5. Click the group you want to invite users to. 

6. Click Invite users and add individuals performing that function to the group. 

 

Assign personnel to ArcGIS Workforce 
The Emergency Debris Management solution includes an ArcGIS Workforce project used by 

debris operations leads to assign debris clearance assignments to the supervisors of work 

crews in the field. Before the solution can be used, the named user accounts of each debris 

operations lead and work crew supervisors must be added to the Workforce project in the 

dispatcher and mobile worker roles, respectively. 

Assign named users to the corresponding group, by completing the following steps: 

1. Sign into your ArcGIS organization. 

2. Go to the App Launcher, then click Workforce. 

3. Mouse over Debris Clearance Assignments, then click Configure. 

4. Click Users. 

5. Use the Organization User drop-down list to select a user. 

6. Use the Project Role drop-down list to select the role for that user. 

7. Click Add User. 

8. Repeat this process for each of your field crew supervisors. 

 

Create incident names 
Over time you may experience several emergency incidents. Therefore, it will be important to 

name each incident so you will be able to track the debris assessments and monitoring tickets 

associated to each incident. The Emergency Debris Management Center app can be used to 

create incident names. 

To create and manage disaster incident names, complete the following steps: 

1. Sign into your ArcGIS organization 
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2. Click on the down arrow next to the Help tab and click Manage Incident Names. 

3. Click Download and open the IncidentName csv file on your computer. 

4. Add a new incident name in the first field and save the file with the changes. 

5. Click Update on the IncidentNames item page and choose the updated IncidentNames 
file on your computer then click Update Item. 

The new incident name has been added to the list of incidents and will appear on each survey 

when debris reports are collected. 

 

Modify surveys 
The Emergency Debris Management solution includes the Load Ticket and Unload Ticket 

surveys. To prevent mistakes and ensure data quality, several fields in the surveys can use 

lookup lists generated from the unique values contained in a field from a separate layer. To 

complete the setup of this capability in the Load Ticket and Unload Ticket, the surveys must 

be edited using ArcGIS Survey123 Connect and then republished. 

Tip: 

The Load Ticket, Unload Ticket and Debris Assessment Form forms are configured to 
provide address information and will consume credits using the ArcGIS World Geocoding 
Service. Learn more about credit usage when using the geocoding service. 

 

Update Load Ticket 
To improve data quality, several fields in the Load Ticket can be updated with a dynamic list of 

values based on fields found in other layers. The Truck ID field in the Load Ticket is updated 

by a lookup list containing the truck IDs of all trucks that have been certified using the Truck 

Certification Form, which uses the TruckCertification related table in the 

DebrisRemovalProviders layer. Once a user selects a truck ID, the available values for the 

truck capacity and removal provider name fields are filtered to correspond to the values 

entered in the Truck Certification Form for the selected truck ID. 

To add dynamic field lookup lists to the Load Ticket, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign into your ArcGIS organization. 

3. Click Load Ticket. 

4. Click Download and OK. 

5. Click Load Ticket again. 

6. Click XLSForm. 

7. A Microsoft Excel spreadsheet opens. Click the survey tab. 

8. Delete the text in the type column of row 9 (Truck ID Number) and type: 
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select_one trucknum 

Note: 

When saving, you may see the following warning message: “Please select yes if you 
are using a select_one or select_multiple XLS”. Click Yes. 

9. Delete the text in the type column of row 10 (Capacity) and type: 

select_one deccap 

10. Delete the text in the type column of row 13 (Contractor) and type: 

select_one truckcont 

11. Paste the following expression into the appearance column of row 9: 

minimal search("TruckCertification1?url={your clipboard 
URL}/1","matches","idnum") 

12. Paste the following expression into the appearance column of row 10: 

minimal search("TruckCertification2?url={your clipboard 
URL}/1","matches","capacity","", "idnum",${truckid}) 

13. Paste the following expression into the appearance column of row 13: 

minimal search("TruckCertification3?url={your clipboard 
URL}/1","matches","contractor","", "idnum",${truckid}) 

14. Sign into your ArcGIS organization. 

15. Search for and click on for the DebrisRemovalProviders_monitors hosted Feature Layer 
View. 

16. Scroll to the bottom of the Overview page for the DebrisRemovalProviders_monitors 
item, and in the URL section, click the Copy icon. This copies the layer service URL to 
your clipboard. 

17. In row 9, Replace {your clipboard URL} with the url in your clipboard. Make sure the /1 
remains at the end of the URL. Repeat for rows 10 and 13. 

18. Save and close the spreadsheet. 

Note: 

When saving, you may see the following warning message: "The appearance value 
you gave is not one of the standard supported appearance types. If you’re attempting 
to combine two different appearance types, ensure that they’re separated by a space". 
Click Yes. 

19. In ArcGIS Survey123 Connect, click Publish. 
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Note: 

After you click publish, you should see a modal window that says "The survey will be 
updated without affecting the existing data". If you get a different message or ArcGIS 
Survey123 Connect has displayed an error prior to clicking the Publish button, you 
have made an error in editing the XLSForm, and should review steps 5-17 for errors. 

20. Click Publish survey. 

21. When the publishing is complete, click OK. 

22. Click the back button to exit the Load Ticket. 

 

Update Unload Ticket 
To improve data quality, the unloading location field in the Unload Ticket can be populated 

with a dynamic list containing only valid debris management site names found in the 

DebrisManagementSites layer. 

To add a dynamic field lookup list to the Unload Ticket, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign into your ArcGIS organization. 

3. Click Unload Ticket. 

4. Click Download and OK. 

5. Click Unload Ticket again. 

6. Click XLSForm. 

7. A Microsoft Excel spreadsheet called Unload Ticket opens. Click the survey tab. 

8. Delete the text in the type column of row 17 (Unloading location) and type: 

select_one dmsname 

9. Paste the following expression into the appearance column of row 17: 

autocomplete search("DebrisManagementSites?url={your clipboard 
URL}/0","matches","name") 

10. In a browser, sign into your ArcGIS organization. 

11. Search for and click on for the DebrisManagementSites_monitors hosted Feature Layer 
View. 

12. Scroll to the bottom of the Overview page for the DebrisManagementSites_monitors item, 
and in the URL section, click the Copy icon. This copies the service URL for this layer 
into your clipboard. 

13. Return to the Microsoft Excel spreadsheet. 

14. Replace {your clipboard URL} with the url in your clipboard. Make sure the /0 remains at 
the end of the URL. 
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15. Save and close the spreadsheet. 

16. In ArcGIS Survey123 Connect, click Publish. 

Note: 

After you click publish, you should see a modal window that says “The survey will be 
updated without affecting the existing data”. If you get a different message or ArcGIS 
Survey123 Connect has displayed an error prior to clicking the Publish button, you 
have made an error in editing the XLSForm, and should review steps 5 - 16 for errors. 

17. Click Publish survey. 

18. When the publishing is complete, click OK. 

19. Click the back button to exit the Unload Ticket. 

 

Configure Emergency Debris Management Center 
Briefing mobile staff can be challenging, especially during times of an emergency and new 

tools may be learned quickly during an event. The Emergency Debris Management Center 

includes an Access Field Apps page that can be used during a briefing to help mobile staff get 

access to the apps they need by scanning a QR code, and simple instructions on how to get 

started. Before the page can be used, you must obtain the QR codes for each of your field 

apps and add them to the page in the Help section of the Emergency Debris Management 

Center app. Additionally, you can include step-by-step instructions appropriate your 

organization. 

 

Prepare images 
Follow the steps below to locate QR codes to be used in the Emergency Debris Management 

Center: 

1. Verify that you are signed in to your ArcGIS organization and browse to the ArcGIS 
QuickCapture Designer. 

2. Open the Road Debris Reporter project and click share. 

3. Click QR Code the right click the QR Code and save the image locally. 

4. Close ArcGIS QuickCapture Designer. 

5. Open ArcGIS Survey123. 

6. Open the Debris Assessment Form. 

7. Click Collaborate. Next to Share this survey, click the Show the QR Code button and 
then, Click to download the QR code image locally. 

8. Repeat the above steps 6 and 7 for the Truck Certification Form, Load Ticket and Unload 
Ticket. 

9. Close the ArcGIS Survey123 website. 
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Update help 
For each Survey123 form, Debris Assessment Form, Truck Certification Form, Load Ticket, 

and Unload Ticket) upcomplete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Emergency 
Debris Management Center and click Edit. 

2. Click Live View in the Experience Builder designer header bar. 

3. In the Emergency Debris Management Center app header, click the drop-down arrow 
next to Help, then click Access Field Apps. 

4. Click on the sub- page that corresponds to the QR code you are updating. 

Note: 

The Debris Assessment Form QR code belongs on the Assessment Apps sub-page, 
while the Load Ticket, Unload Ticket, and Truck Certification Form belong on the 
Removal Apps sub-page. 

5. Click on the image Place QR Code Here. 

6. In the properties window for the image widget, click Select an image. 

7. Click Upload. Use Windows file explorer to select the QR code you saved earlier. 

8. Click the Page button to open the page panel and select the Help page. 

9. Use the Body node of the page panel to navigate between each section. 

10. To update the text or images select the element in the layout and make the necessary 
changes. You may choose to copy some of the help documentation into the page and 
then modify it to fit your organizational needs. 

11. Click Save on the Experience Builder designer header bar, then click Publish. 

 

Share items with the public 
The Emergency Debris Management solution includes Debris Removal Services, an app used 

by the public to understand the debris removal schedule for their area or route, who to 

contact, what to do, and where to drop off debris. In order to make this app accessible to the 

public, the app and its associated map and layers must be shared publicly. 

1. Sign into your ArcGIS Organization and browse to the Debris Removal Services app. 

2. Open the item page and click Share. 

3. In the Share window, click Everyone (public) and click Save. 

4. Repeat steps 1 through 3 to share the following items with everyone: 

Item Name 

Web Map Debris Removal Services 

Feature Layer (hosted, view) DebrisAreas_public 

Feature Layer (hosted, view) DebrisRoutes_public 

Feature Layer (hosted, view) DebrisManagementSites_public 
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Use work routes instead of areas (optional) 
Organizations managing emergency debris assign assessors and removal providers to 

perform their work (and track their status) using polygon-based work areas. Typically, these 

work areas correspond to existing daily operational boundaries; for example, garbage pickup 

areas. Instead of areas, other organizations assign work using line-based routes, for example, 

snowplow routes. The Emergency Debris Management solution is configured by default to 

support polygon-based work areas using the DebrisAreas feature layer. 

Optionally, the default solution configuration using polygon work areas may be reconfigured to 

use DebrisRoutes, a line-based feature layer included in the solution for using line-based work 

routes. 

To replace the DebrisAreas layer with the DebrisRoutes layer, complete the following steps: 

1. Sign into your ArcGIS organization. 

2. Browse to the Manage Assessment Status web map and click Open in Map Viewer 
Classic. 

3. Go to the Content pane. Check Debris Routes and Uncheck Debris Areas. 

4. Click Save. 

5. Repeat steps 2-4 for the following web maps: 

• Debris Assessments Dashboard 

• Debris Assessment Form 

• Manage Removal Status 

• Debris Removal Dashboard 

• Debris Removal Services 

  Note: 

  In the above web maps, the DebrisRoutes layer already contains identical pop-up 
and symbology to the DebrisAreas layer, so no further layer configuration is 
required. 

6. In the Debris Assessments Dashboard, reconfigure the following dashboard elements to 
point to the Debris Routes layer: 

• Assessment area by status 

• Assessment area list 

• Areas Fully Assessed 

7. In the Debris Removal Dashboard, reconfigure the following dashboard elements to point 
to the Debris Routes layer: 

• Removal area by status 

• Removal area list 

• Removal areas completed 

  Note: 
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  When re-configuring dashboard elements, consider opening the dashboard edit 
mode in two separate browser windows so you can refer to the original element 
settings as you reconfigure. 

8. Browse to the Debris Removal Services app and click Configure App. 

9. Click Interactivity. 

10. Click Results. 

11. Uncheck Debris removal service areas. Check Debris removal service routes. 

12. Click Back, then click Text Results. 

13. Click Edit for Text above results section. Change removal service areas to removal 
service routes. 

14. Click About. 

15. Click Edit for Edit Introduction Panel. Change both instances of service area to service 
route. 

16. Click OK, then click Publish, and Confirm. 

Note: 

The Debris Removal Services app will display all routes within the app’s specified search 
distance, not just the nearest route to the selected location. 

 

Configure directions (optional) 
Optionally, you can configure the Debris Removal Services app to provide directions to the 

nearest debris drop-off site. 

This configuration draws routes and provides directions using the ArcGIS Online World Route 

Service. This service requires authorization to consume premium content as it consumes 

credits. Learn more about credit usage when creating simple routes. 

Follow the steps below to connect to a routing service and configure the app to enable 

directions. 

1. Sign into your ArcGIS organization and browse to the Debris Removal Services app. 

2. From the item page, click Configure App. 

3. Close the Welcome to the App Setup Page splash page, if necessary. 

4. Click Nearby > Options and turn on the Show directions toggle button. 

5. Check the check box next to the Debris drop-off sites layer. 

6. Click Publish. 

7. Click Confirm. 

8. The Authorize premium content window appears with information related to 
authorization. 

9. Click Authorize. 
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10. Click Launch. 

 

Use the metric system (optional) 
The Emergency Debris Management solution is configured to support the workflows of U.S. 

state and local emergency management and public works agencies, who perform emergency 

debris management based on guidelines from the Federal Emergency Management Agency 

(FEMA). These guidelines use the Imperial measurement system (feet and cubic yards) to 

measure disaster debris volume. 

Optionally, the Emergency Debris Management solution can be reconfigured for organizations 

outside the U.S. who use the Metric system to measure disaster debris volume. 

To switch Emergency Debris Management from the Imperial to the Metric measurement 

system, complete the following activities: 

1. Start ArcGIS Survey123 Connect and sign into your ArcGIS organization. 

2. Click Debris Assessment Form. 

3. Click XLSForm. 

4. A Microsoft Excel spreadsheet called Debris Assessment Form opens. Click the survey 
tab. 

5. In the label column, change all Imperial measurement references to Metric (for example, 
change ft. to m., cu. yd to cu. m., in. to cm., and lbs. to kg.) 

6. Delete the rows 9-11 (hazardoustree group, diameter and fill fields). These apply only to 
U.S. FEMA estimation methods which have no comparable international standard. 

7. In the calculation field of row 15 (Est. Volume), delete the default function and paste in 
the following: 

round((${length}*${width}*${height}),1) 

8. Click the settings tab. In the instance_name field, change cu yd. to cu. m. 

9. Save and close the spreadsheet. 

10. In ArcGIS Survey123 Connect, click Publish. 

11. Repeat steps 1-5 for the Truck Certification Form. 

12. In the calculation field of row 35 (Final Truck Capacity), delete the default function and 
paste in the following: 

if(selected(${trucktype}, 'Round Bottom Truck'), round(((3.14 * 
((number(${truckdiam}) div 2) * (number(${truckdiam}) div 2))) * 
number(${trucklength})),2), round((number(${trucklength}) * 
number(${truckwidth}) * number(${truckheight})) - 
((((number(${hoistlength1}) + number(${hoistlength2})) div 2) * 
number(${hoistwidth}) * number(${hoistheight}))) - (3.14 * 
(number(${radiusft}) * number(${radiusft}))* 
number(${radiusheight})),2)) 
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13. Save and close the spreadsheet. 

14. In ArcGIS Survey123 Connect, click Publish. 

15. Repeat steps 1-5 and 8-9 for the Load Ticket and Unload Ticket. 

16. Go to the following web maps, review each layer, and in pop-ups change all labels 
Imperial measurement references to Metric (for example, change ft. to m., cu. yd to cu. 
m., in. to cm., and lbs. to kg.) 

• Manage Assessment Statuss 

• Debris Assessments Dashboard 

• Manage Removal Status 

• Debris Removal Dashboard 

• Debris Logs 

• Debris Records Reviewer 

• Debris Assessment Form 

17. Go to the following apps, review the configuration and change all labels Imperial 
measurement references to Metric (for example, change ft. to m., cu. yd to cu. m., in. to 
cm., and lbs. to kg.) 

• Debris Assessments Dashboard 

• Debris Removal Dashboard 

 

Administer debris reports 
After an incident, organizations may choose to extract and delete data from the Emergency 

Debris Management solution in order to prepare for the next incident. 

Many organizations require local copies of web layers for disaster recovery or archival 

purposes. Learn more about how to export data from hosted feature layers into a local file 

geodatabase to create a local copy of your data. 

Organizations may also choose to delete historical data from feature layers after they have 

archived the data to a local file geodatabase. Learn more on how to delete all records from a 

feature layer using the ArcGIS REST API service directory in the topic below. 

 

Delete features 
To delete features from a hosted feature layer or table, complete the following steps: 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

1. Sign in to your ArcGIS organization. 
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2. Go to the Overview tab of the hosted feature layer or table. 

3. In the lower right corner, in the URL category, click View. 

The ArcGIS REST Services Directory for this page appears. 

4. Click the link of the layer or table from which you want to delete records. 

5. In the URL bar of the browser, edit the URL with the following changes. 

a. Add the word admin between rest/ and services. (For example: 

ArcGIS/rest/admin/services/DebrisAreas) 

b. Add the word truncate between 0/ and ?token. (For example: 

FeatureServer/0/truncate?token=) 

6. In the next window, click Truncate. 
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Use Emergency Debris Management 
The Emergency Debris Management solution delivers a set of capabilities that help you 

expedite initial debris clearance, assess debris removal needs, and monitor debris removal 

activities. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Prepare for an emergency incident 
To prepare for disasters, effective organizations train in advance of an incident, using mock 

exercises to familiarize personnel with the processes and technology they will use in the field 

during a real disaster. The Emergency Debris Management solution include mobile apps, 

ArcGIS QuickCapture, ArcGIS Workforce, and ArcGIS Survey123, which mobile workers will 

need to be trained to use in advance of the disaster. 

In this workflow, you will assume the role of the debris operations lead who needs to train 

mobile workers involved in debris clearance, assessment, and removal activities. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click the Help drop-down arrow and choose Access Field Apps. 

This page displays information that can be used in a training briefing to help teach mobile 
workers to use the mobile apps included in the solution. The page is organized by 
workflow, with separate tabs for debris clearance, assessment, and removal mobile apps. 
Each page includes basic information on how to download and open the app, along with 
a space to put a QR code that can be scanned by mobile workers to get the specific form 
or project used in the workflow. 

Note: 

For more information on how to modify text or add a QR code, see Configure Emergency 
Debris Management Center. 

 

Clear road debris 
After a disaster strikes, one of the top response priorities of emergency managers is to rapidly 

identify and clear obstructed roads so that medical and search and rescue teams can provide 

critical life safety services to the community. The Emergency Debris Management solution 

provides a comprehensive system that can be used to report roads obstructed by debris, 

assign reports to field clearance crews, update the status of clearance assignments, and 

monitor the clearance process. 
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Report road debris 
To clear road debris, first responders or other emergency personnel must first drive the 

impacted area to identify locations where debris has obstructed roadway traffic. 

In this workflow, you will assume the role of a first responder in the field that needs to report 

roads obstructed by debris. 

1. Download the ArcGIS QuickCapture app onto your mobile device.  

2. Open the ArcGIS QuickCapture app and sign in to your ArcGIS organization. 

3. Select the add project button. 

4. Select Browse Projects and select the Road Debris Reporter project card to download. 

5. Tap the Road Debris Reporter project in the gallery to open it. 

Note: 

In a disaster response setting, it can be challenging to provision named user accounts 
to first responders identifying debris obstructions. By publicly sharing the Road Debris 
Reporter project, first responders can immediately access the project by using their 
mobile device to scan a QR code during a training briefing. If you elect to require 
named user access to this project, first responders will require a named user account 
to your ArcGIS organization and will need to sign in before proceeding. 

6. Tap the button that most accurately describes the type of debris obstruction you are 
capturing. 

7. Use the mobile device camera to take a photo of the debris, then tap Done. 

8. Optionally, add comments describing the debris that may be helpful to the debris 
operations lead, and then tap Done. 

9. If no comments are entered, tap Skip. 

 

Records captured on your device will autosend at the time interval defined in the settings of 

the ArcGIS QuickCapture app. The default setting for the app is 30 seconds. If the app loses 

network connectivity, the app will attempt to send all records once network connectivity is re-

established. 

 

Record road debris reports from the office 
After severe incidents, network connectivity may not be available for first responders as they 

search for roads obstructed by debris. As a result, first responders may not be able to use 

mobile apps, and debris operations leads will need to manually record this information from 

the office. 

In this workflow, you will assume the role of a debris operations lead who needs to manually 

record a report of a road obstructed by debris. 
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1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click the Clear drop-down arrow and choose Assign Debris Crews. 

You will see the Debris Clearance Assignments Workforce project. 

3. Click the Debris Clearance Assignments to open the project. 

4. Click the Assignments button to create a road debris report. 

5. For Assignment Type, choose the type of report. 

6. Click Search for an address or click the map to add a new location of the report. 

7. Under Assign to, click Assign and select the mobile worker who will complete the work. 

You may choose to immediately assign it to a field crew supervisor. 

8. For Priority, choose a priority level for the assignment.  

9. When complete, click Create Assignments. 

 

Assign debris clearance reports 
Once a road obstruction has been identified, the debris operations lead assigns a field crew to 

clear debris from the roadway to make it passable again. 

In this workflow, you will continue to assume the role of a debris operations lead who needs to 

assign field crews to a debris obstruction identified by a first responder. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click the Clear drop-down arrow and click Assign Debris Crews. 

You will now see the Debris Clearance Assignments Workforce project. 

3. Click the Debris Clearance Assignments to open it. 

4. Click an assignment from the list. 

  You can view the assignment location on the map and can click the attachment to view a 
photo of the debris. 

Note: 

The assignments in the list are created using the Road Debris Reporter ArcGIS 
QuickCapture project. Each observation captured using the project creates an 
assignment in the Debris Clearance Assignments ArcGIS Workforce project. 

5. Under Assign to, click Assign and select the field crew supervisor you want to complete 
the work. 

6. Optionally, click Edit under Location to modify the Assignment Type, Location, or 
Priority, or add a Due Date or a Description. 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 342 

Update debris clearance status 
During the initial response, debris clearance field crews clear debris from obstructed roads as 

they are assigned. 

In this workflow, you will assume the role of a field crew supervisor who needs to direct crews 

to their next assignment and update the status of each assignment as it is completed. 

1. Download the ArcGIS Workforce app onto your mobile device. 

2. Open the ArcGIS Workforce app and sign in to your ArcGIS organization. 

3. Tap the Debris Clearance Field Worker Map to download the map. 

You will see a to do list of all the clearance assignments your field crew has been 
assigned, grouped by priority order. 

4. Tap an assignment in the To do list to view its location on the map and details about the 
assignment. 

5. Tap Start to begin working on an assignment. 

6. To pause, decline, or reset the assignment, tap Overflow  and tap the status you 
require, or tap Cancel. 

7. Tap Finish to complete the assignment and remove it from your to do list.  

8. Optionally, to view your completed assignments, tap your To Do list, and tap Completed. 

9. Changes to the status of your assignments will automatically sync with your ArcGIS 
organization at the default interval of every 15 minutes. To sync more frequently, tap 

Sync  (  if you have edits that aren't synced), then tap Sync Now. 

 

Record debris clearance status from the office 
After severe incidents, network connectivity may not be available for debris clearance field 

crews as they work through their clearance assignments. As a result, field crew supervisors 

may not be able to use mobile apps to update the status of assignments they complete, 

requiring the debris operations lead to record debris clearance assignment status manually. 

In this workflow, you will assume the role of the debris operations lead who needs to update 

the status of debris clearance assignments using the Emergency Debris Management Center 

app. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click the Clear drop-down arrow and choose Manage Assignment 
Status. 

3. To find the assignments you want to update, enter the address in the search bar or zoom 
the map to the location. 

4. Click the Update clearance status widget. 

5. To filter the assignments you want to update, click the Edit tool in the filter column. 

6. In the Filter Layer window, add one or more filter expressions and click OK. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 343 

7. To update a single assignment, click the Point tool and click the assignment on the map; 
for updating multiple assignments, click the Freehand Polygon tool and draw a shape to 
select all features inside the shape. 

A pop-up appears. 

8. Choose an appropriate Status. 

9. Optionally, enter notes in the Notes text box.  

10. For Completed On Date, choose New Date and select a date. 

11. Click Save. 

  All of your selected records will be updated to reflect the values you entered. 

 

Monitor debris clearance 
During the first 72 hours of a disaster response, the debris manager in the Emergency 

Operations Center monitors the debris clearance efforts and coordinates with Emergency 

Managers and other key stakeholders. The debris manager helps to provide situational 

awareness relative to the status of clearance efforts, and coordinates with the debris 

operations lead to prioritize clearance activities relative to opening arterial roads leading to 

critical health and safety infrastructure or other priority locations. 

In this workflow, you will assume the role of the debris manager who needs to monitor the 

progress of debris clearance using the Emergency Debris Management Center app. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click Clear. 

The Debris Clearance Dashboard displays key performance indicators including active 
and completed requests, percent completed, requests by type, and requests by status. 

3. To filter the dashboard by assignment type, click a column in the Active requests by 
type chart. 

4. Click the column again to clear the filter. 

5. To filter the dashboard by status, click a section in the Active requests by work status 
chart. 

6. Click the section again to clear the filter. 

7. To view an assignment on the map and view a photo, click an assignment in the Active 
requests list. 

 

Assess debris 
Once a disaster incident has passed, communities begin the recovery process by assessing 

the nature and extent of damage. With respect to debris generated from the incident, this 

means understanding where debris exists, the types of debris generated, and estimating 

debris volumes. This information, along with information generated from an initial damage 

assessment, can be used by communities to determine whether to make a request to the 
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federal government for an emergency or major disaster declaration to receive assistance 

under the Stafford Act. 

The Emergency Debris Management solution can be used by state and local governments to 

create and manage their assessment areas, perform debris assessments, update the status of 

assessment areas or routes, and monitor progress of assessment efforts. 

 

Manage assessment areas 
Before they can begin performing assessments, mobile workers must be assigned a work 

area. The debris operations lead is responsible for assigning each assessor to a designated 

work area. The nature of the work area will depend on the preferences of the jurisdiction; 

some prefer to use preexisting operational boundaries (public works service areas), some 

prefer service routes (garbage or snowplow routes), and some prefer a grid of uniform size. 

As assessors complete their work, debris operations leads will update the assessment status 

field to reflect the current progress in that work area. 

Note: 

By default, the Emergency Debris Management solution is configured to use polygon-
based work areas. To learn more about loading your operational boundaries into the 
solution, see Load data. If your organization prefers to use line-based work routes, see 
Use work routes instead of areas. 

In this workflow, you will assume the role of the debris operations lead who needs to assign 

an assessor and update the status of a work area. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click the Assess drop-down arrow and click Manage Assessment 
Status. 

3. Click a work area on the map. 

  The Manage assessment area status form for the selected work area appears in the 
Manage assessment area status widget. If you do not see the form, click the Manage 
assessment area status widget to activate it. 

4. Enter the following information in the form: 

a. For Assessment Status, choose Assessment In Progress. 

b. For Assessor Name, type Anne Smith. 

c. For Assessor Email, type asmith@gov.gov. 

d. For Assessor Phone, type (555) 111-2222. 

5. Click Close. 

 

Create assessment grid (optional) 
Some jurisdictions prefer to create a grid of uniform size for debris assessment and removal 

activities, especially when the disaster area of impact does not extend across the entire 
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jurisdiction or has an extent that does not cleanly align with preexisting operational boundaries 

or routes. To create these grids, the debris operations lead works with a GIS professional to fit 

a grid appropriate for each unique disaster incident. In North America, emergency 

management agencies typically create grids using the U.S. National Grid reference system 

standard. 

In this workflow, you will continue in the role of a debris operations lead who needs to create a 

reference grid and add it to the solution to manage assessment and removal areas. 

Note: 

Follow the steps below if you intend to use a grid to manage your assessment and 
removal areas. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click the Assess drop-down arrow and click Manage Assessment 
Status. 

3. Click the Create work area from grid widget. 

4. Click the Define a Grid from an Area arrow. 

Note: 

Below are the steps for creating a grid based on a user-defined area according to the 
US National Grid reference system, but the widget supports additional methods. For 
more information, see Gridded Reference Graphic widget. 

5. Click the By Reference System arrow. 

6. Click Draw GRG Area using extent. 

7. Click the Grid Size drop-down arrow and select a grid size.  

8. Turn the Clip Grid to GRG Area toggle button on to limit the grid to only the extent 
drawn. 

9. Click Create GRG. Ensure that this grid meets your requirements before proceeding to 
the next step. If it does not, click the Back button, then click Clear to redo the grid. 

10. After you have finished, ensure the Published GRG Layer Name is set to Debris Areas, 
and click Publish. The grid will be added to the DebrisAreas feature layer, which is also 
used in the Emergency Debris Management solution. 

 

Perform debris assessment 
Personnel assigned to perform debris assessments are responsible for documenting each pile 

of debris observed in the right of way or on public property within the work area they are 

assigned. This critical work is inherently time-consuming, but when performed on paper, the 

forms require subsequent data entry that delays access to debris volume information that is 

critically important to the disaster declaration request process. 
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In this workflow, you will assume the role of an assessor in the field who needs to perform 

debris assessments in their work area. 

1. Download the ArcGIS Survey123 app onto your mobile device. 

2. Open the ArcGIS Survey123 app and sign in to your ArcGIS organization. 

3. Tap the Menu button at the upper right, then tap Download Surveys. 

4. Search for Debris Assessment Form and tap the Download button. 

Note: 

You can access the Debris Assessment Form by tapping the back arrow and tapping 
the Barcode button in the search bar, then taking a photo of the QR code. 

5. Tap the back arrow in the upper right. 

6. Tap Debris Assessment Form and tap Collect. 

7. Tap the Incident Name drop-down arrow and choose an incident to associate with the 
assessment.  

  The unique values in the drop-down list are derived from the IncidentNames.csv file 

used to manage disaster incident names for debris assessments and debris monitoring 
tickets. 

8. Tap a location on the map, then tap the check mark in the lower right.  

  The Address field will autopopulate based on the location selected. 

Note: 

The reverse geocoding capability enabled in the Address field of the form may 
consume credits if the default address locator for your organization is the ArcGIS 
Online World Geocoding Service. To learn more about reverse geocoding geopoints, 
see Reverse geocoding. 

9. For Status, choose a value. 

10. For Type, choose a value. 

Note: 

If you choose Hazardous Limbs, Trees, and Stumps from the type list, the 
Hazardous Tree, Limbs, and Stumps Only section appears. When you enter 24 for 

the Tree Diameter (in.) question, the Est. Volume (cu. yd.) question will be 
autocalculated based on the value entered in the tree diameter field. 

  The Debris Assessment Form is performing a diameter to volume calculation as 
prescribed by the FEMA Public Assistance Program and Policy Guide, assuming a stump 
diameter measured 2 feet off of the ground, a stump to root-ball diameter of 1:3.6, and a 
root-ball height of 31 inches. 

11. Swipe up and enter the following values: 
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a. For Length, type 5.  

b. For Width, type 4. 

c. For Height, type 3. 

12. When you tap the refresh button next to the Est. Volume (cu yd.) question, you will see 
a value autocalculate based on the values entered in the three previous fields. The 
calculated value should be 2.2. cubic yards of debris based on the values above. 

Note: 

The Debris Assessment Form performs the following calculation: (length in feet x width 
in feet x depth in feet)/27. 

13. Swipe up and for Reimbursable, choose Yes. 

14. Tap the check mark in the lower right and tap Send now. 

 

Update debris assessment status 
Once a removal crew has completed an initial pass of an area, assessors typically perform a 

review check to confirm that all initially assessed debris has been removed, and to document 

any subsequent debris placed at the right of way after the initial pass by the removal crew. 

In this workflow, you will continue to assume the role as an assessor who needs to update the 

status of an assessment from the field. 

1. Open ArcGIS Survey123 on your mobile device and sign in to your ArcGIS organization. 

2. Tap Debris Assessment Form and tap Inbox. 

3. Tap the Refresh button. 

4. Tap Map to view assessments captured near your location. 

5. Tap an assessment to edit it. 

6. Change the Status from Assessed to Removed. 

7. Tap the check mark in the lower right and tap Send now. 

 

Update debris assessment status en masse 
In some cases, it may be more efficient for a debris operations lead to update debris 

assessment status en masse rather than having an assessor update each assessment 

individually. 

In this workflow, you will assume the role of a debris operations lead who needs to update the 

status of assessments in a completed area all at once. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click the Assess drop-down arrow and click Manage Assessment 
Status. 
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3. Click the Batch update assessment status widget. 

4. To filter the assessments you want to update, click the Edit tool in the filter column. 

5. In the Filter Layer window, add one or more filter expressions and click OK. 

6. To update a single assignment, click the Point tool and click the assignment on the map; 
for updating multiple assignments, click the Freehand Polygon tool and draw a shape to 
select all features inside the shape. 

A pop-up appears. 

7. Select an appropriate Status value, and then click Save.  

  The selected records will be updated to reflect the values you entered. 

 

Monitor debris assessments 
As recovery from a disaster begins, the debris manager in the Emergency Operations Center 

works with emergency managers, elected officials, and other key stakeholders to understand 

the impacts and scope of the disaster. As debris assessments get underway, the debris 

manager helps to provide situational awareness relative to the status of assessment efforts, 

and coordinates with the debris operations lead to ensure that debris is assessed in a timely 

fashion. 

In this workflow, you will assume the role of the debris manager who needs to monitor the 

debris assessment process. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click Assess. 

The Debris Assessments Dashboard includes header selectors to filter by date range as 
well as incident name. Some dashboard elements will not display until an incident name 
is selected. 

3. Click the Incident drop-down menu and choose an incident name. 

4. The left panel shows a chart illustrating work areas by their assessment status, along 
with a list of each work area, the assessor assigned, and the area’s status. Clicking a 
column will zoom the map to the work area, filter assessments by the work area’s 
boundaries, and filter other dashboard elements to reflect the values specific to that work 
area. 

5. The first tab in the right panel displays key performance indicators (KPIs) including the 
percent of work areas that have been fully assessed and the total volume active and 
completed requests, percent completed, requests by type, and requests by status. 

6. Click the Charts tab.  

The tab displays pie and serial charts displaying debris volumes by debris type, removal 
status, and assessor. 

7. Click any chart component to filter the map and related dashboard elements. 

8. Click the Assessments tab.  

The tab displays a list of assessments in descending order by date of assessment. 
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9. Click a record in the Assessment List to zoom to the assessment location and view 
details and photos associated with it. 

 

Remove debris 
Removal of disaster debris is often the first visible step a community takes on the road to 

recovery. Municipalities responsible for debris removal face a challenging task, demonstrating 

responsiveness to community demands to get debris out of their neighborhoods; coordinating 

multiple contractors and removal service providers; storing and minimizing large volumes of 

debris while it awaits a final disposal location; and adhering to processes and meticulously 

documenting each step to ensure compliance with federal regulations for reimbursement. 

The Emergency Debris Management solution can be used by state and local governments to 

support debris removal workflows including certification of trucks used in debris removal, 

managing removal provider work areas and status, completing debris monitoring load and 

unload tickets, sharing assessment or ticket logs with contractors and auditors, sharing 

information with the public, and monitoring the progress of removal efforts. 

 

Certify debris removal truck capacity 
To ensure compliance with the FEMA Public Assistance reimbursement program, trucks used 

for debris removal must have their capacity certified and documented by inspectors. These 

inspectors, typically public works employees, measure the capacity of each truck and 

document other key information such as identification numbers and information about the 

vehicle drivers and owners. 

In this workflow, you will assume the role of an inspector who needs to document the capacity 

of a debris removal truck. 

1. Open ArcGIS Survey123 on your mobile device and sign in to your ArcGIS organization. 

2. Tap the Menu button at the upper right, then tap Download Surveys. 

3. Search for Truck Certification Form and tap the Download button. 

Note: 

You can access the Truck Certification Form by tapping the back arrow and tapping the 
Barcode button in the search bar, then taking a photo of the QR code. 

4. Tap Truck Certification Form and tap Inbox. 

5. Tap the Refresh button. 

6. Tap the name of the removal provider that you want to certify trucks for. 
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Tip: 

TheTruck Certification Form will only display removal providers that have records in the 
DebrisRemovalProviders feature layer. If an organization is not displayed in the list, 
they must first be added using the Manage Removal Status app. 

7. Tap Edit. 

8. Complete all the required questions in the survey. 

Note: 

To ensure data quality in debris monitoring tickets, the Load Ticket and Unload Ticket 
surveys use data captured by the Truck Certification Form survey including Truck ID, 
removal provider name, and truck capacity. 

9. Tap the check mark in the lower right and tap Send now. 

 

Create a Load Ticket 
The FEMA Public Assistance reimbursement program requires that debris removal operations 

are observed and documented from initial debris collection to final disposal. Mobile workers, 

known as debris monitors, perform this work at each loading site, initiating a chain of custody 

that is completed by another monitor when a truck is unloaded at a debris management site or 

landfill. 

In this workflow, you will assume the role of a loading site debris monitor who needs to create 

a Load Ticket to document the collection of a debris load in the field. 

1. Open the ArcGIS Survey123 app and sign in to your ArcGIS organization. 

2. Tap the Menu button at the upper right, then tap Download Surveys. 

3. Search for Load Ticket and tap the Download button. 

Note: 

You can access Load Ticket by tapping the back arrow and tapping the Barcode 
button in the search bar, then taking a photo of the QR code. 

4. Tap the back arrow in the upper right. 

5. Tap Load Ticket and tap Collect. 

6. Complete all the required questions in the survey. 

Note: 

There are two types of monitoring tickets in the Ticket Type field: Load tickets, used for 
collecting debris from the field and transporting to a debris management site; and 
Haulout tickets, used for collecting reduced debris from a debris management site and 
transporting it to a landfill. 
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Note: 

The Truck ID Number question list is populated by all unique truck IDs captured by the 
Truck Certification Form. To ensure data quality, you cannot enter the ID number of a 
truck that has not been certified. When you select a valid truck ID, the Capacity (cu. 
yd.) and Removal Provider Name option are automatically updated to reflect valid 
values associated with the selected truck. To add a new certified truck, see Certify 
debris removal truck capacity. To modify these automatic lookup settings, see Modify 
surveys. 

7. Tap the check mark in the lower right and tap Send now. 

 

Create an Unload Ticket 
At landfills or debris management sites, debris monitors are responsible for assessing the load 

size of each incoming truck unloading debris. 

In this workflow, you will assume the role of a debris monitor at a debris management site who 

needs to create an Unload Ticket to document the disposal of a debris load. 

1. Open the ArcGIS Survey123 app and sign in to your ArcGIS organization. 

2. Tap the Menu button at the upper right, then tap Download Surveys. 

3. Search for Unload Ticket and tap the Download button. 

4. Tap Unload Ticket and tap Inbox. 

5. Tap the Refresh button. 

  You see a list of all load tickets that have not yet had an Unload Ticket completed. As the 
debris monitor at a debris management site, you will choose the ticket that corresponds 
to the truck that has just pulled into your site to dispose its debris load. 

6. Tap the debris management site you are monitoring. 

7. Tap Unloading location. 

Note: 

The list is populated by all unique debris management sites captured in the 
DebrisManagementSites layer. To ensure data quality, you cannot enter the name of a 
debris management site that does not exist in the authoritative layer. To add a new 
debris management site, see Manage debris removal status. To modify these 
automatic lookup settings, see Modify surveys. 

8. Tap Unloading Date to automatically select the current date and time. 

9. Tap Load Percent of Truck Capacity and enter a value based on your visual estimation 
of what percentage of the truck is full, based on guidance from the FEMA Debris 
Monitoring guide. 

10. Swipe up and tap Load Size.  

  The field will autopopulate based upon the certified capacity of the truck and the percent 
full value reported. 
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11. Complete all the remaining required questions in the survey. 

12. Tap the check mark in the lower right and tap Send now. 

 

Manage debris removal status 
As debris removal operations commence, the debris operations lead assigns work areas to 

each removal provider. The nature of the work area will depend on the preferences of the 

jurisdiction; some prefer to use preexisting operational boundaries (public works service 

areas), some prefer service routes (garbage or snowplow routes), and some prefer a grid of 

uniform size. As removal crews complete their work, debris operations leads will update the 

removal status field to reflect the current progress in that work area. 

Note: 

By default, the Emergency Debris Management solution is configured to use polygon-
based work areas. To learn more about loading your operational boundaries into the 
solution, see Load data. If your organization prefers to use line-based work routes, see 
Use work routes instead of areas. 

In this workflow, you will assume the role of the debris operations lead who needs to 
manage the assessor and status of a work area. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click the Remove drop-down arrow and click Manage Removal 
Resources And Status. 

3. Click a work area on the map. 

  Editable fields for the work area will now appear in the Update resources widget. 

4. If you do not see editable fields, click the Update resources widget to activate it. 

5. Enter the following information in the form: 

a. For Removal Provider Type, choose Contractor. 

b. For Removal Provider Name, type Connors Contractors. 

c. For Removal Status, choose Assigned. 

d. For Removal Contact Name, type James Connors. 

e. For Removal Contact Email, type jconnors@disposal.com. 

f. For Removal Contact Phone, type (555) 111-2222. 

6. Click Close. 

 

Manage providers and debris management sites 
As removal operations occur, a debris operations lead may need to add or update removal 

resources to reflect a changing scope of work. This may include additional contractors or 

activating new debris management sites to keep up with capacity needs, or deactivating 

resources as operations come to a close. 
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In this workflow, you will continue to assume the role of the debris operations lead who needs 

to manage a new removal provider or debris management site. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click the Remove drop-down arrow and click Manage Removal 
Resources And Status. 

3. To create a removal provider or debris management site, click a Debris Removal 
Provider template you want to create and click a location on the map. 

4. Complete the form with your provider information and click Save. 

5. Click Close. 

6. To update a removal provider or debris management site, click the feature on the map 
you want to update. 

7. Update the form and click Save. 

8. Click Close. 

 

Educate the public 
After a disaster strikes, communities want to get back to normal as quickly as possible, and 

residents want to know when debris in front of their house will be removed. To expedite the 

removal process, residents are asked to segregate debris piles in their right of way according 

to specific types, helping municipalities pick up and process the debris efficiently. In addition, 

drop-off sites enable residents to drop-off specific types of debris, reducing the workload for 

removal crews. 

In this workflow, you will assume the role of a resident who needs to know when debris will be 

removed from their street, what to do to prepare, and where they can drop off debris in the 

meantime. 

1. In a browser, go to the Debris Removal Services app. 

  The information panel describes how to use the app and provides guidance for residents 
on how to sort their debris into separate piles to facilitate removal. 

2. Click the X to close the information panel. 

3. Find debris removal services for a location by clicking the map or entering an address in 
the search bar. 

  The app displays the service area for the selected location, and any drop-off sites within 
the selected search radius. 

4. To change the search distance for finding drop-off sites, click and drag the distance slider 
to your desired distance. 

5. Click Filter to filter drop-off sites by the debris types they accept.  

6. Check the check box next to each type of debris you want to search for and click Close. 

7. To search for a different location, click Clear search location. 
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Review removal progress 
As recovery from a disaster begins, the debris manager in the Emergency Operations Center 

works with emergency managers, elected officials, and other key stakeholders to ensure that 

the debris removal process is handled expediently. The debris manager provides situational 

awareness relative to the status of the removal effort and coordinates with the debris 

operations lead to ensure that debris removal providers are completing their work in a timely 

fashion. 

In this workflow, you will assume the role of the debris manager who needs to review the 

progress of the debris removal process. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click Remove. 

  The Debris Removal Dashboard includes header selectors to filter by date range as well 
as incident name. Some dashboard elements will not display until an incident name is 
selected. 

3. Click the Incident drop-down menu and choose an incident name. 

4. The left panel shows a chart illustrating work areas by their removal status along with a 
list of each work area, the removal provider assigned, and the area’s status. Clicking a 
column will zoom the map to the work area, filter tickets by the work area’s boundaries, 
and filter other dashboard elements to reflect the values specific to that work area. 

5. The first tab in the right panel displays key performance indicators (KPIs) including the 
percent of work areas where removal has been fully completed, the total volume of debris 
removed from the community, and the total volume of debris reduced and taken to a 
landfill or final disposal site. 

6. Click the Removal Charts tab.  

  This tab displays charts displaying debris removal volumes by debris type and provider. 

7. Click a chart column to filter the map and related dashboard elements. 

8. Click the Haulout Charts tab.  

  This tab displays charts displaying volumes of debris hauled to landfills by debris type 
and provider. 

9. Click a chart column to filter the map and related dashboard elements. 

10. Click the Tickets tab.  

  This tab displays a list of debris monitoring tickets in descending order by date of 
assessment. 

11. Click a record in the Monitoring ticket list to zoom the map to the ticket location and 
view details and photos associated with it. 

 

Export debris logs 
Debris operations leads are often asked to provide daily hard-copy logs of assessments or 

monitoring tickets for the various administrative needs of internal and external stakeholders. 
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In this workflow, you will assume the role of the debris operations lead who needs to export 

debris assessment records to provide to an internal stakeholder in the EOC. 

1. In a browser, go to the Emergency Debris Management Center app. 

2. In the app header, click the Help drop-down arrow and choose View Logs. 

3. Click the Filter widget to view available filters for the debris assessments layer.  

4. For Debris type, choose White Goods and click Apply. 

5. Click the Filter widget to hide the available filters. 

6. Click a record in the table.  

  Details about the record are displayed, and the map zooms and selects the record. 

7. Click the Photos tab to view the photos associated with this record. 

8. To export a CSV file of all your filtered data, click the Actions button , and then click 
Export All and choose Export to CSV. 

9. To export a CSV file of a selected record in the table, click the Actions button, and then 
click Export Selected and choose Export to CSV. 

10. To switch from debris assessments to debris monitoring tickets, click Debris Monitoring 
Tickets. 

 

Share debris removal data 
A variety of stakeholders need debris records to support their internal processes. Contractors 

use debris assessment records from the office and the field to identify the parts of a work area 

they need to complete, and to identify where specialized types of debris removal crews are 

required. Contractors also need access to monitoring tickets for invoicing purposes because 

their contracts are typically volume-based. 

FEMA representatives from the Public Assistance program also need access to these records 

for auditing purposes, verifying that debris removed corresponds to debris assessed, and that 

FEMA documentation procedures for debris removal are being followed. 

In this workflow, you will assume the role of a contractor who needs to export debris 

monitoring tickets from the office for generating an invoice. 

1. In a browser, go to the Debris Records Reviewer app. 

2. Click the Filter widget to view available filters for the debris monitoring tickets layer.  

3. For Select debris type(s), choose Vegetative and click Apply. 

4. Click the Filter widget to hide the available filters. 

5. Click a record in the table. 

  Details about the record are displayed, and the map zooms and selects the record. 

6. Click the Photos tab to view the photos associated with this record. 
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7. To export a CSV file of all your filtered data, click the Actions button , and then click 
Export All and choose Export to CSV. 

8. To export a CSV file of a selected record in the table, click the Actions button, and then 
click Export Selected and choose Export to CSV. 

9. To switch from assessments to tickets, click Tickets. 

Note: 

To accommodate small screens, the app layout is different on a mobile device. The Table 
widget is not visible and an arrow on the bottom of the screen (when tapped and Tickets 
is active) displays Details, Photos, and Filters for filter records. To view a record’s 
details, tap either Assessments or Tickets above the map, tap a record on the map, and 
tap the arrow to open the panel. 
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Emergency Management Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Emergency Management 

Operations 
Emergency Management Operations can be used to manage incident operations and 

maintain situational awareness during emergency response and recovery phases. 

The solution provides an integrated suite of role-based apps that helps emergency response 

personnel (for example, duty officers, field operations, incident commanders, and public 

information officers) share information as they perform the unique tasks required to 

accomplish incident objectives. Emergency Management Operations is typically implemented 

by emergency management agencies that want to use shared information during emergency 

response and recovery operations. 

The Emergency Management Operations solution delivers a set of capabilities that help you to 

identify an emergency incident, define the impact, allocate resources, and communicate 

status to internal and external stakeholders. 

 

Requirements 
The Emergency Management Operations solution requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later (Basic, Standard, or Advanced) 

Note: 

To use this solution ensure the following content and services are enabled and configured 
in ArcGIS Enterprise: directions and routing utility service, Living Atlas content and Living 
Atlas subscriber content. 
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Information products 
Emergency Management Operations includes the following information products: 

Item Description Minimum user 
type 

Situational 
Awareness Viewer 

An ArcGIS Web AppBuilder app that can be used by 
emergency management personnel to understand 
the impact of an incident on public infrastructure and 
human populations 

Editor 

Operations 
Response 

An ArcGIS Web AppBuilder app used by emergency 
management personnel to understand the status of 
emergency facilities and response teams 

Editor 

Incident Status 
Dashboard 

An ArcGIS Dashboards app used by emergency 
management personnel to monitor response 
activities and measure progress on incident 
objectives 

Viewer 

Incident Briefing A Portfolio app used by emergency management 
personnel to brief key stakeholders during an 
incident or event 

Viewer 

Public Information A Nearby app used by the public to review 
authoritative information and understand the status 
of an incident or event 

Not required 

Emergency 
Management Maps 

An ArcGIS Pro project used by mapping technicians 
to create a standard set of briefing and response 
maps 

GIS 
Professional 
Basic 

Emergency 
Response 
Volunteer Survey 

An ArcGIS Survey123 form used by the general 
public to volunteer for emergency response 
activities. 

Not required 

Emergency 
Response 

An ArcGIS Hub site used by emergency 
management agencies to share incident information 
with key stakeholders. 

Not required 
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Release notes 
The following are the release notes: 

Version Description 

1.2 • A new Incident Briefing app that uses the Portfolio app. 

• A new Emergency Management Maps ArcGIS Pro project. 

1.1 • A new Emergency Response site that can be used to share incident data 
with key stakeholders. 

• A new Emergency Response Volunteer Survey form that can be used to 
solicit emergency response volunteers. 

• A new Incident Status Dashboard. 

• A new Incident Briefing app that leverages the new Incident Status 
Dashboard. 

• A new Situational Awareness Viewer and Operations Response app that 
includes updated map symbology and editing configurations. 

• A new Emergency Management Maps ArcGIS Pro project that includes a 
series of enhancements to the map book layouts. 

1.0 • First release of Emergency Management Operations 
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Configure Emergency Management Operations 
Emergency Management Operations can be used to manage incident operations and 

maintain situational awareness during emergency response and recovery phases. 

In this topic, you'll learn how to configure the Emergency Management Operations solution to 

meet specific needs in your organization. 

 

Load data 
The Emergency Management Operations solution includes a series of facility layers needed to 

support emergency response activities: 

• Emergency Facilities—Police and fire 

• Industrial Facilities—Factories, utilities 

• Commercial Facilities—Shopping centers and businesses 

• Medical Facilities—Hospitals and clinics 

• Educational Facilities—Schools 

In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to 

load. If you do not have an inventory of facility information in your ArcGIS organization, you 

may have them in a spreadsheet or another system you can export to a spreadsheet. Once 

you have created a spreadsheet for each facility type, you can load the data into the facility 

layers provided with the solution. 

 

Load data from a spreadsheet 
To load your facility data from a spreadsheet, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Emergency Management Operations in the search box. 

4. Under Item Type, click Layers, then click Feature Layers. 

Note: 

Some of the feature layers have a suffix added such as public. These are layer views 
of the of the original source feature layer. These layer views are used to share 
information with the public without showing all the details or allowing the public to edit 
the layers. The original source layers do not have a suffix. 

5. Click the title of the original source layer into which you want to load data to view the item 
details. 

6. Click Update Data, then click Append Data to Layer. 
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7. Under Filename, choose your spreadsheet. 

8. Click Upload, then click Continue. 

9. Click Show field matching to match the fields from the spreadsheet to the fields in the 
selected feature layer. 

10. After you have matched the fields, click Apply Updates. 

11. Click the Data tab on the banner of the item page to confirm your data has loaded 
successfully. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Configure Public Information app 
The Public Information app can be used by the public to review authoritative information and 

understand the status of an incident or event. Directions to the nearest facility can be enabled 

so users can quickly find the facility they are looking for. 

 

Configure directions 
Optionally, the Public Information app can be configured to provide directions to the nearest 

facility. 

This configuration draws routes and provides directions using the ArcGIS Online World Route 

Service. This service requires authorization to consume premium content as it consumes 

credits. Learn more about credit usage when creating simple routes. 

Follow the steps below to enable directions. 

1. If necessary, sign in to your ArcGIS organization and browse to the Public Information 
app. 

2. From the item page, click Configure App. 

Close the Welcome to the App Setup Page splash page, if necessary. 

3. Click Nearby > Options and turn on the Show directions toggle button. 

4. Check the check box next to the Local Incidents, Open Shelters and Road Blocks 
layers. 

5. Click Publish. 

6. Click Confirm. 

The Authorize premium content window appears with information related to 
authorization. 

7. Click Authorize. 

8. Click Launch. 
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Modify volunteer survey 
The Emergency Management Operations solution includes a Emergency Response Volunteer 

Survey that can be used by the general public to volunteer for emergency response activities. 

Review the preconfigured questions and align the survey with your organizational policies and 

desired outcomes. 

To modify the Emergency Response Volunteer Survey, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Emergency 
Response Volunteer Survey. 

2. Open the item page and click Open in Survey 123 > Manage in Survey123 website. 

3. Click the Design tab. 

4. Make your edits to the survey and save the changes. 

5. Click Publish twice. 

 

Configure emergency response site 
The Emergency Management Operations solution includes the Emergency Response ArcGIS 

Hub site that your organization can configure with your branding and use to share emergency 

information with the public. 

 

Update with organizational information 
After deploying the Emergency Management Operations solution, the Emergency Response 

site layout only requires a few updates to fit your local context. Consider what information you 

already have and what you can most easily find. To update your site, complete the following 

steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Emergency 
Response site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. In the title section of the site, click the edit button, click Edit in HTML, and the update the 
text below to reflect the message you want promote with the community. 

<span><strong>Flood Warning</strong> in effect. More than 5" of rain 
expected in next 24 hours. Visit the Emergency Map for more information 
on local road closures.</span> 

Note: 

To remove the animated banner when a warning period has expired or there is nothing 
to report. Edit the Damage Assessment and then edit the row where the text is 
animated. In the Row CSS Class you will see the word warning, remove this text to 
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disable the animation. When you are ready to enable the animated banner, add 
warning to the CSS class and modify the message. 

5. In the title section, click the edit button, click Edit in HTML, and them update the 
Statistics section listed under the title of the website.  

The Road Closures, and Evacuation Notices statistics cards are linked to the layers 
used in the Public Information map. These stats automatically update as incident 
information is maintained using the Emergency Management Operations solution. 

6. Scroll to the Statistics section listed under the title of the website.  

The Road Closures, and Evacuation Notices statistics cards are linked to the layers 
used in the Public Information map. These stats automatically update as incident 
information is maintained using the Emergency Management Operations solution. 

7. Scroll to the Newsroom section, hover over each card and click edit pencil . 

8. Click the Find a Shelter button and click Edit. 

9. Enter the URL to your Shelter Locator, if available, in the Link Destination text box and 
click Add Link. 

10. In the Damage Assessment section, click the Learn More button and click Edit. 

11. Enter the URL to your damage assessment site, if available, in the Link Destination text 
box and click Add Link. 

12. Scroll to the Apply Now section, hover over the card and click edit pencil. 

13. In the Debris Removal section, click the Learn More button and click Edit. 

14. Enter the URL to your emergency debris management site or application, if available, in 
the Link Destination text box and click Add Link. 

15. Scroll to the Frequently Asked Questions section, hover over the card and click the edit 
pencil, and update the questions and answers. 

16. Click Footer.  

A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

17. Click the HTML text box. 

The HTML window appears. 

18. Make the necessary changes and click Apply. 

19. Click Save. 

 

Share items with public 
Several layer views, maps and apps included in the Emergency Management Operations 

solution must be shared with everyone so they can be accessed by the public on the 

Emergency Response site. To share your public emergency response items with everyone, 

use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Emergency 
Management Operations folder. 
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2. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) EmergencyShelters_public 

Feature Layer (hosted, view) Evacuations_active_public 

Feature Layer (hosted, view) IncidentLocations_active_public 

Feature Layer (hosted, view) RoadClosures_active_public 

Web Map Public Information 

Web Mapping Application Public Information 

Feature Layer (hosted, view) EmergencyResponseVolunteer_fieldworker 

Form Emergency Response Volunteer Survey 

Site Application Emergency Response 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

Warning: Sharing editable layers publicly appears notifying that you are sharing 
editable layers publicly. 

5. Click Update. 
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Use Emergency Management Operations 
The Emergency Management Operations solution delivers a set of capabilities that help you to 

identify an emergency incident, define the impact, allocate resources, and communicate 

status to internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Assess impact 
The Situational Awareness Viewer can be used by emergency management personnel to 

understand the impact of an incident on public infrastructure and human populations. 

Situational Awareness Viewer includes incident information used in a suite of related 

emergency operations solutions essential to maintaining situation awareness. 

In this workflow, you will assume the role of a duty watch officer responsible for assessing the 

incident impact and sharing that information with other users in the EOC. 

 

Define an incident area 
The incident area can be defined by selecting an existing incident, weather warning area, or 

storm report from Active Incidents and Warnings. An incident can also be created by creating 

a buffer around a point, line, or polygon. 

To define the incident area using the sample data, complete the following steps: 

1. In a browser, from the Emergency Management Operations solution, view the Situational 
Awareness Viewer. 

2. From the Active Incidents and Warnings list, click an incident perimeter. 

Note: 

You can also define an incident area by clicking any existing polygon. 

3. Click the more options button in the lower right corner of the pop-up window and choose 
Set Location to define the incident area. 

  The Understand Impact widget will open at the bottom of the screen with the impact of a 
one-mile buffer around the flooding incident. 
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Note: 

The point, line, and polygon icons can be used to create another incident area by 
specifying a buffer distance around another location. This can be useful for accidents, 
chemical spills, tornado paths, wildfires, or any other type of incident. 

4. Click the Save button in the Situation Awareness panel at the bottom of the screen to 
save the incident location in the Incident layer. 

  A pop-up will appear allowing you to enter parameters for this incident. 

5. Enter an incident number, name, type, then click Done. 

 

Identify potential impact 
After the incident area has been defined, the impact to population, facilities, and infrastructure 

can be determined. 

To identify the potential impact of an incident using a previously defined area, complete the 

following steps: 

1. To determine the potential impact to the population, select the Potential impact tab in 
the Situation Awareness panel at the bottom of the screen. 

  The estimated potential impact to vulnerable populations in the incident area is displayed 
by age group. 

2. To further understand the impact to population, select the Special Needs tab. 

  This tab displays a list of residents who have registered for assistance during an 
emergency. 

3. To determine the impact to facilities, select the Schools, Shelters, and Hospitals tabs. 
Each tab displays the number of facilities in the incident area. 

4. To determine the impact to road infrastructure, select the Road Closures tab. This tab 
displays the number of Road Closures in the incident area. 

5. Click the Incident tab, then click the Download button to download all the incident 
information into a CSV file. 

Note: 

This CSV file can be given to the emergency management staff or volunteer 
coordinators. 

6. Click the Print button to create a report of the potential impacted facilities, infrastructure, 
and human populations. In the properties window, enter a title, orientation, page size, 
and any comments, then click OK. 

Note: 

This report can be printed or saved electronically to share with emergency 
management staff. 
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7. The Snapshot button can be used to create a time-stamped folder in your ArcGIS 
organization containing a map and feature layers. The map and feature layers can be 
used for after-action reports or other analysis. 

Note: 

The Snapshot button is enabled when deployed in your organization and is enabled. 

8. Close the Situational Awareness Viewer app. 

 

Understand operational needs 
After the incident area has been defined and the impact has been determined, the operations 

personnel can plan and assign response activities. The Operations Response app can be 

used by emergency management personnel to understand the status of emergency facilities 

and response teams. 

In this workflow, you will assume the role of the operations section personnel responsible for 

locating and assigning emergency response resources. 

 

Find resources near an incident 
Operations response begins by identifying the incident area and finding nearby resources to 

support tactical operations. You can search for an address or place to find a given location to 

help plan response activities near that location. 

To locate resources near an incident, complete the following steps: 

1. In a browser, from the Emergency Management Operations solution, view the Operations 
Response app. 

2. In the search box, type an address. 

3. Click the more options button in the lower right corner of the search result pop-up 
window. 

4. Choose Set Location to define the incident area and specify a buffer distance of 1 mile. 

5. Click the MRP Deployments tab to display a list of mission-ready packages within the 
specified buffer. 

6. Click the Response Facilities, Road Closures, and Schools, Shelters tabs to find 
other resources. 

7. Click the Incident tab, then click the Download button on the left side and open the CSV 
file to see the list of resources. 

Note: 

This information can be shared with other agencies or saved for an after-action report. 
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8. Explore other methods of defining incident boundaries by using the line tool to locate a 
linear incident such as a train derailment along the train tracks and use a buffer distance 
of 1 mile to see the impact area. 

9. Click the Start Over button to remove the selected incident area, if necessary. 

 

Locate response teams assigned to an incident 
Mission teams that have been assigned to response activities can be located on the map with 

attributes and symbology for each type of response team. These locations and attributes can 

then be updated from the field as teams change or complete assignments. 

To locate a response team assigned to an incident, complete the following steps: 

1. Click the Add Resources widget in the upper right corner to view the resource that can 
be assigned to this incident. 

2. In the Search Templates box, type Emergency to see a list of resources with that name. 

3. Select Emergency Medical Services to add a point on the map near the point of the 
incident address. 

4. In the Add Resources list for Mission Ready Packages, add the following attributes: 

Parameter Value 

Name EMS 1 

MRP Type medical 

MRP Status Acceptance of Mission 

MRP Description public requested assistance 

NIMS Resource Medical/Public Health System Assessment Team 

NIMS Discipline Emergency Medical Services 

NIMS Resource Kind Team/Equipment 

NIMS Type III 

  Leave the remaining attributes blank for now and close the Resources widget. 

5. Use the Directions widget to get directions from the incident location to the nearest 
hospital. 

6. Click the Print button in the Directions widget to print a map of the route with directions. 

Note: 

Operations Response can be used on a mobile device or printed directions can be sent 
to a mobile device if necessary. 

7. Click Clear to clear the directions from the map. 
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Visualize incident status 
As the incident unfolds, it is important for incident commanders to monitor response activities 

as they occur in real time. Typically, the county or state Emergency Operations Center 

displays the incident status on a big screen so all command staff can monitor events and 

make informed decisions. 

In this workflow, you will assume the role of the incident command personnel responsible for 

monitoring the status of the incident and emergency response activities. 

 

Monitor incident status 
The Incident Status Dashboard can be used by emergency management staff to monitor 

response activities in the Emergency Operations Center and measure progress toward the 

incident objectives. 

To monitor the status of an incident, complete the following steps: 

1. In a browser, from the Emergency Management Operations solution, view the Incident 
Status Dashboard app. 

Note: 

The Incident Status Dashboard is designed to be a passive dashboard, meaning no 
interaction is necessary since it typically will be viewed on a big screen in the 
Emergency Operations Center. 

2. Review the number of Active Incidents and Weather Warnings on the left side of the 
dashboard. As the active incidents increase, so does the demand on resources. 

3. Review the number of Open Shelters and Shelter Occupancy on the right side of the 
dashboard. Each green symbol on the map indicates both the location and status of 
shelters. Closed shelters will appear in red. As the shelter occupancy increases past 75 
percent, the gauge will turn red, indicating additional shelters will need to be opened to 
meet the demand. 

4. Review the indicators at the bottom of the screen. 

• MRPs Deployed indicates the number of Mission Ready Packages that have been 
assigned or deployed. An MRP type describes a specific capability that has been 
developed, trained, and equipped to respond to a unique incident or situation. 

• Road Closures indicates the number of road closures within the current map extent. 

• PODs indicate the number of Points of Distribution where public safety agencies can 
distribute critical supplies to the public. 

5. After you are done reviewing the information, close the Incident Status Dashboard. 
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Brief key stakeholders 
During an incident, emergency management personnel must provide key decision makers 

with accurate and current information that communicates the scope of the emergency 

incident, the status of operational response, and resource availability. Using digital maps to 

brief key stakeholders ensures clear communication across all command levels and enables 

effective executive-level decision-making. 

In this workflow, you will play the role of the incident command staff who is responsible for 

conducting the incident briefing. The briefing is conducted using a series of interactive apps in 

the Incident Briefing app. 

To brief key stakeholders during an incident, complete the following steps: 

1. In a browser, from the Emergency Management Operations solution, view the Incident 
Briefing app. 

2. Review information in the Incident Briefing Introduction tab to see how the briefing app 
can be used. 

3. Click View maps.  

4. Click the Situational Awareness tab to see active incidents and warnings. 

Note: 

The Situational Awareness app is embedded in the Incident Briefing app to provide an 
interactive map showing the status of the incident. You can select an active incident to 
show the current situation and impact to the community. 

5. Click the Operations Response tab to see current emergency response activities. 

Note: 

Questions often arise during an incident briefing such as how many teams are currently 
deployed or how many roads are closed. Because the Operations Response is 
embedded in the Incident Briefing app, questions such as this can be quickly answered 
with current information. 

6. Click the Incident Status tab to see the overall picture of the current situation. 

7. Close the Incident Briefing app when done reviewing. 

 

Locate incident information 
Citizens need access to information before, during, and after an incident to assess their 

personal risk and determine when to act. The Emergency Response site and Public 

Information app can be used by the public to review authoritative information and understand 

the status of an incident or event. 
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In this workflow, you will assume the role of a resident or member of the public that is 

interested in obtaining information about a current incident and volunteering to help if your 

skills are needed. 

 

Find an open shelter 
Follow the steps below to learn more about the incident and locate an open shelter: 

1. In a browser, from the Emergency Management Operations solution, view the 
Emergency Response site. 

2. Scroll to the Emergency Map and click Launch app to open the Public Information app. 

3. In the Public Information pane, drag and use the buffer distance slider to set a distance 
of 3 miles. 

  The slider allows a user to define a distance once an address is entered or a location is 
identified on the map. 

4. In the Public Information pane under Search for an address or locate on map, search 
for an address. 

5. Click the Expand All button to review all the incident information near the specified 
address. 

6. Scroll down the list of incident information to review the local incidents, evacuation 
notices, and weather warnings. 

7. Click Open Shelter to review additional information about the selected shelter. 

8. Close the Public Information app when you are done reviewing the incident information. 

 

Volunteer to help 
Follow the steps below to volunteer to help during an emergency incident. 

1. In a browser, from the Emergency Management Operations solution, view the 
Emergency Response site. 

2. Scroll to the Volunteer to help section. 

3. Click the Volunteer button. 

4.  Complete the survey and click Submit. 

 

Produce emergency maps 
Often, field support personnel don’t have access to the internet or real-time maps on devices 

during an emergency incident. Therefore, it may be necessary to produce paper maps of the 

current situation quickly. Emergency Management Maps can be used by emergency 

management mapping technicians to update the data sources with local incident data, share 

maps and data, and create standard hard copy briefing and response maps. 

In this workflow, you will assume the role of a mapping technician supporting an emergency 

incident. 
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Configure a project 
Emergency Management Maps is an ArcGIS Pro project used by mapping technicians to 

create a standard set of briefing and response maps. It can be used to update source data for 

the current incident which can be used in the other apps that are part of the Emergency 

Management Operations solution. 

Follow the steps below to configure the Emergency Management Maps project. 

1. In a browser, sign in to your ArcGIS Online organization, and then click My Contents. 

2. Locate the Emergency Management Operations folder. 

3. Download the Emergency Management Maps desktop application template. 

4. Start the ArcGIS Pro application and open the project package from the active portal. 

5. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

6. In the Catalog pane, expand the Using your data task group. 

7. Click the Update data sources task and follow the instructions to update the ArcGIS Pro 
project to reference hosted feature layers. 

8. Click the Append your data task and follow the instructions to add your data to the 
existing data schemas provided with the project. 

9. Click the Use existing geodatabase task and follow the instructions to source layers 
with your data or published web layers. 

10. Click the Use Esri Demographic data task and follow the instructions to use data 
included in ArcGIS Living Atlas of the World. 

 

Share incident maps 
Some situations require sharing data and maps with other people within the organization. 

After you resource the data in the previous workflow, you can share layers and maps with 

your data. You can also share the desktop application template with other mapping 

technicians. 

Follow the steps below to share an incident map. 

1. In the tasks panel, expand the Share with your organization task group. 

2. Click Share Layers and follow the task instructions to publish your data as a web layer. 

3. Click Remap layer to use published layers to replace layers in the project with the new 
published layers. 

4. Click Share maps to share the maps as web maps with your organization after 
referencing web layers in the project maps. 

5. Click Create Shared Map Package to create a map package that can be shared with 
other people in your organization to edit data and create map books. 
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Create a map book 
One way to deliver standard hard copy briefing and response maps to field personnel is in the 

form of a map book. The map book can be either a series of the same map with individual 

pages covering the geographic extent of the incident or a collection of different maps with the 

same extent. 

Follow the steps below to create an incident map book. 

1. In the tasks panel, expand the Create map books task group. 

2. Click Create a field reference map series and follow the task instructions to create a 
map series with pages of different extents of the same map. 

3. Click Create an incident map book and follow the task instructions to create an incident 
map book with different maps of the same extent. 

Emergency Management Maps contains several layouts that will be used to create the 

incident map book in PDF format so that you can print the map book or send it by email. 

 

Archive an incident 
After the incident or event is over and operational features in the map are ready to be 

archived, the Operations Response app can be used to update the active incident flag and 

archive incident data quickly and efficiently. When you archive an incident, the features are no 

longer visible in the app but will continue to be stored in the associated feature layers. This 

allows you to manage multiple incidents from a single app and allows you to access your 

archived data from the associated feature layers for after-action analysis or reporting. 

Follow the steps below to archive incident data and prepare for the next event. 

1. In a browser, from the Emergency Management Operations solution, view the Operations 
Response app. 

2. Click the Archive Incidents widget to view the operational layers available to be 
archived. 

3. Check the check boxes next to the layers to be archived. 

4. Click one of the Drawing tools, and then select the features on the map. 

5. From the Active Incident drop-down list, choose No, and then click Save. 

6. Close the Operations Response app. 
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Environmental Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Environmental Analysis 
Environmental Analysis can be used to evaluate and understand environmental impacts of 

proposed development projects and solicit feedback from stakeholders. 

It provides ready-made analysis and reporting tools that help streamline environmental review, 

solicit feedback from stakeholders, and generate reports for proposed development projects. 

This improved process decreases the time required for project review and increases 

communication between all stakeholders involved. Environmental Analysis is typically 

implemented by government agencies and conservation organizations that want to take a 

data-driven approach to environmental review of proposed development projects. 

The Environmental Analysis solution delivers a set of capabilities that help you evaluate 

proposed development projects and solicit feedback from stakeholders. 

 

Requirements 
Environmental Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Basic, Standard, or Advanced) 
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Information products 
Environmental Analysis includes the following information products: 

Item Description Minimum user 
type 

Environmental 
Analysis 

An ArcGIS Pro project used by natural resource 
staff to conduct and report on an environmental 
impact analysis 

GIS 
Professional 
Basic 

Environmental 
Screening 

An ArcGIS Web AppBuilder app used by natural 
resource staff to conduct an initial environmental 
impact assessment and share the impact with 
interested parties 

Viewer 

Environmental 
Impact Public 
Comment 

A Crowdsource Polling app used by the general 
public to review projects and comment on the 
impact to the natural environment 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Environmental Analysis 
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Configure Environmental Analysis 
Learn how to configure the Environmental Analysis solution to meet specific needs in your 

organization. 

 

Load data 
Environmental Analysis can be used to evaluate and understand environmental impacts of 

proposed development projects and solicit feedback from stakeholders. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 

workflows below. 

 

Load data from a shapefile 
You can load data for EnvironmentalScreening and EnvironmentalPublicComment from a 

shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Environmental Analysis 
The Environmental Analysis solution delivers a set of capabilities that help you evaluate 

proposed development projects and solicit feedback from stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Conduct initial environmental assessment 
You will start by assuming the role of a project manager responsible for reviewing proposed 

development project scenarios. You are asked to use the Environmental Screening app to 

review several proposed development project scenarios. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Environmental 
Analysis solution. 

2. View the Environmental Screening app. 

In the app, the Environmental Screening widget is open on the right. The widget 
includes various tools that can be used to define an area of interest. 

3. Define an area of interest with one of the provided tools. 

4. Adjust the Buffer distance. 

5. Click Report to view results. 

6. In the Environmental Screening widget, expand the layer that you are interested in to 
view its details. 

7. Optionally, at the top of the widget, click the Choose units for analysis button to adjust 
the search units. 

8. Click the Download or Print button to export the report. 

 

Conduct detailed environmental assessment 
Now you will assume the role of a project review analyst responsible for reviewing proposed 

development projects. You are asked to use the Environmental Analysis ArcGIS Pro project to 

review a proposed development project. Follow the defined tasks to create analyses, format 

layouts, and create reports of your findings. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Environmental 
Analysis solution. 

2. Download the Environmental Analysis desktop application template and unzip the folder. 

3. From the unzipped folder, browse to the MapsandGeodatabase folder and open the 
Environmental Analysis.ppkx file in ArcGIS Pro. 
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Note: 

The Environmental Analysis ArcGIS Pro project comes preloaded with sample data, 
geoprocessing tools, models, and layout templates for common analyses. 

4. In ArcGIS Pro, in the Catalog pane, expand Tasks, if necessary, and then double-click 
the Environmental Analysis Workflows task. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, follow the steps of each task to begin your project review. 

 

Provide stakeholder feedback 
As an engaged resident in a community, you want to provide your feedback on several 

proposed development project scenarios. You will use the Environmental Impact Public 

Comment app to submit comments on each scenario. 

1. In a browser, from the Environmental Analysis solution, view the Environmental Impact 
Public Comment app. 

2. From the list on the right, select the project that you want to comment on. 

3. Review the project details and comments. 

• Click the Vote for this project button to vote for the project. 

• Click the Add a comment button to leave a comment. 
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Equitable Property Value 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Equitable Property Value 
Equitable Property Value can be used to share authoritative property information, educate 

taxpayers and collect feedback from taxpayers when they are concerned about the equity of 

their property value. 

It provides 24/7 access to answer common property and tax distribution questions in order to 

increase public trust and streamline the assessment appeals process. This approach helps 

stakeholders make well-informed property and development decisions. Equitable Property 

Value is typically implemented by property appraisal departments, assessors, fiscal offices, 

and other local government organizations that want to engage taxpayers in the property 

valuation process. 

The Equitable Property Value solution delivers a set of capabilities that help you communicate 

parcel, property sales, and floodplain information as well as solicit assessment appeals from 

property owners in order to improve customer service and promote fair and equitable property 

values. 

 

Requirements 
Equitable Property Value requires the following: 

• ArcGIS Enterprise 

• Survey123 Connect 
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Information products 
Equitable Property Value includes the following information products: 

Item Description Minimum 
user type 

Equitable 
Property Value 

An ArcGIS Hub site used by the general public to access 
tax parcel and related property information, find 
comparable sales, file assessment appeals, and identify 
properties impacted by FEMA floodplain boundaries 

Not Required 

Floodplain 
Inquiry 

An ArcGIS Web AppBuilder app used by the general 
public, land development companies, and real estate 
professionals to locate parcels impacted by FEMA 
floodplain boundaries 

Not Required 

Residential 
Comp Finder 

An ArcGIS Web AppBuilder app used by the general 
public, real estate agents, and appraisers to find 
comparable sales and related property information 

Community 
Account 

Tax Parcel 
Viewer 

An ArcGIS Web AppBuilder app used by the general 
public to access tax parcel, tax distribution, and related 
property information on smartphones, tablets, and 
desktop computers 

Not Required 

Property Tax 
Assessment 
Appeal 

An ArcGIS Survey123 form used by the general public to 
file a formal request for the review of their property 
assessment 

Community 
Account 

Tax Liability 
Calculator 

An ArcGIS Survey123 form used by the general public to 
compute their estimated tax liability 

Not Required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Equitable Property Value  
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Configure Equitable Property Value 
Learn how to configure the Equitable Property Value  solution to meet specific needs in your 

organization. 

 

Load data 
Equitable Property Value  can be used to share parcel, property sales, floodplain, and tax 

distribution information. In some cases, you may have this information in ArcGIS or another 

business system already. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the hosted feature layers provided with the solution 

before sharing the maps or applications. 

Once you have determined what source data must be loaded, complete one or more of the 

data loading workflows below. 

 

Load data from a shapefile 
You can load data for TaxParcels, SiteAddresses, SchoolDistricts, FloodZones, and 

TaxParcelSales from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

Tip: 
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You can use the Data Assistant add-in, which is part of the Community Data Aggregation 
solution, to load your data into the TaxParcels hosted feature layer. The Data Assistant 
add-in allows you to update and load data manually or on a schedule. 

 

Load tax distribution information 
To configure the Tax Distribution table in the TaxParcels hosted feature layer in ArcGIS, you 

may use the sample .csv file included with the solution (TaxDistributionSources.csv). 

To load tax distribution from a spreadsheet, complete the steps below: 

1. Sign in to your ArcGIS organization and browse to the TaxDistributionSources item. 

2. On the item details page, click Download. 

3. Once downloaded, open the TaxDistributionSources.csv and populate Parcel ID, Total 
Tax, and Tax District distribution totals (in dollars). 

Note: 

After these tax values are populated, you can compute the percent of total tax dollars 
for each Tax District and populate its corresponding Tax District % attribute—for 
example, (TXDIST1/TOTTX)*100 = TXDIST1PER or ($1500/$5000)*100 = 30%. 

4. Alternatively, you can use ArcGIS Pro to populate these values based on their spatial 
relationship with tax districts. 

5. Once TaxDistributionSources.csv is populated with all the necessary data. 

6. In your ArcGIS organization, browse to the TaxParcels hosted feature layer. 

7. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

8. Under Filename, click Choose File. 

9. Browse to your .csv file and click Open. 

10. Click Upload and Continue. 

11. From Choose the layer that you wish to append data into, select the Tax 
Distribution table to load into. 

12. Uncheck Update existing features. 

13. Click Show field matching and map the fields between the two layers. 

14. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Configure the Equitable Property Value site 
The Equitable Property Value solution includes the Equitable Property Value Hub site that 

your organization can configure with your branding and use to share property value 

information with the public. 

 

Share Equitable Property Value items 
When you deploy the Equitable Property Value solution, it will create an Equitable Property 

Value site, and two Groups (Core Team and Followers) in your ArcGIS organization. Several 

maps and apps included in the Equitable Property Value solution must be shared with 

taxpayers before reviewing comparable sales and filing a property tax assessment appeal. 

Sharing the appropriate maps and apps with the Followers group created with the initiative will 

allow business owners to access them after creating a community identity. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Equitable 
Property Value folder. 

2. Check the check box next to each of the items below: 

Item Name 

Web Mapping Application Residential Comp Finder 

Form Property Tax Assessment Appeal 

Web Map Residential Comp Finder 

Feature Layer (hosted, view) PropertyTaxAssessmentAppeal_fieldworker 

Feature Layer (hosted, view) SchoolDistricts_public 

Feature Layer (hosted, view) TaxParcelSales_public 

3. Click Share. 

4. In the Share window, click Edit Group Sharing. 

5. Click Equitable Property Value Followers and click OK. 

6. Click Save. 

7. Next, you'll share items with Everyone (public). 

8. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) FloodZones_public 

Feature Layer (hosted, view) SiteAddresses_public 

Feature Layer (hosted, view) TaxLiabilityCalculator_public 

Feature Layer (hosted, view) TaxParcels_public 

Web Map Floodplain Inquiry 

Web Map Tax Parcel Viewer 
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Web Mapping Application Floodplain Inquiry 

Form Tax Liability Calculator 

Web Mapping Application Tax Parcel Viewer 

Site Application Equitable Property Value 

9. Click Share. 

10. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

11. Click Update. 

 

Modify surveys 
The Equitable Property Value solution includes two surveys (Tax Liability Calculator and 

Property Tax Assessment Appeal) that can be used to estimate tax liability for a given 

property and appeal property tax. 

Review the preconfigured questions and adjust as necessary to fit your needs. 

 

Add additional fields 
Both surveys leverage hosted feature layer views created from the TaxLiabilityCalculator and 

PropertyTaxAssessmentAppeal hosted feature layers. Organizations may want to modify the 

Tax Liability Calculator and Property Tax Assessment Appeal surveys by first adding new 

fields to the hosted feature layers and configuring the surveys to use the newly created fields. 

When doing so, the new fields must be exposed in the appropriate views. 

To add one or more fields to a hosted feature layer and update the views, complete the 

following steps: 

1. Add a new field to a layer in the TaxLiabilityCalculator or PropertyTaxAssessmentAppeal 
hosted feature layer. 

2. Browse to the view in your contents. 

3. Click Open in Map Viewer Classic. 

4. Click the More Options button on the appropriate hosted feature layer or table, and click 
Set View Definition. Click Define Fields. 

5. Scroll to the newly created field and check the box. Click Apply. 

  The new field is added to the view’s definition. 

 

Modify equation for tax liability 
To modify a Equitable Property Value survey, complete the following steps: 

1. Install Survey123 Connect. 
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2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Tax Liability Calculator and download the survey. 

4. Click Tax Liability Calculator again to open the survey. 

5. On the left pane, click the Open XLSForm spreadsheet. 

6. Revise the survey logic to reflect the calculation for tax liability in your community. 

7. Save the Microsoft Excel spreadsheet and preview your changes in Survey123 Connect. 

8. In Survey123 Connect, click Publish in the left pane to publish your changes. 
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Use Equitable Property Value 
In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Locate parcels impacted by a floodplain 
When the public and real estate professionals search for properties, floodplain boundaries 

come into consideration. Knowledge of floodplain boundaries helps ensure that informed 

decisions can be made during the land development and home buying processes. 

In this workflow, you will learn how to locate and view authoritative floodplain boundary 

information (DFIRM panels) provided by the Federal Emergency Management Agency 

(FEMA) using Floodplain Inquiry. 

You will assume the role of a resident in a local community. You want to see whether a 

property that you are interested in purchasing sits within a floodplain boundary. 

1. In a browser, from the Equitable Property Value  solution, view the Equitable Property 
Value  ArcGIS Hub site.  

2. Scroll to the Property Applications section, and then click Locate Floodplain. 

3. The Floodplain Inquiry app opens. 

4. On the right, in the Search Parcels widget, search for a parcel number or address, or 
click the location directly on the map. 

5. Review the property's details, such as its parcel number or address, and whether the 
property is impacted by a flood zone. 

 

Locate comparable sales 
To determine fair market value of a subject or prospective property, the public and real estate 

professionals can use the Residential Comp Finder to look for properties with similar 

characteristics. 

You will assume the role of a local homeowner. You want to find recently sold properties with 

similar characteristics to determine the value of your home. 

1. In a browser, from the Equitable Property Value  solution, view the Equitable Property 
Value  ArcGIS Hub site. 

2. Create a community identity or sign in with an existing user account.  

3. Scroll to the Get Involved section and click Get Involved to follow the initiative. 

Following the initiative gives you access to the Residential Comp Finder app. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 387 

4. Scroll to the How does my property compare section, and then click Find Comps.  

The Residential Comp Finder app opens. 

5. In the Locate Sale widget, search for a parcel number, address, or school district, or 
click the location directly on the map. 

6. Optionally, adjust the buffer slider to see a larger list of potential properties. 

7. Review the property's details, such as its address, parcel number, year built, floor area, 
assessed value, sale price, sales date, and sales ratio. 

8. Optionally, use filters to refine the results; for example, use the Sale Amount is between 
filter to find homes with sale prices between $250,000 and $350,000. 

 

Discover parcel and tax distribution information 
Providing up-to-date and accurate information on taxes can help taxpayers know where their 

dollars go and allow local governments to operate with transparency. Using the Tax Parcel 

Viewer, the public can access property tax information and see where property tax dollars are 

being distributed, along with the amount of each distribution. 

You will assume the role of a local homeowner. You want to find your property to see how 

your property taxes have been distributed. 

1. In a browser, from the Equitable Property Value  solution, view the Equitable Property 
Value  ArcGIS Hub site. 

2. Scroll to the Property Applications section, and then click View Parcels. 

The Tax Parcel Viewer app opens. 

3. On the right, in the Search Parcels widget, search for a parcel number, owner, or 
address, or click the location directly on the map. 

4. Review the property's details, such as its address, parcel number, owner name, 
subdivision, structure types, and assessed and land values. 

5. Review the tax distribution information to see how property tax from this parcel has been 
locally allocated. 

 

Estimate tax liability and appeal assessment 
To determine tax liability and review assessment of a property, property owners depend on 

the assessor’s office to accurately determine and assess their property’s value. 

In this workflow, you will learn how to estimate tax liability and file a formal appeal of a 

property assessment. 

 

Calculate estimated tax liability 
Property owners can use the Tax Liability Calculator to compute their estimated tax liability. 
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1. In a browser, from the Equitable Property Value  solution, view the Equitable Property 
Value  ArcGIS Hub site.  

2. Scroll to the embedded Tax Liability Calculator. 

3. Complete the Sale Price field to see a property’s estimated tax liability. 

 

File a Property Tax Assessment Appeal 
Property owners can use the Property Tax Assessment Appeal form to file a formal request 

for the review of their property assessment. 

1. In a browser, from the Equitable Property Value  solution, view the Equitable Property 
Value  ArcGIS Hub site. 

2. Create a community identity or sign in with an existing user account.  

3. Scroll to the Get Involved section and click Get Involved to follow the initiative. 

Following the initiative gives you access to the Property Tax Assessment Appeal app. 

4. Scroll to the How does my property compare section, and then under Start the 
Appeal Process, click Apply. 

5. Complete the Property Tax Assessment Appeal form, and then click Submit. 
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Fire Accreditation Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Fire Accreditation Analysis 
Fire Accreditation Analysis can be used to complete spatial analysis workflows and generate 

maps based on the Commission on Fire Accreditation International (CFAI) Accreditation 

Model Information Technology Specifications. 

The CFAI and the Center for Public Safety Excellence works with fire agencies around the 

world to encourage continuous improvement and promote standards of excellence. This 

accreditation process demonstrates that a fire agency is committed to continuous 

improvement, serving the community efficiently, and providing a fair and safe work 

environment for all personnel. Accredited fire agencies submit an annual compliance report 

that documents self-improvement efforts. After accreditation has been granted, fire agencies 

are required to submit annual performance appraisals and risk assessments. Fire 

Accreditation Analysis is typically implemented by fire departments, agencies, and districts 

that want to enhance hazard risk analysis and measure service delivery over time. 

The Fire Accreditation Analysis solution delivers a set of capabilities that help fire agencies 

complete a standard set of spatial analysis workflows and generate a series of maps that 

conform with the spatial requirements included in the CFAI Accreditation Model Information 

Technology Specifications. 

 

Requirements 
Fire Accreditation Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 3.0 or later (Basic, Standard, or Advanced) 

Note: 

To use this ArcGIS Solution an ArcGIS Online organizational account is required to 
configure the GeoEnrichment Service to work with ArcGIS Enterprise. 

This solution optionally uses infographics in ArcGIS Pro when connected to an ArcGIS 
Enterprise portal. Follow the instructions to enable infographics. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://www.cpse.org/
https://enterprise.arcgis.com/en/portal/11.0/administer/windows/configure-arcgis-online-utility-services.htm
https://support.esri.com/en/technical-article/000020792


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 390 

Information products 
Fire Accreditation Analysis includes the following information products: 

Item Description Minimum user 
type 

Fire 
Accreditation 
Analysis 

An ArcGIS Pro project used by fire analysts to 
conduct relevant spatial analysis workflows and 
generate a standard set of maps so you can reduce 
the time it takes to produce Fire Accreditation, 
Standards of Cover, and Annual reports. 

GIS Professional 
(Basic, Standard, 
or Advanced) 

Fire 
Accreditation 
Viewer 

A Portfolio app used by internal stakeholders to 
understand if continuous improvement objectives are 
being met. 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Fire Accreditation Analysis 
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Configure Fire Accreditation Analysis 
In this topic, you'll learn how to configure the Fire Accreditation Analysis solution to meet the 

specific needs in your organization. 

 

Organize your data 
Fire Accreditation Analysis uses your data to generate maps based on the Commission on 

Fire Accreditation International (CFAI) Accreditation Model Information Technology 

Specifications. Before you open the Fire Accreditation Analysis project, take some time to 

organize your source data. 

Two foundational data sets (geographic planning zones and incidents) are required to 

complete the analysis workflows in the Fire Accreditation Analysis project. 

 

Geographic planning zones 
Geographic planning zones are required to complete analysis workflows in each criterion. 

They can be fire station response areas, neighborhoods, census tracts, or any other polygonal 

area. Geographic planning zones must have a unique name to be used in the analysis 

workflows. 

 

Incidents 
The accreditation process requires three to five years of incident data that is typically sourced 

from your records management system. This historical data can be exported from your 

records management system in a comma-delimited text file (CSV file) or spreadsheet and 

imported into ArcGIS. Incident data must have the following fields to be used in the analysis 

workflows: 

• Incident identifier 

• NFIRS code 

• NFIRS property use code 

• Call date 

• Total time 

• Address or Longitude, Latitude (x,y) 

 

Additional source data 
As you identify the accreditation maps you wish to generate, you may need to organize other 

source data. In total, the following data is required to complete every analysis workflow in the 

Fire Accreditation Analysis project: 

• Agency service area boundary 
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• Other service area boundaries (mutual aid, contract areas) 

• Fire protection and detection systems 

• Occupancy inspections 

• Public education programs 

• Fire stations 

• Fire hydrants 

• Critical infrastructure 

Much of this data is typically sourced from shapefiles, file geodatabases, or other spatial data 

your organization manages. If this data is not currently managed in ArcGIS, it can be imported 

from a comma-delimited text file (CSV file) or spreadsheet. The source data must have the 

following fields to be used in the analysis workflows: 

• Unique identifier 

• Date 

• Address or Longitude, Latitude (x,y) 

 

Other data 
The following data is sourced from ArcGIS Living Atlas of the World and used in analysis 

workflows when you sign in to your ArcGIS organization: 

• Population density and growth 

• Transportation systems 

• Topography, geology, physiology, and climate 

• Area land use 

• Hazards (natural, environmental, industrial, social and domestic) 

• Demographic and socio-economic 

 

Adjust risk score 
Section 2B.4 of the CFAI Accreditation Model Information Technology Specifications defines a 

methodology that can be used to understand risk in your community. This risk score has a 

default risk range of 1 through 3 (low, medium, high) and summarizes the probability 

(frequency of past occurrence) and consequence (property use codes to determine the 

severity). Using the default values, your risk map will have a range of 2 through 6. In some 

cases, you may alter your risk range and use a wider range, for example 1 through 10. If you 

do modify the risk ranges, ensure that the probability and consequence scores have the same 

risk range. 
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Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

 

Modify consequence and probability range 
Follow the steps below to modify the consequence and probability range values for non-EMS 

incidents. 

1. Open the Fire Accreditation Analysis project in ArcGIS Pro. 

2. Open the 2B - Hazard Risk Assessment map. 

3. Click the Contents tab, and then scroll down and open the Property Use Lookup table. 

4. In the ConsequenceScore adjust the values field to your new range 

5. Click the Edit tab. 

6. Click Save. 

7. Open the Apply risk methodology for all non-EMS incidents (2B.4) task. 

8. Run the Select NFIRS Codes and Determine frequency of incidents steps. 

9. In the Number of Classes parameter, use the same number as the highest value that 
you used for the consequence score. (For example, if using a 1-10 range you would 
enter 10). 

10. Click Run to calculate the probability score based on the new range. 

 

Configure Fire Accreditation Viewer 
When you open the Fire Accreditation Viewer for the first time, it will include a single section 

for the Area Characteristics map. Follow the steps below to add additional accreditation map 

to the Fire Accreditation Viewer. 

1. In a browser, sign in to your ArcGIS organization and then browse to the Fire 
Accreditation Viewer app. 

2. From the item page, click Configure App. 

  Close the Welcome to the App Setup Page splash page, if necessary. 

3. Click Portfolio, and then click Add a New Section. 

4. Click Browse for content, and then browse to the web map you created in the Share 
with your organization task in the Fire Accreditation Analysis ArcGIS Pro project. 

5. Click Select Section to add the web map to the portfolio app. 

6. Click the Section Description from the drop-down list and then add a description about 
that map that you can share with your stakeholders. 

7. Click Publish. 

8. Click Launch. 
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Use Fire Accreditation Analysis 
The Fire Accreditation Analysis solution delivers a set of capabilities that help fire agencies 

complete a standard set of spatial analysis workflows and generate a series of maps that 

conform with the spatial requirements included in the CFAI Accreditation Model Information 

Technology Specifications. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Review the Fire Accreditation Analysis project 
Follow the steps below to download and review the Fire Accreditation Analysis project. 

1. Sign in to your ArcGIS organization and browse to the Fire Accreditation Analysis 
Desktop Application Template. 

2. From the item page, click Download. 

3. Unzip and open the Fire Accreditation Analysis ArcGIS Pro project. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Fire Accreditation 
Analysis task. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Window group, click, 
Catalog Pane. 

5. In the Tasks pane, expand the Getting to know Fire Accreditation Analysis task 
group to see the collection of tasks. 

6. Double-click Fire Accreditation Analysis project structure to review the organizational 
structure and task workflow. 

7. Double-click Organize your data to review the standard data layers used in the project 
and learn about potential sources for the data you will need. 

8. Double-click Sign in to your ArcGIS organization to use content available in the 
ArcGIS Living Atlas. 

 

Create fire accreditation maps 
The 10th Edition of Commission on Fire Accreditation International (CFAI) Model contains 

eleven unique criterion and over forty different core competencies or performance indicators. 

Although all these criteria must be documented, not all of them can be mapped. As a result, 

the (CFAI) Model Information Technology Specifications provides a list of spatial data required 

for the accreditation process. For each spatial data element in the list, there is a reference to 

the core competency or performance indicator used in a map that supports the criteria. 

Preparing for accreditation, community risk reduction or standard of cover is time consuming 

and data intensive. The structured set of tasks included in the Fire Accreditation Analysis 
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project reduces the time it takes to conduct the required analysis, and increase the quality of 

the fire accreditation maps. 

In this workflow, you will assume the role of a fire analyst or GIS analyst who wants to create 

one, or more, fire accreditation maps. 

 

Area characteristics (Criterion 2A) 
The first criterion in the accreditation model is to document the area characteristics—or 

distinct natural, human, and development characteristics—for a defined service area. In task 

2A.3, a planning zone layer is created and will be used in subsequent tasks to create maps of 

area characteristics such as population density, transportation, land use, socio-economic and 

demographic information, critical infrastructure, and other local characteristics. 

1. Identify the area characteristics maps you would like to generate. 

2. To create area characteristics maps, open the Area characteristics (Criterion 2A) task 
group and follow the steps in each task. 

 

Hazard risk assessment (Criterion 2B) 
Hazard risk assessment maps identify, assess, classify, and categorize hazard risks. 

Historical incident data is used to define the risk using the two-axis methodology of probability 

and consequence. The frequency of each type of fire incident determines the probability. 

Property-use codes are used to classify higher-risk properties and determine the 

consequence. Total response time is used to determine the consequence for emergency 

medical services (EMS) incidents. 

1. Identify the hazard risk assessment maps you would like to generate. 

2. To create hazard risk assessment maps, open the Hazard Risk Assessment (Criterion 
2B) task group and follow the steps in each task. 

Note: 

The 2B.2: Data Preparation tasks must be completed before any other task in this group. 

 

Current deployment and performance (Criterion 2C) 
Deployment and performance maps illustrate how well current deployment and performance 

meet identified service demands. They leverage National Fire Protection Association (NFPA) 

1710 and use standard response times for first due (4 minutes) and effective response force 

(8 minutes) for low, and medium, hazards. 

1. Identify the deployment and performance maps you would like to generate. 

2. To create deployment and performance maps, open the Current deployment and 
performance (Criterion 2C) task group and follow the steps in each task. 
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Response capabilities (Criterion 2D) 
Response capabilities maps evaluate current deployments and future service demands. They 

highlight risks associated with development in a community and illustrate a plan is in place to 

maintain, and improve response capabilities if growth, or development, were to occur. 

1. Identify the response capabilities maps you would like to generate. 

2. To create response capabilities maps, open the Response capabilities (Criterion 2D) 
task group and follow the steps in each task. 

 

Community risk prevention program (Criterion 5A) 
A community risk prevention program documents the frequency of occupancy inspections and 

uses inspection data to identify where occupancy risks can be mitigated by increasing the 

frequency of fire code inspections. 

1. To create risk prevention maps, open the Community risk prevention program 
(Criterion 5A) task group and follow the steps in each task. 

 

Public education program (Criterion 5B) 
Community risk prevention programs use public education campaigns to mitigate risks 

identified during an assessment. Public education maps evaluate risks (for example, cooking 

fires or household hazards) and identify gaps in public education programs. 

1. To create public education program maps, open the Public education program 
(Criterion 5B) task group and follow the steps in each task. 

 

Fixed facilities (Criterion 6B) 
Fixed facility maps identify the location of fire stations, administrative offices, training facilities, 

communications centers, logistics, and supply centers. 

1. To create fixed facilities maps, open the Fixed facilities (Criterion 6B) task group and 
follow the steps in each task. 

 

Water supply (Criterion 9A) 
Water supply maps identify water distribution assets (for example, hydrants) in a community. 

They also identify coverage gaps or locations where reliable and adequate water pressure is 

not present. 

1. To create water supply maps, open the Water supply (Criterion 9A) task group and 
follow the steps in each task. 
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Share fire accreditation maps 
Fire accreditation maps and geospatial content created with the Fire Accreditation Analysis 

project can be shared with others in your organization. Sharing maps can be especially 

valuable during the accreditation process to ensure that the correct information is included in 

accreditation documents. 

To share fire accreditation maps, open the Share fire accreditation maps task group and 

follow the steps in the task. 

 

Review fire accreditation maps 
You will assume the role of an accreditation manager in a fire department. You have been 

asked to review maps created for your fire accreditation document. 

Follow the steps below to review fire accreditation maps created by your fire analyst, or GIS 

analyst. 

1. in a browser, sign in to your ArcGIS organization and then browse to the Fire 
Accreditation Analysis solution.  

2. Open the Fire Accreditation Viewer app item page, and then click View. 

3. Read the Welcome information on the splash screen and then click Explore. 

4. At the top of the map, click each tab to view the contents for each map.  

Note: 

Review the Configure Fire Accreditation Analysis for more information on adding content 
to the app to meet the needs of your organization. If you have not completed this step, the 
app will choose default maps for display purposes. 
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Fire Hydrant Inspection 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Fire Hydrant Inspection 
Fire Hydrant Inspection can be used to perform routine fire hydrant inspections and monitor 

fire department hydrant inspection programs that ensure every hydrant performs reliably when 

an emergency occurs. 

Every year, firefighters and civilians are injured or killed in structure fires. When a structure fire 

occurs, every second counts, and proper water supply can mean the difference between life 

and death. The National Fire Protection Association (NFPA) 291 Standard guides fire and 

water departments through best practices for water flow testing and fire hydrant marking. Per 

NFPA 291, hydrants should be flushed and inspected annually, and flow tests should be 

completed every five years. While hydrant inspections may seem like a given today, they are 

often neglected for other duties, and especially time consuming if still done on paper. Forward 

thinking fire departments have implemented procedures that streamline hydrant inspections 

and simplify access to information during an incident. 

The Fire Hydrant Inspection solution delivers a set of capabilities that help you inventory fire 

hydrants, routinely conduct inspections, monitor hydrant inspection programs, and share 

operating status with firefighters. 

Note: 

If you are a Water Utility and looking to conduct routine hydrant inspections that help you 
understand asset conditions, you may be interested in the Water Utility Hydrant 
Inspections solution instead. 

 

Requirements 
Fire Hydrant Inspection requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 
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Information products 
Fire Hydrant Inspection includes the following information products: 

Item Description Minimum 
user type 

Fire Hydrant 
Inspection 
Dashboard 

An ArcGIS Dashboards app used by fire personnel to 
monitor fire hydrant inspections occurring in a community 

Viewer 

Fire Hydrant 
Inspection 

An ArcGIS Field Maps map used by fire personnel to 
inspect fire hydrants and ensure that every hydrant in a 
district performs properly and reliably when an 
emergency occurs 

Mobile 
Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Fire Hydrant Inspection map that can be used with ArcGIS Field 
Maps. 

• A new Fire Hydrant Inspection Dashboard. 

• A new FireHydrants_public feature layer view that can be used to share the 
location of fire hydrants and their operating status with internal stakeholders. 

• A series of enhancements to the FireHydrants layer and related feature layer 
views. 

1.0 • First release of Fire Hydrant Inspection 
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Configure Fire Hydrant Inspection 
Fire Hydrant Inspection can be used to inventory fire hydrants, update operational status on a 

regular schedule, and monitor the progress of fire personnel performing routine hydrant 

inspections. 

In this topic, you'll learn how to configure the Fire Hydrant Inspection solution to meet specific 

needs in your organization. 

 

Load data 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or apps. 

Once you have determined what source data must be loaded, complete one or more of the 

data loading workflows below. 

 

Load data from a shapefile 
Load data into the FireHydrants layer from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. Sign in to your ArcGIS organization and browse to the feature layer you want to populate. 

3. Open the item page and click Update Data > Append Data to Layer. 

4. Click Choose File and browse to your .zip file, and click Open. 

5. Click Upload and Continue. 

6. Click Choose the layer to update drop-down arrow and choose the layer that contains 
the updated data. 

7. Uncheck Update existing features. 

8. Click Show field matching and map the fields between the two layers. 

9. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Fire Hydrant Inspection 
The Fire Hydrant Inspection solution delivers a set of capabilities that helps you inventory fire 

hydrants, update operational status on a regular schedule, and monitor the progress of fire 

personnel performing routine hydrant inspections. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Develop fire hydrant inventory 
A field assessment of fire hydrants is the most efficient way to develop a hydrant inventory for 

a fire department. In some cases, fire departments may be able to access hydrant data 

maintained by the local water utility and use that data to start the collection of operational 

status. In other cases, hydrant data may not exist and the field assessment used to capture 

the location of hydrants and their operational status. 

You will assume the role of a fire fighter in a fire department. In this workflow, you are asked 

to use the ArcGIS Field Maps mobile app to access your Fire Hydrant Inspection and 

inventory hydrants in your community. 

 

Collect new hydrant 
To collect a new fire hydrant in the field, complete the following steps: 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open the app on your mobile device, and sign in to your ArcGIS organization. 

3. Tap Fire Hydrant Inspection to open it. 

4. Tap the search box and type a local address, and then tap the suggested address in 

the search result list to zoom to that location on the map. 

5. Tap Collect Here and tap Operable. 

6. Swipe up on the form and tap Fire Hydrant ID and enter the identifier. 

7. Tap Station to enter the station response area. 

8. Tap Location to enter a more detailed description of the location. 

9. Swipe up and tap Inspected On to choose today's date. 

10. Tap Pumped and choose a value. 

11. Tap Defects, then tap Hard to Open and choose a value. Add other key characteristics 
in the form. 

12. Swipe up and tap Notes to enter any other observations noted in the field. 
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13. When you're done, tap Submit. 

14. Repeat steps 5 through 13 for each fire hydrant. 

 

Update operational status 
To update the operational status of an existing fire hydrant in the field, complete the following 

steps: 

1. Download ArcGIS Field Maps onto your mobile device if you haven't already. 

2. Open the app on your mobile device, and sign in to your ArcGIS organization. 

3. Tap Fire Hydrant Inspection to open it. 

4. Tap search, type your hydrant identifier and tap hydrant identifier in the search 

results. 

5. Tap Edit and swipe up on the form. 

6. Swipe up and tap Inspected On to choose today's date. 

7. Tap Operable and choose No. 

8. Tap Pumped and choose a value. 

9. When you're done, tap Submit. 

10. Repeat steps 4 through 9 for each fire hydrant. 

 

Monitor fire hydrant inspection program 
You will now assume the role of fire command staff and will use the Fire Hydrant Dashboard 

to monitor the progress of fire hydrant inspections. 

To monitor the progress of your fire hydrant inspection program, complete the following steps: 

1. In a browser, go to the Fire Hydrant Dashboard app. 

2. Click the Station drop-down in the left panel and choose a station.  

You can now see all fire hydrants in your district on the map. On the bottom of the 
dashboard, you can see the total number of hydrants in the station area along with the 
number of operable and inoperable hydrants in the same area. 

3. Click the Inoperable bar in the chart to see inoperable fire hydrants. 

4. Click the Inspection Date drop-down and choose Last 30 Days in the left panel. 

5. You can now see how many hydrants have been inspected in the last 30 days. 

6.  Adjust the Pressure slider to identify hydrants with low pressure. 

7. Close the app. 
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Fire Hydrant Inspection 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Fire Incident Dashboard 
Fire Incident Dashboard can be used to visualize fire and emergency medical service (EMS) 

incidents sourced from computer-aided dispatch or records management systems and monitor 

associated response times. 

It improves operational visibility for supervisors in a fire service agency and allows them to 

rapidly identify emerging incident patterns and diagnose response problems. This increased 

operational awareness ensures accreditation standards are being met and community safety 

standards are satisfied. Fire Incident Dashboard is typically implemented by fire service 

agencies that want to proactively monitor response times and detect incident patterns quickly. 

The Fire Incident Dashboard solution delivers a set of capabilities that help you source 

incident records from computer-aided dispatch or records management systems, visualize fire 

and EMS incidents, and monitor trends or patterns. 

 

Requirements 
Fire Incident Dashboard requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later (Basic, Standard, or Advanced) (Optional) 

 

Information products 
Fire Incident Dashboard includes the following information products: 

Name Description Minimum 
user type 

Fire Incident 
Dashboard 

An ArcGIS Dashboards application used by fire command 
staff to monitor fire and EMS incidents sourced from 
computer aided dispatch or records management data 

Viewer 
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Release notes 
The following are the release notes: 

Version Description 

2.1 • A new Fire Incident Dashboard map and app. 

• A new FireServiceDistricts layer that resolves an issue where data could not 
loaded into the layer (BUG-000124358). 

2.0 • A new Fire Incident Dashboard that includes the calculation of calls for 
service response times based on the 90th percentile. 

• A series of enhancements to the FireIncident layer, related feature layer 
views, and Fire Incident Dashboard map. 

• The Records Import Toolbox is no longer included in the solution and the 
capabilities have been replaced with the Update Feature with Incident 
Records toolbox in ArcGIS Pro. 

1.0 • First release of Fire Incident Dashboard. 
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Configure Fire Incident Dashboard 
The Fire Incident Dashboard solution can be configured to meet specific needs in your 

organization. In this topic, you will learn how to use the Update Features with Incident 

Records tool to automatically load data from records management systems (RMS) and 

computer-aided dispatch (CAD) systems into the layers in your Fire Incident Dashboard. You 

will also learn how to modify or remove dashboard elements unsupported by your data 

schema. 

 

Load data 
The layers can be loaded with your data using ArcGIS Pro. Optionally, you can automate data 

updates with current RMS or CAD incident data. These data updates can be scheduled to run 

a regular basis to ensure you are reviewing the most up-to-date information while using the 

dashboard. 

 

Load data using ArcGIS Pro 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or apps. 

Follow the steps below to load your data into the layers used in the Fire Incident Dashboard. 

1. Open ArcGIS Pro, and ensure you are signed into your ArcGIS organization where the 
Fire Incident Dashboard solution is deployed. 

2. Click View, and then click Catalog Pane. 

3. In the Catalog Pane, click Portal, click My Content and choose the folder containing the 
solution. 

4. Add the FireServiceDistricts layer and FireIncidents layer to the map. 

5. Click Analysis, then navigate to the Append tool, open the tool, use the tool to load the 
districts layer of the FireServiceDistricts layer. 

6. Navigate to the Update Features With Incident Records tool, open the tool and use it to 
load your data to the FireIncidents layer. 

Tip: 

The incident type field is based on the codes defined in the National Fire Incident 
Reporting System guide. Values for response time fields are expected to be in seconds 
and each record must have a unique identifier which refers to the first responding 
company. 
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Automate incident data updates 
You can use the Update Features With Incident Records with Microsoft Windows Task 

Scheduler to update incident layers on a regular interval. These scheduled updates ensure 

users have access to current information to support dynamic decision making. 

To update fire incident data on a schedule, use the Update Features With Incident Records 

tool with the Update Existing Target Features parameter enabled. Once the tool is 

configured to use your incident data and follow the instructions in the schedule geoprocessing 

tools documentation to learn how to run the tool on a schedule. 

 

Configure dashboard elements 
When loading data from your RMS or CAD system into the layers of the Fire Incident 

Dashboard, you may find that your source data does not contain specific fields used in the 

filters or charts. You can configure the Fire Incident Dashboard to point to different fields or 

delete it entirely as the schema of your data necessitates. 

The Fire Incident Dashboard utilizes the National Fire Protection Association (NFPA) 1710 

standard benchmark which defines key performance objectives to be met for fire suppression 

and emergency medical operation responses times. The measured response objectives 

include the alarm handling time, turnout time, travel time and total response time. The Fire 

Incident Dashboard utilizes these NFPA standards to help fire command staff monitor and 

manage responses within their jurisdictions. If your organization uses response times that do 

not follow the NFPA response standards, the dashboard can be configured to use your 

standard. 

See Configure an element in ArcGIS Dashboards for more information. 

 

Configure 90th percentile performance gauges 
The 90th percentile performance gauges communicate the key metrics on how quickly your 

agency is responding to emergency calls and shows where 90% of the responses are in 

relation to the set response time performance thresholds. 

To update the response times in the gauges, complete the following steps: 

1. In your browser, sign in to your ArcGIS organization and browse to Fire Incident 
Dashboard item details page. 

2. Click Edit  Dashboard. 

3. On the right under 90th Percentile Performance, configure the Total response time 
gauge. 

4. In the Data tab, modify the maximum value as needed. 

5. In the Gauge tab, scroll to the bottom to the Guides section and update the From and 
To values as needed. 

6. In the General tab, click the Edit button for Description to reveal a text editor and 
change the text as needed. 
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7. Click Done and Save your changes to the dashboard. 

Repeat the steps for the Alarm handling time, Turnout time and Travel time gauges. 

 

Configure performance outliers list 
The Performance Outliers by Incidents lists the incidents that are above each of the specified 

response time thresholds. 

To update the thresholds in the lists, complete the following steps: 

1. Click on the tab Performance Outliers tab to reveal the lists. 

2. Under Performance Outliers by Incidents, configure the Total response time list. 

3. In the Data tab, modify the Total Time filter value as needed. 

4. Click Done and Save your changes to the dashboard. 

Repeat the steps for the Alarm handling time, Turnout time and Travel time outlier lists. 

 

Configure response by date charts 
The Response by Date charts show the response times for each of the incidents and where 

they fall in relation to the specified response time thresholds. 

To update the thresholds in the charts, complete the following steps: 

1. Click the Response by Date tab to reveal the charts. 

2. Configure the Total response time chart 

3. In the Guides tab, modify the Value and To value parameters as needed. 

4. In the General tab, edit the Title to change the text as needed. 

5. Click Done and Save your changes to the dashboard. 

Repeat the steps for the Alarm handling time, Turnout time and Travel time charts. 
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Use Fire Incident Dashboard 
The Fire Incident Dashboard solution delivers a set of capabilities that help you source 

incident records from computer-aided dispatch or records management systems, visualize fire 

and EMS incidents, and monitor trends or patterns. 

The National Fire Protection Association (NFPA) standard 1710 provides a benchmark that 

defines the key performance objectives to be met for responses times to fire suppression and 

emergency medical service calls. The performance objectives include the alarm handling or 

dispatch time, turnout time, travel time and total response time. The Fire Incident Dashboard 

utilizes these NFPA standards to help fire command staff monitor and manage responses 

within their jurisdictions. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Understand recent trends 
The Fire Incident Dashboard includes the ability to measure 90th percentile responses using 

gauges for each of the NFPA performance objectives. These gauges can be used to 

understand recent performance trends for each station, response zone, company and shift. 

The 90th percentile standard is a way to objectively measure response times for each 

category within 90 percent of all responses. 

In this topic, you’ll assume the role of a fire chief who will use the Fire Incident Dashboard to 

explore recent trends in response times for fire and emergency medical service (EMS) calls. 

 

Explore response time to incidents 
Follow these steps to explore the fire department’s overall response-time performance. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Fire Incident 
Dashboard solution.  

2. View the Fire Incident Dashboard app. 

3. On the left, in the filter panel, click the Call Date drop-down list and choose Last 30 
days. 

The map filters to display all responses from the past 30 days in the entire service area. 

4. On the right, review each gauge to explore the 90th percentile performance for alarm 
handling or dispatch time, turnout time, travel time, and total response time. 

Note: 

Values in the green range are within or below the acceptable range for that metric. 
Values in the red range are outside of the acceptable range for that metric. The 
National Fire Protection Association (NFPA) standard is shown below each 
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corresponding gauge. For example, the NFPA standard turnout time for EMS response 
is 60 seconds, and it is 80 seconds for fire suppression. 

5. At the bottom of the dashboard, click Responding Company to review the number of 
responses by each company or unit. 

You can see which responding companies had the highest number of responses in the 
last 30 days. 

6. Click any column in the chart to see the location of responses for the responding 
company on the map and review the 90th percentile performance in each gauge. 

Tip: 

Click the same company again to clear the chart or click another company to compare 
responses. 

7. At the bottom of the dashboard, click the Response Zone tab to see a bar chart of each 
fire station's response zone or first due zone.  

8. In the chart, hover over the bar for a fire station to see the number of responses by each 
station within the response zone.  

Hovering over one fire station's bar allows you to determine if companies from different 
stations responded to calls in the selected fire station's response zone. 

9. At the bottom of the dashboard, click the Response by Date tab to see any dates when 
responses were above the NFPA standard for each performance objective. 

The red line indicates the NFPA performance objective and allows you to visualize the 

date and time of any responses that exceeded the standard. 

10. In the Total response time chart, click a point above the red line to see the date and 
time of that response.  

 

Compare fire response times by fire station 
Response-time performance may vary depending on the station or unit responding. You can 

compare response time using the station and call type filters. 

Follow these steps to examine the response-time performance for each station. 

1. From the Station drop-down list, choose a fire station. 

The map and gauge elements filter to reflect only the incidents occurring by that fire 
station. This filter allows you to see where companies from that station responded and 
compare the response times to the performance objectives. 

2. Click the Call Type drop-down list and choose each call type one by one, noticing the 
differences in response-type performance for each call type. 

3. After you finish, reset all filters. 

4. Repeat this process with the incidents in other fire stations to make a data-driven 
decision on each station’s performance. 
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Examine performance by response zone 
Response-time performance varies depending on the where the call is located. Many times a 

company may be dispatched to call in another station's response zone. This can happen 

either because they are closer or the first due response company is responding to another 

call. You can filter responses to see which companies responded to calls in each response 

zone. This filter can help you identify performance issues caused by travel delays to another 

response zone. 

Follow these steps to examine response-time performance by response zone. 

1. From the Response zone drop-down list, choose a response zone. 

2. Click the Call Date drop-down list and select Year to date. 

The map updates, showing year-to-date responses for the selected zone only, and the 
90th Percentile Performance gauges update to reflect the selected responses. 

3. At the bottom of the dashboard, click the Responding Company tab. 

Note: 

The chart shows the number of responses for each company within the selected 
response zone. Any responses by companies from other stations are indicated by the 
name of the responding company. 

4. Click the column for one of the responding companies from another fire station to see 
how the 90th Percentile Performance gauges change. 

5. Click the same responding company to remove the filter. 

6. At the bottom of the dashboard, click the Response Zone tab to compare the number of 
responses for each company within the selected response zone. 

7. At the bottom of the dashboard, click the Response by Date tab to examine the dates 
when the response times exceeded the standard with the selected response zone. 

8. Reset all filters when you are done examining response-time performance by response 
zone. 

 

Examine performance outliers 
The Fire Incident Dashboard includes the ability to examine performance outliers and get 

details for those outliers. This information can be used to address any performance issues 

with the responding companies. 

In this topic, you’ll assume the role of a fire chief who will use the Fire Incident Dashboard to 

examine responses that exceed the performance standards for fire and emergency medical 

service (EMS) calls. 
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Identify performance outliers 
To address performance outliers, it is necessary to identify them. This process starts by 

reviewing performance for each station and then investigating which responses exceeded the 

standards. 

1. On the left, in the filter panel, click the Call Date drop-down list and choose Year to 
Date. 

The map now displays all responses in the current year for the entire service area. 

2. From the Station drop-down list, choose a fire station. 

3. At the bottom of the dashboard, in the Responding Company chart, select a responding 
company to review the 90th Percentile Performance gauges. 

4. Click another responding company to compare response performance, and then continue 
until you find a company that has exceeded the performance standard for the selected 
station and call date. 

5. Click the Response by Date tab to see the dates when the selected company exceeded 
the performance standard. 

6. In the Total response time chart, click a point above the red line to get the date and time 
for that response. 

 

Inspect performance outliers 
After you have identified the performance outliers you can inspect each one to determine the 

cause and response information. 

1. Near the bottom right corner of the dashboard, click the Performance Outliers tab. 

The performance outliers for the selected company will be listed for each performance 
objective. Each outlier is listed with the call date and time, company, and shift. The 
response time displayed in seconds. 

2. Under the Total response time list, click the response for the date identified previously. 

A pop-up opens for the selected performance outlier. 

3. Review the response information in the pop-up for the selected performance outlier. 

Tip: 

The NFIRS code in the pop-up's banner refers to the National Fire Incident Reporting 
System (NFIRS) code. This code is used to identify the type of incident. 

4. Notice the fire station, company and shift information for the selected response. 

5. Review the address and cause for the incident. 

6. In the pop-up. scroll to review the response details including the response phases and 
incident time. 

This information can be used to discuss the performance issue with the responding company. 
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Fire Safety Survey 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Fire Safety Survey 
Fire Safety Survey can be used to conduct residential dwelling fire safety surveys that are part 

of a community’s risk reduction program. 

It provides fire service agencies with a comprehensive inventory of dwellings that have been 

surveyed and any fire safety issues discovered during an inspection. Fire service agencies 

can use the inventory to prioritize inspection activities. This approach reduces staff time 

necessary to perform safety inspections and ultimately increases the effectiveness of risk 

reduction programs. Fire Safety Survey is typically implemented by fire service agencies that 

want to take a data-driven approach to risk reduction and safety programming. 

The Fire Safety Survey solution delivers a set of capabilities that help you perform fire safety 

surveys and monitor the progress of firefighters performing routine fire safety surveys. 

 

Requirements 
Fire Safety Survey requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 

 

Information products 
Fire Safety Survey includes the following information products. 

Item Description Minimum 
user type 

Fire Safety 
Survey 
Dashboard 

An ArcGIS Dashboards app used by fire personnel to 
monitor fire safety surveys occurring in a community 

Viewer 

Fire Safety 
Survey 

An ArcGIS Field Maps web map used by fire personnel to 
conduct dwelling fire safety surveys that are part of a 
community’s risk reduction program 

Mobile 
Worker 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 413 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Fire Safety Survey Dashboard. 

• A new Fire Safety Survey. 

1.0 • First release of Fire Safety Survey 
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Configure Fire Safety Survey 
The Fire Safety Survey can be used by fire personnel to conduct and monitor dwelling fire 

safety surveys that are part of a community’s risk reduction program. Some agencies may 

want to perform additional configuration of the solution to meet their organizational needs. In 

this topic, you will learn how to modify questions in the Fire Safety Survey and how to 

incorporate additional filters to the Fire Safety Survey Dashboard. 

 

Modify Fire Safety Survey 
The Fire Safety Survey map for ArcGIS Field Maps is used by firefighters to perform fire 

safety surveys while inspecting a dwelling. To adjust the survey to the needs of your risk 

reduction program, add or delete fields from the FireSafetySurveys layer. Fire Safety Survey 

dashboard leverages a feature layer view that you must also update to reflect field changes. 

 

Add new survey question 
To add one or more fields to the FireSafetySurveys layer, complete the following steps: 

1. Sign in to your ArcGIS Online organization and click Content, if necessary. 

2. On the My Content tab, type firesafety in the search box. 

3. Click the Feature Layer item titled FireSafetySurveys. 

4. Click the Data tab. 

5. Click the Fields toggle button. 

6. Click the Add button to create a field. 

7. Define the Field Name, Display Name, Field Type, and Length, and click Add New Field. 

8. Follow the Update feature layer view section below to update your feature layer view to 
reflect the changes made to the layer. 

 

Delete survey question 
To delete one or more fields from the FireSafetySurveys layer, complete the following steps: 

1. Sign in to your ArcGIS Online organization and click Content, if necessary. 

2. On the My Content tab, type firesafety in the search box. 

3. Click the FireSafetySurveys feature layer item and click the Data tab. 

4. Click the check box next to the display name of the fields to delete. 

5. Click the Delete button above and to the right of the field list. 

6. Follow the Update feature layer view section below to update your feature layer view to 
reflect the changes made to the layer. 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 415 

Update feature layer view 
To update the feature layer view to reflect field changes you have made by adding or deleting 

a field, complete the following steps: 

1. Browse to the FireSafetySurveys_dashboard feature layer view item. 

2. Click Visualization 

3. Click the More Options button on the layer, click Set View Definition, and select the 
Define Fields option. 

4. Scroll to the newly created fields and check the boxes. 

5. Click Apply. 

  The new fields are now added to the view’s definition and are visible in the Fire Safety 
Survey Dashboard. 
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Use Fire Safety Survey 
The Fire Safety Survey solution delivers a set of capabilities that help you perform fire safety 

surveys and monitor the progress of firefighters performing routine fire safety surveys. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Conduct Fire Safety Survey 
Fire Safety Survey allows firefighters in the field to conduct fire safety surveys of dwellings 

using a smartphone or tablet. 

In this workflow, you’ll learn how to use the Fire Safety Survey map in ArcGIS Field Maps to 

document a fire safety survey during a dwelling inspection. You will assume the role of a 

firefighter. You are asked to use the ArcGIS Field Maps mobile app to access your Fire Safety 

Survey map and document fire safety inspections you perform in the field. 

1. If necessary, download ArcGIS Field Maps onto your mobile device. 

2. On your mobile device, open the app, and then sign in to your ArcGIS organization. 

3. Tap Fire Safety Survey to open the map. 

4. Search for an address, and then, in the results list, tap the address to zoom to that 
location on the map. 

5. Tap the plus sign or Collect Here to open the survey form.  

Note: 

Your interface will vary depending on the type of mobile device that you use. 

6. Tap Yes to collect survey information. 

7. Complete the form with as much information as possible. 

8. At the upper right, tap the check mark or Submit to submit the form. 

If necessary, a submitted form can be edited. 

9. On the map, tap the point to open the form. 

10. At the lower left, tap Edit, and then make any necessary changes to the form. 

11. Tap the check mark or Submit to resubmit the form. 

12. At the lower right, tap More Options to see additional options. 

13. At the lower middle, tap Copy to complete another survey and add it to the map. 
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Monitor Fire Safety Survey inspections 
The Fire Safety Survey Dashboard can be used by fire department personnel to monitor the 

progress of the fire safety program. It allows the viewer to see the locations where surveys 

were completed. You can also use it to find areas at risk in the community. 

You will now assume the role of fire command staff to monitor how many safety inspections 

have been completed and review the results of those surveys. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Fire Safety 
Survey solution. 

2. View the Fire Safety Survey Dashboard app. 

On the right, in the Surveys panel, all submitted inspections are listed. At the top of the 
panel, the total number of surveys appears. 

3. On the left, use filters to refine the results by occupant type, survey status, or date. 

When you filter results, the bar chart and number of surveys in the Surveys panel 
update. 

4. On the right, click an inspection address to zoom to that location on the map. 

5. Click the point on the map to open a pop-up with information collected for that location. 

This information can be useful in preparing for any necessary follow-up visits. 

6. Below the map, review the chart to see the number of smoke detectors installed and 
batteries provided. 

This information helps you to understand how many smoke detectors may be installed 
but not working correctly. 

7. On the map, close the pop-up, and then in the Surveys panel, click the inspection 
address again to reset the map. 

8. On the left, for Survey Completed, choose No. 

No data appears in the chart area. The locations listed in the Surveys panel require 
follow-up visits to complete the surveys. 

9. On the left, in the filter panel, uncheck any Occupant Type check boxes and for Survey 
Completed, click All. 

10. For Surveyed On, click the drop-down arrow and choose Between the dates. 

11. Set start and end dates to filter for all surveys completed within that time frame. 

12. Close the app. 
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Fire Service Maps 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Fire Service Maps 
Fire Service Maps can be used to produce wall maps and run books that are placed in a fire 

station or apparatus to assist with response activities. 

Fire personnel must understand their communities and quickly respond to calls for service. 

Delayed response times could result in the loss of life and property. While maps have made 

their way on to public safety mobile data computers (MDC), two primary hardcopy maps are 

still produced for reference in the fire service. Station wall maps are generally small scale 

maps hung on the wall of each fire station to help new personnel become more familiar with 

the service area. Run Books, on the other hand, are large scale maps that include a series of 

map pages along with a street index. They are combined in to a single map book and are 

placed in each apparatus to supplement maps provided on the MDC. Having an efficient way 

to produce station wall maps or run books ensure each hardcopy map product reflects 

changes that may occur in a community. Fire Service Maps is typically implemented by fire 

departments that want to quickly produce a standard set of hardcopy maps for their 

community. 

The Fire Service Maps solution delivers a set of capabilities that help you produce station wall 

maps and run books for each fire response district and combine them in single map book 

when necessary. 

 

Requirements 
Fire Service Maps requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later 

• ReportLab 3.4.0 or later 
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Information products 
Fire Service Maps includes the following information products: 

Fire 
Service 
Maps 

Description Minimum user 
type 

Fire 
Service 
Maps 

An ArcGIS Pro project used by fire fighters to produce wall 
maps and run books that are placed in a fire station or 
apparatus to assist with response activities. 

GIS 
Professional 
Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.3 • An update to the Fire Service Maps ArcGIS Pro project to resolve an issue 
with the replace layer tool. 

1.0 • First release of Fire Service Maps. 
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Configure Fire Service Maps 
In this workflow, you will learn how to configure the Fire Service Maps solution to meet 

specific needs in your organization. 

 

Configure Fire Service Maps project 
The Fire Service Maps solution includes an ArcGIS Pro project and sample data you can use 

to explore the sample data schema and a set of tools. When you are ready to configure the 

project, a series of tasks are included to help you review the data, make modifications to the 

maps and layers, load your data, and set the data sources to your data. 

1. Start ArcGIS Pro and open the Fire Service Maps project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service Maps 
task item. 

4. In the Task Pane, click the Configure Fire Service Maps task group to expand the 
collection of tasks. 

 

Review schema 
The Fire Service Maps project contains two geodatabases. 

2. Fire Service Maps Sample.gdb contains sample data for learning how to use the tools. 

3. Fire Service Maps.gdb contains empty layers fields that can be used to create Fire Run 
Books and Fire Station Wall Maps with your data. 

Use this task to review the geodatabase schema, layers, and fields to determine what 

changes you will need to make to use your data. See Fields, domains, and subtypes to learn 

more about how to edit the feature layer schema. 

 

Define spatial reference 
The Fire Service Maps.gdb is an empty geodatabase with the same schema and a spatial 

reference set to Web Mercator. This geodatabase can be used to define your spatial 

reference and load your data. 

Use this task to define the spatial reference for your data. See Specify a coordinate system to 

learn more about coordinate systems for your data. 

 

Load data 
After you have completed any necessary schema modifications, you can add your data layers 

to the map and load them into the empty Fire Service Maps geodatabase by following the 

steps in the Load data task. This task contains steps to load your data into the following 

layers: 
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Layer name Description 

Site Addresses Used to label building addresses in the fire service maps 

Roads Used to label road names and address ranges along a road. It is also 
used to create the street index report. 

Fire Response 
Restrictions 

Used to display the location of access restrictions such as gates, 
narrow roads, and blocked roads that would delay or preclude a fire 
truck in response to an incident 

Fire Map Index Used to create individual pages in Fire Run Books 

Response Areas Used to display administrative and response districts 

As you load your data into each layer, you will be given the option to use the field map 

capabilities to map your data fields to the predefined fields in the empty feature layers. 

 

Set data sources 
Use this task to replace the sample data with your data for each layer in the Fire Service Maps 

project. 
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Use Fire Service Maps 
The Fire Service Maps solution delivers a set of capabilities that help you produce station wall 

maps and run books for each fire response district and combine them in single map book 

when necessary. Fire Station Wall Maps can be produced for individual fire stations or 

combined into a single station wall map. Run books can also be produced for individual fire 

stations or combined into a single run book for the entire fire department. 

In this topic, you’ll learn how to use the Fire Service Maps solution by assuming the role of the 

user and performing these workflows. 

 

Understand Fire Service Maps 
While maps have made their way on to public safety mobile data computers (MDC), two 

primary hardcopy maps are still produced for reference in the fire service. Station wall maps 

are generally small scale maps hung on the wall of each fire station to help new personnel 

become more familiar with the service area. Run Books, on the other hand, are large scale 

maps that include a series of map pages along with a street index. They are combined in to a 

single map book and are placed in each apparatus to supplement maps provided on the MDC. 

To learn more about the elements contained in each fire service map, follow these steps: 

1. Sign in to your ArcGIS organization and browse to the Fire Service Maps Desktop 
Application Template. 

2. Open the item page and click Download. 

3. Unzip and open the Fire Service Maps ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service Maps 
task item. 

6. In the Task Pane, click the Getting to know Fire Service Maps task group to expand 
the collection of tasks. 

7. Click on the Understand Fire Service Maps task and follow the steps provided. 

 

Install ReportLab 
ReportLab is a third-party Python library that can be used to create a street index in PDF 

format. The street index makes it easy to look up an address or street name and find the 

correct map page in a Fire Run Book. To install ReportLab, follow these steps: 

1. Open the Fire Service Maps ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service Maps 
task item. 

4. In the Task Pane, click the Getting to know Fire Service Maps task group to expand 
the collection of tasks. 
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5. Click on the Install Report Lab task and follow the steps provided. 

 

Create fire run book 
Fire Run Books include a cover page, several map pages, and a street index for each fire 

response district. They can be printed, placed in each apparatus, and used en-route to a call. 

You will assume the role of a fire fighter responsible for producing a fire run book for your 

response district or fire department. The Fire Service Maps ArcGIS Pro project includes a 

series of tasks to help guide you through this workflow. 

1. Open the Fire Service Maps ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service Maps 
task item. 

4. In the Task Pane, click the Create fire run book task group to expand the collection of 
tasks. 

5. Click on the Create cover page task. Follow the steps provided in this task and all 
subsequent ones. 

 

Create station wall map 
Station Wall Map are large-format wall maps that can be printed for each fire response area 

and hung near an engine or apparatus. The printed wall maps are used by fire personnel for 

route navigation before leaving the station. 

You will assume the role of a fire fighter responsible for producing a station wall map for your 

response district. The Fire Service Maps ArcGIS Pro project includes a series of tasks to help 

guide you through this workflow. 

1. Open the Fire Service Maps ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service Maps 
task item. 

4. In the Task Pane, click the Create station wall map task group to expand the collection 
of tasks. 

5. Click on the Create station wall map task. Follow the steps provided in this task and all 
subsequent ones. 
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Flood Impact Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Flood Impact Analysis 
Flood Impact Analysis can be used to develop localized flooding scenarios and visualize the 

impact of flooding on public infrastructure, critical facilities, and vulnerable populations. 

The solution allows you to understand and visualize the impact of flooding on the community 

by using flood depth and elevation data to analyze the impact of river flooding, storm surge, 

tidal surge, and sea level rise scenarios. The results of the analysis can be used to plan road 

closures, prioritize evacuation areas, and develop mitigation strategies. Flood Impact Analysis 

is typically implemented by emergency management, public works, and planning 

organizations that want to prepare for future flooding to protect their communities. 

The Flood Impact Analysis solution allows you to prepare flood depth and elevation data, 

define flood impact areas, visualize the flood in 3D, and share the information with the public 

or other organizations. 

 

Requirements 
The Flood Impact Analysis solution requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later (Advanced) 

• ArcGIS 3D Analyst extension 

• ArcGIS Spatial Analyst extension 

 

Information products 
Flood Impact Analysis includes the following information products: 

Item Description Minimum User 
Type 

FloodImpactAnalysis.ppkx An ArcGIS Pro project package used by 
mapping technicians to create flood 
impact maps 

GIS Professional 
Advanced 
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Release notes 
The following are the release notes: 

Version Description 

1.2 • A new Flood Impact Analysis project to support ArcGIS Pro 3.0. 

• Resolved an issue with the Create 3D Flood tool that would cause it to fail on 
larger data sets. 

1.1 • Resolved an issue when a meter-based coordinate system is used with the 
Windows language set to other than English. 

1.0 • First release of Flood Impact Analysis. 
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Use Flood Impact Analysis 
The Flood Impact Analysis solution delivers a set of capabilities that help you to prepare flood 

depth and elevation data, define flood impact areas, visualize the flood in 3D, and share the 

information with the public or other organizations. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Get to know Flood Impact Analysis 
You will assume the role of a mapping technician responsible for analyzing the potential flood 

impact for your community. The Flood Impact Analysis ArcGIS Pro project includes a series of 

tasks to help guide you through these workflows. The first set of tasks will help you get to 

know Flood Impact Analysis. 

Get to know Flood Impact Analysis by completing the following steps: 

1. Start ArcGIS Pro and open the Flood Impact Analysis project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Getting to know 
Flood Impact Analysis task and go through each subtask. 

 

Understand the Flood Impact Analysis solution 
Flood Impact Analysis supports a series of workflows that streamline the process of 

developing flooding scenarios to help plan for a flood event. These workflows include 

preparing the data for analysis, defining the flood impact area and the impact on 

infrastructure, facilities and buildings, sharing the flood impact information, visualizing the 

flood impact in 3D, and sharing the impact in 3D. 

This task will introduce you to the capabilities, data requirements to analyze flood impact, and 

visualization in 3D. 

 

Download sample data 
Sample data is provided to help you learn how to use the Flood Impact Analysis solution. A 

link is provided to download sample data for Baltimore. Using the sample data the first time 

will help you learn how to use the tasks and how to organize your data. 

 

Start using Flood Impact Analysis 
The Flood Impact Analysis project includes a task workflow that provides a structured 

sequence using tasks and steps. Follow the steps in this task to learn how to use the Flood 

Impact Analysis solution. 
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How to use Flood Impact Analysis 
You will assume the role of a mapping technician responsible for creating the flood impact 

analysis and sharing the results with emergency management, public works, and planning 

agencies. The Flood Impact Analysis ArcGIS Pro project includes a series of tasks to help 

guide you through the workflows below. 

To conduct the flood impact analysis, complete the following steps: 

1. Start ArcGIS Pro and open the Flood Impact Analysis project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the How to use Flood 
Impact Analysis task. 

4. In the Task Pane, click the How to use Flood Impact Analysis task group to expand 
the collection of tasks. 

5. Follow the steps in each task. 

 

Prepare flood depth and elevation data 
Accurate analysis and visualization of the flood impact analysis will depend on several factors 

such as: availability of flood depth data in the form of raster, ground elevation data such as 

Digital Terrain Model (DTM) or lidar, and features describing the assets to be analyzed such 

as roads, bridges, and buildings. The data preparation workflow includes a series of tasks to 

help prepare the data for analysis. A description for each task in this group is listed below. 

 

Prepare flood depth rasters 
Flood depth data is necessary to determine flood impact to the community at each flood 

stage. Flood depth grids or raster files contain a flood depth value within each cell in the 

raster. Flood depth at a given point can help determine the impact to buildings, roads, or 

bridges. 

The risk value for each raster is read from the riskTypeTable for the chosen risk type. You can 

find the riskTypeTable in the FloodImpactAnalysis.gdb. You can use the existing risk types, 

modify them, or you can add another entry. 

To remove negative values, extract flooded areas, and create the flood depth geodatabase, 

follow the steps in the Prepare flood depth rasters task. 

 

Prepare a water surface elevation raster 
Water surface elevation (WSE) includes a value within each raster grid cell. However, the 

value describes the elevation of the water surface within each grid cell and is a measurement 

from a fixed zero elevation such as provided in the NAVD88 vertical datum. Water surface 

elevation data can be used to calculate bridge heights above flood stages and to visualize the 

flood stages as 3D surfaces. 
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To create a water surface elevation raster, extract flooded areas, and crate the water surface 

elevation input geodatabase, follow the steps in the Prepare water surface elevation raster 

task. 

 

Define flood impact 
Effective flood response planning begins with a better understanding of the potential flood 

impact. This task is designed to step through a standardized process to create and analyze 

the impact of each flood scenario on your community. A flood scenario can be defined in the 

risk type table as a percent chance of flooding, historical average such as 100 year, or 

number of feet above normal. A description for each task in this group is listed below. 

 

Create flood impact areas 
The flood impact area defines the geographic extent for each flood depth scenario. The flood 

depth data prepared in the Prepare flood depth and elevation data task group will be used 

to create the flood impact area. These flood impact areas will be the foundation for analyzing 

impact to buildings, roads, or bridges in each of the subsequent tasks. 

To create flood impact areas and add them to the map, follow the steps in the Create flood 

impact areas task. 

 

Analyze roads 
This task allows you to analyze impacted roads by calculating depth of flooding for each road 

segment for any number of flood levels. The flooded roads can be an impediment to 

successful evacuations for first responders and community members when it is unknown 

which roads will be impacted. You can also symbolize the impacted roads for each flood 

impact area. The result will be a new feature class representing road segments with a depth 

attribute for each flood scenario. 

To analyze impacted roads and symbolize the impact, follow the steps in the Analyze roads 

task. 

 

Analyze low water crossings 
This task allows you to calculate depth of flooding for each low-level crossing for each flood 

scenario. The result can be used to identify watch points for observers to report flood depth 

during the flooding event. The parameters for this step are similar to the road flood depth 

except for the buffer distance. If this distance is specified to be greater than zero, the analysis 

will run against the buffered input features. This parameter helps you find points within the 

buffer distance that have been misplaced. You can then symbolize the low-level crossings by 

flood depth. 

To identify low water crossings and symbolize the impact, follow the steps in the Analyze low 

water crossings task. 
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Analyze bridges 
Use this task to calculate the bridge height above flood water surface for each flood scenario. 

Some bridges may have one side that is lower than the other. The bridge geometry is needed 

to calculate the height above the water surface instead of a single point along the bridge. 

Therefore, the bridge needs to be a 3D polygon feature instead of a 2D feature. This task will 

extract bridge surfaces from a lidar point cloud as 3D polygons, so they can be used in the 

next task to determine the height above flood level. 

Note: 

This task requires lidar point data stored in a LAS dataset . The bridge surfaces must 
have a separate class code in the LAS dataset. 

Note: 

This task requires that you have a water surface elevation (WSE) geodatabase as 
described in the Prepare flood depth and elevation data task. 

Tip: 

The result of this task is a new point feature with the minimum height above water surface 
for each water level in the WSE geodatabase. You can label the point with the minimum 
height attribute value to show how much clearance there will be below the bridge or how 
deep the water will be over the bridge if the height above water has a negative value. 

To analyze impacted bridges and symbolize the impact, follow the steps in the Analyze 

bridges task. 

 

Analyze buildings 
Understanding building exposure to flooding can help response personnel prioritize 

evacuations and stage equipment where it can be used effectively. It can also help mitigation 

planners understand buildings that are good candidates for purchase and removal. Use this 

task to calculate flood exposure on building polygons or 3D building multipatch feature layers. 

The tool will use your water depth geodatabase and the specified risk type to calculate the 

flood depth exposure to each building within the flood impact area. You can then symbolize 

the features according to the calculated flood exposure attribute such as the flood depth. 

Using a graduated color ramp will allow you to illustrate the severity of the building exposure. 

To analyze impacted buildings and symbolize the impact, follow the steps in the Analyze 

buildings task. 
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Share flood impact information (optional) 
Once the analysis is completed, share the results with community stakeholders who can use 

the information to begin flood response or mitigation planning. Use this task to choose which 

flood impact layers to share, such as the flood impact area, impacted roads, bridges, and 

buildings for each flood scenario. Share the results for each flood scenario. 

Note: 

These tasks require ArcGIS Online or ArcGIS Enterprise 10.5 or later. 

To allow others to see the results of the analysis, follow the steps in the Share flood impact 

information task. 

 

Visualize flood scenarios in 3D (optional) 
The best way to communicate the impact of a flood scenario is to show how it will impact 

homes, streets, bridges, and neighborhoods. Visualizing the flood scenario in a 3D scene is a 

compelling way to communicate the potential flood impact in your community. 

Note: 

These tasks require ArcGIS Online or ArcGIS Enterprise 10.5 or later. 

 

Show flood impact map in 3D 
This task allows you to convert the map containing the results of the flood impact analysis to a 

3D scene using 3D symbology and scene elevation. A digital terrain model (DTM) raster can 

be added to the 3D scene to provide a realistic scene for illustrating the impact of the flood. 

 

Create 3D flood levels from raster 
This task allows you to create 3D flood levels from raster input data. The result is a 3D version 

of the 2D raster data. For example, you may want to show a flood impact area at 5 feet 

against a building to illustrate the depth of flood on the building. 

 

Source 3D basemap data (optional) 
Visualization of 3D flood levels is more powerful when shown together with other 3D layers 

such as 3D buildings, 3D trees, and detailed elevation. Use your organization's 3D basemap 

to complement your flood impact map. If your organization does not have a 3D basemap, use 

3D Basemaps to create your own 3D buildings, trees, and elevation surface. 
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Create a depth elevation raster 
A depth elevation raster can improve the visualization of flood impact in 3D scenes, 

particularly in flood scenarios with very shallow flooding. Use the Create depth elevation 

raster task to create the depth elevation raster. You can repeat this task for every water 

surface elevation (WSE) raster. 

To convert the map to a 3D scene and add the depth elevation raster, follow the tasks in the 

Visualize flood scenarios in 3D task group. 

 

Publish a 3D flood impact scene (optional) 
Once the task to visualize 3D flood scenarios is completed, you can publish a 3D web scene 

for your flood impact scenarios. The 3D web scene can be shared with stakeholders who are 

responsible for flood response planning and flood mitigation planning. 

Note: 

These tasks require ArcGIS Online or ArcGIS Enterprise 10.5 or later. 

 

Publish a 3D flood impact scene 
Use this task to set the coordinate system and publish the new 3D scene to ArcGIS Online or 

your organization. 

 

Share the depth elevation raster 
Use this task to share the depth elevation raster that was created previously to help improve 

the visualization of the 3D scene. 

To share the flood impact in 3D, follow the tasks in the Share 3D flood impact scene task 

group. 

After you have shared the 3D scene and depth elevation raster, you can view the results of 

the Flood Impact Analysis in a Scene Viewer in ArcGIS Online or ArcGIS Enterprise. Share 

the scene with your colleagues to help them understand the impact of local flooding on your 

community. 
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Homelessness Risk Reduction 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Homelessness Risk Reduction 
Homelessness Risk Reduction can be used to identify where regular reports of homelessness 

activity may originate and address regular reports of homelessness activity in a community. 

It provides the ability to leverage continual reports of individuals experiencing homelessness 

and encampments in the community and identify which areas are at risk for generating 

homelessness. This collaborative approach between the public and local government 

agencies help determine where resources can be deployed to assess the situation, offer 

services to persons experiencing homelessness, and determine if additional steps are 

required. Homelessness Risk Reduction is typically implemented by health and human 

services agencies that want to proactively address homelessness and connect individuals 

experiencing homelessness with available resources. 

The Homelessness Risk Reduction solution delivers a set of capabilities that help you 

understand where homelessness may originate in your community and actively monitor 

regular reports of homelessness so assistance can be offered to individuals in need. 

 

Requirements 
Homelessness Risk Reduction requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later (Advanced) 

• ArcGIS Geostatistical Analyst extension 
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Information products 
Homelessness Risk Reduction includes the following information products: 

Item Description Minimum user 
type 

Homelessness 
Activity Reporter  

An ArcGIS Survey123 form used by public safety 
staff, or the public, to report the locations of 
individuals experiencing homelessness and 
encampments in the community 

Mobile Worker 

Homelessness 
Activity Manager 

A Crowdsource Manager app used by homelessness 
program leads to manage reports of individuals 
experiencing homelessness and encampments in the 
community 

Editor 

Homelessness 
Activity Dashboard 

An ArcGIS Dashboards app used by health and 
human service agency and CoC directors to monitor 
reports of individuals experiencing homelessness 
and encampments in the community 

Viewer 

Homelessness 
Risk Reduction 

An ArcGIS Pro project used by GIS analysts to learn 
which areas in their community are at risk for 
generating homelessness and how to prioritize and 
site intervention programs 

GIS 
Professional 
Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 • Name changed from Homeless Risk Reduction to Homelessness Risk 
Reduction. 

• All layers, map, apps, and projects have been updated to use the term 
homelessness instead of homeless. 

• A new version of the Homelessness Risk Reduction ArcGIS Pro project that 
leverages an updated Create Risk Surface tool. 

1.1 • A new version of the Homeless risk Reduction ArcGIS Pro project that 
leverages the Enrich geoprocessing tool. 

1.0 • First release of Homeless Risk Reduction 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 434 

Use Homelessness Risk Reduction 
The Homelessness Risk Reduction solution delivers a set of capabilities that help you 

understand where regular reports of homelessness activity may originate in your community 

and actively monitor regular reports of homelessness so assistance can be offered to 

individuals in need. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Report homelessness activity 
You will assume the role of public safety staff, or a member of the public, that wants to report 

homelessness activity observed in a community. 

Follow these steps to report homelessness activity. 

1. In a browser, go to the Homelessness Activity Reporter survey. 

2. In the Homelessness Activity Reporter, provide the following information: 

Parameter Value 

Activity Observed Individual 

Details Type Observed new individual in the park 
with a tent and dog. 

Observed On Select a date 

Photo Add a photo 

Would you like to be contacted for 
more information? 

Select Yes 

Your Name Type your name 

Phone Number Type your phone number 

Email Type your email address 

Observed at Type location information of where you observed 
the activity. 

3. Click Submit. 

Note: 

While using the app in the field, you can use ArcGIS Survey123 mobile app to use your 
current location from your mobile device GPS. 
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Manage homelessness reports 
Health and human services personnel, public safety, and nonprofit organizations can use  

Homelessness Activity Manager and  Homelessness Activity Dashboard to monitor, verify, 

and assign homelessness reports to agencies responsible for resolving health and safety 

concerns or providing aid to individuals and families experiencing homelessness. 

You’ll assume the role of a homelessness program lead that wants to manage reports of 

homelessness in the community. 

1. In a browser, go to the Homelessness Activity Manager. 

The Homelessness Activity Manager shows a list of all reports that were made. 

2. In the table, highlight the first record in the table. Verify this is the record you just 
submitted via the Homelessness Activity Reporter . 

3. On the dialog box, in the lower left, click the Edit record button. 

4. Change the Status to Submitted, if necessary. 

5. In the Assigned To field, select Health and Human Services. 

Note: 

In many cases, individual follow up may be needed to further document and add to 
ensure you are capturing an accurate representation of homelessness in your 
community. 

6. Scroll down, if necessary, and click Save. 

Note: 

If you want to automate this process more, you can automatically send emails to 
individuals that are assigned. Refer to the Survey 123 Webhooks document to learn 
more. 

 

Visualize homelessness 
You’ll assume the role of a health and human service agency, or CoC, director that wants to 

view the current state of homelessness activity in your community. 

1. In a browser, go to the Homelessness Activity Dashboard app. 

2. On the left under Type, check Individual. Explore the various filtering capabilities. 

3. On the left under Date Observed, choose Last 7 days. 

Note: 

You see the report you submitted in the first workflow. 
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4. Close the dashboard when you are done exploring the Homelessness Reports. 

 

Identify risk of homelessness 
Data analysts can use the Homelessness Risk Reduction ArcGIS Pro project to learn which 

areas in their community are at risk for generating homelessness and how to prioritize site 

intervention programs. It leverages authoritative data and uses indicators such as 

unemployment rate, rental prices, public assistance, health insurance coverage, minority 

population, and number of veterans to compute a vulnerability to homelessness layer. The 

resulting risk surface is then used to prioritize intervention program siting. The results of this 

tool can be used as a foundation for public education and awareness campaigns, operational 

improvements, and policy discussions across an entire community. 

 

Identify areas at risk 
You’ll assume the role of a GIS analyst in a health and human service agency that wants to 

evaluate where homelessness may originate in a community and use the results to guide 

policy discussions. 

1. Open the Homelessness Risk Reduction ArcGIS Pro project and sign in to your ArcGIS 
organization. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand Tasks and double-click the Homelessness Risk 
Reduction task. 

4. Open the Identify areas at risk of generating homelessness task. 

This task contains steps to help you define the homelessness risk criteria. 

5. In the Add risk factor point data step, select the following information. 

• In the Target Features parameter, select Census Naperville. 

• In the Join Features parameter, select Assault. 

• In the Output Feature Class parameter, browse to Databases to open the 
HomelessnessRiskReduction.gdb and type JoinedAssaults for the feature class in 

the Name text box. 

6. Click Run 

7. Click Next Step. 

8. Click the Contents tab. 

9. Right-click the output layer from the Spatial Join tool and choose Attribute Table. 

10. Right-click Join_Count and choose Fields. 

11. Change Join_Count field name and field alias to AssaultCount. 

12. Delete the TARGET_FID field the tool created. 

13. On the Fields tab, in the Changes group, click Save. 
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14. Close the attribute table and fields table. 

15. Click the Tasks tab. 

16. Click Next Step to continue. 

17. In the Add key demographic data step, fill out the information below. 

• In the Input Features parameter, click the drop-down menu and choose 
JoinedAssaults. 

• In the Output Feature Class parameter, browse to Databases to open the 
HomelessRiskReduction.gdb and type EnrichedDemographicData for the feature 

class in the Name text box. 

18. Click Save. 

19. To add additional variables, click the Add button and browse to your variable of interest. 

20. Click OK. Repeat this step to add the remaining variables. 

21. Click the Remove variables button. 

22. Click Run. 

23. Click Next Step. 

24. In the Create homelessness risk surface step, fill out the information below. 

• In the Input Features parameter, click the drop-down menu and select 
EnrichedDemographicData or your own data set. 

• In the Output Feature Class parameter, browse to Databases to open 
HomelessnessRiskReduction.gdb and type HomelessnessRiskSurface for the 

feature class in the Name text box. 

25. Click Save. 

26. In Risk Factors (High Value), click the drop-down menu and choose all your high to low 
ranking variables. 

27. In Risk Factors (Low Value), click the drop-down menu and choose all your low to high 
ranking variables. 

28. Click Run. 

Note: 

The AssaultCount field was created in a previous step after performing the join. 

Based upon the factors you specified, you will see a new Risk layer appear that ranks the 
polygons from high to low. You can run the previous task multiple times ranking values 
differently. In many cases you may want to provide more inputs for data you are tracking 
in addition to assaults, such as known individuals that your organization has perhaps 
been assisting, or areas of renting issues. 

29. Click the Prioritize prevention program locations task. 

30. In Program Design step, fill out the information below. 
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• In the Input Features parameter, click the drop-down menu and choose 
HomelessnessRiskSurface. 

• In the Output Feature Class parameter, browse to Databases to open 
HomelessRiskReduction.gdb and type VulnerableSurvivorsPrograms for the 

feature class in the Name text box. 

31. Click Save. 

32. In the Contributing factors parameter, click the drop-down menu and choose 
AssaultCount and ACS HHs w/Public Assist Income:Percent. 

33. Type Assist Vulnerable Survivors in the Program Name text box. 

34. Type a value in the Number of Results text box. 

35. Click Run. 

Repeat the above for any other programs. Use the output from your previous run as the 
Input Features. 

36. Click Next Step. 

The result is prioritized locations where a new program can be placed, such as a 
woman’s shelter. 

Note: 

The next step allows you to finalize the program rankings. You may have many specific 
programs you want to act upon. Prioritizing helps you better focus your efforts. 

37. Share the map as a web layer. 

This allows others in your organization to see the prioritized risk factors. 
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Invasive Pest Inspections 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Invasive Pest Inspections 
Invasive Pest Inspections can be used to establish and inspect invasive pest monitoring sites. 

It streamlines the inspection of invasive pest monitoring sites that help detect and track the 

spread of invasive pests. This accelerated approach increases the likelihood of detecting 

harmful plant pests and diseases before they have an opportunity to cause significant damage 

to agriculture commodities. Invasive Pest Inspections is typically implemented by agriculture 

agencies that want to take a data-driven approach to monitoring invasive pests and diseases. 

The Invasive Pest Inspections solution delivers a set of capabilities that help you establish 

invasive pest monitoring sites, conduct invasive pest inspections, and monitor invasive pest 

programs. 

 

Requirements 
Invasive Pest Inspections requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Basic, Standard, or Advanced) 

• ArcGIS Survey123 

• Survey123 Connect 
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Information products 
Invasive Pest Inspections includes the following information products: 

Item Description Minimum user 
type 

Invasive Pest 
Survey: New 
Site 

An ArcGIS Survey123 form used by mobile workers to 
establish a new agricultural pest monitoring site 

Mobile Worker 

Invasive Pest 
Survey: Site 
Visit 

An ArcGIS Survey123 form used by mobile workers to 
conduct field inspections at an existing monitoring site 

Mobile Worker 

Invasive Pest 
Survey: New 
Site Map 

A map used by agriculture staff to create multiple 
agricultural pest monitoring sites at a single location 

Editor 

Invasive Pest 
Viewer 

An ArcGIS Web AppBuilder app used by agriculture 
program managers to identify the impact of a suspected 
pest infestation on agricultural commodities and human 
populations 

Editor 

Invasive Pest 
Status 

An ArcGIS Dashboards app used by agriculture 
program managers to monitor pest inspections and 
ensure monitoring sites are meeting federal and state 
goals 

Viewer 

Invasive Pest 
Reports 

An ArcGIS Pro project used by mapping technicians to 
create invasive pest inspection reports 

GIS 
Professional 
Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Invasive Pest Inspections 
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Configure Invasive Pest Inspections 
In this topic, you will learn how to configure the Invasive Pest Inspections solution to meet 

specific needs in your organization. 

 

Load data 
Invasive Pest Inspections can be used to establish and inspect invasive pest monitoring sites. 

In some cases, you may have this information in ArcGIS or another business system already. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or applications. 

Once you have determined what source data must be loaded, complete one of the data 

loading workflows below. 

 

Load data from a shapefile 
You can load data for InvasivePestSurveys, AgricultureLayers, PublicSafetyLocations, and 

TreatmentExemptions from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer that you want to populate. 

3. On the feature layer item page, click Update Data and choose Append Data to Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Create a monitoring site without existing information 
Optionally, you can create a monitoring site using the site form in ArcGIS Survey123. Before 

using this method, you must complete the subsequent Update Survey123 Connect forms 

configuration workflow. 

To create a monitoring site without using existing information, complete the following steps: 

1. Open ArcGIS Survey123. 

2. If the Invasive Pest Survey: New Site survey has not yet been downloaded, browse to 
Download Surveys on the main menu. 

3. Search for the Invasive Pest Survey: New Site survey that you published and click to 
download it. After it downloads, return to My Surveys. 

4. Select the Invasive Pest Survey: New Site survey to open it. 

5. Click the Collect button to create a monitoring site. 

6. Complete the survey by answering all the questions, including information about the 
program this site will support, the monitoring site and site contacts, the species being 
targeted, and the type of inspections that will take place at this monitoring site. 

Note: 

The form exposes more questions depending on your answers; for example, trap 
information is required if the inspection type includes trapping. 

7. Click the check mark to submit the survey. 

 

Create a monitoring site at an existing location 
You may want to create many monitoring sites at one site. To do this, you can use information 

in an existing monitoring site to prepopulate the ArcGIS Survey123 form. Before using this 

method, you must complete the subsequent Update Survey123 Connect forms configuration 

workflow. 

1. Open the Invasive Pest Survey: New Site Map. 

2. Search for an existing site using its site ID in the search bar. 

3. With the pop-up open for the existing site, click the link to launch the Invasive Pest 
Survey: New Site. 

4. When prompted, click to open ArcGIS Survey123.  

The form opens with the site information prepopulated. 

5. Complete the rest of the information in the form, including information about the program 
this site will support, the species being targeted, and the type of inspections that will take 
place at this site. 

6. Click the check mark to submit the survey. 
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Update Survey123 Connect forms 
Though the Invasive Pest Survey: New Site and Invasive Pest Survey: Site Visit forms have 

been configured to gather comprehensive information on an invasive pest inspection, you 

must make two updates to ensure local accuracy. 

 

Update surveyor names in the New Site and Site Visit survey forms 
To update the surveyor names visible in each form, complete the following steps: 

1. Download and install Survey123 Connect. 

2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Invasive Pest Survey: New Site to download the form, if necessary. 

4. Click Invasive Pest Survey: New Site again to open the form. 

5. In the left panel, click XLSForm. 

The XLSForm spreadsheet opens in Microsoft Excel. 

6. In the spreadsheet, click the Choices tab. 

This tab comprises all the selectable options for survey questions. 

7. In the list_name column, scroll to surveyors, and then add or remove names and labels 
as needed. 

8. Click Save to save the spreadsheet. 

9. In Survey123 Connect, on the Form tab, preview your changes. 

10. If necessary, return to the Microsoft Excel spreadsheet and make additional edits, and 
then click Save. 

11. In Survey123 Connect, on the left, click Publish, and then click Publish survey to 
publish your changes. 

12. Repeat these steps to update surveyor names in the Invasive Pest Survey: Site Visit 
form. 

 

Update the species target list in the New Site and Site Visit survey 
To update the species target list visible in each form, complete the following steps: 

1. Download and install Survey123 Connect. 

2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Invasive Pest Survey: New Site to download the form, if necessary. 

4. Click Invasive Pest Survey: New Site again to open the form. 

5. In the left panel, click XLSForm. 

The XLSForm spreadsheet opens in Microsoft Excel. 

6. In the spreadsheet, click the Choices tab. 

This tab comprises all the selectable options for survey questions. 
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7. In the list_name column, scroll to target_species, and then add or remove names and 
labels as needed. 

8. Click Save to save the spreadsheet. 

9. In Survey123 Connect, on the Form tab, preview your changes. 

10. If necessary, return to the Microsoft Excel spreadsheet and make additional edits, and 
then click Save. 

11. In Survey123 Connect, on the left, click Publish, and then click Publish survey to 
publish your changes. 

12. Repeat these steps to update the species target list names in the Invasive Pest Survey: 
Site Visit form. 
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Use Invasive Pest Inspections 
The Invasive Pest Inspections solution delivers a set of capabilities that help you establish 

invasive pest monitoring sites, conduct invasive pest inspections, and monitor invasive pest 

programs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Conduct invasive pest inspections 
The Invasive Pest Survey forms support capturing information about existing or new 

monitoring sites and keeping a record of site visits throughout a season. The survey forms 

were designed to capture information required for the Cooperative Agricultural Pest Survey 

(CAPS) or Farm Bill programs and in a format to report details from site visits to the National 

Agricultural Pest Information System (NAPIS). 

After monitoring sites have been established, an abbreviated version of the Invasive Pest 

Survey form can be used to streamline the process for field inspectors. In this workflow, you 

will assume the role of an inspector who will use the ArcGIS Survey123 inbox to load your 

planned visits into the application, and then you will complete the streamlined form for each 

monitoring site from the field. 

1. On a mobile device, in ArcGIS Survey123 open the Invasive Pest Survey: Site Visit form. 

Tip: 

If the Invasive Pest Survey: Site Visit survey has not yet been downloaded, browse to 
Download Surveys on the main menu. Search for the Invasive Pest Survey: Site Visit 
form that you published and click to download it. After it downloads, return to My 
Surveys and tap the form to open it. 

2. Tap Inbox and, if no surveys appear, click Refresh. 

3. Find your site in the list or tap Map to find sites near you.  

4. After you find your site, tap it to open the form.  

The form opens with the site information prepopulated. 

5. Complete the rest of the information in the form. 

6. Click the check mark to submit the survey. 

7. Repeat these steps to conduct additional inspections as necessary. 
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Monitor invasive pest status 
Now, you will assume the role of an agriculture program manager who will use the Invasive 

Pest Status dashboard to monitor pest inspections. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Invasive Pest 
Inspections solution. 

2. View the Invasive Pest Status dashboard. 

On the right, in the Monitoring Sites panel, all of the monitoring sites are listed. At the 
top of the panel, the total number of sites appears. 

3. On the left, use filters to refine the results for site status, pest status, species, and survey 
type. 

The results on the map and in the Monitoring Sites panel update. 

4. At the bottom right, click the Inspections tab and review the inspection details. 

5. At the bottom middle, click the Monthly Comparison tab and review the metrics. 

 

View invasive pest impact 
Next, you will continue the role of an agriculture program manager who will now use the 

Invasive Pest Viewer app to identify the impact of a suspected pest infestation on agricultural 

commodities and human populations. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Invasive Pest 
Inspections solution. 

2. View the Invasive Pest Viewer app. 

3. Use the provided drawing tools to select an area of interest. 

4. View the results to understand the potential impact of invasive pests for the selected 
area.  

 

Export surveys for NAPIS reporting 
Invasive Pest Reports allows you to export information captured during field inspections for 

the CAPS or Farm Bill programs into a format that can be used to report monitoring activities 

to the NAPIS database. 

This workflow will guide you through exporting field surveys and transforming the data 

structure for use in reporting to the NAPIS database. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Invasive Pest 
Inspections solution. 

2. Download the Invasive Pest Reports desktop application template, and then unzip the 
folder. 

3. From the unzipped folder, open the InvasivePestReports.aprx file in ArcGIS Pro. 
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4. In the Catalog pane, expand the Tasks folder, and then double-click the Invasive Pest 
Monitoring task. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand How to Use Invasive Pest Reports, if necessary, and then 
double-click the Export Surveys for NAPIS Reporting task to begin. 

6. Follow the instructions in the task to export survey responses to a NAPIS report. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 448 

Know Your Zone 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Know Your Zone 
Know Your Zone can be used to share multitiered evacuation zones established to help 

residents evacuate when a hurricane or storm occurs. 

The solution provides round-the-clock access to an organization, and the location-enabled 

search helps residents quickly find evacuation zone information. This transparent approach 

improves communication with the public and promotes efficient use of transportation and 

public safety resources. Know Your Zone is typically implemented by emergency 

management agencies that want to avoid unnecessary evacuation travel, reduce congestion 

on traveled ways, and ease overcrowding at storm shelters. 

The Know Your Zone solution delivers a set of capabilities that help you to share evacuation 

zones and promote current evacuation instructions when an order is issued. 

 

Requirements 
Know Your Zone requires the following: 

• ArcGIS Enterprise 

 

Information products 
Know Your Zone includes the following information products: 

Item Description Minimum 
user type 

Know 
Your 
Zone 

An ArcGIS Web AppBuilder app used by the public so residents 
can determine which evacuation zone they reside in and obtain 
evacuation notices when issued 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Know Your Zone 
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Configure Know Your Zone 
In this topic, you will learn how to configure the solution to meet specific needs in your 

organization and load your data if needed. 

 

Load evacuation zones 
You may have evacuation zones that you would like to use in the Know Your Zone solution. 

To do so, you will need to load your data into the evacuation layer schema provided with the 

app. 

Note: 

To append your data, it must be in a shapefile format. 

To load your facilities information from another data source, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Know Your Zone in the search box. 

4. Under Item Type, click Layers, then click Feature Layers. 

Note: 

Some of the feature layers have a suffix such as public. These are layer views of the 
original source feature layer. These layer views are used to share information with the 
public without showing all the details or allowing the public to edit the layers. The 
original source layers do not have a suffix. 

5. Click the title of the original source layer into which you want to load data to view the item 
details. 

6. Click Update Data, then click Append Data to Layer. 

7. Under Filename, choose your shapefile. 

8. Click Upload, then click Continue. 

9. Click Show field matching to match the fields from the spreadsheet to the fields in the 
selected feature layer. 

10. After you have matched the fields, click Apply Updates. 

11. Click the Data tab on the banner of the item page to confirm your data has loaded 
successfully. 
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Tip: 

If you plan on using the Know Your Zone app to communicate active evacuation notices, 
you will need to set the Active Incident field in the Evacuation feature layer to Yes to 
ensure it is visible on the map. 

Note: 

When you deploy the Emergency Management Operations solution and the Know Your 
Zone solution and both solutions are owned by the same user, the Evacuations layer is 
shared between both solutions. This allows the emergency evacuation status to be 
updated using the Operations Response app. The updates are visible in Know Your Zone 
and other apps that are part of the Emergency Operations solution. 

 

Enable evacuation status 
When a storm is approaching, emergency managers can configure Know Your Zone to 

identify zones that are most at risk. Evacuation status can be enabled on each high-risk zone. 

This information can be shared with the media and residents so they will know what zone they 

are in and when to evacuate. 

To enable evacuation status, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Know Your Zone in the search box. 

4. Open in Map Viewer the Know Your Zone web map. 

5. Turn on the Active Evacuation Notices layer. 

6. Turn off the Your Evacuation Zone layer. 

7. Click Save to save the map. 

8. Open the Know Your Zone web application item page and click Edit Application. 

9. On the banner at the top of the left panel, click the Widget button. 

10. Click Set the widgets in this controller. 

11. Click the edit button to edit the Find Your Zone widget. 

12. On the Search Settings tab, click Set, and check the box to add the Active 
Evacuations Notices layer to the search layers and uncheck the box to remove the 
Your Evacuation Zones layer. 

13. Click OK to the save the Select search layers changes. 

14. Click OK to save the changes to the Configure Find Your Zone window. 

15. Click Save to save the changes to the Know Your Zone web app. 
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Note: 

To test your changes, you will need to load some evacuation zones into both the 
multitiered evacuation zones and evacuations layers. You will need to populate the 
Evacuation Zone, Evacuations Type, and Starts fields to see the results. 

16. After you load data into the evacuations layer, open the web app to test the configuration 
changes. 

17. Enter an address or click a location within the orange evacuation areas. 

The result of the search will indicate the evacuation zone and status of the specified 
address. In this case, the address is in Evacuation Zone B and the status is Voluntary 
Evacuation Notice. 

18. Click one of the red evacuation areas (Evacuation Zone A). 
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Use Know Your Zone 
The Know Your Zone solution delivers a set of capabilities that help you to share evacuation 

zones and promote current evacuation instructions when an order is issued. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Find your zone 
Know Your Zone can be used by the public to locate an address or place and obtain 

information about the evacuation zone and current evacuation status of that location. Search 

for an address in the search bar or click a location directly on the map to define the location to 

be searched. 

In this workflow, you will assume the role of a resident in Baltimore who wants to know in 

which evacuation zone you're located. 

1. In a browser, from the Know Your Zone solution, view the Know Your Zone app. 

2. On the right, in the Find Your Zone panel, type the address. 

The map zooms to the location, and the result that displays in the panel indicates in 
which evacuation zone, if any, the address is located. 

You can also find evacuation zone information by clicking a point on the map. 

3. On the map, click a point. 

On the right, the results indicate in which evacuation zone, if any, the point that you 
clicked resides. 

4. Close the Know Your Zone app. 

Note: 

When a storm is approaching and evacuation orders are implemented, Know Your Zone 
can be configured to inform users of the current evacuation status of each zone. See 
Configure Know Your Zone to learn more. 
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Land Use Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Land Use Outreach 
Land Use Outreach can be used to share development regulations, construction activity, and 

solicit feedback on current land cases from the public. 

It provides 24/7 access to an organization and streamlines the development process. The 

inclusive approach increases public trust reduces the need to attend meetings in person, and 

helps government agencies harness feedback from the public to make better decisions about 

development in the community. Land Use Outreach is typically implemented by planning 

departments, public work agencies and other local government agencies that want to increase 

transparency and encourage public participation. 

The Land Use Outreach solution delivers a set of capabilities that help you share land use, 

zoning and other (for example, floodplain) regulations, generate awareness about permitted 

construction activity and engage the public when new developments are proposed. 

 

Requirements 
Land Use Outreach requires the following: 

• ArcGIS Enterprise 
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Information products 
Land Use Outreach includes the following information products: 

Item Description Minimum 
user type 

Land Use Inquiry An ArcGIS Web AppBuilder app used by the general 
public, developers, and real estate professionals to 
identify land use and zoning designations that impact the 
use of land 

Not 
required 

Floodplain 
Inquiry 

An ArcGIS Web AppBuilder app used by the general 
public, land development companies, and real estate 
professionals to locate parcels impacted by FEMA 
floodplain boundaries 

Not 
required 

Construction 
Activity Tracker 

An ArcGIS Web AppBuilder app used by the general 
public to track individual building permits and general 
construction activity 

Not 
required 

Public Comment A Crowdsource Polling app used by the general public 
and other interested parties to review land use cases or 
capital projects and submit feedback on a given case or 
project 

Not 
required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Land Use Outreach 
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Configure Land Use Outreach 
Learn how to configure the Land Use Outreach solution to meet specific needs in your 

organization. 

 

Load data 
Land Use Outreach can be used to share development regulations, construction activity, and 

solicit feedback on current land cases from the public. In some cases, you may have this 

information in ArcGIS or another business system already. 

Review the layers provided with the solution and determine what source data you want to 

load. Then load your existing data into the layers provided with the solution before sharing the 

maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 

workflow below. 

 

Load data from a shapefile 
Data for TaxParcels, SiteAddresses, ConstructionActivity, LandUse, Zoning, OverlayDistricts, 

and Floodzones can be loaded from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Land Use Outreach 
The Land Use Outreach solution delivers a set of capabilities that help you share land use, 

zoning and other (for example, floodplain) regulations, generate awareness about permitted 

construction activity and engage the public when new developments are proposed. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Locate a parcel impacted by a floodplain 
As the general public and real estate professionals search for properties, floodplain 

boundaries come into consideration so that informed decisions can be made during the land 

development and home buying processes. 

In this workflow, you will learn how to locate and view authoritative floodplain boundary 

information (DFIRM panels) provided by the Federal Emergency Management Agency 

(FEMA) using Floodplain Inquiry. You will assume the role of a resident in a local community. 

You want to see if a property you are interested in purchasing sits in a floodplain boundary. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Land Use 
Outreach solution. 

2. View the Floodplain Inquiry app. 

3. Search for a parcel number or address or click the location directly on the map. 

4. Review the property's details, such as the parcel number, address, and if the selected 
property is impacted by a flood zone. 

 

Identify land use impact 
As development occurs in a community, the general public, developers, and real estate 

professionals must identify land use and zoning designations that affect land use. 

In this workflow, you will learn how to locate and view current land use, future land use, and 

zoning designations using Land Use Inquiry. You will assume the role of a resident in a local 

community. You want to see what the current and proposed land use is for a particular 

property. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Land Use 
Outreach solution. 

2. View the Land Use Inquiry app. 

3. On the right, in the Locate Regulations widget, search for a parcel number or address 
or click the location directly on the map. 
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4. Review current land use, future land use, and current zoning designations. 

 

Review construction activity 
As development occurs in a community, the general public, developers, and real estate 

professionals must locate open, under review, approved, and closed building permits. 

In this workflow, you will learn how to track individual building permits and general 

construction activity. You will assume the role of a resident in a local community. You want to 

check the status of a recently submitted constriction permit. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Land Use 
Outreach solution. 

2. View the Construction Activity Tracker app. 

3. On the right, in the Locate Permit widget, search for an address, applicant name, or 
permit number or click the location directly on the map. 

4. Review the details and current status of the construction permit. 

 

Submit feedback in the Public Comment app 
As land use cases and capital projects are reviewed in a community, the general public and 

other interested parties can submit feedback on a given case or project. 

In this workflow, you will learn how to submit feedback and help make better development 

decisions in the community. You will assume the role of a resident in a local community. You 

want to submit feedback on a current land use case. 

1. In a browser, from the Land Use Outreach solution, view the Public Comment app. 

2. On the right, select a current case up for public comment; alternatively, click a case 
directly on the map. 

3. Review the details and current status of the case. 

4. Click the Add a comment button, complete the comment form, and click Submit. 
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Lead Service Line Inventory 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Lead Service Line Inventory 
Lead Service Line Inventory can be used to develop a lead service line inventory and monitor 

the replacement of service lines required to comply with the Environmental Protection 

Agency's (EPA) Lead and Copper Rule Revisions. 

Replacing lead service lines is the best way to reduce the risk of exposure to lead in drinking 

water across a community. Water utilities are required to create and maintain a lead service 

line inventory under the Lead and Copper Rule Revisions. Having authoritative information 

about the number and location of lead service lines is the first step in creating a lead service 

line removal program to safeguard the health of the community. Lead service line inventory is 

typically implemented by water utilities that want to quickly begin mapping lead service lines 

and monitoring compliance with federal regulations. 

The Lead Service Line Inventory solution delivers a set of capabilities that help you inventory 

lead service lines, validate service line materials in the field, monitor replacement activities 

and regulatory compliance, and share information with the public. 

 

Requirements 
Lead Service Line Inventory requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 3.0 or later (Basic, Standard, or Advanced) 

• ArcGIS Field Maps 

• ArcGIS Survey123 Connect 
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Information products 
Lead Service Line Inventory includes the following information products: 

Item Description Minimum user type 

LeadServiceLineInventory An ArcGIS Pro project used by an 
editor to perform advanced service 
line editing. 

GIS Professional 
(Basic, Standard, 
Advanced) 

Lead Service Line Viewer An ArcGIS Web AppBuilder app 
used by office staff to view lead 
service line information. 

Viewer 

Lead Service Line 
Replacement Manager 

An ArcGIS Web AppBuilder app 
used by a manager to view the 
status of lead service mitigation 
activities. 

Editor 

Lead Service Line Editor An ArcGIS Web AppBuilder app 
used by an editor to update lead 
service line data. 

Editor 

Lead Service Line Public 
Viewer 

A map embedded in the ArcGIS Hub 
site used by the public to view lead 
service line information in the 
community. 

Viewer 

Lead Service Line Field Map An ArcGIS Field Maps map used by 
a mobile worker to add lead service 
line data. 

Mobile Worker 

Lead-Safe Community An ArcGIS Hub site used by the 
general public to view lead service 
line information. 

Not required 

Lead Service Line Dashboard An ArcGIS Dashboards app used by 
office staff to view and report lead 
service line status information. 

Viewer 

Service Line Self-
Assessment Manager 

A Crowdsource Manager app used 
by a manager to review incoming 
water service line material surveys. 

Editor 

Service Line Self-
Assessment Dashboard 

An ArcGIS Dashboards app used by 
a manager to view water service line 
survey results. 

Viewer 

Water Service Line Material 
Survey 

An ArcGIS Survey123 form used by 
the public to report their water 
service line material. 

Not required 
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Release notes 
The following are the release notes: 

Version Description 

3.0 • Updated the ServiceLine schema to align with EPA's August 4th, 2022 
Guidance for Developing and Maintaining a Service Line Inventory Template. 

• Updated Lead Service Line Dashboard. 

• Added a Lead Service Line Field Map and configured a form for field data 
collection. 

2.2 • The Minimal Gallery app has been removed from the solution item. 

2.1 • An update was made to the Lead-Safe Community site to include a link to the 
Water Service Line Material Survey. 

• Added a Service Line Self-Assessment Manager app, Service Line Self-
Assessment Dashboard app, and Water Service Line Material Survey. 

2.0 • Enabled attachments on all Service Line layers and views. 

• Updated the style file in the ArcGIS Pro project. 

1.0 • First release of Lead Service Line Inventory. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://links.esri.com/LeadServicelineInventoryTemplate


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 461 

Configure Lead Service Line Inventory 
Lead Service Line Inventory can be used to develop a lead service line inventory and monitor 

the replacement of service lines required to comply with the Environmental Protection 

Agency's (EPA) Lead and Copper Rule Revisions. 

The Lead Service Line Inventory solution can be configured to meet specific needs in your 

organization. The sections below outline some administrative tasks to update and manage the 

solution to fit your organization's needs. 

 

Provision users 
Included with Lead Service Line Inventory are four groups designed to help managers 

organize their members based on their privileges and their work. 

To add members to the groups, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization. 

Verify that you have privileges to manage member groups before continuing. 

2. Click Groups at the top of the site. 

3. Click the name of the group to open the group details pages. 

4. On the Settings tab, edit and update the properties of the group, including access, 
sharing properties, and group ownership. 

5. Click the Overview tab and click Invite users.  

6. Select the members you want to add and click Add to group. 

7. Repeat steps 3 through 6 for each group you need to add members to. 

The provided groups are intended to be utilized by members with a minimum of the following 

user types in order to fully use the provided maps and apps: 

Group name User type 

Lead Service Line 
Editors 

• Editor 

• Mobile Worker 

• GIS Professional Basic with ArcGIS Pro (minimum of one 
license recommended) 

Lead Service Line 
Viewers 

• Viewer 

Lead Service Line Public 
Viewers 

• Viewer 

Lead Service Line 
Survey 

• Not required 
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Configure Lead Service Line Inventory site 
The Lead Service Line Inventory solution includes the Lead-Safe Community ArcGIS Hub site 

that your organization can configure with your branding and can use to share information 

about lead service information with the public. 

 

Update with organizational information 
After deploying the Lead Service Line Inventory solution, the Lead-Safe Community site layout 

only requires a few updates to fit your local context. Consider what information you already 

have and what you can most easily find. Update the information by completing the following 

steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Lead-Safe 
Community site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Statistics section under the title of the website.  

5.  Update each card by hovering over the card and clicking the edit button . A pane 
appears where you can make changes to the colors, images, text. and more. 

6.  Click Layout to add additional cards to the site and select from the list of options. 

7. Click Customize to access Settings, Theme, Header, Layout, and Footer options.  

8. Make the necessary changes and click Apply. 

9. Click Save. 

To learn more about sites, review What is a site? 

 

Configure Lead Service Line project 
The Lead Service Line ArcGIS Pro project includes a Lead Service Line Editor map which is 

ready to be connected to your published service. 

1. In ArcGIS Pro, sign in to your ArcGIS organization. 

2. To open the LeadServiceLineInventory project, click Open another project, click My 
Content under Portal, double-click the Lead Service Line Inventory folder, click 
LeadServiceLineInventory, and click OK. 

3. In the Contents pane, click the error notification button  next to the Service Line layer. 

  The Change Data Source dialog box appears. 

4. Click My Content under Portal, double-click the Lead Service Line Inventory folder, 
double-click the LeadService_editing feature service, and double-click the Service Line 
layer.  
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5. In the Contents pane, right-click the Lead Service Line Editing map and click 
Properties. 

6. Click the Coordinate Systems tab. In the XY Coordinate Systems Available section, 
select the coordinate system that matches the layers in the map. 

Note: 

Ensure the coordinate system of the map matches that of the feature layers deployed 
in the solution. If they do not match, there may be discrepancies in what units are 
displayed in the map. 

7. Click Save to save the project. 

 

Share items with public 
Several layer views, maps and apps included in the Lead Service Line Inventory solution must 

be shared with everyone so they can be accessed by the public on the Lead-Safe Community 

site. To share your lead service line items with everyone, use the guide below and complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Lead Service 
Line Inventory folder. 

2. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) ServiceLine_viewing 

Feature Layer (hosted, view) Service Line Self-Assessment_customer 

Web Map Lead Service Line Public Viewer 

Web Mapping Application Lead Service Line Public Viewer 

Site Application Lead-Safe Community 

Form Water Service Line Material Survey 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

Note: 

Warning: Sharing editable layers publicly appears notifying that you are sharing 
editable layers publicly. 

5. Click Update. 
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Add utility map layers (optional) 
The Lead Service Line Inventory solution is configured with what you need to manage your 

lead inventory. Adding your organizations water asset layers to the maps can enhance the 

solution by providing additional awareness of existing assets. The steps below provide 

information about adding your organizations water feature layers to the following maps. 

1. Open the Lead Service Line Viewer map by clicking Open in Map Viewer Classic.  

2. Add your organizations water asset data to the map. 

Note: 

Consider configuring layer names and pop-ups to meet your organizations needs. 

3. Click Save > Save to save the map. 

4. Repeat as needed with the following maps: Lead Service Line Editor and Lead Service 
Line Replacement Manager. 
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Use Lead Service Line Inventory 
The Lead Service Line Inventory solution delivers a set of capabilities that help you inventory 

lead service lines, validate service line materials in the field, monitor replacement activities 

and regulatory compliance, and share information with the public. 

 

Understand service line symbology 
Lead Service Line Inventory has been created with multiattribute symbology to display both 

utility-owned and customer-owned service line information. The left side of the symbol always 

represents a utility-owned service line and the right side represents a customer-owned service 

line. This symbology cannot be easily changed once the solution is deployed and is best left 

as designed. The symbology is broken down into four color categories that represent the lead 

service line status. 

The lead status categories are as follows: 

• Red—Lead 

• Yellow—Galvanized Requiring Replacement 

• Blue—Non-Lead 

• Gray—Unknown 

The legend includes the combinations of all of these options as shown in the image below. 
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In addition to the multiattribute symbology, the lead service line point includes a label that 

identifies unverified lead service lines with a dot. The dot will be located on either the utility 

side, the customer side, or both sides of the symbol depending on whether the service lines 

have been verified in the field. The image below shows the various configurations of unverified 

lead service line points. 

 

 

Develop service line inventory 
Water utilities are tasked with completing an inventory of their water systems to ensure there 

are no lead pipes present in their systems. These workflows provide various ways to collect 

and document the lead service line information. 

 

Add lead service line points 
Lead information can be stored in various forms, such as tap cards, paper maps, or other 

digital assets. These sources of information should be added to a single repository to ensure a 

complete inventory of lead service lines can be maintained. 

As an editor, you want to use a web app to add lead service line status information to the 

map. 

1. In a browser, sign in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Lead Service Line Editors group and locate the Lead Service Line 
Editor app. Click View Application to launch the app. 
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In the Lead Service Line Editor app, the Smart Editor widget is open by default on the 
left side of the window. 

4. In the editing pane, click a template from the list of options to select it. 

5. With a point selected, click to add the point to the map. 

6. You are prompted to update attributes and click Save. 

7. Continue adding Service Line points, as needed. 

In the workflow below, you will be taking the role of an editor adding data in ArcGIS Pro. The 

workflow below can be completed in either the web or desktop environments, but if additional 

editing tasks need to be completed, such as loading data or conducting advanced analyses, 

ArcGIS Pro provides a more powerful environment to do this work. 

Note: 

The first time you open the Lead Service Line Editor map in ArcGIS Pro, the layers will 
show as broken. Follow the steps to Configure the Lead Service Line Editor ArcGIS Pro 
project to fix your layers. 

1. Open the Lead Service Line Inventory ArcGIS Pro project and sign in to your ArcGIS 
organization. 

2. In the Catalog pane, expand Maps and double-click Lead Service Line Editor to open 
the map. 

3. On the Edit tab, in the Features group, click Create. 

The Create Features pane appears. 

4. Click a template to select it and add it to the correct location on the map. 

5. On the Map tab, in the Selection group, click Attributes and fill in the remaining 
attributes. 

6. Repeat the steps above to add new lead service line points to the map. 

7. On the Edit tab, in the Manage Edits group, click Save to save your edits. 

 

Conduct field inventory 
In many cases, a field assessment of existing service line assets may be the most efficient 

way to develop a lead service line inventory. The information collected in the field can then be 

used to inform service line replacement and maintenance programs. 

You will assume the role of a mobile worker in a water utility. In this workflow, you will use 

ArcGIS Field Maps to collect lead service line information. 

1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Lead Service Line Field Map. 

3. Browse to the collection location. 

4. Tap Add .  
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5. From the list of features, add a feature from the template list of Service Line values. 

If the point is added to the wrong location, or you want to move the point manually, move 
the crosshairs to the correct location by panning the map and tapping Update Point. This 
moves the added point to the specified location. 

6. Fill in any attributes and tap Submit. 

  Ensure the following attributes are filled out, as they drive some of the dashboard 
indicators. 

• Entire Service Line Status 

• Utility Side Verified, Customer Side Verified 

• Replacement Status 

 

Manage service line replacement 
Water utilities need an inventory of their assets in order to proceed with lead mitigation efforts. 

Managers need to have a clear understanding of what service lines are at risk for lead, 

whether lines have been inspected by field technicians, or if they have been replaced due to 

lead. 

You will assume the role of a manager in a water utility. In this workflow, you want to use a 

web app to update common replacement fields such as Replacement Status, Scheduled 

Replacement Date, and Reason for Replacement. 

1. In a browser, sign in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Lead Service Line Editors group and locate the Lead Service Line 
Replacement Manager app. Click View Application to launch the app. 

In the upper right of the app, there are a number of widgets that can be used to view the 
legend, update the basemap, or print the map. The panel on the left side of the app 
includes a set of options to filter the lead service line points by replacement status and 
lead categories. 

4. Review the list of included widgets to learn how to use them to update and review lead 
service replacement status: 

• Filter—Use the Replacement Status and Lead Categories filters to view 
properties where service lines need replacement or by material category. Select 
an option from the drop-drown menu and turn on a filter to view the selection in 
the map. 

• Batch Attribute Editor—Select a group of lead service line points using one of 
the selection tools and update values for all the selected features at once. 

• Legend—View the included layer in the map. The legend displays what is visible 
on the map, so zooming in or out can expand or reduce the list if scale 
suppression is set on the layers. 

• Layer List—View a list of included layers with some additional capabilities to 
manipulate the layers. 
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• Basemap Gallery—Choose to update the basemap for the app. 

• Print—Use the print widget to save an image or PDF of the map. 

 

Monitor inventory and replacement 
Understanding how many lead service lines there are and progress on replacing identified 

lead service lines is important information that needs to be readily accessible. It may also be 

necessary to provide to regulators, so it is helpful to have a quick view of important metrics. 

Having a quick view of all of the key metrics related to lead service lines allows executives 

and managers to gain an understanding of their water system and lead mitigation efforts. 

As a member of the utility, you want to have a comprehensive view of lead service lines in the 

water system. The dashboard includes a mix of charts, gauges, and elements to report on the 

presence of lead in the water system. 

1. Browse to the Lead Service Line Office Viewers group and locate the Lead Service 
Line Dashboard app. Click View Dashboard to launch the dashboard. 

2. Review the brief descriptions of the included indicators to learn more about them. 

•  Lead—The indicator represents the total number of lead service lines. 

•  Galvanized—The indicator represents the total number of galvanized service 
lines requiring replacement. 

•  Non-Lead—The indicator represents the total number of non-lead service lines. 

•  Unknown—The indicator represents the total number of unknown service lines. 

• Verified Service Lines—The gauge represents the total number of verified 
service lines. The number in the middle of the gauge represents the number of 
verified service line and the number at the end of the gauge represents the total 
number of service lines in the system. 

•  Replaced—The indicator represents the total number of replaced lead service 
lines. 

• Lead Service Line Inventory Table—The table contains all of the fields from the 
EPA's template for reporting a lead service line inventory. 

•  Lead Service Line Inventory Map—The map contains the service lines 
represented as a point. The list on the right contains lead service lines. Clicking a 
lead service line in the list will pan the map to its location. 

  The following table shows which fields are being used to drive the results of this element. 
These must be fully filled in to accurately show the lead service line information. 

Element name Fields used 

Lead Entire Service Line Status 

Galvanized Entire Service Line Status 

Non-Lead Entire Service Line Status 

Unknown Entire Service Line Status 

Verified Service Lines Utility Side Verified, Customer Side Verified 

Replaced Replacement Status 
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Export service line data 
As the lead compliance manager, I need to report the water system's service line inventory to 

comply with regulations. 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
ServiceLine_reporting service.  

2. Click the Export Data drop-down and select Export to CSV file. 

3. Update the Title and click Export. It may take a few seconds to complete the export. 

4. Click Download. 

The csv with the service line data downloads to a .CSV file. 

5. Optionally, after exporting to the CSV copy and paste the data into the EPA's Inventory 
Template. The fields, field order, and values are identical to those found in the template. 
Ignore the last 4 fields of the export (globalid, objectid, x, y) 

 

Engage the public 
Communicating lead service line information helps residents locate their properties and allows 

them to learn if their property may be affected by lead. The Lead-Safe Community site can be 

used to communicate lead service line information to residents in the community. It also 

includes a link to the Water Service Line Material Survey which allows residents to report the 

material of their water service lines, allowing water utilities to better understand their water 

systems and make improvements to eliminate lead pipes within their water systems. 

 

Locate service line information 
You will assume the role of a resident or member of the public. In this workflow, you are 

interested in locating an address to find more information about lead service lines. 

1. In a browser, go to the Lead-Safe Community site. 

2. Scroll to the Lead Service Line Map section. 

3. In the app, use the Search text box to enter an address and click Enter. 

4. Suggestions are presented as you type and you are able to choose the address from the 
search results. 

5. If a Lead Service Line point exists at the property, click the point to view a pop-up with 
more information. 

 

Submit a water service line material survey 
You will assume the role of a resident who is interested in submitting water line material 

information for their property. 

1. In a browser, go to the Lead-Safe Community site. 
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2. Click the Water Service Line Material Survey link to open the survey. 

3. In the Water Service Line Material Survey form, enter your personal information, water 
service line information and a photo of your water line service.  

4. Click Submit, to submit your survey. 

 

Manage water service line surveys 
As water utilities work to eliminate all lead in their water lines, they need the help of the public 

to report their water line service material to aid in this effort. Water utilities need to complete a 

full inventory of their system and public surveys can ensure that utilities are capturing possible 

lead service line locations. This information can help water utilities organize lead replacement 

campaigns and plan service line replacement. 

You will assume the role of a manager tasked with managing and reviewing water service line 

surveys. 

1. In a browser, go to the Service Line Self-Assessment Manager app. 

  The app opens and shows a list of surveys as well as a map and a panel to view 
additional survey details. 

2. Scroll to the right and click the Status column filter. 

3. Click the Status is drop-down arrow and choose Submitted to view surveys which have 
not been reviewed. 

4. Click one of the surveys to view its details. 

5. On the Details tab, click the Edit button . 

6. Click the Status drop-down arrow and choose Received. 

7. Click Save. 

8. In a browser, go to the Service Line Self-Assessment Dashboard app. 

9. Use the filters in the dashboard header to explore the survey information and as well as 
the indicators on the map to view a specific survey details. 

  Dashboard charts are linked. As you click and select a category in one chart, related 
details are filtered and updated in other charts. 
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Market Development 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Market Development 
Market Development can be used to understand market characteristics and performance. 

Executives and retail analysts need to understand the performance of the market landscape 

based on location. Organizations strive to increase profits by using market indicators to drive 

the decisions on where to close locations and open new locations. Understanding market 

performance based on regional and market breakdown is critical in enhancing the business 

strategy for decision makers. Market Development is typically implemented by organizations 

that want to take a data-driven approach to understand market characteristics and the 

performance of their business. 

The Market Development solution delivers a set of capabilities that helps you visualize the 

overall market landscape and communicate key business metrics with decision makers. 

Requirements 
Market Development requires the following: 

• ArcGIS Enterprise 

 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 473 

Information products 
Market Development includes the following information products: 

Item Description Minimum 
user type 

Market Explorer 
Dashboard 

An ArcGIS Dashboards app used by analysts to 
understand the overall performance of retail stores in 
an organization from various geographies 

Viewer 

Sales Performance 
Dashboard 

An ArcGIS Dashboards app used by analysts to 
understand the overall performance of each retail 
store in an organization 

Viewer 

AssetSource An Excel document that can be used to load and 
validate an authoritative list of assets into ArcGIS 

Not 
required 

SalesdataSource A .csv file that can be used to load an authoritative 

dataset of sales data into ArcGIS 

Not 
required 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 • General schema update to the joined layer view. 

1.0 • First release of Market Development 
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Configure Market Development 
In this topic, you will learn how to configure the Market Development solution to meet specific 

needs in your organization. 

 

Prevent duplicate records 
To support the updating of data using the Append Data to Layer and to ensure accurate 

statistics within the information products of the solution. You'll need to add an attribute index 

which applies a unique constraint to facility_id field in the facilities layer. 

To add an unique constraint, complete the steps below: 

1. Sign in to your ArcGIS Enterprise portal. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Assets in the search box. 

4. On the left under Folders, click the folder Market Development was deployed to. 

5. On the right side of the page, click  Assets to view it details. 

6. Under the Layers section, click Assets. 

7. In the URL section , click View. 

A new tab opens into the ArcGIS REST Service Directory for this item. 

8. In the URL bar of the browser, edit the URL with the following changes: 

a. Add the word admin between /rest/ and /services/. (For example: 
ArcGIS/rest/admin/services/assets.) 

b. Scroll to the bottom of the page and click on Add to Definition. 

c. A window appears where you will be entering JSON to add an index to the layer. 

d. In the text box, copy the following: 

{ 

"indexes" : [{ 

"name" : "asset_id_Index", 

"fields" : "asset_id", 

"isAscending" : false, 

"isUnique" : true, 

"description" : "" 

}] 

} 

e. Click Add To Layer Definition to commit update. 

The following message will appear if add was successful. {"success": true} 
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9. In the browser, return to the Assets layer tab and click on the Data tab. 

10. Click the Fields and click on Asset. 

  This page reveals the properties for the asset_id field. Under Settings, the Unique field 
is set to Yes. 

 

Load data 
Information must be loaded before using the Market Explorer Dashboard and Sales 

Performance Dashboard. The AssetSource and SalesdataSource can be used to organize 

your business information before loading into ArcGIS the accompanying sales data in your 

organization. 

Note: 

Ensure you populate the Asset_ID column in the AssetSource with unique values. 

You may need to load existing assets or sales data from a spreadsheet. Review the maps or 

applications provided with the solution and determine what, if any, source data you would like 

to load. 

If you do not have an inventory of assets and sales data in ArcGIS, you may have them in a 

spreadsheet or another system you can export to a spreadsheet. If you don’t have a 

spreadsheet already, you can use the sample .csv files included with the solution 

(AssetSource, SalesdataSource) to inventory your assets and sales data. 

To load your assets or sales data from a spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the AssetSource item. 

2. Open the items details page. 

3. Click Download. 

4. Edit the CSV file and populate your facility information in the document. 

Note: 

At a minimum, you must provide a unique Asset_ID and the latitude and longitude for 
each facility in the FacilitySource. If you don't have a unique ID, you can edit the CSV 
file in Excel and copy this formula into the first row of the facilityid column: 
=CONCATENATE("Asset-", TEXT(ROW(A1),"00000")). You can then drag the right 
corner of the cell to fill the formula down for all facilities, giving each a unique ID. 

5. In your ArcGIS organization at the top of the site, click Content. 

6. Browse to the Assets feature layer. 

7. On the item details page, click Update Data and select Append Data to Layer. 

8. Under Filename, choose your .csv file. 

9. Click Upload and Continue. 
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10. Uncheck Update existing features. 

11. Click Show field matching to map the fields. 

12. Click Apply Updates. 

13. Repeat steps 1 through 12 by downloading the SalesdataSource CSV file and updating 
the Asset Sales Data table. 

To load your data for Region Overlay, Subregion Overlay, and Competitors from a shapefile or 

file geodatabase, complete the following steps: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 
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Use Market Development 
The Market Development solution delivers a set of capabilities that helps you visualize the 

overall market landscape and communicate key business metrics with decision makers. 

In this topic, you will learn how to use the Market Development solution and the set of 

capabilities and features that it provides. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Investigate market characteristics 
The Market Explorer Dashboard application includes your organization's assets overlaid with 

demographic information such as median disposable income, retail goods spending, and 

population growth. The application allows you to conduct a series of key exploratory functions 

that support the visualization of markets in and around your business by region, market, or 

store. 

Note: 

Assets may represent your retail establishments, businesses you sell into, or distributors. 

 

Visualize market characteristics 
In this workflow, you’ll assume the role of a business analyst who is assigned the task of 

exploring a particular market. You will assume that this is a market that your organization is 

considering extending operations within and examine the potential likelihood of growth, and 

communicate this with key leadership. 

1. In a browser, go to the Market Explorer Dashboard application. 

Along the top are a set of global filters for focusing your view based on your organization's 

regional and subregional strategies as well as a specific store location. The filters are an 

essential part of focusing and exploring data within your view. 

2. In the Select a Region drop-down list, select a region. 

Filtering will zoom in to that specific region and automatically updates the set of metrics 
along the bottom of the application and the locations in the list on the right side. 

Note: 

The competitor indicator panel represents the number of features within the map view. 

3. In the Select a Sub-Region drop-down list, select a sub-region. 
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4. In the upper right corner of the map are a set of map settings. Click the layer visibility 
button to reveal operational layers that can be switched on or off. 

5. Switch on the layer labeled USA Population growth. 

6. Zoom in to a particular market to start exploring in more detail. 

  Notice as you zoom in or pan around, the metrics along the bottom as well as the list on 
the right side update. This map-driven capability provides context into what is within your 
view, in and around areas of interest. Also note how the USA population growth layer 
dynamically updates to more granular level of detail depending on the scale. 

Note: 

Holding the Shift key on your keyboard enables the area selection tool in the map. 
This will zoom in to the extent of the selected area. 

 

Explore the performance of your business 
The Sales Performance Dashboard contains your organization's assets, with panels that 

represent your business sales data broken down by category and sales for each store. The 

application is designed to digest key information about the financial performance of your 

organization’s assets. The functionality of the Sales Performance Dashboard is used to 

explore and visualize retail stores and sales information for each retail store and overall 

financial performance of your business by region, market, or store. The map-driven metrics 

provide an overview of key financial business metrics that provide insight into the market 

potential. 

Note: 

Assets may represent your retail establishments, businesses you sell into, or distributors. 

 

Understand store performance 
In this workflow, you’ll assume the role of a business analyst who is assigned the task of 

understanding the sales performance in a particular market. You will assume that this is a 

market that your organization is considering extending operations within and examine the 

potential likelihood of growth, and communicate this with key leadership. 

1. In a browser, go to the Sales Performance Dashboard. 

Along the top are a set of global filters for focusing your view based on your organization's 

regional and subregional strategies as well as a specific store location. The category selector 

filters the sales metrics along the left. The filters are an essential part of focusing and 

exploring data within your view. 

2. In the Select a Region drop-down list, select a region. 

Filtering to the Middle Atlantic will zoom in to that specific region and automatically 
updates the set of metrics and locations in the list along the left side of the application. 
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3. In the Select a Sub-Region drop-down list, select a sub-region. 

4. Zoom in to a specific market to start exploring in more detail. 

Notice as you zoom in or pan around, the metrics and the list along the left update. This 
map-driven capability provides context into what is within your view, in and around areas 
of interest. 

Note: 

Holding the Shift key on your keyboard enables the area selection tool in the map. 
This will zoom in to the extent of the selected area. 

5. In the Select a Category drop-down list, select a category. 

Notice the metrics along the left are now only showing overall sales for that specific 
category, based on the assets within the map view. 

6. Select an asset from the list. This will zoom to the selected feature and open the pop-up 
for additional sales. The metrics will also reflect the currently selected feature. 

7. Optionally, to filter the assets in the list to a specific area of interest, click the button in the 
upper left corner of the map to enable the layer selection mode. 

8. To change the selection method, click the drop-down arrow and click the lasso tool. 

9. Hold the left mouse button and dynamically draw around an area of features to be 
selected. 

  Notice that the metrics and the list along the left update based on the selected features. 
This selection-driven capability provides an additional level of focusing based on an area 
of interest. 

 

Add premium content 
Esri Demographics provides ArcGIS access to global demographics and business listings and 

is used for mapping and analysis. Esri Demographics data supports commercial market 

analytics and noncommercial usages, such as economic development, planning, and at-risk 

population assessment. The data is accessible as dynamic web maps, data enrichment, 

reports, and infographics. 

Market Development is configured by default with a set of information-rich demographic layers 

that can be used to visually explore key market characteristics. 

In this workflow, you will assume the role of a business analyst who is tasked with adding new 

demographic content to help enhance the ability to make decisions with new context. 

1. In a browser, sign in to your ArcGIS organization and click the Content tab. 

2. On the left side, under Folders, click Market Development. 

3. Click Market Explorer (map) to open into the item description page, then click Open in 
Map Viewer. 

4. Above the contents pane, click the Add button, then click Browse Living Atlas Layers. 
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5. Under Search for Layers are a set of buttons to filter and sort layers by relevance. Click 
the filter button to show additional options. 

6. Under the Categories group are a set of themes that can be selected to filter from over 
4,500 layers of ArcGIS Living Atlas content. Select a theme to explore layers and select a 
layer to view more details. 

7. Once a layer has been identified, click Add to Map. 

8. Click the Save button along the upper middle of the map and click Save. 

9. If necessary, repeat steps 1 through 8 for Sales Performance (map). 
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Mosquito Service Requests 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Mosquito Service Requests 
Mosquito Service Requests can be used to solicit reports of mosquito activity and locations of 

potential breeding sites from the general public. 

Mosquitoes are a serious threat to public health, beyond nuisance swarms and annoying 

bites. During peak times, the risk for the spread of diseases such as encephalitis, yellow fever, 

dengue, Zika, and malaria drastically increase. 24/7 access to responsible agencies ensures 

mosquito activity is reported sooner and responsible agencies address problem areas faster. 

This accelerated approach improves the quality of life in a community and reduces risks 

associated with large infestations of mosquitoes. Mosquito Service Requests is typically 

implemented by public works and mosquito control agencies that want to take a data-driven 

approach to the control of mosquito populations. 

The Mosquito Service Requests solution delivers a set of capabilities that help you solicit 

mosquito activity reports from the public, triage reports to staff and field crews for resolution 

and monitor the resolution of reports in a community. 

 

Requirements 
Mosquito Service Requests requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 
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Information products 
Mosquito Service Requests includes the following information products: 

Item Description Minimum user type 

Mosquito 
Control 

An ArcGIS Hub site used by public works and 
mosquito control agencies to share how they 
are controlling mosquito populations and the 
spread of vector-borne disease 

Not required 

Mosquito 
Service Request 

A Crowdsource Reporter app template used by 
the general public to submit mosquito activity 
reports in their community 

Editor (required for 
public works or 
mosquito control 
personnel only) 

Mosquito 
Service Request 
Manager 

A Crowdsource Manager app used by public 
works and mosquito control personnel to triage 
submitted mosquito activity reports and update 
the status of each report as needed 

Editor 

Mosquito 
Service Request 
Dashboard 

An ArcGIS Dashboards app used by public 
works and mosquito control personnel to 
monitor mosquito activity reports submitted by 
the general public 

Viewer 

Mosquito Field 
Operations 

An ArcGIS Field Maps map used by public 
works and mosquito control personnel to 
address mosquito activity reports submitted by 
the general public 

Mobile Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Mosquito Service Requests 
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Configure Mosquito Service Requests 
Learn how to configure the Mosquito Service Requests solution to meet specific needs in your 

organization. 

 

Configure the Mosquito Control site 
The Mosquito Service Requests solution includes an Mosquito Control ArcGIS Hub site. This 

site can be configured with your organization's branding and used to share important mosquito 

control information and abatement activities information with the public. 

 

Update with organizational information 
After deploying the Mosquito Service Requests solution, the Mosquito Control Hub site layout 

requires a few updates to fit your local context. 

To update the site with your organizational information, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Mosquito Control site. 

2. From the item page, click Configure. 

3. Scroll to any additional sections that you want to update, hover over the card, and click 

the edit pencil  that appears in the horizontal toolbar, and then edit the content with 
information specific to your organization. 

4. Click Footer.  

A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

5. Click the HTML text box. 

The HTML window appears. 

6. Make the necessary changes and click Apply. 

7. Click Save. 

8. Click the Save drop-down arrow and click Publish Draft. 

 

Share items with the public 
Several layer views, maps and apps included in the Mosquito Service Requests solution must 

be shared with everyone so they can be accessed by the public on the Mosquito Control site. 

To share items with the public, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Mosquito 
Service Requests folder. 

2. Next to each of the following items, check the check box: 
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Name Item type 

MosquitoObservations_public Feature layer (hosted, view) 

Mosquito Service Request Web Map 

Mosquito Service Request Web Mapping Application 

Mosquito Control Site Application 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

6. At the top of the site, click Groups. 

7. Open the Mosquito Service Request group page and click Settings. 

8. Under Who can view this group, click Everyone (public). 
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Use Mosquito Service Requests 
The Mosquito Service Requests solution delivers a set of capabilities that help you solicit 

mosquito activity reports from the public, triage reports to staff and field crews for resolution 

and monitor the resolution of reports in a community. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Report mosquito activity 
You will first assume the role of a member of the community seeking information about 

mosquito control services. You will use the Mosquito Control site to learn about mosquito 

abatement services in your community and how you can report mosquito activity and potential 

breeding sites. Reports you submit using the Mosquito Service Request app will be 

immediately available to the local Mosquito Control Agency. 

1. In a browser, from the Mosquito Service Requests solution, view the Mosquito Control 
site. 

2. Scroll to the Report a Problem section, and then click Submit a Request to open the 
Mosquito Service Request app.  

Tip: 

You can jump directly to the Report a Problem section by clicking the Outreach button 
in the What are we doing to help section. 

3. On the Mosquito Service Request splash page, click Proceed as Guest. 

4. At the lower right, in the Mosquito Reports panel, click Submit a Report. 

5. For Type of Problem, click the drop-down arrow and choose the problem type. 

6. Complete the form with as much information as possible. 

7. At the bottom of the form, for Location, type the address to set the report location; 
alternatively, click the location on the map. 

8. Click Report It to submit the report. 

9. At the top of the Mosquito Reports form, click the Back button. 

10. At the top of the Mosquito Reports panel, click your problem report submission. 

  Your problem report appears. You will be able to monitor changes to the report here as 
the report moves through its life cycle (Submitted, Received, In Progress, and 
Completed). 
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Respond to mosquito reports 
Next, you will assume the role of an operations manager responsible for handling submitted 

mosquito activity reports. You will use the Mosquito Service Request Manager app to triage 

submitted reports and assign reports to the field inspectors responsible for resolution. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Service Requests solution.  

2. View the Mosquito Service Request Manager app. 

All submitted reports are listed in the table at the top. The table can be sorted and filtered 
in various ways. 

3. In the table, use the column header filters and arrows to filter results. 

4. In the table, select a report with a status of Submitted. 

The report details open at the lower left. 

5. In the report details, click the Edit Record button . 

6. Change the status to Received, and then click Save. 

Field inspectors are ready to address the problem. You'll change the status to In 
Progress and assign the report to the specific mosquito abatement district. 

7. Click the Edit Record button again. 

8. Change the status to In Progress. 

9. Click the Assigned To drop-down arrow and choose the appropriate district. 

10. Click Save. 

 

Update reports from the field 
Now, you will assume the role of a field inspector responsible for addressing mosquito activity 

reports submitted by the public. 

In addition to verifying and updating the status of public reports, field inspectors can also 

record the type of mosquitoes found on site, recommend treatments, and record any 

adulticide or larvicide treatments applied while on site. Status updates that are provided in the 

Mosquito Field Operations app will be immediately viewable to the public in the Mosquito 

Service Request app, and detailed information will be immediately available to operations 

managers in the Mosquito Service Request Dashboard app. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open ArcGIS Field Maps and sign in to your ArcGIS organization. 

3. Tap Mosquito Field Operations to open the map. 

4. On the map, locate a reported problem, and then tap it to see details and additional 
options. 

5. At the lower left, tap Edit. 
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6. Swipe up on the form and tap Status, and then tap Completed. 

7. Complete the rest of the form with information from your field inspection, such as 
information related to the people contacted at the location; the date; observations about 
the mosquitoes or larvae found on site; and what type of treatments, if any, were used. 

8. If applicable, tap Take Photo to take and attach a photo to document any standing water 
or water-retaining receptacles found during the inspection. 

9. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

 

Monitor activity reports 
Finally, you will assume the role of an operations manager responsible for overseeing 

mosquito abatement activity and reports submitted by the public. You will use the Mosquito 

Service Request Dashboard app to monitor incoming reports submitted by the public. 

Relevant metrics can be viewed at a glance or examined in more detail if time permits. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Service Requests solution.  

2. View the Mosquito Service Request Dashboard app. 

3. Review the metrics. 

4. On the left, use the filters to refine the results by request type, status, or date. 

When you filter results, the bar charts and number of reports in the Mosquito Reports 
panel update. 

5. On the right, in the Mosquito Reports panel, click a report to view the location. 

6. Click the point on the map to get detailed report information. 
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Mosquito Surveillance 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Mosquito Surveillance 
Mosquito Surveillance can be used to monitor mosquito populations and track the location of 

positive vector-borne disease test results. 

Routine monitoring of larval and adult mosquito populations is critical to a successful mosquito 

control program. When data is tracked and compared over time, agencies can use this 

knowledge to predict recurring problem areas, times of year, and the potential for increased 

risk of vector-borne diseases. When vector-borne disease cases do arise, health and human 

services agencies must communicate information in a timely and effective manner with the 

public and mosquito control agencies. Mosquito control agencies can then use this information 

to plan adulticide spray operations that prevent the spread of vector-borne diseases. Mosquito 

Surveillance is typically implemented by public works, health and human services, and 

mosquito control agencies that want to use data to proactively plan spray areas and reduce 

the risk of vector-borne diseases. 

The Mosquito Surveillance solution delivers a set of capabilities that help you record mosquito 

counts by species at surveillance sites; visualize trends over time; track where mosquitoes, 

chickens, birds, or humans have tested positive for vector-borne diseases; and share this 

information with internal and external stakeholders. 

 

Requirements 
Mosquito Surveillance requires the following: 

• ArcGIS Enterprise 
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Information products 
Mosquito Surveillance includes the following information products: 

Item Description Minimum user type 

Mosquito Health 
Concerns 

An ArcGIS Web AppBuilder app used by 
mosquito control and public health staff to track 
locations where mosquitoes, chickens, birds, or 
humans have tested positive for a vector-borne 
disease 

Editor 

Mosquito Health 
Concerns 
Summary 

An ArcGIS Web AppBuilder app used by 
mosquito control and public health staff to 
communicate positive vector-borne disease test 
results to the general public 

Not required 

Mosquito 
Population 
Surveillance 

A Crowdsource Polling app used by biologists 
and field inspectors to record mosquito counts by 
species at surveillance sites 

Editor 

Mosquito 
Population 
Surveillance 
Charts 

An ArcGIS Web AppBuilder app used by 
mosquito control agencies to visualize population 
changes over time through informative charts 

Viewer (required 
for internal 
stakeholders) 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Mosquito Surveillance 
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Use Mosquito Surveillance 
The Mosquito Surveillance solution delivers a set of capabilities that help you record mosquito 

counts by species at surveillance sites; visualize trends over time; track where mosquitoes, 

chickens, birds, or humans have tested positive for vector-borne diseases; and share this 

information with internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Monitor mosquito populations 
You will first assume the role of a biologist with the mosquito control agency responsible for 

processing the samples collected at the trap sites across the community. You will use the 

samples to identify the species of mosquitoes and the size of the population and record the 

counts for each surveillance site. 

You can then visualize trends and share current and historical mosquito population data with 

internal stakeholders. This information can also be used to educate the public about the types 

of mosquitoes prevalent in the area, the diseases they can carry, when they are most active, 

and how to best protect themselves from the spread of vector-borne diseases. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Surveillance solution. 

2. View the Mosquito Population Surveillance app. 

3. From the list or the map, select one of the surveillance sites. 

You see the details on the site and a history of counts by species recorded in past 
observations. 

4. Click the Add a comment button. 

5. Fill in the counts for each species found at the surveillance site. 

6. Click Submit. 

7. Repeat these steps for each surveillance site. 

You can now visualize the trends of the various species of mosquitoes at each 
surveillance site over time. 

8. From your ArcGIS organization, view the Mosquito Population Surveillance Charts app. 

9. In the Population Charts widget, search for a location; alternatively, click a point on the 
map. 

10. In the widget, click a mosquito species to see the population trend for the surveillance 
site. 
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Track vector-borne diseases 
You will continue your role as a biologist with the mosquito control agency. You typically send 

a small sampling of mosquitoes collected at each surveillance site to the lab to be tested for 

vector-borne disease. Dead birds are often reported or found in the community and sent for 

testing as well. Health departments may share with mosquito control agencies the general 

locations (so that personal health information is protected) where a vector-borne disease has 

been transmitted to a human. 

You will track where mosquitoes, chickens, birds, or humans have tested positive for vector-

borne diseases. This information can be used to plan adulticide spray operations that prevent 

the spread of a disease. It can also be used to educate the public about the types of vector-

borne diseases found in the community and how they can help prevent the spread of disease. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Surveillance solution. 

2. View the Mosquito Health Concerns app. 

3. In the Edit widget, click a template. 

4. Click the map to place the location at which the disease was found. 

5. Complete the Public Health Reports form with the details of the agent carrying the 
disease, when it was reported, and any additional comments. 

6. Click Save. 

7. At the top of the Edit widget, click the All drop-down arrow and choose Public Health 
Concerns. 

The Public Health Concerns template can be used to generalize the location of positive 
tests in a human to avoid revealing personal health information. 

8. Click the Public Health Concerns template. 

9. On the map, draw the boundary of the generalized location of the positive human case. 

10. Complete the Public Health Concerns form with the details of the type of disease, when 
it was reported, and any additional comments. 

11. Click Save. 

You can now visualize locations and counts of vector-borne cases across the community. 

12. From your ArcGIS organization, view the Mosquito Health Concerns Summary app. 

13. In the Health Concerns widget, expand Mosquito and Bird Cases and Human Cases 
to view the counts by each disease. 

14. Pan and zoom around the map to see how the counts change for different areas in the 
community and find areas of concentration. 
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Mosquito Treatments 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Mosquito Treatments 
Mosquito Treatments can be used to manage adulticiding and larviciding activities and share 

treatment plans with the general public. 

Protecting public health is at the center of all mosquito control programs, and effective 

treatment strategies are critical to controlling mosquito populations. Public works and 

mosquito control agencies use adulticides to kill adult mosquitoes and larvicides to target 

mosquito larvae in breeding habitats. When adulticides are applied to control mosquito 

populations, agencies must proactively share this information with the public and give 

residents an opportunity to request an exclusion or be notified prior to treatment. This ensures 

that individuals who have concerns about chemical treatments can avoid having their home 

sprayed or seek temporary shelter when spraying does occur. Mosquito Treatments is 

typically implemented by public works and mosquito control agencies that want to increase 

transparency, grow public trust, and improve relationships with the communities they serve. 

The Mosquito Treatments solution delivers a set of capabilities that help you plan adulticide 

spraying operations, solicit requests for spray notifications and exclusions, maintain spray 

exclusion areas, record larvicide treatments in the field, and share spray areas with internal 

and external stakeholders. 

 

Requirements 
Mosquito Treatments requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 

• ArcGIS Survey123 Connect 
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Information products 
Mosquito Treatments includes the following information products: 

Item Description Minimum 
user type 

Mosquito Larvicide 
Reporting 

An ArcGIS Field Maps map used by public works and 
mosquito control personnel to test larvicide sites and 
record any treatments applied at those sites 

Mobile 
Worker 

Mosquito 
Adulticide Planning 

An ArcGIS Web AppBuilder app used by public works 
and mosquito control personnel to plan adulticide 
spraying operations and maintain spray exclusion areas 

Editor 

Mosquito Spray 
Areas 

An ArcGIS Web AppBuilder app used by the general 
public to locate recent and planned adulticide spraying 
areas near their home or business 

Not 
required 

Mosquito Spray 
Notifications 

An ArcGIS Survey123 form used by the general public 
to request a notification of adulticiding or larviciding 
near their home or business 

Not 
required 

Mosquito Spray 
Exclusions 

An ArcGIS Survey123 form used by the general public 
to request an exclusion from adulticiding or larviciding 
near their home or business 

Not 
required 

Mosquito Spray 
Exclusions 
Manager 

A Crowdsource Manager app used by public works and 
mosquito control personnel to manage adulticide and 
larvicide exclusion requests from the general public 

Editor 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Mosquito Treatments 
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Use Mosquito Treatments 
The Mosquito Treatments solution delivers a set of capabilities that help you plan adulticide 

spraying operations, solicit requests for spray notifications and exclusions, maintain spray 

exclusion areas, record larvicide treatments in the field, and share spray areas with internal 

and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Plan spray operations 
First, you will assume the role of a mosquito control agency staff member responsible for 

managing adulticide operations. You will use the Mosquito Adulticide Planning app to plan 

adulticide spray operations, update the status of spray areas to indicate whether treatments 

were completed, and maintain exclusion areas in the community. 

Updates to adulticide treatment areas will be immediately available to the public and viewable 

in the Mosquito Spray Areas app. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Treatments solution. 

2. View the Mosquito Adulticide Planning app. 

The Edit widget enables you to create new and update existing adulticide treatment or 
treatment exemption areas. 

3. To create an adulticide treatment area, click the Adulticide Treatment Areas template. 

4. Click the map to draw the adulticide treatment area and double-click to finish drawing the 
polygon. 

After you finish drawing the area, the Planned Adulticide Areas form opens in the Edit 
widget. 

5. Complete the form with as much information as possible, and then click Save. 

Existing adulticide treatment areas and treatment exemption areas can also be edited 
and deleted. 

6. On the map, select an existing planned adulticide area. 

The area's Planned Adulticide Areas form opens in the Edit widget. Here, you can 
correct errors, update information, or modify the area's geometry. 

7. Make necessary updates to the form: 

a. Correct errors directly in the form. 

b. To edit the area's geometry, check the Edit Geometry check box, and then modify the 
area's vertices. 
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c. After the spray occurs, add the Actual Spray Date parameter. 

d. Alternatively, to delete the area, click the Delete button. 

Updating the planned adulticide area with an actual spray date changes the symbology to 
show the area as an actual adulticide area. 

8. Click Save. 

You can also choose which layers are visible on the map. 

9. On the right, at the top of the panel, click the Layer List button to open the widget. 

10. To view the layer of recently treated areas, check the Actual Adulticide Area check box. 

 

Locate mosquito spray areas 
Now, you will assume the role of a resident in the community who is interested in learning 

about mosquito spraying near your home or business. You will use the Mosquito Spray Areas 

app to locate recent and planned adulticide spraying areas near your home. 

1. In a browser, from the Mosquito Treatments solution, view the Mosquito Spray Areas 
app. 

2. In the Find Spray Areas widget, search for an address; alternatively, click the location 
on the map. 

3. In the widget, review the Recent Spray Area details. 

The app provides details on when the spray occurred or is planned to occur, along with 
the method and any comments from the agency. 

 

Request spray notifications 
After reviewing recent and planned adulticide spraying in the community, you have 

determined that you want to be notified of future spraying. You will use the Mosquito Spray 

Notifications app to submit your contact information to the mosquito control agency so you can 

be notified of future operations. 

1. In a browser, from the Mosquito Treatments solution, view the Mosquito Spray 
Notifications app. 

2. Complete the Mosquito Spray Notifications form with as much information as possible.  

Required fields are marked with a red asterisk. The Request Date field is automatically 
populated with the current date. 

3. Click Submit. 

 

Request a spray exclusion 
You will now assume the role of a resident in the community with strong allergies to 

pesticides. You want to have your home excluded from adulticide spraying. You will use the 

Mosquito Spray Exclusion app to submit your exclusion request to the mosquito control 
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agency. The agency will review your request and may follow up for more information, and if 

approved, it will include your exclusion into its adulticide operation planning for future 

spraying. 

1. In a browser, from the Mosquito Treatments solution, view the Mosquito Spray Exclusion 
app. 

2. Complete the Application for Pesticide Exclusion form with as much information as 
possible.  

Required fields are marked with a red asterisk. The Request Date field is automatically 
populated with the current date. 

3. Sign the form and click Submit to complete the exclusion request. 

 

Manage exclusion requests 
As an operations manager, you will use the Mosquito Spray Exclusions Manager to manage 

adulticide and larvicide exclusion requests from the public. Approved exclusion requests will 

be immediately available to biologists and other staff planning adulticide operations. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Mosquito 
Treatments solution. 

2. View the Mosquito Spray Exclusions Manager app. 

All exclusion requests are listed at the top of the table. The table can be sorted and 
filtered in various ways. 

A Submitted status indicates requests that have not yet been reviewed by staff. 

3. In the table, in the Status column, click the filter, and then for Status is, choose 
Submitted. 

4. Click an exclusion request. 

The request details open at the lower left. After a request has been received, staff 
members review it for completeness, including forms, signatures, and justification. 

5. On the Application Info tab, click the Edit button , and then for Status, choose 
Staff Review. 

6. Click an exclusion request to open its details. 

7. Click Edit, and then for Status, choose Approved. 

8. Click Save. 

  Approving the exclusion request removes the request from the Mosquito Spray 
Exclusions Manager app and promotes it to the Mosquito Adulticide Planning app, where 
you can use it to plan mosquito spray areas and known exemption areas. 
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Control juvenile mosquitoes 
As a field biologist for a mosquito control agency, you are responsible for inventorying 

larvicide sites, recording inspection results at each site, and documenting larvicides applied. 

Using the Mosquito Larvicide Reporting map, you will also be able to add new inspection sites 

as well as update the status of each site. 

 

Add a new inspection site 
On occasion, new inspection sites will be added. You will use the Mosquito Larvicide 

Reporting map to make these changes. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open ArcGIS Field Maps and sign in to your ArcGIS organization. 

3. Tap the Mosquito Larvicide Reporting map to open it. 

4. Tap Add to add a new inspection site. 

By default, ArcGIS Field Maps uses your current location. 

5. Pan or zoom to the site location, and then tap Add Point. 

6. Swipe up on the form, if necessary, and then for Location, type a location name or 
description. 

7. Tap Status and choose Active. 

8. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

 

Complete a site inspection 
After an inspection at each site is complete, a history of larviciding in a community can be 

reported. 

1. On the Mosquito Larvicide Reporting map, tap an existing larvicide site. 

2. In the form, under Related, tap Larvicide Inspections. 

3. Tap Add to begin documenting your larvicide inspection results. 

4. Swipe up, if necessary, and then complete the inspection form. 

5. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 
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Retire an inspection site 
On occasion, inspection sites will need to be retired. You will use the Mosquito Larvicide 

Reporting map to make these changes. 

1. On the Mosquito Larvicide Reporting map, tap the existing larvicide site that you want 
to retire. 

2. Tap Edit. 

3. Tap Status and choose Retired. 

4. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

Only active status larvicide inspection sites are visible on the map. The recently retired 

inspection site is no longer displayed on the Mosquito Larvicide Reporting map. 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 499 

Neighborhood Services 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to My Neighborhood Services 
My Neighborhood Services can be used to share information about available facilities and 

services in a community. 

It provides 24/7 access to amenities and services to residents, businesses and visitors to help 

them determine if they would like to live, work, or locate a business in the community. This 

approach allows government agencies to communicate available facilities and services timely 

and flexible manner and improves overall quality of life. My Neighborhood Services is typically 

implemented by economic development departments, planning departments, chambers of 

commerce, and other local government agencies that want to promote government services to 

the public. 

The My Neighborhood Services solution delivers a set of capabilities that help you promote 

government facilities and services to the public. 

 

Requirements 
My Neighborhood Services requires the following: 

• ArcGIS Enterprise 

 

Information products 
My Neighborhood Services includes the following information products: 

Item Description Minimum 
user type 

My Neighborhood 
Services 

An ArcGIS Web AppBuilder app used by the general 
public to locate government facilities and available 
services that increase the quality of life in a community 

Not 
required 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of My Neighborhood Services 
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Configure My Neighborhood Services 
In this topic, you will learn how to configure the My Neighborhood Services solution to meet 

specific needs in your organization. 

 

Load data 
My Neighborhood Services can be used to share information about available facilities and 

services in a community. In some cases, you may have this information in ArcGIS or another 

business system already. 

Review the layers provided with the solution and determine what source data you would like to 

load. Then, load your existing data into the layers provided with the ArcGIS Solution before 

sharing the maps or applications. 

Once you have determined what source data must be loaded, complete the data-loading 

workflows below. 

 

Load data from a shapefile 
Data for EmergencyResponseFacilities, GovernmentFacilities, LandmarkFacilities, 

MailShippingFacilities, MedicalFacilities, ParkRecreationFacitilies, and TransportationFacilities 

can be loaded from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer into which you want to load data and the layer that contains the 
updated data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Configure directions 
Follow the steps below to connect to a routing service and configure the widget to enable 

directions in the app. 

 

Configure widget 
To configure an app to use routes and provide directions, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the ArcGIS Web AppBuilder app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab and click Set the widget in this controler to open the page for an 
in-panel widget.  

4. Hover over the Near Me widget and click the Configure this widget button to open the 
widget configuration window. 

5. Check the Enable Directions check box if it is not checked. 

6. Click the Direction Settings tab, click Set, and choose a routing service. 

7. Click Next and choose one or more route layers, click OK, and click OK again. 

8. Save the app and share it with everyone. 

9. Open the app. 

 

Esri premium content 
The app draws routes and provides directions using the ArcGIS Online World Route Service. 

This service requires subscriber access because it consumes credits. See Configure Living 

Atlas content to enable access to premium content. 

Learn more about credit usage when creating simple routes 
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Use My Neighborhood Services 
The My Neighborhood Services solution delivers a set of capabilities that help you promote 

government facilities and services to the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Find services 
My Neighborhood Services is an application for the public to find services near them. 

Members of the public can search for an address or click the corresponding map to find 

information about services near them. 

In this workflow, you are a member of the public and want to learn what services are in your 

area. 

1. In a browser, from the My Neighborhood Services solution, view the My Neighborhood 
Services app. 

2. In the Locate Services widget, search for an address; alternatively, click a location 
directly on the map. 

In the widget, an expandable list of available services near your defined location appears. 

3. Optionally, adjust the slider to increase or decrease the search area. 

4. In the widget, click a service. 

The map zooms to and highlights the service's location, and details about the service 
appear in the widget. 

5. Review the information provided. 

6. In the widget, click the Directions tab to view driving directions from your defined 
location. 
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My Trash Services 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to My Trash Services 
My Trash Services can be used to share waste pickup schedules and recycling information 

with the general public. 

It provides 24/7 access to an organization, and the location-enabled search helps residents 

quickly find waste pickup schedules and recycling centers and learn what materials are 

accepted. This transparent approach improves communication with the public and addresses 

one of the most frequently asked questions in a community. My Trash Services is typically 

implemented by public works agencies and other local government organizations that want to 

educate the public and promote waste and recycling services available in their community. 

The My Trash Services solution delivers a set of capabilities that help you share typical waste 

pickup schedules with the public, highlight schedule changes, and promote nearby recycling 

centers and the materials accepted. 

 

Requirements 
My Trash Services requires the following: 

• ArcGIS Enterprise 

• ArcGIS Hub Premium (optional) 

• ArcGIS Survey123 Connect 
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Information products 
My Trash Services includes the following information products: 

Item Description Minimum user 
type 

Curbside Service 
Areas 

A Zone Lookup app used by the general public to 
learn what curbside services are available 

Not Required 

Self Service 
Facilities 

A Nearby app used by the general public to find 
self service facilities 

Not Required 

Trash Service Data 
Management 

An ArcGIS Pro project used by mapping 
technicians to maintain curbside services areas 
and trash service information 

GIS 
Professional 
Basic 

Trash Request 
Manager 

A Crowdsource Manager app used by operation 
managers to manage trash service requests 

Editor 

Trash Requests An ArcGIS Survey123 form used by the general 
public to request trash services 

Not Required 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • A new ArcGIS Hub site used by the general public to learn about and request 
trash services. 

• A new Zone Lookup app used by the general public to learn what curbside 
services are available. 

• A new Nearby app used by the general public to find self service facilities. 

• A new ArcGIS Pro project used by mapping technicians to maintain curbside 
services areas and trash service information. 

• A new ArcGIS Survey123 form used by the general public to request trash 
services. 

• A new Crowdsource Manager app used by operations managers to manage 
trash service requests. 

1.0 • First release of My Trash Services 
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Configure My Trash Services 
My Trash Services can be used to inventory curbside services and collection facilities, 

communicate holiday closures, and provide the public with a way to request additional 

services. 

In this topic, you'll learn how to configure the My Trash Services solution to meet specific 

needs in your organization. 

 

Load data 
The Trash Service Data Management ArcGIS Pro project includes a series of tasks that can 

be used to load your existing trash service data, and manage key characteristics, in the layers 

provided with the solution. 

1. Sign in to your ArcGIS organization and browse to the Trash Service Data Management 
Desktop Application Template. 

2. From the item page, click Download. 

3. Unzip and open the Trash Service Data Management project. 

4. On the View tab, in the Window group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Trash Data 
Management task. 

6. In the Tasks pane, click the Getting Started task group to expand the collection of tasks. 

Trash Service Data Management is used to load and create foundational data used in the My 

Trash Services solution such as Curbside Service Areas and Self Service Facilities apps. The 

solution uses three foundational datasets: 

10. Self Service Facilities 

11. Curbside Service Areas 

12. Pickup Events Areas 

Self Service Facilities contains locations of facilities where the public can bring trash, 

recycling, or other waste. 

Curbside Service Areas contains geographies that define service areas for routine pickups. 

Pickup Events Areas contains geographies that define areas for seasonal or one time pickups. 

Before proceeding to subsequent tasks, follow the instructions in the Add trash service 

geography layer task to add the Trash Services feature layer deployed with the solution. 

 

Load existing trash services data 
You may have existing service areas, facilities, and pickup events areas, which can be loaded 

into the Trash Services feature layer. 
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Self Service Facilities use a standard for operational days and hours in the Self Service 

Facilities app included with the My Trash Services solution. To load existing facility data, 

designate the type, format the operational days and hours, and edit attributes follow the 

instructions in the Self Service Facilities task. 

The Curbside Services Areas use a standard for scheduled pick ups in the Curbside Service 

Areas app included with the My Trash Services solution. To load existing curbside service 

area data, designate the pickup type, format the pickup days and edit attributes, follow the 

instructions in the Curbside Service Areas task. 

The Pickup Events are used in the Curbside Service Areas app included with the My Trash 

Services solution. To load existing pickup event data and provide information regarding the 

event, follow the instructions in the Pickup Events task. 

 

Create new trash services data 
You may need to create new trash services data if existing data is not available. Follow the 

instructions in the Create new trash services data task group to create new facilities, 

curbside service areas, or pick up events. 

Note: 

Map layers must be visible to create new data. 

 

Configure My Trash Services site 
The My Trash Services solution includes the My Trash Services ArcGIS Hub site that your 

organization can configure with your branding and use to share trash service information with 

the public. 

1. Verify that you are signed in to your ArcGIS organization and browse to the My Trash 
Services site. 

2. From the item page, click Configure. 

3. If necessary, click the Edit button  to open the site editor. 

4. Scroll to the Frequently Asked Questions section, hover over the card, click the edit 
pencil, and update the questions and answers. 

5. In the side panel, click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

6. Click the HTML box. 

The HTML window appears. 

7. Make the necessary changes and click Apply. 
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Share items with public 
Several layer views, maps and apps included in the My Trash Services solution must be 

shared with everyone so they can be accessed by the public on the My Trash Services site. 

To share your trash services locator items with everyone, use the guide below and complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the My Trash 
Services folder. 

2. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) TrashServices_public 

Feature Layer (hosted, view) Requests_submit 

Web Map Self Service Facilities 

Web Map Curbside Service Areas 

Web Mapping Application Self Service Facilities 

Web Mapping Application Curbside Service Areas 

Form Trash Requests 

Site Application My Trash Services 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

 

Modify service request types 
The Trash Requests solution can be used to solicit requests for trash service from the general 

public. Service request types appear in the Trash Requests ArcGIS Survey123 form. 

The My Trash Services solution includes several service request types. In some cases, you 

may want to modify service request types to meet your organization’s needs. For example, 

you may want different request types available that are not included in the Trash Requests 

form. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Trash Request to download the survey. 

3. In the Download window, click Download and click OK. 

4. Click Trash Requests to open the survey. 

5. On the left, from the side toolbar, click the XLSForm button. 

6. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 
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  This tab comprises all the selectable options for survey questions. 

7. In the list_name column type reqtype.  

8. Type the new service request type into the name and label columns. 

9. Repeat steps 7 and 8 for each new service request type. 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

11. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

12. Click Publish survey to publish your changes, and then click OK. 

 

Configure directions 

Note: 

This workflow is optional and doesn't need to b completed in order to work with the 
solution 

The Self Service Facilities app can be used by the general public to locate facilities where 

they can bring trash, recycling, or other waste. Directions to the nearest facility can be 

enabled so users can quickly find the facility they are looking for. 

Follow the steps below to enable directions. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Self Service 
Facilities app. 

2. From the item page, click Configure App. 

  Close the Welcome to the App Setup Page splash page, if necessary. 

3. Click Nearby > Options and turn on the Show directions toggle button. 

4. Check the check box next to the Self Service Facilities layer. 

5. Click Publish. 

6. Click Confirm. 

  The Authorize premium content window appears with information related to 
authorization. 

7. Click Authorize. 

8. Click Launch. 

 

Populate operational hours 
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Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

This solution leverages the Opening Hours Specification to display operating hours for a place 

or service. When you populate the data fully, Arcade expressions interpret the data and 

display the operating hours in a human-readable format in the map pop-up. Understanding the 

data specification and options in the expressions will help you populate your data and display 

it in the maps and apps provided with the ArcGIS Solution. 

 

Operating Hours specification 
The Operating Hours Specification allows you to store a combination of operating hours in a 

single field but relies on a series of data standards to render the information correctly. To 

ensure operating hours are displayed correctly, follow the standards below: 

• Enter all times using a 24-hour clock without a leading 0—for example, Tu (7:00-19:00). 

• Use a two-letter abbreviation for each day, with the first letter capitalized—for example, 
Mo, Tu, We, Th, Fr, Sa, Su. 

• When a location is open 24 hours a day, use 24 Hours—for example, Mo (24 Hours). 

• When a location is closed on a specific day, use Closed—for example, Sa-Sun (Closed). 

• Enclose all times and closed statuses in parentheses—for example, Tu (7:00-19:00); We-
Mo (Closed). 

• Separate days and ranges with a semicolon to denote the two (or more) groups—for 
example, Th-Fr (7:00-19:00); Sa (24 Hours). 

Using the standards above, a diverse set of operating hours can be populated for your places 

and services. Some common examples include the following: 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. seven days a week, populate the 
operating hours field with the following: Mo-Su (9:00-17:00). 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. during the week and closed on 
weekends, populate the operating hours field with the following: Mo-Fr (9:00-17:00); Sa-
Su (Closed). 

• To specify the place is open one day (Tuesday) a week, populate the operating hours 
field with the following: Tu (7:00-19:00); We-Mo (Closed). 

• To specify the place has operating hours that vary by day, populate the operating hours 
field with the following: Mo-Tu (9:00-17:00); We (Closed); Th-Fr (7:00-19:00); Sa (24 
Hours); Su (Closed). 

Operating hours data can be populated all at once for many places and services using 

Calculate field values or uniquely entered for each place or service using an application 

provided with the solution. 
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Populate calendar 
This solution leverages Arcade to populate and display a calendar showing when the next 

curbside services will occur. When you populate the data fully, the Arcade expression 

interprets the data and displays the curbside services on a calendar. 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

 

Pickup schedule 
Pickup schedules are stored as unique schedules for areas in your community. The 

information below outlines how the information should be structured: 

• Use the Schedule field to indicate how often curbside pickups will occur. 

• Use the Pick Up Day field to indicate which day of the week curbside pickups will occur. 

• Use the Pick Up Week field to indicate which week a monthly pickup will occur. 

Pickup Schedules can be populated all at once for many areas using Calculate field values or 

uniquely entered for each place or service using an application provided with the solution. 

 

Arcade expressions 
The Arcade expression includes several settings that allow you to configure the look and feel 

of what is displayed in the web map pop-up. The expression works with the pickup data and 

web map pop-up configurations to display calendar information in your map and app. 

This solution includes Arcade expressions. Tod modify one of these expressions, compete the 

following steps: 

1.  Verify that you are signed in to your ArcGIS organization and browse to the Curbside 
Service Areas map. 

2. Open the item page and click Open in Map Viewer.  

3. Click More and click Configure Pop-ups on the Trash layer. 

4. Click Manage, double-click the Arcade expression you want to modify. 

  Each Arcade expression has a set of variables that can be configured according to your 
organization’s needs. Review the expression notes and modify the variables as needed. 
Do not change anything else in the expressions. 

5. Click OK. 
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Use My Trash Services 
The My Trash Services solution delivers a set of capabilities that help you share typical waste 

pickup schedules with the public, highlight schedule changes, and promote nearby recycling 

centers and the materials accepted. 

In this topic, you'll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Discover trash service information 
Trash services have a huge impact on everyday life but often run behind the scenes in a 

community. To provide cleaner and healthier communities, mapping technologies can help 

inform the public about curbside services, self service facilities, and provide a way for non 

emergency requests to be made. 

In these workflows, you will assume the role of a resident, or member of the public, who wants 

to understand what curbside services are available and where to bring trash, recyclables, or 

other waste. Finally, you will request a large item pick up at your residence by notifying the 

city of your need. 

 

View curbside pickup schedule 
1. In a browser, go the My Trash Services site. 

2. Scroll down to the When is My Trash Pick up? section and review the Curbside Service 
Areas app.  

  Use the Curbside Service Areas app to learn about curbside services offered for your 
address. 

3. Type an address in the search text box and press the Enter key, or click the suggested 
address. 

4. Review the list of services offered for the entered address. 

  You can see the schedule for Trash, Recycle, and Yard Waste pick up and get 
information regarding special pick up events. 

 

Find self service facilities 
1. In a browser, go the My Trash Services site. 

2. Scroll to the Where Can I bring Trash or Recycling section and launch the Self Service 
Facilities app. 

3. Type an address in the search text box and press the enter key, or click Search this 
area.  

4. Click Filter and check the Electronics check box to filter the map. 

5. Click Close. 
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6. In the search results, click the first search result. 

  The map pans to the corresponding facility. 

 

Request trash service 
1. In a browser, go the My Trash Services site. 

2. Scroll down to the Request Service section and click the Submit Request button to 
launch the Trash Requests form. 

3. Click the Select Request Type drop-down and choose Large Item Pickup. 

4. Click the map to set the location of the service request, use the device's location, or typ 
an address in the map search box. 

5. Use the form to provide optional information such as additional details, photos, and 
contact information. 

6. To complete your service request, click Submit. 

 

Triage service requests 
Staff can use the Trash Request Manager app to triage trash service requests from the 

community. This allows staff to monitor and address small issues before they become too big, 

costly, or unsafe for your community. 

You will assume the role of an operations manager responsible for providing status updates 

on service requests. You will use the Trash Request Manager app to triage submitted reports 

and update the status of reports as they move through the queue. 

1.  Sign in to your ArcGIS organization and browse to the Trash Request Manager form. 

2. From the item page, click View. 

3. Click the Request Type drop-down arrow and choose Large Item Pickup. 

4. In the Trash Requests table, identify and click the service request you reported. 

5. Review the details of the service request in the lower left corner of the app. 

6. In the app, click the Edit record button . 

7. Click the Status drop-down arrow and change the status to Received 

  As new service requests are submitted by the community, update the status to Received 
to acknowledge receipt of the new request. Continue to update the status of the request 
as you further investigate, prepare to address, and complete or cancel the service 
request. 

8. Click Save. 
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Neighborhood Early Warning 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Neighborhood Early Warning 
Neighborhood Early Warning can be used to identify neighborhoods trending in a positive or 

negative direction and ultimately measure the fragility of neighborhoods over time. 

It leverages authoritative data and key indicators (for example, blight violations, demolitions, 

crime, utility shutoffs, sales, rental units) to identify tipping neighborhoods. The resulting maps 

are a foundation for public education and awareness campaigns, operational improvements, 

and community-based policy discussions. Neighborhood Early Warning is typically 

implemented by planning departments, building officials, health and human services agencies, 

blight task forces, and other local government agencies that monitor neighborhood change 

over time, investing in stabilization programs and need to evaluate whether their investments 

are effective. 

The Neighborhood Early Warning solution delivers a set of capabilities that help you create a 

neighborhood change index, measure the fragility of neighborhoods over time and share the 

results with key stakeholders. 

 

Requirements 
Neighborhood Early Warning requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 -2.9 (Basic, Standard, or Advanced) 

 

Information products 
Neighborhood Early Warning includes the following information products: 

Item Description Minimum user 
type 

Neighborhood 
Early Warning 

An ArcGIS Pro project used by data analysts to 
identify neighborhoods trending in a positive or 
negative direction and ultimately measure the fragility 
of neighborhoods over time 

GIS 
Professional 
Basic 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Neighborhood Early Warning 
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Use Neighborhood Early Warning 
The Neighborhood Early Warning solution delivers a set of capabilities that help you create a 

neighborhood change index, measure the fragility of neighborhoods over time and share the 

results with key stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Identify neighborhood change 
The Neighborhood Early Warning project can be used to understand neighborhoods trending 

in a positive or negative direction and ultimately measure the fragility of neighborhoods over 

time. 

You will start by assuming the role of a data analyst in a neighborhood revitalization task force 

responsible for organizing key neighborhood indicators. You are asked to use the 

Neighborhood Stabilization project to identify neighborhoods trending in a positive or negative 

direction. 

1. From the Neighborhood Stabilization solution, click the Neighborhood Stabilization item 
under Solution Contents to open the item details of the desktop application template. 

2. Click Download and place the contents on your computer. 

3. Using Explorer, browse to the NeighborhoodEarlyWarning.zip folder and extract it. 

4. Open the Neighborhood Stabilization ArcGIS Pro project. 

5. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

6. In the Catalog pane, expand Maps and review the maps provided. 

Note: 

The map provided in this project is used by data analysts to identify neighborhoods 
trending in a positive or negative direction and ultimately measure their fragility over 
time. 

7. In the Catalog pane, expand the Tasks folder, and double-click the Neighborhood Early 
Warning task. 

8. In the Tasks pane, click the How to Use Neighborhood Early Warning task group to 
expand the collection of tasks. 

9. Follow the steps in each task. 
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Neighborhood Stabilization 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Neighborhood Stabilization 
Neighborhood Stabilization can be used to understand current property conditions, return 

blighted properties to productive use, and engage the public in neighborhood stabilization 

conversations. 

It provides neighborhood stabilization program managers the ability to develop strategies that 

assist in the rehabilitation of properties that might otherwise become sources of abandonment 

and blight. The result can be used to rehabilitate, resell, or redevelop properties in order to 

stabilize neighborhoods and help to curtail the decline of property values in neighborhoods. 

Neighborhood Stabilization is typically implemented by planning departments, building 

officials, health and human services agencies, and other local government agencies that want 

to develop a location-driven approach to neighborhood stabilization. 

The Neighborhood Stabilization solution delivers a set of capabilities that help you conduct 

property surveys, measure the fragility of neighborhoods, track blight, demolition activity, and 

publish a focused set of information products for citizens in your community. 

 

Requirements 
Neighborhood Stabilization requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 -2.9 (Standard or Advanced) 
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Information products 
Neighborhood Stabilization includes the following information products: 

Item Description Minimum user 
type 

Neighborhood 
Stabilization 

An ArcGIS Hub site used by the general public to 
access blight complaints, track demolition activity, 
locate mortgage or housing counselors, and conduct 
property surveys 

Not required 

Blight Status 
Dashboard 

An ArcGIS Dashboards app used by local 
government leaders to proactively monitor the status 
of blight complaints and efforts made to reduce 
blighted properties 

Viewer 

Demolition 
Tracker 

An ArcGIS Web AppBuilder app used by the general 
public to track building demolitions and the financial 
cost to a community 

Not required 

Mortgage 
Counseling 
Locator 

An ArcGIS Web AppBuilder app used by the general 
public to locate mortgage or housing counselors in a 
community 

Not required 

Tax Liability 
Calculator 

An ArcGIS Survey123 form used by citizens to 
compute their estimated tax liability 

Not required 

Property 
Condition Survey 

A Photo Survey app used by local governments to 
publish street-level photo collections, conduct 
property surveys, and automate the classification of 
property condition using ML/AI 

GIS 
Professional 
Standard 

Neighborhood 
Early Warning 

An ArcGIS Pro project used by data analysts to 
identify neighborhoods trending in a positive, or 
negative, direction and ultimately measure the 
fragility of neighborhoods over time 

GIS 
Professional 
Standard 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Neighborhood Stabilization 
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Configure Neighborhood Stabilization 
Learn how to configure the Neighborhood Stabilization solution to meet specific needs in your 

organization. 

 

Load data 
Neighborhood Stabilization can be used to understand current property conditions, return 

blighted properties to productive use, and engage the public in neighborhood stabilization 

conversations. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 

workflow below. 

Note: 

Prior to loading data, ensure you populate the Status field in DemolitionSites with values 
represented in the layer: Planned Demolition, Contracted Demolition, or Completed 
Demolition. 

 

Load data from a shapefile 
Data for DemolitionSites or MortgageCounselingFacilities can be loaded from a shapefile by 

following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 
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Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Configure property surveys 
Blighted and vacant structures can have a significant impact on property value and may have 

substantial remediation costs associated with them. Property Condition Survey can be used 

by local governments to publish street-level photo collections, conduct property surveys, and 

automate the classification of property condition using ML/AI. 

 

Publish a property survey app 
The Property Condition Survey app consumes the map you authored during the publish map 

step in the ArcGIS Pro project. 

To configure the Photo Survey app, complete the following steps: 

1. Using Windows Explorer, browse to the 
\Documents\ArcGIS\Packages\PropertyConditionSurvey\commondata\userdata\
PhotoSurvey folder and unzip it. 

2. Open the configuration.json file in Microsoft Notepad or another text editor. 

3. Enter the web map ID for your photo survey map, for example, "webmap": 
daa3eeae86954f4cba87c044466c4c2f. 

Note: 

The web map ID can be found at the end of the map URL in ArcGIS Online. For 
example, in 
http://myorganization.maps.arcgis.com/home/item.html?id=2ef11dad8ff04
178b2b236e867e9c952, the web map ID is 2ef11dad8ff04178b2b236e867e9c952. 

4. Save and close the file. 

5. Copy the PhotoSurvey folder to your web server so it can be accessed as a website or 
virtual directory. In IIS, the default web server directory is <your 
directory>\Inetpub\wwwroot\. 

6. Browse to Start > Control Panel > Administrative Tools > Internet Information 
Services (IIS) Manage. 

7. Click <your server> > Sites > Default Web Sites. 

8. Right-click the web server directory folder for the app and choose Convert to 
Application. 

9. Choose the DefaultAppPool application pool. 

10. Click OK. 
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11. Begin using Property Condition Survey by browsing to http://<your 
server>/PhotoSurvey/default.htm. 

 

Configure the property survey app 
Use the configuration.json file to configure the Photo Survey app to your organization's needs. 

Photo randomization, guest access, thumbnail image display, and Twitter credentials can all 

be configured by modifying the following parameters: 

Parameter Description 

randomizeSelection Controls how the Photo Survey app will display photos. 

• True for random photo display (default) 

• False for ordered photo display 

allowGuestSubmissions Specifies if the Photo Survey app will allow guest or anonymous 
survey submissions. 

• True to allow guests (anonymous) to submit survey 
submissions 

• False to disallow guests (anonymous) to submit survey 
submissions 

showGuest Specifies if the Photo Survey app will allow guest or anonymous 
access. 

• True to allow guest (anonymous) access 

• False to disallow guest (anonymous) access 

thumbnailLimit Sets the maximum number of thumbnails displayed in the Photo 
Survey carousel. If the number of photos for a given property 
exceeds this number, the photo carousel will not be displayed in 
the app. 

includeOverviewMap Specifies if the Photo Survey app will include an overview map. 

• True to show overview map 

• False to remove overview map 

showSkip Specifies if the Photo Survey app will include a skip button. This 
requires all surveys to be submitted. 

• True to show skip button 

• False to remove skip button 

 

Configure survey questions 
There are several options available regarding the types of survey responses that can be 

displayed in the survey panel. Choose from the options below based on the structure of your 

data as well as the desired user experience. 

Once you have determined which response type to use, choose the appropriate options in the 

Survey Questions table. 
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Field Description Required information 

Field name in 
Photo Points 

Field name in the Photo Points layer that the 
survey response will be stored in. 

Field name 

Question Type Survey question type. Choose from the drop-
down list. 

Parent, Child 

Parent 
OBJECTID 

If the question should be dependent on the 
response to a parent question, add the parent 
ObjectID of this question. 

ObjectID 

Display 
Condition(s) 

Value required to display this question. Value 

Question Text Text displayed for each survey question. Text 

Question UI 
Type 

Available question types. Choose from the 
drop-down list. 

Button, List, Drop-
down list, Text, 
Number 

Image URL To display images on the survey panel, add the 
image URL. 

URL 

Image Position Position of image in the survey panel. Choose 
from the drop-down list. 

Before, After 

Required? If the question is required for the survey, 
choose from the drop-down list. 

Yes, No 

Question Order Order of the questions as they appear in the 
survey form. 

Numeric value 
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Use Neighborhood Stabilization 
The Neighborhood Stabilization solution delivers a set of capabilities that help you conduct 

property surveys, measure the fragility of neighborhoods, track blight, demolition activity, and 

publish a focused set of information products for citizens in your community. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Identify neighborhood change 
The Neighborhood Early Warning project can be used to understand neighborhoods trending 

in a positive or negative direction and ultimately measure the fragility of neighborhoods over 

time. 

You will start by assuming the role of a data analyst on a neighborhood revitalization task 

force responsible for organizing key neighborhood indicators. You are asked to use the 

Neighborhood Stabilization project to identify neighborhoods trending in a positive or negative 

direction. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Neighborhood 
Stabilization solution. 

2. Download the Neighborhood Early Warning desktop application template, and then unzip 
the folder. 

3. From the unzipped folder, open the Neighborhood Early Warning.aprx file in ArcGIS Pro. 

4. In the Catalog pane, expand Maps and review the maps provided. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

The map provided in this project is used by data analysts to identify neighborhoods 
trending in a positive or negative direction and ultimately measure their fragility over 
time. 

5. In the Catalog pane, expand the Tasks folder, and then double-click the Neighborhood 
Early Warning task. 

6. In the Tasks pane, expand the How to Use Neighborhood Early Warning task group to 
see the collection of tasks. 

7. Follow the steps in each task. 
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Perform property condition surveys 
Property Condition Survey uses location-enabled photos produced by many commercially 

available cameras and simplifies data processing so street-level photo collections can be 

gathered on a regular basis. Photo collections can then be used in the Property Condition 

Survey app or be classified using the Microsoft Custom Vision service to identify property 

where overgrowth, graffiti, and boarded windows may exist. 

Perform street-level photo acquisition 
To start, you’ll assume the role of a data analyst who needs to decide what type of camera will 

be used to acquire street-level photos. The Photo Survey toolbox has been designed to work 

with standard EXIF data captured by commercially available cameras, and there are several 

on the market that can be used to collect photos. 

When selecting cameras and planning photo collection for your community, consider the 

following questions: 

1. Is the camera well suited for diverse weather conditions, and can it be mounted on the 
side of a vehicle or on a window of a vehicle? 

2. Does the camera take photos at predefined intervals (for example, every two seconds) 
and acquire GPS coordinate values for each photo taken? 

3. Does the camera write photo data in a standard EXIF format? 

4. How many photos can be stored on a given camera, and how will you get photos off the 
device? 

5. How many vehicles will you use to acquire photos for your entire community? You will 
need two cameras for each vehicle used to acquire photos. 

6. What is the speed you will travel to acquire the photos? The slower you can drive, the 
more photos you will acquire for each property. 

7. What are the routes used to acquire photos? Will those routes cover every property in 
your community? 

8. Can you use vehicles (for example, trash trucks and street cleaners) or employees (for 
example, code enforcement officers and assessors) who already canvass the community 
to acquire photos? 

9. Would volunteer organizations working in your community partner with you to acquire 
photos? 

 

Review the Property Condition Survey project 
Now you will assume role of a data analyst on a neighborhood revitalization task force 

responsible for configuring the property condition survey. You are asked to configure the 

Property Condition Survey app using the map authored during the publish map step in the 

ArcGIS Pro project. 

1. Start ArcGIS Pro and open the Property Condition Survey project package from the 
active portal. 
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2. In the Catalog pane, expand Databases and review the sample survey questions 
provided with the Property Condition Survey project. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, if necessary, and then double-click the 
Property Condition Survey task. 

4. In the Tasks pane, follow the steps in the Property Condition Survey task to set up the 
Property Condition Survey app. 

 

Calculate blight probability 
Now you will assume role of a data scientist on a neighborhood revitalization task force 

responsible for configuring the Property Condition Survey. You are asked to calculate the 

blight probability in the images taken at street level to augment manual surveys. 

1. In a browser, go to Microsoft Custom Vision, and then sign in or create an account. 

Note: 

If you created an account, after your account has been created, be sure to accept the 
terms and conditions. 

2. If necessary, in the Azure Portal, create a resource group for Custom Vision. 

3. On the Custom Vision landing page, in the upper right, click the settings button. 

4. Copy the training key, prediction key, prediction resource ID, and prediction endpoint for 
your account. 

5. In the Property Condition Survey project, for the Detect Blight task, use the copied 
values. 

6. After you have run the Detect Blight task, review your results in the Photo Points layer 
published in the Publish Map task in the Property Condition Survey project. 

 

Survey the property condition 
Now you will assume the role of a community volunteer. You are concerned with 

neighborhoods in your community and want to contribute by completing the Property 

Condition Survey. 

1. In a browser, from the Neighborhood Stabilization solution, view the Neighborhood 
Stabilization ArcGIS Hub site. 

2. Scroll to the Understanding Neighborhood Conditions section, and then under 
Survey Property Conditions, click Learn More. 

The Property Condition Survey sign-in page appears. 
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3. Sign in with your Twitter credentials, if applicable, or click Guest to complete the survey 
anonymously. 

Tip: 

If you choose to sign in with your Twitter credentials, you can keep track of the total 
number of surveys that you’ve completed and your overall ranking. 

4. Answer the survey questions based on the photo that is displayed in the main panel. 

Tip: 

You can use the thumbnail images in the lower area of the screen to cycle through all 
the photos available for the property, if available. To select the photo that best shows 
the property, click the favorite button in the upper-left corner of the photo. 

5. Click Submit survey to complete the report. 

 

Track demolition activity 
Demolition activity can have a significant impact on property value and the financial cost to a 

community. Demolition Tracker can be used by the public to locate planned, contracted, and 

completed building demolition. 

Now, you will assume the role of a resident in a local community. You are concerned with 

where demolitions have occurred, where they are contracted and planned, and what the total 

cost is to the community. 

1. In a browser, from the Neighborhood Stabilization solution, view the Neighborhood 
Stabilization ArcGIS Hub site. 

2. Scroll to the Understanding Neighborhood Conditions section, and then under Track 
Demolition Activity, click Learn More. 

The Demolition Tracker opens. On the right, the Demolition Tracker widget lists the 
number of planned, contracted, and completed demolitions visible in the map extent. 

3. On the map, in the search field, type your address or zoom to a location directly on the 
map. 

The demolition information in the Demolition Tracker widget updates to the new map 
extent. 

4. In the Demolition Tracker widget, click Planned Demolitions to view specific 
addresses of buildings planned for demolition. 

5. Click a specific planned demolition address. 

On the map, a pop-up shows the demolition's neighborhood, use description, comments, 
planned date, and estimated cost. 

6. In the Demolition Tracker widget, click Contracted Demolitions to view specific 
addresses of buildings contracted for demolition. 

7. Click a specific contracted demolition address. 
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On the map, a pop-up shows the demolition's neighborhood, use description, comments, 
contractor, scheduled date, and quoted cost. 

8. In the Demolition Tracker widget, click Completed Demolitions to view specific 
addresses of buildings that have been demolished. 

9. Click a specific completed demolition address. 

  On the map, a pop-up shows the demolition's neighborhood, use description, comments, 
contractor, completed date, and actual cost. 

 

Monitor blight status 
Blight complaints can have a significant impact on property value and may have substantial 

remediation costs associated with them. Blight Status Dashboard can be used by local 

government leaders to proactively monitor the status of blight complaints and efforts made to 

reduce blighted properties. 

Now you will assume the role of a local government leader. You are concerned with where 

blight reports have been submitted and the resolution status. 

1. In a browser, from the Neighborhood Stabilization solution, view the Blight Status 
Dashboard app. 

The Blight Status Dashboard opens with an overview of the current blight-related reports. 

Note: 

The overview displays key metrics. This information gives management a quick 
overview of the number of blight reports in their community. 

2. At the lower left, click the Blight Dashboard tab and explore the blight reports. 

3. On the left side of the app, click the arrow to display the filter panel. 

Tip: 

You can pin the filter panel to the dashboard by clicking the pin in the upper-right 
corner. 

4. Use filters to refine the results by status or submission date. 

5. Below the map, in the Report Type panel, review the charts to see a breakdown of the 
report types. 
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Network Path Planner 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Network Path Planner 
Network Path Planner can be used to plan fronthaul routes to wireless equipment such as 5G 

sites, backhaul routes from wireless towers, and plan routes to residential neighborhoods or 

business locations. 

In a connected world, access to reliable broadband communications service is essential. To 

close existing coverage gaps and increase overall broadband speeds, public and private 

funding is pouring into the communications market and driving expansion of existing 

communications networks. Every day, communication organizations are building out 

broadband infrastructure to reach new customers and businesses. Before construction begins, 

communication organizations must design effective networks that balance capital costs with 

customer service. Simple tools that provide an efficient route to a proposed site reduce costs 

and increase revenue opportunities. Network Path Planner is typically implemented by 

telecommunications organizations that want to quickly develop cost effective, high-level 

network designs from their existing network to proposed sites. 

The Network Path Planner solution delivers a set of capabilities that help you optimize fiber 

routes and estimate investment costs. 

 

Requirements 
Network Path Planner requires the following: 

• ArcGIS Pro 2.9 or later (Advanced) 

• ArcGIS Network Analyst extension 

• SteetMap premium Extension or Network Dataset 
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Information products 
Network Path Planner includes the following information products: 

Item Description Minimum user 
type 

Network 
Path 
Planner 

An ArcGIS Pro project used by network planners to 
create a network route to help develop proposed 
network routes and quickly estimate the cost. 

GIS Professional 
Advanced 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • Updated and added ArcGIS Pro tasks to walk through new functionality. 

• Added new charts and cost estimating functionality to route results. 

• Updated Path Planner toolbox and fixed minor issues. 

1.0 • First release of Network Path Planner 
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Use Network Path Planner 
The Network Path Planner project can be used to plan fronthaul routes to wireless equipment 

such as 5G sites, backhaul routes from wireless towers, and plan routes to residential 

neighborhoods or business locations. 

 

Get started with the solution 
You will start by assuming the role of a network planner or wireless provider responsible for 

generating a proposed route for a series of 5G sites. You are asked to use the Network Path 

Planner project to identify the optimal network path for your organization. 

1. From the Network Path Planner solution, click the Network Path Planner V2 item under 
Solution Contents to open the item details of the desktop application template. 

2. Click Download and place the contents on your computer. 

3. Using File Explorer, browse to the NetworkPathPlannerV2.zip folder and extract it. 

4. Open the Network Path Planner ArcGIS Pro project. 

5. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

6. In the Catalog pane, expand Maps and review the maps provided. 

Note: 

The map provided in this project is provided with sample dataset to exercise the tools. 

7. In the Catalog pane, expand the Tasks folder, and double-click the Network Path 
Planner task. 

8. In the Tasks pane, click the How to Use Network Path Planner task group to expand 
the collection of tasks.  

  This task group provides high level information about the solution. 

 

Getting to know Network Path Planner 
This solution is designed for telecommunication organizations that want to generate optimized 

route planning for backhaul routes, fronthaul routes and routes to service business and 

residential customers. Learn about how to use the solution and requirements to get started by 

using the task-based workflows provide key information. 

This task group includes the following task 

• Understanding Network Path Planner 
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Create a network dataset (optional) 
A network dataset is required to generate optimized network path. The following tasks provide 

steps on how to creating network datasets using sample data. If your organization utilizes 

StreetMap Premium skip to the How to use Network Path planner task group. 

This task group includes the following tasks: 

• Create a basic network dataset 

• Create a network dataset with element evaluator 

 

How to use Network Path Planner 
The network path planner solution is key to planning network expansion project. These tasks 

are a guide to help you prepare key data, generate optimized network paths, and review route 

results. 

This task group includes the following tasks: 

• Prepare data 

• Route Modifiers 

• Generate paths 

• Explore the results 

• Add costing to results 

• Share results 
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Operations Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Operations Management 
Operations Management can be used to respond to an event and manage resulting missions. 

It empowers military organizations with the ability to capture real-time data related to the event 

and mission development. Leadership is able to review reports submitted by operations 

personnel from any connected device. The solution enables immediate interaction between 

the technology and military personnel allowing for rapid information dissemination and 

intelligent decision making. Operations Management is typically implemented by 

organizations, such as the Army National Guard, that want to take a data-driven approach to 

plan, manage, and understand current missions associated with events. 

The Operations Management solution delivers a set of capabilities that help you to capture 

and update event and mission details, allocate resources, and gain situational awareness of 

resources and tasks against designated missions. 

 

Requirements 
Operations Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 
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Information products 
Operations Management includes the following information products: 

Item Description Minimum 
user type 

Operations 
Dashboard 

An ArcGIS Dashboards app with embedded ArcGIS 
Survey123 used by operations staff to enter events, 
missions, status reports, and field reports. 

Editor 

Operations 
Management 
Dashboard 

An ArcGIS Dashboards app used by leadership to 
monitor events, missions, status reports, and field 
reports. 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Operations Dashboard that allows operations staff to manage the life 
cycle of an event and associated missions. 

• A new Operations Management Dashboard that allows operations staff to 
view status reports and field reports. 

• Multiple layers are shared with the Civil Support solution and can be utilized 
for tasking workflows during mission coordination. 

1.0 • First release of Operations Management 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 534 

Configure Operations Management 
In this topic, you will learn how to configure the Operations Management solution to meet 

specific needs in your organization. The apps included with the Operations Management 

solution come with Survey123 reports. Follow the steps below to configure the solution. 

 

Configure solution 
Once Operations Management has been deployed, you can make optional configurations to 

the solution. Follow the steps below to configure the Operations Dashboard and the 

associated surveys. 

 

Add data sources 
The Operations Management solution allows operations management personnel to enter 

details about events and missions supporting events. It can be helpful to add additional data 

to provide context for feature entry and management. 

The layers listed below can be added to the map to provide further context when entering new 

events, missions, status reports, and field reports. 

Learn more about how to add layers to a map. 

• State and county layers 

• States map service 

• Counties map service 

• COVID-19 cases data feed 

• ArcGIS Living Atlas layers 

• National Weather Service Severe Events 

• National Weather Service Extreme Events 

• NOAA Web Services 

• NOAA Base Reflectivity Radar 

 

Extend the Operations Management Dashboard 
The Operations Management Dashboard is preconfigured to display all units under the 

Assigned To section within the Survey123 form. It also displays default mission statuses. You 

may need to configure the dashboard to align with your organization. 

 

Add a battalion 
To add additional battalions or companies to the dashboard, complete the following steps: 
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1. Browse to the Operations Management Dashboard and click Edit Dashboard. 

2. In the Mission Assignment/Stage serial chart element, click the Configure button . 

3. Go to the Data tab, select the Filter window, and under the Assigned To window, select 
Include. At this point, you will add only the units of interest and nothing else will be 
included. 

4. Save your application. 

 

Modify mission stage 
The dashboards are preconfigured to display various stages. The stages can be modified or 

removed. If your organization uses a stage that is not included, ensure a new category is 

added to the Survey123 form before adding it to the Operations Management Dashboard. To 

modify the mission stages, complete the following steps: 

1. Select any Mission Stage element and go to Editing Features. 

2. Click the Duplicate button  to copy the setting of the existing indicator elements to 
add a new category. Make sure that the new category has been added to the Survey123 
form first. 

3. Remove the stage element by clicking the delete button . 
4. Save your application. 

 

Modify lists 
The dashboards included in this solution come with preselected and basic fields within their 

appropriate lists. Additional fields can be turned on when configuring your solution to better 

address your organization's needs. To modify lists, complete the following steps: 

1. Click the Configure button  for any of the list components within the dashboard. 

2. Select the List tab and click Insert  to see the field options available. 

3. Select one or multiple fields to be added to the display. 

4. Add a label in front of your field item. 

5. Click Done. 

6. Save your application. 
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Use Operations Management 
The Operations Management solution delivers a set of capabilities that help you to capture 

and update event and mission details, allocate resources, and gain situational awareness of 

resources and tasks against designated missions. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Manage missions 
The Operations Dashboard provides operations staff with a single interface to establish events 

along with their related missions. In addition, surveys within Operations Dashboard can be 

used to provide status reports, field reports, and manage the lifecyle of events and missions 

from start to end. Command leadership can remain aware of current and historical missions in 

the Operations Management Dashboard. New events and missions can be added as 

frequently as needed. 

 

Enter a new event 
You will start by assuming a role as a member of the operations staff National Guard. The 

governor has issued a request for assistance to the National Guard, in response to a 

hurricane that is due to touch down in Miami-Dade County. Your commanding officer has 

asked you to manage the entry of the event and related missions so that leadership can gain 

quick understanding as the situation progresses. You will start by using the Event Entry 

survey to capture the hurricane as a new event. 

To capture a new event using the Event Entry survey, complete the following steps: 

1. In a browser, go to your Operations Dashboard.  

2. Select the Add Event tab in the lower right and fill in the following details:  

Parameter Value 

Event ID Type EVENT001. 

Include RFA 
Information 

Select No. 

Begin Date Select the date 07/15/2022. 

End Date Select the date 07/22/2022. 

Location Draw a polygon along the Miami-Dade County area. 

Event Type Select Weather. 

Event Sub 
Category 

Select Hurricane. 

Event 
Description 

Type Hurricane Olga is moving at 15 mph with high winds of 
175 mph. Hurricane Olga is approaching the Miami-Dade 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 537 

County geographical area and is located approximately 300 
miles from the Florida coastline. 

3. Click Submit. 

 

Enter a new mission 
Maintaining the same role as a member on the operations staff, you have now been asked to 

start entering the missions related to Hurricane Olga. You will use the Mission Entry survey to 

enter mission information. 

To enter information related to a new mission, complete the following steps: 

1. In a browser, go to your Operations Dashboard or refresh your current browser if you 
have just entered the event. 

2. Select EVENT001 from the Event List. 

3. Select the Add Mission tab in the lower right. Notice that the EVENT001 Event ID is 

automatically showing as part of the new Mission Entry.  

4. In the Mission Entry survey, fill in the following details: 

Parameter Value 

Mission ID Type MISSION001. 

Location Type Lat: 25.79496 Lon: -80.12594. 

Start Date Select the date 07/15/2022. 

End Date Select the date 07/22/2022. 

Mission Type Select Personnel Support. 

Mission Description Type 50 personnel are needed to fill sandbags and 
place them in designated areas. 

Mission Stage Select Pending Approval. 

Mission Priority Select Medium. 

Battalion Select 1st Battalion. 

Company Select B Company. 

Personnel Information Select Yes. 

Personnel Details Select Other. 

Enter # of Other 
Personnel 

Type 50. Total Personnel will automatically fill. 

Vehicle Information Select Yes. 

Vehicle and Aircraft 
Details 

Select Land Vehicles. 

Land Vehicle Type Select Utility Truck and type 5 for the Quantity. 

Estimate Cost Select Yes. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 538 

Estimate Mission 
Cost/Day 

Type 5000. 

Submitter POC Details Enter your name and contact information. 

Ground Commander 
POC Details 

Enter commander point of contact details. 

5. Click Submit. 

 

Enter additional missions 
It is likely that there will be several similar missions taking place in a response to an event. In 

this exercise, you will use the Operations Dashboard to enter several additional sandbagging 

missions. 

To quickly create additional sandbagging missions, complete the following steps: 

1. Select MISSION001 from the Mission List.  

2. From the pop-up, select Copy Mission. Once the survey loads, notice that it is an exact 
copy of MISSION001. 

3. In the Mission Entry survey, modify the following details: 

Parameter Value 

Mission ID Change MISSION001 to MISSION002 . 

Location Change Lat: 25.79496 Lon: -80.12594 to Lat: 25.80076 Lon: -
80.12482. 

Mission 
Description 

Change 50 personnel are needed to fill sandbags and place 
them in designated areas. to 25 personnel are needed to 
fill sandbags and place them in designated areas. 

Battalion Change 1st Battalion to 2nd Battalion. 

Company Change B Company to E Company. 

Enter # of Other 
Personnel 

Change 50 to 25 . Total Personnel will automatically fill. 

Land Vehicle 
Type 

Change 5 to 3 for the Quantity. 

Estimate 
Mission 
Cost/Day 

Change 5000 to 2500. 

4. Click Submit. 

5. Return to Operations Dashboard and verify MISSION002 shows in the Mission List and 
map. 
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Monitor events and missions 
Now, you will assume a leadership role in the National Guard. Your job is to monitor your 

unit's open events and missions to determine if there are any that require your attention. You 

will view the stages of all missions and then look more closely at specific missions, including 

trends like estimated cost and which unit the mission has been tasked to. 

To evaluate information related to events and missions, complete the following steps: 

1. In a browser, go to your Operations Management Dashboard. 

2. Use the filters in the left panel to narrow down the missions. 

You can filter by status of event, event name, status of mission, and mission name. 

3. Start by reviewing MISSION001. After selecting it from the Select Mission filter, notice 
that the dashboard updates to reflect information related to that mission.  

Information related to the mission stage, allocated personnel, allocated vehicles, cost, 
and location are updated once an event and/or mission is selected. Notice that there is 
no information currently visible for the status report and field report section. These can be 
populated by returning to the Operations Dashboard and using the specific tabs to submit 
the reports. 

4. Change the selection in the Select Mission filter to MISSION002. As the dashboard 
updates to show details for MISSION002, make note of the mission assignment/stage, 
number of personnel and vehicles requested, location, and estimated cost. This 
information can be relayed to the Adjutant General for event status, or a decision made 
and passed back to the operations staff to approve or deny a proposed mission. 

 

Manage mission stages 
You will go back to assuming a role as a member of the operations staff. After leadership used 

the Operations Management Dashboard dashboard to review ongoing missions, they 

determined that there were not enough resources to conduct MISSION002. You will use the 

Operations Dashboard to change the status of MISSION001 and MISSION0In a browser, go 

to your Operations Dashboard.  

1. Select MISSION002 from the Mission List. 

2. Select Edit Mission from the pop-up. The Mission Editor survey loads for MISSION002 . 

3. In the Mission Editor survey, modify the following details: 

Parameter Value 

Provide Additional 
Details 

Select Yes. 

Enter Additional 
Details 

Type  Mission declined by Unit Commander. Not enough 
resources available to conduct mission. 

Mission Stage Change Pending Approval to Declined 

4. Click Submit. 

5. Return to Operations Dashboard and verify the stage label reflects as Declined for 
MISSION002 in the Mission List and the symbology is updated in the map. 
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Provide a status report for a mission 
During the life cycle of a mission, it is common for leadership to request a status report for 

ongoing missions. Remaining in an operations staff role, you will assume that leadership has 

requested a 72 hour outlook for MISSION001. 

1. In a browser, go to your Operations Dashboard.  

2. Select MISSION001 from the Mission List. 

3. Select the Add Status Report tab in the lower right. Notice that the EVENT001 Event ID 

is and MISSION001 Mission ID are automatically showing as part of the new Status 

Report.  

4. In the Status Report survey, fill in the following details: 

Parameter Value 

Date and Time:  Select the date 07/16/2022. 

Name: Enter your name. 

Email: Enter your email. 

Phone: Enter your phone number. 

Battalion: Leave autopopulated value of 1st Battalion unchanged . 

Company: Leave autopopulated value of B Company unchanged . 

Personnel 
Deployed 

Leave autopopulated value of 50 unchanged . 

Vehicles 
Deployed 

Leave autopopulated value of 5 unchanged . 

Equipment Status Select Amber. 

Add Notes Type 2 Utility trucks will need to be refueled prior to 
departure. 

Logistics Status Select Green. 

Logistics Status Type On Track. 

24 Hour 
Projection 

Type Refuel trucks and load sandbags/shovels. 

48 Hour 
Projection 

Type Arrive on site and fill/place 1000 sandbags. 

72 Hour 
Projection 

Type Return to armory for more sandbags and refuel. 

5. Click Submit. 

6. In a browser, go to your Operations Management Dashboard.  

7. Use the filters in the left panel to narrow down to MISSION001. 
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8. Notice that there is information related to the Status Report now present in the 
dashboard.  

 

Enter field report 
As a member of the operations staff, you will submit a field report on behalf of a guardsman 

who conducted an unplanned civilian rescue while responding to a mission. Although the 

guardsman does have the ability to download the survey to their phone to directly submit the 

report, they have opted to phone it in for you to enter. 

1. In a browser, go to your Operations Dashboard.  

2. Select MISSION001 from the Mission List. 

3. Select the Add Field Report tab in the lower right. Notice that the EVENT001 Event ID is 

and MISSION001 Mission ID are automatically showing as part of the new Field Report.  

4. In the Field Report survey, fill in the following details: 

Parameter Value 

Date and Time:  Select the date 07/18/2022. 

Name: Enter your name. 

Email: Enter your email. 

Phone Number: Enter your phone number. 

Location: Type Lat: 25.79679 Lon: -80.12552. 

Battalion: Leave autopopulated value of 1st Battalion unchanged . 

Company: Leave autopopulated value of B Company unchanged . 

What Happened: Type While driving back to resupply encountered 4 
civilians with flooded car. Assisted in tow and water 
rescue. 

Enter Names of 
Others Involved: 

Enter other names. 

Photo(s): Add 2 photos. 

5. Click Submit. 

6. In a browser, go to your Operations Management Dashboard .  

7. Use the filters in the left panel to narrow down to MISSION001. 

8. Notice that there is information and photos related to the Field Report now present in the 
dashboard.  

 

Close missions and event 
In order to maintain a clear operational picture for leadership, it is necessary to close missions 

and events which are no longer ongoing. You will assume the role of an operations staff 

member who was just informed that all missions and events are now over. You will use the 
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Operations Dashboard with the Mission Closer and Event Closer to close the missions and 

events. 

1. In a browser, go to your Operations Dashboard.  

2. Select MISSION001 from the Mission List. 

3. Select Close Mission from the pop-up. The Mission Closer survey loads for MISSION001. 

4. In the Mission Closer survey, fill in the following details: 

Parameter Value 

Mission Stage:  Select Complete. 

Closing 
Comments: 

Type Mission has been completed. Over 10,000 sandbags 
filled and placed. 

5. Click Submit. 

  Notice that MISSION001 has now been removed from the Mission List and map in the 
Operations Dashboard. Closed missions can still be viewed by using the Mission Status 
filter in the header of the dashboard to select Closed or All. 

6. Select MISSION002 from the Mission List. 

7. Select Close Mission from the pop-up. The Mission Closer survey loads for MISSION002. 

8. In the Mission Closer survey, fill in the following details: 

Parameter Value 

Closing 
Comments: 

Type Mission was declined and hurricane response is 
complete. 

9. Click Submit 

10. Select EVENT001 from the Event List. 

11. Select Close Event from the pop-up. The Event Closer survey loads for EVENT001 . 

12. In the Event Closer survey, fill in the following details: 

Parameter Value 

Event Closing 
Comments: 

Type Hurricane Olga and all mission responses are 
complete. Closing event. 
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Outage Damage Assessment 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Outage Damage Assessment 
Outage Damage Assessment can be used to perform damage assessments and respond to 

outages caused by severe weather conditions and emergency incidents. 

Electric utilities and communication organizations have technology systems that allow 

customers to report outages. But after a severe weather event, or emergency incident, they 

need to gather field intelligence. This field intelligence helps utilities and communication 

organizations understand the extent of damage and quickly allocate storm restoration crews. 

Outage Damage Assessment is typically implemented by electric utilities and communication 

organizations that want to quickly assess the extent of damage, effectively allocate crews, and 

make informed decisions during storm restoration. 

The Outage Damage Assessment solution delivers a set of capabilities that help you collect 

damage reports, manage field assignments, and monitor the impact of a severe weather, or 

emergency, incident on electric utility and communication assets. 

 

Requirements 
Outage Damage Assessment requires the following: 

• ArcGIS Enterprise 

• ArcGIS Notebook Server 

• ArcGIS Workforce 

• ArcGIS Field Maps 
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Information products 
Outage Damage Assessment includes the following information products: 

Item Description Minimum 
user type 

Damage 
Assessment Center 

An ArcGIS Experience Builder application used by 
dispatchers and office staff to create, manage, and 
monitor damage assessments 

Creator 

Damage 
Assessment 

An ArcGIS Workforce project used by dispatchers and 
office staff to manage damage assessment 
assignments. Field assessors access the project using 
the ArcGIS Workforce mobile app. 

Mobile 
Worker 

Damage 
Assessment 
Locations - Field 
Assessor 

An ArcGIS Field Maps map used by a field assessor to 
capture damaged assets 

Mobile 
Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • Updated the Download Photo Attachments notebook. 

1.0 • First release of Outage Damage Assessment 
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Configure Outage Damage Assessment 
In this topic, you will learn how to configure the Outage Damage Assessment solution to meet 

specific needs in your organization. 

 

Assign personnel to ArcGIS Workforce 
The Outage Damage Assessment solution includes an ArcGIS Workforce project used by a 

dispatcher to assign damage assessment assignments to the field assessors. Before the 

solution can be used, the named user accounts of each dispatcher and field assessor must be 

added to the Workforce project in the dispatcher and mobile worker roles, respectively. 

1. Sign into your ArcGIS organization. 

2. Go to the App Launcher, then click Workforce. 

3. Mouse over Damage Assessment, then click Configure. 

4. Click Users. 

5. Use the Organization User drop-down list to select a user. 

6. Use the Project Role drop-down list to select the role for that user. 

7. Click Add User. 

8. Repeat this process for each of your dispatchers and field assessors. 

Learn more about assigning personnel to a ArcGIS Workforce project 

 

Add asset map layers (optional) 
The Outage Damage Assessment solution is configured with what you need to manage an 

outage event. Electric utilities and telecommunication organizations can add their asset layers 

to the maps to enhances the solution and provide situational awareness of existing assets. 

Follow the steps below to learn how to add your organizations electric or telecommunication 

data to the following maps. 

1. Open the Damage Assessment Locations - Manage map by clicking Open in Map 
Viewer Classic.  

2. Add your organizations electric or telecommunications asset data to the map. 

Note: 

Consider configuring layer names and pop-ups to meet your organizations needs. 

3. Click Save > Save to save the map. 

4. Repeat as needed with the following maps: Damage Assessment Locations - Field 
Assessor and Damage Assessment Dispatcher map. 
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Configure Damage Assessment Center (optional) 
The Damage Assessment Center app is pre configured as the central location to create, 

manage, and monitor damage assessments. Complete the following steps if you want to 

customize the ArcGIS Experience Builder app to fit your organizations needs. 

1. Navigate to the item page for the Damage Assessment Center app and click the Edit 
button.  

2. Click the Page button to open the page panel and select the Help page. 

3. Use the Body node of the page panel to navigate between each section. 

4. To update the text or images select the element in the layout and make the necessary 
changes.  

5. Click Save on the Experience Builder designer header bar, then click Publish.  
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Use Outage Damage Assessment 
Outage Damage Assessment can be used to perform damage assessments and respond to 

outages caused by severe weather conditions and emergency incidents. 

 

Prepare for an outage 
To prepare for an outage event, effective organizations train in advance of an event, using 

mock exercises to familiarize personnel with the processes and technology they will use in the 

field during a real outage. The Outage Damage Assessment solution includes mobile apps 

such as, ArcGIS Workforce and ArcGIS Field Maps, which mobile workers will need to be 

trained to use in advance of an outage event. 

In this workflow, you will assume the role of a manager that needs to educate office staff and 

field assessors involved in the damage assessment process. 

1. Before getting started with the solution, review and follow the configuration steps. 

2. Open the Damage Assessment Center app.  

3. In the app header, click the Help button. 

4. This page displays information that can be used in a training briefing to help teach office 
and mobile workers to use the apps included in the solution. The page is organized by 
application, with a tab for Damage Assessment Apps, Damage Assessment Manager, 
and Outage Damage Assessment Dashboard. 

5. Use the following sections assign damage assessments, conduct damage assessment, 
manage damage assessments, monitor impact and administer damage assessments to 
learn how to use the solution. 

 

Assign damage assessments 
Once an outage event has occurred the dispatcher identifies the location that needs to be 

assessed and assigns it to the field assessor. 

In this workflow, you will assume the role of a dispatcher who needs to assign damage 

assessments to field assessors so they can evaluate the impact of an outage. 

1. Open the Damage Assessment Center app.  

2. Click the Create button in the app header to open the Damage Assessment ArcGIS 
Workforce project. 

3. Click a location or asset on the map and then click Create Assignment. 

4. Select the Assignment Type as Damage Assessment. 

5. Assign a field assessor by selecting a name from the Assign drop-down menu. 

6. Optionally, select a Priority from the drop-down menu. 

7. Enter any comments in the Description field and click Create Assignments. 
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Conduct damage assessments 
After an outage event, damage assessments can be conducted by field personnel to 

determine the impact of the event. Using field apps with location-based information helps the 

organization prioritize repairs to the network. 

In the workflows below, you will assume the role of a field assessor who has been assigned to 

conduct damage assessments at a given location. 

 

Start assignments and collect damage locations 
As a field assessor, I need to start an assignment and collect the location of damaged assets 

in the field. 

1. Open the ArcGIS Workforce app and sign into your ArcGIS Organization.  

2. Open the Damage Assessment project. 

3. Tap on an assignment in the To do list to view its' location on the map and details about 
the assignment. 

4. Tap Start (iOS) or START (Android) to begin working on an assignment.  

5. Tap Open in Field Maps to begin collecting damage assessment locations. 

This will open the Damage Assessment - Field Assessor Map in ArcGIS Field Maps. 

6. Tap the Add button. 

7. Select the appropriate damage assessment type from the list of features to collect. 

  If the damaged location is added to an inaccurate location, or you want to move the point 
manually, move the crosshairs to the correct location by panning the map and tapping 
Update Point. This moves the added feature to the specified location. 

 

Complete damage assessments 
As a field assessor, I need to complete my damage assessment assignment. 

1. Open the Damage Assessment project in the ArcGIS Workforce app.  

2. Select the assignment and tap Finish to complete the assignment. 

  This will remove the assignment from your to do list. 

 

Manage damage assessments 
During the damage assessment process field assessors may require additional support from 

dispatchers when they lack connectivity. Using a pre configured app, dispatchers can help 

update the status of assignments, complete damage assessments, or add damage 

assessment locations. 

In the workflows below, you will assume the role of a dispatcher who needs to manage 

damage assessments conducted in the field. 
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Edit assignment status 
As a dispatcher, I may need to manage the status of a workforce assignment when field 

assessors do not have access to the internet. 

1. Open the Damage Assessment Center app. 

2. Click the Manage button in the app header to open the Assignment Manager app. 

3. Open the Assignment Editor widget. 

4. Select an assignment on the map. 

5. Select the appropriate status from the Status drop-down. 

6. Fill out the date and time for the status and click Save. 

 

Edit damage assessment status 
As a dispatcher, I need to manage the status of a damage assessment report. 

1. Open the Update Damage Status widget.  

2. Select the location(s) on the map using the Select tools. 

3. Select Completed from the Status drop-down. 

4. Select the date and time the damage location was completed and click Save. 

 

Add damage assessment location 
As a dispatcher, I may need to add a damage assessment location in the office when field 

assessors do not have access to the internet. 

1. Open the Add/Edit widget.  

2. Select the damage type and click on the map to add the new damage location.  

3. Enter Asset ID if necessary and any notes about the damage. 

4. Select Close at the bottom when done. 

 

Monitor impact 
Damage assessments can be used by electric utilities and telecommunication organizations to 

evaluate the severity and magnitude of an outage event. Mangers can monitor a high-level 

view of information about assigned work and damaged assets to determine the impact to their 

network. 

In this workflow you will assume the role of a manager who needs to review key metrics of 

damaged assets and assigned work. 

1. Open the Damage Assessment Center app. 

2. Click the Monitor button in the app header to open the Outage Damage Assessment 
Dashboard app. 
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3. Click the Assignments tab to view assignment statistics.  

4. Click the Damage Assessments tab to view damage assessment statistics. 

 

Administer damage assessments 
After an outage event is completed an organization may archive damages, download photos, 

and delete assessments records to prepare for a future event. 

 

Archive damage assessments 
When an outage event is over it is important to close out the damage assessments that have 

been resolved. You can archive all completed damage assessments to the format that works 

for your organization. The archived data can be used for reviewing past outage events and 

ensures you are ready to start conducting damage assessments for future events. The 

archived damage assessments can also be used as a backup in case of data loss. 

In this workflow, you will assume the role of a GIS Analyst that needs to archive data after an 

outage event and download the photos collected in the damage assessments. 

1. Open the Damage Assessment Center app.  

2. Click the Manage button to open the Damage Assessment Manager app. 

3. Click the Archive Data widget and click the Select button. 

4. Select the features on the map you would like to archive. 

5. Click the ellipse button next to each layer you would like archive and pick the format you 
want to export your data to. 

Note: 

Images will not be archived as attachments. 

As a GIS Analyst, I may want to export data from a hosted feature layer into a local file 

geodatabase after an outage event. 

1. Sign in and open the DamageAssessmentLocations item page for the features you 
want to export. 

2.  Click the Export Data button on the Overview tab and click Export to FGDB. 

To learn more go to the Export data from hosted feature layers page. 

As a GIS Analyst, I may want to delete data after an outage event is finished using a pre 

configured web app by completing the following steps: 

1. Open the Damage Assessment Center app.  

2. Click the Manage button to open the Damage Assessment Manager app. 

3. After archiving the data you can using the Add/Edit widget to delete the data. 

4. Use the New selection tool to select the locations on the map that need to be deleted. 
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5. Click the Delete button to remove the selected features. 

 

Download Photos 
Organizations may want to view photos captured during an outage event for future. You can 

use the Download Photo Attachments notebook to export photos into a zip file that can be 

shared with others. 

Note: 

You must be assigned a role of Administrator or custom role which includes the privilege 
to Create and edit notebooks in order to run an ArcGIS Notebooks and complete the 
following steps. 

As a GIS Analyst, I may want to download photo attachments from an outage event. 

1. Open the Download Photos widget and click the Download Photo Attachements 
button to open the Download Photo Attachments notebook. 

2. Click Cell > Run All to load the photo extraction form in this notebook 

Note: 

Do not refresh the page while the notebook is running. 

3. Enter a name for the item to be created. 

Note: 

Please note that assessments with a large number of photos may take several minutes. 

4. Click Generate Attachments Item to create the item. 

5. Click the item to open the attachment page. 

6. Click the Download button to download the file locally. 
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Parcel Drafter 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Parcel Drafter 
Parcel Drafter can be used to enter metes-and-bounds descriptions and check for closure 

errors in order to verify survey information prior to submission. 

It provides deed examiners up-to-date parcel information and a digital workflow for entering 

new metes-and-bounds land descriptions. This optimized approach helps organizations 

reduce the time required to process land description documents and share results between 

staff. Parcel Drafter is typically implemented by property appraisal departments, assessors, 

fiscal offices, and other local government agencies that want to improve their overall 

transaction time when a parcel related document is recorded. 

The Parcel Drafter solution delivers a set of capabilities that help you capture parcel 

boundaries as documents are filed and can be integrated into a larger land records workflow 

that produces a complete inventory of tax parcels, subdivisions, lots, and related 

encumbrances. 

 

Requirements 
Parcel Drafter requires the following: 

• ArcGIS Enterprise 

 

Information products 
Parcel Drafter includes the following information products: 

Item Description Minimum 
user type 

Parcel 
Drafter 

An ArcGIS Web AppBuilder app used by mapping technicians 
to enter metes-and-bounds descriptions and check for closure 
errors 

Editor 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 553 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Parcel Drafter 
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Configure Parcel Drafter 
Learn how to configure the Parcel Drafter solution to meet specific needs in your organization. 

 

Load data 
Parcel Drafter can be used to enter metes-and-bounds descriptions and check for closure 

errors to verify survey information prior to submission. In some cases, you may already have 

this information in ArcGIS or another business system. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 

workflow below. 

 

Load data from a shapefile 
1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Parcel Drafter 
The Parcel Drafter solution delivers a set of capabilities that help you capture parcel 

boundaries as documents are filed and can be integrated into a larger land records workflow 

that produces a complete inventory of tax parcels, subdivisions, lots, and related 

encumbrances. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Provide parcel descriptions 
Parcel Drafter can be used to provide metes-and-bounds descriptions and check for closure 

errors to verify survey information prior to submission. 

 

Add a parcel 
You will start by assuming the role of a mapping technician in a tax assessment office who is 

responsible for checking a new parcel description. You are asked to use Parcel Drafter to 

provide a metes-and-bounds description and check for closure errors to verify survey 

information prior to submission. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Parcel Drafter 
solution. 

2. View the Parcel Drafter app. 

3. Use the Search widget to find a parent parcel or address. 

4. Click the Enter a property description button to open the widget. 

5. In the widget, click the Start New Traverse button, and then either click the map or 
specify X,Y coordinates to start drafting a parcel. 

Before starting a new description, you will choose appropriate units. 

6. In the widget, at the top right, click the Settings button, and then use the drop-down lists 
to choose the units that best represent the units of the incoming document. 

7. At the top of the pane, click the Back arrow to return to the New Traverse template. 

8. Under New Traverse, to the left of Bearing, click the red connection line to open a drop-
down list. 

9. Choose either Boundary or Connection as the line type of your parcel traverse leg. 

10. For Bearing, Length, and Radius, type the dimensions of the parcel traverse, and then 
click the Add button on the right to add a new leg. 
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As you type the dimensions, the traverse lines are drawn on the map from the starting 
point. Optionally, you can use the Digitize tool below the New Traverse grid to manually 
draw the parcel boundaries. 

Tip: 

To provide a bearing in degrees/minutes/seconds using quadrant bearing, type the 
values in one of the following formats: 20-25-25-3 (3 is the shortcut for the southwest 

quadrant) or S20-25-25W. 

When providing a bearing in decimal degrees, type the value in the following format: 
20.2525. 

11. Optionally, update the angle and scale during the traverse to rotate and scale new lines. 

Tip: 

After providing the first line of the traverse (and if rotation or scale values have not 
been specified), you can rotate the line to fit the underlying geometry (for example, 
section line, parcels, or other survey lines). All subsequent lines will be applied this 
rotation, but the records, bearings, and distances will be captured as provided. 

12. Click Save. 

 

Edit parcels 
Next, you will assume the role of a mapping technician in a tax assessment office who is 

responsible for editing parcel descriptions. You are asked to use Parcel Drafter to edit a 

metes-and-bounds description and check for closure errors. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Parcel Drafter 
solution. 

2. View the Parcel Drafter app. 

3. In the Enter a property description widget, click Edit Traverse. 

4. Click an existing parcel, and then edit the traverse or attribute information. 

5. Click Save. 
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Parcel Value Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Parcel Value Analysis 
Parcel Value Analysis can be used to find comparable sales and visualize the impact of sales, 

foreclosures, and assessment appeals on property value in a neighborhood or tax district. 

It improves the quality of property valuations and provides property appraisers access to 

current property characteristics and neighborhood trends, ensuring that property is valued in a 

fair and equitable way. The result can be shared with property appraisers inside your 

organization and can be used to defend property valuations. Parcel Value Analysis is typically 

implemented by property appraisal departments, assessors, fiscal offices, and other local 

government agencies that want to take a visual, location-driven approach to property 

valuation. 

The Parcel Value Analysis solution delivers a set of capabilities that help you improve the 

overall quality of property valuations by accessing key operational layers from assessment 

and tax business systems; narrows a search of property sales by defining a price range, year 

built, and living area; and provides a high-level view into changes in property assessments 

and tax revenue within a local government. 

 

Requirements 
Parcel Value Analysis requires the following: 

• ArcGIS Enterprise 
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Information products 
Parcel Value Analysis includes the following information products: 

Item Description Minimum 
user type 

Value Analysis 
Dashboard 

An ArcGIS Dashboards app used by assessors to visualize 
the impact of sales, foreclosures, and assessment appeals 
on property value in a neighborhood or tax district 

Viewer 

Residential 
Comp Finder 

An ArcGIS Web AppBuilder app used by the general public, 
real estate agents, and appraisers to find comparable sales 
and related property information 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Parcel Value Analysis 
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Configure Parcel Value Analysis 
Learn how to configure the Parcel Value Analysis solution to meet specific needs in your 

organization. 

 

Load data 
Parcel Value Analysis can be used to share parcel, property sales, floodplain, and tax 

distribution information. In some cases, you may already have this information in ArcGIS or 

another business system. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or applications. 

Once you have determined what source data must be loaded, complete one or more of the 

data loading workflows below. 

 

Load data from a shapefile 
Load data for TaxParcels, SiteAddresses, SchoolDistricts, and TaxParcelSales from a 

shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Load tax distribution information 
To configure the Tax Distribution table in the TaxParcels layer in ArcGIS, you can use the 

sample .csv file included with the solution (TaxDistribution.csv). 

To load tax distribution from a spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the TaxDistribution item. 

2. On the item details page, click Download. 

3. Once downloaded, open the TaxDistribution.csv file and populate the Parcel ID, Total 
Tax, and Tax District distribution totals (in dollars). 

Note: 

After these tax values are populated, you can compute the percent of total tax dollars 
for each tax district and populate its corresponding Tax District % attribute, for 
example, (TXDIST1/TOTTX)*100 = TXDIST1PER or ($1500/$5000)*100 = 30%. 

4. Alternatively, you can use ArcGIS Pro to populate these values based on their spatial 
relationship with tax districts. 

5. In your ArcGIS organization, browse to the TaxParcels feature layer. 

6. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

7. Under Filename, click Choose File. 

8. Browse to your .csv file and click Open. 

9. Click Upload and Continue. 

10. From Choose the layer that you wish to append data into, select the Tax Distribution 
table to load data into. 

11. Uncheck Update existing features. 

12. Click Show field matching to map the fields. 

13. Map the Latitude field to the y-column and the Longitude field to the x-column. 

14. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Parcel Value Analysis 
The Parcel Value Analysis solution delivers a set of capabilities that help you improve the 

overall quality of property valuations by accessing key operational layers from assessment 

and tax business systems; narrows a search of property sales by defining a price range, year 

built, and living area; and provides a high-level view into changes in property assessments 

and tax revenue within a local government. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Analyze property value 
Value Analysis Dashboard can be used to visualize the impact of sales, foreclosures, and 

assessment appeals on property value in a neighborhood or tax district. 

 

Explore assessment neighborhoods 
You will start by assuming the role of a residential property appraiser in an assessment 

organization that is responsible for valuing property. You are asked to use the Value Analysis 

Dashboard to investigate specific assessment neighborhoods and identify assessed value 

outliers, analyze recent property sales, and review appeals and foreclosures. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Parcel Value 
Analysis solution. 

2. View the Value Analysis Dashboard. 

The Value Analysis Dashboard opens, showing information about sales, appeals, and 
foreclosures, as well as overall metrics regarding property value and total property tax 
outstanding. 

3. On the left, click the All Neighborhoods drop-down arrow and choose an assessment 
neighborhood to refine the results. 

4. Click the All Sales drop-down arrow and choose a date range to further refine the 
results. 

5. Explore the neighborhood and notice the range of assessed values.  

6. The parcels shaded in blue have higher values than parcels shaded in yellow. 

7. On the map, click a sale to see a pop-up with the sale's details and a description of the 
likelihood that this sale could impact property tax levied against the property. 

8. Review the high-level metrics about the neighborhood, including the current assessed 
value, current taxable value, and the overall taxes owed. 
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Locate comparable sales 
Now, you will assume the role of a residential property appraiser in an assessment 

organization that is responsible for valuing property. You are asked to use the Residential 

Comp Finder to investigate property sales by defining a price range, year built, and living area. 

The resulting list of properties sold can then be used to help determine the fair market value of 

a subject or prospective property. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Parcel Value 
Analysis solution. 

2. View the Residential Comp Finder app. 

3. On the right, in the Locate Sale widget, search for a parcel number, address, or school 
district, or click a location directly on the map. 

4. Optionally, adjust the buffer slider to see a larger list of potential businesses. 

5. Review the property's details, such as its address, parcel number, year built, floor area, 
assessed value, sale price, sales date, and sales ratio. 

6. Optionally, use filters to refine the results; for example, use the Sale Amount is between 
filter to find homes with sale prices between $250,000 and $350,000. 
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Park Infrastructure Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Park Infrastructure Management 
Park Infrastructure Management can be used to inventory park assets, understand asset 

condition, and communicate changing asset conditions that impact park services. 

Parks improve quality of life, protect natural resources, and enhance local economies. 

Unfortunately, park agencies are increasingly burdened with overuse and many times the first 

agency to receive funding cuts during an economic downturn. As a result, they are 

continuously balancing park asset maintenance needs with available funding. The first and 

most critical step park agencies must take to prioritize asset needs is to create a park asset 

inventory. Park Infrastructure Management is typically implemented by park agencies that 

want to understand what assets they have, plan improvements, and ensure guest safety. 

The Park Infrastructure Management solution delivers a set of capabilities that help you 

inventory park assets, understand asset condition, and communicate changing asset 

conditions that impact park services. 

 

Requirements 
Park Infrastructure Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Workforce 

• ArcGIS Field Maps 

• ArcGIS Survey123 

• ArcGIS Survey123 Connect 
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Information products 
Park Infrastructure Management includes the following information products: 

Item Description Minimum 
user type 

Park Assignments An ArcGIS Workforce project used by maintenance 
supervisors to manage inspection and maintenance 
assignments. 

Editor 

Park Field Map An ArcGIS Field Maps map used by park rangers to 
inventory, inspect and maintain park assets. 

Mobile 
Worker 

Park Request 
Manager 

A Crowdsource Manager app used by park operations 
staff to triage submitted problem reports and update the 
status of each report. 

Editor 

Park Request 
Dashboard 

An ArcGIS Dashboards app used by park operations 
staff to monitor park requests submitted by the general 
public and internal staff 

Viewer 

Park Asset 
Inventory 

A Sidebar app used by used by mapping technicians to 
create, edit, and review park assets. 

Editor 

Recreation 
Closure Manager 

An ArcGIS Web AppBuilder app used by public 
information staff to create and update recreation 
closures. 

Editor 

Create Park 
Assignment 

An ArcGIS Survey123 form used by park operations 
staff to create park assignments. 

Editor 

Park Request 
Internal 

An ArcGIS Survey123 form used by park rangers to 
submit service requests. 

Mobile 
Worker 

Park Request An ArcGIS Survey123form used by park visitors to 
submit service requests. 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Park Infrastructure Management 
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Configure Park Infrastructure Management 
In this topic, you'll learn how to configure the Park Infrastructure Management solution to meet 

specific needs in your organization. 

 

Load data 
Park Infrastructure Management can be used to inventory park assets, understand asset 

condition, and communicate changing asset conditions that impact park services. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 

workflow below. 

 

Load data from a shapefile 
1. In your ArcGIS organization, browse to the feature layer you wish to populate. 

2. On the feature layer item details page, Click Update Data and select Append Data to 
Layer. 

3. Under Filename, click Choose File. 

4. Browse to your .zip file and click Open. 

5. Click Upload and Continue. 

6. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

7. Uncheck Update existing features. 

8. Click Show field matching and map the fields between the two layers. 

9. Click Apply Updates. 

 

Modify inspection and maintenance types 
The Park Infrastructure Management solution helps you assess park asset condition and 

record maintenance activities. Inspection and maintenance types are defined on the 

ParkAssets feature layer and appear in the Park Field Map when park rangers are recording 

their work. In some cases, you may want to modify inspection and maintenance types to meet 

your organization’s needs 

1. Verify that you are signed in to your ArcGIS organization and browse to the ParkAssets 
feature layer. 

2. Open the item page and click the Data tab. 

3. Click the Layer drop-down and select Trails Inspection. 
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4. Click Fields. 

5. Click the Inspection Type display name. 

6. Click Create List. 

7. Type the new inspection type into the Displayed Value and Stored Value text boxes. 

8. Optionally, click Add to create additional inspection types. 

9. Optionally, click the Delete button to remove an inspection type from the list. 

10. Repeat steps 8 and 9 to add the remaining inspection types. 

11. Optionally, drag the category to a new location in the list to reorder them. 

12. Click Save. 

13. Click the Layer drop-down and select Trails Maintenance. 

14. Click the Maintenance Type display name. 

15. In the List of Values (Domain) section, repeat steps 6-12 to add maintenance types. 

16. Repeat this process for the remaining inspection and maintenance tables (Barriers, 
Gates, Roads, Structures). 

 

Administer field assignments 
The Park Infrastructure Management solution can be used to manage work such as data 

collection, routine and ad-hoc inspections, and maintenance assigned to park rangers. Types 

of assignments appear in the Park Assignments app used by park rangers as well, the Park 

Assignments ArcGIS Workforce project and the Create Park Assignment ArcGIS Survey123 

form. 

The Park Infrastructure Management solution includes several assignment types. In some 

cases, you may want to modify inspection and maintenance types to meet your organization’s 

needs. Park rangers and dispatchers also need to be assigned roles in the Park Assignments 

ArcGIS Workforce project. 

 

Administer park assignments 
1. Verify that you are signed in to your ArcGIS organization and click the Apps button  in 

the header of the site. 

2. From the app launcher, click Workforce to open the app. 

3. Under Projects, hover over the Park Assignments project, and click Configure. 

4. Click the Assignment Types tab. 

In the Assignment Type section, review existing types and identify ones that are not 

applicable and ones that are missing. 

5. Type a new assignment type in the Enter a new type text box then click + Type button. 

6. To remove assignment types, click the X button. 
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7. Click the Users tab. 

8. From the Project Role menu, assign the user either the dispatcher role or mobile worker 
role. 

9. Click +User. 

10. Click the Advanced tab. 

Each assignment type is integrated to the Park Field Map. This allows park rangers to access 

the Park Field Map from the ArcGIS Workforce app. As you add new assignment types, you 

may want to add the Park Field Map integration. 

11. In the ArcGIS Field Maps, click Edit on any of the existing Park Field Map integrations. 

Check the box next to the new assignment type. Click the Next button. 

12. Click the Done button. 

 

Update create park assignment form 
1. In your ArcGIS organization, browse to the Park Assignments feature layer. 

Before populating the new assignment types into the Create Park Assignment form, you will 

first copy the GlobalID for each new assignment type. 

2. Open the item page and click Open in Map Viewer. 

3. On the Contents (dark) toolbar, click Tables. 

4. Click Assignment Types layer. 

5. Click Tools in the table header and check the GlobalID field to show (unhide) in the 
table. Click Done to close the pop-up window. 

6. Expand the GlobalID field and copy each new assignment type's ID.  

7. Paste the copied GlobaIID or GlobalIDs into a text editor for reference. 

8. Install ArcGIS Survey123 Connect. 

9. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

10. Click Create Park Assignment to download the survey. 

11. In the Download window, click Download and click OK. 

12. Click Create Park Assignment to open the survey. 

13. On the left, from the side toolbar, click the XLSForm button. 

14. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 

This tab comprises all the selectable options for survey questions. 

15. In the list_name column type ASSIGN_TYPE.  

16. In the name column, copy and paste the GlobalID, before and after the GlobalID add 
curly braces. 

For example, {5b3e80df-aec7-4739-929f-8cb70cdbd62c}. 

17. In the label column, type the assignment type. 
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18. Repeat steps 15 through 17 for each new assignment type. 

19. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

20. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

21.  Click Publish survey to publish your changes, and then click OK. 

 

Modify service request types 
The Park Infrastructure Management solution can be used to solicit park requests for service 

from park rangers as well as the general public. Service request types appear in the Park 

Request Internal and Park Request ArcGIS Survey123 forms. 

The Park Infrastructure Management solution includes several service request types. In some 

cases, you may want to modify service request types to meet your organization’s needs, for 

example you may want some requests to be available to park rangers using the Park Request 

Internal form that are not available to the general public using the Park Request form. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Park Request to download the survey. 

3. In the Download window, click Download and click OK. 

4. Click Park Request to open the survey. 

5. On the left, from the side toolbar, click the XLSForm button. 

6. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 

This tab comprises all the selectable options for survey questions. 

7. In the list_name column type reqtype.  

8. Type the new service request type into the name and lable columns. 

9. Repeat steps 7 and 8 for each new service request type. 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

11. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

12.  Click Publish survey to publish your changes, and then click OK. 

13. Click Park Request Internal to download the survey. 

14. Repeat steps 3 through 12 to add new service request types to the Park Request 
Internal form.  
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Use Park Infrastructure Management 
The Park Infrastructure Management solution delivers a set of capabilities that help you 

inventory park assets, understand asset condition, and communicate changing asset 

conditions that impact park services. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Inventory and assess park assets in the field 
In many cases, a field assessment of existing park assets may be the most efficient way to 

develop a park asset inventory. The information collected in the field can then be augmented 

with other descriptive information that helps park staff or the general public view park 

information easily. 

You will assume the role of a park ranger in a park agency. In this workflow, you are asked to 

use the ArcGIS Field Maps mobile app to access your Park Field Map and inventory park 

assets. 

Collect park assets in the field 
1. Download ArcGIS Field Maps onto your mobile device. 

2. Open ArcGIS Field Maps and sign in to your ArcGIS organization. 

3. Tap the Park Field Map to open it. 

4. Browse to the collection location. 

5. Tap Add and tap Restrooms. 

6.  Swipe up on the form and tap Name to enter the name of the restroom. 

7.  Tap Park to enter the name of the park. 

8.  Tap Amenity Details to expand the form. 

9.  Tap Condition and choose a value. 

10.  Tap Owned By and choose a value. 

11.  Tap Maintained By and choose a value. 

12.  Swipe down and tap Take Photo, and then take a photo and tap Use Photo. 

13. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

14. Repeat steps 6 through 14 for each park asset. 

 

Assess park assets in the field 
1. Tap a trail in the Park Field Map. 
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2.  Swipe up on the form to review the trail information. 

3. Swipe up on the form to the Related section. 

4. Tap Trails Maintenance. 

  Previously recorded maintenance activities are displayed. When present, tap the 
maintenance record and swipe up on the form to review the information. 

5. Tap Add. 

6. Swipe up on the form to expand the form. 

7. Tap Maintenance Type to enter the type of maintenance activity completed.  

8. Tap Maintenance Status and choose Completed.  

9. Tap Date finished and choose today's date. 

10. Optionally, tap Notes to enter maintenance notes. 

11. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

12. Swipe up on the form to review the recorded maintenance information.  

13. In the Related section, tap Trails to return to the Trail feature. 

14. Swipe up on the form to the Related section. 

15. Tap Trails Inspection. 

  Previously recorded inspections are displayed. When present, tap the inspection record 
and swipe up on the form to review the information. 

16. Tap Add. 

17. Swipe up to expand the form. 

18. Tap Condition and choose a value. 

19. Tap Inspection Type and enter a value. 

20. Tap Needs Maintenance and choose Yes. 

21. Tap Inspection Date and choose today's date. 

22. Swipe down and tap Take Photo, and then take a photo and tap Use Photo. 

23. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

24. Swipe up on the form to review the recorded inspection information. 

25. In the Related section, tap Trails to return to the Trail feature. 

26. Swipe up on the form and tap the Create service request button. 
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27. Complete the Park Request form to report a request for service. 

28. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

 

Complete field assignments 
Park Rangers will often receive work through assignments that help organize tasks to be 

completed and communicate the status of work to maintenance supervisors. In this workflow, 

you are asked to use the ArcGIS Workforce app on your mobile device to track the status of 

your work in the field. 

1. Download ArcGIS Workforce onto your mobile device. 

2. Open ArcGIS Workforce and sign in to your ArcGIS organization. 

3. Tap the Park Assignments map. 

4. In the To do list, tap an assignment to view its location on the map and see details about 
the assignment. 

5. In the assignment details, tap Directions to see a list of installed navigation apps, and 
then tap the app you want to use and allow ArcGIS Workforce to open it. 

The app opens, generating a route to your assignment. 

6. In the assignment details, tap Start to begin working on an assignment. 

7. Optionally, tap Add Note to enter information for the maintenance supervisors. Tap Done. 

8. Optionally, tap Take Photo to take and attach a photo. 

9. Optionally, tap Attach to record video and audio and to attach other photos from your 
device. 

10. Swipe up and tap Open in Field Maps. 

The Park Field Map opens in ArcGIS Field Maps. 

11. After you have finished collecting data or recording work in the Park Field Map return to 
the ArcGIS Workforce app. 

12. To pause, decline, or reset the assignment, tap the Overflow button  and tap the 
appropriate status, or tap Cancel. 

13. In the assignment details, tap Finish when you have completed the assignment. 

14. Optionally, tap To Do and tap Completed to view your completed assignments. 

15. Optionally, tap Sync  (  if you have edits that aren't synced) and tap Sync Now to 
sync them. 

Changes to the status of your assignments automatically syncs with your ArcGIS 
organization at the default interval of every 15 minutes. 
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Develop park asset inventory 
The Park Asset Inventory app can be used by mapping technicians to create, edit, and review 

park assets. Existing park assets collected in the field can be reviewed and information added 

to help park staff and the general public find information about a park. New park assets can 

also be added to a park asset inventory using imagery and record documents. 

You will assume the role of a mapping technician in a park agency. In this workflow, you are 

asked to review park assets collected by field staff and add new park assets. The steps below 

provide guidance; however, you can enter information as you see fit and examine the different 

dependencies in the form. 

 

Review park assets collected in the field 
1. Sign in to your ArcGIS organization and browse to the Park Asset Inventory app. 

2. Open the item page and click View Application. 

3. Open the Filter panel and click the Trailheads: Needs Review filter to display trailheads 
that need to be reviewed. 

4. Open the Edit panel and click Edit feature. 

5. Select a trailhead on the map. 

6. In the panel, review the attribute information and enter the remaining details for the 
trailhead. 

7. Set Status to Open, Publicly Visible to Yes, and Reviewed to Yes. 

8. When you're finished, click Update. 

 

Add a new park asset 
1. In the Park Asset Inventory app, open the Edit panel, and click Add feature. 

2. Type Trails into the Filter types search box, and click the Trails feature template. 

3. Add a new trail to the map. 

4. Enter the following trail details: 

Parameter Value 

Asset ID Type T1-0004. 

Name Type McDowell Grove Trail. 

Park Name Type McDowell Park. 

Trail System Type McDowell Park. 

Status Choose Open. 

Reviewed Choose Yes. 

Seasonal Choose No. 
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Hiking Choose Yes. 

Mountain Biking Choose Yes. 

eBikes Choose No. 

Dogs Allowed Choose Yes. 

Surface Type Choose Native. 

Publicly Visible Choose Yes. 

Install Date Choose today's date. 

Owned By Choose Our Agency. 

Managed By Choose Our Agency. 

5. Scroll to the bottom of the form and click Add. 

6. Repeat all of the steps for each park asset. 

 

Update recreation closure information 
Communicating the status of recreation opportunities helps visitors plan trips and reduces 

congestion and overuse of resources. The Recreation Closure Manager app can be used by 

public information staff to create and update recreation closures. 

 

Create recreation closure 
1. Sign in to your ArcGIS organization and browse to the Recreation Closure Manager app. 

2. Open the item page and click View Application. 

The Manage Recreation Closures widget is opened by default, which allows you to 
create and edit existing recreation closures. 

3. In the Search widget, type an address. 

4. In the Manage Recreation Closures widget, click the Closures template and add a new 
recreation closure to the map. 

5. Enter the following recreation closure details: 

Parameter Value 

Name Type Trail Maintenance. 

Type Choose Temporary Closure. 

Reason Choose Maintenance. 

When Type Winter 2021 to Spring 2022. 

Comment Type Trail closed Winter 2021 to Spring 2022. 

6. Click Save. 
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Update asset status 
1. Open the Update Public Status widget. 

2. Select the Freehand Polygon selection tool, and select the assets associated with the 
recreation closure. 

3. For Status, choose Closed. 

4. Click Save. 

Note: 

When you create recreation closures and update asset status information using the 
Recreation Closure Manager app, the recreation locators deployed with the Recreation 
Outreach solution will automatically be updated with the new information. 

 

Manage operations 
You will now assume the role of a maintenance supervisor responsible for organizing routine 

and ad-hoc inspections and maintenance activities. In this workflow, you are asked to monitor 

field activities and conditions, manage requests for service, and assign work. 

 

Respond to requests for service 
1. Verify that you are signed in to your ArcGIS organization and browse to the Park Request 

Manager app. 

2. From the item page, click View. 

3. Click the Status column filter. 

4. Click the Status is drop-down arrow and choose Submitted to view requests for service 
with a submitted status. 

5. Click the Submitted On column and choose Sort in descending order. 

6. Click one of the service request features to view its details. 

7. On the Details tab, click the Edit button . 

8. Click the Status drop-down arrow and choose Received. 

9. Click Save. 

You will create an assignment so the request for service can be addressed by park 
rangers. 

10. Click the service request feature in the table to view its details. 

11. On the Details tab, click the Create Park Assignment button. 

The Create Park Assignment form opens. 

12. Complete the form to create an assignment that you will assign to park rangers.  

13. When you're finished, click Submit. 
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Monitor requests for service 
1. Verify that you are signed in to your ArcGIS organization and browse to the Park Request 

Dashboard. 

2. From the item page, click View Dashboard. 

3. Use the graphs to filter and explore active and resolved requests for service. 

  Dashboard charts are linked. As you click and select a category in one chart, related 
details are filtered and updated in other charts on the service request to allow a manager 
to identify issues and areas that need attention. 

 

Manage field assignments 
1. Verify that you are signed in to your ArcGIS organization and click the Apps button  in 

the header of the site. 

2. From the app launcher, click Workforce to open the app. 

3. Under Projects, hover over the Park Assignments project, and click Open to open the 
project. 

Tip: 

When implementing the Park Infrastructure Management solution in your organization, 
you must add everyone responsible for verifying park assignments in the field to the 
Park Assignments ArcGIS Workforce project with a Mobile Worker role. You can add 
users and assign roles in the configuration settings of the project. To access the 
configuration settings, hover over the Park Assignments project and click Configure. 
Click the Users tab. For the purposes of this exercise, ensure that your named user 
account is assigned as a dispatcher and as a mobile worker. Click the My Projects tab 
to return to your projects. 

4. At the bottom of the pane, click the Assignments tab. 

5. If present, click on an assignment from the list of assignments.  

6. Click the Assign drop-down and select a mobile worker who will complete the work. 

7. Optionally, click the Edit button to modify the Priority, Description or other assignment 
details. When you're finished, click Save. 

8. Click the back button. 

9. On the map, select a park asset. Review the asset information then click + Create 
Assignment. 

10. You can also use the search box on the map to search by address, place, or park asset 
ID. 

11. Choose an Assignment Type and assign a mobile worker. 

12. Click Create Assignment. 
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Participatory Budgeting 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Participatory Budgeting 
Participatory Budgeting can be used to solicit community feedback to identify, discuss, and 

prioritize public spending projects. 

It provides 24/7 access to an organization, and the location-enabled project ideas drive 

community engagement and help efficiently triage ideas to the person or department 

responsible for project scoping. Input gathered in the public application often makes up for 

gaps in official knowledge and brings the people and their government closer together as a 

community. It also allows historically disenfranchised groups to participate, leading to new 

ideas in government. Participatory Budgeting is typically implemented by planning 

departments, public works agencies, and other local government agencies that want to 

increase transparency and solicit feedback from the public and ultimately build a community in 

which everyone’s voice can be heard. 

The Participatory Budgeting solution delivers a set of capabilities that help you solicit project 

ideas from the public, triage and monitor these ideas, and incorporate popular ideas in future 

capital improvement plans. 

 

Requirements 
Participatory Budgeting requires the following: 

• ArcGIS Enterprise 
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Information products 
Participatory Budgeting includes the following information products: 

Item Description Minimum 
user type 

Participatory 
Budgeting 

An ArcGIS Hub site used by the general public to 
learn how they can become involved in the 
participatory budgeting process 

Not required 

Participatory 
Budgeting 

A Crowdsource Reporter app used by the general 
public to identify, discuss, and prioritize project ideas 

Not required 

Participatory 
Budgeting Manager 

A Crowdsource Manager app used by local 
government personnel to triage project ideas 
submitted by the general public 

Editor 

Participatory 
Budgeting 
Dashboard 

An ArcGIS Dashboards app used by local 
government personnel to monitor project ideas 
reported by the general public 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Participatory Budgeting 
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Configure Participatory Budgeting 
Learn how to configure the Participatory Budgeting solution to meet specific needs in your 

organization. 

 

Configure the Participatory Budgeting site 
The Participatory Budgeting solution includes the Participatory Budgeting ArcGIS Hub site, 

which your organization can configure with your own branding and use to share important 

budgeting and planning information with the public. 

After deploying the Participatory Budgeting solution, the Participatory Budgeting site layout 

only requires a few updates to fit your local context. Follow the steps below to update the site 

with your organization's needs: 

1. Sign in to your ArcGIS organization and browse to the Participatory Budgeting site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Statistics section under the title of the website. The Community Ideas 
statistics card is already linked to the Participatory Budgeting solution’s 
PublicProjectIdeas_public feature layer. This statistic automatically updates as you load 
data into your solution. 

The Available Budget and Ideas Funded statistics are provided in a text card but styled 
to resemble the Community Ideas statistics card; this allows you the option to manually 
enter a statistic of your choice, independent of data. Update the Available Budget and 
Ideas Funded statistics cards using a metric of your choice, or replace the text card with 
a Summary Statistics card and use the PublicProjectIdeas_public feature layer view as 
its data source, similar to the other statistics cards. 

5.  Update the Available Budget and Ideas Funded cards by hovering over one of the 

cards and clicking the edit pencil , and then update the text. To add a Summary 
Statistics card to the existing row, see the Display key metrics section in the Insert 
charts, tables, and metrics topic. Once the card has been added to the row, hover over 

the replaced card and click the delete button . 

6. Scroll to the Meet the Participatory Budgeting Committee section, hover over the 
card, and click the edit pencil on the horizontal toolbar. 

7. To update the image, click </> Edit in HTML and replace the existing URL with the URL 
of your image, and edit the photo names in the card. 

8. Click Apply. 

9. Scroll to the Frequently Asked Questions section, hover over the card and click the edit 
pencil, and update the questions and answers. 

10. Click Footer.  
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A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

11. Click the HTML text box. 

The HTML window appears. 

12. Make the necessary changes and click Apply. 

13. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Participatory Budgeting solution must be 

shared with everyone so they can be accessed by the public on the Participatory Budgeting 

site. To share your participatory budgeting items with everyone, use the guide below and 

complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Participatory 
Budgeting folder. 

2. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) PublicProjectIdeas_public 

Web Map Participatory Budgeting 

Web Mapping Application Participatory Budgeting 

Site Application Participatory Budgeting 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 580 

Use Participatory Budgeting 
The Participatory Budgeting solution delivers a set of capabilities that help you solicit project 

ideas from the public, triage and monitor these ideas, and incorporate popular ideas in future 

capital improvement plans. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Submit a project idea 
You will first assume the role of an engaged resident in the community. You want to learn 

more about the project ideas submitted by the community that are being considered for 

funding. You also have your own project idea that you want to submit for consideration by the 

community. 

1. In a browser, from the Participatory Budgeting solution, view the Participatory Budgeting 
site. 

2. Scroll to the Do You Have a Project Idea section and click the Submit an Idea button to 
open the Participatory Budgeting app. 

3. Click Proceed as Guest or sign in with your ArcGIS Online or ArcGIS Hub community 
account. 

4. In the Ideas list, browse ideas created by others in the community. 

5. Click an idea. 

6. To like an idea, click the I agree button to vote for it, or click the Leave a reply button to 
comment. 

7. At the upper left, click the arrow to return to the list of submissions. 

8. Click Submit Idea to add your own idea. 

9. In the form, provide details about your idea, your contact information, and the location for 
the idea. 

10. Click the Report It button to submit your idea. 

 

Manage project ideas 
You will now assume the role of a member of the participatory budgeting committee. One of 

your responsibilities is to review ideas submitted by the public and determine if they are viable 

and what the estimated cost would be. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Participatory 
Budgeting solution. 
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2. View the Participatory Budgeting Manager app. 

3. In the table or on the map, click an idea. 

The idea details open at the lower left. 

4. In the idea details, click the Edit Record button . 

5. Confirm that the idea category is appropriate. 

6. For Vetted, choose Yes. 

7. For Viable, choose Yes, if appropriate. 

8. For Estimated Cost, type an estimated cost for the project. 

9. Click Save. 

 

Monitor project ideas 
As a member of the participatory budgeting committee, another of your responsibilities is to 

monitor ideas submitted by the public to ensure the program is running smoothly. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Participatory 
Budgeting solution. 

2. View the Participatory Budgeting Dashboard app. 

3. On the left, use filters to refine the results by project category, status, viability, or date. 

When you filter the results, the bar chart and number of project ideas update. 

4. Click an idea on the map to view its details. 
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Performance Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Performance Management 
Performance Management can be used to monitor key performance metrics and communicate 

progress made on strategic outcomes to the general public and other interested stakeholders. 

Historically, government agencies have focused on process and compliance, but this 

management style has not yielded the expected results. As a result, many agencies are 

focusing on performance or results that benefit the public and attempting to increase public 

confidence in the results. Performance Management is typically implemented by government 

agencies that want to use evidence and results to foster a culture of continuous improvement, 

spend scarce budget resources wisely, and ensure that the community's needs are being 

prioritized. 

The Performance Management solution delivers a set of capabilities that help you tabulate 

performance metrics, monitor performance using a series of dashboards and key performance 

indicators (KPIs), visualize performance for defined geographies, and share performance with 

the public through a community website. 

 

Requirements 
Performance Management requires the following: 

• ArcGIS Enterprise 
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Information products 
Performance Management includes the following information products: 

Item Description Minimum user type 

Community 
Performance 

An ArcGIS Hub site used by government agencies 
to share key performance indicators (KPIs) and 
communicate progress made on strategic 
outcomes with the general public and other 
interested stakeholders 

Not required 

Performance 
Management 

An ArcGIS Dashboards app used by government 
agencies to monitor key performance indicators 
(KPIs) and communicate progress made on 
strategic outcomes with the general public and 
other interested stakeholders 

Viewer (required if 
dashboard is used 
for internal 
purposes only) 

Performance 
Management 
Mobile 

An ArcGIS Dashboards app, optimized for mobile 
devices, used by government agencies to monitor 
key performance indicators (KPIs) and 
communicate progress made on strategic 
outcomes with the general public and other 
interested stakeholders 

Viewer (required if 
dashboard is used 
for internal 
purposes only) 

Performance 
Management 
Survey 

An ArcGIS Survey123 form used by the general 
public to provide feedback on the community's 
strategic outcomes and key performance indicators 
(KPIs) 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Performance Management and Performance Management Mobile 
dashboard that resolves an issue where the location selector fails to load in 
the new ArcGIS Dashboards app. 

1.0 • First release of Performance Management. 
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Configure Performance Management 
Learn how to configure the Performance Management solution to meet specific needs in your 

organization. 

 

Load data 
The PerformanceManagement feature layer deployed with the solution is designed to be 

flexible to the different metrics that communities may want to measure as part of their 

Performance Management initiative. The PerformanceManagement feature layer contains two 

sublayers: 

• A Boundaries layer, which stores the different levels of geography used to measure 
community performance—for example, the municipality or city, council districts, 
neighborhoods, and so on. 

• A Metrics table, which stores the name of the metric, the strategic outcome it is 
associated with, the date it was reported, the geography it is measuring, the target or 
goal associated with the metric, and the actual value recorded. The image below shows 
an example of two metrics, Graduation Rate and Median Household Income, measured 
for different geographies and dates. 

 

The image below shows a filtered view of the table for a single metric, Graduation Rate, 
for the City of Naperville recorded annually since 2014. In this example, you have also 
set a new target or goal for 2019 with no actual value recorded yet. This allows you to 
display future goals in the performance dashboard. 
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Load performance boundaries 
The Boundaries layer is used to define, which geographies the community want to measure 

performance and controls the options listed in the filter of the performance dashboard. This 

can be a single location (for example, the city), or multiple locations (for example, the city, its 

neighborhoods, and council districts). 

To load features from a shapefile into the Boundaries layer, complete the steps below: 

1. Sign in to your ArcGIS organization and browse to the PerformanceManagement feature 
layer item. 

Note: 

When you deploy the solution, two feature layers are created in your ArcGIS 
organization My Content tab, PerformanceManagement and 
PerformanceManagement_dashboard. PerformanceManagement_dashboard is a 
noneditable view of the PerformanceManagement feature layer that is used by the 
dashboards. PerformanceManagement is editable and is intended for users inside the 
organization to add, modify, and delete records. 

2. Open the item page and click Update Data > Append Data to Layer. 

3. Click Choose File and browse to a .zip containing the shapefile with your boundary 

features, and then click Open. 

4. Click Upload and Continue. 

5. Click the Choose the layer that you wish to append data into drop-down arrow and 
choose Boundaries. 

6. Uncheck Update existing features. 

7. Click Show field matching to map the fields. 
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Note: 

The key required field for the Boundaries layer is the name field, which represents the 
name of the geography. This field is used in the relationship between the Boundaries 
layer and Metrics table and is what drives the location filter in the dashboard. If you 
have a type field on the source layer, it can be mapped as well. If not, it can be edited 
after you append the data. 

8. Click Apply Updates. 

 

Load performance metrics 
The Metrics table is configured to allow a community to manage all their key performance 

indicator (KPI) data across different geographies and over time in a single table. Each row in 

the table corresponds to a single KPI for a specified geography and date and time. 

Often the performance data is coming from multiple business systems in the organization and 

exist in many different formats. Much of the effort in standing up the performance 

management dashboards is in bringing all these different datasets into a consistent format 

that can be consumed in ArcGIS. One approach for external tabular data is to use software 

such as Microsoft Excel to format the data to the model expected by the Metrics table. Once 

formatted in Microsoft Excel, the spreadsheet can be loaded into Metrics table. 

Tip: 

Download a sample Microsoft Excel spreadsheet with a schema matching the schema of 
the Metrics table to help with loading into the Performance Management solution. 

To prototype the dashboard, it may help to focus on one metric for a specific geography in the 

community. To load records from the spreadsheet into the Metrics table, complete the steps 

below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
PerformanceManagement feature layer item. 

2. Open the item page and click Update Data > Append Data to Layer. 

3. Click Choose File, browse to your spreadsheet, and click Open. 

4. Click Upload and Continue. 

5. Click the Choose the layer that you wish to append data into drop-down arrow and 
choose Metrics. 

6. Uncheck Update existing features. 

7. Click Show field matching to map the fields. 

8. Click Apply Updates. 
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Configure performance dashboard for an outcome 
The Performance Management solution comes with two template dashboards (large display 

and mobile) that can be reused for different outcomes and configured for KPIs measured in 

your community. 

To configure a dashboard for your strategic outcome and KPIs, complete the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Performance 
Management or Performance Management Mobile dashboard. 

2. Open the item page and click Edit Dashboard. 

3. Click the arrow next to Save, click Save As, and specify a title, tags, and a summary. 

4. Hover over the upper left corner of the header and click Configure . 

5. Update the Title for your strategic outcome, and then click Done. 

6. Click the Save to save the dashboard. 

The large display dashboard has two rows of four panels each and the mobile dashboard has 

a single column with eight panels. Each panel is composed of three stacked elements: 

• The Current tab is an indicator element that displays the most recent reported value for a 
given metric. When applicable, this element also displays if the metric is meeting or not 
meeting the designated target for that geography. 

• The History tab is a serial chart element that displays the performance of that metric over 
time. The actual value is displayed as a bar chart, and when applicable, the target is 
displayed as a line. 

• The Detail tab is a rich text element where you can provide additional context for the 
metric, for example, how it is measured, where the data is coming from, and why it is 
important. 

Each panel is configured for a different key performance indicator associated with the 

strategic outcome. The steps below describe how you can configure each element in a panel 

for your metric. Repeat the steps below for each panel in the dashboard. 

Note: 

The mobile dashboard is intended to be embedded in a website, for example, the 
Community Performance site included in the solution. When editing or viewing the 
dashboard in the browser, the panels fill the space available and do not leave enough 
space for each panel vertically. The Community Performance site provides the mobile 
dashboard with enough space vertically so that each panel displays well, and the user 
can scroll the page to view each metric. 

 

Current tab 
To configure the Current tab, complete the steps below: 

1. Click the Current tab. 
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2. Hover over the upper left corner of the element and click Configure . 

3. Click the Data tab. 

4. Change the Filter settings, by clicking the drop-down arrow and changing the Value to 
correspond to your metric. 

5. Click the Indicator tab. 

6. If your metric has a target, enable Conditional Formatting; otherwise, turn off this 
option. 

Note: 

When enabled, you can visualize the value differently when the actual value is equal 
to or above the target value and when the actual value is less than the target. Also, 
complete the following steps for both representations. 

7. Optionally, modify the Middle Text for each indicator, to add or remove additional 
characters to display next to the actual value, for example, a percent sign, dollar sign, 
and so on. 

8. In the Icon area, click Change and choose an appropriate icon, or click the Custom tab 
to add your own custom Scalable Vector Graphics (SVG) icon. 

9. Optionally, in the Formatting area, change the value pattern to format the number. 

10. Click the General tab. 

11. Change the name of the element. 

12. Modify the Title setting by clicking Edit and updating the title for the metric. 

13. Modify the Description setting by clicking Edit. 

14. Click Source and copy and paste the appropriate HTML snippet below into the editor: 

  Value is meeting the target: 

<table style="background-color:#35ac46; color:#ffffff; font-size:16px; 
padding:0px; width:100%"> 
    <tbody> 
        <tr>  
            <td width="40"> 
                <svg fill="#ffffff" height="32" id="ember25808" 
style="vertical-align: middle; margin-left:auto; margin-right:auto; 
display:block;" viewbox="0 0 16 16" width="32" 
xmlns="http://www.w3.org/2000/svg" 
xmlns:xlink="http://www.w3.org/1999/xlink"> 
                    <path d="M7.5 0C3.366 0 0 3.364 0 7.5S3.365 15 7.5 
15c4.136 0 7.5-3.364 7.5-7.5S11.636 0 7.5 0zm.001 14C3.916 14 1 11.084 1 
7.5S3.916 1 7.501 1C11.085 1 14 3.916 14 7.5S11.085 14 7.501 
14z"></path> 
                    <path d="M11.634 4.633L6.5 9.767 4.312 7.579l-
.707.707L6.5 11.18l5.841-5.84z"></path> 
                </svg> 
            </td> 
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            <td>  
                <p><span>Target: </span>{element/reference}</p>  
                <p>{reportdt}</p>  
            </td>  
        </tr> 
    </tbody> 

  </table> 

  Value is not meeting the target: 

<table style="background-color:#de2900; color:#ffffff; font-size:16px; 
padding:0px; width:100%">  
    <tbody>  
        <tr>  
            <td width="40">  
                <svg fill="#ffffff" height="32" id="ember25808" 
style="vertical-align: middle; margin-left:auto; margin-right:auto; 
display:block;" viewbox="0 0 16 16" width="32" 
xmlns="http://www.w3.org/2000/svg" 
xmlns:xlink="http://www.w3.org/1999/xlink">  
                    <path d="M7 3h1v7H7zm0 8h1v1H7z" vector-effect="non-
scaling-stroke"></path>  
                    <path d="M7.5 0C3.366 0 0 3.364 0 7.5S3.365 15 7.5 
15c4.136 0 7.5-3.364 7.5-7.5S11.636 0 7.5 0zm.001 14C3.916 14 1 11.084 1 
7.5S3.916 1 7.501 1C11.085 1 14 3.916 14 7.5S11.085 14 7.501 14z" 
vector-effect="non-scaling-stroke"></path>  
                </svg>  
            </td>  
            <td>  
                <p><span>Target: </span>{element/reference}</p> 
                <p>{reportdt}</p> 
            </td> 
        </tr> 
    </tbody> 

  </table> 

  Metric has no target: 

<table style="background-color:#0084a8; color:#ffffff; font-size:16px; 
padding:0px; width:100%">  
    <tbody>  
        <tr>  
            <td width="40">  
                <svg fill="#ffffff" height="32" id="ember25808" 
style="vertical-align: middle; margin-left:auto; margin-right:auto; 
display:block;" viewbox="0 0 16 16" width="32" 
xmlns="http://www.w3.org/2000/svg" 
xmlns:xlink="http://www.w3.org/1999/xlink">  
                    <path d="M7.5 0C3.366 0 0 3.364 0 7.5S3.365 15 7.5 
15c4.136 0 7.5-3.364 7.5-7.5S11.636 0 7.5 0zm.001 14C3.916 14 1 11.084 1 
7.5S3.916 1 7.501 1C11.085 1 14 3.916 14 7.5S11.085 14 7.501 
14z"></path>  
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                    <path d="M8.164 3.414l-.707.708L10.336 7H3v1h7.336l-
.224.224-2.655 2.655.707.707L12.25 7.5z"></path>  
                </svg>  
            </td>  
            <td>  
                <p>Measured</p>  
                <p>{reportdt}</p>  
            </td>  
        </tr>  
    </tbody>  
</table> 

   

15. Click Source, and click Done. 

16. Click Save to save the dashboard. 

 

History tab 
To configure the History tab, complete the steps below: 

1. Click the History tab. 

2. Hover over the upper left corner of the element and click Configure . 

3. Click the Data tab. 

4. Change the Filter settings, by clicking the drop-down arrow and changing the value to 
correspond to your metric. 

5. Update the Minimum Period setting frequency at which the metric is updated. 

6. If the metric has a target value, configure the chart with two series. Set the Series 1 
Field setting to Actual and set the Series 2 Field setting to Target. Click the + Series 
button to add a second series if it isn't already added. If the metric has no target, remove 
the second series. 

7. If you did not add a second series, go to step 12. 

8. Click the Chart tab. 

9. Change the Legend Placement setting to Bottom. 

10. Click the Series tab. 

11. In the Target area, change the Type setting to Line and the Color setting to #00734c. 

12. Click the General tab. 

13. Change the name of the element. 

14. Modify the Title setting by clicking Edit and updating the title for the metric. 

15. Click Done, and click the Save button to save the dashboard. 

 

Detail tab 
To configure the Detail tab, complete the steps below: 
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1. Click the Detail tab. 

2. Hover over the upper left corner of the element and click Configure . 

3. In the rich text editor, update the title for the metric. 

4. Add any addition text, hyperlinks, or images to the description that will help explain how 
the metric is measured, where the data comes from, and why it is important. 

5. Click Done, and click the Save button to save the dashboard. 

 

Add a strategic outcome page to Community 

Performance site 
The Performance Management solution comes with a site that you can use to share key 

performance metrics and communicate progress made on strategic outcomes to the general 

public and other interested stakeholders. The site includes a template page that can be 

reused for each outcome defined for the community. 

To add a new outcome page, complete the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Community 
Performance site. 

2. Open the item page and click View Application. 

3. At the top of the Community Performance site, click the Outcome tab. 

4. Click the edit button  to open the site editor. 

5. In the top right corner of the page, click More Actions  and choose Clone Layout. 

Note: 

This creates a copy of the Outcome page and creates a new item in the home folder 
of your content. 

6. In the side panel, click Page Info and update Page Info, Page Summary, and the slug 
of the page for your outcome. 

7. Scroll down the page and you will see the two performance management dashboards 
included with the solution embedded in the page. 

  Note: 

  While editing the page, both dashboards display. When viewing the page, the first 
dashboard is in a row that only displays when the browser width is greater than 992 
pixels. The second dashboard is optimized for mobile display and is in a row that only 
displays when the browser width is less than 992 pixels. 

8. Hover over the first dashboard and click the edit pencil . 

9. In the side panel, hover over the Modify button and click Edit. 
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10. In the Select Application window, search for the Performance Dashboard associated 
with the outcome and click Select. 

11. Repeat steps 8 through 10 for the mobile dashboard. 

12. Scroll to the Outcome section of the page, hover over the image card and click the edit 
pencil. 

13. In the side panel, provide an image for the outcome by either dragging an image or 
browsing for an image. 

14. Hover over the Outcome card and click the edit pencil. 

15. Edit the text for your outcome to describe what it is and why it is important to the 
community. 

16. Click Save. 

17. At the top of page, click the Community Performance drop-down arrow and choose 
Initiative Site. 

18. In the side panel, click Header. 

19. Expand the Menu options, click the Add Link drop-down arrow, and choose to existing 
content. 

20. In the Add Content window, search for the Outcome page you created in the previous 
steps and click Select. 

21. Drag the menu link in the side panel to reorder link positions at the top of the site. 

22. Click Save. 

Note: 

In the Discover What Makes Our Community Stand Out section of the site is a gallery 
card. This gallery shows any pages shared with the site that have the Outcome tag. The 
new outcome page you added in the previous steps now display here and provide a link 
to the page. To update the image and text associated with the gallery card, browse to the 
page item in your content and update the thumbnail, summary, and description. 

 

Share items with the public 
Several layer views, maps and apps included in the Performance Management solution must 

be shared with everyone so they can be accessed by the public on the Community 

Performance site. To share your performance management items with everyone, use the 

guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Performance 
Management folder. 

2. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) PerformanceManagement_dashboard 
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Feature Layer (hosted, view) PerformanceManagementSurvey_public 

Dashboard Performance Management 

Dashboard Performance Management Mobile 

Form Performance Management Survey 

Site Application Community Performance 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

 

Modify performance survey 
To modify the Performance Management Survey, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to Performance 
Management Survey. 

2. Open the item page and click Open in Survey123 > Manage in Survey123 website. 

3. Click the Design tab. 

4. Edit the survey and save the changes. 

5. Click Publish. 
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Use Performance Management 
The Performance Management solution delivers a set of capabilities that help you tabulate 

performance metrics, monitor performance using a series of dashboards and key performance 

indicators (KPIs), visualize performance for defined geographies, and share performance with 

the public through a community website. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Monitor community performance 
You will assume the role of a resident in the community. You are interested in learning how 

the community measures success and learn how well the community and your neighborhood 

is performing in these areas. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Performance 
Management solution. 

2. View the Community Performance site. 

3. Scroll down to the Discover What Makes Our Community Stand Out section of the 
page and click one of the strategic outcomes. 

At the top of the page is the associated performance dashboard. Each KPI displays the 
most recent reported value, when it was last measured, and when applicable, if the 
metric is meeting or not meeting the designated target. 

4. For a KPI, click the History tab. 

This tab displays the performance of that KPI over time. The actual value is displayed as 
a bar chart and when applicable the target is displayed as a line. 

5. For a KPI, click the Details tab. 

This tab provides additional context for the KPI—for example, how it is measured, where 
the data is coming from, and why it is important. 

6. Click a new geography from the drop-down menu in the upper right corner of the 
dashboard to visualize for performance at locations in the community—for example, a 
neighborhood or council district. 

7. Click another outcome using the links at the top of the site to view the corresponding 
performance dashboard and related KPIs. 
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Provide feedback on performance initiative 
After reviewing the community goals and the KPIs used to measure performance, you want to 

provide feedback on the aspects you liked and thought the community is performing well in 

and the aspects you feel the community can improve. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Performance 
Management solution. 

2. View the Community Performance site. 

3. Scroll down to the Tell Us How We’re Doing section and click the Share Feedback 
button to open the Performance Management Survey app. 

4. Fill out the Performance Management Survey survey to provide your feedback. 

5. Click Submit. 
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Plans and Drawings 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Plans and Drawings 
Plans and Drawings can be used to index the geographic extent of record plans and drawings 

and provide access to a catalog of source documents in the office or the field. 

Design drawings, construction plans, as-builts, and other source documents contain vital 

information that is used daily by engineers and field staff to make infrastructure improvements. 

Many times, these drawings have been automated and are cataloged in a document 

management system, but some drawings may only exist in hardcopy format and be stored in 

an office file cabinet. And while each of these record drawings may represent a given 

geography, understanding the extent of the record drawing and whether it contains the 

information you are looking for can be quite time consuming. Plans and Drawings is typically 

implemented by public works agencies and utilities that want to simplify access to record 

drawings and ensure that engineers and field staff understand what drawings exist at a given 

location. 

The Plans and Drawings solution delivers a set of capabilities that help you index record 

drawings, associate a geographic extent with each drawing, and provide access to a catalog 

of plans and drawings in the office or the field. 

 

Requirements 
Plans and Drawings requires the following: 

• ArcGIS Enterprise 
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Information products 
Plans and Drawings includes the following information products: 

Item Description Minimum 
user type 

Plan 
Catalog 

An ArcGIS Web AppBuilder app used by public works staff to 
access a catalog of record drawings, as-builts, and other source 
documents 

Viewer 

Plan 
Index 

An ArcGIS Web AppBuilder app used by public works staff to 
index the geographic extent of record plans and drawings 

Editor 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Plans and Drawings 
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Use Plans and Drawings 
The Plans and Drawings solution delivers a set of capabilities that help you index record 

drawings, associate a geographic extent with each drawing, and provide access to a catalog 

of plans and drawings in the office or the field. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Index plans and drawings 
First, you will assume the role of a public works engineer. You need to index a record drawing 

submitted for a recent project. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Plans and 
Drawings solution. 

2. View the Plan Index app. 

The Index Plan widget allows you to create a geographic extent for your project. 

3. To create a new plan, click the Plans and Drawings template. 

4. Click the map to draw the geographic extent around the project location, and then 
double-click to finish drawing the polygon. 

Note: 

You can use the Search widget to quickly update the map extent to desired addresses, 
place-names, or locations of existing projects. 

5. After you draw the geographic extent, you are prompted with a Plans Index form. 

6. Complete the form with as much information as possible. 

Tip: 

In the Document Path text box, type a URL or other resolvable file path to your 
organization's existing document repository solution. 

In the Document Location Description text box, describe the physical location if 
documents are not stored in a digital format with a resolvable document path, link, or 
URL. For example, type Public Works Building, 2nd Floor in the 2022 
Projects cabinet. 

7. Scroll to the Attachments option. 
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Note: 

The Attachments option is useful for uploading before-and-after photos related to the 
project and other relevant project media. 

8. Optionally, add attachments. 

9. Click Save to complete the indexing workflow. 

 

View plans and drawings 
After they are indexed, record drawings can be accessed from the office or the field. Now, you 

will assume the role of an engineer at a local utility who needs to access pertinent plans and 

drawings while in the field on a site visit to a new infrastructure project. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Plans and 
Drawings solution. 

2. View the Plan Catalog app. 

The app opens with the Filter Plans widget open on the right. Filters are active by 
default; filtering by project type or date automatically updates the results in the map. 

3. In the Filter Plans widget, adjust the filters to refine the results. 

4. On the map, click a project extent. 

A pop-up with more information about the project appears. In addition to providing project 
information, the pop-up includes a Document ID link, if available. 

5. If available, click the Document ID link to open the referenced plan or drawing 
associated with this project.  

  The link opens in a new browser tab. 

 

Share a record drawing link 
A colleague has requested information about the record drawing for a bridge project that you 

recently indexed. You will use the Plan Catalog to create a direct link to the project details and 

share with your colleague. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Plans and 
Drawings solution. 

2. View the Plan Catalog app. 

3. At the upper right, click the Share button to open the widget. 

In the Share widget, under Share a link to this app, there is a pregenerated link. By 
default, this short link uses your app's current map extent. In the following steps, you will 
construct a query within the share link so that it opens a specific project detail when 
opened. 

4. Click Link Options. 

5. Click Query a feature and zoom to it.  
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The drop-down lists that appear must be completed to generate a project-specific app 
link. 

6. Click the first drop-down arrow and choose Plans and Drawings. 

7. Click the second drop-down arrow and choose projname. 

8. Click the third drop-down arrow and search for or choose the project that you want to 
share.  

9. At the top of the widget, click the Back arrow. 

The sharing short link is now updated using your project query information. 

10. Below the short link, click the Email button to launch a pregenerated email with your 
custom app link.  

  A draft email opens in your device’s default email handler. Alternatively, you can copy the 
short link from the Share a link to this app text box. If you have accessed the Plan 
Catalog app from a mobile device, you can use this link to share a record by text 
message or other messaging app. 
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Police Transparency 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Police Transparency 
 Police Transparency can be used to share authoritative information and communicate 

engagement efforts that build trust with the public and community stakeholders. 

In some communities, inequitable policing practices have eroded the public’s trust and 

challenged the legitimacy of local law enforcement agencies. As a result, many agencies are 

seeking new ways to improve their relationship with the communities they serve. The larger 

reform efforts are helping law enforcement agencies improve transparency and demonstrate 

accountable police policies. At the same time, agencies are also engaging the community 

more deeply and using their feedback to drive policing priorities and enforcement policies.  

Police Transparency is typically implemented by law enforcement agencies that want to 

increase transparency, grow public trust, and improve relationships with the communities they 

serve. 

The Police Transparency solution delivers a set of capabilities that help you share information 

openly with the public, promote your agency’s work, demonstrate accountability when force is 

used, illustrate how workforce recruiting reflects the diversity of the community, and engage 

the public to improve policing services. 

 

Requirements 
 Police Transparency requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 3.0 or later (Basic, Standard, or Advanced) 
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Information products 
 Police Transparency includes the following information products: 

Item Description Minimum user 
type 

 Police 
Transparency 

An Enterprise Sites site used by the public to 
understand community crime conditions, explore 
patterns of police use of force, learn about the 
diversity of their police force, access open data, 
and discover opportunities for police-community 
engagement. 

Not required 

Crime Summary 
Dashboard 

An ArcGIS Dashboards app used by the public to 
understand historical statistical trends across 
major crime categories and individual crime 
types. 

Not required 

Crime Summary 
Mobile Dashboard 

An ArcGIS Dashboards app used by the public 
on mobile devices to understand historical 
statistical trends across major crime categories 
and individual crime types. 

Not required 

Crime Trends 
Dashboard 

An ArcGIS Dashboards app used by the public to 
explore statistical trends and xlusters across 
individual crime types. 

Not required 

Public Crime Map An ArcGIS Web AppBuilder app used by the 
public to explore recent crime conditions in their 
community and create reports for an area of 
interest. 

Not required 

Use of Force by 
Race and Ethnicity 

An ArcGIS Dashboards app used by the public to 
explore patterns in the race and ethnicity of 
officers and subjects involved in use of force 
incidents in relation to the composition of the 
community. 

Not required 

Use of Force by 
Race and Ethnicity 
Mobile Dashboard 

An ArcGIS Dashboards app used by the public 
on mobile devices to explore patterns in the race 
and ethnicity of officers and subjects involved in 
use of force incidents in relation to the 
composition of the community. 

Not required 

Use of Force by 
Neighborhood 

An ArcGIS Dashboards app used by the public to 
explore characteristics of use of force incidents 
by community policing area. 

Not required 

Use of Force by 
Subject 

An ArcGIS Dashboards app used by the public to 
explore characteristics of the subjects of use of 
force incidents. 

Not required 

Use of Force by 
Officer 

An ArcGIS Dashboards app used by the public to 
explore characteristics of the officers involved in 
use of force incidents. 

Not required 

Police Interaction 
Survey 

An ArcGIS Survey123 form used by the public to 
provide feedback about their interactions with 
police personnel. 

Not required 
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My Community 
Officer 

A Zone Lookup app used by the public to learn 
about the community policing officer responsible 
for an area of interest and how to contact them. 

Not required 

Community Safety 
and Policing 
Satisfaction Survey 

An ArcGIS Survey123 form used by the public to 
report their perceptions of community safety and 
holistic performance of their police agency. 

Not required 

Law Enforcement 
Diversity 
Dashboard 

An ArcGIS Dashboards app used by the public to 
understand the racial, ethnic, and gender 
diversity of their police force in relation to the 
composition of the community. 

Not required 

Law Enforcement 
Diversity Mobile 
Dashboard 

An ArcGIS Dashboards app used by the public 
on mobile devices to understand the racial, 
ethnic, and gender diversity of their police force 
in relation to the composition of the community. 

Not required 

 Law Enforcement 
Data Management 

An ArcGIS Pro project used by crime analysts to 
automate data imports from records 
management or computer-aided dispatch 
systems, which helps free up time crime analysts 
typically spend on data preparation. 

GIS Professional 
(Basic, Standard, 
or Advanced) 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • A new Police Transparency site. 

• A new Crime Trends Dashboard, Crime Summary Dashboard, Crime 
Summary Mobile Dashboard, and Public Crime Map that leverages a new 
common crimes feature layer. 

• A new Law Enforcement Diversity Dashboard pro project to help you load and 
manage your data. 

• Removed the Community Crime Problem Reporter, Community Crime 
Problem Manager, Community Crime Problem Editor, and Community Crime 
Problem Dashboard from the solution. 

1.0 • First release of Police Transparency 
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Configure Police Transparency 
In this topic, you will learn how to configure the Police Transparency solution to meet specific 

needs in your organization. 

 

Load your data 
Police Transparency can be used by law enforcement agencies to share crime, use of force, 

police personnel, and community policing boundary information. In some cases, you may 

already have this information in ArcGIS Enterprise or another business system. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the ArcGIS Solution before 

sharing the maps or apps. 

Once you have determined what source data must be loaded, complete one, or more, of the 

data-loading workflows below. 

 

Load police personnel roster 
Police Transparency can be used by law enforcement agencies to share data about the 

diversity of their agency personnel. The  Police Transparency solution includes the Law 

Enforcement Diversity Dashboard that can be used to display this information by race, 

ethnicity, and gender in relation to community proportions. 

To load your agency personnel roster into the Law Enforcement Diversity Dashboard from a 

spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Police Personnel Microsoft Excel 
item. 

2. On the item details page, click Download. 

3. Once downloaded, open the Police_Personnel.csv file and enter your personnel roster 
information. 

Tip: 

Many fields have existing domain values that are used for filters and charts in the Law 
Enforcement Diversity Dashboard. If the values in your data are not identical to the 
values in each domain, you can either change the values in your data to match the 
values already in each field’s domain list to update the domain list of each field in the 
Police_Personnel table to reflect the values in your data. Then follow the steps in the 
Modify apps section to update the Law Enforcement Diversity Dashboard to reflect your 
values. 

4. Ensure the name of the spreadsheet is Police_Personnel and do not change any field 
names. 

5. Click Save to save your changes. 
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6. In your ArcGIS organization, browse to the Police_Personnel hosted feature table. 

7. On the item details page, click Update Data, then click Append Data to Layer. 

8. Under Filename, choose your .csv file. 

9. Click Upload and Continue. 

10. Uncheck Update existing features. 

11. Click Show field matching. 

12. Confirm that all fields listed in the Fields column have a corresponding field listed in the 
Match Field column. 

13. If no field is listed in the Match Field column, click the drop-down box for that field, and 
select the field name from the spreadsheet that reflects the value shown in the Fields 
column. 

14. Click Apply Updates. 

In subsequent data loads, you will want to delete the existing data in this table and replace it 

with updated roster information. To delete data from a hosted feature table, see the Delete 

data section. 

 

Load community policing areas 
To load your data into the CommunityPolicingAreas layer, complete the following steps: 

1. In your ArcGIS organization, browse to the feature layer you want to populate. 

2. Create a .zip file of a shapefile of your Community Policing Areas. 

3. On the item details page, click Update Data, then click Append Data to Layer. 

4. Under Filename, choose your .zip file. 

5. Click Upload and Continue. 

6. From Choose the layer to update, select the CommunityPolicingAreas layer. 

7. Uncheck Update existing features. 

8. Click Show field matching to map the fields. 

9. Click Apply Updates. 

 

Load use of force data 
 Police Transparency can be used by law enforcement agencies to share use of force 

information. The solution includes several charts and dashboards that can be used to display 

characteristics of use of force incidents by race and ethnicity, neighborhood, subject of the 

force, and the officer involved. 

To load your agency use of force data from a spreadsheet into the UseOfForce feature layer, 

complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the UseOfForce Microsoft Excel item. 
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2. On the item details page, click Download. 

3. Once downloaded, open the UseOfForce Excel workbook. 

Note: 

The workbook contains three spreadsheet tabs—one for Incidents, one for Subjects, 
and one for Officers. Enter your personnel roster information. 

4. Ensure the name of the spreadsheet is UseOfForce and do not change any field names. 

Note: 

Review the fields in the UseOfForce feature layer. This layer is comprised of an 
Incidents layer, an Officers related table, and a Subjects related table—you will need 
to be familiar with the fields and domain values of all three. 

Tip: 

Many fields have existing domain values that are used in filters and charts on the 
ArcGIS Enterprise Sites page and in the use of force dashboard. If the values in your 
data are not identical to the values in each domain, you can either change the values 
in your data to match the values already in each field’s domain list, or follow the steps 
in the Modify data section to update the domain list of each field in the UseOfForce 
feature layer to reflect the values in your data. Then follow the steps in the Modify 
apps section to update the ArcGIS Enterprise Sites charts, Use of Force by Race and 
Ethnicity, Use of Force by Neighborhood, Use of Force by Officer, and Use of Force 
by Subject dashboards to reflect your values. 

5. Click Save to save your changes. 

6. In your ArcGIS organization, browse to the UseOfForce feature layer. 

7. On the item details page, click Update Data, then click Append Data to Layer. 

Note: 

Ensure that the data in your Excel workbook already has valid latitude and longitude 
coordinates. If your data has only addresses and no coordinates, you can geocode it 
using a local address locator and ArcGIS Pro, or the Publish an Excel file workflow in 
your ArcGIS organizational portal. Export the resulting layer as a CSV file or Excel 
spreadsheet and add the Latitude and Longitude values to the UseOfForce 
worksheet in the Incidents layer. 

8. Under Filename, choose your Excel workbook file.  

9. Click Upload and Continue. 

10. Select Incidents from the drop-down list and choose the layer into which you want to 
append data. 

11. Select Incidents from the drop-down list and choose the layer from UseOfForce.xlsx that 
contains the updated data. 
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12. Uncheck Update existing features. 

13. Click Show field matching. 

14. Confirm that all fields listed in the Fields column have a corresponding field listed in the 
Match Field column. 

If no field is listed in the Match Field column, click the drop-down box for that field, and 
select the field name from the spreadsheet that reflects the value shown in the Fields 
column. 

15. Click Apply Updates. 

16. Repeat steps 7 through 15 twice, appending the data from the Officers and Subjects 
tabs of your spreadsheet into the Officers and Subjects feature tables. 

Note: 

If you want to automate the process of appending new Use of Force data from a local 
Excel workbook into the UseOfForce feature layer, see the Automate data updates 
section. 

 

Load crime data 
Police Transparency can be used by law enforcement agencies to share crime data. The 

solution includes web mapping apps and dashboards that can be used to display current and 

historical crime conditions in a community. 

To load your agency crime data from a spreadsheet into the Crime feature layer, complete the 

steps below. 

Tip: 

Ensure that the data in your Excel workbook already has valid latitude and longitude 
coordinates. If your data has only addresses and no coordinates, you can geocode it 
using a local address locator and ArcGIS Pro, or the Publish an Excel file workflow in your 
ArcGIS organizational portal. Export the resulting layer as a CSV file or Excel 
spreadsheet and add the Latitude and Longitude values to the Crimes worksheet along 
with the rest of your features. 

1. Sign in to your ArcGIS organization and browse to the Crimes feature layer. 

2. On the item details page, click Update Data, then click Append Data to Layer. 

3. Under Filename, choose your Excel workbook file. 

4. Click Upload and click Continue. 

Tip: 

You will need to be familiar with the fields and domain values. Many fields have 
existing domain values that are used for filters and charts in the Crime Summary 
Dashboard, Crime Trends Dashboard, and Public Crime Map. If the values in your 
data are not identical to the values in each domain, you can either change the values 
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in your data to match the values already in each field’s domain list, or follow the steps 
in the Modify data section to update the domain list of each field in the Crime feature 
layer to reflect the values in your data. When complete, you will update the Crime 
Summary Dashboard, Crime Trends Dashboard, and Public Crime Map to reflect your 
data values. 

5. Uncheck Update existing features. 

6. Click Show field matching. 

The Field column contains all of the fields in the Crimes feature layer. The Match Field 
column displays the names of all fields in your source Excel workbook. 

If no field is listed in the Match Field column, click the drop-down box for that field, and 
select the field name from your spreadsheet that reflects the value shown in the Fields 
column. 

7. Click Apply Updates. 

Note: 

If you want to automate the process of appending new Use of Force data from a local 
Excel workbook into the Crimes feature layer, see the Automate record import section. 

 

Load data for use of force context chart 
1. Sign in to your ArcGIS organization and browse to the ContextOfUseOfForce CSV item. 

2. On the item details page, click Download. 

3. Click Edit on the CSV file and enter a single year’s worth of summary totals for the 
following datasets: Calls For Service, Arrests, Total Use of Force, Serious Injury Force, 
and Deadly Force. Click Save to save the CSV file when complete. 

4. In your ArcGIS organization, browse to the ContextOfUseOfForce feature table. 

5. On the item details page, Click Update Data, then click Append Data to layer. 

6. Under Filename, choose your CSV file. 

7. Click Upload and Continue. 

8. Uncheck Update existing features. 

9. Click Show field matching. Confirm that all fields listed in the Fields column have a 
corresponding field listed in the Match Field column. If no field is listed in the Match 
Field column, click the drop-down box for that field, and select the field name from the 
CSV file that reflects the value shown in the Fields column. 

10. Click Apply Updates. 

Tip: 

To modify the data in this table after the initial load, browse to the data section of the 
ContextOfUseOfForce item, and double-click a value in the table to change it. 
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Remove outdated personnel records (optional) 
At some point, you may want to delete all data in a feature layer to load new information. For 

example, your organization may update the personnel roster information used in the Law 

Enforcement Diversity Dashboard semi-annually. To avoid duplicate or incorrect records, the 

existing records must first be deleted before a current roster can be appended into the 

solution’s Police Personnel table. 

 

Delete features 
To delete features from a hosted feature layer or table, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Go to the Overview tab of the Police_Personnel hosted feature table. 

3. In the lower right corner, in the URL category, click View. 

4. The ArcGIS REST Services Directory for this page appears. 

5. Click the link of the layer or table from which you want to delete records. 

6. In the URL bar of the browser, edit the URL with the following changes. 

a. Add the word admin between rest/ and services. (For example: 

ArcGIS/rest/admin/services/Police_Personnel) 

b. Add the word truncate between 0/ and ?token. (For example: 

FeatureServer/0/truncate?token=) 

7. In the next window, click Truncate. 

The hosted feature table will now be emptied and reset for new data to be appended. 

 

Update a layer with a join view 
The Police Transparency solution includes a series of feature layer join views that are used to 

display information in the Use Of Force page and in a series of use of force dashboards. Join 

views are created using the Join Features analysis tool by joining two sources together based 

on a matching field. The benefit of the join view is that it remains up to date as the source data 

changes. However, when new fields are added to the source layers or when field domain 

values are changed, the join views must be recreated with the same name and URL for the 

charts and dashboards to continue working properly. 

To add a field to a layer and update the join views, complete the following steps: 

1. Browse to the join view in your contents. 

2. On the item's Overview page, scroll to the URL section. Click the Copy button. 

3. Paste the copied URL into Microsoft Notepad or another text editor for reference. 
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Note: 

The feature layer’s service name will be used below when re-creating the join. The 
name can be found after services in the URL structure and may also contain a unique 
GUID, for example, 
UseOfForce_Incidents_Subjects_joina45f71a48587425c9b90ee5527cd26d1. 

4. Delete the existing join view. 

5. Add the source hosted feature layer to a new web map (for example, UseOfForce). 

6. Click Analysis, Summarize Data, Join Features. 

7. Configure the join using the table below. 

Name of join Target layer Layer to join to 
the target layer 

Fields to match Join 
operation 

UseOfForce_Incidents_Subjects_join Incidents 
(UseOfForce) 

Subjects 
(UseOfForce) 

agency_case_number 

= 

agency_case_number 

Join one 
to many 

UseOfForce_Incidents_Officers_join Incidents 
(UseOfForce) 

Officers 
(UseOfForce) 

agency_case_number 

= 

agency_case_number 

Join one 
to many 

Tip: 

Ensure each new join view uses the names defined in the table above. If you use the 
same names, the layers in the map and the existing dashboard widgets will not have 
to be reconfigured. If your join view contained a unique GUID, the new join view must 
be named with the unique GUID. 

8. If necessary, uncheck Use current map extent. Check Create results as hosted 
feature layer view. 

9. Update the web map and app configurations of Use of Force by Race and Ethnicity, Use 
of Force by Neighborhood, Use of Force by Subject, and Use of Force by Officer 
Dashboard to account for the new fields or domain values you added. 

 

Automate record import 
Some organizations may want to automate the importing of data from their record systems 

into the layers in the Police Transparency solution. In particular, users may want to perform 

daily or weekly updates of their Crimes or Use of Force data to ensure that residents have 

timely access to information. 

The layers in the Police Transparency solution can be updated using the Record Import Tools 

toolbox. These tools can be executed from ArcGIS Pro manually or automated on a schedule 

using Windows Task Scheduler. The Toolbox supports the use of database tables from your 
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Computer Aided Dispatch (CAD) or Records Management System (RMS) as well as Microsoft 

Excel spreadsheets (.xls) or comma-separated values (.csv) files. 

 

Modify ArcGIS Enterprise Sites pages 
The Police Transparency solution includes an ArcGIS Enterprise Sites site and pages that 

your organization can configure with your own branding and share your organization’s story 

with the public. 

 

Update with organizational information 
After deploying the Police Transparency solution, the site and pages require a few updates to 

fit your local context. Consider what information you already have and what you can most 

easily find. 

To update the Police Transparency site, complete the following steps: 

1. From the Customize window of the Site Home, select Header and Branding. 

2. Update the header to include your organizational icon. 

3. Change the name and short name of the site ( Police Transparency) to a name that 
better reflects your specific organization. 

4. Browse to the Social Icons group and enter in the URLs for your agency's Facebook, 
Twitter, and Instagram accounts, or disable if you don’t want them displayed. 

5. Click Apply, then click Save to save the page, and click Publish Draft. 

6. From the Customize window of the Site Home, select Footer. 

7. Click the expand button in the right corner of the HTML section. 

8. Replace the default icon URL, department name, email address, and street address with 
the correct values for your organization. 

9. Enter the URLs for your agency's Facebook, Twitter, LinkedIn, Instagram, and YouTube 
accounts. 

10. Delete any icons from the HTML that are not required, then click Apply. 

11. Click Save to save the page. 

12. Click Publish Draft. 

13. Update the main header image on each page to an image from your organization. 

For best results, this image should be 96 dpi and 1920 x 400. 

14. Update the other stock images in the site with images from your organization. 

For best results, these images should be 600 x 400 and 96 dpi. 

15. On the main page, click Configure on the Facebook and Twitter Social Media Cards to 
update the Timeline Link URL to your organization’s Facebook and Twitter pages. 

16. Review all text on each page for consistency with your organizational messaging. 
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Tip: 

Consider working with your Public Information Officer to refine this content to reflect 
your organizational needs. 

17. Browse to the Frequently Asked Questions section of the main page and click 
Configure to update the questions and answers. 

18. Browse to the Recruitment, Employment, and Diversity Resources section of the 
Personnel Diversity page and click Configure to update the images, text, and buttons to 
reflect your organizational initiatives. 

 

Remove ArcGIS Hub Premium content 
The Police Transparency solution comes with features that require ArcGIS Hub Premium; if 

you are using ArcGIS Enterprise Sites, you will want to remove the features that require 

ArcGIS Hub Premium. Organizations using this solution with ArcGIS Enterprise Sites should 

perform the following steps to remove the ArcGIS Hub Premium content from their site. 

To remove ArcGIS Hub premium content, complete the following steps: 

1. Browse to your app launcher and click Hub and click Police Transparency to begin 
editing the site. 

2. Scroll to the section titled Get Involved on the main site page. 

3. Click the delete button for the row card containing the section title, not just the section 
title. 

4. Click Save, then click Publish Draft. 

5. Repeat steps 1 through 3 for the Community Engagement, Workforce Diversity, 
Crime Stats, and Use of Forces pages in the site. 

6. Go to the Community Engagement page and scroll to the Scheduled Events section. 

7. Click the delete button for the row card containing the event calendar, not just the event 
calendar itself. 

8. Click Save, then click Publish Draft. 

 

Modify custom use of force charts 
Several charts on the Use of Force page of the Police Transparency solution make use of 

custom queries from solution layers that use preexisting values from domain lists. For your 

data to display properly in these charts, the values in your data must exactly match the values 

in the field domain list of the field in the feature layer. If your data contains different values, 

you must modify the custom JSON of the Hub charts to reflect your field values. 

To modify the JSON of the custom use of force charts, complete the following steps: 

1. Sign in to your ArcGIS organization. 
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2. Click your app launcher and select Sites. 

3. Click the Police Transparency site. 

4. On the Customize accordion, click the number of associated pages button. 

5. Click the Use of Force page. 

6. Find the chart labeled Serious Injury Use of Force Incidents and click the configure 
button (shaped like a gear). 

7. In the JSON Chart Definition section, find the section of the JSON that looks like the 
following: 

"where": "forcelevel='Level 3- Serious Injury'" 

8. Replace the value Level 3- Serious Injury with the value in your data that represents 
incidents involving serious injury. 

9. Click Apply. 

10. Click Save and click the drop-down list and select Publish Draft. 

11. Repeat steps 6 through 10 with the Fatal Use Of Force Incidents chart, replacing the 
value Deadly Force-Fatality with the value in your data that represents fatal use of force 
incidents. 

 

Modify apps 
The Police Transparency solution includes many apps that are used by law enforcement 

agencies to help residents and stakeholders explore crime conditions, use of force patterns, 

and departmental diversity. Apps in the Police Transparency solution can be modified to meet 

the needs of individual organizations. This section covers several app modification workflows 

organizations commonly require. 

 

Modify dashboards 
The Use of Force by Race and Ethnicity and Law Enforcement Diversity Dashboard require 

an organization to manually enter your jurisdiction’s population percentage values for each 

race/ethnicity group represented on the dashboards. This information helps to contextualize 

proportions of force and personnel data relative to the composition of the community. 

To update the dashboards with population percentages by race and ethnicity for your 

jurisdiction, complete the following steps: 

1. Obtain information about population percentages by race and ethnicity for your 
jurisdiction. 

Tip: 

This data is most typically obtained from the U.S. Census Bureau’s Quick Facts web 
page, where you can type the name of your jurisdiction to get population percentages 
by race and ethnicity. Consult your planning department for more information. 
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2. Sign in to your ArcGIS organization. 

3. Browse to and click to open the item page of the dashboard you want to edit. 

4. Click Edit Dashboard. 

5. Find the first indicator element where the language Community Makeup: X% appears 
and click the configure (gear) button. 

6. Click the General options category, then click Edit in the Description section. 

7. Switch the default value with the appropriate value for your jurisdiction. 

8. Repeat for all indicator elements with the Community Makeup: X% text. 

9. Click Save. 

 

Update dashboard charts to reflect new field values 
Dashboards in the  Police Transparency solution have been preconfigured to use layer fields 

that are powered by default domain values. If your data does not match the preexisting 

values, your data may not display or may display as a gray other value in dashboard charts. 

To update dashboards to reflect new field values, complete the following workflow: 

1. Sign in to your ArcGIS organization. 

2. Browse to and click to open the item page of the dashboard you want to edit. 

3. Click Edit Dashboard. 

4. Review your dashboard and identify all chart elements that require updating. 

5. For each chart element that needs an update, click the configure button. 

6. If the chart is a pie chart, click the Slices options category, delete the existing values, 
then click Load Categories. Style the categories with colors appropriate for the 
dashboard. 

7. If the chart is a serial chart, click the Series options category, delete the existing values, 
then click Load Series. Style the categories with colors appropriate for the dashboard.  

8. Click Save. 

 

Update dashboard filters to reflect new field values 
The Use of Force by Race and Ethnicity and Law Enforcement Diversity Dashboard both use 

field values (that are preset by a domain) to filter by specific demographic groups. If the values 

in your data differ from the domains present in the default fields of the Police_Personnel, 

UseOfForce-Subjects, and UseOfForce-Officers tables, these dashboards may not properly 

display. For example, if your data contains coded values for race/ethnicity (A, B, W, I, H, and 

so on) instead of complete values such as the domain for these fields, you will need to modify 

the element filters of these dashboards to reflect your values. 

To update dashboard elements in Law Enforcement Diversity Dashboard or Use of Force by 

Race and Ethnicity to use your field values, complete the following steps: 
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1. Sign in to your ArcGIS organization. 

2. Browse to and click to open the item page of the dashboard you want to edit. 

3. Click Edit Dashboard. 

4. Review your dashboard and identify all chart elements that require updating. 

5. For each indicator element that needs an update, click the configure button. 

6. In the Value drop-down list of the Filter section, replace the default value with the 
appropriate value from your data that represents the information conveyed by the 
element. 

7. Click Done. 

8. Repeat for all other indicator elements in the dashboard that require updating. 

9. Click the Save button. 

 

Change the crime summary dashboard from NIBRS to UCR 
Some organizations may want to provide public crime data according to the Federal Bureau of 

Investigation’s old Uniform Crime Reporting Summary Reporting System (SRS) standards 

rather than the new National Incident-Based Reporting System (NIBRS). The Crime Summary 

Dashboard is configured using the NIBRS standard, but can be updated to reflect the older 

UCR SRS standard if required by an organization. 

To update the Crime Summary Dashboard from NIBRS reporting standards to UCR SRS 

standards, complete the following workflow. 

Note: 

Before you begin this workflow, ensure that you have valid values populated in the UCR 
Offense Description and UCR Offense Category fields of the Crimes layer. 

1. Sign in to your ArcGIS organization. 

2. Browse to your content and click the Crime Summary Dashboard. 

3. Click Edit Dashboard. 

4. Click the configure button in the upper left corner of the Rich Text element containing the 
text Crimes Against Persons. 

5. In the text box, change the text to Violent Crime, then click Done. 

6. In the indicator element immediately below, click the configure button. 

7. In the Value section and Filter subsection, change the drop-down selection from NIBRS 
Crime Against Category to UCR Category, then change the value from Crimes 
Against Persons to Violent Crime (or the equivalent value in your data). 

8. Scroll down to the Reference section and Filter subsection, change the drop-down 
selection from NIBRS Crime Against Category to UCR Category, then change the 
value from Crimes Against Persons to Violent Crime (or the equivalent value in your 
data). 
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9. Click Done. 

10. Click the configure button on the Crimes Against Persons By Year chart element to the 
right of the last two elements you modified. 

11. In the Filter section, change the drop-down selection from NIBRS Crime Against 
Category to UCR Category, then change the value from Crimes Against Persons to 
Violent Crime (or the equivalent value in your data). 

12. Click Done. 

13. Click the configure button on the Crimes Against Persons By Month chart element to 
the right of the last element you modified. 

14. In the Filter section, change the drop-down selection from NIBRS Crime Against 
Category to UCR Category, then change the value from Crimes Against Persons to 
Violent Crime (or the equivalent value in your data). 

15. Click Done. 

16. Repeat steps 4 through 15 for the remaining two rows of elements, replacing Crimes 
Against Property with Property Crime (or the equivalent value in your data), then 
replacing Crimes Against Society with Part II crimes (or the equivalent value in your 
data). 

17. Click the Save button. 

 

Change the crime trends dashboard from NIBRS to UCR 
Some organizations may want to provide public crime data according to the Federal Bureau of 

Investigation’s old Uniform Crime Reporting Summary Reporting System (SRS) standards 

rather than the new National Incident-Based Reporting System (NIBRS). The Crime Trends 

Dashboard is configured using the NIBRS standard, but can be updated to reflect the older 

UCR SRS standard if required by an organization. 

To update the Crime Trends Dashboard from NIBRS reporting standards to UCR SRS 

standards, complete the following workflow. 

Note: 

Before you begin this workflow, ensure that you have valid values populated in the UCR 
Offense Description and UCR Offense Category fields of the Crimes layer. 

1. Sign in to your ArcGIS organization. 

2. Browse to your content and click the Crime Summary Dashboard. 

3. Click Edit Dashboard. 

4. Click the configure button along the right side of the Crime Type filter. 

5. In the Category Field, change the drop-down selection from NIBRS Description to UCR 
Description. 

6. Click the Actions options tab. 
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7. In the Target Field drop-down list for the Crime Hotspots layer, select UCR 
Description. 

8. Click Done. 

9. Click the Save button. 

 

Change the public crime map from NIBRS to UCR SRS 
Some organizations may want to provide public crime data according to the Federal Bureau of 

Investigation’s old Uniform Crime Reporting Summary Reporting System (SRS) standards 

rather than the new National Incident-Based Reporting System (NIBRS). The Public Crime 

Map app is configured using the NIBRS standard, but can be updated to reflect the older UCR 

SRS standard if required by an organization. 

To update the Public Crime Map app from NIBRS reporting standards to UCR SRS standards, 

complete the following workflow. 

Note: 

Before you begin this workflow, ensure that you have valid values populated in the UCR 
Offense Description and UCR Offense Category fields of the Crimes layer. 

1. Sign in to your ArcGIS organization. 

2. Browse to your content and click the Public Crime Map Web Mapping app. 

3. Click Edit Application. 

4. Click the Widget button at the top of the configuration section of Web AppBuilder. 

5. Click the Header Control- Set the widgets in this controller button. 

6. Click the Configure this widget edit button on the Summary widget. 

7. Click the edit button under Display Options for the Crimes layer. 

8. Click the Panel tab. 

9. In the Layer Options section, change the drop-down selection from NIBRS Description 
to UCR Description. 

10. In the Group Options section, change the drop-down selection from NIBRS Offense 
Category to UCR Category. 

11. Click OK twice to save the reconfigured Summary widget. 

12. Click the Configure this widget edit button on the Filter widget. 

13. Click the NIBRS Offense Category filter. 

14. On the Info tab, change the label of the filter from NIBRS Offense Category to UCR 
Category. 

15. On the Expressions tab, change the drop-down selection from NIBRS Offense 
Category to UCR Category. 

16. Change operator to is any of. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 618 

17. Check the Ask for values check box. 

18. Click the NIBRS Offense Description filter. 

19. On the Info tab, change the label of the filter from NIBRS Offense Description to UCR 
Description. 

20. On the Expressions tab, change the drop-down selection from NIBRS Offense 
Description to UCR Description. 

21. Change operator to is any of. 

22. Check the Ask for values check box. 

23. Click OK to save the reconfigured Filter widget. 

24. Click the Configure this widget edit button on the Report widget. 

25. Click the edit button under Actions for the Crimes layer. 

26. Change the drop-down selection from NIBRS Description to UCR Description. 

27. Click OK twice to save the reconfigured Report widget. 

28. Click Save at the bottom of the configuration window of Web AppBuilder. 

 

Modify Police Transparency surveys 
To modify any survey in the Police Transparency solution, including the Police Interaction 

Survey or the Community Safety and Policing Satisfaction Survey, complete the following 

steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click to download the survey you want to edit. 

4. Click again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all the 
selectable options for survey questions. 

7. Revise the survey to reflect your organizational needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

To view your changes in ArcGIS Survey123 Connect, on the Download Surveys page, 

click Download to download the updated survey. 

 

Share items with the public 
In order to make the  Police Transparency solution visible to the public, the sharing level of the 

site item and its associated apps, maps, and layers must be configured to allow public access. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 619 

1. Sign into your ArcGIS Organization and browse to the  Police Transparency Hub Site 
Application. 

2. Open the item page and click Share. 

3. In the Share window, click Everyone (public) and click Save. 

4. Repeat steps 1 through 3 to share the following items with everyone: 

Item Name 

Feature Layer (hosted) Community Safety and Police Satisfaction Survey 

Feature Layer (hosted, view) CommunityCrimeProblems_public 

Feature Layer (hosted, view) CommunityPolicingAreas_public 

Feature Layer (hosted, view) Crimes_public 

Feature Layer (hosted, view) Police Interaction Survey_fieldworker 

Feature Layer (hosted, view) UseOfForce 

Feature Layer (hosted, view) UseOfForce_Incidents_Officers_join 

Feature Layer (hosted, view) UseOfForce_Incidents_Subjects_join 

Table (hosted) ContextOfUseOfForce 

Table (hosted) Police_Personnel 

Web Map Community Crime Problem Dashboard 

Web Map Community Crime Problem Manager- Analysis 

Web Map Community Crime Problem Manager- Assessment 

Web Map Community Crime Problem Manager- Community Review 

Web Map Community Crime Problem Manager- New Problems 

Web Map Community Crime Problem Manager- Overview 

Web Map Community Crime Problem Manager- Response 

Web Map Community Crime Problem Reporter 

Web Map Crime Summary and Trends 

Web Map My Community Officer 

Web Map Public Crime Map 

Web Map Use of Force By Neighborhood 

Web Map Use of Force By Officer 

Web Map Use of Force By Subject 

Dashboard Community Crime Problem Dashboard 

Dashboard Community Crime Problem Manager 

Dashboard Crime Summary Dashboard 

Dashboard Crime Summary Mobile Dashboard 

Dashboard Crime Trends Dashboard 

Dashboard Law Enforcement Diversity Dashboard 

Dashboard Law Enforcement Diversity Mobile Dashboard 

Dashboard Use of Force by Neighborhood 

Dashboard Use of Force by Officer 

Dashboard Use of Force by Race and Ethnicity 

Dashboard Use of Force by Race and Ethnicity Mobile Dashboard 

Dashboard Use of Force by Subject 

Pages Community Engagement 

Pages Crime Stats 

Pages Use of Force 

Pages Workforce Diversity 

Web Mapping Application Public Crime Map 
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Web Mapping Application Community Crime Problem Reporter 

Web Mapping Application My Community Officer 

Form Community Crime Problem Editor 

Form Community Safety and Police Satisfaction Survey 

Form Police Interaction Survey 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 621 

Use Police Transparency 
The Police Transparency solution delivers a set of capabilities that help you share information 

openly with the public, promote your agency’s work, demonstrate accountability when force is 

used, illustrate how workforce recruiting reflects the diversity of the community, and engage 

the public to improve policing services. 

In this topic, you will learn how to use the Police Transparency solution by assuming various 

roles and using the solution to answer questions about policing topics of general interest, 

including understanding crime conditions in your community, learning about law enforcement 

use of force, discovering police-community engagement opportunities, and exploring the 

workforce diversity of the law enforcement agency. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Understand crime statistics 
You will assume the role of a resident in the community. You are interested in learning more 

about overall trends of crime in your community, and specifically about trends in burglary. You 

are concerned that burglaries are increasing around your home, so you’d like to be able to 

learn about recent burglaries in your area and print a report to take to the upcoming 

neighborhood meeting to ask your community policing officer what is going on and how to 

address the problem. 

 

Examine statistical crime trends 
Complete the following steps to learn more about overall crime trends, specifically burglary, in 

your community: 

1. In a browser, open the  Police Transparency site, and click the Crime Stats page. 

2. Scroll down the page to view the Crime Summary Dashboard. The dashboard displays 
the three main categories of crimes according to the National Incident-Based Reporting 
System (NIBRS). These categories are shown as 365-day percent change statistics, 
counts by year, and counts by month. 

Note: 

In January 2021, the Federal Bureau of Investigation (FBI) changed to NIBRS from the 
previous Uniform Crime Reporting (UCR) Summary Reporting System. Links to 
additional details about NIBRS can be found in the resources section of the Crime 
Stats page. 

3. To understand burglary trends specifically, scroll to the Crime Mapping Apps section 
and click the Crime Trends Dashboard. 
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4. Click the Crime Type filter and select Burglary/Breaking & Entering, then click the 
Filter Results tab. 

You can now view 28-day, year-to-date, and last 365-day percent change statistics, 
burglary counts by year, by month, and a map of burglary hot spots. 

5. To filter for only the current year of burglaries, select This Year from the Report Date 
filter. 

The Crime By Year and Crime By Month charts will be updated. Additionally, the 
burglary hot spots will change to reflect the current year only. 

6. Zoom in on the map. As you zoom in, individual burglaries appear. Click the burglary to 
learn more about the incident. 

 

Explore recent crime activity 
The Public Crime Map app can be used to explore recent burglary activity and create a printed 

report to take to your neighborhood meeting. 

Complete the following steps to learn about recent burglaries in your area and print a report to 

take to the upcoming neighborhood meeting: 

1. On the Crime Stats page, scroll to the Crime Mapping Apps section, and click Public 
Crime Map. 

This mapping app displays the last 28 days of crime by default and shows a list of all 
crimes in the community, grouped by type of crime. 

2. To view all burglaries this year, click the Filter widget. In the NIBRS Offense Description 
filter, select Burglary/Breaking & Entering, then click the option to activate the filter. 

3. In the Date of Crime filter, in the first drop-down box, select January 1 of this year. 

4. In the second drop-down box, select today, then click the option to activate the filter. 

You can now view year-to-date burglaries citywide. 

5. To view the burglaries near your home, go to the address search bar and enter your 
address. Click each burglary to learn more about the incident. 

You would like to discuss these burglaries with your neighbors and community policing 
officer at an upcoming community meeting. 

6. Click the Report widget, then select the Point draw mode. 

7. Click your home address. In the buffer distance (optional) parameter, enter a buffer 
distance of .25 miles, then click Report. 

8. Click the add button to see a list of all burglaries within the 0.25-mile radius around your 
house. 

9. To download these records as a CSV file, click the Download button or click the Print 
button to create a printable report. 

A report will be generated containing a map of your app’s current map extent and a list of 
the records within the search area. You can change the report title or any header text to 
meet your needs. You can also choose to enter additional comments in the comments 
box. 
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10. To filter for only the current year of burglaries, select This Year from the Date of Crime 
Report filter. 

The Crime By Year and Crime By Month charts will be updated. Additionally, the 
burglary hot spots will change to reflect the current year only. 

11. Zoom in on the map to see individual burglaries. 

12. Click a burglary to learn more about the incident. 

 

Share your perceptions of community safety and police performance 
Complete the following steps to provide feedback on your interactions with law enforcement in 

your community: 

1. In a browser, open the Police Transparency site and click the Crime Stats menu tab. 

2. Scroll down to the Tell Us How We’re Doing section and click the Take the Survey 
button. 

3. Fill in the Community Safety and Policing Satisfaction Survey to provide your feedback. 

4. Click Submit. 

 

Learn about use of force 
Now you will assume the role of a community leader. You have recently been appointed to a 

police oversight board responsible for reviewing use of force incidents in the community. To 

perform this role, you need to first gain a basic understanding of how and why force is used by 

law enforcement, racial equity implications of its use, and then dig deeper to understand 

patterns in the use of force by the subjects of force, officers involved, and by neighborhood. 

 

Gain a basic understanding of use of force 
Complete the following steps to learn more about use of force in your community: 

1. In a browser, open the Police Transparency site, and click the Use Of Force page. 

2. Scroll down to view the Key Use of Force Metrics. 

These three charts show total use of force incidents, use of force incidents involving a 
serious injury requiring medical care or hospitalization, and fatal use of force incidents. 

3. Scroll to the How Often Do We Use Force? section. 

This section displays charts illustrating the infrequency of use of force relative to the total 
scope of police interactions with citizens, and how few are determined to be inconsistent 
with policy. 

4. Scroll down to the Why Do Officers Use Force? section. 

This section helps you understand what types of incidents are most likely to result in 
force, the type of resistance officers are encountering that require use of force, and the 
type of force applied. 
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5. Scroll down to the Racial Equity section. 

This section displays a dashboard that examines the distribution of subject of force and 
officers involved by race and ethnicity, compared to the racial and ethnic composition of 
the community overall. 

6. Click the Force Level or Date drop-down filters to further refine these metrics. 

7. Click the Officers Involved tab to visualize the distribution of officers involved in use of 
force incidents by race and ethnicity relative to community composition. 

 

Explore characteristics of subjects of force 
The Use of Force by Subject dashboard helps the public explore the characteristics of use of 

force in your neighborhood and compare through the perspectives of demographics, context 

of the incident, condition of the subjects, and location. Use the filters to set criteria, then click 

any bar in the charts to refine the results. For example, you may want to know more about the 

characteristics of subjects of electric force through conducted electrical devices such as 

Tasers or stun guns. 

Complete the following steps to dig deeper into the topic of use of force by exploring the 

characteristics of the persons subjected to force: 

1. In a browser, open the Police Transparency site, and click the Use Of Force page. 

2. Scroll down to view the Gain a Deeper Understanding section. 

3. Click Use of Force by Subject. 

4. In the Force Type drop-down filter, select a type of force. 

5. Click the Incident Context tab to see the proportion of incidents that were found to be 
inconsistent with policy. 

6. Click the Out of Policy slice of the Result of Internal Review pie chart. 

7. Click the Map tab to view the selected incidents symbolized by color according to the 
race and ethnicity of the subject of force. 

The colors correspond to another layer in the map, the Predominant Race and Ethnicity 
by Census Tract, an ArcGIS Living Atlas of the World layer based on data from the U.S. 
Census Bureau’s American Community Survey. 

8. Click the Legend tool in the map to understand how color corresponds to race and ethnic 
group. 

The presence of both layers on the map allows us to understand the relationship 
between the race and ethnicity of the residents of an area and who is subjected to force 
there, and to recognize patterns in which force is being applied to a particular group 
disproportionately to its community composition. 

9. Click a polygon in the Predominant Race by Tract layer. 

The pop-up displays which race or ethnic group is predominant in that tract as well as the 

resident counts of all other race and ethnic groups within the tract. 
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Explore characteristics of officers applying force 
The Use of Force by Officer dashboard helps the public explore the characteristics of 

officers applying force through the perspectives of demographics, context of the incident, and 

location. Use the filters to set criteria, then click any bar in the charts to refine the results. For 

example, you may want to know more about the characteristics of officers who apply force 

resulting in serious injury or death. 

Complete the following steps to dig deeper into the topic of use of force by exploring the 

characteristics of the persons subjected to force: 

1. In a browser, open the Police Transparency site, and click the Use Of Force page. 

2. Scroll down to view the Gain a Deeper Understanding section. 

3. Click Use of Force by Officer. 

4. In the Force Level drop-down filter, select a force level. 

5. Click the Incident Context tab to view the incident contexts most frequently associated 
with the level of force you selected. 

6. Click a category on the Call Type bar chart. This further filters the dashboard, allowing 
you to explore the characteristics of officers involved specifically in the force level and 
call type you have selected. 

7. Click back on the Demographics tab. 

8. Follow steps 6 through 8 of the Explore characteristics of subjects of force section in 
this topic to learn about the spatial distribution of race and ethnicity and community 
composition. 

 

Explore use of force incidents by neighborhood 
The Use of Force by Neighborhood dashboard helps the public explore the characteristics of 

use of force in their neighborhood and to compare it to other neighborhoods and the 

community overall. Use the filters to set criteria, then click any bar in the charts to refine the 

results. For example, you may want to know more about the characteristics of use of force 

incidents in your neighborhood and how they compare to nearby neighborhoods. 

Complete the following steps to explore the characteristics of use of force incidents in your 

neighborhood and compare them to other neighborhoods and the community overall. 

1. In a browser, open the  Police Transparency site, and click the Use Of Force page. 

2. Scroll down to view the Gain a Deeper Understanding section. Click Use of Force by 
Neighborhood. 

3. In the Neighborhood drop-down filter, select a neighborhood. 

The map zooms to your neighborhood boundaries and filters the content. The charts 
automatically adjust to your filter selection. You can see from the filtered charts use of 
force incidents the trend in use of force incidents overall, and the frequency of serious 
injury or fatal incidents. 

4. In the Neighborhood drop-down filter, select a different neighborhood. 
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You can now compare the overall, serious injury, and fatal trends in use of force incidents 
between the two neighborhoods. 

5. Click the Details tab to review and contrast demographic characteristics of subjects of 
use of force, the type of force applied, and the type of calls in which force most frequently 
occurs. 

6. Follow steps 6 through 8 of the Explore characteristics of subjects of force section in this 
topic to learn about the spatial distribution of race and ethnicity and community 
composition. 

 

Discover community engagement opportunities 
Now you will assume the role of a concerned business owner. Your business has recently 

been victimized. You believe the crime to be part of a larger problem, and you want to become 

more active in working with your department to solve this problem and prevent future crimes. 

To perform this role, you’ll need to learn how to get connected to police by finding your 

community officer, report your crime problem, provide feedback on your experience as a 

victim, and get information on upcoming police community events in which you can 

participate. 

Find your community officer 
Complete the following steps to learn more about the men and women that work with your 

neighborhood to solve safety concerns: 

1. In a browser, open the Police Transparency site, and click the Community Engagement 
page. 

2. Scroll down to the Find Your Community Officer section. 

3. In the My Community Officer app, you have the following options: enter your address 
or click a map location. 

The app will show a name and picture of your community officer, contact information, duty 

hours, the community policing area the location belongs to, and information about when 

meetings are held for this area. 

 

Report community crime problems 
Complete the following steps to view existing crime problems reported by the public and to 

submit a new non-emergency problem you have observed in the community. 

1. In a browser, open the Police Transparency site, and click the Community Engagement 
page. 

2. Scroll down to the Engaging the Community section and under Report a Crime 
Problem, click Submit a Problem. 

3. Click Proceed as Guest. 

4. Click Submit a Problem. 
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5. Complete the form, providing a name for the problem, describing the nature of the 
problem and where it is occurring, and, optionally, your contact information. 

6. Click the map to start drawing a polygon that defines the extent of the problem area. 
Keep clicking to define the edges of the polygon, then double-click to complete. 

7. Click Report It. 

8. Now you can view your crime problem and others recently submitted by residents. Click 
another crime problem. 

9. Click the like button to like the report. 

10. To add your comments, click the comment button. When complete, click Submit 
Comment. 

 

Manage community crime problems 
Once a crime problem report has been submitted, Community Policing Officers (CPOs) work 

with community members to validate, prioritize, and solve these concerns. The Community 

Crime Problem Manager enables CPOs to manage the crime problems through a 

collaborative, community-oriented problem-solving process based on the Problem-Oriented 

Policing SARA model (Scan, Analyze, Respond, Assess). In this section, you will take the role 

of a CPO. Complete the following steps to learn how to manage citizen-reported crime 

problems through a problem-solving process: 

1. From your content, open the Community Crime Problem Manager. 

The overview tab displays a list of all crime problems with charts displaying their project 
approval status and problem-solving phase. 

2. Click a bar in the chart to filter the crime problem list. You may also use the 
neighborhood filter to select crime problems occurring in a specific neighborhood. 

3. Click a problem from the list to zoom to the location of the problem. 

4. Click the problem on the map to activate a pop-up to learn more about the problem. 

Each tab in the Community Crime Problem Manager displays a step in the problem-
solving process, with instructions on the actions to be taken and data to be edited for that 
step. 

5. Click Create Report. 

This opens the Data tab of ArcGIS Survey123, where you can click the Print button to 
create a printable PDF file of the crime problem record. 

6. Review the list of crime problems and click the one you want to edit. The map will zoom 
to the problem, and the left-side ArcGIS Survey123 form will display the record you have 
selected. 

7. Follow the instructions to update the form with the data required for the step. Click the 
Submit button at the bottom of the ArcGIS Survey123 form to submit your edits. 

8. As your crime problem proceeds through the problem-solving steps in the real world, 
follow the instructions on each tab to advance the problem through the process in the 
app. 
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Explore community crime problems 
As CPOs and community members work together to solve crime problems, the public can 

exercise oversight on the status of active and completed projects using the Community Crime 

Problem Dashboard. In this section, you will resume your role of a concerned business owner. 

Complete the following steps to explore previous crime problem-solving successes and other 

active problem-solving projects that are underway: 

1. In a browser, open the Police Transparency site, and click the Community Engagement 
page. 

2. Scroll down to the Engaging the Community section and under Monitor Problem-
Solving Projects, click Monitor Projects to open the Community Crime Problem 
Dashboard. 

3. Use the filters to set criteria, then click any chart or list to refine the results. 

4. Click a project in the list to review a specific project. 

The map will zoom to the location of the problem. 

5. Click the Details tab to view complete details for that project. 

 

Submit feedback on a police interaction 
Complete the following steps to provide feedback to the department on your recent 

experience as a crime victim: 

1. In a browser, open the Police Transparency site and click the Community Engagement 
menu tab. 

2. Scroll down to the Engaging the Community section and under How Did We Do?, click 
Complete Survey. 

3. Fill in the Police Interaction Survey to provide your feedback. 

4. Click Submit. 

 

Explore law enforcement workforce diversity 
You will assume the role of a local media reporter. You are writing a story about 

representation of women and communities of color in policing. You want to learn more about 

the composition of the workforce of the local law enforcement agency and how that compares 

to the community overall. 

1. In a browser, open the Police Transparency site and click the Workforce Diversity menu 
tab. 

2. Scroll down to the Law Enforcement Diversity Dashboard. 

The summary tab of the dashboard displays the percentage of employees in each 
demographic group listed. 
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Note: 

Under each demographic group, a text box indicates the percentage that group 
represents in the community overall. This information allows you to quickly identify 
which demographic groups are overrepresented in the police workforce relative to the 
composition of the community. 

3. To view civilian employees only, go to the Rank drop-down filter and select Civilian. 

The demographic percentages will adjust to your selection. This will allow you to 
compare representation of sworn employees versus civilian employees. 

4. To view all sworn employees, deselect Civilian in the drop-down filter and select all other 
ranks. 

5. Click the Details tab. 

The Details tab allows you to visualize and interact with various diversity metrics of the 
workforce. 

6. Click the Black Female section of the Race and Gender bar chart to learn more about 
representation of Black females in the department. 

The charts and metrics automatically adjust based on your selection. 

7. Click the Black Female section of the Race and Gender bar chart to turn off the 
selection. 
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Protection Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Protection Operations 
Protection Operations can be used to track poaching or illegal activity and monitor the status 

of protection operations in and around protected areas. 

It provides 24/7 access to protection operations information and helps organizations respond 

to threats in real-time. This accelerated approach improves wildlife safety and reduces risks 

associated with illegal activities in a protected area. Protection Operations is typically 

implemented by conservation organizations that want to take a data-driven approach to 

monitoring illegal activity. 

The Protection Operations solution delivers a set of capabilities that help you track poaching 

and illegal activity, monitor protection operations, and visualize patterns of illegal activity. 

 

Requirements 
Protection Operations requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

• Survey123 Connect 
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Information products 
Protection Operations includes the following information products: 

Item Description Minimum 
user type 

Protected Area 
Dashboard 

An ArcGIS Dashboards app used by conservation staff 
to monitor the status of protected area operations 

Viewer 

Protection 
Incident 
Dashboard 

An ArcGIS Dashboards app used by conservation staff 
to monitor the status of protection operations within and 
around protected areas 

Viewer 

Protected Area 
Reports 

An ArcGIS Web AppBuilder app used by conservation 
staff to perform analysis and generate reports 

Creator 

Protection 
Incident Manager 

A Crowdsource Manager app used by conservation staff 
to manage and update protection incident reports 

Editor 

Protection 
Incident Reporter 

An ArcGIS Survey123 form used by conservation staff to 
collect protection incident reports 

Mobile 
Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Protection Operations 
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Configure Protection Operations 
Learn how to configure the Protection Operations solution to meet specific needs in your 

organization. 

 

Load data 
Protection Operations can be used to track poaching or illegal activity and monitor the status 

of protection operations in and around protected areas. In some cases, you may already have 

this information in ArcGIS or another business system. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 

workflow below. 

 

Load data from a shapefile 
Load data for ProtectionIncidents from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Protection Operations 
The Protection Operations solution delivers a set of capabilities that help you track poaching 

and illegal activity, monitor protection operations, and visualize patterns of illegal activity. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect protection incidents 
You will start by assuming the role of a mobile worker in a protected area collecting protection 

incidents. You are asked to use the Protection Incident Reporter survey to collect protection 

incidents. 

1. On a mobile device, in ArcGIS Survey123, open the Protection Incident Reporter form. 

2. Tap the Collect button. 

3. Complete the survey with as much information as possible. 

4. Tap the check mark to submit the form, and then tap Send now. 

 

Manage protection incidents 
Next, you will assume the role of a conservation staff member. You will review protection 

incidents. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Protection 
Operations solution. 

2. View the Protection Incident Manager app. 

3. In the table, use the Illegal Incident Type column header filter to filter for a specific 
incident type. 

4. Select a protection incident from the table. 

  The report details open at the lower left. 

5. In the report details, click the Edit record button . 

6. Make any necessary updates to the report, and then click Save. 

 

Monitor protection incidents 
Now, you will assume the role of a protected area manager. You will monitor the status of 

protection incidents in and around a protected area. 
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1. In a browser, sign in to your ArcGIS organization, and then browse to the Protection 
Operations solution. 

2. View the Protection Incident Dashboard app. 

3. On the left, adjust the filters to refine the results. 

4. On the right, select a protection incident from the incidents list. 

  The map zooms to the incident, and a pop-up with incident information appears. 

5. In the pop-up, click View Incident Details to open a new browser tab and review the 
protection incident details. 

 

Monitor protected area operations 
For this workflow, you will continue to assume the role of a protected area manager. You will 

monitor the status of poaching and illegal activity, wildlife observations, and wildlife conflicts in 

and around protected areas. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Protection 
Operations solution. 

2. View the Protected Area Dashboard app. 

3. In the left, adjust the filters to refine the results. 

Tip: 

If you do not see the filter panel, click the arrow on the left to expand the panel. 

4. At the bottom of the page, click the Protection Incidents, Wildlife Observations, and 
Wildlife Conflicts tabs to view information about each area. 

5. On the Protection Incidents tab, on the right, select a protection incident from the 
incidents list. 

  The map zooms to the incident, and a pop-up with incident information appears. 

6. In the pop-up, click View Incident Details to open a new browser tab and review the 
protection incident details. 

 

Generate protected area reports 
Finally, you will assume the role of a conservation staff member. You will perform analysis and 

generate reports on protected area data. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Protection 
Operations solution. 

2. View the Protected Area Reports app. 

3. Click the Filter Protected Area Data button to open the widget. 

4. In the widget, turn on the Poaching Incident Status filter, expand the section, and select 
a status type. 
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5. Click the Update Layer Visibility button to open the widget. 

6. In the widget, select the layers that you want to include in your report. 

7. Click the Perform Analysis button to open the widget.  

8. Select an analysis tool, set the analysis parameters, and click Run Analysis.  

  After the tool completes, the analysis output displays on the map. 

9. To create a hard copy of the map showing analysis outputs, click the Print a Map button. 

10. To generate a report, click the Create Reports  button to open the widget. 

11. To create a report, complete the following steps: 

a. Choose the report type. 

b. Define the area of interest. 

c. Optionally, set a buffer distance. 

d. Click Report. 

  An overview of the report information is displayed. 

12. Click the Download button to download the report data. 

13. Click the Print button to print a copy of the report. 
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Public Notification 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Public Notification 
Public Notification can be used to identify a collection of properties and create structured 

mailing lists of owners and occupants. 

It streamlines the public notification process and reduces staff resources required to generate 

public notices required to meet procedural or statutory requirements. Public Notification is 

typically implemented by planning departments, assessor offices, and other local government 

agencies that want to increase the reliability of their public notification process. 

The Public Notification solution delivers a set of capabilities that help you identify properties, 

generate a list of owners or occupants, and document which properties were included in the 

public notice. 

 

Requirements 
Public Notification requires the following: 

• ArcGIS Enterprise 

 

Information products 
Public Notification includes the following information products: 

Item Description Minimum 
user type 

Public 
Notification 

An ArcGIS Web AppBuilder app used by local government 
staff to identify a collection of properties and create mailing 
labels, or a structured text file, of owners and occupants 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Public Notification 
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Configure Public Notification 
Learn how to configure the Public Notification solution to meet specific needs in your 

organization. 

 

Load data 
Public Notification can be used to identify a collection of properties and create structured 

mailing lists of owners and occupants. In some cases, you may already have this information 

in ArcGIS or another business system. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or applications. 

Once you have determined what source data must be loaded, complete the following data 

loading workflow: 

 

Load data from a shapefile 
Load data for TaxParcels or SiteAddresses from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Use Public Notification 
The Public Notification solution delivers a set of capabilities that help you identify properties, 

generate a list of owners or occupants, and document which properties were included in the 

public notice. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Create mailing list 
An update to the land-use plan requires a zoning change for a residential area. As a result, 

city planners must notify property owners and occupants in and around the proposed change 

of an upcoming public meeting. In this workflow, you'll learn how to create a structured mailing 

list using a selected parcel and adding the appropriate buffer to notify property owners and 

occupants. 

You will start by assuming the role of a city and regional planner. You are asked to use Public 

Notification to notify property owners and occupants of a proposed zoning change. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Public 
Notification solution. 

2. View the Public Notification app. 

3. On the right, use the search field to search for a parcel or address, or use the Select tool 
to select a feature directly on the map. 

Note: 

The search options that you see vary depending on how you configured the app. 

Tip: 

You can also use the Select tool to add features to an existing selection by pressing 
Shift and drawing the addition on the map. You can use the Select tool to remove 
features by pressing Ctrl and drawing around the area that you want to remove. 

4. Optionally, apply a search distance to add a buffer. 

Note: 

The buffer distance set during the configuration will be used as the default for each 
layer. 

5. For Addressee Layer, choose the layer to use for the notification. 
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6. If applicable, click Review to further refine and finalize your selection; use the Select tool 
to add or remove parcels. 

7. For Format, choose the PDF label format or CSV output for the notification. 

8. Click Download. 
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Public Parking 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Public Parking 
Public Parking can be used to inventory parking assets and promote public parking (lots, 

garages, on-street spaces, and pay stations) alternatives in a downtown or neighborhood. 

As downtowns and neighborhoods expand and become more vibrant, accessible and reliable 

parking information allows drivers to choose a convenient parking option. Any challenge 

locating a parking option or the perception of a parking shortage will frustrate drivers and 

impact businesses and restaurants in the area. Managing and communicating parking 

information helps drivers locate desirable spaces and reduces congestion in a downtown or 

neighborhood. Public Parking is typically implemented by public works and planning 

departments that want to educate the public and promote parking assets in their community. 

The Public Parking solution delivers a set of capabilities that help you inventory parking assets 

and share nearby surface lots, garages, and on-street spaces with drivers. 

 

Requirements 
Public Parking requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 
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Information products 
Public Parking includes the following information products: 

Name Description Minimum 
user type 

Parking Field 
Map 

An ArcGIS Field Maps map used by public works or 
planning department personnel to inventory public 
parking and pay stations in the field 

Mobile 
Worker 

Parking 
Inventory 

An ArcGIS Web AppBuilder app used by public works or 
planning department personnel to inventory public 
parking and pay stations 

Editor 

Parking Locator A Nearby app used by the general public to locate public 
parking alternatives 

Not required 

Public Parking An ArcGIS Hub site used by public works and planning 
departments to communicate public parking alternatives. 

Not required 

Parking 
Satisfaction 
Survey 

An ArcGIS Survey123 form used by the general public to 
share their experience with parking resources in a 
community. 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Public Parking 
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Configure Public Parking 
Public Parking can be used to inventory parking assets and promote public parking (lots, 

garages, on-street spaces, and pay stations) alternatives in a downtown or neighborhood. 

In this topic, you'll learn how to configure the Public Parking solution to meet specific needs in 

your organization. 

 

Load data 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or apps. 

Once you have determined what source data must be loaded, complete one or more of the 

data loading workflows below. 

 

Load data from a shapefile 
Load data into the Parking layer from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. Sign in to your ArcGIS organization and browse to the feature layer you want to populate. 

3. Open the item page and click Update Data > Append Data to Layer. 

4. Click Choose File and browse to your .zip file, and click Open. 

5. Click Upload and Continue. 

6. Click Choose the layer that you wish to append data into drop-down arrow and 
choose the layer that contains the updated data. 

7. Uncheck Update existing features. 

8. Click Show field matching and map the fields between the two layers. 

9. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Populate operational hours 
This solution leverages the Opening Hours Specification to display operating hours for a place 

or service. When you populate the data fully, Arcade expressions interpret the data and 

display the operating hours in a human-readable format in the map pop-up. Understanding the 
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data specification and options in the Arcade expressions will help you populate your data and 

display it in the maps and apps provided with the ArcGIS Solution. 

Operating Hours Specification 
The Operating Hours Specification allows you to store a combination of operating hours in a 

single field but relies on a series of data standards to render the information correctly. To 

ensure operating hours are displayed correctly, follow the standards below: 

• Enter all times using a 24-hour clock without a leading 0—for example, Tu (7:00-19:00). 

• Use a two-letter abbreviation for each day, with the first letter capitalized—for example, 
Mo, Tu, We, Th, Fr, Sa, Su. 

• When a location is open 24 hours a day, use 24 Hours—for example, Mo (24 Hours). 

• When a location is closed on a specific day, use Closed—for example, Sa-Sun (Closed). 

• Enclose all times and closed statuses in parentheses—for example, Tu (7:00-19:00); We-
Mo (Closed). 

• Separate days and ranges with a semicolon to denote the two (or more) groups—for 
example, Th-Fr (7:00-19:00); Sa (24 Hours). 

Using the standards above, a diverse set of operating hours can be populated for your places 

and services. Some common examples include the following: 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. seven days a week, populate the 
operating hours field with the following: Mo-Su (9:00-17:00). 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. during the week and closed on 
weekends, populate the operating hours field with the following: Mo-Fr (9:00-17:00); Sa-
Su (Closed). 

• To specify the place is open one day (Tuesday) a week, populate the operating hours 
field with the following: Tu (7:00-19:00); We-Mo (Closed). 

• To specify the place has operating hours that vary by day, populate the operating hours 
field with the following: Mo-Tu (9:00-17:00); We (Closed); Th-Fr (7:00-19:00); Sa (24 
Hours); Su (Closed). 

Operating hours data can be populated all at once for many places and services using 

Calculate field values or uniquely entered for each place or service using an application 

provided with the solution. 

 

Arcade expressions 
The Arcade expressions include several settings that allow you configure the look and feel of 

the operating hours when they are displayed in the web map pop-up. The expressions work 

with the operating hours data and web map pop-up configurations to display current operating 

hours in your map and app. 

This solution uses three Arcade expressions: Hours, Days, and Open/Closed. To modify one 

of these expressions, complete the following steps: 
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1. Verify that you are signed in to your ArcGIS organization and browse to the Parking 
Locator map. 

2. Open the item page and click Open in Map Viewer Classic. 

3. Click More Options and click Configure Pop-up on the On Street Parking layer. 

4. Under Attribute Expressions, double-click the Arcade expression you want to modify. 

Each Arcade expression has a set of variables that can be configured according to your 
organization’s needs. Review the expression notes and modify the variables as needed. 
Do not change anything else in the expressions. 

5. Click OK. 

6. Repeat the above steps for the Lots and Garages layer. 

 

Configure parking locator 
The Parking Locator app can be used by the general public to locate public parking 

alternatives. Directions to the nearest parking space can be enabled so users can quickly find 

the space they are looking for. 

 

Configure directions 
Follow the steps below to enable directions. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Parking 
Locator app. 

2. From the item page, click Configure App. 

Close the Welcome to the App Setup Page splash page, if necessary. 

3. Click Nearby > Options and turn on the Show directions toggle button. 

4. Check the check box next to the Lots and Garages, On Street Parking and Pay 
Stations layers. 

5. Click Publish. 

6. Click Confirm. 

The Authorize premium content window appears with information related to 
authorization. 

7. Click Authorize. 

8. Click Launch. 

 

Modify satisfaction survey 
The Public Parking solution includes a Parking Satisfaction Survey that can be used to gather 

public sentiment and feedback on parking facilities. Review the preconfigured questions and 

align the survey with your organizational policies and desired outcomes. 
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To modify the Parking Satisfaction Survey, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Parking 
Satisfaction Survey. 

2. Open the item page and click Open in Survey 123 > Manage in Survey123 website. 

3. Click the Design tab. 

4. Make your edits to the survey and save the changes. 

5. Click Publish twice. 

 

Configure parking site 
The Public Parking solution includes the Public Parking ArcGIS Hub site that your 

organization can configure with your branding and use to share parking information with the 

public. 

 

Update with organizational information 
After deploying the Public Parking solution, the Public Parking site layout only requires a few 

updates to fit your local context. Consider what information you already have and what you 

can most easily find. To update your site, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Public 
Parking site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Statistics section listed under the title of the website.  

  The Total Number of Spaces, EV Charging Stations, and Average Hourly Rate ($) 
statistics cards are linked to the Public Parking solution’s Parking_public feature layer. 
These stats automatically update parking assets are added using the Parking Inventory 
app. 

5. Scroll to the Pay Your Parking Ticket section, hover over the card and click edit pencil 

. 

6. Click the Pay Now button and click Edit. 

7. Enter the URL to your online payment system, if available, in the Link Destination text 
box and click Add Link. 

8. Scroll to the Apply Now section, hover over the card and click edit pencil. 

9. Click the Apply for Permit button and click Edit. 

10. Enter the URL to your residential permit program, if available, in the Link Destination 
text box and click Add Link. 

11. Scroll to the Frequently Asked Questions section, hover over the card and click the edit 
pencil, and update the questions and answers. 
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12. Click Footer.  

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

13. Click the HTML text box. 

  The HTML window appears. 

14. Make the necessary changes and click Apply. 

15. Click Save. 

 

Share items with public 
Several layer views, maps and apps included in the Public Parking solution must be shared 

with everyone so they can be accessed by the public on the Public Parking site. To share your 

public parking items with everyone, use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Public 
Parking folder. 

2. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) Parking_public 

Web Map Parking Locator 

Web Mapping Application Parking Locator 

Form Parking Satisfaction Survey 

Feature Layer (hosted) ParkingSatisfactionSurvey_public 

Site Application Public Parking 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

  Warning: Sharing editable layers publicly appears notifying that you are sharing 
editable layers publicly. 

5. Click Update. 
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Use Public Parking 
The Public Parking solution delivers a set of capabilities that help you inventory parking assets 

and share nearby surface lots, garages, and on-street spaces with drivers. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect parking assets in the field 
In many cases, a field assessment of existing parking assets may be the most efficient way to 

develop a parking inventory. The information collected in the field can then be augmented with 

other descriptive information that helps drivers or the public find parking alternatives. 

You will assume the role of a mobile worker in a public works or planning department. In this 

workflow, you are asked to use the ArcGIS Field Maps mobile app to access your Parking 

Field Map and inventory parking assets in your community. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Tap Parking Field Map to open the map. 

3. Search for an address, and then in the results list, tap the address to zoom to that 
location on the map. 

4. Tap the plus sign or Collect Here to open the survey form. 

Note: 

Your interface may vary depending on the type of mobile device you use. 

5. Tap the type of parking asset that you want to add. 

6. Swipe up to view the form, and then complete the survey with as much information as 
possible, tapping to expand sections as necessary. 

7. Swipe down and tap Add Point. 

8. At the upper right, tap the check mark or Submit to submit the survey. 

9. Repeat these steps for each parking asset. 

 

Develop parking inventory 
The Parking Inventory app can be used by public works or planning department personnel to 

inventory public parking and pay stations. Existing parking assets collected in the field can be 

reviewed and information added to help drivers or the public find parking alternatives. New 
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parking assets can also be added to a parking inventory using imagery and record 

documents. 

You will assume the role of a parking supervisor in a public works or planning department. In 

this workflow, you are asked to review parking assets collected by field staff and add new 

parking assets available in record drawings. The steps below provide guidance; however, you 

can enter information as you see fit and examine the different dependencies in the form. 

Review assets collected in the field 
To review assets that were collected in the field, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Public Parking 
solution. 

2. View the Parking Inventory app. 

3. At the upper right, click the Filter button to open the widget. 

4. In the widget, in the Public Parking section, click the Visible to Public drop-down arrow 
and choose No, and then turn the Public Parking filter on. 

5. On the map, click a parking asset to open its pop-up. 

Tip: 

If you do not see any assets, return to and complete the Collect parking assets in the 
field workflow. 

6. In the pop-up, at the lower right, click the more options button  and choose Smart 
Editor. 

  The Add Parking Assets widget opens on the right, showing the form that was collected 
in the field for this parking asset. 

7. Update or complete the information in the form. 

Tip: 

This solution uses the Operating Hours Specification and relies on a series of data 
standards (for example, Mo-Fr (7:00-19:00)) to render the operating hours correctly. 
For more information, see Populate operational hours. 

8. For Visible to the public, choose Yes. 

9. Scroll to the bottom of the form and click Save. 

10. Click Close. 

11. Repeat these steps for each parking asset. 

 

Add a new parking asset 
1. In the Parking Inventory app, click the Add Parking Assets button to open the widget, if 

necessary, and then select the type of parking asset that you want to add. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://doc.arcgis.com/en/arcgis-solutions/11.0/reference/configure-public-parking.htm#ESRI_SECTION1_FD59EE89253742D6BEB99F384CB47699


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 649 

2. On the map, click the location of the asset. 

3. Complete the form with as much information as possible. 

4. Scroll to the bottom of the form and click Save. 

5. Click Close. 

6. Repeat these steps for each parking asset. 

 

Locate parking alternatives 
Communicating parking information helps drivers locate desirable spaces and reduces 

congestion in a downtown or neighborhood. The Public Parking site and Parking Locator app 

can be used to communicate public parking alternatives and find a parking space. 

 

Find a parking space 
You will assume the role of a resident or member of the public. In this workflow, you are 

interested in locating a parking space near a given location in a downtown or neighborhood. 

1. In a browser, from the Public Parking solution, view the Public Parking site. 

2. Scroll to the Find Parking Space section, and then click the Locate Parking button. 

  The Parking Locator opens, showing parking alternatives in the area. 

3. On the left, in the Parking Locator panel, search for an address.  

  You see suggestions as you type. 

4. Press Enter or choose an address from the list. 

  In the Parking Locator panel, nearby parking alternatives are listed. 

Tip: 

If your search returned no results, adjust the slider to increase the search distance. 

5. In the Parking Locator panel or on the map, click a parking alternative and review the 
additional details. 

 

Share parking experience 
Understanding public perception with parking alternatives helps shape parking studies and 

plans to deliver affordable and well-located parking. The Parking Satisfaction Survey form is 

used by the public to share their experience with parking resources in a community. 

1. In a browser, from the Public Parking solution, view the Public Parking site. 

2. Scroll to the Parking Satisfaction section. 

3. Click Share Your Experience. 

4. Complete the survey, and then click Submit. 
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Recreation Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Recreation Outreach 
Recreation Outreach can be used to increase participation in outdoor activities and 

understand recreation license trends. 

For decades there has been a decline in the number of people that are interested in outdoor 

recreation, prompting the need to understand recreation license trends more deeply and 

maximize the use of recreation resources. Understanding who has purchased recreation 

licenses or permits helps organizations target marketing activities and increase retention 

rates. Providing 24/7 access to recreation opportunities allows you to reach new outdoor 

license and permit buyers and increase the use of outdoor resources in your community. 

Recreation Outreach is typically implemented by fish and wildlife agencies, parks 

departments, and other recreation agencies that want to take a data-driven approach to 

increasing public participation in outdoor recreation. 

The Recreation Outreach solution delivers a set of capabilities that help you understand 

recreation license trends, engage the public about their recreation experiences, and promote 

recreation opportunities to the public. 

 

Requirements 
Recreation Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.6 or later (Basic, Standard, Advanced) 

• ArcGIS Survey123 
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Information products 
Recreation Outreach includes the following information products: 

Item Description Minimum user 
type 

Outdoor 
Recreation 

An ArcGIS Hub site used by the general public to 
discover outdoor recreation opportunities 

Not required 

Angler Catch 
Survey 

An ArcGIS Survey123 form used by anglers to 
provide feedback related to their fishing experience 

Not required 

Boating 
Experience 
Survey 

An ArcGIS Survey123 form used by boaters to 
provide feedback related to their boating experience 

Not required 

Hunting Harvest 
Survey 

An ArcGIS Survey123 form used by hunters to 
provide feedback related to their hunting experience 

Not required 

Trail Experience 
Survey 

An ArcGIS Survey123 form used by trail users to 
provide feedback related to their trail experience 

Not required 

Recreation 
License 
Dashboard 

An ArcGIS Dashboards app used by Fish and Wildlife 
Coordinators to determine which communities to 
target for Reactivation, Retention, and Recruitment 
(R3) campaigns 

Viewer 

Recreation 
License 
Management 

An ArcGIS Pro project package used to manage and 
analyze license data 

GIS 
Professional 
Basic 

Park Locator A Nearby app used by the general public to locate a 
park or recreation facility and obtain information about 
recreation activities in the area 

Not required 

Recreation 
License Locator 

A Nearby app used by anglers, boaters, and hunters 
to locate license or permit retailers and obtain 
information about rules and regulations 

Not required 

Water Resource 
Locator 

A Nearby app used by anglers and boaters to locate 
water access sites and obtain information about 
amenities at the access site 

Not required 

Wildlife Resource 
Locator 

A Nearby app used by the general public to locate 
wildlife conservation or recreation areas and obtain 
information about area amenities 

Not required 

Trail Locator A Nearby app used by the general public to locate a 
trail and obtain information about trail activities in the 
region 

Not required 

Recreation 
Inventory 

A Sidebar app used by used by mapping technicians 
to create, edit, and review recreation assets. 

Editor 

Recreation 
Closure Manager 

An ArcGIS Web AppBuilder app used by public 
information staff to create and update recreation 
closures. 

Editor 
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Release notes 
The following are the release notes: 

Version Description 

2.0 • New recreation locator apps using the Nearby Instant app for a better mobile 
experience. 

• A new Recreation Inventory app for park and trail data management. 

• A new Trails page on the Outdoor Recreation Hub site that can be used to 
share trail information. 

• A new Trail Experience Survey to collect trail use information. 

1.2 • A new version of the Recreation License Management ArcGIS Pro project that 
resolves an issue with the Standardize Licenses tool to work with domains. 

1.1 • Updated the Recreation License Management ArcGIS Pro project to reference 
correct layers. 

1.0 • First release of Recreation Outreach 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 653 

Configure Recreation Outreach 
Learn how to configure the Recreation Outreach solution to meet specific needs in your 

organization. 

 

Load data 
Recreation Outreach can be used to increase participation in outdoor activities and 

understand recreation license trends. In some cases, you may already have this information in 

ArcGIS or another business system. 

The Recreation Outreach solution includes five locator apps to share outdoor resources with 

the public: the Water Resource Locator, the Wildlife Resource Locator, the Trail Locator, the 

Park Locator, and the Recreation License Locator. Each of these locator apps has a 

corresponding feature layer that needs to be populated with data for the apps to function. 

Review the layers provided with the solution and determine what source data you want to 

load. Then, load your existing data into the layers provided with the solution before sharing the 

maps or apps. 

Once you have determined what source data must be loaded, complete one or more of the 

data loading workflows below. 

 

Load data from a shapefile 
Load data for LicenseLocations, ParkRecreationFacilities, Trails, WildlifeResources, and 

WaterResources from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you want to populate. 

3. On the feature layer item details page, click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Browse to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you want to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 
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Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 

 

Modify satisfaction surveys 
The Recreation Outreach solution includes focused surveys to gauge public opinion and 

gather feedback on outdoor recreation use. These surveys require slight modification to 

localize them for your use. 

To update the list of locations in each survey, complete the following steps: 

1. Download and install Survey123 Connect. 

2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click any of the surveys to download the individual survey forms. 

4. Click the survey again to open it. 

5. In the left panel, click the XLSForm button. 

A Microsoft Excel spreadsheet opens. 

6. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all the 
selectable options for survey questions. 

7. In the choice list, find the placeholder choices (Choice 1, Choice 2, and so on) and 
replace them with your own values. 

8. Click Save to save the Microsoft Excel spreadsheet and preview your changes on the 
Form Preview tab of Survey123 Connect. 

9. In Survey123 Connect, click Publish in the left panel to publish your changes. 

 

Create native apps 
The Recreation Outreach solution enables organizations to optionally configure native app 

experiences for the recreation locators, use the guide below and complete the following steps: 

1. Download ArcGIS Appstudio. 

2. Use the Nearby template for one or more recreation locators. 

3. Publish your native app. 

4. Update the download app buttons on the Outdoor Recreation site to reference your 
published apps. 

 

Configure Outdoor Recreation site 
The Recreation Outreach solution requires small modifications to localize it for your use. The 

following sections describe how to configure Recreation Outreach for your organization. 
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Update organizational information 
The Recreation Outreach solution includes an Outdoor Recreation site to share information 

about outdoor recreation with the public. This app requires slight modification to be localized 

for your use. 

1. Sign in to your ArcGIS Online organization and browse to the Outdoor Recreation site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. On the main Outdoor Recreation page, update the following: 

a. Under the Buy License Online section, hover over the card and click the edit pencil  
to update the Learn more link to your online licensing portal. 

b. Under the Buy License Online section, hover over the card and click the edit pencil to 
update the Learn more link to your online licensing portal. 

c. Under the Make a Reservation section, hover over the card and click the edit pencil to 
update the Learn more link to your online reservation portal. 

d. To modify the footer on the Outdoor Recreation site, on the side panel, click 

Customize Toggle . 

5. Click Footer. A custom footer is already provided, and in most cases needs to be 
updated with just your organization's branding, contact information, and social media 
references. Click the HTML text box, make the necessary changes, and click Apply. 

6. Click Settings and expand Interactions. Make sure the Embedded Apps setting is 
toggled off. 

7. Click Save. 

8. On the Fishing page, update the following: 

a. Under the Fishing Rules and Regulations section, hover over the card and click the 

edit pencil  to update the Learn more link to your regulation website. 

b. Under the Buy License Online section, hover over the card and click the edit pencil to 
update the Learn more link to your online licensing portal. 

c. Under the Frequently Asked Questions section, hover over the card and click the edit 
pencil, and update the questions and answers. 

9. Click Save. 

10. On the Hunting page, update the following: 

a. Under the Learn to Hunt and Hunting Rules and Regulations sections, hover over the 
card and click the edit pencil to update the Learn more link to your learning and 
regulations websites. 

b. Under the Buy License Online section, hover over the card and click the edit pencil to 
update the Learn more link to your online licensing portal. 
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c. Under the Frequently Asked Questions section, hover over the card and click the edit 
pencil, and update the questions and answers. 

11. Click Save. 

12. On the Boating page, update the following: 

a. Under the Boating Education and Boating Rules and Regulations sections, hover over 
the card and click the edit pencil to update the Learn more link to your learning and 
regulations websites. 

b. Under the Frequently Asked Questions section, hover over the card and click the edit 
pencil, and update the questions and answers. 

13. Click Save. 

14. On the Trails page, update the following: 

a. Under the Trails Rules and Regulations section, hover over the card and click the edit 
pencil to update the Learn more link to your regulation website. 

b.  Under the Buy Permit Online section, hover over the card and click the edit pencil to 
update the Learn more link to your online permitting portal. 

c.  Under the Featured Trails section, hover over the gallery cards and click the edit 
pencil to manually select Featured Trails apps. 

d.  Under the Frequently Asked Questions section, hover over the card and click the edit 
pencil, and update the questions and answers. 

15. Click Save. 

 

Create feature trails apps 
The Recreation Outreach solution enables organizations to showcase feature trails, use the 

guide below and complete the following steps: 

1. Open the Trail Locator and find the Trail you would like to feature. 

2. Click the Copy Link button. 

3. Navigate to your ArcGIS Online Content. 

4. Click the New Item button and select Application, choose Web Mapping.  

5. Paste the URL from Copy Link in the space for URL. Click Next. 

6. Add a Title, select a folder, assign Categories, add Tags and a Summary. Click Save. 

7. Repeat steps 1-7 for each trail you would like to feature. 

8. On the Trails page, navigate to the Feature Trails gallery section. 

9. Click the Settings on the Featured Trails gallery. 

10. In the Settings panel, select Manual. 

11. Click the Select Content and find and select the featured trail applications built in steps 
1-7. 

12. Click the Save option, then the dropdown and select Publish Draft. 
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Share items with public 
Several layer views, maps and apps included in the Recreation Outreach solution must be 

shared with everyone so they can be accessed by the public on the Outdoor Recreation site. 

To share your Outdoor Recreation items with everyone, use the guide below and complete the 

following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Recreation 
Outreach folder. 

2. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) AnglerCatchSurvey_public 

Feature Layer (hosted, view) BoatingExperienceSurvey_public 

Feature Layer (hosted, view) HuntingHarvestSurvey_public 

Feature Layer (hosted, view) LicenseLocations_public 

Feature Layer (hosted, view) ParkRecreationFacilities_public 

Feature Layer (hosted, view) ParkAssets_trails 

Feature Layer (hosted, view) WaterResources_public 

Feature Layer (hosted, view) WildlifeResourceAreas_public 

Feature Layer (hosted, view) WildlifeResourceLocations_public 

Feature Layer (hosted, view) TrailExperienceSurvey_public 

Web Map Park Locator 

Web Map Recreation License Locator 

Web Map Trail Locator 

Web Map Water Resource Locator 

Web Map Wildlife Resource Locator 

Web Mapping Application Park Locator 

Web Mapping Application Recreation License Locator 

Web Mapping Application Trail Locator 

Web Mapping Application Water Resource Locator 

Web Mapping Application Wildlife Resource Locator 

Form Angler Catch Survey 

Form Boating Experience Survey 

Form Hunting Harvest Survey 

Form Trail Experience Survey 

Hub Site Application Outdoor Recreation 

Hub Initiative Outdoor Recreation 
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Hub Page Boating 

Hub Page Fishing 

Hub Page Hunting 

Hub Page Trails 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

6. Click OK and click Save. 
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Use Recreation Outreach 
The Recreation Outreach solution delivers a set of capabilities that help you understand 

recreation license trends, engage the public about their recreation experiences, and promote 

recreation opportunities to the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Explore outdoor destinations 
Recreation Outreach contains multiple locator apps for the general public to find recreation 

opportunities and license information. Members of the public can search for an address or 

click the corresponding map to find information about parks, trails, water resources, wildlife 

resources, or recreation license locations. 

You are a member of the public and want to learn what recreation opportunities are in your 

area. You will use the locator apps in the Recreation Outreach solution to find outdoor 

destinations. 

 

Find park opportunities 
1. Browse to the Outdoor Recreation site. 

2. Find the Park Locator card and click the Explore button to launch the Park Locator. 

3. Enter your address in the search box or pan and zoom to an area of the map you are 
interested in. 

4. Click the Filter button and select characteristics to limit results based on your selected 
criteria. 

5. Select the location of interest from the list and review information provided. 

6. Click on the Directions tab to view driving directions to the recreation opportunity from 
your defined location. 

 

Find trail opportunities 
1. Browse to the Outdoor Recreation site. 

2. Find the Trail Locator card and click the Explore button to launch the Trail Locator. 

3. Enter your address in the search box or pan and zoom to an area of the map you are 
interested in. 

4. Click the Filter button and select characteristics to limit results based on your selected 
criteria. 

5. Select the location of interest from the list and review information provided. 

6. Click on the Directions tab to view driving directions to the recreation opportunity from 
your defined location. 
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Find fishing and boating opportunities 
1. Browse to the Outdoor Recreation site. 

2. Find the Water Resource Locator card and click the Explore button to launch the Water 
Resource Locator . 

3. Enter your address in the search box or pan and zoom to an area of the map you are 
interested in. 

4. Click the Filter button and select characteristics to limit results based on your selected 
criteria. 

5. Select the location of interest from the list and review information provided. 

6. Click on the Directions tab to view driving directions to the recreation opportunity from 
your defined location. 

 

Find hunting opportunities 
1. Browse to the Outdoor Recreation site. 

2. Find the Wildlife Resource Locator card and click the Explore button to launch the 
Wildlife Resource Locator . 

3. Enter your address in the search box or pan and zoom to an area of the map you are 
interested in. 

4. Click the Filter button and select characteristics to limit results based on your selected 
criteria. 

5. Select the location of interest from the list and review information provided. 

6. Click on the Directions tab to view driving directions to the recreation opportunity from 
your defined location. 

 

Develop recreation inventory 
The Recreation Inventory app can be used by recreation staff to create and update recreation 

information shared with the public. Existing recreation assets collected in the field can be 

reviewed and information added to help internal staff and the general public find information 

about recreation opportunities. New recreation assets can also be added to a recreation 

inventory using imagery and record documents. 

You will assume the role of recreation staff in a local government department. In this workflow, 

you are asked to review recreation assets and add new recreation assets. The steps below 

provide guidance; however, you can enter information as you see fit and examine the different 

dependencies in the form. 

 

Review recreation assets 
1.  Sign in to your ArcGIS organization and browse to the Recreation Inventory app. 
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2. Open the item page and click View Application. 

3. Open the Edit panel and click Edit feature. 

4. Select a trailhead on the map. 

5. In the panel, review the attribute information and enter the remaining details for the 
trailhead. 

6. Set Status to Open, Publicly Visible to Yes, and Reviewed to Yes. 

7. When you're finished, click Update. 

 

Add a new recreation asset 
1. In the Recreation Inventory app, open the Edit panel, and click Add feature. 

2. Type Trails into the Filter types search box, and click the Trails feature template. 

3. Add a new trail to the map. 

4. Enter the following trail details: 

Parameter Value 

Asset ID Type T1-0004. 

Name Type McDowell Grove Trail. 

Park Name Type McDowell Park. 

Trail System Type McDowell Park. 

Status Choose Open. 

Reviewed Choose Yes. 

Seasonal Choose No. 

Hiking Choose Yes. 

Mountain Biking Choose Yes. 

eBikes Choose No. 

Dogs Allowed Choose Yes. 

Surface Type Choose Native. 

Publicly Visible Choose Yes. 

Install Date Choose today's date. 

Owned By Choose Our Agency. 

Managed By Choose Our Agency. 

5. Scroll to the bottom of the form and click Add. 

6. Repeat all of the steps for each recreation asset. 
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Update recreation closure information 
Communicating the status of recreation opportunities helps visitors plan trips and reduces 

congestion and overuse of resources. The Recreation Closure Manager app can be used by 

public information staff to create and update recreation closures. 

 

Create recreation closure 
1. Sign in to your ArcGIS organization and browse to the Recreation Closure Manager app. 

2. Open the item page and click View Application. 

The Manage Recreation Closures widget is opened by default, which allows you to 
create and edit existing recreation closures. 

3. In the Search widget, type an address. 

4. In the Manage Recreation Closures widget, click the Closures template and add a new 
recreation closure to the map. 

5. Enter the following recreation closure details: 

Parameter Value 

Name Type Trail Maintenance. 

Type Choose Temporary Closure. 

Reason Choose Maintenance. 

When Type Winter 2021 to Spring 2022. 

Comment Type Trail closed Winter 2021 to Spring 2022. 

6. Click Save. 

 

Update asset status 
1. Open the Update Public Status widget. 

2. Select the Freehand Polygon selection tool, and select the assets associated with the 
recreation closure. 

3. For Status, choose Closed. 

4. Click Save. 

Note: 

When you create recreation closures and update asset status information using the 
Recreation Closure Manager app, the recreation locators deployed with the Recreation 
Outreach solution will automatically be updated with the new information. 
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Review and prepare recreation license data 
Staff can use the Recreation License Management ArcGIS Pro project and Recreation 

License Management Dashboard to organize, load, and review recreation license data. This 

allows staff to review this information spatially, which can provide an enhanced view and 

understanding of license trends. 

You are a data analyst at a conservation agency responsible for analyzing trends in recreation 

license data. You are asked to use the Recreation License Management ArcGIS Pro project to 

prepare your data to share in the Recreation License Dashboard. 

1. Start ArcGIS Pro and open the Recreation License Management project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand Tasks, and double-click the Recreation License 
Management task. 

4. In the Tasks pane, click the Getting Started task group to expand the collection of tasks. 

5. Click the Understanding Recreation License Management task to review the project. 

6. Follow the tasks provided in the Prepare License Data task group to format recreation 
license data. 

7. Follow the tasks provided in the Calculate License Information task group to 
summarize and load recreation license data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 664 

Road Closures 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Road Closures 
Road Closures can be used to maintain an inventory of road closures and communicate 

closures and detours to travelers. 

Public works and public safety departments close roads for construction activities, special 

events, and public safety incidents, often creating detours for drivers. Proactively managing 

and communicating closure and detour information helps residents and drivers navigate an 

altered road landscape and avoid unnecessary congestion. Road Closures is typically 

implemented by public works and public safety agencies that want to have a single catalog of 

roads impacted by construction activities, events, and incidents and share this information 

with the public. 

The Road Closures solution delivers a set of capabilities that help you inventory road closures 

and related detours, communicate closures and detours with the public, and share 

authoritative closure information with consumer applications, such as Waze. 

 

Requirements 
Road Closures requires the following: 

• ArcGIS Enterprise 

 

Information products 
Road Closures includes the following information products: 

Item Description Minimum 
user type 

Road 
Closures 

An ArcGIS Web AppBuilder app used by public works and 
public safety staff to maintain an inventory of road closures and 
communicate closures, blocks, and detours to travelers 

Editor 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Road Closures 
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Configure Road Closures 
Learn how to configure the Road Closures solution to meet specific needs in your 

organization. 

 

Create a public road closure map 
Focused road closure maps and information can be embedded in your website so they can be 

accessed by the general public. Maps can be focused on public safety incidents or specific 

events occurring in a community, or they can be more general road closure maps used during 

road construction season. 

To create a public road closure map, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Create a map that can be used by the general public to view road closures by doing the 
following: 

a. Choose a basemap. 

b. Add the RoadClosures_public layer to the map and remove RoadClosures_public from 
the layer names. 

c. Save the map as Public Road Closures. 

3. Share the map with your organization and everyone. 

4. Embed the Public Road Closures map in your public works website. 

 

Share with Waze 
Sharing your road closure information allows consumer navigation and traffic companies, such 

as Waze, to leverage the information in apps used daily by the general public. Sharing up-to-

date information with these apps helps minimize the impact of road closures, ease congestion, 

and enhance driver safety in your community. The road closures layer complies with the 

Common Internet File Structure (CIFS) for road closures but must be configured, as shown 

below, to capture required information. 

 

Share road closure information 
To share your road closure information with Waze, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. When assigning a Creative Commons License to your RoadClosures layer, choose the 
following options: 

• For Allow adaptations of your work to be shared, choose Yes. 

• For Allow commercial uses of your work, choose Yes. 
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3. In the Have a web page area, copy the HTML that is generated by the Creative 
Commons site. 

4. In your ArcGIS organization, browse to your RoadClosures_public layer. 

5. Open the item details page. 

6. Click Edit to edit the item details. 

7. Scroll to the Terms of Use section and click Edit. 

8. Click View HTML Source. 

9. Paste the HTML copied from the Creative Commons site into the Terms of Use text box. 

10. Click Save. 

Note: 

You must use a license that allows international commercial use and allows shared 
adaptations or a license placing your data in the public domain. 

11. Enroll in the Waze for Cities program. 

  When you share your road closure information with Waze for Cities, new road closures 
added by your community in ArcGIS will be added to Waze every minute. 

 

Add your organization reference 
To share your road closures with Waze, you must store your organization reference with every 

road closure. This field is used by Waze to identify which organization the road closure data is 

coming from. The reference name must be a maximum of either 10 capital letters or 12 

lowercase letters. The reference is your Waze for Cities program ID. 

To add your organization reference, complete the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Road 
Closures map. 

2. Open the item page and click Open in Map Viewer Classic. 

3. Click Edit. 

4. Click Manage. 

5. Click the Layer drop-down arrow and choose the Road Closures layer. 

6. Click the drop-down arrow next to the Both Directions feature template and choose 
Properties. 

7. In the Properties window, scroll to Organization and enter your organization reference. 

8. Click Done. 

9. Repeat steps 6 through 7 for the One Direction feature template layer properties. 

10. Click Save Changes. 
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Set required fields 
To share your road closures with Waze, some information is required. You must change the 

fields indicated below as required so all road closures that are created capture the information 

needed by Waze. 

To set fields transmitted to consumer apps as required, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Road 
Closures app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab and click Set the widget in this controller to open the page for an 
in-panel widget. 

4. Hover over the Create New Closure widget and click the Configure this widget button 

 to open the widget configuration window. 

5. Click the Smart Actions tab. 

6. Click Add New. 

7. In the Group Name text box, type Required Fields. 

8. Click the Layer for Expression drop-down arrow and choose Road Closures. 

9. Click the Edit Expression button. 

10. Click Add expression and set the expression to OBJECTID is not blank. 

11. Click OK. 

12. Expand the Road Closure layer and check the check box for following fields as required: 

• Street Name 

• Reason 

• Description 

• Direction 

• Start Time 

• End Time 

13. Click OK twice. 

14. Save the app. 

 

Configure the Road Closures layer to share with Waze 
One of the partners that your community can share data with is Waze through the Waze for 

Cities program. To share your data with Waze, follow the steps found in the Waze partners 

Overview page. To share your feed, you must create a JSON request from the Public Road 

Closures feature layer. 

To create the request URL required by Waze, follow the steps below: 
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1. Verify that you are signed in to your ArcGIS organization and browse to the 
RoadClosures_public item. 

2. Open the item page and click the Road Closures layer under Layers. 

3. From the layer URL, click Copy. 

4. Paste the URL into a text editor. 

5. Copy the code below and paste it into the text editor at the end of the URL you pasted in 
the previous step. 

/query?where=1%3D1&outFields=OBJECTID,street,subtype,description,direct
ion,starttime,endtime,type,reference&outSR=4326&returnZ=false&f=geojson 

Tip: 

For more information on querying a feature layer, see Query a feature layer. 

6.  Provide the URL to Waze. 
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Use Road Closures 
The Road Closures solution delivers a set of capabilities that help you inventory road closures 

and related detours, communicate closures and detours with the public, and share 

authoritative closure information with consumer applications, such as Waze. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Create road closures 
You will assume the role of an employee in the public works department. You have received 

plans for streets that will need to be closed. You will draw the closures on the map, place the 

road blocks, and identify the detour routes. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Road Closures 
solution. 

2. View the Road Closures app. 

The Road Closures app opens with the Create New Closure widget open on the right. 

3. In the Create New Closure widget, check the Use Preset Values (new features only) 
check box. 

4. Type the contact information for the closure in the appropriate text boxes. 

5. In the Identifier text box, type a unique ID. 

Note: 

This information will be added to each closure, road block, and detour you create to 
associate it with the same event. 

6. On the map, use the search field or pan and zoom to the closure location. 

7. In the widget, click the Both Directions template. 

8. Click the map and begin to draw a line at an intersection; click to add a vertex and 
double-click to finish the closure line. 

After you finish drawing the closure on the map, a Road Closures form appears on the 
right. 

9. Complete the form with as much information as possible. 

10. Click Save. 

11. Click the Road Blocks template. 

12. On the map, click the intersection on one side of the closure. 
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Note: 

The road block is automatically populated with the information from the closure it 
intersects, so you don’t have to reenter it. 

13. Click Save. 

14. Click the Road Detours template. 

15. On the map, sketch the alternate route around the closure and double-click to finish 
drawing the line. 

Note: 

If the detour intersects the closure at the start and end, it automatically pulls the details 
from the closure. 

16. Click Save. 

 

Update closure details 
You will continue as an employee in the public works department. Dates for a road closure 

have been extended. You will update the end date of the closure and its associated road 

blocks and detour. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Road Closures 
solution. 

2. View the Road Closures app. 

3. In the upper right of the app, click the Update Existing Closures button to open the 
widget. 

4. In the Update Existing Closures widget, click the Extent tool. 

5. On the map, drag a box around the road closure, including the associated road blocks 
and detour. 

6. In the Update Existing Closures pop-up, click the End Time drop-down arrow and 
choose a new date. 

7. Click Save. 

Closures that are no longer active, with an end date that is before today, will continue to 
show on the map but will have a transparency applied. This feature is helpful when you 
have reoccurring events; for example, past closures can be selected and updated with 
new dates. 
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Road Network Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Road Network Data Management 
Road Network Data Management can be used to maintain an authoritative inventory of roads, 

intersections, and physical road characteristics and track legal agreements executed with a 

public works agency. 

It provides a series of workflows and standard road layers that streamline the maintenance of 

a public road repository, their physical characteristics, and legal agreements defining 

maintenance services provided by the organization. Road Network Data Management is 

typically implemented by public works and transportation departments that want to develop 

and maintain a public road repository that supports a variety of maintenance functions. 

The Road Network Data Management solution delivers a set of capabilities that help you 

maintain a standard set of public road layers, streamline road data management workflows, 

track maintenance agreements, and continuously improve the quality of public road 

information. 

 

Requirements 
Road Network Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Standard or Advanced) 
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Information products 
Road Network Data Management includes the following information products: 

Item Description Minimum user 
type 

Road Network 
Data Management 

An ArcGIS Pro project used by mapping technicians 
to maintain an authoritative inventory of public 
roads, road intersections, and physical road 
characteristics 

GIS 
Professional 
Standard 

Road 
Maintenance 
Agreements 

An ArcGIS Web AppBuilder app used by engineers 
and operations staff to track legal agreements 
executed with a public works agency 

Editor 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Road Network Data Management 
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Use Road Network Data Management 
The Road Network Data Management solution delivers a set of capabilities that help you 

maintain a standard set of public road layers, streamline road data management workflows, 

track maintenance agreements, and continuously improve the quality of public road 

information. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage road network data 
You will start by assuming the role of a mapping technician responsible for maintaining an 

inventory of public roads, road intersections, and physical road characteristics. The Road 

Network Data Management ArcGIS Pro project includes a series of tasks to help guide you 

through these workflows. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Road Network 
Data Management solution. 

2. Download the Road Network Data Management desktop application template, and then 
unzip the folder. 

3.  From the unzipped folder, open the Road Network Data Management ArcGIS Pro 
project in ArcGIS Pro. 

4. In the Catalog pane, expand the Tasks folder, and then double-click the Road Network 
Data Management task item. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to use Road Network Data Management task 
group to see the collection of tasks. 

 

Add roads 
Roads are line segments representing centerlines of all public roadways or carriageways that 

support asset management and mapping. Typically, this information is compiled from 

authoritative road centerlines maintained for addressing purposes. 

1. To add new public roads, follow the steps in the Add roads task. 
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Add intersections 
When creating new roads, existing roads are split at intersections along the new road. An 

inventory of road intersections with the names of relevant crossroads is often required by 911 

systems and to manage right-of-way assets. 

1. To add new road intersections, follow the steps in the Add intersections task. 

 

Add road characteristics 
A series of map layers is used to track the characteristics (for example, ownership, functional 

classification, speed limit, physical characteristics, and special routes) of each public road. 

The feature classification and type schema for the roads is based on a functional classification 

of roads provided by the Federal Highway Administration (FHWA). Specific attributes and 

default values vary for each feature type. 

1. To add new road characteristics, follow the steps in the Add road characteristics task. 

 

Track maintenance agreements 
You will now assume the role of an engineer or operations staff at a public works agency. You 

are responsible for managing the legal agreements defining maintenance services provided 

by the agency for assets within the public right-of-way. 

1. In a browser, from the Road Network Data Management solution, view the Road 
Maintenance Agreements app. 

  The app opens with the Create Maintenance Agreement open on the right. 

2. In the Create Maintenance Agreement widget, choose a template. 

3. Click the map to start a sketch. 

4. Click the map to add additional vertices and double-click to finish the sketch. 

  After you finish the sketch, the Road Maintenance Agreements legal agreement form 
opens in the Create Maintenance Agreement widget. 

5. Complete the details of the legal agreement. 

6. Click Save. 

7. At the top right, click the Filter Maintenance Agreement button to open the widget.  

8. Filter for the asset type that you just added. 

9. On the map, select an agreement to view its details. 
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School Locator 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to School Locator 
School Locator can be used to inventory educational facilities and relevant districts, 

communicate neighborhood schools, and promote educational resources available in a 

community. 

When people search for a home, one important factor is always the school district. Even if the 

buyer doesn't have children, school districts have an impact on home value and living area. 

When other factors are constant, a good school district tends to equal a good neighborhood, 

or location. And a good location can mean safer neighborhoods and amenities like public 

parks and services. Increasing access to school attendance zones and other educational 

resources makes it easier for home buyers to invest in your community.School Locator is 

typically implemented by local governments, or school districts, that want to promote high-

quality educational resources available in a community. 

The School Locator solution delivers a set of capabilities that help you inventory educational 

facilities and relevant districts, communicate neighborhood schools, and promote educational 

resources available in a community. 

 

Requirements 
School Locator requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.8 or later (Basic, Standard, or Advanced) 
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Information products 
School Locator includes the following information products: 

Item Description Minimum user 
type 

School Locator A Nearby app used by the general public to locate 
and explore all elementary and secondary schools 
within a district 

Not required 

My Neighborhood 
School 

A Nearby app used by the general public to find 
schools within an attendance zone boundary 

Not required 

School Data 
Management 

An ArcGIS Pro project used to maintain attendance 
zone boundaries, schools, and bus stop locations 

GIS 
Professional 
Basic 

Find Your School An ArcGIS Hub site used by the general public to 
locate your neighborhood school and explore all 
schools in our district 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • A new ArcGIS Hub site used by the general public to locate your 
neighborhood school and explore all schools in our district. 

• A new Nearby app used by the general public to locate and explore all 
elementary and secondary schools within a district. 

• A new Nearby app used by the general public to find schools within an 
attendance zone boundary. 

• A new ArcGIS Pro project used to maintain attendance zone boundaries, 
schools, and bus stop locations. 

1.0 • First release of School Locator 
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Configure School Locator 
School Locator can be used to inventory educational facilities and relevant districts, 

communicate neighborhood schools, and promote educational resources available in a 

community. 

In this topic, you'll learn how to configure the School Locator solution to meet specific needs in 

your organization. 

 

Load data 
The School Data Management ArcGIS Pro project includes a series of tasks that can be used 

to load your existing school data, and manage key characteristics, in the layers provided with 

the solution. 

1. Sign in to your ArcGIS organization and browse to the School Data Management 
Desktop Application Template. 

2. From the item page, click Download. 

3. Unzip and open the School Data Management project. 

4. On the View tab, in the Window group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the School Data 
Management task. 

6. In the Tasks pane, click the Getting Started task group to expand the collection of tasks. 

School Data Management is used to load and create foundational school data used in the 

School Locator solution such as My Neighborhood School and School Locator apps. The 

solution uses three foundational datasets: 

• Schools 

• Bus Stops 

• Attendance Zones 

Schools contains locations of educational facilities (elementary and secondary schools). 

Bus Stops contains the locations of bus stops. A unique ID is used to relate to schools. 

Attendance Zones contains geographies that define where students will attend elementary 

and secondary schools. A unique ID is used to relate to schools. 

Before proceeding to subsequent tasks, follow the instructions in the Add school geography 

layer task to add the Schools feature layer deployed with the solution. 

 

Load existing school data 
Your school district may have existing schools, bus stops, and attendance zone data, which 

can be loaded into the Schools feature layer. 
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Schools use a standard for operational days and hours in the School Locator app included 

with the School Locator solution. To load existing school location data, designate the type, 

assign school ID, format the operation days and hours, and edit attributes follow the 

instructions in the Schools task. 

The attendance zones relationship with a schools is defined by populating the School ID field. 

Establishing this relationship allows the My Neighborhood School app and the School Locator 

solution to display the appropriate school attendance zone when a user searches by address 

or defines a location on the map. Follow the instructions in the Attendance zones task to load 

existing data, designate the type, and establish the relationship. 

The bus stops relationship with a schools is defined by populating the School ID field. Follow 

the instructions in the Bus stop task to load existing data, establish the relationship, format 

the operation days and hours, and edit attributes. 

 

Create new school data 
You may need to create new school data if existing data is not available. Follow the 

instructions in the Create new school data task group to create new schools, attendance 

zones, or bus stops. 

Note: 

Map layers must be visible to create new data. 

 

Configure Find Your School site 
The School Locator solution includes the Find Your School ArcGIS Hub site that your 

organization can configure with your branding and use to share school information with the 

public. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Find Your 
School site. 

2. From the item page, click Configure. 

3. If necessary, click the Edit button  to open the site editor. 

4. Scroll to the Frequently Asked Questions section, hover over the card, click the edit 
pencil, and update the questions and answers. 

5.  In the side panel, click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

6. Click the HTML box. 

The HTML window appears. 

7. Make the necessary changes and click Apply. 
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8. Click Save. 

 

Share items with public 
Several layer views, maps and apps included in the School Locator solution must be shared 

with everyone so they can be accessed by the public on the Find Your School site. To share 

your school locator items with everyone, use the guide below and complete the following 

steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the School 
Locator folder. 

2. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) Schools_public 

Feature Layer (hosted, view) Schools_zones 

Feature Layer (hosted, view) Schools_stops 

Web Map My Neighborhood School 

Web Map School Locator 

Web Mapping Application My Neighborhood School 

Web Mapping Application School Locator 

Site Application Find Your School 

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

 

Configure directions 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

The School Locator app can be used by the general public to locate elementary and 

secondary school alternatives. Directions to the nearest school can be enabled so users can 

quickly find the school they are looking for. 

Follow the steps below to enable directions. 

1. Verify that you are signed in to your ArcGIS organization and browse to the School 
Locator app. 
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2. From the item page, click Configure App. 

Close the Welcome to the App Setup Page splash page, if necessary. 

3. Click Nearby > Options and turn on the Show directions toggle button. 

4. Check the check box next to the Schools layer. 

5. Click Publish. 

6. Click Confirm. 

The Authorize premium content window appears with information related to 
authorization. 

7. Click Authorize. 

8. Click Launch. 

 

Populate operational hours 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

This solution leverages the Opening Hours Specification to display operating hours for a place 

or service. When you populate the data fully, Arcade expressions interpret the data and 

display the operating hours in a human-readable format in the map pop-up. Understanding the 

data specification and options in the Arcade expressions will help you populate your data and 

display it in the maps and apps provided with the ArcGIS Solution. 

 

Operating Hours specification 
The Operating Hours Specification allows you to store a combination of operating hours in a 

single field but relies on a series of data standards to render the information correctly. To 

ensure operating hours are displayed correctly, follow the standards below: 

• Enter all times using a 24-hour clock without a leading 0—for example, Tu (7:00-19:00). 

• Use a two-letter abbreviation for each day, with the first letter capitalized—for example, 
Mo, Tu, We, Th, Fr, Sa, Su. 

• When a location is open 24 hours a day, use 24 Hours—for example, Mo (24 Hours). 

• When a location is closed on a specific day, use Closed—for example, Sa-Sun (Closed). 

• Enclose all times and closed statuses in parentheses—for example, Tu (7:00-19:00); We-
Mo (Closed). 

• Separate days and ranges with a semicolon to denote the two (or more) groups—for 
example, Th-Fr (7:00-19:00); Sa (24 Hours). 

Using the standards above, a diverse set of operating hours can be populated for your places 

and services. Some common examples include the following: 
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• To specify the place is open from 9:00 a.m. to 5:00 p.m. seven days a week, populate the 
operating hours field with the following: Mo-Su (9:00-17:00). 

• To specify the place is open from 9:00 a.m. to 5:00 p.m. during the week and closed on 
weekends, populate the operating hours field with the following: Mo-Fr (9:00-17:00); Sa-
Su (Closed). 

• To specify the place is open one day (Tuesday) a week, populate the operating hours 
field with the following: Tu (7:00-19:00); We-Mo (Closed). 

• To specify the place has operating hours that vary by day, populate the operating hours 
field with the following: Mo-Tu (9:00-17:00); We (Closed); Th-Fr (7:00-19:00); Sa (24 
Hours); Su (Closed). 

Operating hours data can be populated all at once for many places and services using 

Calculate field values or uniquely entered for each place or service using an application 

provided with the solution. 

 

Arcade expressions 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

The Arcade expressions include several settings that allow you configure the look and feel of 

what is displayed in the web map pop-up. The expressions work with the operating hours data 

and web map pop-up configurations to display current information in your map and app. 

This solution includes Arcade expressions. To modify one of these expressions, complete the 

following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the School 
Locator map. 

2. Open the item page and click Open in Map Viewer. 

3. Click More and click Configure Pop-ups on the Schools layer. 

4. Click Manage, double-click the Arcade expression you want to modify. 

Each Arcade expression has a set of variables that can be configured according to your 
organization’s needs. Review the expression notes and modify the variables as needed. 
Do not change anything else in the expressions. 

5. Click OK. 
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Use School Locator 
The School Locator solution delivers a set of capabilities that help you inventory educational 

facilities and relevant districts, communicate neighborhood schools, and promote educational 

resources available in a community. 

 

Find schools and attendance zones 
You will assume the role of a resident in the community and want to learn more about schools 

and attendance zone boundaries in your area. 

1. Sign in to your ArcGIS organization and browse to the Find Your School site. 

2. From the item page, click View. 

3. Scroll to the Schools by the Numbers section and review key metrics. 

4. Scroll to the Find a Neighborhood School section and review the My Neighborhood 
School app. 

Use the My Neighborhood School app to locate your neighborhood school. 

5. Type an address in the search text box and press the Enter key, or click a location on the 
map. 

6. Click Expand All. 

7. Review the list of school attendance zones. 

You can see information related to which school your child will attend, program and 
services, hours of operation, grades, and enrollment numbers. 

8. In the search results, click Elementary School. 

The map zooms to corresponding school attendance zone boundaries and highlights the 
associated school your child will attend based on your searched address. 

9. Scroll to the Explore all Schools section and review the School Locator app. 

Use the School Locator app to explore all schools in our district. 

10. Type an address in the search text box and press the Enter key, or click Search this 
area. 

11. Click Filter and check the Elementary Schools check box to filter the map. 

12. Click Close. 

13. In the search results, click the first search result. 

The map pans to the corresponding school. 
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Sewer Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Sewer Data Management 
Sewer Data Management can be used to map sewer assets, edit data, view system maps in 

the field and office, view asset reports, and collaborate with map notes. 

It turns ArcGIS into a system for sewer organizations to easily inventory their assets and keep 

information up to date. It provides simple to use interactive system maps and dashboards for 

office and field staff, and increases collaboration. 

After deploying, organizations with no sewer data can immediately begin mapping their sewer 

systems using GPS or digitizing data with web or desktop software. Organizations with 

existing spatial sewer data can load it and begin using the apps. 

 

Requirements 
Sewer Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 (Basic, Standard, or Advanced) 

• ArcGIS Field Maps 
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Information products 
Sewer Data Management for ArcGIS Online includes the following information products: 

Item Description Minimum user type 

Sewer Data 
Manager 

An ArcGIS Pro project package used to 
manage sewer system data and map notes 

GIS Professional (Basic, 
Standard, or Advanced) 

Sewer Editor An ArcGIS Web AppBuilder application used 
to edit sewer system data and map notes 

Editor 

Sewer Viewer An ArcGIS Web AppBuilder application used 
to view sewer map and create map notes 

Editor 

Sewer 
Dashboard 

An ArcGIS Dashboards application used to 
view sewer asset information 

Viewer 

Sewer Map 
Notes Manager 

An ArcGIS Web AppBuilder application used 
to review and manage map notes 

Editor 

Sewer Mobile 
Viewer 

A map used in ArcGIS Field Maps to view 
sewer system assets and view or create map 
notes 

Mobile Worker 

Sewer Asset 
Collector  

A map used in ArcGIS Field Maps to capture 
and modify sewer assets and create map 
notes from the field 

Mobile Worker 

 

Release notes 
The following are the release notes: 

Version Description 

2.1 • The Minimal Gallery app has been removed from the solution item. 

2.0 • Name changed from Sewer Data Management for ArcGIS Online to Sewer 
Data Management. 

• Added a related table for every layer. 

1.2 • Added a table for Manhole inspection. 

• Updated the StormwaterSystem feature layer to support the Adopt-A-Catch 
Basin solution. 

1.1 • Updated to use ArcGIS Field Maps instead of ArcGIS Collector. 

• Removed AssetID Management Notebook. 

• Removed cathodic protection and various other features to simplify the data 
model. 

1.0 • First release of Sewer Data Management for ArcGIS Online 
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Configure Sewer Data Management 
The Sewer Data Management solution can be configured to meet specific needs in your 

organization. The sections below outline some administrative tasks to update and manage the 

solution to fit your organization's needs. 

 

Load data 
In some cases, you may need to load existing data into the solution before sharing the maps 

or applications. Review the maps or applications provided with the solution and determine 

what, if any, source data you want to load. Sewer Data Management also includes a data 

model to store information about typical sewer system assets. To explore the schema, view 

the data dictionary. 

Tip: 

If you do have to load data into the solution, you may want to develop a source-target 
matrix to track how your source data will be loaded into the target layer or layers used in 
the solution. 

Depending on the format of your source data, you may choose to append your source data to 

the new layers. Once you have determined what source data must be loaded, complete one of 

the data loading workflows below: 

 

Use the Append tool 
In ArcGIS Pro, the Append tool can be used to append multiple input datasets to an existing 

target dataset. Input datasets can be point, line, or polygon feature classes. 

To append features to the target layer or layers using the Append tool, complete the steps 

below: 

1. In ArcGIS Pro, sign in to your ArcGIS organization. 

2. To open the Sewer Data Manager project, click Open another project, click My 
Content under Portal, double-click the Sewer Data Management folder, and click 
Sewer Data Manager. 

3. Add your existing source layers to a new map. To add the target feature layers from the 
SewerSystem feature service, click My Content under Portal, double-click the Sewer 
Data Management folder, and add the SewerSystem feature service to the map. 

4. On the Analysis tab, in the Geoprocessing group, click Tools to open the 
Geoprocessing pane. 

5. In the search bar, type Append and click to open the Append tool. 

6. Add your existing sewer data from the map to the Input Datasets parameter. 

7. For Target Datasets, use the SewerSystem features in the map. 
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8. In the Schema Type parameter, use the drop-down menu to choose Use the Field Map 
to reconcile schema differences to perform field mapping. 

9. Update your field mapping and click Run. 

10. Repeat this process as needed to load all your existing data into the target sewer 
schema. 

 

Use the Data Loading Tools 
The Data Loading toolbox can be used in ArcGIS Pro to streamline loading data from a source 

to a target dataset and provide the ability to perform in-process data transformation. Setup the 

Data Loading toolbox before getting started with the steps below. 

1. Open the Sewer Data Manager project. 

2. On the Project tab, click Python to access the Python Package Manager. 

3. Under Project Environment, click Manage Environments. 

4. Click Clone Default  to clone your default environment.  

5. Click the Active button for the new environment, and click OK.  

6. Restart ArcGIS Pro to allow your environment changes to take effect. 

7. In the Python Package Manager, click Add Packages to see the Python packages 
available for installation. 

8. Click Refresh  to update the list of available packages. 

9. In the Search box, type dltsolutions to find the Data Loading Tools toolbox.  

10. Select the dltsolutions package and click the drop-down arrow to update the version. 

11. Click Install. 

The Install Package dialog box appears. 

12. Review the terms and conditions and check the box to agree.  

13. Click Install to install the package. 

14. Once the installation is complete, close ArcGIS Pro.  

The Data Loading Tools toolbox is now installed. The next time you start ArcGIS Pro, you 
can access it from the geoprocessing toolboxes. 

15. Review An overview of the Data Loading toolbox to learn more about the tools and how 
to use them to load data into the SewerSystem layers.  

 

Configure the Sewer Data Manager ArcGIS Pro 

project 
The Sewer Data Manager project includes a Sewer Data Manager map with broken links. 

1. In ArcGIS Pro, sign in to your ArcGIS organization. 
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2. To open the Sewer Data Manager project, click Open another project, click My 
Content under Portal, double-click the Sewer Data Management folder, and click 
Sewer Data Manager. 

3. In the Catalog pane, expand Maps and double-click Sewer Data Manager to open the 
map. 

4. In the Contents pane, click the red exclamation point  next to the Map Notes layer. 

The Change Data Source dialog box appears. 

5. Click My Content under Portal, double-click the Sewer Data Management folder, 
double-click the MapNotes_managing feature service, and double-click the Map Notes 
layer.  

6. In the Contents pane, click the red exclamation point  next to the Manhole layer. 

The Change Data Source dialog box appears. 

7. Click My Content under Portal, double-click the Sewer Data Management folder, 
double-click the SewerSystem_editing feature service, and double-click the Manhole 
layer.  

The data source is repaired for the remaining layers. 

8. In the Contents pane, right click the Sewer Data Manager map and click Properties. 

9. Click the Coordinate Systems tab. In the XY Coordinate Systems Available section 
select the coordinate system that matches the layers in the map. 

Note: 

Ensure the coordinate system of the map matches that of the feature layers deployed 
in the solution. If these do not match there may be discrepancies in what units are 
displayed in the map. 

10. Click Save to save the project. 

 

Add members to groups in your organization 
Included with Sewer Data Management are four groups designed to help managers organize 

their members based on their privileges and their work. The solution includes the following 

groups: Sewer Editors, Sewer Field Users, Sewer Map Notes Managers, and Sewer Office 

Users. 

To add members to the groups, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization. 

Verify that you have privileges to manage member groups before continuing. 

2. Click Groups at the top of the site. 

3. Click the name of the group to open the group details pages. 

4. On the Settings tab, edit and update the properties of the group, including access, 
sharing properties, and group ownership. 
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5. Click the Overview tab and click Invite users.  

6. Select the members you want to add and click Add to group. 

7. Repeat steps 3 through 6 for each group you need to add members to. 

The provided groups are intended to be utilized by members with a minimum of the following 

user types in order to fully use the provided maps and apps: 

Group name User type 

Sewer Editors • Editor 

• GIS Professional Basic with ArcGIS Pro (minimum of one 
license recommended) 

Sewer Field Users • Mobile Worker 

Sewer Map Notes 
Managers 

• Editor 

Sewer Office Users • Editor 

 

Set the default map extent to your service territory 
When the Sewer Data Management solution is deployed into your organization, it uses the 

map default set in your organization. If this property has not been set, you may want to quickly 

update a few maps and apps to your service territory manually to avoid having to pan and 

zoom to your area each time you open a map. Follow the steps below to update the initial 

extent of the maps and apps provided with this solution. 

1. In a browser, sign in to your ArcGIS organization. 

2. To set the default map extent for the Sewer Viewer application, browse to the Sewer 
Viewer item page and click Edit Application. 

3. On the Map tab, zoom the map to the desired extent and click Use current map view 
under Set initial extent. Click Save. 

4. Repeat steps 2 and 3 to set the default map extent for the Sewer Editor and Sewer Map 
Notes Manager applications. 

5. To set the default map extent for the Sewer Asset Collector map, open the Sewer 
Asset Collector map. 

6. Zoom the map to the desired extent and save it. 

7. Repeat steps 5 and 6 for the Sewer Mobile Viewer map. 

 

Configure the dashboard 
When you deploy the Sewer Data Management solution to your organization you have the 

option to change spatial reference. If you selected a spatial reference with a linear unit other 

than meters, you will need to revise the dashboard by completing the following steps. 

1. In a browser, sign in to your ArcGIS organization. 
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2. To set the default map extent for the Sewer Dashboard application, browse to the 
Sewer Dashboard item page and click Edit Dashboard. 

3. Navigate to the General tab and click the configure button  on Miles of Gravity Main 
indicator. 

4. On the Data tab, change the Factor setting to the correct conversion.  

The dashboard Factor setting is configured to convert meters to miles. Learn more about 
how to Convert Values. 

5. Repeat steps 3 through 4 for the Miles of Forced Main indicator. 

6. Click the save button . 
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Use Sewer Data Management 
The Sewer Data Management solution can be used by staff to collect and manage sewer 

system information. This solution allows a sewer utility to obtain information about the current 

state of their system. These workflows are intended for editors, field technicians, and 

managers who want to use the maps and apps to manage their utility data. You will learn how 

to use the Sewer Data Management solution to add new assets from the field, manage sewer 

data in the web and desktop, and view and interact with a dashboard to find key statistics 

about your system. 

 

Add data in the field 
In these workflows, you will be taking the role of a mobile worker collecting data in the field. If 

you have a mobile-centric workforce, this may be the best option to collect new data or 

validate existing data. 

 

Collect manholes and pipes 
As a mobile worker, you can add manholes and mains from the field. 

1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Sewer Asset Collector  map. 

3. Navigate to the collection location. 

4. Tap Add .  

5. From the list of features, search for Manhole by swiping up or typing manhole in the filter 

search bar. 

If the manhole is added to an inaccurate location, or you want to move the point 
manually, move the crosshairs to the correct location by panning the map and tapping 
Update Point. This moves the added manhole to the specified location. 

6. Fill in any attributes and tap Submit. 

Note: 

Move to a safe location to fill in the attributes. The added manhole remains in its 
original location. 

7. Ensure the last collected manhole is selected and browse to the next manhole's location. 
Tap the Copy button at the bottom of the screen to create a copy of the previously added 
manhole at the location of the new manhole. 

8. Adjust any attributes as needed. Next, add the pipes to connect the manholes. 

9. Tap Add .  

10. Search for Collector Gravity Main by swiping up or typing collector gravity main in 

the filter search bar. 
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11. Pan the map until the crosshairs snap to the manhole. An orange point appears when it 
is within a tolerance to snap. 

 

12. Tap the options button and select Update Selected Point to move the start of the 
Collector Gravity Main to the manhole. 

13. Snap to the second manhole and tap Add Point. 

14. Update the attributes and tap Submit to complete the sketch. 

 

Collect cleanouts 
As a mobile worker, you can collect cleanouts using ArcGIS Field Maps in the field. 

1. In ArcGIS Field Maps open the Sewer Asset Collector map. 

2. Navigate to the collection location. 

3. Tap Add .  

4. From the list of features, search for Cleanout by swiping up or typing cleanout in the 

filter search bar, and select Cleanout.  

A point is added to your location. 
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Note: 

If the cleanout is added to an inaccurate location, or you want to move the point manually, 
move the crosshairs to the correct location by panning the map and tapping Update 
Point. The added cleanout moves to the specified location. 

5. Fill in any attributes and tap Submit. 

6. Ensure the last collected cleanout is selected and browse to the next cleanout location. 
Tap the Copy button at the bottom of the screen to copy the previously added cleanout 
to the location of the new cleanout. 

7. Adjust the attributes and tap Submit. 

 

Add map notes 
As a mobile worker, you can add a map note to the system. 

1. In ArcGIS Field Maps open the Sewer Asset Collector map. 

2. Navigate to the map note location. 

3. Tap Add.  

4. From the list of features, search for the Map Notes type by swiping up or typing a 
description in the filter search bar, select the Map Notes type, and add the note to the 
map by sketching a polygon in the map note location. 
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5. Fill in the attributes and click Submit. 

  The map note is added to the map and is available to be viewed and reviewed by others 
in the organization. 

 

Add data in the web 
In the workflows below, you will be taking the role of an editor adding data in ArcGIS Online. 

The workflows explain how to add data in the web, use the provided dashboard, and add and 

manage map notes. 

 

Add pipes to connect features 
As an editor, you want to use a web app to connect features with pipes. 

1. In a browser, sign in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Navigate to the Sewer Editors group and locate the Sewer Editor app. Click View 
Application to launch the app. 
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In the Sewer Editor app, the Asset Editor widget is open by default on the left side of the 
window when the app opens. 

4. In the Asset Editor pane, click the template drop-down menu and select Sewer Gravity 
Main, and select Collector Gravity Main from the list of options. 

5. Scroll down and fill in the preset values. 

6. With Collector Gravity Main selected, press Ctrl to snap to a manhole by hovering over 
the point, and click to start the line. 

 

7. Draw a line from the first manhole to the next, press Ctrl to snap, and double-click to 
finish the sketch. 

You are prompted to update attributes and save. 

8. Click Save. 

9. Continue adding mains between the manholes. 

  The template and preset attributes remain selected so you can continue adding mains. 

 

Add map notes 
As a user, you can add a map note to the system. 
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1. Browse to the Sewer Office Users group and locate the Sewer Viewer app. Click View 
Application to launch the app. 

a. In the Sewer Viewer, click the Map Notes Editor widget to open it. 

b. Choose a map note issue type and sketch a polygon in the desired map note 
location. 

c. Enter attributes and click Save. 

   

 

Manage map notes 
As a GIS manager, you can review and resolve map notes about your system to ensure 

issues are addressed. 

1. Browse to the Sewer Map Notes Managers group and locate the Sewer Map Notes 
Manager app. Click View Application to launch the app. 

  In the upper right of the app, there are a number of widgets that have been configured to 
filter, edit, update, and manage map notes. 

2. Review the list of included widgets to learn how to use them to manage map notes:  
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• Legend—View a list of included layers in the map. The legend displays what is 
visible on the map, so zooming in or out can expand or reduce the list if scale 
suppression is set on the layers. 

• Filter—Use the Creation Date, Issue, and Severity filters to view only map notes 
that fit the entered criteria. Select a date range or an option from the drop-drown 
menu and turn on a filter to view the selection on the map. 

• Batch Edit Map Notes—Select a group of map notes using one of the selection 
tools and update values for all the selected features at once. 

• Map Notes Editor—Add a new map note or edit an existing map note. 

• Map Notes Summary—View all the map notes by status and expand each 
section to view the individual notes. Click a note to zoom to it on the map and 
view its attributes in a pop-up. 

  These changes are reflected in other apps and maps across the system so others in your 
organization can view the latest information. 

 

Use the sewer dashboard 
As a member of the utility, you want to have a comprehensive view of your sewer system 

assets. 

1. Browse to the Sewer Office Users group and locate the Sewer Dashboard app. Click 
View Dashboard to launch the dashboard. 

2. View the sewer system statistics on the General tab, click the Gravity Main tab to view 
the gravity main details, and click the Force Main tab to view the force main details. 

 

Add data in ArcGIS Pro 
In the workflows below, you will be taking the role of an editor adding data in ArcGIS Pro. If 

you have known locations of assets or as-built drawings to work from, the following workflows 

can demonstrate using ArcGIS Pro to add data to your sewer system. 

Note: 

The first time you open the Sewer Data Manager map in ArcGIS Pro, the layers will show 
as broken. Follow the steps to Configure the Sewer Data Manager ArcGIS Pro project to 
fix your layers. 

 

Add manholes and pipes 
As an editor, you can add manholes and mains to the map in ArcGIS Pro. If you already have 

manholes, you can complete steps 8 through 10 to add mains between the manholes. 

1. Open the Sewer Data Manager ArcGIS Pro project, sign in to your ArcGIS organization. 

2. In the Catalog pane, expand Maps and double-click Sewer Data Manager to open the 
map. 
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3. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

4. On the Edit tab, in the Features group, click Create. 

  The Create Features pane appears. 

5. Select the Manholes template from the Favorites list, fill in the attributes, and add the 
manhole to the map. 

   

6. On the Map tab, in the Selection group, click Attributes and fill in the remaining 
attributes. 

7. Repeat steps 4 through 6 to add the remaining manholes to the map. 

8. Select the Sewer Gravity Main template from the Favorites list and fill in the attributes. 

  As a best practice, digitize in the direction that wastewater flows. 

9. Snap and click the start of the line to the first manhole to begin digitizing the pipe. Snap 
to the next manhole and double-click to complete the sketch. 

10. Open the Attributes pane and fill in the remaining attributes. 

11. Repeat steps 8 through 10 to draw in the remaining pipes between the rest of the 
manholes. 

 

Add residential service laterals 
As an editor, you can add service laterals to the map in ArcGIS Pro. 

1. In the Catalog pane, expand Maps and double-click Sewer Data Manager to open the 
map. 
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2. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

3. On the Edit tab, in the Features group, click Create. 

  The Create Features pane appears. 

4. Select the Residential Lateral Service group template from the Favorites list and click 
through the included templates to fill in the attributes.  

  The group template works by adding the service connection, cleanout, and tap with three 
consecutive clicks, and automatically digitizes the lateral. 

   

5. Add the template to the map by following the steps below: 

a. Click the location on the map for the service connection. 

b. Click to add the cleanout to the map. 

c. Snap to the main and double-click to complete the sketch. This adds the tap to 
connect the lateral to the main.  
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6. On the Map tab, in the Selection group, click Attributes and fill in the remaining 
attributes. 

7. Repeat steps 4 through 6 to add the remaining residential lateral services to the map. 

 

Add features from an as-built drawing 
As an editor, you can add assets such as manholes to the system from an as-built drawing. 

1. In the Catalog pane, expand Maps and double-click Sewer Data Manager to open the 
map. 

2.  On the Map tab, in the Layers group, click Add Data. Browse to the location of the as-
built drawing, select it, and click OK to add it to the map. 

3. With the image selected in the Contents pane, browse to the Raster Layer ribbon. On 
the Appearance tab, in the Effects group, change the Layer Transparency setting to 
50%. 

4. On the Imagery tab, in the Alignment group, select Georeferencing. 

  If you are unfamiliar with georeferencing, see Overview of georeferencing in the ArcGIS 
Pro help. 

5. On the Georeferencing tab, in the Adjust group, click Add Control Points. 
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a. Add a minimum of two control points to connect your image to your known map 
positions. 

b. Once you have added all the control points, browse to the Georeferencing tab and 
click Save. 

6. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

7. On the Edit tab, in the Features group, click Create.  

  The Create Features pane appears. 

8. Select an asset from the template list and add the asset to the map where it corresponds 
to the georeferenced as-built drawing. 

9. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

10. Remove the image from the Contents pane once digitizing is complete. 

 

Add map notes 
As an editor, you can add a map note to the system. 

1. In the Catalog pane, expand Maps and double-click Sewer Data Manager to open the 
map. 

2. On the Edit tab, in the Features group, click Create. 

  The Create Features pane appears. 

3. In the Favorites list, expand the Map Notes folder and choose a Map Note option. Add 
the map note by digitizing a polygon on the map at the desired location. 

4. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

  The map note is added to the map and is available to be viewed and reviewed by others 
in the organization. 
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Social Equity Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Social Equity Analysis 
Social Equity Analysis can be used to identify and analyze demographics, assets, conditions, 

and outcomes to optimize plans for community investment. 

Governments across the globe struggle to ensure residents have opportunities to continue 

their education, secure a well-paying job, find healthy foods, access affordable health care, 

and locate housing options in safe neighborhoods. They recognize many face challenges due 

in part to systematic and structural barriers that constrain access to opportunity. Social equity 

aims to understand how systems negatively affect certain groups and level the playing field by 

making investments aligned with the severity of needs. Many governments are making a 

commitment to social equity and seeking interventions, or policy changes, that reduce 

burdens for marginalized communities, Social Equity Analysis is typically implemented by 

state and local governments that want to understand unique characteristics and conditions 

that exist in their community and how actions they are taking impact access or needs. 

The Social Equity Analysis solution delivers a set of capabilities that help you understand 

community characteristics, analyze community conditions and actions, and generate an equity 

analysis index that can be used to educate internal and external stakeholders. 

 

Requirements 
Social Equity Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 3.0 or later (Advanced) 

• ArcGIS Geostatistical Analyst extension 
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Information products 
Social Equity Analysis includes the following information products: 

Item Description Minimum user 
type 

Social 
Equity 
Analysis 

An ArcGIS Pro project used by equity analysts to analyze 
community assets, conditions, or outcomes in relation to 
community characteristics to create an equity analysis index 
and locate optimal asset locations to meet community 
needs. 

GIS 
Professional 
Advanced 

Equity 
Analysis 
Index 

A Media app used by the internal and external stakeholders 
to view the resulting Equity Analysis Index produced using 
the Social Equity Analysis ArcGIS Pro project. 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • An update to the Social Equity Analysis ArcGIS Pro project to resolve a bug 
in the Create Ranked Surface tool. 

1.0 • First release of Social Equity Analysis 
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Configure Social Equity Analysis 
Social Equity Analysis can be used to identify and analyze demographics, assets, conditions, 

and outcomes to optimize plans for community investment. 

In this topic, you'll learn how to configure the Social Equity Analysis solution to meet specific 

needs in your organization. 

 

Publish equity index 
Once the Equity Analysis Index map is shared as a web layer using the Create equity analysis 

index map task in the Social Equity Analysis ArcGIS Pro project, the resulting map can be 

shared with internal and external stakeholders. 

 

Add layer into web map 
To add one, or more, layers to a web map, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization. 

2. Browse to the Equity Analysis Index web map. 

3. Open the item details and click Open in Map Viewer. 

4. In the left pane, click Add, select Browse Layers. 

5. Search for the Equity Analysis Index layer or alternative layer that was shared using the 
Social Equity Analysis tasks. 

6. Click the Add button. 

7. Open the Layer pane, click the Options ellipses on the Equity Analysis Index layer, click 
Zoom to. 

8. Save the map. 

9. Browse to the Equity Analysis Index application, open the item details page and click 
View Application. 

10. The Equity Analysis map is now available in the application to be shared with 
stakeholders. 
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Use Social Equity Analysis 
The Social Equity Analysis solution delivers a set of capabilities that help you understand 

community characteristics, analyze community conditions and actions, and generate an equity 

analysis index that can be used to educate internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Evaluate conditions and actions 
To load and normalize community asset, condition or outcome data with the Social Equity 

Analysis project. Use the tasks to summarize and load data into your reporting areas spatially. 

You will assume the role of an equity analyst. You are asked to use the Social Equity Analysis 

project to analyze and normalize community asset, condition or outcome data in relation to 

your reporting areas. 

1.  Sign in to your ArcGIS organization and browse to the Social Equity Analysis Desktop 
Application Template. 

2.  Open the item page and click Download. 

3.  Unzip and open the Social Equity Analysis ArcGIS Pro project. 

4.  Open the Social Equity Analysis ArcGIS Pro Project. 

5.  On the View tab, in the Windows group, click Catalog Pane 

6.  In the Catalog pane, expand the Tasks folder, and double-click the Social Equity 
Analysis task. 

7.  In the Tasks pane, click the Evaluate Conditions and Actions task group to expand 
the collection of tasks. 

8.  In the Tasks pane, double-click the Prepare community asset, condition and 
outcome data task and follow the steps provided. 

 

Identify community characteristics 
Community characteristics and community asset, condition or outcome rates can be used to 

identify areas of focus quickly using the Social Equity Analysis project. These tools have been 

designed to be flexible in order to analyze many different variables and equity scenarios. 

You will continue to assume the role of an equity analyst. You are asked to use the Social 

Equity Analysis project to identify areas of need. 

1. On the View tab, in the Windows group, click Catalog Pane. 

2. In the Catalog pane, expand the Tasks folder, and double-click the Social Equity 
Analysis task. 

3. In the Tasks pane, expand the Tasks folder, click the Identify Community 
Characteristics task group to expand the collection of tasks. 
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4. In the Tasks pane, double click the Prepare community characteristic data task, and 
follow the steps provided. 

 

Create equity analysis index 
To find the areas of most need with the Social Equity Analysis project. Use the previously 

generated focus populations and community condition rate data to identify and rank 

community need for your reporting areas. 

You will continue to assume the role of an equity analyst. You are asked to use the Social 

Equity Analysis project to find reporting areas of highest need. 

1. Open the Social Equity Analysis ArcGIS Pro Project. 

2. On the View tab, in the Windows group, click Catalog Pane 

3. In the Catalog pane, expand the Tasks folder, and double-click the Social Equity 
Analysis task. 

4. In the Tasks pane, click the Create Equity Analysis Index task group to expand the 
collection of tasks. 

5. In the Tasks pane, double-click the Create equity analysis index map task and follow 
the steps provided. 

 

Evaluate asset locations 
To find the best potential asset locations with the Social Equity Analysis project. Use the 

previously generated Equity Analysis Index and a list of potential asset locations to analyze 

new asset locations in your community by travel time. 

You will continue to assume the role of an equity analyst. You are asked to use the Social 

Equity Analysis project to select the best potential asset locations from a list of candidate sites 

that meet needs defined in the Evaluate Conditions and Actions task group. 

1. Open the Social Equity Analysis ArcGIS Pro Project. 

2. On the View tab, in the Windows group, click Catalog Pane 

3. In the Catalog pane, expand the Tasks folder, and double-click the Social Equity 
Analysis task. 

4. In the Tasks pane, click the Evaluate Asset Locations task group to expand the 
collection of tasks. 

5. In the Tasks pane, double-click the Evaluate coverage and existing asset locations 
by travel time task and follow the steps provided. 

6. Double-click the Identify candidate asset locations task and follow the steps provided. 

7. Double-click the Select new asset locations task and follow the steps provided. 
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Explore community need 
Once the Equity Analysis Index is created, it can be shared with stakeholders via a web 

mapping application. This app can be used to see how need is distributed across the 

community. 

You will assume the role of an internal or external stakeholder. You are asked to use the 

Equity Analysis Index app to explore need in the community. 

1. Sign in to your ArcGIS organization and browse to the Equity Analysis Index app. 

2. Open the item page and click View Application. 

3. Search for an address or click a reporting area on the map. 

  A popup will display showing the Equity Rank Score and details for the given area. 

4. Review other communities and examine how need is distributed across the region. 

5. The Information tab displays details regarding the map. 

6. Click the Share icon to copy a link or share the app on social media. 
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Special Event Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

  

Introduction to Special Event Operations 
Special Event Operations can be used to develop safety plans and monitor public safety 

operations during a special event. 

It provides a way to collaborate in a geographic context to simplify the safety planning and 

operations workflows. Event information from the incident action plan can be mapped and 

monitored along with live event information such as weather, traffic, field reports, and health 

and safety incidents. Special Event Operations is typically implemented by public safety 

operations that want to improve event health and safety planning to protect participants and 

the public. 

Special Event Operations delivers a set of capabilities that help you organize special events, 

create event site maps, develop health and safety plans, manage event incidents and 

assignments, monitor public health and safety operations, and create after-action reports. 

Note: 

If you represent a local government that requires permitting capabilities, you may be 
interested in the Special Event Permitting and Operations solution. It includes permitting 
capabilities and special events operations capabilities. 

 

Requirements 
Special Event Operations requires the following: 

• ArcGIS Enterprise 

• ArcGIS Data Store - Spatiotemporal big data store 

• ArcGIS Notebook Server 

• ArcGIS Survey123 

• ArcGIS Survey123 Connect 

• ArcGIS Workforce 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://www.arcgis.com/apps/solutions/index.html?solution=94aa66d6bca943d69c8f16d88e529770


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 709 

Note: 

To use this solution ensure the following content and services are enabled and configured 
in ArcGIS Enterprise: Living Atlas content and Living Atlas subscriber content. 

Information products 
Special Event Operations includes the following information products: 

Item Description Minimum 
user type 

Special Event 
Form 

An ArcGIS Survey123 form used by public safety event 
planners to catalog community or special events 

Editor 

Special Event 
Manager 

A Crowdsource Manager app used by public safety 
event planners to manage the status of special events 
during the review process 

Editor 

Special Event Site 
Map 

An ArcGIS Web AppBuilder app used by event 
coordinators to create site maps (temporary structures, 
routes, and so on) that accompany permit apps 

Editor 

Special Event 
Operations Map 

An ArcGIS Web AppBuilder app used by public safety 
event planners to create operations maps of public 
safety resources and conduct a high-level threat 
analysis 

Editor 

Special Event 
Operations 
Notebook 

An ArcGIS Notebooks app used by public safety event 
planners to create unique public safety operations maps 
and apps for each event 

Creator 

Copy Previous 
Site and 
Operations Maps 

An ArcGIS Notebooks app used by event coordinators 
and public safety event planners to create a copy of site 
and operations maps 

Creator 

Special Event 
Field Reporter 

An ArcGIS Survey123 form used by public safety staff to 
report lost children, suspicious activity, field 
observations, and health- and safety-related issues 

Mobile 
Worker 

Special Event 
Field Manager 

An ArcGIS Workforce project used by public safety 
event dispatchers to manage field reports and event 
assignments. Field users access the project using the 
ArcGIS Workforce app 

Editor 

Special Event 
Command Center 

An ArcGIS Experience Builder app used by public safety 
command staff to monitor operations, weather, traffic, 
and health and safety issues during a special event 

Editor 

Special Event 
After Action 

An ArcGIS Web AppBuilder app used by public safety 
command staff to visualize historical event operations 
and support event after-action reports 

Viewer 

Special Event 
Operations App 

A Category Gallery app used to organize the Special 
Event Operations apps after running ArcGIS Notebooks 

Editor 
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Release notes 
The following are the release notes: 

Version Description 

2.1 • A new Special Event Command Center app. 

• A new Special Event Operations Notebook. 

• A new Special Event Operations app that uses the Category Gallery. 

• Removed the Crowd Counter App. 

• Removed the Field Personnel spreadsheet to improve the management of 
mobile workers. 

2.0 • A new Special Event Field Reporter that leverages ArcGIS Field Maps. 

• A new Special Event Field Manager that leverages ArcGIS Workforce. 

• A new Special Event Permit Manager app. 

• A new Special Event Operations Map app. 

• A new Special Event Command Center app that contains the Special Event 
Field Manager, the Special Event Operations, and dashboards. 

1.2 • A new Special Event Operations Notebook that adds support for ArcGIS 
Tracker with the Field Worker user type, incorporates schema updates made 
to the location tracking layer, and a resolution to an issue where Dispatchers 
needed additional licensing. 

1.1 • A new version of the Crowd Counter App that resolves an issue where the 
app would not load in the AppStudio Player 

1.0 • First release of Special Event Operations 
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Configure Special Event Operations 
The ArcGIS Solutions app can be used to deploy the Special Event Operations solution in 

your ArcGIS organization. After deploying the solution to your ArcGIS organization, configure 

the solution to meet specific needs in your organization and load your data if needed. 

 

Extend event survey 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

The Special Event Operations solution includes a Special Event Form, which is a survey that 

can be used by public safety event planners to catalog community or special events. Review 

the preconfigured questions and adjust as necessary to remain in compliance with your 

organizational policies. In addition, ensure that you secure the survey and underlying layers 

and only share the content with appropriate members of your organization. 

 

Update feature layer views 
The Special Event Operations solution includes a series of views created from feature layers 

provided with the solution. Organizations may want to modify the Special Event Form by first 

adding new fields to the feature layers and then configuring the surveys to use the newly 

created fields. When doing so, the new fields must be exposed in the appropriate views. 

Additionally, some views are created by joining two sources, and these views must be re-

created with the same name and URL after a new field is added. 

When adding new questions, begin with the steps below. For changes such as removing 

questions or formatting the survey, proceed to the Modify the event form survey section. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Sign in to your ArcGIS organization and search for the Special Events hosted feature 
layer. 

2. Add a new field to a layer in the Special Events hosted feature layer. 

3. Navigate to the Special Event Permit stakeholder layer view in your contents. 

4. Note: 

5. In some cases, you may have existing permits you want to load into the special event 
layer. The stakeholder view is designed to provide a read-only view of the event form 
when accessed from Special Event Manager. 

6. Click the Open in Map View arrow and click Add to new map. 

7. Click the More Options button on the appropriate layer or table and click Set View 
Definition. Click Define Fields. 
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8. Scroll to the newly created field, check the box, and click Apply. 

The new field is added to the view’s definition. 

 

Modify the event form survey 
To modify the Special Event Form survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Special Event Form to download the survey. 

4. Click Special Event Form again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all the 
selectable options for survey questions. 

7. Revise the survey to reflect your Special Event Form needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

Note: 

To view your changes in ArcGIS Survey123, on the Download Surveys page, click 
Download to get the updated survey. 

 

Add event assets 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

The Special Event Operations solution includes several layers that can be used to locate 

event assets and develop health and public safety plans. These layers include several 

domains to help you get started with the event planning process. Each of these domains can 

be configured to include any additional features you would like to capture. 

To add a new event asset and update the symbology, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Click Content and browse to the folder you deployed the Special Event Operations 
solution in. 

3. Search for SpecialEventAssets and open the item details page. 
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4. Click Fields and click Event Asset Type. 

5. Next to List of Values, click Edit. 

6. Add your additional asset types and click Save. 

7. Click the Visualization tab. 

8. Click Change Style and update the style for each new asset you added to the list. 

9. Repeat steps 7 and 8 and update the style for SpecialEventAssets_operations. 

Note: 

The same steps can be used to modify the SafetyPlanning and HealthSafetyPlanning 
layers and associated views. 

 

Create After Action app 
Incident commanders are responsible for the health and safety of participants during an event. 

The Special Event After Action app provides useful visualization tools to see both how 

incidents occurred and how field personnel responded. This information can be used to further 

examine specific incidents and help plan for future events. 

Follow the workflow below to create a unique Special Event After Action app for your event. 

Follow the steps below create a unique track view of your event. 

1. Open a new map project in ArcGIS Pro. 

2. Sign in to your ArcGIS organization account within ArcGIS Pro . 

3. Search for the <Event Name Date>_trackview and add the track view to the map. 

4. If you have many field personnel over an extended period of time then, you may have a 
large number of tracks and want to change the maximum number of records returned. 

5. Select the track view you added to the map and export the data from the track view into a 
new layer. 

6. Publish the new layer as a service in your ArcGIS organization and name it <Event 
Name Date> - Tracks. 

Follow the steps below create a Special Event After Action web map to use in the After Action 

app. 

1. Sign in to ArcGIS organization and navigate to the Special Event After Action web map 
item. 

2. Open in Map Viewer the Special Event After Action web map. 

3. Add the layer you published in the previous workflow to the map. 

4. Change the style of the layer and symbolize by the Full Name field. 

5. Add the layer assignments layer named the <Event Name Date> - Assignments to the 
map. 
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6. Change the style of the layer and symbolize by the report type field using the public 

safety category. 

7. Remove the Report Type layer from the map. 

8. Save the Special Event After Action map with a new same for example, Special Event 
After Action - Event Name.  

Follow the steps below create a Special Event After Action app for your event. 

1. In your ArcGIS organization, navigate to the Special Event After Action app item and Edit 
Application. 

2. Choose the triangle button, next to Save, and choose Save As. 

3. Choose a name for the app for example, Special Event After Action - <Event Name>.  

4. Choose Map, Choose web map, then choose the map you created in the previous 
workflow. 

5. Choose Widget, Set the widgets in this controller, Group Filter widget, and then 
choose OK. 

6. Add each layer of the map to the widget and choose the Event Identifier field as the 
filter. 

7. Choose After Action Report widget and update the layer to the<Event Name Date> - 
Assignments. 

8. Choose Find Personnel widget and update the layer to the<Event Name Date> - 
Tracks. 

9. Save and then Launch the application. 

The application is a historical archive of the special event and can be used to animate 

assignments and track locations. Repeat this workflow for each event. 
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Use Special Event Operations 
Special Event Operations can be used to organize special events, create event site maps, 

develop health and safety plans, manage event incidents and assignments, monitor public 

health and safety operations, and create after-action reports. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage special events 
Special Event Operations offers a comprehensive system to manage all events in one central 

location. It allows you to manage the entire process through the event approval process, event 

site planning, operations and after-action review. All information can be kept in preparation for 

each event to be used next year. 

In this workflow, you'll learn how to create and manage events. 

 

Create a special event 
You will start by assuming the role of a public safety event planner who needs create a special 

event and manage it through the planning approval process. You are asked to use the Special 

Event Form survey to create an event. 

1. In a browser, from the Special Event Operations solution, view the Special Event Form 
survey. 

2. In the Special Event Form survey, fill in the following details on the first page: 

Parameter Value 

Enter the name of the 
special event 

Type 5K for the Local Animal Shelter. 

Select an event type Type Competition or Race. 

Description of Event Type A great event to be had by everyone 
benefiting animals in need. 

Open to the public Select Yes. 

Estimated Attendance Type 1000. 

Will alcohol be served at 
the event 

Select No. 

3. At the bottom of the first page, click Next. 
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4. Complete the remaining event form pages, selecting an event start date one week from 
today in the morning and ending in the evening of the same day. 

5. On page 4 of the event survey, provide the following information: 

• For Event location, type a name of a local park. 

• For Locate the event on a map, type the name and city of the local park and zoom 
to the location. 

6. At the bottom of the page, click Submit. 

 

Manage and review special events 
In this workflow, you will assume the role of a public safety event planner who is asked to 

manage the review process and notify other government departments or agencies when a 

Special Event Form has been submitted. You will review the event information and update the 

status. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Manager app. 

3. In the Special Events table, click the Status column filter and select Under Review. 

4. From the table, select the event that you created previously. 

The event details open in the Info panel. 

5. In the Info panel, scroll down and click Review Event Info.  

The Special Event Form that was submitted earlier opens. 

6. Review the form, and then close the Special Event Form survey. 

 

Prepare site plans 
Since many of the assets are temporarily set up before the event, planners need an 

interactive way to quickly assign the location of each asset. The Special Event Site Map 

allows coordinators or safety planners to quickly add these assets to the map for an event. 

In this workflow, you'll learn how to create and copy site maps as well as notify others when 

maps are ready to be reviewed. 

 

Create a special event site map 
You will start by assuming the role of a public safety event organizer who needs to create an 

event site map for the special event. You are asked to use the Special Event Manager app to 

locate a special event and the Special Event Site Map to create a site map. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Manager app. 
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3. In the Special Events table, click the Status column filter and select Under Review. 

4. In the table, select the event that you created previously. 

5. In the Info panel, click Edit Site Map. 

The Special Event Site Map app opens and zooms to the event. It also filters all related 
information, so you only see temporary features for your event. 

6. In the Create Site Map pane, click Food Concessions and type King Smoothie. 

7. Click a location on the map within the park. 

Note: 

The Event Identifier field is passed automatically from your filter selection in the Select 
Event widget and cannot be edited. 

8. Click Save. 

9. Repeat these steps for each event asset, route, and area you would like to add to your 
site map. 

10. After completing your site map, click Save, and then close the Special Event Site Map. 

 

Copy event maps from the previous year (optional) 
In many cases, events are reoccurring and have similar site maps year after year. The Copy 

Previous Site and Operations Maps allows you to copy a previous site map to a new event. 

Modifications can then be made and added to the site map for the new event. 

In this workflow, you will learn how to copy event maps from a previous year and update the 

maps when necessary. 

Note: 

To execute the Copy Previous Site and Operations Maps script, the event organizer must 
have access to the ArcGIS Notebooks item. In addition, you need at least two events (see 
the Create a special event section). The first event's status must be set to Archived and 
should have an associated site map. The new event should have the status set to Under 
Review. Do not use the event you have already approved above as it will be used in the 
subsequent steps. 

Note: 

You must be assigned a role of Administrator or custom role which includes the privilege 
to Create and edit notebooks in order to run an ArcGIS Notebooks and complete the 
following steps. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Manager app. 
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3. Click the Status column filter and select Under Review. 

4. Select the event that you created in the Special Event Form survey. 

5. In the Info panel, scroll down and click Copy Previous Site and Operations Maps. 

An ArcGIS Notebooks app appears on a separate tab and will prompt you to sign in. 

6. Click Cell and choose Run All. 

7. In the Archived drop-down menu, choose a previous event that already has a site map. 

8. In the New Event drop-down menu, choose the new event that does not have an 
associated site map. 

9. Click Copy Previous Site and Operations Maps. 

10. After the script completes, return to the Special Event Manager app and select the event 
in the list of events. 

11. Click Edit Site Map and verify the new site map is complete. 

Note: 

You may also want to verify the operations map is complete. 

12. Make any required modifications to the site map and click Save. 

 

Prepare operations plans 
The Special Event Operations Map allows safety planners to add all relevant health and safety 

resources and perform high-level risk assessments. It can be used to locate isolation areas or 

set up plexiglass barriers at ticket counters or food vending booths. In addition, it can be used 

to calculate the number of people allowed in each space using Centers for Disease Control 

and Prevention (CDC) guidelines. Event staff can use the real-time counter at entrances and 

exits for each venue to maintain a safe environment for everyone. 

Public safety staff can add resource assignments, road closures, traffic restrictions, and 

estimates of crowd sizes to guide field personnel assignments. Optionally, planners can 

create a reference grid for field staff supporting the event, conduct a visibility assessment for 

high-risk locations, or identify areas that may be impacted by a potential bomb explosion or 

chemical spill. 

In this workflow, you'll learn how to create operations maps and copy events from previous 

years. 

 

Coordinate with public safety event planners 
You will start by assuming the role of a public safety event planner who needs to coordinate 

with public safety event planners. You are asked to use the Special Event Manager app to 

locate a permit app and notify public safety that a health and safety plan is needed for this 

event. 
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1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Manager app. 

3. Click the Status column filter and select Under Review. 

4. Select the event you created in the Special Event Form survey, or another event. 

5. On the Info tab, click Edit Operations Map. 

Note: 

When you open the Special Event Operations Map from the Special Event Manager, 
the Event Identifier and Plan Identifier fields are passed automatically to the Select 
Event widget and should not be edited. 

You can use the Develop a health and safety plan workflow in the next section to help 
you edit the operations map. 

6. After the Special Event Operations Map is complete, return to the Special Event Manager 
app, and then in the event's Info panel, click the Edit button. 

7. Locate the Operations Map Complete field and click Yes. 

8. Locate the Status field, click Approved. 

9. Click Save. 

 

Develop a health and safety plan 
Next, you will assume the role of a public safety event planner who needs to develop a health 

and safety plan for an event. You are asked to use the Special Event Operations Map to 

create an operations map of public safety resources and conduct a high-level threat analysis. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  

2. View the Special Event Operations Map app. 

3. Click the Basemap widget and select Imagery. 

4. Click the Create Operations Map widget and search for PPE Station. 

5. Place a PPE station on the map and add details for the health and safety asset. 

6. Click Save. 

7. Search for Handwashing Station., place it on the map, and add details for the event 

asset. 

8. Click Save. 

9. Repeat these steps for each health and safety asset, route, and area you would like to 
add to your operations map. 

10. Search for Road Blocks, place two on the map, and add details for each of the road 

blocks. 

11. Click Save. 
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12. At the top of the Create Operations Map widget, select Social Distancing Crowd 
Areas from the drop-down list. 

13. Draw an area on the map and double-click to complete the sketch. 

14. For Area name, type Vendor Area. 

Note: 

The Area name field must be unique. 

15. For Max Capacity, type 100, and then click Save. 

Note: 

The area on the map is labeled with the number of people that can safely enter an area 
of this size based on CDC social distancing guidelines. Adjust the maximum capacity or 
area size if necessary. 

16. At the top of the Create Operations Map widget, select Crowd Estimates from the 
drop-down list. 

Note: 

Crowd estimation is determined by Jacobs' method; the high, medium, and low values 
of crowd estimation appear on the map. 

17. Click the template, draw an area on the map, and double-click to complete the sketch. 

18. For Description, type Crowd Area for Event. 

19. Click Save. 

20. Search for Medical Tent, place it on the map, and add details for the event asset. 

21. Finally, search for On Foot, place three public safety resources on the map, and add the 

following details for each resource: 

• For Point of Contact, type an officer name. 

• For Point of Contact Phone, type a unique phone number for each officer. 

• For Comments, type Public Safety support for Humane Shelter Event. 

22. After completing your health and safety operations map, click Save. 

 

Conduct high-level threat analysis (optional) 
The Special Event Operations Map includes a series of tools that can be used to define the 

impact of an incident (chemical or other threat) on event assets and resources. As you 

complete the health and safety plan, you may be asked to conduct a high-level threat analysis 

and identify the impact on your event operations plan. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  
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2. View the Special Event Operations Map app. 

3. Click the Gridded Reference Graphic widget to create a reference grid that can be used 
in large outdoor events.  

4. Define the location of the grid from a point or area, and then click Create GRG. 

5. To identify the impact of a chemical incident and create a potential evacuation area, click 
the Emergency Response Guide widget. 

6. Select the location, material, and size of the accident along with the wind direction and 
time, and then click Create Zones. 

7. Click the Threat Analysis widget to identify the impact of other threats. 

8. Select the location, type of threat, and size of the accident, and then click Create Zones. 

9. Finally, to identify the impact of an incident on event assets and resources, click the 
Situational Awareness widget. 

10. Select the location and the distance impacted, and then click the map. 

After using the Gridded Reference Graphic, Emergency Response Guide, or Threat 
Analysis widgets and publishing the derived layers, you can associate the layers with the 
event so they can be used in other event operations apps. 

11. Select a health and safety resource you added earlier and copy the event identifier. 

12. Click the Assign Event Identifier widget and select the features generated by the 
previously identified widgets.  

13. Type the event identifier, and then click Save. 

 

Copy event maps from the previous year 
Many times, reoccurring events will use similar site and operations maps from one year to the 

next. For instance, an annual 5k run will have similar route, food concessions, and public 

safety support locations. Re-creating the site map every year can be very time consuming. In 

this workflow, you will learn how to copy event maps from a previous year and update the 

maps when necessary. 

You will continue assuming the role of an event organizer. You are asked to use the Special 

Event Manager app and the Copy Previous Site and Operations Maps script to create a copy 

of the previous year site map and operations maps. 

Note: 

To execute the Copy Previous Site and Operations Maps script, the event organizer must 
have access to the ArcGIS Notebooks item. In addition, you need at least two events (see 
the Create a special event section). The first event's status must be set to Archived and 
should have an associated site map. The new event should have the status set to Under 
Review. Do not use the event you have already approved above as it will be used in the 
subsequent steps. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Special Event 
Operations solution.  
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2. View the Special Event Manager app. 

3. Click the Status column filter and select Under Review. 

4. Select the event that you created previously. 

5. In the Info panel, scroll down and click Copy Previous Site and Operations Maps. 

An ArcGIS Notebooks app appears on a separate tab and will prompt you to sign in. 

6. Click Cell and choose Run All. 

7. In the Archived drop-down list, choose a previous event that already has a site map. 

8. In the New Event drop-down list, choose the new event that does not have an 
associated site map. 

9. Click Copy Previous Site/Operations Maps. 

10. After the script completes, return to the Special Event Manager app and select the event 
in the table. 

11. Click Edit Site Map and verify the new site map is complete. 

Note: 

You may also want to verify the Special Event Operations Map is complete. 

12. Make any required modifications to the site map, and then click Save. 

 

Conduct health and safety operations 
The Special Event Operations solution provides a complete set of capabilities that improve the 

efficiency and effectiveness of public safety personnel working at special events by enabling 

public safety personnel with tools to capture information from the field to share with 

commanders in a synthesized operational picture in real time. 

In this workflow, you'll learn how to use a collection of maps and apps to support incident 

commanders and site staff to visualize, monitor, and communicate real-time status during an 

event as well as visualize incident response after an event has occurred. 

 

Deploy event operations apps 
Public safety event planners and incident commanders need a unique set of maps and apps 

for each event. The unique maps and apps allow them to manage personnel assignments, 

activities, and incidents during an event and conduct after-action reviews that help them 

improve planning for future events. Each event requires the following: 

• Unique apps for incident commanders, firefighters and emergency medical technicians, 
law enforcement officers, event dispatchers, health and safety officers, cleaning staff, 
and site staff 

• The ability to monitor the location field personnel assigned to an event 

• An incident tracking and assignment system that can be used onsite at the event 
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• Maps that show relevant event assets and public safety resources assigned to an event 

You will assume the role of a public safety event planner. You are asked to use the Special 

Event Operations Notebook to create a copy of the event operations apps for a unique event. 

Note: 

You must be assigned a role of Administrator or custom role which includes the privilege 
to Create and edit notebooks in order to run an ArcGIS Notebooks and complete the 
following steps. 

1. In a browser, go to the Special Event Operations Notebook and review the instructions 
provided with ArcGIS Notebooks. 

2. Click the Cell menu and click Run All. 

3. Under Select a Special Event to deploy Operations applications, click the Select an 
Event drop-down arrow and choose your event. 

4. Click Deploy Special Event Operations. 

The creation of the event operations apps takes a few minutes to complete. 

5. After the progress bar is complete, click View Deployed Event Operations. 

  A collection of new event operations apps opens. 

 

Assign mobile personnel 
Public safety staff working at the event can use the mobile apps in the next steps to track their 

locations and collect field operations. To accomplish this, they will need a named user login 

and access to the applications utilized later in the workflow. The following steps will grant 

users access so they can utilize the apps and share their location. Note, before proceeding 

make sure all users have the ArcGIS account requirements for location tracking. 

1. In a browser, sign in to your ArcGIS organization and click the Apps button  in the 
header of the site. 

2. From the app launcher, click Workforce to open the app. 

3. Under Projects, hover over the {Event Name} Special Event Manager and click the 
Configure button. 

4. Click the Users tab. 

5. Follow the instructions to either manually add mobile workers or to add workers from a 
file. 

6. Optionally, add additional dispatchers to the Workforce project. 

Users added to the Workforce project will now be able to open the Workforce app on their 

mobile device to receive assignments from the dispatcher.  

7. After you finish, return to your ArcGIS organization and click the Apps button  in the 
header of the site. 

8. From the app launcher, click Track Viewer to open the app. 
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9. Under Projects, hover over the {Event Name}_trackview and click the Configure button. 

10. Click the Select to add mobile users drop-down arrow, and then under Workforce 
project (import workers), select {Event Name} Special Event Field Manager. 

11. Click Add. 

12. Optionally, add additional Track Viewers that can view the location of mobile personnel in 
the Command Center application. 

Note: 

To add additional support personnel, repeat these steps. 

  Users added to the track view will now be able to share their location when using the 
Field Maps app on their mobile device described later. 

 

Report activity and track locations from the field 
During an event, public safety staff and site staff collect field observations that are used to 

protect the health and safety of event attendees. In addition, the ability to quickly identify the 

location of field personnel is critical during the event. Dispatchers and incident commanders 

need to see a map with the location of their staff to determine who should respond to specific 

incidents. 

You will assume the role of a firefighter, emergency medical technician, or law enforcement 

officer who needs to report suspicious activity or a safety concern observed at the event. You 

are asked to use the Special Event Field Reporter map to report the suspicious activity or 

safety concern. Your location will also be tracked so dispatch has the ability to see resources 

as they receive calls. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open the app on your mobile device and sign in to your organization. 

3. Tap {Event Name} Special Event Field Reporter to open it. 

4. Tap Add and tap Suspicious Activity. 

5. Fill in the following details: 

Parameter Value 

Description Select Suspicious Activity. 

Notes Type Backpack left at location with no owner to 
be seen for 20 minutes. 

Enter address, or generic 
description. 

Type Behind bbq vendor tent. 

6. Optionally, add an image or picture. 

7. Locate the field report on the map. 

8. Click Submit. 
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Manage field assignments 
It’s common for minor incidents such as traffic accidents, medical calls, or disorderly 

spectators to occur during a special event. Often these incidents are reported by radio or 911 

calls to a dispatcher in the event command center. 

Now, you will assume the role of an event dispatcher who needs to assign field reports or 

other incidents to field staff. You are asked to use the Special Event Command Center to 

assign the suspicious activity or safety concern to a firefighter, emergency medical technician, 

or law enforcement officer. 

Note: 

This workflow requires you to be signed in to your ArcGIS organization and have the 
Special Event Operations solution deployed. 

1. In a browser, go to the Special Event Command Center and open it in a browser. 

2. Click Dispatch to create assignments. 

3. Click one of the listings for Assignment in the list. 

4. Click Edit. 

5. Validate the assignment type by looking at the Description and change the Assignment 
Type to the correct type (Suspicious Activity).  

6. Select Assign and choose a mobile worker from the drop-down menu. 

7. Click the Search bar and type an address or name of a special event asset such as a 
concession stand.  

8. Click Special Event Assets: 1 Result feature and click Create assignment. 

9. In the new assignment, fill in the following details: 

Parameter Value 

Assignment Type Select Medical Response. 

Assign Choose a mobile worker from the drop-down list. 

Description Type Citizen reporting heat exhaustion and has 
collapsed. 

Priority Choose High from the drop-down list. 

Due Date and 
Time 

Select a time on the same day of the event. 

10. Click Create Assignment. 

Field personnel can open the ArcGIS Workforce app on their mobile device and see their 
assignments. 

In many cases field personnel will be too busy to examine their assignments on their 
phone and communication will be done via radio. In this case, the dispatcher may want to 
close the assignments to take them off the active list. 

11. In the Special Event Command Center click Dispatch > Update Status. 
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12. Click Freehand Polygon and draw a polygon to select some Assignments. 

13. In the Update Assignment Status  dialog change the Status to Completed. 

  This will mark the assignments as Closed and not appear as an active assignment for the 
field personnel to work. You will see the assignment status in the Dispatch console and 
dashboards later in the workflow. 

 

Track cleaning and stocking status 
You will now assume the role of janitorial staff. You are asked to use the ArcGIS Field Maps 

mobile app to update the status of locations after you clean, disinfect, or restock them with 

PPE. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open the app on your mobile device and sign in to your ArcGIS organization. 

3. Choose Cleaning and Restocking Map. 

4. Choose a station for PPE Station, choose Cleaning and Restocking Status in the pop-
up, and tap the Add button. 

Note: 

The space under the Add button displays all historical status records for a location, so 
as a station is restocked with PPE, a user can review this list to see when it was 
restocked and how much PPE it was restocked with. 

5. Choose status, choose Re-stocked, and add the number of boxes stocked of each PPE 
type. 

6. Choose Submit. 

 

Monitor event operations 
Incident commanders need real-time information on the location of incidents and staff as well 

as incoming weather and traffic information to make informed decisions during an event. The 

Special Event Operations Dashboard can be used in the command center on the day of the 

event. 

1. In a browser, go to the Special Event Operations gallery app. 

2. Click the name and date of your event Special Event Command Center. 

3. On the Monitor tab, Tracked Units, Units on assignment, and Last Known Locations 
provide up-to-date location information of staff and assignments. 

4. Click Open incidents within the last hour and choose an incident. 

5. Click the Post Locations drop-down arrow under Monitor to see post location versus the 
actual location of staff. 

6. Click the Weather drop-down arrow under Monitor to see real-time weather radar 
information. 
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7. Click the Traffic drop-down arrow under Monitor to see real-time traffic and road closure 
information. 

8. Click the Sanitation drop-down arrow under Monitor to see real-time cleaning and 
restocking status for PPE stations, high-touch locations, and other health assets. 

9. Close the app. 
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Special Event Permitting and Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Special Event Permitting and 

Operations 
Special Event Permitting and Operations can be used to manage special event permits, 

protect event attendees, and promote special events occurring in the community. 

It provides a way to collaborate in a geographic context to simplify the permitting and 

operations workflows. These integrated apps ensure that permits are routed to the correct 

person for approval, operation and field staff are coordinated, and necessary event 

information remains current. Special Event Permitting and Operations is typically implemented 

by planning, public works, public safety, and other organizations that want to improve event 

permitting workflows and health and safety planning and to protect participants and the public. 

Special Event Permitting and Operations delivers a set of capabilities that help you collect and 

organize permit apps, develop event site maps and health and safety plans, coordinate the 

permit review process, share event information with the public, monitor public health and 

safety operations, and create after-action reports. 

Note: 

If you do not require the permitting capabilities of this solution, you may be interested in 
the Special Event Operations solution instead. 

 

Requirements 
Special Event Permitting and Operations requires the following: 

• ArcGIS Enterprise 

• ArcGIS Data Store - Spatiotemporal big data store 

• ArcGIS Notebook Server 

• ArcGIS Survey123 

• ArcGIS Survey123 Connect 

• ArcGIS Workforce 
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• ArcGIS Hub 

Note: 

To use this solution ensure the following content and services are enabled and configured 
in ArcGIS Enterprise: Living Atlas content and Living Atlas subscriber content. 

Information products 
Special Event Permitting and Operations includes the following information products: 

Item Description Required 
user type 

Special Event 
Permit 

An ArcGIS Survey123 form used by event organizers 
and sponsors to apply for a community or special event 
permit 

Not 
required 

Special Event 
Permit Manager 

A Crowdsource Manager app used by event 
coordinators to facilitate the special event permit 
process and manage the status of a permit app 

Editor 

Special Event Site 
Map 

An ArcGIS Web AppBuilder app used by event 
coordinators to create site maps (temporary structures, 
routes, and so on) that accompany permit apps 

Editor 

Special Event Site 
Map Viewer 

An ArcGIS Web AppBuilder app used by the general 
public and other interested parties to view event site 
maps 

Not 
required 

Special Event 
Permit Review 

An ArcGIS Web AppBuilder app used by departments 
or agencies to review permit apps and offer comments 
during the permit review process 

Editor 

Special Event 
Permit Dashboard 

An ArcGIS Dashboards app used by government 
executives to monitor the status of special event 
permits 

Viewer 

Special Event 
Calendar 

An ArcGIS Experience Builder app used by the public 
to discover festivals, shows, concerts, and other events 
occurring in a community 

Not 
required 

Promoting Special 
Events 

An ArcGIS Hub site used by the general public to 
access special event information and destinations in 
their community 

Not 
required 

Special Event 
Operations 
Notebook 

An ArcGIS Notebooks app used by public safety event 
planners to create unique public safety operations 
maps and apps for each event 

Creator 

Copy Previous Site 
and Operations 
Maps 

An ArcGIS Notebooks app used by event coordinators 
and public safety event planners to create a copy of site 
and operations maps 

Creator 

Special Event 
Operations Map 

An ArcGIS Web AppBuilder app used by public safety 
event planners to create operations maps of public 
safety resources and conduct a high-level threat 
analysis 

Editor 

Special Event Field 
Reporter 

An ArcGIS Field Maps form used by public safety staff 
to report lost children, suspicious activity, field 
observations, and health- and safety-related issues 

Mobile 
Worker 
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Special Event Field 
Manager 

An ArcGIS Workforce project used by public safety 
event dispatchers to manage field reports and event 
assignments 

Editor 

Special Event 
Command Center 

An ArcGIS Experience Builder app used by public 
safety command staff to monitor operations, weather, 
traffic, and health and safety issues during a special 
event 

Editor 

Special Event After 
Action 

An ArcGIS Web AppBuilder app used by public safety 
command staff to visualize historical event operations 
and support event after-action reports 

Viewer 

Special Event 
Operations App 

A Category Gallery app used to organize the operations 
apps after running the Special Event Operations 
Notebook 

Editor 

 

Release notes 
The following are the release notes: 

Version Description 

2.1 • A new Special Event Command Center app. 

• A new Special Event Operations Notebook. 

• A new Special Event Operations app that uses the Category Gallery. 

• Removed the Crowd Counter App. 

• Removed the Field Personnel spreadsheet to improve the management of 
mobile workers. 

2.0 • A new Special Event Field Reporter that leverages ArcGIS Field Maps. 

• A new Special Event Field Manager that leverages ArcGIS Workforce. 

• A new Special Event Calendar that leverages ArcGIS Experience Builder. 

• A new Special Event Permit dashboard. 

• A new Special Event Permit Manager app. 

• A new Special Event Operations Map app. 

• A new Special Event Command Center app that contains the Special Event 
Field Manager, the Special Event Operations, and dashboards. 

1.2 • A new Special Event Operations Notebook that adds support for ArcGIS 
Tracker with the Field Worker user type, incorporates schema updates made 
to the location tracking layer, and a resolution to an issue where Dispatchers 
needed additional licensing. 

1.1 • A new version of the Crowd Counter App that resolves an issue where the 
app would not load in the AppStudio Player 

1.0 • First release of Special Event Permitting and Operations 
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Configure Special Event Permitting and 

Operations 
The ArcGIS Solutions app can be used to deploy the Special Event Permitting and Operations 

solution in your ArcGIS organization. After deploying the solution, configure it to meet specific 

needs in your organization, and load your data if needed. 

 

Extend an event permit survey 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

The Special Event Permitting and Operations solution includes a survey that can be used by 

event organizers to apply for a special event permit. Review the preconfigured questions and 

adjust as necessary to remain in compliance with your organizational policies. In addition, 

ensure that you secure the survey and underlying layers and only share the content with 

appropriate members of your organization. 

 

Update feature layer views 
The Special Event Permitting and Operations solution includes a series of views created from 

feature layers provided with the solution. You can modify the Special Event Permit survey by 

first adding new fields to the feature layers and then configuring the surveys to use the newly 

created fields. The new fields must be exposed in the appropriate views. Additionally, some 

views are created by joining two sources together, and these views must be re-created with 

the same name and URL address after a new field is added. 

Note: 

Complete the workflow below to add new questions to the survey by adding new fields. 
Refer to the Modify event permit survey section to learn how to remove questions or 
format a new survey. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Sign in to your ArcGIS organization and search for the SpecialEvents hosted feature 
layer. 

2. Add a new field to a layer in the SpecialEvents hosted feature layer. 

3. Go to the SpecialEvents_approved view in your contents. 

4. Click the Open in Map View drop-down arrow and click Add to new map. 

5. Click the more options button on the appropriate layer or table and click Set View 
Definition. Click Define Fields. 
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6. Scroll to the newly created field and check the box. Click Apply. The new field is added 
to the view’s definition. 

To update a join view, complete the following steps: 

1. Go to the join view in your contents (for example, SpecialEventAreas_approved). 

2. On the item details page, scroll to the URL section. Click the Copy button. 

3. Paste the copied URL into Microsoft Notepad or another text editor for reference. 

Note: 

The feature layer name is used below when re-creating the join. The name can be 
found after services in the URL structure and may also contain a unique GUID, for 
example, SpecialEventAreas_approved_a45f71a48587425c9b90ee5527cd26d1. 

4. Delete the existing join view (for example, SpecialEventAreas_approved). 

5. Add the SpecialEvents hosted feature layer to a new web map. 

6. Click Analysis > Summarize Data > Join Features. 

7. Configure the join using the information in the following table: 

Name of join Target layer Layer to 
join to the 
target 
layer 

Fields to 
match 

Join 
operati
on 

Define which 
record is 
kept 

SpecialEventAssets_a
pproved 

SpecialEventA
ssets 

SpecialEv
ents 

eventident
ifier = 
eventid 

Join 
one to 
one 

Order by 
Date 
Reported/Ne
west 

SpecialEventRoutes_a
pproved 

SpecialEventR
outes 

SpecialEv
ents 

eventident
ifier = 
eventid 

Join 
one to 
one 

Order by 
Date 
Reported/Ne
west 

SpecialEventAreas_ap
proved 

SpecialEventA
reas 

SpecialEv
ents 

eventident
ifier = 
eventid 

Join 
one to 
one 

Order by 
Date 
Reported/Ne
west 

Note: 

Ensure that each new join view uses the names defined in this table. If you use the 
same names, the layers in the map and the existing dashboard widgets do not have to 
be reconfigured. If your join view contained a unique GUID, the new join view must be 
named with the unique GUID. 

8. If necessary, uncheck Use current map extent. Check Create results as hosted 
feature layer view. 
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9. Update the Special Event Site Map Viewer and other special event maps and apps to 
account for the new fields you added to the layers. 

 

Modify event permit survey 
To modify the Special Event Permit survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Special Event Permit to download the survey. 

4. Click Special Event Permit again to open the survey. 

5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all the 
selectable options for survey questions. 

7. Revise the survey to reflect your special event permit needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

Note: 

On the Download Surveys page, click Download to view your changes in ArcGIS 
Survey123 Connect. 

 

Notify reviewers 
The Special Event Permit Review app allows departmental reviewers to provide input on each 

event. The Special Event Permit Manager has a button that opens an email to send to these 

reviewers. Often these reviewers are the same for every event, so rather than typing the same 

emails for each departmental reviewer every time an event is ready for review, you can 

populate the email so it always includes their email addresses. 

1. Sign in to your ArcGIS organization. 

2. Click Content and browse to the folder where you deployed the Special Event Permitting 
and Operations solution. 

3. Search for the Special Event Permit Manager web map and open it. 

4. In the layer list, highlight Special Event Permits, click the more options button, and click 
Configure Pop-up. 

5. Under Attribute Expressions, scroll down to Notify Reviewers Email Link. 

6. Find the following line of code: var emailRecipient = "" 

7. Enter the email addresses of the reviewers separated by semicolons between the empty 
quotation marks. 
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8. Click OK to close the Arcade window. 

9. Click OK to close the Configure Pop-up window. 

10. Click Save to save the Special Event Permit Manager. 

11. Click Content and browse to the folder where you deployed the Special Event Permitting 
and Operations solution. 

12. Search for the Special Event Permit Manager app and open it. 

13. Find an event that has the Status parameter set to Approved and Site Map Complete 
set to Yes. 

14. Click the Notify Reviewers button. Verify that the emails are now populated as part of 
the email. 

 

Add event assets 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

The Special Event Permitting and Operations solution includes several layers that can be 

used to locate event assets and develop health and public safety plans. These layers include 

several domains to help you get started with the event permitting and planning process. Each 

of these domains can be configured to include any additional features you want to capture. 

To add a new event asset and update the symbology, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Click Content and browse to the folder where you deployed the Special Event Permitting 
and Operations solution. 

3. Search for SpecialEventAssets and open the item details page. 

4. Click Fields and click Event Asset Type. 

5. Next to List of Values, click Edit. 

6. Add your additional asset types and click Save. 

7. Click the Visualization tab. 

8. Click Change Style and update the style for each new asset you added to the list. 

9. Repeat steps 7 and 8 and update the style for SpecialEventAssets_approved and 
SpecialEventAssets_operations. 

Tip: 

You can use the same steps to modify the SafetyPlanning and HealthSafetyPlanning 
layers and associated views. 
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Share event destination 
Promoting Special Events is an ArcGIS Hub site that can be used to promote special events in 

a community. It can also serve as a destination for event organizers that must apply for a 

special event permit. The ArcGIS Hub site integrates several maps and apps included in the 

Special Event Permitting and Operations solution. Each of these maps and apps must be 

shared with the public so they can be accessed at the Promoting Special Events destination. 

To share the event maps and apps, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Search for Promoting Special Events and open the item details page. 

3. Share the ArcGIS Hub site with everyone (public). 

4. Repeat this process for each of the following items: 

Item Name Sharing 

Web mapping app Special Event Site Map Viewer Everyone (public) 

Dashboard Special Event Calendar Everyone (public) 

Form Special Event Permit Everyone (public) 

Web map Special Event Site Map Viewer Everyone (public) 

Web map Special Event Calendar Everyone (public) 

Feature layer (hosted) SpecialEvents Everyone (public) 

Feature layer (hosted, view) SpecialEvents_approved Everyone (public) 

Feature layer (hosted, view) SpecialEventsAssets_approved Everyone (public) 

Feature layer (hosted, view) SpecialEventsRoutes_approved Everyone (public) 

Feature layer (hosted, view) SpecialEventsAreas_approved Everyone (public) 

Feature layer (hosted, view) RoadClosures_public Everyone (public) 

Hub Initiative Promoting Special Events Everyone (public) 

 

Create After Action app 
Incident commanders are responsible for the health and safety of participants during an event. 

The Special Event After Action app provides useful visualization tools to see both how 

incidents occurred and how field personnel responded. This information can be used to further 

examine specific incidents and help plan for future events. 

Follow the workflow below to create a unique Special Event After Action app for your event. 

Follow the steps below create a unique track view of your event. 

1. Open a new map project in ArcGIS Pro. 

2. Sign in to your ArcGIS organization account within ArcGIS Pro . 

3. Search for the <Event Name Date>_trackview and add the track view to the map. 

If you have many field personnel over an extended period of time then, you may have a 
large number of tracks and want to change the maximum number of records returned. 

4. Select the track view you added to the map and export the data from the track view into a 
new layer. 
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5. Publish the new layer as a service in your ArcGIS organization and name it <Event 
Name Date> - Tracks. 

Follow the steps below create a Special Event After Action web map to use in the After Action 

app. 

1. Sign in to ArcGIS organization and navigate to the Special Event After Action web map 
item. 

2. Open in Map Viewer the Special Event After Action web map. 

3. Add the layer you published in the previous workflow to the map. 

4. Change the style of the layer and symbolize by the Full Name field. 

5. Add the layer assignments layer named the <Event Name Date> - Assignments to the 
map. 

6. Change the style of the layer and symbolize by the report type field using the public 

safety category. 

7. Remove the Report Type layer from the map. 

8. Save the Special Event After Action map with a new same for example, Special Event 
After Action - Event Name.  

Follow the steps below create a Special Event After Action app for your event. 

1. In your ArcGIS organization, navigate to the Special Event After Action app item and Edit 
Application. 

2. Choose the triangle button, next to Save, and choose Save As. 

3. Choose a name for the app for example, Special Event After Action - <Event Name>.  

4. Choose Map, Choose web map, then choose the map you created in the previous 
workflow. 

5. Choose Widget, Set the widgets in this controller, Group Filter widget, and then 
choose OK. 

6. Add each layer of the map to the widget and choose the Event Identifier field as the 
filter. 

7. Choose After Action Report widget and update the layer to the<Event Name Date> - 
Assignments. 

8. Choose Find Personnel widget and update the layer to the<Event Name Date> - 
Tracks. 

9. Save and then Launch the application. 

The application is a historical archive of the special event and can be used to animate 

assignments and track locations. Repeat this workflow for each event. 
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Use Special Event Permitting and Operations 
Special Event Permitting and Operations can be used by local governments to collect and 

organize permit apps, develop event site maps and health and safety plans, coordinate the 

permit review process, share event information with the public, monitor public health and 

safety operations, and create after-action reports. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage event permits 
Special events start with private or nonprofit organizations that request an event permit from 

the local authorities. Typically, this permit request is submitted in hard copy or a fillable form 

that is received by a special event coordinator. The coordinator is then often responsible for 

delegating the review process to stakeholders from many departments. Often this process is 

further encumbered by paper or email delays. 

In this workflow, you'll learn how to create and manage special event permits. 

 

Apply for a special event permit 
You will start by assuming the role of an event organizer who needs to submit a permit app to 

a local government for approval. You are asked to use the Special Event Permit survey to 

apply for an event permit and submit a site map along with your app. 

1. In a browser, go to your Special Event Permit survey. 

2. In the Special Event Permit survey, fill in the following details on the first page: 

Parameter Value 

Enter the name of the 
special event 

Type 5K for the Local Animal Shelter. 

Select an event type Type Competition or Race. 

Description of Event Type A great event to be had by everyone 
benefiting animals in need. 

Open to the public Select Yes. 

Estimated Attendance Type 1000. 

3. At the bottom of page 1, click Next. 

4. Complete the remaining event permit pages. Select an event start date one week from 
today in the morning and ending in the evening of the same day. On page 8 of the event 
survey, provide the following information: 
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• For Event location, type a name of a local park. 

• For Locate the event on a map, type the name and city of the local park and zoom 
to the location. 

• For Event Site Map, Browse to a local file and attach a diagram an event organizer 
would use to describe the setup of an event. 

5. At the bottom of the page, click Next. 

6. On page 9, sign the permit app. 

7. Click Submit. 

 

Submit an internal event 
In some cases, an event may be hosted by your own organization, so there is no need to fill 

out the full permit. In that case, you can use a shortened version of the permit that represents 

the internal submission. 

1. In a browser, go to your Special Event Permit survey. 

2. At the end of the URL, add &field:submittype=Internal. 

Your URL parameter should look like the following: 

https://survey123.arcgis.com/share{YourItemID}?portalUrl={YourPortalURL}&field:submit
type=Internal 

The internal event permit will not contain as much detail as a sponsored event. 

3. Fill out the survey with a new event and submit it. 

 

Coordinate a permit review 
Now, you will assume the role of an event organizer in the same local government. You are 

asked to coordinate the review process and notify other government departments when a 

special event permit has been submitted. You will review the permit app and update the status 

of the permit. 

1. In a browser, go to the Special Event Permit Manager app. 

2. Click the Permit Status column filter and select Submitted. 

3. Select the event you created in the Special Event Permit survey. 

4. In the Info panel, scroll down and click Review Permit Application. 

The permit app that was submitted by the organizer opens, which allows further review of 
the app, permit updates, and email communication with the organizer. 

5. Close the Special Event Permit survey. 

6. On the Info tab, click the edit button and click Edit to edit the event status. 
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Note: 

As a special event coordinator, you can track the permit status throughout the review 
life cycle and identify when site and operations maps have been created. 

7. For Permit Status, choose Under Review, and click Save. 

 

Prepare site plans 
The event site map is the foundation of the event. It provides a common reference for 

planning, operating, and promoting each event. It can also include the event location, event 

assets, designated areas, and routes required to conduct the event. The Special Event Site 

Map allows coordinators or safety planners to quickly add these assets to the map for an 

event. 

In many cases, events are reoccurring and have similar setups year after year. The Copy 

Previous Site and Operations Maps notebook allows you to create a new event using a 

previous site map as a starting point. Modifications can then be made and added to the site 

map for the new event. 

In this workflow, you'll learn how to create and copy site maps as well as notify others when 

maps are ready to be reviewed. 

 

Create a site map 
You will start by assuming the role of an event organizer who needs to create an event site 

map for a permit app. You are asked to use the Special Event Permit Manager to locate a 

permit app and the Special Event Site Map to create a site map. 

1. In a browser, go to the Special Event Permit Manager app. 

2. Click the Permit Status column filter and select Under Review. 

3. Select the event you created in the Special Event Permit survey. 

4. In the Info panel, scroll down and click Edit Site Map. 

This opens the Special Event Site Map app and zooms to the event permit app. It also 
filters all related information, so you see temporary features for your event. 

5. On the Create Site Map dialog box, click Food Concessions, and enter the name of a 
food concession you added earlier. 

6. Click a location on the map within the park. 

Note: 

The Event Identifier field is passed automatically from your filter selection in the Select 
Event widget and cannot be edited. 

7. Click Save. 
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8. Repeat steps 6 and 7 for each event asset, route, and area you want to add to your site 
map. 

9. After completing your site map, click Save, and close the Special Event Site Map. 

 

Copy event maps from the previous year (optional) 
Many times, reoccurring events will use similar site and operations maps from one year to the 

next. For instance, an annual 5k run will have a similar route, food concessions, and public 

safety support locations. Re-creating the site map every year can be time-consuming. In this 

workflow, you will learn how to copy event maps from a previous year and update the maps 

when necessary. 

You will continue assuming the role of an event organizer. You are asked to use the Special 

Event Permit Manager and the Copy Previous Site and Operations Maps script to create a 

copy of the previous year's site map and operations maps. 

Note: 

To execute the Copy Previous Site and Operations Maps script, the event organizer must 
have access to the ArcGIS Notebooks item. In addition, you need at least two events (see 
the Create a special event section). The first event's status must be set to Archived and 
should have an associated site map. The new event should have the status set to Under 
Review. Do not use the event you have already approved above as it will be used in the 
subsequent steps.. 

1. In a browser, go to the Special Event Permit Manager app. 

2. Click the Permit Status column filter and select Under Review. 

3. In the Special Event Permits table, select the event you created in the Special Event 
Permit survey. 

4. In the Info panel, scroll down and click Copy Previous Site/Operations Maps. 

An ArcGIS Notebooks app appears in a new tab and may prompt you to sign in. 

5. Click Cell and choose Run All. 

6. In the Archived drop-down list, choose a previous event that already has a site map. 

7. In the New Event drop-down list, choose the new event that does not have an 
associated site map. 

8. Click Copy Previous Site/Operations Maps. 

9. When the script completes, return to the Special Event Permit Manager and select the 
event in the Special Event Permits table. 

10. Click Edit Site Map and verify the new site map is complete. 

Note: 

You may also want to verify the Special Event Operations Map is complete. 

11. Make any required modifications to the site map and click Save. 
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Notify permit reviewers 
You will continue assuming the role of an event organizer. You are asked to use the Special 

Event Permit Manager to update the permit app and notify internal stakeholders that the 

proposed event is ready for review. 

1. In a browser, go to the Special Event Permit Manager app if you do not have it open 
already. 

2. Click the Permit Status column filter and select Under Review. 

3. In the Special Event Permit table, select the event you created in the Special Event 
Permit survey. 

4. In the Info panel, scroll down and click Edit. 

5. Locate the Site Map Complete field, choose Yes, and click Save. 

6. On the Info tab, click Notify Reviewers. 

7. Copy the hyperlink from the email and paste it in a new tab in your browser. 

Note: 

You will send this email to the permit review staff members who participate in your 
permit review process. 

8. Close your email client. 

Note: 

If your email client does not open when you click the Notify Reviewer button, ensure that 
your default email client is configured. 

 

Inform stakeholders 
As the number and size of local special events increase, so does the impact on public 

infrastructure and resources. Executives from a local government need to see a 

comprehensive impact to the community. Key indicators, such as events serving alcohol or 

fireworks or requiring road closures, can show the impact on public safety or public works 

resources. The Special Event Permitting and Operations solution provides a Special Event 

Permit Dashboard to allow executives to see a historical context of all events and where they 

are in the approval process, and filter by event type. 

Public attendance to an event can be dependent on how well it is promoted. The Promoting 

Special Events ArcGIS Hub site allows your community to have a branded destination to 

promote events as well as other places to visit, such as museums or popular restaurants. A 

member of the general public can view the Special Event Calendar to find a specific event of 

interest to them, with an associated detailed site map of the event. 

In this workflow, you'll learn how to update and monitor special event permits as well as view 

the special events in your community. 
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Gather feedback from internal stakeholders 
Event permits are typically reviewed by several different government departments or 

agencies. Incorporating feedback from the internal stakeholders before the permit is approved 

is critical. In this workflow, you will learn how to review a permit app and offer comments. You 

will also learn how to review a summary of all comments provided during the review process. 

You will start by assuming the role of a permit review staff member (for example, public works 

director, planning director, or incident commander). You are asked to use the Special Event 

Permit Review app to review an event permit app and the site map and offer any comments. 

1. In a browser, go to the Special Event Permit Review app. 

2. In the list of special events, select the event you created in the Special Event Permit 
survey, or select another special event. 

The Special Event Permit Review app should specify the event from the email in the Notify 

permit reviewers section in the Prepare site plans workflow. If you are using the try-it-live 

example app, you can provide feedback for any event listed. 

3. Click View Permit Application to review details found in the permit app. Close the 
Special Event Permit survey after you have finished reviewing the app. 

4. Click the Add a comment button and fill in the following details: 

Parameter Value 

Organization Select Public Works. 

Comments Type Concerned that additional roads need to be blocked at 
the cross-streets of Gartner Road. 

Any 
Instructions 

Type Approved contingent on additional road blocks. 

Action Select Approved. 

5. Click Submit and close the Special Event Permit Review app. 

Now you will assume the role of an event coordinator. You are asked to use the Special Event 

Permit Manager app to review comments provided by the permit review staff to approve or 

deny the permit app. 

1. In a browser, go to the Special Event Permit Manager app if you do not have it open 
already. 

2. Click the Permit Status column filter and select Under Review. 

3. Select the event you created in the Special Event Permit survey, or select another event. 

4. In the Info panel, click the Comments tab. 

Comments may be provided by the permit review staff. In some cases, the comments 
may require you to update the site and operations maps or contact the event organizer to 
alter their plans for the event. 

5. Click Edit in the Info panel and scroll down to Permit Status. 

6. Select Approved and click Save. 
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7. On the Info tab, click Notify Organizer. 

The email is directed to the person who originally applied for the permit and the event 
organizer. The email includes a link to the original permit app and the site map that can 
be viewed for reference. 

8. Close your email client. 

 

Monitor event permit applications 
Many organizations are seeing a growing number of events in their community. As a result, 

event executives need to monitor the status of the event permit process and understand which 

events are occurring throughout the community. 

In this workflow, you will assume the role of an event executive. You are asked to use the 

Special Event Permit Dashboard to monitor the special event permit program, review key 

indicators, and get an understanding of the type of events scheduled in the community. 

1. In a browser, go to the Special Event Permit Dashboard. 

2. In the left panel, click the Status filter and select Under Review. 

3. Review the list of permits and indicators. 

4. Select an event from the list and review additional event information. 

5. Click the graph to filter events by month.  

This filter can be useful to review a list of events planned for a given month (for example, 

October). 

 

Share events with the public 
Special events have become an important factor in local economies by attracting participants 

and spectators from outside the community to events such as 5k fun runs, marathons, outdoor 

concerts, and arts and crafts festivals. In some cases, local governments hosting similar 

special events are competing with each other for event participants that help support the local 

economy. Therefore, promoting and marketing local events is important. 

Finally, you will assume the role of a resident or member of the public. You are interested in 

events happening in your community and will use an ArcGIS Hub destination on your 

community's website along with the Special Event Calendar app to discover upcoming events. 

1. In a browser, go to the Promoting Special Events ArcGIS Hub site. In the Things to Do 
section, click Learn more to open the Special Event Calendar app. 

2. If you know the name of the event you are interested in, you can search for it by name in 
the left panel. Otherwise, click the Date filter and enter the date range you are interested 
in. 

Select a date range that aligns with the event you entered in the Special Event Permit survey. 

3. Click an event type to further refine the results. 

4. Review the list of events occurring in the community. 
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5. Select an event from the list and review additional event information. 

6. Click the View Event Map link and review assets (for example, entrances, road blocks, 
and vendors) placed for the event. 

Note: 

For larger events, it may be useful to search for an event asset. 

7. After reviewing the Special Event Site Map Viewer, close it and return to the Special 
Event Calendar. 

 

Prepare operations plans 
The Special Event Operations Map allows safety planners to add all relevant health and safety 

resources and perform high-level risk assessments. It can be used to locate isolation areas or 

set up plexiglass barriers at ticket counters or food vending booths. In addition, it can be used 

to calculate the number of people allowed in each space using Centers for Disease Control 

and Prevention (CDC) guidelines. Event staff can use a real-time counter at entrances and 

exits for each venue to maintain a safe environment for everyone. 

In addition, public safety staff can add resource assignments, road closures, traffic 

restrictions, and estimates of crowd sizes to guide field personnel assignments. Optionally, 

planners can create a reference grid for field staff supporting the event, conduct a visibility 

assessment for high-risk locations, or identify areas impacted by a potential bomb explosion 

or chemical spill. 

In this workflow, you'll learn how to create operations maps and copy events from previous 

years. 

 

Coordinate with public safety event planners 
You will start by assuming the role of an event organizer who needs to coordinate with public 

safety event planners. You are asked to use the Special Event Permit Manager to locate a 

permit application and notify the public safety event planners that a health and safety plan is 

needed for this event. 

1. In a browser, go to the Special Event Permit Manager app. 

2. Click the Permit Status column filter and select Under Review. 

3. Select the event you created in the Special Event Permit survey, or select another event. 

4. On the Info tab, click Edit Operations Map. 

A new email message opens with the link to the event operations map. 

5. Copy the link from the email and paste it in a new tab in your browser. 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 745 

Note: 

For larger events, it may be useful to search for an event asset. You will send this email 
to public safety event planners who participate in your permit review process. 

6. Close your email client. 

7. Once the Special Event Operations Map is complete, scroll down and click Edit. 

8. Locate the Special Event Operations Map Complete field and choose Yes. 

 

Develop a health and safety plan 
Next, you will assume the role of a public safety event planner who needs to develop a health 

and safety plan for an event. You are asked to use the Special Event Operations Map to 

create an operations map of public safety resources and conduct a high-level threat analysis. 

1. In a browser, go to the Special Event Operations Map app. 

Note: 

When the public safety event planner opens the email sent by the event organizer, the 
event identifier and the plan identifier fields are passed automatically to the Select 
Event widget and should not be edited. 

2. Click the Basemap widget and select Imagery. 

3. Click the Create Operations Map widget and search for PPE Station. 

4. Place a personal protective equipment (PPE) station on the map and enter details for the 
health and safety asset. 

5. Search for Hand washing Station, place it on the map, and enter details for the event 

asset. 

6. Repeat step 5 for each health and safety asset, route, and area you want to add to your 
operations map. 

7. Search for Road Blocks, place two on the map, and enter details for each of the road 

blocks. 

8. Click Save. 

9. Select Social Distancing Crowd Areas from the drop-down list at the top of the Create 
Operations Map widget. 

10. Draw an area on the map and double-click to complete the sketch. 

11. For Area name, type Vendor Area. 

The Area name value must be unique. 

12. For Max Capacity, type 100 and click Save. 
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Note: 

The area on the map will be labeled with the number of people who can safety enter an 
area of this size based on CDC social distancing guidelines. Adjust the maximum 
capacity or area size, if necessary. 

13. Select Crowd Estimates from the drop-down list at the top of the Create Operations 
Map widget. 

Note: 

Crowd estimation is determined by the Jacobs method. The high, medium, and low 
values of crowd estimation appear on the map. 

14. Draw an area on the map and double-click to complete the sketch. 

15. For Description, type Crowd Area for Concert. 

16. Click Save. 

17. Search for Medical Tent, place it on the map, and enter details for the event asset. 

18. Finally, search for On Foot, place three public safety resources on the map, and enter 

the following details for each resource: 

Parameter Value 

Point of Contact Type an officer's name. 

Point of Contact Phone Provide a unique phone number for each officer. 

Comments Type Public Safety support for Humane Shelter Event. 

19. After completing your health and safety operations map, click Save. 

 

Conduct high-level threat analysis (optional) 
The Special Event Operations Map includes a series of tools that can be used to define the 

impact of an incident (chemical or other threat) on event assets and resources. As you 

complete the health and safety plan, you may be asked to conduct a high-level threat analysis 

and identify the impact on your event operations plan. 

1. In a browser, go to the Special Event Operations Map app. 

2. Click the Gridded Reference Graphic widget to create a reference grid that can be used 
in large outdoor events. Define the location of the grid from a point or area. Click Create 
GRG. 

3. To identify the impact of a chemical incident and create a potential evacuation area, click 
the Emergency Response Guide widget. Select the location, material, and size of the 
accident along with the wind direction and time. Click Create Zones. 

4. Click the Threat Analysis widget to identify the impact of other threats. Select the 
location, type of threat, and size of the accident. Click Create Zones. 
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5. Finally, to identify the impact of an incident on event assets and resources, click the 
Situational Awareness widget. Select the location and the distance impacted, and click 
a location on the map. 

After using the Gridded Reference Graphic, Emergency Response Guide, or Threat 

Analysis widgets and publishing the derived layers, you can associate the layers with the 

event so they can be used in other event operations apps. 

6. Select a health and safety resource you added earlier and copy the event identifier. 

7. Click the Assign Event Identifier and select the features generated by the previously 
identified widgets. Enter the event identifier and click Save. 

 

Conduct health and safety operations 
The Special Event Permitting and Operations solution provides a complete set of capabilities 

that improve the efficiency and effectiveness of public safety personnel working at special 

events by enabling public safety personnel with tools to capture information from the field to 

share with commanders in a synthesized operational picture in real time. 

In this workflow, you'll learn how to use a collection of maps and apps to support incident 

commanders and site staff to visualize, monitor, and communicate real-time status during an 

event as well as visualize incident response after an event has occurred. 

 

Deploy event operations apps 
Public safety event planners and incident commanders need a unique set of maps and apps 

for each event. The unique maps and apps allow them to manage personnel assignments, 

activities, and incidents during an event and conduct after-action reviews that help them 

improve planning for future events. Each event requires the following: 

• Unique apps for incident commanders, firefighters and emergency medical technicians, 
law enforcement officers, event dispatchers, health and safety officers, cleaning staff, 
and site staff 

• The ability to monitor the location field personnel assigned to an event 

• An incident tracking and assignment system that can be used onsite at the event 

• Maps that show relevant event assets and public safety resources assigned to an event 

You will assume the role of a public safety event planner. You are asked to use the Special 

Event Operations Notebook to create a copy of the event operations apps for a unique event. 

Note: 

This workflow requires you to sign in to your ArcGIS organization, and the Special Event 
Permitting and Operations solution must be deployed. 

Note: 
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You must be assigned a role of Administrator or custom role which includes the privilege 
to Create and edit notebooks in order to run an ArcGIS Notebooks and complete the 
following steps. 

1. In a browser, go to the Special Event Operations Notebook and review the instructions 
provided with ArcGIS Notebooks. 

2. Click the Cell menu and click Run All. 

3. Under Select a Special Event to deploy Operations applications, click the Select an 
Event drop-down arrow, and choose your event. 

4. Click Deploy Special Event Operations. 

The creation of the event operations apps takes a few minutes to complete. 

5. When the progress bar is complete, click View Deployed Event Operations. 

  A collection of new event operations apps opens. 

 

Report activity and track locations from the field 
During an event, public safety staff and site staff collect field observations that are used to 

protect the health and safety of event attendees. In addition, the ability to quickly identify the 

location of field personnel is critical during the event. Dispatchers and incident commanders 

need to see a map with the location of their staff to determine who should respond to specific 

incidents. 

You will assume the role of a firefighter, emergency medical technician, or law enforcement 

officer who needs to report suspicious activity or a safety concern observed at the event. You 

are asked to use the Special Event Field Reporter map to report the suspicious activity or 

safety concern. Your location will also be tracked so dispatch has the ability to see resources 

as they receive calls. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open the app on your mobile device, and sign in to your organization. 

3. Tap {Event Name} Special Event Field Reporter to open it. 

4. Tap Add and tap Suspicious Activity. 

5. Fill in the following details: 

Parameter Value 

Description Select Suspicious Activity. 

Notes Type Backpack left at location with no owner to 
be seen for 20 minutes. 

Enter address, or generic 
description. 

Type Behind bbq vendor tent.. 

6. Optionally, add an image or picture. 

7. Locate the field report on the map. 
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8. Click Submit. 

 

Assign mobile personnel 
Public safety staff working at the event can use the mobile apps in the next steps to track their 

locations and collect field operations. To accomplish this, they will need a named user login 

and access to the applications utilized later in the workflow. The following steps will grant 

users access so they can utilize the apps and share their location. Note, before proceeding 

make sure all users have the ArcGIS account requirements for location tracking. 

1. In a browser, sign in to your ArcGIS organization and click the Apps button  in the 
header of the site. 

2. From the app launcher, click Workforce to open the app. 

3. Under Projects, hover over the {Event Name} Special Event Manager and click 
Configure. 

4. Click the Users tab. 

5. Follow the instructions to either manually add Mobile Workers or Add workers from a file. 

6. Optionally, add additional Dispatchers to the Workforce Project.  

Users added to the Workforce Project will now be able to open the Workforce app on 
their mobile device to receive assignments from the dispatcher as described later. 

7. When finished, return to your ArcGIS organization and click the Apps button  in the 
header of the site. 

8. From the app launcher, click Track Viewer to open the app. 

9. Under Projects, hover over the {Event Name}_trackview and click Configure. 

10. Click the Select to add mobile users dropdown. Under Workforce project (import 
workers), select {Event Name} Special Event Field Manager. 

11. Click Add. 

12. Optionally, add additional Track Viewers that can view the location of mobile personnel in 
the Command Center application described later. 

  Users added to the track view, will now be able to share their location when using the 
Field Maps app on their mobile device described later. Repeat the above process as you 
have additional personnel added to support the event. 

 

Manage field assignments 
It’s common for minor incidents such as traffic accidents, medical calls, or disorderly 

spectators to occur during a special event. Often these incidents are reported by radio or 911 

calls to a dispatcher in the event command center. 

Now, you will assume the role of an event dispatcher who needs to assign field reports or 

other incidents to field staff. You are asked to use the Special Event Command Center to 

assign the suspicious activity or safety concern to a firefighter, emergency medical technician, 

or law enforcement officer. 
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Note: 

This workflow requires you to be signed in to your ArcGIS organization and have the 
Special Event Permitting and Operations solution deployed. 

1. In a browser, go to the Special Event Command Centerand open it in a browser. 

2. Click Dispatch to create assignments. 

3. Click one of the listings for Assignment in the list. 

4. Click Edit. 

5. Validate the assignment type by looking at the Description and change the Assignment 
Type to the correct type (Suspicious Activity).  

6. Select Assign and choose a mobile worker from the drop-down menu. 

7. Click the Search bar and type an address or name of a special event asset such as a 
concession stand.  

8. Click Special Event Assets: 1 Result feature and click Create assignment. 

9. In the new assignment, fill in the following details: 

Parameter Value 

Assignment Type Select Medical Response. 

Assign Choose a mobile worker from the drop-down list. 

Description Type Citizen reporting heat exhaustion and has 
collapsed. 

Priority Choose High from the drop-down list. 

Due Date and 
Time 

Select a time on the same day of the event. 

10. Click Create Assignment. 

Field personnel can open the ArcGIS Workforce app on their mobile device and see their 
assignments. 

In many cases field personnel will be too busy to examine their assignments on their 
phone and communication will be done via radio. In this case, the dispatcher may want to 
close the assignments to take them off the active list. 

11. In the Special Event Command Center click Dispatch > Update Status. 

12. Click Freehand Polygon and draw a polygon to select some Assignments. 

13. In the Update Assignment Status  dialog change the Status to Completed. 

  This will mark the assignments as Closed and not appear as an active assignment for the 
field personnel to work. You will see the assignment status in the Dispatch console and 
dashboards later in the workflow. 
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Track cleaning and stocking status 
You will now assume the role of janitorial staff. You are asked to use the ArcGIS Field Maps 

mobile app to update the status of locations after you clean, disinfect, or restock them with 

PPE. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open the app on your mobile device and sign in to your ArcGIS organization. 

3. Choose Cleaning and Restocking Map. 

4. Choose a station for PPE Station, choose Cleaning and Restocking Status in the pop 
up, and click the Add button. 

Note: 

The space under the Add button displays all historical status records for a location, so 
as a station is restocked with PPE, a user can review this list to see when it was 
restocked and how much PPE it was restocked with. 

5. Choose status, choose Re-stocked, and add the number of boxes stocked of each PPE 
type. 

6. Choose Submit. 

 

Monitor event operations 
Incident commanders need real-time information on the location of incidents and staff as well 

as incoming weather and traffic information to make informed decisions during an event. The 

Special Event Operations Dashboard can be used in the command center on the day of the 

event. 

1. In a browser, go to the Special Event Operations gallery app. 

2. Click the name and date of your event Special Event Command Center. 

3. On the Monitor tab, Tracked Units, Units on assignment, and Last Known Locations 
provide up-to-date location information of staff and assignments. 

4. Click Open incidents within the last hour and choose an incident. 

5. Click the Post Locations dropdown under Monitor to see post location versus the actual 
location of staff. 

6. Click the Weather dropdown under Monitor to see real-time weather radar information. 

7. Click the Traffic dropdown under Monitor to see real-time traffic and road closure 
information. 

8. Click the Sanitation dropdown under Monitor to see real-time cleaning and restocking 
status for PPE stations, high-touch locations, and other health assets. 

9. Close the app. 
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Stormwater Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Stormwater Data Management 
Stormwater Data Management can be used to map stormwater assets, edit data, view system 

maps in the field and office, view asset reports, and collaborate with map notes. 

It turns ArcGIS into a system for stormwater organizations to easily inventory their assets and 

keep information up to date. It provides simple to use interactive system maps and 

dashboards for office and field staff, and increases collaboration. 

After deploying, organizations with no stormwater data can immediately begin mapping their 

stormwater systems using GPS or digitizing data with web or desktop software. Organizations 

with existing spatial stormwater data can load it and begin using the apps. 

 

Requirements 
Stormwater Data Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 3.0 or later (Basic, Standard, or Advanced) 

• ArcGIS Field Maps 
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Information products 
Stormwater Data Management includes the following information products: 

Item Description Minimum user type 

Stormwater Data 
Manager 

An ArcGIS Pro project package used to 
manage stormwater system data and map 
notes 

GIS Professional 
(Basic, Standard, or 
Advanced) 

Stormwater 
Editor 

An ArcGIS Web AppBuilder application used 
to edit stormwater system data and map notes 

Editor 

Stormwater 
Viewer 

An ArcGIS Web AppBuilder application used 
to view stormwater map and create map notes 

Editor 

Stormwater 
Dashboard 

An ArcGIS Dashboards application used to 
view stormwater asset information 

Viewer 

Stormwater Map 
Notes Manager 

An ArcGIS Web AppBuilder application used 
to review and manage map notes 

Editor 

Stormwater 
Mobile Viewer 

A map used in ArcGIS Field Maps view 
stormwater system assets to view stormwater 
system assets and view or create map notes 

Mobile Worker 

Stormwater 
Asset Collector  

A map used in ArcGIS Field Maps to capture 
and modify stormwater assets and create map 
notes from the field 

Mobile Worker 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • An update to the StormwaterSystem feature layer to support the Catch Basin 
and Outlet Inspections solution. 

1.3 • The Minimal Gallery app has been removed from the solution item. 

1.2 • An update to the StormwaterSystem feature layer to support the Adopt-A-
Catch Basin solution. 

1.1 • Name changed from Stormwater Data Management for ArcGIS Online to 
Stormwater Data Management. 

1.0 • First release of Stormwater Data Management for ArcGIS Online 
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Configure Stormwater Data Management 
The Stormwater Data Management solution can be configured to meet specific needs in your 

organization. The sections below outline some administrative tasks to update and manage the 

solution to fit your organization's needs. 

 

Load data 
In some cases, you may need to load existing data into the solution before sharing the maps 

or applications. Review the maps or applications provided with the solution and determine 

what, if any, source data you want to load. Stormwater Data Management also includes a data 

model to store information about typical storm water system assets. To explore the schema, 

view the data dictionary. 

Tip: 

If you have to load data into the solution, you may want to develop a source-target matrix 
to track how your source data will be loaded into the target layer or layers used in the 
solution. 

Depending on the format of your source data, you may choose to append your source data to 

the new layers. Once you have determined what source data must be loaded, complete one of 

the data loading workflows below: 

 

Use the Append tool 
In ArcGIS Pro, the Append tool can be used to append multiple input datasets to an existing 

target dataset. Input datasets can be tables; rasters; or point, line, polygon, annotations, or 

dimensions feature classes. 

To append features to the target layer or layers using the Append  tool, complete the steps 

below: 

1. In ArcGIS Pro, sign in to your ArcGIS organization. 

2. To open the Stormwater Data Manager project, click Open another project, click My 
Content under Portal, double-click the Stormwater Data Management folder, and click 
Stormwater Data Manager. 

3. Add your existing source layers to a new map. To add the target feature layers from the 
StormwaterSystem feature service, click My Content under Portal, double-click the 
Stormwater Data Management folder, and add the StormwaterSystem feature service 
to the map. 

4. On the Analysis tab, in the Geoprocessing group, click Tools to open the 
Geoprocessing pane. 

5. In the search bar, type Append and click to open the Append tool. 

6. Add your existing storm water data from the map to the Input Datasets parameter. 
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7. For Target Datasets, use the StormwaterSystem features in the map. 

8. In the Schema Type parameter, use the drop-down menu to choose Use the Field Map 
to reconcile schema differences to perform field mapping. 

9. Update your field mapping and click Run. 

10. Repeat this process as needed to load all your existing data into the target storm water 
schema. 

 

Use the Data Loading Tools 
The Data Loading toolbox can be used in ArcGIS Pro to streamline loading data from a source 

to a target dataset and provide the ability to perform in-process data transformation. Setup the 

Data Loading toolbox before getting started with the steps below. 

1. In ArcGIS Pro, open the Stormwater Data Manager project and sign in to your ArcGIS 
organization. 

2. On the Project tab, click Package Manager. 

3. In the upper right corner, click the Environment Manager button. 

4. Click the Clone environment button  on the row representing the environment you 

want to clone. Alternatively, click the Clone arcgispro-py3 button  to clone the default 
environment.  

The Clone Environment dialog box appears. 

5. Select your newly cloned environment and click OK. 

Cloning an environment may take several minutes. You can close the Clone 
Environment dialog box while you wait. You can monitor progress in the Tasks section 
of the Package Manager page. 

6. In the Python Package Manager, click Add Packages to see the Python packages 
available for installation. 

7. In the Search box, type dltsolutions to find the Data Loading toolbox. 

8. Select the dltsolutions package and click the drop-down arrow to update the version. 

9. Click Install to open the Install Package dialog box. 

10. Review the terms and conditions and check the check box to agree. 

11. Click Install to install the package. 

12. Once complete, close ArcGIS Pro.  

The Data Loading toolbox is now installed. The next time you start ArcGIS Pro, you can 
access it from the list of geoprocessing toolboxes. 

13. Review An overview of the Data Loading toolbox to learn more about the tools and how 
to use them to load data into the StormwaterSystem layers. 
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Configure the Stormwater Data Manager ArcGIS Pro 

project 
The Stormwater Data Manager project includes a Stormwater Data Manager map with broken 

links. 

1. Sign in to your ArcGIS organization and browse to the Stormwater Data Manager item. 

2. From the item page, click Download. 

3. Unzip and open the downloaded Stormwater Data Manager ArcGIS Pro project. 

 

1. In ArcGIS Pro, sign in to your ArcGIS organization. 

2. Click 

3. To open the Stormwater Data Manager project, click Project > Open > Open another 
project.  

4. Under Portal, click My Content, double-click the Stormwater Data Management folder, 
and click Stormwater Data Manager to open the map. 

5. In the Catalog pane, expand Maps and double-click Stormwater Data Manager to open 
the map. 

6. In the Contents pane, click the red exclamation point  next to the Map Notes layer. 

The Change Data Source dialog box appears. 

7. Click My Content under Portal, double-click the Stormwater Data Management folder, 
double-click the StormwaterMapNotes_managing feature service, and double-click the 
Map Notes layer.  

8. In the Contents pane, click the red exclamation point  next to the Manhole layer. 

The Change Data Source dialog box appears. 

9. Click My Content under Portal, double-click the Stormwater Data Management folder, 
double-click the StormwaterSystem_editing feature service, and double-click the 
Manhole layer. 

Once you have repaired the data layers, you will need to update the coordinate system of 
the map to match your layers. 

10. In the Contents pane, right-click the Stormwater Data Manager map and click 
Properties. 

11. Click the Coordinate Systems tab. In the XY Coordinate Systems Available section, 
select the coordinate system that matches the layers in the map. 

Note: 

Ensure that the coordinate system of the map matches that of the feature layers 
deployed in the solution. If these do not match, there may be discrepancies in which 
units are displayed in the map. 

12. Click Save to save the project. 
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Add members to groups in your organization 
Included with Stormwater Data Management are four groups designed to help managers 

organize their members based on their privileges and their work. The solution includes the 

following groups: Stormwater Editors, Stormwater Field Users, Stormwater Map Notes 

Managers, and Stormwater Office Users. 

To add members to the groups, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization. 

Confirm that you have privileges to manage member groups before continuing. 

2. Click Groups at the top of the site. 

3. Click the name of the group to open the group details pages. 

4. On the Settings tab, edit and update the properties of the group, including access, 
sharing properties, and group ownership. 

5. Click the Overview tab and click Invite users.  

6. Select the members you want to add and click Add to group. 

7. Repeat steps 3 through 6 for each group you need to add members to. 

The provided groups are intended to be used by members with a minimum of the following 

user types to fully use the provided maps and apps: 

Group name User type 

Stormwater Editors • Editor 

• GIS Professional Basic with ArcGIS Pro (minimum of one 
license recommended) 

Stormwater Field Users • Mobile Worker 

Stormwater Map Notes 
Managers 

• Editor 

Stormwater Office Users • Editor 

 

Set the default map extent to your service territory 
When the Stormwater Data Management solution is deployed to your organization, it uses the 

map default set in your organization. If this property has not been set, you may want to quickly 

update a few maps and apps to your service territory manually to avoid having to pan and 

zoom to your area each time you open a map. Complete the following steps to update the 

initial extent of the maps and apps provided with this solution: 

1. In a browser, sign in to your ArcGIS organization. 

2. To set the default map extent for the Stormwater Viewer application, browse to the 
Stormwater Viewer item page and click Edit Application. 

3. On the Map tab, zoom the map to the desired extent and click Use current map view 
under Set initial extent. Click Save. 
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4. Repeat steps 2 and 3 to set the default map extent for the Stormwater Editor and 
Stormwater Map Notes Manager applications. 

5. To set the default map extent for the Stormwater Asset Collector map, open the 
Stormwater Asset Collector map. 

6. Zoom the map to the desired extent and save it. 

7. Repeat steps 5 and 6 for the Stormwater Mobile Viewer map. 

 

Configure the dashboard 
When you deploy the Stormwater Data Management solution to your organization, you have 

the option to change the spatial reference. If you selected a spatial reference with a linear unit 

other than meters, you will need to revise the dashboard by completing the following steps: 

1. In a browser, sign in to your ArcGIS organization. 

2. To set the default map extent for the Stormwater Dashboard application, browse to the 
Stormwater Dashboard item page and click Edit Dashboard. 

3. Browse to the General tab and click the configure button  on the Miles of Open 
Channel indicator. 

4. On the Data tab, change the Factor setting to the correct conversion. 

The dashboard Factor setting is configured to convert meters to miles. Learn more about 
how to Convert Values. 

5. Update the Statistic field to Sum and Field to Shape_Length to display miles of 

channels.  

6. Repeat steps 3 and 4 for the Miles of Pipe indicator. 

7. Click Done and click Save . 

 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://enterprise.arcgis.com/en/dashboards/11.0/get-started/convert-values.htm


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 759 

Use Stormwater Data Management 
The Stormwater Data Management solution can be used by staff to collect and manage 

stormwater system information. This solution allows a stormwater utility to obtain information 

about the current state of their system. These workflows are intended for editors, mobile 

workers, and managers who want to use the maps and apps to manage their utility data. You 

will learn how to use the Stormwater Data Management solution to add new assets from the 

field, manage stormwater data in the web and desktop, and view and interact with a 

dashboard to find key statistics about your system. 

Add data in the field 
In these workflows, you will be taking the role of a mobile worker collecting data in the field. If 

you have a mobile-centric workforce, this may be the best option to collect new data or 

validate existing data. 

Collect manholes and pipes 
As a mobile worker, you can add manholes and gravity pipes using ArcGIS Field Maps in the 

field. 

1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Stormwater Asset Collector  map. 

3. Browse to the collection location. 

4. Tap Add .  

5. From the list of features, search for Manhole by swiping up or typing manhole in the filter 

search bar. 

If the manhole is added to an inaccurate location, or you want to move the point 
manually, move the cross hairs to the correct location by panning the map and tapping 
Update Point. This moves the added manhole to the specified location. 

6. Fill in any attributes and tap Submit. 

Note: 

Move to a safe location to fill in the attributes. The added manhole remains in its 
original location. 

7. Ensure the last collected manhole is selected and browse to the next manhole's location. 
Tap the Copy button at the bottom of the screen to create a copy of the previously added 
manhole at the location of the new manhole. 

8. Adjust any attributes as needed. Next, add the pipes to connect the manholes. 

9. Tap Add .  

10. Search for Gravity by swiping up or typing gravity in the filter search bar. 

11. Pan the map until the crosshairs snap to the manhole. An orange point appears when it 
is within a tolerance to snap.  
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12. Tap the Add Point button to snap Gravity to the manhole. 

13. Pan to the second manhole and tap the Add Point button. 

14. Update the attributes and tap Submit to complete the sketch. 

 

Collect a catch basin 
As a mobile worker, you can collect catch basins of type sediment trap using ArcGIS Field 

Maps in the field. 

1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Stormwater Asset Collector map. 
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3. Browse to the collection location. 

4. Tap Add .  

5. From the list of features, search for Sediment Trap under Catch Basin by swiping up to 
view all the options or typing Sediment Trap in the filter search bar, and selecting 

Sediment Trap. 

If the sediment trap is added to an inaccurate location, or you want to move the point 

manually, move the crosshairs to the correct location by panning the map and tapping Update 

Point. The added sediment trap moves to the specified location.  

6. Fill in any attributes and tap Submit. 

7. If you want to continue to collect the same type of catch basin, ensure the last collected 
sediment trap is selected and browse to the next sediment trap location. Tap the Copy 
button at the bottom of the screen to copy the previously added point to the location of 
the new sediment trap. 

8. Adjust the attributes and tap Submit. 

 

Collect an outfall 
As a mobile worker, you can collect an outfall location in the field using ArcGIS Field Maps. 

1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Stormwater Asset Collector  map. 

3. Browse to the collection location. 

4. Tap Add .  

5. From the list of features, search for Pipe Outlet under Outlet by swiping up to view all 
the options or by typing Pipe Outlet in the filter search bar. 

If the pipe outlet is added to an inaccurate location, or you want to move the point manually, 

move the crosshairs to the correct location by panning the map and tapping Update Point. 

The added pipe outlet moves to the specified location. 

6. Swipe up to expand the attributes and make sure to set the field Outfall to Yes to 

designate this outlet as an outfall. Populate the Outfall ID field and any other attributes 

and tap Submit.  
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When an outlet is designated as an outfall, the symbology will change to include an 
orange halo around the point and the label will update to use the Outfall ID field instead 
of the Asset ID. These updates are made using ArcGIS Arcade. 
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7. If you want to continue to collect the same type of outfall, ensure the last collected outfall 
is selected and browse to the next location. Tap the Copy button at the bottom of the 
screen to copy the previously added point to the location of the new outfall. 

8. Adjust the attributes and tap Submit. 

 

Collect a BMP boundary 
As a mobile worker, you can collect BMP Boundary by collecting points and adjusting the 

boundary using ArcGIS Field Maps in the field. 

1. Open the ArcGIS Field Maps app and verify you are signed in to your ArcGIS 
organization. 

2. Open the Stormwater Asset Collector  map. 

3. Browse to the collection location. 

4. Tap Add .  

5. From the list of features, search for BMP Boundary by swiping up or typing in the search 
bar. 

A point is added to your location. 

If the starting point is added to an inaccurate location, or you want to move the point manually, 

move the crosshairs to the correct location by panning the map and tapping Update Point. 

The added starting point moves to the specified location. 

6. Collect or add the necessary points by tapping Add Point to outline the boundary.  
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7.  Fill in any attributes and tap Submit.  

 

Collect BMP boundary by streaming 
As a mobile worker, you can collect boundaries by collecting points and adjusting the 

boundary using ArcGIS Field Maps in the field. 

1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Stormwater Asset Collector  map. 

3. Browse to the collection location. 

4. Tap Add .  
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5. From the list of features, search for BMP Boundary by swiping up or typing in the search 
bar. 

A point is added to your location. 

6. Once the starting point is in the correct location, tap the options button and select Start 
Streaming. 

7. Walk the perimeter of the boundary until you get to a desired ending location. 

8. Tap Stop Streaming.  

9. Fill in any attributes and tap Submit. 

 

Add map notes 
As a mobile worker, you can add a map note to the system. 

1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Stormwater Asset Collector  map. 

3. Browse to the map note location. 

4. Tap Add.  

5. From the list of features, search for the Map Notes type by swiping or typing a 
description in the filter search bar, select the Map Notes type, and add the note to the 
map by sketching a polygon in the map note location. 

6. Fill in the attributes and click Submit.  

  The map note is added to the map and is available to be viewed and reviewed by others 
in the organization. 

 

Add data in the web 
In the workflows below, you will be taking the role of an editor adding data in ArcGIS Online. 

The workflows explain how to add data in the web, use the provided dashboard, and add and 

manage map notes. 

 

Add pipes to connect features 
As an editor, you want to use a web app to connect features with pipes. 

1. In a browser, sign in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Stormwater Editors group and locate the Stormwater Editor app. Click 
View Application to launch the app. 

In the Stormwater Editor app, the Asset Editor widget is open by default on the left side 
of the window when the app opens. 

4. In the Asset Editor pane, click the template drop-down menu and select Pipe, and 
choose Gravity from the list of options. 
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5. Scroll down and fill in the preset values. 

6. With Gravity selected, press Ctrl to snap to a manhole by hovering over the point and 
clicking to start drawing.  

 

7. Draw a line from the first manhole to the next, press Ctrl to snap, and double-click to 
finish the sketch. 

You are prompted to update attributes and save. 

8. Click Save. 

9. Continue adding pipes between the manholes. 

  The template and preset attributes remain selected so you can continue adding pipes. 

 

Add an outfall and gravity pipe 
As an editor, you want to use a web app to add a new outfall and gravity pipe. 

1. Verify you are signed in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Stormwater Editors group and locate the Stormwater Editor app. Click 
View Application to launch the app. 

In the Stormwater Editor app, the Asset Editor widget is open by default on the left side 
of the window when the app opens. 

4. In the Asset Editor pane, click the template drop-down menu and select Outlet, and 
choose Pipe Outlet from the list of options. 

5. Scroll down and fill in the preset values. 

6. With Pipe Outlet selected, click to add it to the map. 
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7. In the attributes panel, set the Outfall field to Yes to designate this outlet as an outfall. 

Populate the Outfall ID field and any other attributes and click Save. 

 

When an outlet is designated as an outfall, the symbology will update to include an 
orange halo around the point and the label will update to use the Outfall ID field instead 
of the Asset ID field. These updates are made using ArcGIS Arcade. 

8. In the Asset Editor pane, click the template drop-down menu and select Pipe, and 
choose Gravity from the list of options. 

9. With Gravity selected, press Ctrl to snap to a the outfall by hovering over the point and 
clicking to start drawing. 

10. Draw a line from the outfall to the drop inlet, press Ctrl to snap, and double-click to finish 
the sketch. 

11. Click Save. 

12. Continue adding outfalls and gravity pipes by repeating steps 4-11. 

 

Add a BMP Boundary 
As a user, you can add a BMP Boundary to a system. 

1. Verify you are signed in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Stormwater Editors group and locate the Stormwater Editor app. 

In the Stormwater Editor app, the Asset Editor widget is open by default on the left side 
of the window when the app opens. 

4. In the Asset Editor pane, click the template drop-down menu and select BMP Boundary 
from the list, and select BMP Boundary. 

5. Scroll down and fill in the preset values if applicable. 

6. Sketch a polygon in the desired boundary location.  
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7. Enter the remaining attributes and click Save. 

 

Add map notes 
As a user, you can add a map note to the system. 

1. Verify you are signed in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Stormwater Office Users group and locate the Stormwater Viewer app. 
Click View Application to launch the app.  
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a. In the Stormwater Viewer, click the Map Notes Editor widget to open. 

b. Choose a map note issue type and sketch a polygon in the desired location. 

c. Enter attributes and click Save. 

 

Manage map notes 
As a GIS manager, you can review and resolve map notes about your system to ensure 

issues are being addressed. 

1. Verify you are signed in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Stormwater Map Notes Managers group and locate the Stormwater 
Map Notes Manager app. Click View Application to launch the app. 

In the upper right of the app, there are a number of widgets that have been configured to 
filter, edit, update, and manage map notes. 

4. Review the list of included widgets to learn how to use them to manage map notes: 

• Legend—View a list of included layers in the map. The legend displays what is 
visible on the map, so zooming in or out can expand or reduce the list if scale 
suppression is set on the layers. 

• Filter—Use the Creation Date, Issue, and Severity filters to view only map notes 
that fit the entered criteria. Select a date range or an option from the drop-drown 
menu and turn on a filter to view the selection on the map. 
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• Batch Edit Map Notes—Select a group of map notes using one of the selection 
tools and update values for all the selected features at once. 

• Map Notes Editor—Add a new map note or edit an existing map note. 

• Map Notes Summary—View all the map notes by status and expand each 
section to view the individual notes. Click a note to zoom to it on the map and 
view its attributes in a pop-up. 

  These changes are reflected in other apps and maps across the system so others in your 
organization can view the latest information. 

 

Use the stormwater dashboard 
As a member of the utility, you want to have a comprehensive view of your stormwater system 

assets. 

1. Verify you are signed in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Stormwater Office Users group and locate the Stormwater Dashboard 
app. Click View Dashboard to launch the dashboard. 

4. View the stormwater system statistics on the General tab, click the Pipe tab to view the 
pipe details, and click the BMP tab to view the BMP details. 

 

Add data in ArcGIS Pro 
In the workflows below, you will be taking the role of an editor adding data in ArcGIS Pro. If 

you have known locations of assets or as-built drawings to work from, the following workflows 

can demonstrate using ArcGIS Pro to add data to your stormwater system. 

Note: 

The first time you open the Stormwater Data Manager map in ArcGIS Pro, the layers will 
show as broken. Follow the steps to Configure the Stormwater Data Manager ArcGIS Pro 
project to fix your layers. 

 

Add manholes and pipes 
As an editor, you can add manholes and pipes to the map in ArcGIS Pro. If you already have 

manholes, you can complete steps 8 through 10 to add pipes between the manholes. 

1. Open the Stormwater Data Manager ArcGIS Pro project and sign in to your ArcGIS 
organization. 

2. In the Catalog pane, expand Maps and double-click Stormwater Data Manager to open 
the map. 

3. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

4. On the Edit tab, in the Features group, click Create. 
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The Create Features pane appears. 

5. Select the Manhole template from the Templates list, fill in the attributes, and add the 
manhole to the map. 

6. On the Map tab, in the Selection group, click Attributes and fill in the remaining 
attributes.  

 

7. Repeat steps 4 through 6 to add the remaining manholes to the map. 

8. Select the Pipe: Gravity template from the Templates list and fill in the attributes. 

As a best practice, digitize in the direction that wastewater flows. 

9. Snap and click the start of the line to the first manhole to begin digitizing the pipe. Snap 
to the next manhole and double-click to complete the sketch. 

10. Open the Attributes pane and fill in the remaining attributes. 

11. Repeat steps 8 through 10 to draw in the remaining pipes between the rest of the 
manholes. 

 

Add catch basins 
As an editor, you can add gravity pipes to the map in ArcGIS Pro. 

1. Open the Stormwater Data Manager ArcGIS Pro project and verify that you are signed 
in to your ArcGIS organization. 

2. In the Catalog pane, expand Maps and double-click Stormwater Data Manager to open 
the map. 

3. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

4. On the Edit tab, in the Features group, click Create. 
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The Create Features pane appears. 

5. Select the Catch Basin: Sediment Trap group template from the Templates list and fill 
in the attributes.  

 

6. Add Sediment Trap to the map.  

7. On the Map tab, in the Selection group, click Attributes and fill in the remaining 
attributes. 

8. Select the Pipes: Gravity template from the Templates list and fill in the attributes. 

9. Snap the end of the gravity pipe from the sediment trap to the to the primary gravity pipe.  

 

10. Open the Attributes pane and fill in the remaining attributes. 

 

Add a BMP boundary 
As an editor, you can add a BMP Boundary to the system. 

1. Open the Stormwater Data Manager ArcGIS Pro project and verify you are signed in to 
your ArcGIS organization. 
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2. In the Catalog pane, expand Maps and double-click Stormwater Data Manager to open 
the map. 

3. On the Edit tab, in the Features group, click Create. 

The Create Features pane appears. 

4. Choose the BMP Boundary with centroid BMP Point template and fill in the attributes. 

5. Add the boundary by digitizing a polygon on the map at the desired location. 

6. On the Map tab, in the Selection group, click Attributes and fill in the attributes for both 
the polygon and point feature added to the map. 

  The boundary is added to the map and is available to be viewed and reviewed by others 
in the organization. 

 

Add features from an as-built drawing 
As an editor, you can add assets such as manholes to the system from an as-built drawing. 

1. After receiving the Stormwater Data Manager editing ArcGIS Pro project, sign in to your 
ArcGIS organization. 

2. In the Catalog pane, expand Maps and double-click Stormwater Data Manager to open 
the map. 

3. On the Map tab, in the Layers group, click Add Data. Browse to the location of the as-
built drawing, select it, and click OK to add it to the map. 

4. With the image selected in the Contents pane, browse to the Raster Layer ribbon. On 
the Appearance tab, in the Effects group, change the Layer Transparency setting to 
50%. 

5. On the Imagery tab, in the Alignment group, select Georeferencing. 

If you are unfamiliar with georeferencing, review Overview of georeferencing in the 
ArcGIS Pro help. 

6. On the Georeferencing tab, in the Adjust group, click Add Control Points. 

a. Add a minimum of two control points to connect your image to your known map 
positions. 

b. Once you have added all the control points, browse to the Georeferencing tab and 
click Save. 

7. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

8. On the Edit tab, in the Features group, click Create. 

The Create Features pane appears. 

9. Select an asset from the template list and add the asset to the map where it corresponds 
to the georeferenced as-built drawing. 

10. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

11. Remove the image from the Contents pane once digitizing is complete. 
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Add map notes 
As an editor, you can add a map note to the system. 

1. Open the Stormwater Data Manager ArcGIS Pro project and verify that you are signed 
in to your ArcGIS organization. 

2. In the Catalog pane, expand Maps and double-click Stormwater Data Manager to open 
the map. 

3. On the Edit tab, in the Features group, click Create. 

The Create Features pane appears. 

4. In the Template list, expand the Map Notes folder and choose a Map Note option. Add 
the map note by digitizing a polygon on the map at the desired location. 

5. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

  The map note is added to the map and is available to be viewed and reviewed by others 
in the organization. 
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Target Hazard Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Target Hazard Analysis 
Target Hazard Analysis can be used to identify properties and buildings that could result in a 

loss of life, or have a negative impact on the community, if a fire were to occur. 

Many fire departments are taking proactive steps to assess risk and mitigate the impact of a 

fire in their community. The first step in this risk assessment is the identification of buildings or 

properties that may harm the community if a fire were to occur. Occupancy, size, life safety 

and economic impact are some of the criteria used to assess the risk of a building or property. 

Understanding risk can be a time consuming process and reducing the time it takes to 

conduct an assessment saves fire departments money. It also allows them to evaluate their 

community on a regular basis and measure the effectiveness of mitigation strategies. Target 

Hazard Analysis is typically implemented by fire departments that want to understand risk in 

their community and use the assessment to prioritize preplanning activities, fire inspections 

and other community risk activities. 

The Target Hazard Analysis solution delivers a set of capabilities that help you calculate a 

hazard score for each building or property and understand where a fire may negatively impact 

a community. 

 

Requirements 
Target Hazard Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.9 or later (Basic, Standard or Advanced) 
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Information products 
Target Hazard Analysis includes the following information products. 

Item Description Minimum user 
type 

Target 
Hazard 
Analysis 

An ArcGIS Pro project package used by fire service 
personnel to identify properties and buildings that could 
result in a loss of life, or have a negative impact on the 
community, if a fire were to occur. 

GIS 
Professional 
Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • An update to the Target Hazard Analysis ArcGIS Pro project which simplifies 
the workflow, includes National Fire Incident Reporting System (NFIRS) 
occupancy standards, and criteria guidance. 

1.0 First release of Target Hazard Analysis 
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Use Target Hazard Analysis 
The Target Hazard Analysis solution delivers a set of capabilities to calculate a hazard score 

for each building or property and understand where a fire may negatively impact a community. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Getting to know Target Hazard Analysis 
Target Hazard Analysis includes a set of tasks to help you get familiar with the project, 

prepare your data and analyze target hazards. Some of the tasks include steps that use 

python scripts included in the Target Hazard Analysis toolbox. As you step through each task 

in the workflow, the scripts will be executed to conduct the analysis. 

Target Hazard Analysis is conducted on your building polygons to identify those buildings that 

could result in a loss of life, or have a negative impact on the community, if a fire were to 

occur. The building polygons must have certain attributes to conduct the analysis and 

determine the level of risk for each building. The Getting to Know Target Hazard Analysis task 

group includes an explanation of the data requirements, target hazard methodology and a 

review of the data provided in the project 

To learn more about the data required and methodology used in Target Hazard Analysis, 

follow these steps: 

1. Sign in to your ArcGIS organization and browse to the Target Hazard Analysis Desktop 
Application Template. 

2. Open the item page and click Download. 

3. Unzip and open the Target Hazard Analysis ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Target Hazard 
Analysis task item. 

6. In the Task Pane, click the Getting to know Target Hazard Analysis task group to 
expand the collection of tasks. 

7. Open each task and follow the step provided. 

 

Prepare your data for analysis 
This task workflow allows you to prepare the target hazard layer using your building data 

before conducting the analysis. It allows you to set the target hazard analysis geodatabase 

provided in the project to your spatial coordinate system and load your building data into the 

target hazard layer. This layer has all the pre-defined fields that are necessary for conducting 

target hazard analysis. Your building layer may contain small buildings such as garages or 

sheds that you do not want to include in the analysis. An optional task is provided to allow you 

to remove the small buildings from the target hazard layer. Similarly, you may not want to 

include single-family homes in the target hazard analysis. Removing those buildings would 
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allow you to focus on the high-occupancy buildings to determine risk areas in your community 

and greatly reduce the size of the target hazard layer. An optional task is provided to remove 

the single-family homes from the target hazard layer. 

You will assume the role of a fire data analyst responsible for preparing your target hazard 

layer for analysis. The Target Hazard Analysis ArcGIS Pro project includes a series of tasks to 

help guide you through this workflow. 

1. Open the Target Hazard Analysis ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Target Hazard 
Analysis task item. 

4. In the Task Pane, click the Prepare data for analysis task group to expand the 
collection of tasks. 

5. Click on each task and follow the steps provided. 

 

Analyze target hazard data 
When the data preparation on the target hazard layer is completed, the analysis can begin. 

This task group contains tasks with a series of steps to conduct the analysis using the building 

data that was loaded into the target hazard layer. These steps will allow you to assign the 

hazard criteria from the occupancy type and life safety type categories, calculate the hazard 

scores for each building, review the results and symbolize them by the total hazard score. 

A task is provided to share the results of the analysis as a web layer to your organization so 

non-GIS users can view the risks. In addition, a step is provided to export the results to a file 

geodatabase which can be incorporated into other information products such as Pre-Incident 

Planning or conduct further analysis such as Critical Task Analysis and Community Risk 

Assessment. 

You will assume the role of a fire data analyst responsible for conducting a target hazard 

analysis on all buildings in your community. The Target Hazard Analysis ArcGIS Pro project 

includes a series of tasks to help guide you through this workflow. 

1. Open the Target Hazard Analysis ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Target Hazard 
Analysis task item. 

4. In the Task Pane, click the Analyze target hazard data task group to expand the 
collection of tasks. 

5. Click on each task and follow the steps provided. 
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Tax Reverted Property 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

  

Introduction to Tax Reverted Property 
Tax Reverted Property can be used to collect delinquent tax property information and market 

properties available for sale to land development companies, real estate professionals, and 

the general public. 

It provides treasurer staff with a digital process that streamlines property posting and replaces 

newspaper-based tax sale processes that help in the recovery of back taxes, interest, and 

penalties. This approach helps government agencies more efficiently document delinquent 

property and return them to tax-producing ones. Tax Reverted Property is typically 

implemented by treasurer and tax collection agencies that want to improve the overall process 

for recovering property tax revenue. 

The Tax Reverted Property solution delivers a set of capabilities that help you improve the 

collection of delinquent property information, document tax-delinquent properties, and market 

properties during a property tax sale. 

 

Requirements 
Tax Reverted Property requires the following: 

• ArcGIS Enterprise 

• ArcGIS Field Maps 
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Information products 
Tax Reverted Property includes the following information products: 

Item Description Minimum 
user type 

Tax Reverted 
Property 

A map used by treasurer's office staff to collect 
delinquent tax property information 

Editor 

Tax Reverted 
Property 
Dashboard 

An ArcGIS Dashboards app used by treasurer's office 
staff to monitor tax-reverted property field work 

Viewer 

Tax Sale An ArcGIS Web AppBuilder app used by the general 
public, land development companies, and real estate 
professionals to locate tax reverted properties sold at 
auction 

Not 
Required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Tax Reverted Property 
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Use Tax Reverted Property 
The Tax Reverted Property solution delivers a set of capabilities that help you improve the 

collection of delinquent property information, document tax-delinquent properties, and market 

properties during a property tax sale. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

Collect and monitor tax-reverted properties 
Code Enforcement Operations can be used to collect delinquent property information, 

document tax-delinquent properties, and market properties during a property tax sale. 

 

Collect tax-reverted property information 
You will start by assuming the role of a treasurer staff member responsible for verifying a tax-

reverted property. You are asked to use Tax Reverted Property to visit a tax-delinquent 

property in the field and verify the details. 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Tap Tax Reverted Property to open the map. 

3. Search for an address, and then in the results list, tap the address to zoom to that 
location on the map. 

4. Tap the plus sign or tap Collect Here to open the survey form. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

5. Tap Not Posted or Posted as needed. 

6. Complete the survey with as much information as possible. 

7. Optionally, attach a property photograph. 

8. At the upper right, tap the check mark or tap Submit to submit the survey. 

 

Monitor a tax-reverted property posting 
Next, you will assume the role of a tax collection administrator responsible for reviewing the 

status of the tax-reverted property fieldwork. You are asked to use the Tax Reverted Property 

Dashboard app to monitor the collection and posting progress. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Tax Reverted 
Property solution. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 783 

2. View the Tax Reverted Property Dashboard app. 

On the right, in the Delinquent Properties panel, all tax-delinquent properties are listed. 

3. Review the number of properties that have been posted. 

4. On the left, use filters to refine the results by status or date. 

5. Click a specific tax-delinquent property to review the parcel information, property 
information, and tax information. 

 

Find a property for sale 
Finally, you will assume the role of a real estate agent who wants to attend a property tax 

auction for the purposes of buying land. You use the Tax Sale app to find a property that fits 

the needs of your client. 

1. In a browser, from the Tax Reverted Property solution, view the Tax Sale app. 

2. Search for a parcel number or address. 

3. Click a specific property to review the property, structure, and tax information. 
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Traffic Crash Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Traffic Crash Analysis 
Traffic Crash Analysis can be used to analyze crash data and identify streets and 

intersections where concentrations of serious and fatal crashes occur. 

Safety is one of the most important factors to consider when evaluating a road network. 

Analyzing crashes that occur at intersections and along roadways to determine where a high 

percentage of serious injury and fatalities occur is a key aspect of the safety evaluation. The 

result of this analysis is generally referred to as a High Injury Network (HIN). It helps inform 

engineering, education, and enforcement decisions and also serves as the foundation for 

Complete Streets or Vision Zero initiatives adopted to reduce fatalities or serious injury on 

roadways in the community. Traffic Crash Analysis is typically implemented by transportation, 

public works, and public safety agencies that want to use data-driven strategies to improve 

safety along the transportation network. 

The Traffic Crash Analysis solution delivers a set of capabilities that help you to analyze crash 

data using methodologies defined by the United States Road Assessment Program (usRAP) 

and the Federal Highway Administration (FHWA), identify locations where concentrations of 

serious injury and fatal crashes occur, and share the results with decision makers and the 

public. 

 

Requirements 
Traffic Crash Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Advanced) 
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Information products 
Traffic Crash Analysis includes the following information products: 

Item Description Minimum user type 

Crash Analysis An ArcGIS Pro project used by transportation, 
public works, and public safety staff to analyze 
crash data and identify streets and intersections 
where concentrations of serious and fatal 
crashes occur. 

GIS Professional 
Basic 

Fatal and 
Serious Injury 
Dashboard 

An ArcGIS Experience Builder app used by the 
public and other interested stakeholders to locate 
traffic crashes that resulted in serious injury or 
fatality to motorists, cyclists, or pedestrians. 

Viewer (required if 
dashboard is used for 
internal purposes 
only) 

High Injury 
Network 
Locator 

A Nearby app used by the public and other 
interested stakeholders to locate streets and 
intersections where concentrations of serious 
and fatal traffic crashes occur. 

Viewer (required if 
app is used for 
internal purposes 
only) 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Traffic Crash Analysis 
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Configure Traffic Crash Analysis 
In this topic, you will learn how to configure the Traffic Crash Analysis solution to meet specific 

needs in your organization. 

 

Load traffic crashes 
The Fatal and Serious Injury Dashboard can be used to share locations of traffic crashes that 

resulted in serious injury or fatality to motorists, cyclists, or pedestrians. The dashboard also 

provides insights into the times of day, days of week, and months of year when these crashes 

occur more frequently. 

To load your traffic crashes from a spreadsheet, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the TrafficCrashesSource.csv 

item. 

2. Open the item page and click Download. 

3. Edit the .csv file and provide your traffic crash information. 

Note: 

The crash_date field should be formatted with times expressed using a 24-hour clock: 
12/31/2020 22:30:00. 

4. In your ArcGIS organization, browse to the TrafficCrashes feature layer. 

5. Open the item page and click Update Data > Append Data to layer. 

6. Click Choose File and browse to your .csv file, and click OK. 

7. Click Upload and Continue. 

8. Uncheck Update existing features. 

9. Click Show field matching to map the fields. 

10. Click Apply Updates. 

 

Update crash date, month, day, and hour attributes 
When dates are loaded into hosted feature layers, it is assumed the dates are in Coordinated 

Universal Time (UTC). Those times are then displayed in the local time of the browser, which 

can cause them to be offset from the original time of the crash. This can be resolved in the 

attributes by calculating the offset. In addition, the Day, Month, and Hour fields used in the 

Fatal and Serious Injury Dashboard charts can be calculated from the crash date. 

To update the Crash Date, Day, Month, and Hour fields, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
TrafficCrashes feature layer. 

2. Open the item page and click the Data tab. 
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3. If you need to offset the crash time to account for UTC, complete the steps below; 
otherwise, skip to step 9. 

4. Click the Date of Crash column. 

5. Click Calculate. 

6. On the Calculate Field dialog box, choose Arcade. 

7. Enter the following expression: ToUTC($feature.crash_date). 

8. Click OK. 

9. Click the Day column. 

10. Click Calculate. 

11. On the Calculate Field dialog box, choose Arcade. 

12. Enter the following expression: Weekday($feature.crash_date). 

13. Click OK. 

14. Click the Month column. 

15. Click Calculate. 

16. On the Calculate Field dialog box, choose Arcade. 

17. Enter the following expression: Month($feature.crash_date) + 1. 

Note: 

In Arcade, January is returned as 0 and December is 11. You are adding it to express 
the months as 1-12. 

18. Click OK. 

19. Click the Hour column. 

20. Click Calculate. 

21. On the Calculate Field dialog box, choose Arcade. 

22. Enter the following expression: Hour($feature.crash_date). 

23. Click OK. 

Tip: 

For more information, see Calculate field values. 

 

Load high injury network 
A high percentage of serious injury and fatal crashes involving motorists, cyclists, and 

pedestrians often occur on a small percentage of streets and intersections. These streets and 

intersections are often referred to as the High Injury Network (HIN). The Crash Analysis 

ArcGIS Pro project can be used to analyze crash data along the transportation network to the 

streets and intersections that have the highest frequency of crashes. The results of this 
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analysis can be loaded into the High Injury Network Locator and be shared with the public and 

other stakeholders. 

To load your High Injury Network, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Crash 
Analysis Desktop Application Template. 

2. Open the item page and click Download. 

3. Unzip and open the Crash Analysis ArcGIS Pro project. 

4. On the View tab, in the Windows group, click CatalogPane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Crash Analysis 
task. 

6. In the Tasks pane, click the How to Use Crash Analysis task group to expand the 
collection of tasks. 

7. Double-click the Analyze crashes with FHWA network screening task and follow the 
steps provided. 

 

usRAP data prerequisites 
The United States Road Assessment Program (usRAP) protocol defines how roads should be 

segmented to analyze risk. Road networks are divided into segments with breakpoints at 

locations where the following things occur: 

• A route begins or ends. 

• The county name changes. 

• There is discontinuity in the route, such as a gap in mileposts. 

• The roadway type changes. 

• The annual average daily traffic (AADT) changes by 20 percent or more. 

• The speed limit category changes. 

The usRAP tools use a series of input feature classes and fields on those feature classes to 

create basic road segments. Verify your data meets the tools parameter requirements below 

before using the usRAP tools. 

Feature class Description Required fields 

CrashLocations Locations of crashes. crashyear: The 4-digit year 
the crash occurred, for 
example, 2020. 
routename: The name of the 
route on which the crash 
occurred. 

Routes Baseline routes. routename: Name of the 
route. 
routetype: Type of the route. 
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CountyBoundary County features. countyname: Name of the 
county. 

AccessControl Road segments with access control 
information. 

accesscontrol: Type of 
access control to segment. 
This field should have a 
domain applied with the 
following options: 
Full Access Control 
Partial Access Control 
No Access Control 

Medians Road segments with median information. mediantype: Type of median 
of the segment. This field 
should have a domain 
applied with the following 
options: 
Undivided Roadway 
Divided Roadway 

TravelLanes Road segments with number of travel 
lanes. 

totallanes: Number of lanes 
for the segment. 

AreaType Road segments with the type of area. areatype: Type of area for 
the segment. This field 
should have a domain 
applied with the following 
options: 
Urban 
Rural 

SpeedLimit Road segments with the speed limit. speedlimit: The speed limit of 
the segment. 

AADT Road segments with the annual average 
daily traffic (AADT) values. Each year 
should be stored as a separate feature 
class (for example, AADT_2020) and 
you can include up to five years in the 
analysis. 

aadt: The annual average 
daily traffic of the segment. 
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Use Traffic Crash Analysis 
The Traffic Crash Analysis solution delivers a set of capabilities that help you to analyze crash 

data using methodologies defined by the United States Road Assessment Program (usRAP) 

and the Federal Highway Administration (FHWA), identify locations where concentrations of 

serious injury and fatal crashes occur, and share the results with decision makers and the 

public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Analyze traffic crashes 
The Crash Analysis ArcGIS Pro project helps public works, public safety, and transportation 

staff analyze crash data along roadways and at intersections. The project provides tasks and 

tools that allow you to perform this analysis using two methodologies. You will assume the 

role of transportation analyst responsible for analyzing crash data to identify roadways that 

have a higher risk of traffic crashes. 

 

United States Road Assessment Program (usRAP) protocol 
usRAP uses a risk-mapping protocol to create maps that show variations in the level of crash 

risk across a road network. These maps can guide the prioritization of highway infrastructure 

improvements and targeted enforcement strategies. The tasks and tools will guide you 

through performing the analysis according to the usRAP protocol. 

• Create roadway segments. 

• Assign crashes. 

• Create risk maps. 

The advantage of this methodology is that it uses roadway and traffic control feature data to 

assess risk and can better account for rural areas with lower traffic volumes or limited or 

unreliable crash data. The usRAP tools use a series of input feature classes and fields on 

those feature classes to create basic road segments. Confirm that your data meets the tools 

parameter requirements below before using the usRAP tools. 

To analyze crash data using the usRAP protocol, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Traffic Crash 
Analysis solution. 

2. Download the Crash Analysis desktop application template and unzip the folder. 

3. From the unzipped folder, open Crash Analysis.aprx in ArcGIS Pro. 
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4. In ArcGIS Pro, in the Catalog pane, expand Tasks, and then double-click the Crash 
Analysis task. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to Use Crash Analysis task group to see the 
collection of tasks. 

6. Double-click the Analyze crashes with usRAP protocol task and follow the steps 
provided. 

 

Federal Highway Administration (FHWA) network screening 
Network screening is the process of studying safety conditions on an entire road network or a 

subset of the network. While there are a variety of methods available to conduct network 

screening, three are included in the Crash Analysis project: 

• Crash Frequency 

• Crash Rate 

• Equivalent Property Damage Only 

The advantage of this tool is that it only requires the location of crashes and streets or 

intersections to calculate a crash frequency. Optionally, traffic volume expressed as an 

average daily traffic volume or the severity of the crash can be used to calculate the crash rate 

and equivalent property damage only, respectively. 

To analyze crash data using the FHWA network screening, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Traffic Crash 
Analysis solution. 

2. Download the Crash Analysis desktop application template and unzip the folder. 

3. From the unzipped folder, open Crash Analysis.aprx in ArcGIS Pro. 

4. In ArcGIS Pro, in the Catalog pane, expand Tasks, and then double-click the Crash 
Analysis task. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to Use Crash Analysis task group to see the 
collection of tasks. 

6. Double-click the Analyze crashes with FHWA network screening task and follow the 
steps provided. 
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Visualize fatal and serious injury crashes 
Now you will assume the role of a resident who commutes daily to work by bike. You want to 

see where fatal and severe injury crashes involving cyclists have occurred in the community 

and the times of day they most often occur. 

1. In a browser, from the Traffic Crash Analysis solution, view the Fatal and Serious Injury 
Dashboard app. 

The dashboard displays traffic crashes by mode, severity, and date. An accident may 
involve multiple parties and modes of transportation; in those cases, the most vulnerable 
mode of transportation is used for the mode. For example, if a motorist and bicyclist are 
involved in an accident, click the Mode drop-down arrow and choose Bicyclist. Similarly, 
the highest severity is associated with the accident. For example, if a car accident results 
in one fatality and three non-incapacitating injuries, click the Severity drop-down arrow 
and choose Fatality. 

2. In the left panel, use the filters to refine results by Mode, Severity, and Date Range. 

The charts below and to the right of the map are linked, so as you click a bar in one 
chart, related details are filtered and updated in other charts and in the map. This feature 
can be helpful in looking for trends in crashes, both spatially and by time of day, week, 
and year. 

3. Use the graphs to filter traffic crashes by Hour of Day, Day of Week, and Month of 
Year. 

 

Locate high-risk streets and intersections 
You will continue your role of a resident in the community and want to learn what streets and 

intersections along your daily commute have a higher risk of traffic crashes. 

1. In a browser, from the Traffic Crash Analysis solution, view the High Injury Network 
Locator app. 

The app displays the streets and intersections where concentrations of serious and fatal 
traffic crashes have occurred. 

2. To set a location to be buffered, type an address in the search bar and press Enter or 
click a location on the map. 

3. Optionally, move the slider to increase or decrease the buffer distance. 

4. Expand Intersections or Streets to see details about the number of crashes per mile 
and per million vehicle miles. 
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Transit Outreach 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Transit Outreach 
Transit Outreach can be used to share information about planned service changes and solicit 

feedback from riders and the general public on their experience with public transit. 

It provides 24/7 access to an organization, and the location-enabled reports help efficiently 

triage reports to the correct person or department responsible for their resolution. Through 

effective public engagement, transit agencies identify and understand the needs of the 

community as a whole and incorporate those needs into transportation plans and programs. 

Transit Outreach is typically implemented by transit agencies that want to become more 

transparent and responsive and ultimately provide better transit service. 

The Transit Outreach solution delivers a set of capabilities that help you solicit feedback from 

riders, manage the transit agency's response, share information about upcoming service 

changes, and allow the public to provide feedback on proposed changes. 

 

Requirements 
Transit Outreach requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

 

 

 

 

 

 

 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 794 

Information products 
Transit Outreach includes the following information products: 

Item Description Minimum user 
type 

Transit Service 
Change 

A Crowdsource Polling app used by the general 
public to obtain information about planned service 
changes and, optionally, comment on proposed 
changes 

Not required 

Transit Rider 
Reporter 

An ArcGIS Survey123 form used by the general 
public to submit compliments, problems, questions, 
and suggestions related to their experience on public 
transit 

Not required 

Transit Rider 
Reporter Manager 

A Crowdsource Manager app used by transit staff to 
triage rider feedback and update the status of each 
report 

Editor 

Transit Rider 
Reporter 
Dashboard 

An ArcGIS Dashboards app used by transit staff to 
monitor feedback submitted by the general public 

Viewer 

Transit Data 
Management 

An ArcGIS Pro project used by transit staff to convert 
a GTFS public transit dataset to route and stop 
features and manage service change communication 

GIS 
Professional 
Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Transit Outreach 
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Configure Transit Outreach 
In this topic, you will learn how to configure the Transit Outreach solution to meet specific 

needs in your organization. 

 

Load transit system 
The Transit Outreach solution includes an ArcGIS Pro project used to convert your GTFS 

public transit dataset to route and stop features that are used as base layers in the maps and 

apps included in the solution. 

To load your transit routes and stops in the solution, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Transit Data Management Project 
Package. 

2. Open the item page and click Download. 

3. Start the ArcGIS Pro application and open the Transit Data Management project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Transit Data 
Management task. 

6. In the Tasks pane, click the How to Use Transit Data Management task group to 
expand the collection of tasks. 

7. Double-click the Load transit routes and stops task and follow the steps provided. 

 

Manage service change commenting 
Some transit agencies offer riders the ability to provide their feedback on proposed service 

changes before they are implemented. This information is used by the transit agency to help 

decide if they should move forward with the change. 

The Transit Service Change app allows riders to view upcoming service changes and by 

default allows riders to add a comment on the change. Transit agencies can also control when 

the commenting period is open or closed or disable commenting completely. 

 

Close commenting period 
To close the commenting period, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transit 
Service Change app. 

2. Open the item page and click Configure App. 

3. Click the Options tab. 

4. Under Feedback period, click Feedback period closed and provide an appropriate 
window title and message in the Feedback period closed window title text box. 
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5. Click Save to save the app configuration. 

6. Click Close. 

 

Disable comments 
To disable comments, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transit 
Service Change app. 

2. Open the item page and click Open in Map Viewer Classic. 

3. Click Details and click the Contents button. 

4. On the Comments layer, click More Options and click Remove. 

5. Click Yes, remove table. 

6. Click Save. 

 

Add route name pick list 
The Transit Rider Reporter survey can be used by the public to submit compliments, 

problems, questions, and suggestions related to their experience on public transit. Adding 

accurate names to the routes pick list ensures data consistency and ensures that Transit 

Rider Reporter functions properly with other apps included in the Transit Outreach solution. 

To add your list of route names to the pick list, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

3. Click Transit Rider Reporter to download the survey. 

4. In the Download window, click Download and click OK. 

5. Click Transit Rider Reporter again to open the survey. 

6. In the XLSForm Modified window, click Yes. 

7.  On the side toolbar, click the Open XLSForm Spreadsheet button. 

8. In the Microsoft Excel spreadsheet, click the choices tab. This tab comprises all the 
selectable options for survey questions. 

9. Update the name and label for routes with your route names. Add additional route names 
and rows as needed, and if necessary, delete all placeholder information. 

The choices tab includes Rail, Streetcar, and Bus route types. This allows the Transit 
Rider Reporter to present the appropriate pick list based on the rider's category selection. 

10. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

11. In ArcGIS Survey123 Connect, click Publish on the side toolbar. 

12. Click Publish survey to publish your changes and click OK. 
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Use Transit Outreach 
The Transit Outreach solution delivers a set of capabilities that help you solicit feedback from 

riders, manage the transit agency's response, share information about upcoming service 

changes, and allow the public to provide feedback on proposed changes. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

View service changes 
First, you’ll assume the role of a transit rider. You use the same transit routes on your daily 

commute. You will use the Transit Service Change app to learn about upcoming changes to 

service and how it may impact your commute. 

1. In a browser, from the Transit Outreach solution, view the Transit Service Change app. 

All routes are listed in the panel on the right. They are also marked on the map. 

2. Click a route in the list or on the map. 

3. Review the details about when the service change is effective, how it will impact riders, 
and why the change is being made. 

The Transit Service Change app can also be used by riders to comment on proposed 
changes. 

4. On the right, at the bottom of the route details, click the Add a comment button. 

5. Provide your name, address, and comments. 

6. Click Submit. 

 

Manage service changes 
Next, you’ll assume the role of a transit mapping technician who manages service change 

communication. You will use the Transit Data Management project to manage the routes and 

service change details visible to the public in the Transit Service Change app. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit 
Outreach solution. 

2. Download the Transit Data Management project package. 

3. Open the Transit Data Management project in ArcGIS Pro. 

4. In the Catalog pane, expand the Tasks folder, and double-click the Transit Data 
Management task. 
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Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to Use Transit Data Management task group to 
see the collection of tasks. 

6. Double-click Manage transit service changes task and follow the steps provided. 

 

Submit rider feedback 
Now, you’ll assume the role of a transit rider. While riding a bus, you noticed a problem and 

want to report it to the transit agency. You will use Transit Rider Reporter to submit feedback. 

1. In a browser, from the Transit Outreach solution, view the Transit Rider Reporter app. 

2. For I would like to, choose the reason that you are submitting the survey. 

3. For Related to, choose the response that best describes what your report is about. 

Depending on the category selected, additional questions appear. For example, clicking 
Bus adds questions about the route and vehicle number. 

4. Answer any additional questions, if necessary. 

5. For Details, type additional information about the issue. 

6. For When did it occur, choose the date and time that you made your observation. 

7. For Where did it occur, search for the address and press Enter. 

8. In the Contact Information section, choose the type of response that you want. 

Tip: 

To submit feedback anonymously, choose No, for your information only. 

9. Click Submit. 

 

Manage rider reports 
You will now assume the role of a transit agency employee who monitors customer feedback. 

You will use Transit Rider Reporter Manager to view and manage rider feedback. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit 
Outreach solution. 

2. View the Transit Rider Reporter Manager app. 

All reports are listed in the table at the top. The table can be sorted and filtered in various 
ways. 

3. In the table, use the column header filters and arrows to filter results. 

4. From the table, select a report with a status of Submitted. 
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The report details open at the lower left, and the map zooms to the report's location. 

5. After reviewing the details, you decide to assign the report for follow-up. 

6. In the report details, click the Edit Record button . 

7. Click the Assigned To drop-down arrow and choose a group. 

8. Change the status to In Progress. 

9. Optionally, to add comments to the rider report, click the Comments tab, and then click 
Add Record. 

10. Click Save. 

In the table, the record's status updates to In Progress. On the map, the symbol also 
changes. 

You have received a message from the group that you assigned the report to. The 
message states that the rider report has been communicated to the appropriate team and 
the report can be closed. 

11. If necessary, in the table, click the report. 

12. In the report details, click the Edit Record button. 

13. Change the status to Completed. 

14. Click Resolved On and choose a date. 

15. Optionally, for Resolution, type details about how the report was resolved. 

16. Click Save. 

  In the table, the record's status updates to Completed. On the map, the symbol also 
changes. 

 

Monitor rider reports 
As rider reports are submitted, resolved, and closed, you are interested in noting trends and 

the overall feedback received. You will continue your role as a transit agency employee, this 

time looking to gain insight into the feedback received through the Transit Rider Reporter app. 

You will use Transit Rider Reporter Dashboard to view feedback and key metrics. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit 
Outreach solution. 

2. View the Transit Rider Reporter Dashboard app. 

The Transit Rider Reporter Dashboard app opens with the Overview tab active. 

The Overview tab displays infographics of categories of reports. This information gives 
management a quick overview of the number of reports submitted by the public. 

3. Click the Rider Reports tab. 

The Rider Reports tab allows a transit manager to monitor their department's progress 
with responding to reports. The tab displays the top problem types and categories and 
summarizes reports by month with details. 
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Charts are linked, so when you click a category in one chart, related charts and lists are 
filtered and updated to allow a manager to identify issues and areas that need attention. 

4. On the left side of the app, click the arrow to display the side panel.  

Tip: 

To pin the side panel to the dashboard, click the pin in the upper right. 

  The side panel allows you to apply several survey and feedback filters. You can filter by 
Report Type, Submission Date, Occurrence Date, and Route. 
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Transit Safety 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Transit Safety 
Transit Safety can be used to document safety issues and manage corrective actions or 

mitigation activities. 

Each transit ride must be carefully executed to ensure the safety, security, and timeliness of 

service. Safety is the highest priority for transit agencies. Even with the best foresight, 

unexpected events can occur. The Federal Transit Administration (FTA) recently adopted the 

practice of safety management systems (SMS) to improve transit safety. Implementing an 

SMS helps transit agencies continuously improve system safety. Rapid data collection and 

high-quality reporting can lead to process improvements across organizations. Visualizing this 

data over time allows transit agencies to identify trends and implement changes that address 

safety issues. Transit Safety is typically implemented by transit agencies that want to adopt an 

SMS to improve transit services and save lives. 

The Transit Safety solution delivers a set of capabilities that help you document events 

(accidents, incidents, and occurrences), report hazards, create work assignments, dispatch 

field staff for mitigation activities, and monitor the status of safety events and hazards across 

the transit system. 

 

Requirements 
Transit Safety requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

• ArcGIS Field Maps 

• ArcGIS Workforce 
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Information products 
Transit Safety includes the following information products: 

Item Description Minimum user 
type 

Transit Event 
Reporter 

AnArcGIS Survey123 form used by transit safety staff 
to document the initial event report of an accident, 
incident, or occurrence. 

Editor 

Transit Hazard 
Reporter 

An ArcGIS Survey123 form used by the general public 
or transit staff to report a safety hazard issue. 

Editor (required 
for transit staff 
only) 

Transit Safety 
Manager 

A Crowdsource Manager app used by transit safety 
staff to manage safety event investigations and 
hazard risk assessments and mitigation. 

Editor 

Transit Safety 
Dashboard 

An ArcGIS Dashboards app used by transit safety 
staff to monitor events and hazards across the transit 
system. 

Viewer 

Transit 
Mitigation 
Assignments 

An ArcGIS Workforce project used by transit staff to 
manage mitigation activities in the field and track the 
resolution of each. Field users access the Transit 
Mitigation Assignments project using the ArcGIS 
Workforce mobile app. 

Mobile Worker 

Transit Field 
Mitigations 

An ArcGIS Field Maps map used by transit staff to 
update the status of a mitigation activity while in the 
field. 

Mobile Worker 

Transit Data 
Management 

An ArcGIS Pro project used by transit staff to convert 
a GTFS public transit dataset to route and stop 
features and manage service change communication. 

GIS 
Professional 
Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • Updated the Transit Mitigation Assignments project from ArcGIS Workforce 
Classic to ArcGIS Workforce. 

1.0 • First release of Transit Safety 
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Configure Transit Safety 
In this topic, you will learn how to configure the Transit Safety solution to meet specific needs 

in your organization. 

 

Load transit routes and stops 
The Transit Safety solution includes an ArcGIS Pro project that is used to convert your GTFS 

public transit dataset to route and stop features that are used as base layers in the maps and 

apps included in the solution. 

To load your transit routes and stops in the solution, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Transit Data Management Project 
Package. 

2. Open the item page and click Download. 

3. Start the ArcGIS Pro application and open the Transit Data Management project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Transit Data 
Management task. 

6. In the Tasks pane, click the How to Use Transit Data Management task group to 
expand the collection of tasks. 

7. Double-click Load transit routes and stops task and follow the steps provided. 
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Use Transit Safety 
The Transit Safety solution delivers a set of capabilities that help you document events 

(accidents, incidents, and occurrences), report hazards, create work assignments, dispatch 

field staff for mitigation activities, and monitor the status of safety events and hazards across 

the transit system. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Report safety events 
You’ll assume the role of safety manager. You just received information about an incident that 

occurred on one of your rail lines. You will use Transit Event Reporter to add the safety event 

and send a report to the state oversight committee. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Safety 
solution. 

2. View the Transit Safety Manager app. 

3. Click the Help button  in the upper right corner of the app. 

4. Click the Input New Event button. 

5. In the Transit Event Reporter survey, fill in the following details: 

• For Location, click the map. 

• For Date of event, choose a date and time. 

• For Date of report, choose a date and time. 

• Click the Event Type drop-down arrow and choose Incident. 

• Type INCI-587 in the Event ID text box. 

• Click the Mode drop-down arrow and choose Tram, Light Rail, Streetcar. 

• Type OID-43 in the Operator text box. 

• Type 3001 in the Vehicle ID text box. 

• Type 1 in the Number injured text box. 

• Type the following in the Initial summary text box: An 83-year-old female fell 
shortly after departure of the transit vehicle. The fall was 
initiated by the sudden movement of the vehicle after it left the 
station. 

6. Click Submit. 
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Manage safety events 
You’ll assume the role of safety manager. You have just received a new event report and 

need to send the report to the state and follow the event throughout the investigation period. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Safety 
solution. 

2. View the Transit Safety Manager app. 

3. In the left panel, click the Events map. 

4. Click the event you reported in the previous section. 

The event details appear under the table. You have determined that this event requires 
sending information to the transit oversight committee. 

5. On the Details tab, click the Email Event Report button. 

An email opens with the specific event details. Fill in an email address and any other 
important details. You can send the email to the necessary recipients. 

6. Return to the Transit Safety Manager app. 

You will now update the status of the report. After a week, new details about the event 
become available. You will add these details to the report. 

7. On the Details tab, click the Edit button . 

8. Fill in the following details: 

• Click the Status drop-down arrow and choose Continued Investigation. 

• Type One light rail car in the Involved Vehicles text box. 

• Click the Weather drop-down arrow and choose Sunny. 

• Type 58 in the Temperature text box. 

• Type 0 in the Damage Estimate text box. 

• Click the D&A Testing drop-down arrow and choose No. 

9. Click Save. 

After some time, you are now ready to complete the investigation and decide on a 
probable cause. 

10. Click the Edit button. 

11. Fill in the following details: 

• Click the Status drop-down arrow and choose Final Report. 

• Click the Probable Cause drop-down arrow and choose Slips and Falls. 

• Type fall during initial acceleration of light rail in the Detailed 

Probable Cause text box. 

• Click the Preventable drop-down arrow and choose No. 

12. Click Save. 
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13. On the Details tab, click the Print Final Report button to view the sample result. 

14. Click the Edit button. 

15. Fill in the following details: 

• Click the Status drop-down arrow and choose Event Closed. 

• For Date Closed, choose the current date. 

16. Click Save. 

 

Report safety hazards 
You’ll assume the role of a transit agency employee. You need to report a hazard that you 

found at a bus stop. You will use Transit Hazard Reporter to add the safety hazard. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Safety 
solution. 

2. View the Transit Hazard Reporter survey. 

3. Fill in the following details: 

• For Location, click the map. 

• For Date of hazard, select a date and time. 

• Click the Hazard type drop-down arrow and choose Unsafe Conditions. 

• Type There is ice at the bus stop in the Descriptions text box. 

• Click Select image file to upload a photo. 

• For Would you like to report anonymously, click No. 

• For Identity, click Contractor. 

• Type your name in the Name text box. 

• Type your email in the Email text box. 

• Type your phone number in the Phone text box. 

4. Click Submit. 

 

Manage safety hazards 
You will now assume the role of a transit safety manager. You need to mitigate all hazards 

that relate to your transit system. You will access the risk of the hazard, assign mitigation 

activities, and submit a final risk assessment for the hazard. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Safety 
solution. 

2. View the Transit Safety Manager app. 

3. In the left panel, click the Hazards map. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 807 

4. Click the hazard you reported in the previous section. 

The hazard details appear under the table. 

5. On the Details tab, click the Edit button . 

6. Fill in the following details: 

• Type HAZ-123 in the Hazard ID text box. 

• Click the Risk Score Pre-Mitigation drop-down arrow and choose 3E. 

• Click the Risk Value (pre) drop-down arrow and choose Medium. 

• Type your name in the Risk Assessor (pre) text box. 

Note: 

The risk values and score are modeled on the Mil Standard 882E. Assign both a 
score and a value to complete the risk assessment. 

7. Click Save. 

The risk score premitigation is now populated with a visual representation of your risk 
score. You have determined that mitigation is necessary for this risk. You will now add 
related mitigation activities to the hazard. 

8. Click the Related Information tab. 

9. Click Add Record. 

10. Fill in the following details: 

• Click the Mitigation Type drop-down arrow and choose Maintenance. 

• Type Facilities - Bus Stops in the Manager Responsible text box. 

• Type Apply salt to bus stop to remove ice in the Details text box. 

11. Click Save. 

Now that you have created mitigation assignments, you will update the status of your 
hazard. 

12. Click the Details tab. 

13. Click the Edit button. 

14. Click the Status drop-down arrow and choose Mitigation in progress. 

15. Click Save. 

16. Assign field staff to complete mitigation activities. 

Note: 

Use the Create Work Assignment button to launch a workforce app where you can 
assign field activities. Field staff can then use the Transit Mitigation Assignments 
ArcGIS Workforce project to manage their work assignments and the Transit Field 
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Mitigations ArcGIS Field Maps map to update the action taken and close the 
mitigation activity. 

Update the hazard status to reflect that the fieldwork for this mitigation is complete. 

17. Click the Related Information tab. 

18. Click the Edit button. 

19. Fill in the following details: 

• Click the Status drop-down arrow and choose Closed. 

• Type Salt applied and ice removed in the Action Taken text box. 

• For Date Complete, choose the current date. 

20. Click Save. 

You will now close the hazard. 

21. Click the Details tab. 

22. Click the Edit button. 

23. Fill in the following details: 

• Click the Status drop-down menu and choose Closed. 

• Click the Risk Score Post-Mitigation drop-down arrow and choose 4C. 

• Click the Risk Value (post) drop-down arrow and choose Low. 

• Type your name in the Risk Assessor (Post) text box. 

• For Date Closed, choose the current date. 

24. Click Save. 

 

Monitor safety performance 
You are the Transit Safety manager interested in understanding the performance of your 

Safety Management Program and searching for areas of improvement. You will view the 

status of the program and then look in detail at both hazards and events. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Transit Safety 
solution. 

2. View the Transit Safety Dashboard app. 

The Transit Safety Dashboard opens with the Overview tab active. 

The Overview tab displays infographics of events and hazards. This information gives 
management a quick overview of the number of events and hazards in the last 90 days 
and their performance relative to the previous 90 days. 

3. Click the Events tab. 

The Events tab allows a safety manager to monitor how their department is doing when 
it comes to investigating events. 
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In the report, charts are linked. As you click and select a category in one chart, related 
details are filtered and updated in other charts on the report to allow a manager to 
identify issues and areas that need attention. 

4. Click the Hazards tab. 

The Hazards tab allows a safety manager to monitor how their department is doing when 
it comes to assessing and mitigating hazards. 

In the report, charts are linked. As you click and select a category in one chart, related 
details are filtered and updated in other charts on the report to allow a manager to 
identify issues and areas that need attention. 

5. Click the arrow on the left side of the app to display the side panel. You can pin the side 
panel to the dashboard by clicking the pin in the upper right corner. 

  The side panel allows you to apply several event and hazard filters. You can filter by 
Occurrence Date, Event Type, Event Mode, and Hazard Type by clicking the drop-
down and choosing a filter. 
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Transportation 511 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Transportation 511 
 Transportation 511 can be used to share road conditions and closures that may impact travel 

throughout a community or state. 

Established in July 2000 by the Federal Communications Commission, 511 is the nationally 

designated, three-digit telephone number for traveler information. 511 provides a simple 

number travelers can use to access road and traffic information from within the jurisdiction 

they are traveling. Many 511 systems now include a map-based application that includes real-

time incident and weather information. The application provides 24/7 access to critical 

information, and the location-enabled search allows travelers to quickly find traffic incidents, 

travel restrictions, road conditions, closures, live traffic camera feeds, and other transportation 

information.  Transportation 511 is typically implemented by public works or transportation 

agencies that want to provide the public with current road conditions and traffic information. 

The Transportation 511 solution delivers a set of capabilities that help you import critical 

information from your incident management system and share roadway information with the 

public so they can make informed decisions before they travel. 

 

Requirements 
 Transportation 511 requires the following: 

• ArcGIS Enterprise 
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Information products 
 Transportation 511 includes the following information products: 

Item Description Minimum 
user type 

Transportation 
511 

An ArcGIS Web AppBuilder for the general public to 
understand roadway conditions and closures that may 
impact travel throughout a state. 

Not 
required 

Overwrite 
Features 

A Python script and sample file geodatabase that you can 
schedule to update the Transportation 511 app with real-
time traffic and roadway condition information. 

Creator 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Transportation 511 
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Configure Transportation 511 
In this topic, you will learn how to configure the Transportation 511 solution to meet specific 

needs in your organization. 

 

Add a real-time traffic layer 
Add additional context to your Transportation 511 app by including World Traffic Service from 

ArcGIS Living Atlas. Part of a larger collection of Esri curated content, World Traffic Service 

presents historical and near real-time traffic information for different regions of the world. This 

dynamic traffic map service is updated every 5 minutes, includes traffic incidents and provides 

visualizations for different traffic speeds relative to the free flow of traffic. 

Note: 

World Traffic Service is licensed under the Esri Master License Agreement and is 
exclusive content for Esri subscribers. Use of this service requires an ArcGIS Online 
organization subscription or an ArcGIS developer account. ArcGIS Living Atlas subscriber 
content does not consume ArcGIS Online credits. See Configure Living Atlas content to 
enable access subscriber content. 

 

Configure map 
To leverage Esri’s World Traffic Service in your Transportation 511 app, you first must add the 

service to your map. 

1. Sign in to your ArcGIS organization and browse to the Transportation 511 map. 

2. Open the item page and click Open in Map Viewer Classic. 

3. Click Add > Browse Living Atlas Layers. 

4. Type traffic in the search text box. 

5. Click the Add button  World Traffic Service to add it to the map. 

Tip: 

You may determine you do not want to display the Traffic Incidents layers from World 
Traffic Service as this is already a layer you will provide. Before proceeding to the next 
step, click the Back button and in the Contents pane, expand the World Traffic 
Service group layer. Uncheck the North America Traffic Incidents (or your region if 
outside North America) layer group to ensure these layers are not visible in the 
Transportation 511 app. 

6. Click Save. 
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Configure the app 
Once the World Traffic Service layer is added to your map, additional steps are needed to 

configure the service to properly display in your Transportation 511 app. 

 

Configure World Traffic Service Incidents with the Road Conditions widget 

Optionally, you can display traffic incidents from World Traffic Service in the Transportation 

511 app the same way as Road Condition layers are displayed from your feature collection. 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
Transportation 511 app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab. 

4. Click Set the widgets in this controller. 

5. Hover over the Road Conditions widget and then click the Configure this widget 

button . 

6. Click Add Layer three times. 

Each time you click Add Layer, the following layers are added to the Road Conditions 
widget: Traffic Incidents Overview, Traffic Incidents Intermediate, and Traffic Incidents 
Detailed. 

Note: 

The World Traffic Service Traffic Incident layers are scale dependent. If you want your 
app to display Traffic Incident information and counts at all scales, you must add all 
three layers to the Road Conditions widget configuration. 

7. Provide a label for each of the layers added, for example: World Traffic Service Incidents. 

8. Click OK. 

9. Click Save. 

 

Troubleshoot Overwrite Hosted Features script 

errors 
The table below describes common errors that can occur when running the Overwrite Hosted 

Features script and how to resolve each. 

Script error Resolution 

Unable to find feature 
service with ID: {ID} 

Verify the Item ID for your feature service and the baseURL 
entered for your ArcGIS organization. 

Unable to find feature 
collection with ID: {ID} 

Verify the Item ID for your feature collection and the baseURL 
entered for your ArcGIS organization. 

File GDB: {path to 
zipped file 

Verify the path and file name for your zipped file geodatabase. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 814 

geodatabase} could not 
be found 

Cannot add the item Verify that the user name used in the configuration does not 
already own a file geodatabase item with the same name as input 
to the fgdb parameter. 

IOError: [Errno 2] No 
such file or directory: 
{Log File Path} 

Verify that the script can write to the file path location configured 
for the log. 

Error Processing table 
data – check file 
format, supported data 
types and data license 

Verify that each layer in the feature service has an associated 
feature class in the geodatabase and that the published feature 
service and zipped file geodatabase contain the same number of 
layers. 

URLOpen Error 
[Errno11001] 
getaddrinfo failed 
URLOpen Error 
[Errno11004] 
getaddrinfo failed 

Verify that baseURL parameter contains a forward slash at the 
end of the address, for example, 
http://myorganization.maps.arcgis.com/. 
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Use Transportation 511 
The Transportation 511 solution delivers a set of capabilities that help you import critical 

information from your incident management system and share roadway information with the 

public so they can make informed decisions before they travel. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

View road conditions 
You will assume the role of a motorist planning travel to your next destination in search of 

information about road conditions prior to driving across state. You will use the  Transportation 

511 app to discover current roadway conditions, restrictions and closures, and other alerts to 

help plan a safer trip. 

1. In a browser, from the Transportation 511 solution, view the  Transportation 511 app. 

The Road Conditions widget is open by default. Road Conditions categories are 
presented in a list with corresponding total counts. 

Note: 

Information shown in the Road Conditions list automatically updates as you pan and 
zoom the map to different extents or when searching for a location by address. 

2. Click a category to expand it. 

After expanding a category, you may notice that it includes expandable lists that are 
specific to a particular road or highway. 

3. If necessary, in the category, expand a list. 

4. Click one of the listed reports. 

On the map, a pop-up displays at the location of the incident. The pop-up includes details 
about the incident, and, for some types of incidents, it provides a link to additional 
information. 

5. In the Road Conditions widget, to the left of a category, click the button to turn the layer 
on and off. 

 

Configure data updates 
The Overwrite Hosted Features script is meant to be scheduled as a task to run regularly to 

keep road condition information current in the app. The script takes a zipped file geodatabase 

and overwrites the published feature collection with the current road condition information. 
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The script can run on a machine without ArcGIS installed. You will now assume the role of a 

employee in the transportation agency responsible for keeping the Transportation 511 app up 

to date with the latest information on road conditions across the state. 

 

Configure script parameters 
To configure the Overwrite Hosted Features script, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the Transportation 511 solution item. 

2. Open the item page and click Overwrite Features. 

3. On the item page, click Download. 

4. Unzip the OverwriteFeatures folder. 

5. Download and install Python version 2.7 or version 3.4 if you do not have it installed on 
your machine. 

6. Browse to and open the overwrite_hosted_features.cfg file in a text editor, and 

update the following inputs: 

Parameter Description 

featureService
ItemID 

The item ID for your Transportation 511 feature service. 

featureCollect
ionItemID 

The item ID for your Transportation 511 feature collection. 

Note: 

Item IDs are found at the end of the URLs when viewing item 
details, for example, 
http://myorganization.maps.arcgis.com/home/item.html?i
d=d7c57317a0564cafae28cdc464d63ff9. 

fgdb The path to the provided zipped file geodatabase, for example, 
C:\Transportation511\RoadConditions.zip. 

Tip: 

A sample schema geodatabase is provided in the Overwrite 
Features .zip file. 

baseURL Your organization's URL, for example, 
https://myorganization.maps.arcgis.com. 

username Your ArcGIS username. 

pw Your ArcGIS password. 

maxAllowableOf
fset 

To optimize performance of the data in the application, it is 
recommended that you generalize complex line and polygon features. 
Enter the maximum amount of simplification you want for the features in 
the feature collection. 
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Note: 

This is defined in the units of the spatial reference of the service, 
by default, in meters. 

nameMapping To ensure that features in your feature collection are updated with data 
from the correct feature class in the file geodatabase, enter a layer 
mapping to match layers in the published feature layer with the file 
geodatabase feature class in this parameter following this pattern: 

Feature Service Layer 1, Database Feature Class 1; Feature Service 
Layer 2, Database Feature Class 2 

Note: 

The defaults provided in the configuration file work against the 
provided sample geodatabase and the deployed feature service. 

path (Optional) The path and file name where you want the log to be written. 

isVerbose 

(Optional) 
True or false. To disable logging, leave this parameter blank. 

7. Save your edits to the configuration file. 

8. Run the Overwrite Hosted Features script, overwrite_hosted_features.py, to test 

your configuration. If necessary, refer to the troubleshooting guide below. 

Note: 

Optionally, you can pass in a configuration file as a parameter to the script. If no 
configuration file is passed in as a parameter, the script looks for a configuration file 
named overwrite_hosted_features.cfg in the same directory as the script. 

 

Schedule data updates 
You can use the Overwrite Hosted Features script (overwrite_hosted_features.py) with 

Windows Task Scheduler to overwrite feature collections at a regular interval. Scheduled 

updates ensure that users have access to current information to support more timely decision-

making when traveling. 

To update the Transportation 511 feature collection on a schedule, complete the following 

steps: 

1. Open Task Scheduler on the computer hosting the scripts. 

2. Click Action > Create Task and name your task. 

3. Click the Action tab and click New. 

4. Set Action to Start a Program. 
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5. Click Browse and go to the location of your Python installation (for example, <default 
directory>\Python27\python.exe), and click Open. 

6. In the Add Arguments text box, type the path and name of the script 
(overwrite_hosted_features.py) and path and name of the configuration file 

(overwrite_hosted_features.cfg), and click OK. 

7. Click the Trigger tab, click New, and set a schedule for your task. 

8. Click the Settings tab, click the If the task is already running, then the following rule 
applies drop-down arrow, and choose Do not start a new instance. 

9. Click OK. 
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Tree Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Tree Management 
Tree Management can be used to inventory publicly owned trees, streamline inspection and 

maintenance activities, understand conditions, cultivate a volunteer workforce, and inform the 

public. 

Publicly owned trees that line streets and dot parks are important assets and must be 

maintained like streets and sewers. These natural resources provide demonstrative 

environmental, economic, and social benefits to a community. They also play an increasingly 

important role in climate resiliency plans as communities attempt to mitigate the impact of 

extreme weather. The first, and most critical, step a local government must take to manage its 

urban forest is to create a tree inventory. A local government cannot effectively manage their 

urban forest and plan improvements unless they know how many publicly owned trees they 

have, and where they are. Tree Management is typically implemented by public works 

departments, parks departments, and road commissions that want to develop a tree inventory, 

effectively manage their urban forest, and plan improvements. 

The Tree Management solution delivers a set of capabilities that help you inventory publicly 

owned trees, conduct routine inspection and maintenance assignments, understand tree 

conditions, engage volunteers, and inform the public. 

 

Requirements 
Tree Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Notebook Server 

• ArcGIS Pro 3.0 or later (Basic, Standard, or Advanced) 

• ArcGIS 3D Analyst extension 

• ArcGIS Spatial Analyst extension 

• ArcGIS Workforce 

• ArcGIS Field Maps 

• ArcGIS Survey123 Connect 
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Information products 
Tree Management includes the following information products: 

Item Description Minimum user 
type 

Tree Data 
Management 

An ArcGIS Pro project used by GIS technicians to 
develop a tree inventory from record information 

GIS 
Professional 
Basic 

Tree Field Map An ArcGIS Field Maps map used by field staff to 
conduct a tree inventory and record inspection and 
maintenance activities 

Mobile Worker 

Tree Requests 
Internal 

An ArcGIS Survey123 form used by field staff to report 
requests for service 

Mobile Worker 

Tree 
Assignments 

An ArcGIS Workforce project used by operations and 
maintenance supervisors to organize and manage 
routine and ad-hoc field assignments 

Editor 

Tree 
Management 
Center 

An ArcGIS Experience Builder app used by operations 
and maintenance supervisors and arborists to monitor 
tree conditions and manage requests for service 

Mobile Worker 

Our Urban 
Forest 

An ArcGIS Hub site used by the general public to learn 
more about the community's urban forest program 
ArcGIS Hub Premium is required to operate the Tree 
Stewardship volunteer program 

Not required 

Tree Viewer An ArcGIS Experience Builder app used by the general 
public understand the condition of publicly owned trees 
in their neighborhood, or around their homes 

Not required 

Tree Requests An ArcGIS Survey123 form used by general public to 
report requests for service 

Not required 

Tree 
Stewardship 
Center 

An ArcGIS Experience Builder app used by volunteer 
coordinators to monitor volunteer activities 

Editor 

Tree Steward 
Notebook 

An ArcGIS Notebooks app used to grant approved 
stewards access to the Tree Care Activities form 

Editor 

Tree Steward 
Application 

An ArcGIS Survey123 form used by volunteers to 
express interest in the tree stewardship program 

Community 
Identity 

Tree Care 
Activities 

An ArcGIS Survey123 form used by volunteers to 
report stewardship activities 

Community 
Identity 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • A new Tree Data Management project to support ArcGIS Pro 3.0. 

1.0 • First release of Tree Management 
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Configure Tree Management 
Tree Management can be used to inventory publicly owned trees, streamline inspection and 

maintenance activities, understand conditions, cultivate a volunteer workforce, and inform the 

public. 

In this topic, you'll learn how to configure the Tree Management solution to meet specific 

needs in your organization. 

 

Modify tree types 
The Tree Management solution helps you build an inventory of publicly owned trees. Types of 

trees are defined by their common name, genus, and species. Types of trees appear in the 

Tree Field Map when field staff are collecting trees. 

The Tree Management solution includes many types of common names, genus, and species 

values. In some cases, you may want to add additional types of trees to the Tree 

Management solution to meet your organization’s needs. Review the common name, genus, 

and species fields in the Trees feature layer and identify the tree types your organization may 

want to add or remove from the Tree Management solution. 

1. Sign in to your ArcGIS organization and browse to your Trees feature layer. 

2. Open the item page and click the Data tab. 

3. Click Fields. 

4. Click the Common name display name. 

In the List of Values (Domain) section, review existing types and identify ones that are 
not applicable and ones that are missing. 

5. Click Edit next to List of Values (Domain). 

6. Optionally, click the Delete button to remove a category from the list. 

7. Optionally, click Add. 

8. Type the new common name into the Displayed Value and Stored Value text boxes. 

9. Repeat steps 7 and 8 to add the remaining missing types. 

10. Optionally, drag the category to a new location in the list to reorder them. 

11. Click Save. 

12. Repeat steps 4-11 for the genus and species fields. 

 

Modify inspection and maintenance types 
The Tree Management solution helps you assess tree conditions and record maintenance 

activities. Inspection and maintenance types are defined on the Trees feature layer and 

appear in the Tree Field Map when field staff are recording their work. 
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The Tree Management solution includes types of inspection and maintenance. In some cases, 

you may want to modify inspection and maintenance types to meet your organization’s needs. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Trees feature 
layer. 

2. Open the item page and click the Data tab. 

3. Click the Layer drop-down and select Inspections. 

4. Click Fields. 

5. Click the Inspection type display name. 

In the List of Values (Domain) section, review existing types and identify ones that are 
not applicable and ones that are missing. 

6. Click Edit next to List of Values (Domain). 

7. Optionally, click the Delete button to remove a category from the list. 

8. Optionally, click Add. 

9. Type the new type into the Displayed Value and Stored Value text boxes. 

10. Repeat steps 8 and 9 to add the remaining missing types. 

11. Optionally, drag the category to a new location in the list to reorder them. 

12. Click Save. 

13. Click the Layer drop-down and select Maintenance. 

14. Click the Maintenance type display name. 

In the List of Values (Domain) section, review existing categories and identify ones that 
are not applicable and ones that are missing. 

15. Repeat steps 6-12 to add missing maintenance types. 

 

Administer field assignments 
The Tree Management solution can be used to manage work such as data collection, routine 

and ad-hoc inspections and maintenance assigned to field staff. Types of assignments appear 

in the Tree Assignments ArcGIS Workforce mobile app used by mobile workers as well as the 

Tree Assignments ArcGIS Workforce project and Create Tree Assignment ArcGIS Survey123 

form in the Tree Management Center app. 

The Tree Management solution includes several assignment types. In some cases, you may 

want to modify inspection and maintenance types to meet your organization’s needs. Mobile 

workers and dispatchers also need to be given roles in the Tree Assignments ArcGIS 

Workforce project. 

 

Administer tree assignments 
1. Verify that you are signed in to your ArcGIS organization and click the Apps button  in 

the header of the site. 
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2. From the app launcher, click Workforce to open the app. 

3.  Under Projects, hover over the Tree Assignments project, and click Configure. 

4. Click the Assignment Types tab. 

In the Assignment Type section, review existing types and identify ones that are not 
applicable and ones that are missing. 

5. Type a new assignment type in the Enter a new type text box then click + Type button. 

6. Click the Users tab. 

7. From the Organization User drop-down menu, select a user to add to the project. 

8. From the Project Role menu, assign the user either the dispatcher role or mobile worker 
role. 

9. Click +User. 

10. Click the Advanced tab. 

Each assignment type is integrated to the Tree Field Map. This allows field staff to 
access the Tree Field Map from the ArcGIS Workforce app. As you add new assignment 
types, you may want to add the Tree Field Map integration. 

11. In the ArcGIS Field Maps, click Edit on any of the existing Tree Field Map integrations. 

Check the box next to the new assignment type. Click the Next button. 

12. Click the Done button. 

13. Optionally, remove the ArcGIS Field Maps integration for assignment types that are not 
needed in your organization.  

Removing the integration is necessary to remove the assignment type from the Tree 
Assignments ArcGIS Workforce project. 

14. Click the Assignment Types tab. 

15. To remove assignment types, click the X button. 

 

Update create tree assignment form 
1. In your ArcGIS organization, browse to the Tree Assignments feature layer. 

Before populating the new assignment types into the Create Tree Assignment form, you 
will first copy the GlobalID for each new assignment type. 

2. Open the item page and click Open in Map Viewer. 

3. On the Contents (dark) toolbar, click Tables. 

4. Click Assignment Types layer. 

5. Click Tools in the table header and check the GlobalID field to show (unhide) in the 
table. Click Done to close the pop-up window. 

6. Expand the GlobalID field and copy each new assignment type's ID.  

7. Paste the copied GlobaIID or GlobalIDs into Microsoft Notepad or another text editor for 
reference. 
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8. Install ArcGIS Survey123 Connect. 

9. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

10. Click Create Tree Assignment to download the survey. 

11. In the Download window, click Download and click OK. 

12. Click Create Tree Assignment to open the survey. 

13. On the left, from the side toolbar, click the XLSForm button. 

14. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 

This tab comprises all the selectable options for survey questions. 

15. In the list_name column type ASSIGN_TYPE.  

16. In the name column, copy and paste the GlobalID, before and after the GlobalID add 
curly braces (for example, {5b3e80df-aec7-4739-929f-8cb70cdbd62c}).  

17. In the label column, type the assignment type. 

18. Repeat steps 15 through 17 for each new assignment type. 

19. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

20. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

21.  Click Publish survey to publish your changes, and then click OK. 

 

Modify service request types 
The Tree Management solution can be used to solicit tree requests for service from field staff 

as well as the general public. Service request types appear in the Tree Requests Internal and 

Tree Requests ArcGIS Survey123 forms. 

The Tree Management solution includes several service request types. In some cases, you 

may want to modify service request types to meet your organization’s needs. For example, 

you may want certain request types available to field staff using the Tree Requests Internal 

form that are not available to the general public using the Tree Requests form. 

1. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization. 

2. Click Tree Request to download the survey. 

3. In the Download window, click Download and click OK. 

4. Click Tree Requests to open the survey. 

5. On the left, from the side toolbar, click the XLSForm button. 

6. At the bottom of the Microsoft Excel spreadsheet, click the choices tab. 

This tab comprises all the selectable options for survey questions. 

7. In the list_name column type reqtype.  

8. Type the new service request type into the name and label columns. 

9. Repeat steps 7 and 8 for each new service request type. 
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10. Save and close the Microsoft Excel spreadsheet and preview your changes in ArcGIS 
Survey123 Connect. 

11. In ArcGIS Survey123 Connect, in the left toolbar, click Publish to publish your changes. 

12. Click Publish survey to publish your changes, and then click OK. 

13. Click Tree Request Internal to download the survey. 

14. Repeat steps 3 through 12 to add new service request types to the Tree Request 
Internal form.  

 

Configure Our Urban Forest site 
The Tree Management solution includes the Our Urban Forest ArcGIS Hub site that your 

organization can configure with your branding and use to share urban forest information with 

the public. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Our Urban 
Forest site. 

2. From the item page, click Configure. 

3. If necessary, click the Edit button  to open the site editor. 

4. Scroll to the Frequently Asked Questions section, hover over the card, click the edit 
pencil, and update the questions and answers. 

5. In the side panel, click Footer. 

A custom footer is provided. In most cases, you will need to update it with your 
organization's branding, contact information, and social media references. 

6. Click the HTML box. 

The HTML window appears. 

7. Make the necessary changes and click Apply. 

8. Click Save. 

9. When you're finished click the Save drop-down then Publish Draft. 

 

Share items with the public 
Several layer views, maps and apps included in the Tree Management solution must be 

shared with everyone so they can be accessed by the public on the Our Urban Forest site. To 

share your Our Urban Forest items with everyone, use the guide below and complete the 

following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Tree 
Management folder. 

2. Check the check box next to each of the items below: 
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Item Name 

Feature Layer (hosted, view) Trees_public 

Feature Layer (hosted, view) Requests_submit 

Feature Layer (hosted, view) TreeStewardship_public 

Web Map Tree Viewer 

Web Scene Tree Viewer (3D) 

Web Experience Tree Viewer 

Form Tree Request 

Site Application Our Urban Forest 

  

3. Click Share. 

4. In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

5. Click Update. 

 

Administer tree stewardship program 
The Tree Management solution can be used to cultivate a volunteer workforce of tree 

stewards. Mapping technicians can configure the Approved Tree Stewards group and Tree 

Steward Notebook to help volunteer coordinators manage the tree stewardship program 

efficiently. 

 

Manage approved stewards group 
1. Verify that you are signed in to your ArcGIS organization and browse to the Approved 

Tree Stewards group. 

2. Open the group and click the Settings tab. 

3. In the Group membership section, select Partnered collaboration and my 
organization's members only for the Who can be in this group setting. 

4. Click the Overview tab. 

The group Description contains a message sent to newly approved tree stewards. 

5. Optionally, click Edit in the Description section to modify the message to your 
organization's needs. When you're finished click Save. 

 

Share Tree Steward Application with Hub Community Members group 
To apply to the program a user must have a community user account and be signed into the 

Our Urban Forest site. To grant access to the Tree Steward Application, share the form and 

the TreeStewardship_submit feature layer to the Hub Community Members group. This group 
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is automatically created during Hub Premium activation and contains all members of your 

community organization. As new community members join, they will be automatically added to 

this group and will have access to the Tree Steward Application form. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Tree 
Management folder. 

2. Check the box next to the Tree Steward Application Form and TreeStewardship_submit 
Feature Layer (hosted, view). 

3. Click Share. 

4. In the Share window, click Edit group sharing. 

5. Check the box next to the Hub Community Members group. 

Note: 

The Hub Community Members group will only be available to users who were 
administrators of the org when Hub Premium was activated. If you don’t see this group 
work with Hub Community organization administrator to get access to this group. 

6. Click OK. 

7. Click Save. 

 

Schedule the Tree Stewardship Notebook 
When volunteer coordinators use the Tree Stewardship Center app to approve volunteer 

stewards, the Tree Steward Notebook grants volunteers access to the Tree Care Activities 

form and sends an e-mail to new volunteers. 

Follow the steps below to schedule the Tree Steward Notebook to run as a scheduled task. 

Note: 

You must be assigned a role of Administrator or custom role which includes the privilege 
to create, edit and schedule notebooks in order to run and schedule ArcGIS Notebooks 
and complete the following steps. 

1. Verify that you are signed in to your ArcGIS organization and browse to the Tree Steward 
Notebook item. 

2. Open the item page and click Open Notebook. 

3. Click Tasks.  

4. Click Create Task.  

5. For Title, type Tree Stewardship Task and click Next.  

6. The task can be configured to run nightly by selecting Day from the Repeat Type drop-
down then selecting 1 - Every Day from the Repeat Interval drop-down. 

7. Select a Time for the task to run like 3:00 AM. 
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8. Click Create Task to finish scheduling the notebook 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Use Tree Management 
The Tree Management solution delivers a set of capabilities that help you inventory publicly 

owned trees, conduct routine inspection and maintenance assignments, understand tree 

conditions, engage volunteers, and inform the public. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 
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Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Manage tree data 
The first, and most critical, step a local government must take to manage its urban forest is to 

create a tree inventory. A local government cannot effectively manage its urban forest and 

plan improvements unless officials know how many publicly owned trees they have and where 

they are located. 

You will first assume the role of a mapping technician responsible for maintaining an 

authoritative tree inventory. The Tree Data Management ArcGIS Pro project includes a series 

of tasks to help guide you through these workflows. 

 

Get started 
First, you will download an ArcGIS Pro project. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Tree 
Management solution. 

2. Download the Tree Data Management desktop application template, and then unzip the 
folder. 

3. From the unzipped folder, open the Tree Data Management project. 

4. In the Catalog pane, expand the Tasks folder, and then double-click the Tree Data 
Management task. 

Note: 

If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, click the Getting Started task group to expand the collection of tasks. 

Tree Data Management is used to load and create authoritative tree inventory data used 
in the Tree Management apps such as Tree Field Map and Tree Viewer. 

6. Before proceeding to subsequent tasks, follow the instructions in the Add tree layer task 
to add the Trees feature layer deployed with the solution. 

 

Extract and load tree points from Lidar 
Tree location, size, and width can be extracted from ground-classified lidar as point features. If 

trees are classified in the lidar, the quality of the tree extraction will improve. 

In the Task pane, expand the Extract and load tree points from Lidar group task and follow 

the steps provided. Review the Required data task. 
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Optionally, complete the Download sample data task. Sample data is provided to help you 

learn how to use the Tree Data Management task. A link is provided to download sample 

data for Naperville. Using the sample data the first time will help you learn how to use the 

tasks and how to organize your data. 

Optionally, run the tool in the Classify trees in lidar using deep learning task to classify 

trees in the lidar using a deep learning model. Classified trees will improve the vegetation 

extraction, but keep in mind that deep learning is computationally very intensive, and a 

powerful GPU is needed to process large datasets faster. Depending on data size and 

available hardware, it can take hours to finish. Start with one LAS file to determine processing 

time on your system. 

To work with the deep learning tools in ArcGIS Pro, you must install supported deep learning 

frameworks packages. See deep learning frameworks for ArcGIS. 

A tree classification model trained by Esri can be downloaded from ArcGIS Living Atlas of the 

World or you can create your own model using the Training a Deep Learning model for Point 

Cloud Classification notebook that can be found in the notebooks folder of the Tree Data 

Management ArcGIS Pro project. 

Extract tree points using surface analysis—Use this tool to extract tree points from the 

lidar using surface analysis. This type of extraction is faster for large lidar datasets, but the 

results are less accurate than using cluster analysis for dense lidar (point spacing less than 

1.5 feet/0.5 meters). 

Extract tree points using cluster analysis—Use this tool to extract tree points from the lidar 

using cluster analysis. This type of extraction is slower for large lidar datasets, but the results 

are more accurate than using surface analysis. 

Note: 

When creating the 3D trees, verify the Vegetation class code. The correct class codes 
for vegetation is typically 5. The tool will verify whether your lidar has this code, but trees 
might be represented by other codes as well. Visually review your lidar and verify what 
class code tree points have by clicking a tree lidar point. If the vegetation has not been 
classified, enter the class code that represents the vegetation, for example, 0 or 1. 

Tip: 

Use the Extract tree points using surface analysis tool to create an initial vegetation layer. 
Run the Extract tree points using cluster analysis tool for lidar files for which you need 
detailed trees and replace the trees from the initial layer with the more detailed trees 
where needed. 

Append extracted trees to layer—Use this task to load tree points extracted in the previous 

tasks into the Trees feature layer deployed with the solution. 
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Load, create, and modify tree data 
In the Task pane, expand the Load, create, and modify tree data group task. 

Your organization may have existing tree data, which can be loaded into the Trees feature 

layer. Use the Load existing tree data task to load your organizations's existing tree 

inventory data into the Trees feature layer deployed with the solution. 

You may need to create new tree data prior to conducting a field inventory if existing data is 

not available. Follow the instructions in the Create new tree data task to create new trees. 

Use the Modify trees task to modify created data. 

 

Collect and assess trees in the field 
In many cases, a field assessment of publicly owned trees may be the most efficient way to 

develop a tree inventory. Information collected in the field can also enhance and verify trees 

extracted or loaded using the Tree Data Management ArcGIS Pro project. Recording tree 

condition through routine and ad hoc inspections provides important information needed to 

plan improvements. 

You will now assume the role of a mobile worker responsible for conducting a tree inventory in 

the field as well as condition assessments and recording maintenance activities. In this 

workflow, you are asked to use the ArcGIS Field Maps mobile app to access your Tree Field 

Map and inventory trees in your community. 

 

Collect trees in the field 
To collect trees in the field, complete the following steps: 

1. Download ArcGIS Field Maps onto your mobile device. 

2. Open ArcGIS Field Maps and sign in to your ArcGIS organization. 

3. Tap Tree Field Map to open the map. 

4. Tap Add. 

Trees are collected according to their planting space status. A planting space can be 
Planted, Available, Retired, Stump, or Other. 

5. Tap Planted. 

6. Drag the map to the correct location, and then click Add Point. 

7. Swipe up on the form and tap Common name to choose the tree's common name, and 
then provide all other required information in the Tree Details section. 

8. Tap Planting Space to expand the form, and then provide planting space information as 
needed. 

9. Tap Ownership Details to expand the form, and then provide tree ownership information 
as needed. 

10. Tap Nearest address to provide the nearest site address. 
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When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

11. Repeat these steps to collect additional trees. 

The fields in the Tree Field Map form are configured according to planting space status. 
When collecting a Planted tree, Available space, Retired space, Stump, or Other 
feature, the form will present the appropriate fields. 

12. On the Tree Field Map, tap a tree. 

13. Tap Edit. 

14. Optionally, pan the map to update the tree's location, and then tap Update Point.  

15. Swipe up on the form to modify the tree's information. 

16. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

Assess trees in the field 
To assess trees in the field, complete the following steps: 

1. On the Tree Field Map, tap a tree. 

2. Swipe up on the form to review the tree's information. 

3. Swipe up on the form to the Related section. 

4. Tap Maintenance. 

Previously recorded maintenance activities are displayed. When present, tap the 
maintenance record and swipe up on the form to review the information. 

5. Tap Add. 

6. Swipe up on the form to expand the form.  

7. Tap Maintenance Type to enter the type of maintenance activity completed.  

8. Optionally, tap Start date to enter the date the maintenance activity was started.  

9. Tap Date finished to enter the date the maintenance activity was completed. 

10. Optionally, tap Status to modify the status of the maintenance record. 

11. Optionally, tap Notes to enter maintenance notes. 

12. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 
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13. Swipe up on the form to review the recorded maintenance information.  

14. In the Related section, tap Trees to return to the Tree feature. 

15. Swipe up on the form to the Related section. 

16. Tap Inspections. 

Previously recorded inspections are displayed. When present, tap the inspection record 
and swipe up on the form to review the information. 

17. Tap Add. 

18. Swipe up on the form to expand the form.  

19. Tap Inspection Type to enter the type of inspection.  

20. Tap Inspection date to enter the date the inspection was completed.  

21. Optionally, tap Status to modify the status of the inspection record. 

22. Tap Tree condition to record the condition of the inspected tree. 

23. Optionally, tap Evidence of disease to record evidence of disease. 

24. Optionally, tap Evidence of pests to record evidence of pests. 

25. Optionally, tap Planting space condition to record the condition of the planting space. 

26. Optionally, tap Sidewalk condition to record the condition of an adjacent sidewalk. 

27. Optionally, tap Sidewalk damage to record the appearance of sidewalk damage. 

28. Optionally, tap Inspection notes to enter inspection notes. 

29. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

30. Swipe up on the form to review the recorded inspection information.  

31. In the Related section, tap Trees to return to the Tree feature. 

32. Swipe up on the form and tap Request Service. 

33. Complete the Tree Request form to report a request for service. 

34. When you're finished, tap Submit. 

Note: 

Your interface may vary depending on the type of mobile device you use. 

 

Complete field assignments 
Field staff will often receive work through assignments that help organize tasks to be 

completed and communicate the status of work to operations and maintenance supervisors. 

1. Download ArcGIS Workforce onto your mobile device. 
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2. Open ArcGIS Workforce and sign in to your ArcGIS organization. 

3. Tap the Tree Assignments map. 

4. In the To do list, tap an assignment to view its location on the map and see details about 
the assignment. 

5. In the assignment details, tap Directions to see a list of installed navigation apps, and 
then tap the app you want to use and allow ArcGIS Workforce to open it. 

The app opens, generating a route to your assignment. 

6. In the assignment details, tap Start to begin working on an assignment. 

7. Optionally, tap Add Note to enter information for the operations and maintenance 
supervisors, and then tap Done. 

8. Optionally, tap Take Photo to take and attach a photo. 

9. Optionally, tap Attach to record video and audio and to attach other photos from your 
device. 

10. Swipe up and tap Open Tree Field Map. 

The Tree Field Map opens in ArcGIS Field Maps and defaults to the location of the 
assignment. 

11. After you have finished collecting data or recording work in the Tree Field Map, return to 
the ArcGIS Workforce app. 

12. To pause, decline, or reset the assignment, tap the Overflow button  and tap the 
appropriate status, or tap Cancel. 

13. In the assignment details, tap Finish when you have completed the assignment. 

14. Optionally, tap To Do and tap Completed to view your completed assignments. 

15. Optionally, tap Sync  (  if you have edits that aren't synced) and tap Sync Now 
to sync them. 

  Changes to the status of your assignments automatically syncs with your ArcGIS 
organization at the default interval of every 15 minutes. 

 

Manage operations 
You will now assume the role of an operations and maintenance supervisor responsible for 

organizing routine and ad hoc inspections and maintenance activities as well as an arborist 

responsible for monitoring tree conditions. 

In this workflow, you are asked to use the Tree Management Center app to monitor field 

activities and conditions, manage requests for service, and assign work. 

 

Monitor conditions 
To monitor conditions, complete the following steps: 
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1. In a browser, sign in to your ArcGIS organization, and then browse to the Tree 
Management solution. 

2. View the Tree Management Center application.  

The Home page of the Tree Management Center app displays metrics that help you 
understand your organization's tree inventory as well as requests for service that need to 
be addressed and work that needs to be assigned to field staff. 

3. In the upper right, click Trees to open the Trees page. 

4. Review the high-level metrics, such as Inspections Completed and Tree Condition. 

5. Use the charts to filter and explore inspections and maintenance activities. 

Note: 

Dashboard charts are linked. If you click a condition in the Tree Condition chart or a 
month on the By Month tab in the Inspection History charts, related details are 
filtered and updated in other elements in the dashboard. 

6. On the map, use the select tool to select a tree. 

Note: 

Map selections are linked. If you select a tree in the map, related details are filtered 
and updated in other elements in the dashboard. 

7. In the Inspection History table, click an inspection record to view its details in the 
Details panel.  

8. In the Maintenance History table, click a maintenance record to view its details in the 
Details panel.  

9. In the Tree Inventory feature details pane, click the Create Assignment button. 

The Create Tree Assignment form opens. 

10. Complete the form to create an assignment that you will assign to field staff.  

11. When you're finished, click Submit, and then return to the Tree Management Center app. 

12. On the left, click the arrow to display the filter panel, and then use filters to explore the 
tree inventory by genus, species, common name, date planted or inspected, or other 
specification. 

Tip: 

To pin the filter panel, click the pin in the upper-right corner. 

 

Respond to and monitor requests for service 
To respond to and monitor service requests, complete the following steps: 

1. In the upper right, click Requests and choose Manage. 
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2. In the Tree Requests table, click the Status column filter, and then for Status is, choose 
Submitted to view requests for service with a submitted status. 

3. Click the Submitted On column header and choose Sort in descending order. 

4. Click a service request feature. 

Its details open at the lower left. 

5. In the details, on the Details tab, click the Edit Record button . 

6. For Status, choose Received. 

7. Click Save. 

8. In the Tree Requests table, click the Status column filter, and then for Status is, choose 
Received to view requests for service with a received status. 

You will create an assignment so that the request for service can be addressed by field 
staff. 

9. In the table, click the service request feature to view its details. 

10. On the Details tab, click Create Assignment. 

The Create Tree Assignment form opens. 

11. Complete the form to create an assignment that you will assign to field staff.  

12. When you're finished, click Submit, and then return to the Tree Management Center app. 

13. In the upper right, click Requests and choose Monitor. 

14. Use the charts to filter and explore active and resolved requests for service. 

  Dashboard charts are linked. As you click and select a category in one chart, related 
details are filtered and updated in other charts on the service request to allow a manager 
to identify issues and areas that need attention. 

 

Manage field assignments 
To manage field assignments, complete the following steps: 

1. In the upper right, click Assignments. 

2. At the bottom of the pane, click the Assignments tab. 

3. From the list of assignments, click an assignment, if present.  

4. In the upper left, click Assign and choose a mobile worker who will complete the work. 

5. Optionally, click the Edit button to modify the Priority, Description, or other assignment 
details.  

6. When you're finished, click Save. 

7. Click the back button. 

8. On the map, select a tree and review its information, and then click + Assignment. 

You can also use the search box on the map to search by address, place, or tree asset 
ID. 
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9. Choose an Assignment Type and assign a mobile worker. 

10. Click Create Assignment. 

 

Learn about the community's urban forest 
Trees garner significant interest from community residents that would like to understand their 

characteristics, benefits, and condition and also report requests for service such as hazards or 

new plantings. 

You will now assume the role of a community resident who is interested in learning about the 

condition of publicly owned trees in their neighborhood or around their home. 

1. In a browser, from the Tree Management solution, view the Our Urban Forest site. 

2. Scroll to the Explore the Trees section, and then click the Explore button to open the 
Tree Viewer app. 

The Tree Viewer app opens in a new tab. 

3. In the left panel, on the Home tab, review the information. 

4. Click the Details tab, and then on the map, click a tree. 

Details about the tree that you selected appear in the left panel. 

5. Review the tree's information, such as its common name, height, and condition. 

The Details pane displays Recent Maintenance recorded by the organization and 
Recent Tree Steward Activities reported by volunteers. 

6. On the map, at the lower left, click the globe. 

The Tree Viewer app displays a 3D scene of the trees. 

7. In the 3D scene, click a tree to view its information in the Details pane. 

8. Close the Tree Viewer app and return to the Our Urban Forest site. 

 

Solicit requests for service 
The Our Urban Forest site can be used to solicit service requests from the public so that small 

problems can be tackled quickly and efficiently before they become large and costly. You will 

continue to assume the role of a resident, now reporting a request for tree service. 

1. Scroll to the Request Service section, and then click the Submit Request button to 
open the Tree Viewer app. 

The Tree Viewer app opens in a new tab. 

2. On the map, click the tree that you want to request service for, and then in the left panel, 
click the Details tab. 

3. Click Request Service. 

The Tree Requests form opens in a new tab. 

4. Complete the form, and then click Submit. 
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  The request type on the Tree Requests form will be prepopulated when requesting 
service for an available space or stump. 

 

Volunteer as a steward 
Public works and parks organizations cultivate a volunteer workforce to help improve the 

health of trees. Tree steward programs allow volunteer stewards to help care for trees in the 

neighborhood or around their house and report their activities to the organization. 

You will now assume the role of a community resident who is interested in volunteering in the 

tree steward program. 

1. In a browser, from the Tree Management solution, view the Our Urban Forest site. 

2. Scroll to the Become a Tree Steward section. 

If visitors to the site are not signed in, the Our Urban Forest site displays the buttons to 
Create an account or Sign In with an existing account. If a user is signed in to the site, 
the Our Urban Forest site displays an Apply button, which can be used to access the 
Tree Steward Application form. In the following steps, the user has created an account 
and is signed in to the Our Urban Forest site. 

3. Click the Apply button. 

4. Complete the Tree Steward Application form to express interest in becoming a volunteer 
tree steward. 

The application will be reviewed by a volunteer coordinator. After the application has 
been approved, the volunteer can access the Tree Care Activities form to report 
stewardship activities. 

5. Close the Tree Steward Application and return to the Our Urban Forest site. 

6. Scroll to the Care for a Tree! section. 

The Care for a Tree! section is displayed when a volunteer's Tree Steward Application 
has been approved by the volunteer coordinator. 

7. Click the Report Care button. 

The Tree Viewer app opens in a new tab. 

8. On the map, click the tree that you have cared for, and then click the Details pane. 

9. Click the Report Care button. 

The Tree Care Activities form opens in a new tab. 

10. Complete the form recording the activity date, duration, and activities completed to report 
your volunteer tree care to the organization. 

11. Close the Tree Care Activities form and the Tree Viewer app and return to the Our Urban 
Forest site. 

Manage volunteer stewards 
You will now assume the role of a volunteer coordinator responsible for managing the tree 

stewardship program and monitoring volunteer activities. 
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In this workflow, you are asked to use the Tree Stewardship Center app to review and 

approve volunteer applications and monitor volunteer activities. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Tree 
Management solution. 

2. View the Tree Stewardship Center app. 

The Home page of theTree Stewardship Center app displays metrics that help you 
understand the tree stewardship program, and it states whether there are pending 
applications to be reviewed. 

3. In the upper right, click Manage. 

4. In the Stewards table, click the Status column filter, and then for Status is, choose 
Pending to view volunteer applications with a pending status. 

5. Click a volunteer application to view its details. 

The details open at the lower left. 

6. On the Steward tab, click the Edit Record button . 

7. For Status, choose Approved. 

8. Click Save. 

The Tree Steward Notebook can be used to schedule a process that grants access to the 
Tree Care Activities form to approved tree stewards. 

9. In the table, remove the Status column filter. 

10. Click an approved volunteer to view details. 

11. Click the Care Activities tab to view reported tree care activities.  

12. Review the tree care information, and then click View Tree to open the Tree Viewer app 
and view the tree's location and information. 

13. Return to the Tree Stewardship Center app, and then in the upper right, click Monitor. 

14. Use the charts to filter and explore stewards and tree care activities. 

Dashboard charts are linked. When you click and select a category in one chart, related 
details are filtered and updated in other charts. 

15. From the dashboard header, use the Activity Date and Stewards filters to explore tree 
care and steward activities.  

  

 

Vaccine Coverage Analysis 
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This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Vaccine Coverage Analysis 
Vaccine Coverage Analysis can be used to identify underserved populations and optimize 

plans for disease vaccination sites. 

Comprehensive vaccination coverage is one of the most effective ways to stop a pandemic 

and reopen communities. Communities of color and socioeconomically vulnerable areas are 

disproportionately burdened when vaccinations are available but underutilized. Identifying 

areas of low vaccination rates and vulnerable populations can help ensure equitable vaccine 

distribution. Vaccine Coverage Analysis is typically implemented by health and human 

services or public safety agencies that want to optimize the location of vaccination sites, 

maximize limited resources, and ensure communities affected the most have access to 

vaccines. 

The Vaccine Coverage Analysis solution delivers a set of capabilities that help you identify 

priority and underserved populations, locate optimal vaccination sites, and share vaccine site 

information with internal and external stakeholders. 

 

Requirements 
Vaccine Coverage Analysis requires the following: 

• ArcGIS Enterprise 

• ArcGIS Pro 2.7–ArcGIS Pro 2.9 (Advanced) 

• ArcGIS Geostatistical Analyst extension 

 

 

 

 

 

 

Information products 
Vaccine Coverage Analysis includes the following information products: 

Item Description Minimum user 
type 
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Vaccine 
Coverage 
Analysis 

An ArcGIS Pro project used by health and human 
services analysts to identify priority and underserved 
populations, locate optimal vaccination sites, and share 
vaccine site information with internal and external 
stakeholders 

GIS 
Professional 
Advanced 

 

Release notes 
The following are the release notes: 

Version Description 

1.2 • An update to the Vaccine Coverage Analysis ArcGIS Pro project to resolve a 
bug in the Create Ranked Surface tool. 

1.1 • Added support for single dose vaccines and revised vaccination rate 
calculation. 

• Resolved an issue in the Configure Existing Sites model that prevented the 
Append tool from functioning properly in ArcGIS Pro 2.8. 

1.0 • First release of Vaccine Coverage Analysis 

 

 

 

 

 

 

 

 

 

 

 

 

Use Vaccine Coverage Analysis 
The Vaccine Coverage Analysis solution delivers a set of capabilities that help you identify 

priority and underserved populations, locate optimal vaccination sites, and share vaccine site 

information with internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 
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Identify coverage gaps 
Priority populations and vaccine rates can be used to identify underserved populations quickly 

using the Vaccine Coverage Analysis project. Current vaccination statistics collected from 

vaccination sites and priority populations will help you identify areas that have low vaccination 

rates and high-priority populations. 

You will start by assuming the role of a health and human services analyst. You are asked to 

use the Vaccine Coverage Analysis project to identify underserved populations. 

1. Sign in to your ArcGIS organization and browse to the Vaccine Coverage Analysis 
Desktop Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Vaccine Coverage Analysis ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Vaccine Coverage 
Analysis task. 

6. In the Tasks pane, click the Identify underserved populations task group to expand 
the collection of tasks. 

7. In the Tasks pane, double-click the Prepare vaccination and priority population task 
and follow the steps provided. 

8. Double-click the Create coverage map task and follow the steps provided. 

9. Double-click the Evaluate current vaccine distribution by drive time task and follow 
the steps provided. 

 

Locate vaccination sites 
The best vaccination sites can be quickly located with the Vaccine Coverage Analysis project. 

Use the previously identified coverage gaps and a list of candidate sites to locate new sites in 

your community. 

You will continue to assume the role of a health and human services analyst. You are asked 

to use the Vaccine Coverage Analysis project to select the best vaccination sites from a list of 

candidate sites that meet needs defined in the vaccine gap analysis. 

1. Open the Vaccine Coverage Analysis ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Vaccine Coverage 
Analysis task. 

4. In the Tasks pane, click the Locate vaccination sites task group to expand the 
collection of tasks. 

5. In the Tasks pane, double-click the Identify potential distribution sites task and follow 
the steps provided. 

6. Double-click the Select new points of distribution task and follow the steps provided. 
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Vision Zero 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 
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Introduction to Vision Zero 
Vision Zero can be used to solicit transportation hazards and dangerous traffic behaviors on 

roadways from bikers, drivers, pedestrians, and others using public streets. 

Traffic collisions result in thousands of deaths each year and many communities are 

beginning to tackle this public health problem by adopting Vision Zero programs. Vision Zero 

programs engage many internal and external stakeholders (for example, the general public, 

planners, engineers, public health officials, and policymakers) and use data-driven strategies 

to create safer roadways for travelers. A key aspect of any Vision Zero program is a web 

destination that helps agencies share key initiatives with the public and solicit feedback from 

stakeholders. Feedback is then used to understand perceived problems, visualize trends, and 

inform policies. Vision Zero is typically implemented by public works, transportation, and 

public safety agencies that want to engage stakeholders and use data to reduce traffic 

hazards in their community. 

The Vision Zero solution delivers a set of capabilities that help you share your Vision Zero 

strategy with the public, solicit transportation hazards and dangerous traffic behaviors from 

key stakeholders, manage each reported hazard, and monitor the status of its resolution. 

 

Requirements 
Vision Zero requires the following: 

• ArcGIS Enterprise 

 

 

 

 

 

 

Information products 
Vision Zero includes the following information products: 

Item Description Minimum user type 

Vision Zero An ArcGIS Hub site used by public works, 
transportation, and public safety agencies to 
communicate strategies to eliminate traffic deaths 
of and life-altering injuries to travelers in the 
community. 

Not required 

Vision Zero 
Pledge 

An ArcGIS Survey123 form used by the general 
public to pledge to practice safe driving behaviors 
and obey all traffic laws. 

Not required 
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Transportation 
Hazard Reporter 

A Crowdsource Reporter app used by the 
general public to report transportation hazards 
and dangerous traffic behaviors that could lead to 
fatalities or serious injuries. 

Not required 

Transportation 
Hazard Manager 

A Crowdsource Manager app used by public 
works, transportation, and public safety agencies 
to triage transportation hazards submitted by the 
general public. 

Editor 

Transportation 
Hazard 
Dashboard 

An ArcGIS Experience Builder app used by 
public works, transportation, and public safety 
agencies to monitor transportation hazards and 
dangerous traffic submitted by the general public. 

Viewer (required if 
the app is used for 
internal purposes 
only) 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Vision Zero 

 

 

 

 

 

 

 

 

 

Configure Vision Zero 
In this topic, you will learn how to configure the Vision Zero solution to meet specific needs in 

your organization. 

 

Modify hazard types and responsible agencies 
Vision Zero includes problem types and responsible agencies for hazard reports. In some 

cases, you may want to add a problem type. In addition, you may want to modify the 

responsible agencies provided to more accurately reflect the name of the agency, department, 

or team that is responsible for responding to hazard reports. 

1. Sign in to your ArcGIS organization and browse to the TransportationHazardReports 
feature layer. 
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2. Open the item page and click the Data tab. 

3. Click Fields. 

4. Click the Problem observed display name. 

Review the List of Values (Domain). Identify domains that are missing or need to be 
removed from the list. 

5. Click Edit next to List of Values (Domain). 

6. Optionally, click Add. 

7. Type the problem type in the Displayed Value and Stored Value text boxes. 

8. Repeat steps 6 and 7 to add the remaining problem types. 

9. Optionally, click Delete to remove a problem type. 

10. Optionally, click in the Label text box with an existing problem type and change the 
name. Repeat this step to change the Code value as well. 

11. Optionally, drag the problem type to a new location in the list to reorder them. 

12. Click Save. 

 

Now, let’s review the list of responsible agencies and modify it to meet the needs of your 

organization. 

1. Click the Assigned To display name in the left panel. 

Review existing agencies and identify missing ones in the List of Values (Domain) 
section. 

2. Click Edit next to List of Values (Domain). 

3. Optionally, click Add. 

4. Type the new agency name in the Displayed Value and Stored Value text boxes. 

5. Repeat steps 3 and 4 to add the remaining missing agencies. 

6. Optionally, click Delete to remove an agency. 

7. Optionally, click in the Label text box with an existing agency labeled and change the 
agency name. Repeat this step to change the Code value as well. 

8. Optionally, drag the category to a new location in the list to reorder them. 

9. Click Save. 

 

Update the pledge survey 
The Vision Zero Pledge survey allows you to enlist the general public in practicing safe driving 

behaviors. Review the preconfigured questions and align the survey with your organizational 

policies and desired outcomes. 

To modify the Vision Zero Pledge survey, complete the following steps: 
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1. Verify that you are signed in to your ArcGIS organization and browse to the Vision Zero 
Pledge form. 

2. Open the item page and click Open in Survey123 > Manage in Survey123 website. 

3. Click the Design tab. 

4. Edit the survey and save the changes. 

5. Click Publish twice. 

 

Configure the Vision Zero site 
The Vision Zero solution includes the Vision Zero ArcGIS Hub site that your organization can 

configure with your branding and use to share strategies to eliminate traffic deaths of and life-

altering injuries to travelers in the community. 

 

Update with organizational information 
After deploying the Vision Zero solution, the Vision Zero site layout requires a few updates to 

fit your local context. Consider what information you already have and what you can most 

easily find. To update your site, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Vision Zero 
site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the By the Numbers section listed under the title of the website. 

The Taken the Vision Zero Pledge statistic card is linked to the Vision Zero solution’s 
VisionZeroPledge_opendata feature layer. The stat is automatically updated as pledges 
are submitted. 

The Fatalities and Seriously Injured cards are text cards but styled to resemble the 
summary statistics cards; this allows you the option to manually enter a statistic of your 
choice, independent of the solution data. 

5. Hover over the Fatalities card and click the edit pencil . 

6. Update the number of traffic fatalities. 

7. Hover over the Seriously Injured card and click the edit pencil. 

8. Update the number of traffic-related injuries. 

9. Scroll to the Transportation Hazards section, hover over the Other Reporting Methods 
card and click the edit pencil. 

10.  Click the Edit in HTML option and update the phone number, and click Apply. 

11. Scroll to the Frequently Asked Questions section, hover over the card and click the edit 
pencil, and update the questions and answers. 
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12. Scroll to the Additional Resources section, hover over an image card, and click the edit 
pencil. 

13. On the side panel, provide a URL to an image in the text box or click Upload to upload 
an image associated with the resource. 

14. Hover over the text card, click the edit pencil, and update the text. 

15. Click the Learn More button and click Edit. 

16. Enter a URL in the Link Destination text box and click Add Link. 

17. Scroll to the Partner section, hover over an image card, and click the edit pencil. 

18. On the side panel, provide a URL to an image in the text box or click Upload to upload 
an image associated with a partner you want to promote on the site. 

19. To modify your site’s footer, click Customize Toggle  on the side panel. 

20. Click Footer.  

A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

21. Click the HTML text box. 

The HTML window appears. 

22. Make the necessary changes and click Apply. 

23. Click Save. 

 

Share Traffic Crash Analysis apps 
You can enhance the Vision Zero site with additional public-facing applications included with 

the Traffic Crash Analysis solution. The High Injury Network Locator helps the general public 

locate streets and intersections where concentrations of serious and fatal traffic crashes 

occur. You can share the Fatal and Serious Injury Dashboard so the general public can locate 

crashes that resulted in serious injury or fatality. To share the apps on the Vision Zero site, 

complete the following steps: 

1. Verify you are signed in to your ArcGIS organization and browse to the Fatal and Serious 
Injury Dashboard web experience. 

2. Open the item page and click the Share button. 

3. In the Share window, click Edit group sharing. 

4. Enter Vision Zero Maps in the search text box. 

5. Click the check box next to the Vision Zero Maps group. 

6. Click OK. 

7. Click Save. 

8. Repeat steps 2-6 for the High Injury Network Locator app. 

9. Click Update in the Update sharing window. 
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Share items with the public 
Several layer views, maps, and apps included in the Vision Zero solution must be shared with 

everyone so they can be accessed by the public on the Vision Zero site. To share your items 

with everyone, use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. Click Groups at the top of the site. 

3. Open the Transportation Hazard Reporter group page and click the Settings tab. 

4. Under Who can view this group, click Everyone (public), and click Save. 

5. Click Content at the top of the site. 

6. On the My Content tab, under Folders, type Vision Zero in the search box. 

7. Click the Vision Zero folder. 

8. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, view) TransportationHazardReports_public 

Web Map Transportation Hazard Reporter 

Web Mapping Application Transportation Hazard Reporter 

Feature Layer (hosted, view) TransportationHazardReports_dashboard 

Web Map Transportation Hazard Dashboard 

Dashboard Transportation Hazard Desktop Dashboard 

Dashboard Transportation Hazard Mobile Dashboard 

Web Experience Transportation Hazard Dashboard 

Form Vision Zero Pledge 

Feature Layer (hosted) VisionZeroPledge_public 

Feature Layer (hosted) VisionZeroPledge_opendata 

Site Application Vision Zero 

9. Click Share. 

10. In the Share window, click Everyone (public) and click Save. 

The Warning: Sharing editable layers publicly message appears notifying you that 
you are sharing editable layers publicly. 

11. Click Update. 

 

Extend Vision Zero 
You can extend the Vision Zero solution with a set of Python tools that can be used to 

generate report IDs, moderate reports, send email notifications, and enrich reports. These 
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tools can be executed automatically via Task Scheduler and as new problem reports are 

submitted, or updated, the corresponding action will occur. 

 

Add the ServiceFunctions toolbox 
The ServiceFunctions toolbox contains tools for generating report IDs, moderating reports, 

sending email notifications, and enriching reports. Download and add the ServiceFunctions 

toolbox to your ArcGIS Pro project before configuring the appropriate tools. 

1. Download the ServiceFunctions toolbox. 

2. Browse to the ServiceSupport.zip file and unzip the file to the location from which you 

want to the tools to execute. 

3. Open ArcGIS Pro and create a new project. 

4. Sign in to the ArcGIS organization to which you deployed the Vision Zero solution, if 
necessary. 

5. On the View tab, in the Windows group, click the Catalog pane, if necessary. 

6. In the Catalog pane, right-click Toolboxes and choose Add Toolbox. 

The Add Toolbox dialog box appears. 

7. Browse to the ServiceSupport folder. 

8. Click the ServiceSupport.pyt Python toolbox, and click OK. 

9. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

If you've never used the ServiceSupport toolbox before, run the Define Connection 
Settings tool to establish a connection between the toolbox and the 
TransportationHazardReports feature layer. 

10. In the Catalog pane, in the ServiceSupport.pyt Python toolbox, double-click the Define 
Connection Settings tool. 

11. In the ArcGIS Online organization or ArcGIS Enterprise portal URL parameter, click 
the drop-down arrow and choose a URL. 

12. In the Username parameter, type your user name for the organization you chose in step 
11. 

13. In the Password parameter, type your password for the user name provided in the 
Username. 

14. Click Run. 

 

Generate report IDs 
Many workflows require you to generate a unique identifier when a feature or record is created 

so it can be referenced and tracked in other workflows. You can use the Generate IDs tool to 

configure custom unique identifiers that will be applied to features at a regularly scheduled 

interval of your choosing. The tool only generates the configuration; you must run an 

additional script (provided) to update the features with incrementing identifier values. 
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1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt, if necessary. 

2. Double-click the Generate IDs tool. 

3. In the Layer parameter, click Browse. 

The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Vision Zero folder. 

6. Double-click the TransportationHazardReports feature layer. 

7. Click Transportation Hazard Reports, and then click OK. 

Expand General Identifier Settings. If the tool has not been run previously, start by 
specifying at least one identifier sequence. 

8. In the Sequence Name parameter, type a name for the sequence. 

This value appears in the drop-down menu for selecting the sequence to assign to each 
layer. 

9. In the Pattern parameter, type a pattern to use for the sequence. 

This can be a combination of letters, numbers, and symbols. Mark the location for the 
incrementing value with a pair of curly braces {}. Python formatting is applied to the 
pattern text, so string formatting syntax such as {0:03d} pads the incrementing number 
section with zeros to a length of 3. For example, the expression seq-{0:05d} creates the 
following pattern of values: seq-00001, seq-00002, seq-00003, and so on. 

10. In the Next Value parameter, type a value. 

When initially creating the sequence, this must be the first value in the identifiers. After 
this point, this value shows the value to be used for the next identifier generated. 

11. In the Interval parameter, type a value. 

The interval by which the identifier values increase between features. For example, an 
initial Next Value of 1 and an Interval of 10 creates identifiers with the incrementing 
values of 1, 11, 21, and so on. 

Deleting or changing these sequences impacts all the layers that are configured to use 
the edited sequences. 

12. Optionally, edit the identifier configuration and run the tool to overwrite the existing 
identifier configuration for the selected layer. 

Note: 

If an identifier configuration already exists, a check box appears that, when checked, 
deletes the existing identifier configuration for the selected layer. 

13. Choose the moderation list to use to process the features in the selected layer. 

14. Choose the sequence to use to generate the identifiers for each feature in the layer. 

15. Choose a text field to store the generated identifier. 

16. Click Run to write out the identifier configuration for the layer and any changes to the 
identifier sequences. 
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17. To configure identifiers for another layer, rerun the tool with the settings for the next 
layer. 

General Identifier Settings are not specific to any one layer—they apply to all layers 

configured using this tool. 

 

Moderate reports 
Public comment apps can occasionally generate feedback that should not be made publicly 

visible. Data entered into specific fields, such as personal information, can be hidden and 

protected using the pop-up configuration and layer security, but sometimes entire comments 

need to be hidden to avoid displaying sensitive or explicit content to other users. 

You can hide features by updating the value of a field so that it no longer meets the 

requirements of a filter applied to that layer in the map. You can use the Moderate Reports 

tool to configure which layers and fields to scan for explicit or sensitive words and phrases 

and how to update the feature so that it can be filtered from the map. You can choose how 

often to scan features and records. The tool only generates the configuration; an additional 

script (provided) must be run to scan the features. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Moderate Reports tool. 

3. In the Layer parameter, click Browse. 

The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Vision Zero folder. 

6. Double-click the TransportationHazardReports feature layer. 

7. Click Transportation Hazard Reports, and then click OK. 

Expand General Moderation Settings. If the tool has not been run previously, start by 
specifying at least one moderation list. 

8. In the List Name parameter, type a name. 

This value appears in the drop-down menu for selecting the moderation list use when 
scanning each layer. 

9. In the Filter Type parameter, click the drop-down arrow and choose to scan feature for 
words and phrases that exactly match the provided list of words and phrases. 

For example, when the filter type is EXACT, if the list contains the word duck, the script 
updates the specified field when the feature contains the word duck, but not when it 
contains the word duckling. When the filter type is FUZZY, the script updates the feature 
when either duck or duckling are found. 

10. In the Words and Phrases parameter, type a word or phrase. Provide a comma-
separated list of words or phrases to scan for. 

Keep in mind that deleting or changing these lists will impacts all the layers that are 
configured to use the edited sequences. 
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11. If a moderation configuration already exists for the selected layer, choose to edit an 
existing configuration by selecting the name of the moderation list used in the 
configuration, or choose the option to add a new moderation configuration. 

If you choose to edit an existing configuration, a check box appears that, when checked, 
deletes the existing moderation configuration for the selected layer. Alternatively, edit the 
moderation configuration and run the tool to overwrite the existing moderation 
configuration for the selected layer and moderation list. 

To add a new moderation configuration, click the Add New button and continue with the 
following steps. 

12. Choose the moderation list to use to process the features in the selected layer. 

13. Choose the fields that will be scanned for content that matches the words and phrases in 
the selected moderation list. 

14. Optionally, provide an SQL query to only apply moderation to some features. 

If no query is provided, all features are processed. 

15. Use the Field to Update parameter when a match is found between the value of a field 
and the content of a moderation list. Use the Found Value parameter to specify the 
value that should be written to this field indicating a match. 

16. Click Run. 

 

Send email notifications 
Many workflows require that an email be sent when a feature or record is created and 

updated. You can use the Send Emails tool to configure emails that can be sent based on 

attribute values and a schedule of your choosing. The tool only generates the configuration; 

you must run an additional script (provided) to actually generate and send the emails. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Send Emails tool. 

3. In the Layer parameter, click Browse. 

The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Vision Zero folder. 

6. Double-click the TransportationHazardReports feature layer. 

7. Click Transportation Hazard Reports, and then click OK. 

All existing email settings for the layer load and can be edited by updating the parameter 
values for each configuration. To delete a single email configuration, click the Remove 

button  next to the configuration. To delete all the email configurations for the layer, 
check the Delete all existing email configurations for this layer check box. Run the 
tool to save your changes. 

8. In the Email Template parameter, click Browse to access the ServiceSupport folder. 

9. Click one of the HTML templates for the body of the email, and click OK. 
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To add attributes from the triggering feature to the email, use unique string keys in the 
places where the values should appear in the HTML and reference these strings in the 
Find parameter of the Email Substitutions section of the General Email Settings along 
with the name of the field that contains the value to be substituted for the string key in the 
Replace parameter. 

10. Optionally, in the SQL Query parameter, provide an SQL query to only trigger an email 
from specific features. 

If no query is provided, all features trigger emails every time the script is run, so you most 
likely want to use this query along with the Field to Update and Sent Value parameters 
to ensure that the same email isn't sent repeatedly for the same feature. 

11. In the Recipient Email Address parameter, type an email address of the recipient or the 
name of a field in the layer that contains the address of the recipient. 

12. In the Email Subject parameter, type the subject for the email. 

Similar to the email body provided in the HTML document, this text can contain string 
keys that will be swapped out for attribute values based on the Find and Replace values 
defined in the Email Substitutions list in the General Email Settings section. 

13. In the Field to Update parameter, type Email. When the email has been sent for each 

feature, use the Sent Value parameter to specify the value that should be written to this 
field indicating that the email has been sent. 

This field and value can be used in the previously described SQL query to prevent 
duplicate emails from being sent. 

14. Configure additional emails to be sent for the currently selected layer by clicking the Add 
New button. 

Emails will be sent in the order they are configured. Expand General Email Settings. If 
the tool has not been run previously, start by specifying the connection information for 
your SMTP server in the tool. 

15. In the SMTP Server parameter, type the URL of the SMTP server used for sending 
emails. 

16. In the SMTP Username parameter, type the user name required to authenticate to the 
SMTP server. This is not required if authenticating through a port. 

17. In the SMTP Password parameter, type the password required to authenticate to the 
SMTP server. This is not required if authenticating through a port. 

18. In the From Address parameter, type the address from which the emails should be sent. 

19. In the Reply Address parameter, type the address that should be used for any replies to 
the email message. 

20. Check or uncheck the Use TLS check box to turn on or off TLS. 

21. In the Email Substitutions section, type Find and Replace values. Swap out one piece 
of text for another in the outgoing email subject or body.  

Anywhere a value in the Find parameter is found in the email subject or body, it will be 
replaced with the corresponding value from the Replace parameter. If the value in the 
Replace parameter is a field in the layer, the Find value will be replaced with the value in 
that field in the triggering feature. For example, to add the ID of a feature from the 
REQUESTID field to the email subject, include a piece of text such as {ID} in the 
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configured Email Subject, and add {ID} to the Find parameter and REQUESTID to the 
Replace parameter. All specified substitutions are applied to all emails configured for all 
layers so, while the Find values can be any piece of text, it's suggested that you use 
something that is clearly variable-like and unlikely to appear elsewhere in the messages 
in a literal form. 

Deleting or changing these settings impacts all the emails for all the layers configured 
with this tool. 

22. Click Run. 

 

Enrich reports 
Reports made in public comment apps can be enriched with information about the report 

location. You can then use this information to efficiently direct the report to the correct person 

or agency responsible for its resolution. 

You can then use the Enrich Reports tool to configure which attribute values to calculate from 

a coincident or intersecting set of features at a regularly scheduled interval of your choosing. 

Note that the tool only generates the configuration; you must run an additional script 

(provided) to update the features based on intersecting features. 

1. In the Catalog pane, expand Toolboxes and ServiceSupport.pyt. 

2. Double-click the Enrich Reports tool. 

3. In the Layer parameter, click the browse button. 

The Layer dialog box appears. 

4. Under Portal, click My Content. 

5. Double-click the Vision Zero folder. 

6. Double-click the TransportationHazardReports feature layer. 

7. Click Transportation Hazard Reports, and then click OK. 

8. In the Enrichment parameter, if an enrichment configuration already exists for the 
selected layer, choose to either edit an existing configuration by selecting the 
configuration from the drop-down list, or choose the option to add a new enrichment 
configuration. 

If you choose to edit an existing configuration, a check box appears that, when checked, 
deletes the existing enrichment configuration for the selected layer. Alternatively, edit the 
configuration and run the tool to save the changes. To add a new enrichment 
configuration, click the Add New button and continue with the following steps. 

9. Choose the polygon feature layer that will provide the enriching attribute values by either 
choosing a layer from the active map or by browsing to your hosted content and choosing 
a polygon feature layer. 

10. In the Source Field parameter, click the drop-down arrow and choose a field from the 
enrichment layer. 

11. In the Target Field parameter, click the drop-down arrow and choose a field from the 
TransportationHazardReports feature layer. 
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The script does not process features that already have a value in the target field. 

12. In the Priority parameter, type a value. Specify the priority that should be given to this 
enrichment configuration relative to the other configurations for the 
TransportationHazardReports feature layer.  

Enrichment configurations for a layer that have a lower priority value will override 
enrichment configurations with a higher value. For example, a layer has two enrichment 
configurations that use the same target field, but one has a priority value of 1 and the 
other has a priority of 2. If the configuration with priority 1 does not produce a valid value 
for the field, the field is populated with the value produced from the configuration with 
priority 2. 

13. Click Run. 

 

Set up Task Scheduler 
Use Windows Task Scheduler to schedule the script to generate report IDs when a feature or 

record is created, moderate reports when feedback contains inappropriate language, send 

email notifications when a feature or record is created or updated, or enrich reports. All the 

tools in this toolbox share a common configuration file and execution script, so only one 

scheduled task is required to automate running all the associated processes. 

1. Open the Task Scheduler on the computer that is hosting the scripts. 

2. Click Action > Create Task and name your task. 

3. Click the Action tab and click New. 

4. Set Action to Start a Program. 

5. Browse to the location of your Python 3 installation (for example, <default 
directory>\C:\Program Files\ArcGIS\Pro\bin\Python\envs\arcgispro-
py3\python.exe). 

6. In the Add arguments text box, type the name of the script (servicefunctions.py). 

7. In the Start in text box, type the path to the folder where your script is and click OK. 

8. Click the Trigger tab, click New, and set a schedule for your task. 

9. Click OK. 

When the trigger occurs, the scripts begin scanning the configured layers and, for each one, 

processing (in order) configurations for generating identifiers, enriching reports, moderating 

reports, and sending emails. 
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Use Vision Zero 
The Vision Zero solution delivers a set of capabilities that help you share your Vision Zero 

strategy with the public, solicit transportation hazards and dangerous traffic behaviors from 

key stakeholders, manage each reported hazard, and monitor the status of its resolution. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Submit a traffic hazard 
You will first assume the role of a concerned resident in the community who wants to notify 

the city of a problem that you observed. 

1. In a browser, from the Vision Zero solution, view the Vision Zero site. 

2. Scroll to the Transportation Hazards section and click Report Hazard. 

3. In the Transportation Hazard Reporter app, at the lower right, click Submit a Hazard. 

4. Complete the form with as much information as possible. 

5. Click Report It. 

6. At the top of the Transportation Hazards form, click the arrow to return to the list. 
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7. At the top of the list, click the problem that you just submitted. 

Information about the problem that you reported appears. As the report moves through its 
life cycle (Submitted, Received, In Progress, and Completed), the status bar updates. 

8. Below the status bar, click Leave a reply. 

You or others can add comments to update or highlight information related to the initial 
problem reported to authorities. 

9. Optionally, add and submit a comment; otherwise, click Cancel. 

 

Respond to hazard reports 
You are now a city employee who is responsible for responding to submitted transportation 

hazard problem reports, assigning them to the appropriate department for resolution, and 

providing the resolution information when completed. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Vision Zero 
solution. 

2. View the Transportation Hazard Manager app. 

All problem reports are listed in the table at the top. The table can be sorted and filtered 
in various ways. 

3. In the table, use the column header filters and arrows to filter results. 

4. Select a problem with a status of Submitted. 

The problem details open at the lower left. 

5. In the details, on the Details tab, click the Edit Record button . 

6. For Visible to the Public, choose Yes. 

7. For Status, choose Received. 

8. Click Save. 

The next step is to investigate the location for Vision Zero improvements. You'll change 
the status to In Progress and assign the problem to the most appropriate department. 

9. Click the Edit Record button again. 

10. For Status, choose In Progress. 

11. For Assigned To, choose the appropriate department. 

12. Click Save. 

After the department assigned to the problem informs you that the problem has been 
investigated and improvements to the intersection have been submitted for review, you'll 
change the status to Completed. 

13. Click the Edit Record button again. 

14. For Status, choose Completed. 
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15. In the Resolution text box, type Improvements submitted to Vision Zero 
taskforce for review. 

16. Click Save. 

  Because the issue has been completed, the status indicator has changed, and the details 
now provide information about when and how the issue was resolved. 

 

Monitor reports and measure performance 
As a program manager for the city, you want to know how well the Vision Zero program is 

functioning and monitor the reports coming in. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Vision Zero 
solution. 

2. View the Transportation Hazard Dashboard app. 

3. On the left, use filters to refine results by status, transportation mode, problem, or date. 

4. Use the graphs to filter and explore active and resolved problem reports. 

5. In the Hazard Reports list, click a report to zoom to it on the map and open a pop-up 
with more information. 

 

Take the Vision Zero pledge 
As an engaged resident of the community, you want to take the Vision Zero pledge to commit 

to streets that are safe, accessible, and shared by everyone in the community. 

1. In a browser, from the Vision Zero solution, view the Vision Zero site. 

2. Scroll to the Vision Zero Pledge section and click Take the Pledge. 

3. Complete the Vision Zero Pledge survey, and then click Submit. 
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Walkout Survey 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Walkout Survey 
Walkout Survey can be used to streamline the management of communication walkout 

surveys and quickly evaluate the feasibility of proposed broadband expansion projects. 

In a connected world, access to reliable broadband communications service is essential. 

Today, the FCC estimates that approximately 35% of Americans do not have reliable access 

to service (25MB download / 3MB upload). To close this gap and increase overall broadband 

speeds, public and private funding is pouring into the communications market and driving 

expansion of existing communications networks. Every day, communication organizations are 

building out broadband infrastructure to reach new customers and businesses. Before 

construction begins, detailed field surveys are required to determine the most optimum and 

cost-effective route. Walkout Survey is typically implemented by communication organizations 

that want to collect critical asset information needed to plan new communication network 

projects and validate proposed network routes. 
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The Walkout Survey delivers a set of capabilities that helps you streamline the management 

of walkout surveys and quickly evaluate the feasibility of proposed broadband expansion 

projects. 

 

Requirements 
Walkout Survey requires the following: 

• ArcGIS Enterprise 

• ArcGIS Notebook Server 

• ArcGIS Workforce 

• ArcGIS Field Maps 

 

 

 

 

Information products 
Walkout Survey includes the following information products: 

Item Description Minimum 
user type 

Walkout Survey 
Center 

An ArcGIS Experience Builder app used operations 
managers to create, manage, assign, and monitor 
walkout survey projects 

Creator 

Walkout Survey 
Assignments 

An ArcGIS Workforce project used by operations 
managers to assign walkout survey projects to field 
staff 

Mobile 
Worker 

Field Walkout 
Survey 

An ArcGIS Field Maps map used by field staff to collect 
walkout survey assets along a proposed network 
expansion route 

Mobile 
Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Walkout Survey 
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Configure Walkout Survey 
Walkout Survey can be used to streamline the management of communication walkout 

surveys and quickly evaluate the feasibility of proposed broadband expansion projects. 

In this topic you'll learn how to configure the Walkout Survey solution to meet specific needs in 

your organization. 

 

Configure ArcGIS Workforce project 
In this workflow you'll assume the role an operations manager responsible for setting up the 

ArcGIS Workforce project. 

1. Sign in to your ArcGIS organization and click the Apps button  in the header of the 
site. 

2. From the app launcher, click Workforce to open the app. 

3. Under Projects, hover over the Walkout Survey Assignments project, and click 
Configure. 

4. Click the Overview tab. 

5. Click the Assignment Types tab. 

6. Click the Users tab. 

7. Click the Advanced tab. 

8. From the Organization User drop-down menu, select a user to add to the project. 

9. From the Project Role menu, assign the user either the dispatcher role or mobile worker 
role. 

10. Click +User. 
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11. Repeat the steps above for each dispatcher and mobile worker. 

 

Brand Walkout Survey Center 
In this workflow, you'll assume the role of an operations manager who wants to customize and 

brand the Walkout Survey Center app to fit your organizations needs. 

1. Navigate to the item page for the Walkout Survey Center app and click the Edit button.  

2. Click the Page button to open the page panel. 

3. Use the Header node of the page panel to edit the header. 

4. Select the App Title section and edit the title to brand the app to your organization.  

5. In the Body node of the page panel click the Background section.  

6. On the Background settings panel on the right click Background under the Views 
section and change the background color or add an image. 

7. On the Page panel select the Help page. 

8. To update the text or images select an element in the layout and make the necessary 
changes.  

9. Click Save on the Experience Builder designer header bar, then click Publish.  

 

Add asset map layers 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

The Walkout Survey solution is configured with what you need to manage broadband 

expansion projects. Communication organizations can add their asset layers to the maps to 

enhances the solution and provide situational awareness of existing assets. 

In this workflow you'll assume the role of an operations manager who wants to add your 

organizations data to the following maps. 

1. Open the Field Walkout Survey map by clicking Open in Map Viewer Classic.  

2. Add your organizations asset data to the map. 

Note: 

Configure layer names and pop-ups to meet your organizations needs. 

3. Click Save > Save to save the map. 

4. Repeat as needed with the following maps: Walkout Survey Manager and Walkout 
Survery Reviewer. 
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Use Walkout Survey 
The Walkout Survey delivers a set of capabilities that helps you streamline the management 

of walkout surveys and quickly evaluate the feasibility of proposed broadband expansion 

projects. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Create broadband expansion project 
Increasing broadband access to customers is crucial for communication organizations and 

public entities. Organizations need to be able to efficiently evaluate the feasibility of a new 

network expansion project. Creating and managing walkout survey projects allows 

organizations to save time and monitor the progress of projects. 

 

Add a new project 
In this workflow, you will assume the role an operations manager who wants to create a new 

walkout survey project. 

1. Sign in to your ArcGIS organization and browse to the Walkout Survey Center web 
experience. 

2. Open the item page and click View. 

3. Click the Manage button in the app header to open Manage page. 

The Edit Project widget is opened by default, which allows you to create and edit 
existing walkout survey projects. 

4. Use the Search widget to look for your area of interest and choose the appropriate 
address from the drop-down list. 

5. On the Edit Project widget, type the name of the project in the Project Name field.  
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Define the project name once and the Project Editor widget will add the project name to 
all new project features. Additionally, the project name cannot be changed one the 
project feature is created. 

6. To create a Project Area, click the Proposed template. 

Note: 

The Project Area should always be created first. 

7. On the map, draw a new Project Area. 

You are prompted with a Project Area form. 

8. Fill in the form with the Project Area information. 

9. Click Save to complete the Project Area creation workflow. 

10. Repeat steps 6-9 to create a new Initial Route or follow the steps below to load an 
existing route into the walkout survey project. 

a. Open the Add Data widget, add an initial route to the map using the Search, URL or 
File tab. 

b. On the Edit Project widget, select the Initial Route template and from the drop-
down below select Copy by rectangle. 

c. On the map select the route that you like to add to the project.  

d. Click Create Feature and update the Initial Route form with the necessary details. 

e. Click Save to complete the loading of the Initial Route workflow. 

11. Repeat steps 6-9 to create a new Target Site. 

 

Create a project package 
In this workflow, you will assume the role of an operations manager who wants to create 

project package and provide it the field staff team to perform the walkout survey in the field. 

Note: 

You must be assigned a role of Administrator or custom role which includes the privilege 
to Create and edit notebooks in order to run an ArcGIS Notebooks and complete the 
following steps. 

1. Verify you have the Walkout Survey Center web experience open. 

2. Click the Manage button in the app header to open Manage page. 

3. Open the Project Creator widget to and click the Project Creator button to open the 
Project Creator notebook. 

4. Click Cell > Run All to load the project packaging form in this notebook. 

5. Select the newly create project from the drop-down and click Create Project Package. 

6. Click the Open Project Folder link to see the project items. 
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7. Check the check box next to each of the items below: 

Item Name 

Feature Layer (hosted, 
view) 

<Project Name> 

Web Map Field Walkout Survey - <Project Name> 

8. Click Share. 

9. In the Share window, click Edit group sharing. 

10. Check the box next to the group that you want to share the item with. 

11. Click OK and click Save. 

 

Assign walkout survey 
The ability to perform walkout surveys requires field staff to be assigned to perform the 

assessment by the dispatcher. Assigning and tracking the field staff member performing the 

work allows the dispatcher to streamline field operations for the network expansion project. 

In this workflow, you will assume the role of a dispatcher who wants to assign field staff with to 

perform a walkout survey. 

1. Verify you have the Walkout Survey Center web experience open.  

2. Click the Assign button in the app header to open Assign page. 

3. Click + Assignments. 

4. For Assignment Type, choose Field Assessment for high-level assessment or Field 
Survey for an in-depth walkout survey. 

5. Click Search for an address and type the project name from the result to view its details 
and click + Create Assignment. 

a. Move the blue pin on the map to the desired start location of the walkout survey 
project. 

6. Under Assigned to, click Assign and select the mobile worker who will complete the 
work. 

7. For Priority, choose a priority level for the assignment. 

8. Click Due Date, and in the date picker, choose the appropriate date as the due date and 
time for the assignment to be completed. 

9. If you use a work order management system, in the ID field, type the work order number 
for this assignment. 

10. In the Description text box, type all the information the mobile worker needs to know to 
complete their assignment. 

11. Under Attachments, add any relevant attachments to the assignment. 

12. Click Create Assignment to create the assignment and assign it to the mobile worker 
specified. 
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  The mobile worker receives the notification on their mobile device. 

 

Conduct walkout survey 
Performing a walkout survey is critical to determining if a proposed network expansion project 

is feasible. Field staff conduct walkout surveys to provide accurate and current information to 

determine the feasibility of network expansion projects. 

In this workflow, you will assume the role of a field staff member who has been assigned to 

perform a walkout survey. 

1. Download ArcGIS Workforce onto your mobile device. 

2. Open ArcGIS Workforce and sign in to your ArcGIS organization. 

3. Tap the Walkout Survey Assignments map. 

4. Tap Download. 

5. Tap the Walkout Survey Assignments map to open it. 

6. In the To do list, tap an assignment to view its location on the map and see details about 
the assignment. 

7. In the assignment details, tap Directions. A list of navigation apps that are installed on 
your device appears. Tap the app you want to use and allow Workforce to open it.  

The app opens, generating a route to your assignment. 

8. In the assignment details, tap Start to begin working on an assignment. 

9. In the assignment details, tap Take Photo to take and attach a photo. 

10. Tap Attach to record video and audio and to attach other photos from your device. 

11. Swipe up and tap Open in Field Maps. 

12. Search for the Field Walkout Survey - <Project Name> map. 

13. Tap the Field Walkout Survey - <Project Name> map to open it. 

14. Browse to the collection location. 

15. Tap Add and tap General Assets. 

16. Tap Edit. 

17. Swipe up on the form and tap Notes to provide any important information about the 
asset. 

18. Swipe down and tap Add Point. 

19. When you're finished, at the top right, tap the check mark or Submit. 

Note: 

Your interface may vary depending on the type of mobile device that you use. 

20. Add the asset to the walkout survey project by tapping Related button  the tap Add. 
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21. Provide any notes about the specific asset for this project and click Submit. 

The asset has now been added to the walkout survey project. 

22. Tap the Project Area polygon on the map then tap the Related button  and select 
Walkout Survey Observation, Fielded Route or Target Site. 

23. Add the selected feature to the map. 

Learn more about capturing features 

24. Tap the Project Area polygon on the map, tap the Related button  the select Project 
Table. 

This table provides a list of all the assets collected for this specific walkout survey project. 

25. After you have finished collecting data, return to Workforce. 

26. To pause, decline, or reset the assignment, tap the Overflow button  and tap the 
appropriate status, or tap Cancel. 

27. In the assignment details, tap Finish when you have completed the assignment. 

28. Optionally, tap Sync  (  if you have edits that aren't synced) and tap Sync Now 
to sync them. 

  Changes to the status of your assignments automatically syncs with your ArcGIS 
organization at the default interval of every 15 minutes. 

 

Monitor project progress 
The process of performing walkout surveys is critical to expansion project moving forward. 

Monitor the progress of the field survey helps the operations manager to quickly evaluate the 

route expansion feasibility. 

In this workflow, you will assume the role of an office staff member who wants to perform a 

walkout survey. 

1. Verify you have the Walkout Survey Center web experience open.  

2. Click the Monitor button in the app header to open the Monitor page. 

3. Use the Project Status and Project Creation Date filters to filter walkout survey 
projects. 

4. On the Project Details tab, review the Project Information list and click on a project.  

Click a project from the list filters the Pole Information tab and the General Assets 
section. 

5. On the Pole Information tab, review the high-level metrics for poles collected during 
walkout surveys. 

6. Use the Pole Type and Violation charts to filter the Pole Information list. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://doc.arcgis.com/en/field-maps/android/help/capture.htm


    Back to top 

Copyright © 2024 Esri. All rights reserved. | Privacy | Legal                                                                          Page 869 

Note: 

Dashboard charts are linked when clicking on charts related details are filtered and 
updated in other elements in the dashboard. 

 

Update project status 
Once the survey has been performed and completed the status of the project can be updated 

to reflect the progress. The ability to update the status streamlines the workflow and lets all in 

your organization know the current state of the project. 

In this workflow, you'll assume the role of an office staff member who wants to manage 

walkout survey project projects. 

1. Verify you have the Walkout Survey Center web experience open.  

2. Click the Manage button in the app header to open Manage page. 

3. Open the Filter Project widget and select Project Name or Status to filter the map.  

4. To update the status of a project open the Edit Project Status and click on the project 
area on the map that you would like to update. 

5. To update the status of the walkout survey project, select a new status from the drop-
down list. 

  This updates all related features with a status field. If the status is set to an archived 
status it will be filtered from the map. 
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Water Distribution Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Water Distribution Data 

Management 
Water Distribution Data Management can be used to map water distribution assets, edit data, 

view system maps in the field and office, view asset reports, and collaborate with map notes. 

It turns ArcGIS into a system for water distribution organizations to easily inventory their 

assets and keep information up to date. It provides simple to use interactive system maps and 

dashboards for office and field staff, and increases collaboration. 

After deploying, organizations with no water distribution data can immediately begin mapping 

their water distribution systems using GPS or digitizing data with web or desktop software. 

Organizations with existing spatial water distribution data can load it and begin using the apps. 

 

Requirements 
Water Distribution Data Management requires the following: 

• ArcGIS Enterprise 
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• ArcGIS Pro 2.9 (Basic, Standard, or Advanced) 

• ArcGIS Field Maps 

 

 

 

 

 

 

 

 

Information products 
Water Distribution Data Management includes the following information products: 

Item Description Minimum user type 

Water Distribution 
Data Manager 

An ArcGIS Pro project package used to 
manage water distribution system data and 
map notes 

GIS Professional 
(Basic, Standard, or 
Advanced) 

Water Distribution 
Editor 

An ArcGIS Web AppBuilder application 
used to edit water distribution system data 
and map notes 

Editor 

Water Distribution 
Viewer 

An ArcGIS Web AppBuilder application 
used to view water distribution map and 
create map notes 

Editor 

Water Distribution 
Dashboard 

An ArcGIS Dashboards application used to 
view water distribution asset information 

Viewer 

Water Distribution 
Map Notes 
Manager 

An ArcGIS Web AppBuilder application 
used to review and manage map notes 

Editor 

Water Distribution 
Mobile Viewer 

A map used in ArcGIS Field Maps to view 
water distribution system assets and view or 
create map notes 

Mobile Worker 

Water Distribution 
Asset Collector  

A map used in ArcGIS Field Maps to 
capture and modify water distribution assets 
and create map notes from the field 

Mobile Worker 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • Manufacturer and Model fields were added to the Hydrant Maintenance 
Inspection table to support the Water Utility Hydrant Inspections solution. 
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1.3 • The Minimal Gallery app has been removed from the solution item. 

1.2 • Name changed from Water Distribution Data Management for ArcGIS Online 
to Water Distribution Data Management. 

1.1 • Added Backflow device to the feature service. 

• Added tables for Backflow, Hydrant Maintenance, Hydrant, Meter, and System 
Valve inspections. 

1.0 • First release of Water Distribution Data Management for ArcGIS Online. 

 

 

Configure Water Distribution Data Management 
The Water Distribution Data Management solution can be configured to meet specific needs in 

your organization. The sections below outline some administrative tasks to update and 

manage the solution to fit your organization's needs. 

 

Load data 
In some cases, you may need to load existing data into the solution before sharing the maps 

or applications. Review the maps or applications provided with the solution and determine 

what, if any, source data you want to load. Water Distribution Data Management also includes 

a data model to store information about typical Water Distribution system assets. To explore 

the schema, view the data dictionary. 

Tip: 

If you do have to load data into the solution, you may want to develop a source-target 
matrix to track how your source data will be loaded into the target layer or layers used in 
the solution. 

Depending on the format of your source data, you may choose to append your source data to 

the new layers. Once you have determined what source data must be loaded, complete one of 

the data loading workflows below: 

 

Use the Append tool 
In ArcGIS Pro, the Append can be used to append multiple input datasets to an existing target 

dataset. Input datasets can be point, line, or polygon feature classes. 

To append features to the target layer or layers using the Append tool, complete the steps 

below: 

1. In ArcGIS Pro, sign in to your ArcGIS organization. 
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2. To open the Water Distribution Data Manager project, click Open another project, 
click My Content under Portal, double-click the Water Distribution Data Management 
folder, and click Water Distribution Data Manager. 

3. Add your existing source layers to a new map. To add the target feature layers from the 
WaterDistributionSystem feature service, click My Content under Portal, double-click the 
Water Distribution Data Management folder, and add the WaterDistributionSystem 
feature service to the map. 

4. On the Analysis tab, in the Geoprocessing group, click Tools to open the 
Geoprocessing pane. 

5. In the search bar, type Append and click to open the Append tool. 

6. Add your existing water distribution data from the map to the Input Datasets parameter. 

7. For Target Datasets, use the WaterDistributionSystem features in the map. 

8. In the Schema Type parameter, use the drop-down menu to choose Use the Field Map 
to reconcile schema differences to perform field mapping. 

9. Update your field mapping and click Run. 

10. Repeat this process as needed to load all your existing data into the target Water 
Distribution schema. 

 

Use the Data Loading Tools 
The Data Loading toolbox can be used in ArcGIS Pro to streamline loading data from a source 

to a target dataset and provide the ability to perform in-process data transformation. Setup the 

Data Loading toolbox before getting started with the steps below. 

1. Open the Water Distribution Data Manager project. 

2. On the Project tab, click Python to access the Python Package Manager. 

3. Under Project Environment, click Manage Environments. 

4. Click Clone Default  to clone your default environment.  

5. Click the Active button for the new environment, and click OK.  

6. Restart ArcGIS Pro to allow your environment changes to take effect. 

7. In the Python Package Manager, click Add Packages to see the Python packages 
available for installation. 

8. Click Refresh  to update the list of available packages. 

9. In the Search box, type dltsolutions to find the Data Loading Tools toolbox.  

10. Select the dltsolutions package and click the drop-down arrow to update the version. 

11. Click Install. 

The Install Package dialog box appears. 

12. Review the terms and conditions and check the box to agree.  

13. Click Install to install the package. 
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14. Once the installation is complete, close ArcGIS Pro.  

The Data Loading Tools toolbox is now installed. The next time you start ArcGIS Pro, you 
can access it from the geoprocessing toolboxes. 

15. Review An overview of the Data Loading toolbox to learn more about the tools and how 
to use them to load data into the WaterDistributionSystem layers.  

 

Configure the Water Distribution Data Manager 

ArcGIS Pro project 
The Water Distribution Data Manager project includes a Water Distribution Data Manager map 

with broken links. 

1. In ArcGIS Pro, sign in to your ArcGIS organization. 

2. To open the Water Distribution Data Manager project, click Open another project, 
click My Content under Portal, double-click the Water Distribution Data Management 
folder, and click Water Distribution Data Manager. 

3. In the Catalog pane, expand Maps and double-click Water Distribution Data Manager 
to open the map. 

4. In the Contents pane, click the red exclamation point  next to the Map Notes layer. 

The Change Data Source dialog box appears. 

5. Click My Content under Portal, double-click the Water Distribution Data Management 
folder, double-click the MapNotes_managing feature service, and double-click the Map 
Notes layer.  

6. In the Contents pane, click the red exclamation point  next to the Service Connection 
layer. 

The Change Data Source dialog box appears. 

7. Click My Content under Portal, double-click the Water Distribution Data Management 
folder, double-click the WaterDistributionSystem_editing feature service, and double-
click the Service Connection layer.  

The data source is repaired for the remaining layers. 

8. In the Contents pane, right click the Water Distribution Data Manager map and click 
Properties. 

9. Click the Coordinate Systems tab. In the XY Coordinate Systems Available section 
select the coordinate system that matches the layers in the map. 

Note: 

Ensure the coordinate system of the map matches that of the feature layers deployed 
in the solution. If these do not match there may be discrepancies in what units are 
displayed in the map. 

10. Click Save to save the project. 
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Add members to groups in your organization 
Included with Water Distribution Data Management are four groups designed to help 

managers organize their members based on their privileges and their work. The solution 

includes the following groups: Water Distribution Editors, Water Distribution Field Users, 

Water Distribution Map Notes Managers, and Water Distribution Office Users. 

To add members to the groups, complete the following steps: 

1. In a browser, sign in to your ArcGIS organization. 

Verify that you have privileges to manage member groups before continuing. 

2. Click Groups at the top of the site. 

3. Click the name of the group to open the group details pages. 

4. On the Settings tab, edit and update the properties of the group, including access, 
sharing properties, and group ownership. 

5. Click the Overview tab and click Invite users.  

6. Select the members you want to add and click Add to group. 

7. Repeat steps 3 through 6 for each group you need to add members to. 

The provided groups are intended to be utilized by members with a minimum of the following 

user types in order to fully use the provided maps and apps: 

Group name User type 

Water Distribution Editors • Editor 

• GIS Professional Basic with ArcGIS Pro (minimum of 
one license recommended) 

Water Distribution Field 
Users 

• Mobile Worker 

Water Distribution Map 
Notes Managers 

• Editor 

Water Distribution Office 
Users 

• Editor 

 

Set the default map extent to your service territory 
When the Water Distribution Data Management solution is deployed into your organization, it 

uses the map default set in your organization. If this property has not been set, you may want 

to quickly update a few maps and apps to your service territory manually to avoid having to 

pan and zoom to your area each time you open a map. Follow the steps below to update the 

initial extent of the maps and apps provided with this solution. 

1. In a browser, sign in to your ArcGIS organization. 

2. To set the default map extent for the Water Distribution Viewer application, browse to 
the Water Distribution Viewer item page and click Edit Application. 
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3. On the Map tab, zoom the map to the desired extent and click Use current map view 
under Set initial extent. Click Save. 

4. Repeat steps 2 and 3 to set the default map extent for the Water Distribution Editor 
and Water Distribution Map Notes Manager applications. 

5. To set the default map extent for the Water Distribution Asset Collector map, open the 
Water Distribution Asset Collector map. 

6. Zoom the map to the desired extent and save it. 

7. Repeat steps 5 and 6 for the Water Distribution Mobile Viewer map. 

 

Configure the dashboard 
When you deploy the Water Distribution Data Management solution to your organization you 

have the option to change spatial reference. If you selected a spatial reference with a linear 

unit other than meters, you will need to revise the dashboard by completing the following 

steps. 

1. In a browser, sign in to your ArcGIS organization. 

2. To set the default map extent for the Water Distribution Dashboard application, browse 
to the Water Distribution Dashboard item page and click Edit Dashboard. 

3. Navigate to the General tab and click the configure button  on Miles of Main 
indicator. 

4. On the Data tab, change the Factor setting to the correct conversion.  

The dashboard Factor setting is configured to convert meters to miles. Learn more about 
how to Convert Values. 

5. Click the save button . 
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Use Water Distribution Data Management 
After deploying, organizations with no water distribution data can immediately begin mapping 

their water distribution systems using GPS or digitizing data with web or desktop software. 

Organizations with existing spatial water distribution data can load it and begin using the apps. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Add data in the field 
In these workflows, you will be taking the role of a mobile worker collecting data in the field. If 

you have a mobile-centric workforce, this may be the best option to collect new data or 

validate existing data. 

 

Collect hydrants and valves 
As a mobile worker, you can add hydrants and associated valves from the field. 

1. Open the ArcGIS Field Maps app and sign in to your ArcGIS organization. 

2. Open the Water Distribution Asset Collector map. 

3. Navigate to the collection location. 

4. Tap Add .  

5. From the list of features, search for Fire Hydrant by swiping up or typing fire hydrant 

in the filter search bar. 

If the hydrant is added to an inaccurate location, or you want to move the point manually, 
move the crosshairs to the correct location by panning the map and tapping Update 
Point. This moves the added manhole to the specified location. 

6. Fill in any attributes and tap Submit. 

7. If the fire hydrant has an accompanying valve, you can add it next. 

8. Tap Add . 

9. Search for Hydrant by swiping up or typing hydrant in the filter search bar and select 

Hydrant under Service Valve. 

If the hydrant valve is added to an inaccurate location, or you want to move the point 
manually, move the crosshairs to the correct location by panning the map and tapping 
Update Point. This moves the added hydrant valve to the specified location. 
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10. Fill in any attributes and tap Submit. 

Note: 

Move to a safe location to fill in the attributes; the added hydrant valve remains in its 
original location. 

 

Collect service features 
As a mobile worker, you can collect service meters and/or valves using ArcGIS Field Maps in 

the field. 

1. In ArcGIS Field Maps open the Water Distribution Asset Collector map. 

2. Browse to the collection location. 

3. Tap Add .  

4. From the list of features, search for the type of meter. In this example you are collecting a 
residential meter. Search for Residential by swiping up or typing residential in the 

filter search bar and select Residential under Service Meter. 

A point is added to your location. 

5. Fill in any attributes and tap Submit. 

6. Ensure the last collected service meter is selected and browse to the next meter location. 
Tap the Copy button at the bottom of the screen to copy the previously added meter to 
the location of the new meter. 

7. Adjust the attributes and tap Submit. 

8. If the meter has an accompanying service valve, you can add it next. 

9. Tap Add .  

10. From the list of features, search for Service by swiping up or typing service in the filter 

search bar and select Service under Service Valve. 

A point is added to your location. 

11. Fill in any attributes and tap Submit. 

 

Add map notes 
As a mobile worker, you can add a map note to the system. 

1. In ArcGIS Field Maps open the Water Distribution Asset Collector map. 

2. Navigate to the map note location. 

3. Tap Add.  

4. From the list of features, search for the Map Notes type by swiping up or typing a 
description in the filter search bar, select the Map Notes type, and add the note to the 
map by sketching a polygon in the map note location.  
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5. Fill in the attributes and click Submit. 

  The map note is added to the map and is available to be viewed and reviewed by others 
in the organization. 

 

Add data in the web 
In the workflows below, you will be taking the role of an editor adding data in ArcGIS Online. 

The workflows explain how to add data in the web, use the provided dashboard, and add and 

manage map notes. 

 

Add service connections 
As an editor, you want to use a web app to add service connections to the map. 

1. In a browser, sign in to your ArcGIS organization. 

2. At the top of the site, click Groups. 

3. Browse to the Water Distribution Editors group and locate the Water Distribution 
Editor app. Click View Application to launch the app. 

In the Water Distribution Editor app, the Asset Editor widget is open by default on the 
left side of the window when the app opens. 

4. In the Asset Editor pane, click the template drop-down menu and select Service 
Connection, and select Service Connection from the list of options. 

5. Scroll down and fill in the preset values. 

6. With service connection selected, click to add the service connection to the map.  
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7. You are prompted to update attributes and click Save. 

8. Continue adding service connections, changing the service connection type as needed. 

  The template and preset attributes remain selected so you can continue adding service 
connections. 

 

Add map notes 
As a user, you can add a map note to the system. 
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1. Browse to the Water Distribution Office Users group and locate the Water 
Distribution Viewer app. Click View Application to launch the app. 

a. In the Water Distribution Viewer, click the Map Notes Editor widget to open it. 

b. Choose a map note issue type and sketch a polygon in the desired map note 
location.  

 

c. Enter attributes and click Save.  

Map note changes are reflected in other apps and maps across the system so others 
in your organization can view the latest information. 

 

Manage map notes 
As a GIS manager, you can review and resolve map notes about your system to ensure 

issues are addressed. 

1. Browse to the Water Distribution Map Notes Managers group and locate the Water 
Distribution Map Notes Manager app. Click View Application to launch the app. 

In the upper right of the app, there are a number of widgets that have been configured to 
filter, edit, update, and manage map notes. 

2. Review the list of included widgets to learn how to use them to manage map notes:  
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• Legend—View a list of included layers in the map. The legend displays what is 
visible on the map, so zooming in or out can expand or reduce the list if scale 
suppression is set on the layers. 

• Filter—Use the Creation Date, Issue, and Severity filters to view only map notes 
that fit the entered criteria. Select a date range or an option from the drop-drown 
menu and turn on a filter to view the selection on the map. 

• Batch Edit Map Notes—Select a group of map notes using one of the selection 
tools and update values for all the selected features at once. 

• Map Notes Editor—Add a new map note or edit an existing map note. 

• Map Notes Summary—View all the map notes by status and expand each 
section to view the individual notes. Click a note to zoom to it on the map and 
view its attributes in a pop-up. 

 

Use the water distribution dashboard 
As a member of the utility, you want to have a comprehensive view of your water distribution 

system assets. 

1. Browse to the Water Distribution Office Users group and locate the Water 
Distribution Dashboard app. Click View Dashboard to launch the dashboard. 

2. View the water distribution system statistics on the General tab, click the Water Main tab 
to view the water main details, click the Service tab to view details about services and 
click Hydrants to view the hydrant details. 

 

Add data in ArcGIS Pro 
In the workflows below, you will be taking the role of an editor adding data in ArcGIS Pro. If 

you have known locations of assets or as-built drawings, the following workflows demonstrate 

using ArcGIS Pro to add data to your water distribution system. 

Note: 

The first time you open the Water Distribution Data Manager map in ArcGIS Pro, the 
layers will show as broken. Follow the steps to Configure the Water Distribution Data 
Manager ArcGIS Pro project to fix your layers. 

 

Add residential service laterals 
As an editor, you can add a service lateral and service connection to the map in ArcGIS Pro. 

1. Open the Water Distribution Data Manager ArcGIS Pro project, sign in to your ArcGIS 
organization. 

2. In the Catalog pane, expand Maps and double-click Water Distribution Data Manager 
to open the map. 

3. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 
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4. On the Edit tab, in the Features group, click Create. 

The Create Features pane appears. 

5. Select the 3/4" Residential Service group template from the Favorites list and click 
through the included templates to fill in the attributes. The group template works by 
adding the tap, service valve, and service connection with three consecutive clicks, and 
automatically digitizes the lateral. 
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6. Add the template to the map by following the steps below: 

a. Snap to the main and click to add the tap. 

b. Click to add the service valve to the map. 
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c. Double-click the location on the map for the service connection. This completes the 
sketch, adding a residential service lateral, the service valve, and tap at the main. 

   

7. On the Map tab, in the Selection group, click Attributes and fill in the remaining 
attributes. 

8. Repeat steps 5 through 7 to add the remaining residential lateral services to the map. 

 

Add features from an as-built drawing 
As an editor, you can add assets such as fittings and mains to the system from an as-built 

drawing. 

1. In the Catalog pane, expand Maps and double-click Water Distribution Data Manager to 
open the map. 

2. On the Map tab, in the Layers group, click Add Data. Browse to the location of the as-
built drawing, select it, and click OK to add it to the map. 

3. With the image selected in the Contents pane, browse to the Raster Layer ribbon. On the 
Appearance tab, in the Effects group, change the Layer Transparency setting to 50%. 

4. On the Imagery tab, in the Alignment group, select Georeferencing. 

If you are unfamiliar with georeferencing, see Overview of georeferencing in the ArcGIS 
Pro help. 

5. On the Georeferencing tab, in the Adjust group, click Add Control Points. 

a. Add a minimum of two control points to connect your image to your known map 
positions. 

b. Once you have added all the control points, browse to the Georeferencing tab and 
click Save. 

6. On the Edit tab, in the Snapping group, click Snapping and turn snapping on. 

7. On the Edit tab, in the Features group, click Create.  
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The Create Features pane appears. 

8. Select an asset from the template list and add the asset to the map where it corresponds 
to the georeferenced as-built drawing. 

9. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

10. Remove the image from the Contents pane once digitizing is complete. 

 

Add map notes 
As an editor, you can add a map note to the system. 

1. In the Catalog pane, expand Maps and double-click Water Distribution Data Manager to 
open the map. 

2. On the Edit tab, in the Features group, click Create. 

The Create Features pane appears. 

3. In the Favorites list, expand the Map Notes folder and choose a Map Note option. Add 
the map note by digitizing a polygon on the map at the desired location. 

4. On the Map tab, in the Selection group, click Attributes and fill in the attributes. 

The map note is added to the map and is available to be viewed and reviewed by others in 
the organization. 
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Weather Operational Effects 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Weather Operational Effects 
Weather Operational Effects can be used to quickly understand the impact of weather on 

military operations. 

Weather Operational Effects applies doctrinal operational thresholds against weather forecast 

data to determine the weather effects on specific types of operations and equipment. The 

resulting tactical decision aids—such as charts, dashboards, and overlays—enable planners 

and leadership to see weather effects over space, maximize operational effectiveness, and 

reduce operational risk. 

The Weather Operational Effects solution delivers a set of capabilities that help you to 

understand weather conditions within an area of responsibility, analyze potential operational 

effects of weather, and share information among staff and leadership. 

 

Requirements 
Weather Operational Effects requires the following: 

• ArcGIS Enterprise 

• ArcGIS Image Server configured for raster analytics 

• ArcGIS Pro 3.0 or later (Standard or Advanced) 

• ArcGIS Spatial Analyst extension or 

• ArcGIS Image Analyst 
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Information products 
Weather Operational Effects includes the following information products: 

Item Description Minimum user 
type 

 Weather 
Operational Effects 
Project 

A zipped file with an ArcGIS Pro project and 
supporting files used by intelligence staff to 
compile and analyze weather data. 

GIS 
Professional 
Standard 

 Weather 
Operational Effects 
Center 

An ArcGIS Experience Builder app used by 
intelligence staff, operations staff, and leadership 
to review weather data, forecasts, and effects. 

Viewer 

 Climate Station 
Dashboard 

An ArcGIS Dashboards app used by operations 
staff and leadership to view climate station data. 

Viewer 

 Current Weather 
Dashboard 

An ArcGIS Dashboards app used by operations 
staff and leadership to view current weather 
conditions. 

Viewer 

 Forecast 
Dashboard 

An ArcGIS Dashboards app used by operations 
staff and leadership to view forecasted weather 
and effects. 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • Minor updates to tools in the Weather Operational Effects Project 

• Minor updates to Arcade in the Forecast Dashboard 

1.0 • First release of Weather Operational Effects 
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Configure Weather Operational Effects 
Weather Operational Effects can be used to quickly understand the impact of weather on 

military operations. 

In this topic, you'll learn how to configure the Weather Operational Effects solution to meet 

specific needs of your organization. 

 

Configure the Weather Operational Effects project 
To get started, follow the steps below to download and review the Weather Operational 

Effects Project 

1. Sign in to your ArcGIS organization and browse to the Weather Operational Effects 
Project desktop application template. 

2. From the item page, click Download. 

3. In the Catalog Pane, expand the Tasks folder and then double-click the Weather 
Operational Effects task group. 

 

Set up the Weather Operational Effects project 
Weather Operational Effects can leverage either local or hosted data layers. Both sets of data 

are provided in the solution. 

To set up the Weather Operational Effects project, complete the following steps: 

1. In the Tasks pane, click the Set up the Weather Operational Effects project task group 
to expand the collection of tasks. 

2. If you plan to utilize the Portal applications and hosted feature layers, double-click Set up 
for Enterprise. 

3. If you do not plan to utilize Portal content and would prefer to use local data, double-click 
Set up for Local Data. 

 

Configure threshold CSVs (optional) 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

After Weather Operational Effects is deployed, downloaded, and unzipped, you can modify 

the threshold CSVs to best suit the needs and capabilities of your unit. Currently, the 

thresholds are based on U.S. Army doctrine - ATP 2-01.3 Intelligence Preparation of the 

Battlefield (March 2019). 
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There are individual threshold CSVs for each supported operation and weather type. For 

instance, Tracked Vehicle operations have CSVs for rainfall rate, snow depth, and visibility. 

Each CSV outlines the favorable, marginal, and unfavorable conditions for this operation and 

weather type. These values are then used in the Threshold Operations tool. 

1. Browse to the downloaded and unzipped Weather Operational Effects project folder 
and open the thresholdtables folder. 

2. Double-click the CSV file you wish to update. 

3. In the open CSV file, modify the numeric Min or Max values to best meet the needs and 
capabilities of your unit.  

It is critical that these updated values are in the same units as the original values. 

Note: 

Only modify the numeric values in the Min and Max columns. Do not modify any of the 
other columns, rows, or CSV file names because it will result in processing errors. 

For example, in AirborneOperationsCeiling.csv, the Unfavorable threshold currently 
spans a minimum of 0 feet and a maximum of 300 feet. These numeric values need to be 
updated to reflect 0 to 500 feet instead. For the Unfavorable row, you would replace the 
Max value of 300 with 500. This change also affects the Marginal threshold. For the 
Marginal row, you would replace the Min value of 300 with 500. 

4. Save the updated CSV file. 

 

Configure raster functions (optional) 

Note: 

This workflow is optional and doesn't need to be completed in order to work with the 
solution. 

In addition to the threshold CSV files, the raster functions can also be modified to best suit the 

needs and capabilities of your unit. Like the threshold CSV files, there are individual raster 

functions for each supported operation and weather type. 

To modify the raster functions applied to the forecast mosaic dataset as processing templates, 

follow these steps. 

1. Browse to the downloaded and unzipped Weather Operational Effects project folder. 

2. Open the WOE.aprx file. 

3. In the Catalog pane, navigate to the default file geodatabase (WOE.gdb). 

4. Expand the file geodatabase contents. 

5. Right click the WOE_Forecast mosaic dataset and select Manage Processing 
Templates. 
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6. In the Manage Processing Templates pane, scroll to the raster function template that you 
wish to update. 

7. In the template item, click the Edit button to open the Function Editor. 

8. To modify the thresholds used in the raster function template, double-click the Remap 
item.  

The Remap properties open. 

9. In the List table, update the minimum and maximum values as needed. 

Note: 

Ensure that the units are the same as defined in the preceding Unit Conversion 
function. Do not modify the Output values as these correspond to the Favorable, 
Marginal, and Unfavorable classification defined in the Attribute Table raster function. 

10. After editing is complete, click OK. 

11. In the Function Editor, click the Save button to save your changes. 

 

Configure Forecast Overlay web map and app 
After the forecast mosaic dataset has been published as an image service using the Weather 

Operational Effects project and tasks, it can be configured with a Portal web map and 

application. 

 

Configure Portal web map 
First, the image service must be added to a web map and rendered using the operational 

effects processing templates. 

1. In a browser, sign in to Portal. 

2. Browse to the Forecast Operational Effects Overlays Map and open the item page. 

3. Open the map in Map Viewer Classic. 

4. Add the published image service to the map. 

5. Follow the Use a predefined template instructions to render the image service with the 
operational effects processing templates. 

Note: 

Template load and application may take several minutes, depending on your system 
resources. 

6. Save the map. 
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Configure Forecast Effects app 
After the forecast image service has been configured in the web map, it can be used in an 

application with a Time Slider widget. 

1. Browse to the Forecast Operational Effects Overlays App and open the item page. 

2. Click Edit Application. 

3. In the side panel, click the Widget button and browse to the Time Slider widget. 

4. Follow the Configure the Time Slider widget instructions to use the widget to play the 
time-enabled image service. 

5. Save the application. 
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Use Weather Operational Effects 
The Weather Operational Effects solution delivers a set of capabilities that help you to 

understand weather conditions within an area of responsibility, analyze potential operational 

effects of weather, and share information among staff and leadership. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Get started 
The Weather Operational Effects solution provides maps, a data structure, step-by-step 

instructions, and more. The tasks in the Weather Operational Effects project guide you 

through downloading forecast data, processing the forecast data for operational effects, and 

creating tactical decision aids. 

First, you will download and unzip the  Weather Operational Effects Project. 

1. Sign in to your ArcGIS organization and browse to the Weather Operational Effects 
Project item. 

2. From the item page, click Download. 

3. Unzip the downloaded folder, and then from the unzipped folder, open the ArcGIS Pro 
project. 

4. If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. Expand the Tasks folder and then double-click the Weather Operational Effects task 
group. 

6. In the Tasks pane, expand the Explore Weather Operational Effects task group to see 
the collection of tasks. 

Tip: 

Click a group heading or task name to view its description at the bottom of the Tasks 
pane. 

7. Double-click Overview to review the project. 

8. Double-click What's Included to review the data, maps, and files included with the 
project. 

Each task group includes a set of steps for using the solution. 
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Use the Weather Operational Effects project 
In this workflow, you will assume the role of an intelligence staff member who wants to use the 

ArcGIS Pro project to download, process, and review weather data for an Area of 

Responsibility and Points of Interest. 

 

Create Area of Responsibility and Points of Interest 
In order to understand the weather within an operational environment, this environment must 

first be defined. The first step is to create an Area or Responsibility (AOR) polygon and 

identify Points of Interest point features within this AOR. Points of Interest could be key and 

decisive terrain, convoy checkpoints, objectives, or local population centers. 

In follow-on steps, the AOR and Points of Interest will be used to download, process, and 

determine the effects of weather forecast data. 

To create and save these features, click the Use Weather Operational Effects task group 

and follow the Create AOR and Points of Interest task. 

 

Acquire Forecast Raster Data 
Acquiring and processing weather forecast data drives the overall solution. This solution uses 

Global Forecast System (GFS) data produced by the National Centers for Environmental 

Prediction (NCEP) and distributed on the NOAA Operational Model Archive and Distribution 

System (NOMADS). 

GFS is multidimensional raster data "posted to a quarter degree equally spaced 

longitude/latitude grid with a temporal resolution of 1 hour out to 120 hours, then 3 hours for 

days 5-16, has 57 vertical standard pressure levels, and is cycled 4x/day." (NOMADS). For 

more information on GFS, visit the Documentation Homepage. 

NCEP utilizes a subscriber list to provide announcements regarding data servers. To receive 

these announcements, subscribe to the list. 

To download the required Global Forecast System (GFS) for your Area of Responsibility 

(AOR), follow the Acquire Forecast Raster Data step. This step downloads and saves GFS 

data as GRIB2 files and then adds those files to a mosaic dataset. 

 

Process Points of Interest forecast data 
Now that the forecast raster data has been downloaded for the Area of Responsibility, this 

data should be processed for the Points of Interest. Processing results in a standalone data 

table with a record for each location at every time slice/interval in the weather forecast data. 

The table contains fields for each forecast weather variable, such as surface temperature and 

wind gust. 

The table also contains individual fields for operational thresholds, such as the effects of 

temperature on personnel. Using the threshold CSVs and the table weather values, these 

fields are populated with Favorable, Marginal, or Unfavorable ratings. 
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To process Points of Interest forecast data and thresholds, follow the Process Points of 

Interest Forecast Data step. 

 

Review forecast data and analysis 
With the operational environment defined and weather forecast data processed, the resulting 

tactical decision aids can be reviewed. 

To review the forecast data and analysis for your AOR and Points of Interest, follow the 

Review Forecast Data and Analysis step. 

 

Publish and share the forecast mosaic dataset (optional) 
If you intend to review the forecast overlays in the Portal applications, the forecast mosaic 

dataset must be published as an image service. 

To publish and share this overlay content, follow the Publish and Share Forecast Mosaic 

Dataset (optional) step. 

 

Configure the Forecast Overlay web map and app (optional) 
After the forecast mosaic dataset has been published as an image service, the forecast 

overlay web map and app should be configured to use this service. The web map layers can 

be rendered by the operational effects raster functions and the app time widget can be 

configured to use the image time extent. 

To configure the web map and app, follow the Configure Forecast Overlay Web Map and 

App (optional) step. 

 

Review climate station data 
Climate data can provide historical context and a baseline for possible future weather 

conditions. This solution utilizes GHCN-D World Monthly Climate Means 1981 - 2010 climate 

station data from the GIS for Climate Hub. 

To review this data, follow the Review Climate Station Data step. 

 

Use the Weather Operational Effects Center app 
In this workflow, you will assume the role of an operations staff member who wants to use the 

Weather Operational Effects Center application to review historical, current, and forecasted 

weather. 

Follow the steps below to review the content provided with the solution and created by your 

unit's intelligence staff. 
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1. In a browser, sign in to your ArcGIS organization and browse to the Weather Operational 
Effects solution. 

2. Open the Weather Operational Effects Center application item page, and then click View. 

3. The Climate page shows historical weather conditions. Select a climate station within 
your Area of Responsibility from the list to view historical temperature and precipitation 
data. 

4. The Current page shows current weather conditions. Current weather station data is 
provided by ArcGIS Living Atlas of the World. Select a weather station within your Area of 
Responsibility from the list to view current temperature, humidity, wind, and visibility data.  

5. To review the weather forecast analysis produced by your unit's intelligence staff, you will 
use the Forecast page. 

6.  To review the forecasted effects for Points of Interest, follow these steps: 

a. In the dashboard header, select a Point of Interest.  

b. An optional time frame may be selected as well. With a point of interest selected, 
the dashboard elements will populate with forecasted weather values and 
operational effects. 

c. On the left side of the dashboard, click and then scroll through the operational 
effects list items to view forecasted weather conditions and the corresponding color-
coded effects of Favorable, Marginal, and Unfavorable. 

d. At the bottom of the dashboard, click through the weather conditions charts to view 
how conditions change over time. 

7. To review forecast overlays (if published by your unit's intelligence staff), follow these 
steps: 

a. On the dashboard, click the Forecast Overlays tab.  

An embedded application opens. 

b. Within the application, click the Layer List widget and toggle on the forecast overlay 
layer you wish to review. 

c. Click the Time Slider widget to play and interact with the time-enabled forecast 
overlays. 
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Wildlife Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Mar 2024 - Feb 2026 

Retired phase 
Mar, 2026 

 

Introduction to Wildlife Management 
Wildlife Management can be used to capture wildlife observations and monitor the status of 

wildlife populations in and around protected areas. 

It streamlines wildlife field observations and the location-enabled wildlife observations help 

protected area managers evaluate the effectiveness of current wildlife management 

strategies. Monitoring wildlife observation information and trends derived from this information 

informs monitoring and protection plans developed for a protected area. Wildlife Management 

is typically implemented by conservation agencies that want to take a data-driven approach to 

managing wildlife populations. 

The Wildlife Management solution delivers a set of capabilities that help you capture wildlife 

observations, monitor wildlife populations, and analyze trends in protected areas. 

 

Requirements 
Wildlife Management requires the following: 

• ArcGIS Enterprise 

• ArcGIS Survey123 

• ArcGIS QuickCapture 

• Survey123 Connect 
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Information products 
Wildlife Management includes the following information products: 

Item Description Minimum 
user type 

Wildlife 
Observation 
Dashboard 

An ArcGIS Dashboards app used by conservation staff 
to monitor the status of wildlife observations within and 
around protected areas 

Viewer 

Wildlife 
Observation 
Reporter 

An ArcGIS Survey123 form used by conservation staff 
to collect wildlife observations 

Mobile 
Worker 

Rapid Wildlife 
Reporter 

An ArcGIS QuickCapture project used by conservation 
staff to collect wildlife observations 

Mobile 
Worker 

 

Release Notes 
The following are the release notes: 

Version Description 

1.0 • First release of Wildlife Management 
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Configure Wildlife Management 
In this topic, you will learn how to configure the Wildlife Management solution to meet specific 

needs in your organization. 

 

Load data 
Wildlife Management can be used to capture wildlife observations and monitor the status of 

wildlife populations in and around protected areas. In some cases, you may have this 

information in ArcGIS or another business system already. 

Review the layers provided with the solution and determine what source data you would like to 

load. Then, load your existing data into the layers provided with the ArcGIS Solution before 

sharing the maps or applications. 

Once you have determined what source data must be loaded, complete the data loading 

workflow below. 

 

Load data from a shapefile 
Data for WildlifeObservations be loaded from a shapefile by following the steps below: 

1. Create a .zip file of your shapefile. 

2. In your ArcGIS organization, browse to the feature layer you wish to populate. 

3. On the feature layer item details page, Click Update Data and select Append Data to 
Layer. 

4. Under Filename, click Choose File. 

5. Navigate to your .zip file and click Open. 

6. Under Contents, select Shapefile. 

7. Click Upload and Continue. 

8. Choose the layer that you wish to load data into and the layer that contains the updated 
data. 

9. Uncheck Update existing features. 

10. Click Show field matching and map the fields between the two layers. 

11. Click Apply Updates. 

Tip: 

To make additional updates to a hosted feature layer, see Append data to layers. 
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Updating the animal list 
Species diversity varies between protected areas, so it is critical for protected area staff to be 

able to configure the animal list within the Wildlife Management solution. In the following 

sections, we will highlight how protected area staff can configure the Wildlife Management 

solution to match local animal species. 

 

Update the animal choice list in the Wildlife Observation Reporter 
To update the animal choice list, complete the following steps: 

1. Download and install Survey123 Connect. 

2. Start Survey123 Connect and sign in to your ArcGIS organization. 

3. Click on Wildlife Observation Reporter to download the survey. 

4. Click on Wildlife Observation Reporter again to open the survey. 

5. On the left panel, click Open XLSForm Spreadsheet. A Microsoft Excel spreadsheet will 
open. 

6. In the Microsoft Excel spreadsheet, click on the Choices tab. This tab comprises all the 
selectable options for survey questions. 

7. In the animal choice list, add or remove animal names and labels as needed. 

8. Save the Microsoft Excel spreadsheet and preview your changes in the Form Preview 
tab of Survey123 Connect. 

9. In Survey123 Connect, click Publish in the left panel to publish your changes. 

Note: 

The default animal list configuration comes with SVG graphics for each animal. If 
additional animals are added, you will need to add a new graphic for each additional 
animal to the media folder of the Wildlife Observation Reporter survey and list the file 
name of the new image in the image column of the XLSForm. 

 

Update the animal attribute list in the WildlifeObservations feature layer 
To update the animal attribute list in the WildlifeObservations feature layer, complete the 

following steps: 

1. On the WildlifeObservations feature layer item page, click the Data tab and then click the 
Fields button. 

2. Click the Animal field to open the field settings and click Edit under List of Values 
(Domain). 

3. Remove all animals from the list using the Delete button and enter the Label and Code 
for each new animal. 

4. When updates are complete, click Save. 
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Note: 

The animal list in the WildlifeObservations feature layer must be identical (syntax and 
order) to the animal choice list you updated in the Wildlife Observation Reporter. 

 

Update the Rapid Wildlife Reporter ArcGIS QuickCapture project 
To update the Rapid Wildlife Reporter ArcGIS QuickCapture project, complete the following 

steps: 

1. Click the Apps button  and Open ArcGIS QuickCapture. 

2. Click the Edit button on the Rapid Wildlife Reporter project. 

3. To add new animal buttons: 

a. Select an existing animal button, then click the Copy button in the button pane. 

b. In the Appearance tab, update the Label of the new animal button with the animal 
name. Then remove the existing animal image and add your new animal image. 
Select an existing animal button, then click the Copy button in the button pane. 

c. In the Data tab, select the new animal name from the Animal choice list dropdown. 
This will reflect the changes made to the WildlifeObservations feature layer. 

4. To delete animal buttons, select the Animal button then click the Delete button in the 
button page. To delete multiple animal buttons at once, hold down the shift key and 
select the animal buttons. 

5. To reorder animal buttons, simply drag and drop the animal buttons in the desired order. 

6. When you are finished making updates, click Save. 

Note: 

After the updates are saved, field users will see an option to update the Rapid Wildlife 
Reporter project in the ArcGIS QuickCapture application. Selecting update will download 
the new project updates to their device. 
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Use Wildlife Management 
The Wildlife Management solution delivers a set of capabilities that help you capture wildlife 

observations, monitor wildlife populations, and analyze trends in protected areas. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note: 

Use your organization's data or configured apps to follow these workflows. 

 

Collect wildlife observations 
The Rapid Wildlife Reporter app can be used to quickly capture wildlife observations in the 

field using a simple big button interface. The Wildlife Observation Reporter app can be used to 

capture detailed wildlife counts, information about the health of observed animals, and photos 

of the observation. Both can be used on a mobile device in a connected or disconnected 

environment. 

 

Collect rapid wildlife observations 
You will start by assuming the role of a mobile worker in a protected area collecting 

observations of wildlife. You are asked to use the Rapid Wildlife Reporter app to collect rapid 

observations. 

1. Download ArcGIS QuickCapture onto your mobile device. 

2. In ArcGIS QuickCapture, open the Rapid Wildlife Reporter app. 

3. Tap the image of the animal that you have observed. 

4. For Total Animals, type the number of animals, and then click Done. 

5. Repeat these steps to add additional animal observations. 

6. After recording your observations, close the project. 

Note: 

By default, wildlife observations automatically send when your device is in connected 
mode. Before sending, you can click the Map button and view the wildlife observation 
locations on a map, and then, if necessary, you can adjust the location. 

 

Collect detailed wildlife observations 
You will start by assuming the role of a mobile worker in a protected area collecting 

observations of wildlife. You are asked to use the Wildlife Observation Reporter to collect 

detailed observations. 
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1. On a mobile device, in ArcGIS Survey123, open the Wildlife Observation Reporter form. 

2. Tap Collect. 

3. Complete the survey with as much information as possible. 

Note: 

Required information is marked with a red asterisk. 

4. Tap the check mark to submit the form, and then tap Send now. 

 

Monitor wildlife observations 
Now you will assume the role of a protected area manager. You will view wildlife observations 

throughout the protected area. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Wildlife 
Management solution. 

2. View the Wildlife Observation Dashboard app. 

The Wildlife Observation Dashboard app opens with an overview of the current program 
status. 

3. On the left, adjust the filters to refine the results. 

4. On the right, select an observation from the list. 

The map zooms to the location of the observation, and a pop-up with more information 
appears. 

5. Review the observation details. 
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